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Configure user experiences

Interact with ServiceNow AI Platform  applications and data in the way that works best for you.

Get started

Click any of the tiles below to learn more about the variety of customizations, communications, 
and other options for a user experience unique to your enterprise on the ServiceNow AI Platform.

Configure UIs and Portals

Build user interfaces 
and create custom user 

experiences with this 
versatile suite of tools.

Provide user assistance

Give users assistance 
on the ServiceNow AI 

Platform with knowledge 
articles, step-by-step 
tutorials, and more.

Personalize 
your experience

Create visual timelines 
and task tracking.

Configure UIs and portals

Improve workflow and data retrieval using Workspace  and Core UI  apps. Take user interface 
development further with custom menus and pages from the Next Experience, or integrated 
apps with the Content Management System. Customize catalogs at any developer skill level with 
Service Portal, and enable your customers to get the services and products that they need.

Provide user assistance

Inform, educate, and assist your users with a full set of guidance and knowledge apps on the 
ServiceNow AI Platform. Help users get familiar with the ServiceNow AI Platform  using the 
Onboarding Experience, and give Guided Tours of the UI. Provide further assistance with step-
by-step instructions from Guided Setup, and on-demand knowledge with In-Product Help.

Personalize your experience

Get a graphical breakdown of workflows and give users customized views in your enterprise on 
the ServiceNow AI Platform. Visual Task Boards  and Timeline Visualization  help you manage 
projects, lists, and other aspects of your business, in two- or three-dimensional views. A further 
host of settings for users is available in Homepage administration, to fine-tune page rendering, 
user access, dashboards, and other options.

Access data on any device through a configurable web-based interface

Access workspaces, Core UI, applications, history, and favorites through the single pane Next 
Experience UI.

For highlights, see the Next Experience UI landing page.
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Provide just the data that you need

Access the data that you need and get to work immediately. Next Experience landing pages are 
personalized according to user and role.

Access your instance in single pane

Navigate to modules in your instance without opening multiple windows. Favorite the modules, 
explore modules you visited, and search your instance. Receive web and email notifications in 
one location too.
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Personalize your user interface

Next Experience  preferences

You can customize the UI to determine the information that you want to see, that's accessible, 
and in the format that works for you.

Improve agent efficiency with Workspace

Workspace  user interface

Solve issues faster with a workspace that is built to facilitate resolutions. Agents get full context 
and AI-assisted recommendations in a single view to resolve issues quickly. Agents can 
communicate with customers from the same interface while reviewing issues.

Applications and features

• Next Experience UI

• Workspace UI

• Working in Core UI

• Content Management System (CMS)

• Service Portal

• Adoption services

• Visual Task Boards (VTB)

• Timeline Visualizations
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Configure UIs and portals
Customize your interface to create an efficient, unique experience for users and customers.

Next Experience  UI

Unify your instance 
apps and reduce clicks 

with the ServiceNow®

Next Experience.

Workspace UI

Improve agent efficiency 
with Workspace
UI, to offer better 

customer experience.

Working in Core UI

Upgrade the user 
experience with custom 

homepages and URL 
navigation, all in Core UI.

Service Portal

Build the perfect self-
service interface for your 

customers with the mobile-
friendly Service Portal.

Content 
Management System

Design custom interfaces 
for the ServiceNow

platform and its 
applications using this 

highly flexible application.

Next Experience  UI

Personalize your experience to increase productivity and engagement. With the Next Experience 
UI, you can take control of navigation with all app shell items in one place. The ServiceNow AI 
Platform  lets you create custom menus and landing pages. You can easily move between core UI 
apps and personalized workspaces.

Workspace  UI

Create a workspace that works perfectly for you and your business needs. The Workspace  UI 
offers improved agent efficiency, swifter resolution, and monitoring for major incidents. All this 
data is provided from a single view, complete with analysis and AI-based recommendations.

Working in Core UI

Explore improvements in both usability and design with Core UI. Easy URL-based navigation to 
records or modules brings you the data that you want in an instant, from full addresses to tiny-
URL-supported links. Building homepages to your specifications lets you have all the navigation, 
controls, and system info you need to work most efficiently.

Service Portal

Design the optimal self-service experience with Service Portal. Connected to the ServiceNow AI 
Platform, the Service Portal  brings you the platform features that enhance your user experience. 
Whether a new developer or veteran engineer, you can customize the UI with everything from 
basic configurations to in-depth scripts and web apps to best serve your customers.
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Content Management System

Build everything from full websites to integrated apps using CMS. This powerful application 
offers a range of solutions for your business, whether you need an interface based on a simple 
search bar, or detailed text-and-image-based layouts. Options such as full internationalization 
and translation further expand your customer reach and influence.

Next Experience  UI
The Next Experience  UI delivers a next generation, intuitive, personalized experience to drive 
productivity, improve engagement, and surface insights across the ServiceNow AI Platform. The 
UI unifies your instance apps and reduces clicks to access the items you need to get working.

Get started

Work

Learn about Next 
Experience concepts 

and features.

Configure

Configure environments, 
tools, and user access.

Migrate

Migrate to Next 
Experience UI.

Benefits

New features and benefits when working in the Next Experience:

Unified Navigation

https://player.vimeo.com/video/995182005?
h=9e4dcc44a5&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

• Access app shell items—such as the contextual app pill, menu items, 
notifications, and search—all in one place across the entire platform, no matter 
which application you're using.

• Pin and unpin navigation menus to access menu items or free up screen real 
estate.

• Find your favorite pages quickly by organizing your favorites into folders.

Additional menus

• Navigate to and save important resources with the Favorites, History, and 
Workspaces menus. Find your recently-viewed items in a single menu.

• Easily switch between classic environment applications and configurable 
workspaces.

• Create custom menus for your end users. For more information, see Configure 
custom menus for Unified Navigation.

Next Experience  landing pages
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• Start your day with everything you need right when you log in.

• View content specific to your role and tasks all in one location.

• Designate a start page for your users, or allow them to choose their own.

Functionality not supported

Important: 

Connect Chat  is not available in Next Experience. Starting with Zurich, certain Connect Chat 
functions are available in Next Experience  by using Sidebar. See KB1123615 – Moving from 
Connect Chat to Sidebar  for more information about the differences between Connect 
Chat  and Sidebar.

Connect Support  is not available in Next Experience  and is scheduled to be completely 
deprecated in Utah. If you want to automatically assign chat requests and other work items 
to agents in Next Experience, you must migrate to Advanced Work Assignment  and Agent 
Chat. For details, see Move from Connect Support to Advanced Work Assignment and 
Agent Chat .

These features and products are not currently supported with Next Experience:

• The functionality found in homepages, arranging information from your instance to tell a story 
about your data, is found in dashboards on new instances. On upgraded instances with Next 
Experience  enabled, users can view existing homepages if they have a direct URL, but they 
can't create or edit them. Responsive dashboards and Analytics Center  dashboards take over 
homepage functionality.  Use the Homepage deprecation help tool  to convert the homepages 
on your instance to responsive dashboards.

• Live Feed  is not supported.

• The JavaScript console log isn't supported in the Next Experience  framework.

• ATF doesn't support these elements of Next Experience, but support for these features is 
planned for future releases:

◦ Pages built with UI Builder, including pages with lists and form components.

◦ Configurable Workspaces

◦ Landing pages

Note: 
ATF still supports the Core UI, including Classic Environment (such as classic lists and 
forms).

For more information, see:

• KB1156736 – Moving from Connect Chat to AWA and Agent Chat

• KB1123615 – Moving from Connect Chat to Sidebar

• KB1157068 – Live Feed Is Not Supported in Next Experience
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Next Experience  Unified Navigation  items  (continued)

Header items UI depiction Description

updated by your administrator. 
For more information, see Next 
Experience system properties.

For a list view, enter the 
table name in the format 
name.list, for example, 
sys_properties.list.

For a form view, enter the 
table name in the format 
name.do, for example, 
sys_user.do.

By default, filtering in any of 
the menus returns results from 
all menus, except the History 
menu.

All menu
Lists all the menu items and 
modules in the instance.

Select the refresh icon  to 
obtain the latest menu items 
without the need to manually 
clear the cache.

Favorites menu
Items you have marked 
as favorites, for example, 
favorite workspaces, classic 
environment, and records.

Select the edit icon  to 
open the edit modal.

For more information on 
adding and editing favorites, 
see Managing your favorites in 
Next Experience.

History menu History of your activities 
across the instance.
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Next Experience  Unified Navigation  items  (continued)

Header items UI depiction Description

Workspaces menu Lists the workspaces you can 
access. The menu appears 
only when workspace access 
is available. If you have one 
workspace, its name appears 
in the header.

Admin menu Provides access to items 
specific to admin functions.

Contextual app pill Provides the context for where 
you are in the instance.

Select the star icon to favorite 
the displayed page.

Global search field Search for a string across your 
instance.

Globe Select the scope of your 
instance and the scope of 
your update sets. You can also 
select the Update set  option 
and select the Plus sign icon 

 to create an update set.

Any application scope other 
than Global displays a red 

circle icon .

Now Assist Enables you to address and 
resolve customer issues. The 
Now Assist panel  helps 
you generate summaries 
for records, chats, cases, or 
incidents, get help, and create 
resolution notes. Use the 
menu width button to toggle 
between standard and wide 
widths. Standard and wide 
widths are static values and 
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Next Experience  Unified Navigation  items  (continued)

Header items UI depiction Description

the setting that you choose is 
retained.

The Now Assist  panel is 
configured using the Now 
Assist Admin  console.

Show instance tools Displays the application 
scope and current update 
set in a horizontal row 
beneath the other tool 
icons. To enable this feature, 
you must first create a 
system property called 
glide.ui.next_experience.instance_tools_disabled 
and set it to false. When this 
feature is enabled, the Globe 
icon is hidden.

Sidebar discussions Engage in real-time 
collaboration with others 
based around a Workspace 
task-based or interaction-
based record. Sidebar 
discussions facilitate the 
exchange of information and 
knowledge to help resolve 
issues faster and with higher-
quality outcomes.

Usage analytics Access usage analytic data 
directly from your applications 
and web pages.

Help The Help menu includes 
Get help  and What's new. 
A blue dot indicates new 
updates. Use Provide 
Feedback  to share feedback 
about the current page with 
ServiceNow®.

OpenFrame phone OpenFrame lets you make and 
receive embedded, contextual 
calls. When calls are active, 
the phone icon displays a 
badge. For more information, 
see OpenFrame overview .

Notifications menu View and personalize 
notifications that apply to you 
in one place. Notifications 
appear across your instance, 
including Workspace, based 
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Next Experience  Unified Navigation  items  (continued)

Header items UI depiction Description

on your access and admin 
settings.

User menu Menu items to personalize 
your instance.

• Profile: Your instance 
profile, which includes 
your personal information 
displayed in the instance.

• Preferences: Display, 
accessibility, notifications, 
and Workspace 
preferences.

• Keyboard shortcuts: 
Display a modal with 
keyboard shortcuts that 
are specific to the screen 
you’re viewing. For more 
information on the keyboard 
shortcut modal, see Next 
Experience keyboard 
shortcuts. The keyboard 
shortcuts modal can also be 
accessed using Command
+/  (Mac) or Control+/ 
(Windows).

• Impersonate user: 
Administrators can 
impersonate other 
authenticated users for 
testing purposes and view 
impersonation logs. For 
more information, see 
Impersonating users .

• Elevate role: Designate any 
role as an elevated privilege 
role, and then assign that 
role to one or more users. 
Do this when you want to 
restrict users from having 
access to the rights that the 
role provides immediately 
after login.
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Next Experience  Unified Navigation  items  (continued)

Header items UI depiction Description

• Printer friendly version: A 
printer-friendly version of 
the current content frame.

Note: 
The Printer-friendly 
version option is 
available in the classic 
environment but not in 
Workspace.

Managing your favorites in Next Experience

Favorites help you quickly find and go to your most used Next Experience  pages.

After you add favorites, they appear in the Favorites  menu in the Next Experience  Unified 
Navigation. You can customize how favorites appear in the menu by editing their names, icons, 
and colors, and their position in a folder structure.
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Add favorites in Next Experience

Find and go to your most used pages quickly by adding them to the Favorites menu in the Next 
Experience  Unified Navigation.

Before you begin
Role required: none

Procedure

1. Add a favorite in one of the ways listed in the following table.

Option Description

From any page

From any page, select the star icon in the con­
textual app pill.

From the All menu

◦ To add a single module: In the 
application navigator, select 
the star icon next to the module 

name.

◦ To add all the modules under an applica­
tion: In the application navigator, select the 
star icon next to the application name.

From a list or record in the classic environ­
ment

a. Open a list or record in the classic environ­
ment.

b. Select the context menu icon  next to 
the list or record title.

c. Select Create Favorite.

You can add a different favorite for each view 
of a list or record.

From a knowledge base article

a. Navigate to All  > Self-Service  > Knowl­
edge.

b. From the Knowledge Homepage, select a 
knowledge article.

c. In the header, select the star icon (If the 
knowledge article has multiple versions, on­
ly the currently viewed knowledge article 
version is added to favorites).
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2. Optional:  In the Favorite added  dialog box, modify the favorite.
A sample initial dialog box is shown in the following example.

(Optional)

a. In the Name  field, edit the name that appears in the Favorites menu.

b. In the Location  field, if you have created groups for the Favorites menu, select a group for 
the favorite to be listed in.
For information about creating groups to organize the Favorites list, see Organize favorites in 
Next Experience.

c. Either save your changes, make further modifications, or remove the favorite.

▪ To make no further modifications, select Done.

▪ To modify the favorite's icon and its color, select More, select an icon and its color, and 
select Save edits.

▪ To remove the favorite, select Remove.

Organize favorites in Next Experience

Find entries in the Next Experience  Favorites menu quickly by organizing your favorites in a 
folder structure.

Before you begin
Role required: none

Procedure

1. Select the Favorites  menu in the Next Experience  Unified Navigation.

2. Select the Edit your favorites icon .

3. Select Create custom group.

4. In the Name  field, enter a name for the group.

5. Optional:  Select a color for icons associated with the favorites in this group.
You can also set colors specific to each favorite in the group.

6. Move favorites into the group by dragging them under the group's name.
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Example 

7. Optional:  Repeat the previous steps to create additional custom groups or subgroups.

8. Select Save edits.

Edit favorites in Next Experience

Keep your Next Experience  Favorites menu updated by editing the names and icons of favorites, 
reordering favorites, moving them into groups, or deleting favorites you no longer need.

Before you begin
Role required: none

Procedure

1. Select the Favorites  menu in the Next Experience  Unified Navigation.

2. Edit or delete favorites.

Option Description

Edit a favorite
a. Select the Edit your favorites icon .

b. In the favorites panel, select a favorite.

c. Modify the favorite.
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Option Description

▪ To reorder the favorite, drag it to a new lo­
cation in the list.

▪ To move the favorite to within a group, 
drag the favorite under the group's name.

▪ To customize the name, enter a different 
name in the Name  field.

▪ To change the icon, select a different 
icon from the Icon list or color from the 
Color list.

d. Select Save edits.

Delete a favorite Select the Remove favorite icon .

Using search in Next Experience

Global search enables you to search multiple record types at once from the Next Experience 
Unified Navigation  search field. Search returns the results that are most relevant to you, grouped 
by source, or takes you directly to a record that exactly matches your search query. You can 
switch between global search results and results from workspace applications that you have 
access to.

Search in the Unified Navigation  search field

To perform a global search, enter your search query in the Unified Navigation  search field, then 
select View results  or press Enter.

The search results page reports the total number of records that matched your search and 
previews a selection of results from each searchable table that contains matching records. You 
can open any search result record by selecting it in the preview list.
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For more details on the contents of the Next Experience  search results page, see Search results 
page in Next Experience .

Narrow your search by source on the search results page

The search results page includes a list of source tables showing the number of matching records 
each contains. Select an entry to see search results from the specified source table.

When there are more matching records from a source table than can be previewed, the results 
page displays a View all  link next to the table title. Select this link to view all matching records 
from the specified table.
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Return to your starting point from the search results page

To return to the page where you initiated your search, select the link with a left arrow that appears 
above the total results count on the search results page. The title of this link indicates the page 
it returns you to. For example, if you searched from the Home page, the link text would be Home, 
but if you searched from the Dashboards page, the link text would be Dashboards Overview.

Search for a specific record using Exact Match

Enter a record number into the Unified Navigation  search field but don't press Enter or select 
View results. The search field displays a preview of the record with an Exact Match  tag. Select 
the preview to go directly to the matching record, bypassing the search results page.

Access your most recent search queries and results

When you select the empty Unified Navigation  search field, the system displays lists showing 
your most recent search queries and your most recently viewed search results. Select a Recently 
Searched  query to repeat it, or select a Recently Viewed  search result record to navigate to it.
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View results for your search in an available workspace application

If you have access to search in workspace applications, an arrow appears at the right of the 
Unified Navigation  search field after you search that enables you to switch between the results in 
global search and in your workspace applications.

For example, if the context menu in the illustration was available after you performed a global 
search, you could select CSM/FSM Configurable Workspace  from the context menu to view 
results for the search in CSM/FSM Configurable Workspace.

Exact matches open in the selected workspace application. For example, if you selected CSM/
FSM Configurable Workspace, entered a record number, and selected the record preview in the 
search results, the record would open in CSM/FSM Configurable Workspace.

For information adding a workspace to the Unified Navigation  search menu, see Add a 
workspace application to the Unified Navigation search context menu .
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Configuring Next Experience start page options

Multiple start page options help you determine where best to start your day in Next Experience. 
Configure the landing page so that you and your users start on a page tailored to your needs in 
ServiceNow.

There are several options for the page that opens when you launch ServiceNow®  or select the 
logo at the top of the screen.

Start page options

Any page can have redirect rules as the page is loading to take the user to a different page.

Next Experience  default landing page

The default landing page provides information to help orient you to your tasks 
in an instance enabled with Next Experience. Variants of this page are available, 
depending on your setup. For more information, see Exploring your Next Experience 
default landing page.

Configurable workspace home

Any page within a configurable workspace can be the start page. For more 
information about configurable workspace  options, see Configuring Configurable 
Workspace.

User-selected landing page

You can select any page on the platform to be your start, based on a user 
preference. A user-selected landing page can be any page inside a configurable 
workspace as well. For more information, see Configure a user-selected start page.

Admin-selected landing page

This option can be any page inside a workspace, but also a classic dashboard. The 
admin can include role-based logic to direct users to configurable workspaces. For 
more information, see

• Configure a Core UI global landing page in Next Experience enabled instances

• Configure per-user landing pages in Next Experience

Responsive dashboards

You can start with a responsive dashboard created in the classic environment to 
use an existing dashboard that isn't available in a configurable workspace. For more 
information, see Set responsive dashboards as your home .

Homepages

Homepages are a deprecated feature. Homepages from earlier releases are 
read-only from the Tokyo  release. For information on converting homepages to 
Responsive dashboards, see Homepage deprecation .

How to choose a start page

The different options for start pages serve different purposes. For example, choose a responsive 
dashboard for your start page if most of your data is in the classic environment, rather than in 
configurable workspaces.

Upgrade considerations

When you upgrade to an instance with Next Experience  enabled, it's best to convert homepages 
to responsive dashboards, so that you don't lose editing capabilities. Homepages are turned 
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off by default when Next Experience  is enabled. For more information, see Homepage 
deprecation .

Next Experience  administrator start options

As an administrator, you can configure where users start when they log in to ServiceNow.

Determine the start page

The start page that you configure should address your needs and the needs of your organization. 
Next Experience  default landing pages show visualizations that you can select to address 
immediate tasks. Dashboards and configurable workspaces can provide more focused 
information.

Options

Next Experience  default landing page

The default landing page provides information to help orient you to your tasks 
in an instance with Next Experience  enabled. Variants of this page are available, 
depending on your setup. For more information, see Exploring your Next Experience 
default landing page

Custom Next Experience  landing page

You can provide users the information that they need to start working by creating 
custom Next Experience landing pages for different audiences. For more 
information, see Create a Next Experience landing page.

Configurable workspace home

Any page within a configurable workspace can be the start page. For more 
information about configurable workspace  options, see Configuring Configurable 
Workspace.

Admin-selected landing page

The admin can set a default landing page for all users that may override a user-
selected page. This option can be any page inside a workspace, but also a classic 
responsive dashboard. The admin can also include role-based logic to direct users 
to configurable workspaces. For more information, see

• Configure a Core UI global landing page in Next Experience enabled instances

• Configure per-user landing pages in Next Experience

Responsive dashboards

You can start with a responsive dashboard created in the classic environment to 
use an existing dashboard that isn't available in a configurable workspace. For more 
information, see Set responsive dashboards as your home .

Next Experience  user start options

As a user, you can specify where you want to start when you log in to ServiceNow.

Determine your start page

The start page that you configure should address your daily needs. Next Experience  default 
landing pages show visualizations that you can select to address immediate tasks. Configurable 
workspaces can provide more focused information.

Note: 
Your administrator can configure a start page that individual users cannot override.
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Options

Next Experience  default landing page

The default landing page provides information to help orient you to 
your tasks in an instance with Next Experience  enabled. Variants 
of this page are available, depending on your setup. For more 
information, see Exploring your Next Experience default landing 

page.

Configurable workspace home

Any page within a configurable workspace can be the start page. For more 
information about configurable workspace  options, see Configuring Configurable 
Workspace.

Another user-selected landing page

You can select any page on the platform to be your start, based on a user 
preference. A user-selected landing page can be any page inside a configurable 
workspace as well. For more information, see Configure a user-selected start page.

Next Experience  preferences

Next Experience  offers user preferences to personalize your instance UI.

Next Experience  preferences let you personalize how the interface looks, behaves, and 
communicates with you; some options are available to all users, while others appear only to 
administrators or in specific contexts. If you have the admin role, you can customize the behavior 
of Next Experience  across your instance by setting global preferences.

The Preference modal is divided into three parts: a search field, preference category panel, and 
a preferences panel that displays the associated preferences for each selected preference 
category. Once a preference category is selected you see all the preference toggles for that 
category listed in the Preferences panel.
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Preference modal

As you enter text into the Search  field, the Preferences panel dynamically updates to show 
relevant user preference toggles, organized by category. The search function uses a fuzzy search 
filter, which finds applicable results even with shortened text.

Preference modal Search field

The following table shows how you can customize different preference types.

Next Experience  preferences

Preference Description

Configure Next Experience display 
preferences: Control how the Next Experience 
interface looks and behaves on screen, such 
as layout, visual density, and presentation 
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Next Experience  preferences  (continued)

Preference Description

options. These settings affect only the current 
user’s view.

Configure Next Experience accessibility 
preferences: Adjust the interface to support 
accessibility needs, such as keyboard 
navigation, contrast, or motion behavior, to 
make the UI easier to use for different abilities.

Configure Next Experience debugging 
preferences: Debug your Next Experience 
instance to detect and remove the existing 
and potential errors in your Next Experience 
components and scripts.

Note: 
The debugging preferences only appear 
for users with the admin role.

Select a theme in Next Experience: Personalize 
your Next Experience  instance by choosing 
from the multiple themes that are available to 
you.

Note: 
The themes that appear in the Theme 
user preference are determined by the 
user access and admin customizations.

Configure Next Experience notification 
preferences: Control how and where you 
receive system and in product notifications, 
including banners, badges, and delivery 
channels such as email.

Configure Next Experience language and 
region preferences: Define your language, time 
zone, and date and time formats.

Configure Next Experience Workspace 
preferences: Customize behavior within 
a specific workspace, such as layout or 
interaction settings

Note: 
The workspace preferences appear only 
if you have access to Workspace and the 
workspace is in focus.
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Next Experience  preferences  (continued)

Preference Description

Configure Next Experience user experience 
preferences: Manage high level Next 
Experience  behaviors, such as enabling or 
disabling the experience, analytics collection, 
or selecting a start page, depending on your 
access.

Configure Next Experience  display preferences

Configure Next Experience  display preferences to achieve the UI that works best for you.

Before you begin
Role required: none

Procedure

1. Navigate to User Menu  > Preferences  > Display.
The user menu is represented by your user icon or initials in the Next Experience  Unified 
Navigation.

2. Select the toggle next to each option to turn the preference on or off.

Display preferences

Option Description

Displays forms and related lists in tabs so you 
can navigate directly to form sections.

Enables you to create a new line within the 
same list entry.

Enables the ability to edit the name and 
location of a favorite when adding it.

Loads related lists in classic forms at one of 
the following times:

◦ With the form

◦ After the form loads

◦ On demand

Optimizes the spacing between form 
fields, controls, and list rows and columns, 
displaying more content on forms and lists.
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Option Description

Provides tooltips to use and configure 
features in the instance.

Sets persistent top navigation when opening 
a new window from the menu so you can 
continue to access your menus.

Shows results from all menus except the 
History menu when filtering from any menu 
in the Unified Navigation. If turned off, menus 
show results only from the menu you're 
filtering from. The All  menu returns results 
from all menus except the History  menu 
regardless of this setting.

Configure Next Experience  accessibility preferences

Set up Next Experience  accessibility preferences to achieve a UI that's most accessible to you.

Before you begin
Role required: none

Procedure

1. Navigate to User Menu  > Preferences  > Accessibility.

2. Select the toggle next to each option to turn the preference on or off.

Accessibility preferences

Field Description

Displays the date and time format (yyyy-
MM-dd-HH:mm:ss) next to the form 
fields ensuring the format remains visible 
even when the field is in focus. For more 
information, see Show date and time formats 
on forms preference.

Adjusts charts and graphs to display with 
a pattern such as stripes or dashed lines 
instead of just a color. For more information, 
see Replace colors with patterns in charts 
and graphs preference.

Use keyboard shortcuts to quickly perform 
common actions in the user interface. The 
keyboard shortcuts that display in the modal 
are specific to the screen you are viewing. 
For more information, see Enable keyboard 
shortcuts preference  and Next Experience 
keyboard shortcuts.
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Field Description

Note: 
If you’re working in the Classic 
Environment, see Core UI keyboard 
shortcuts.

Displays all hidden fields, buttons or other 
UI elements, eliminating the need to hover 
over them. For more information, see 
Show all buttons without the need to hover 
preference.

Shows a table with chart and graph data 
for easier screen reader access. For more 
information, see Enable data table for charts 
and graphs preference.

Reduces the speed of the animations when 
switching between screens. This reduction 
pertains mainly to login animations. For more 
information, see Reduce motion preference.

Extends keyboard navigation and enables 
more tab stops in the classic environment 
so you can tab to icons and buttons in lists, 
form fields, and cards. This option also 
presents additional info on forms. For more 
information, see Enable accessibility in 
Classic preference.

Note: 
The classic environment refers to 
working in lists of records and on 
record forms directly. You can work 
in the classic environment with Next 
Experience  active, or with it inactive, 
which is referred to as Core UI.

Allows keyboard-only users to access 
truncated text. Truncated text is text that 
doesn't fit on the screen and is indicated 

by an ellipsis . When this preference is 
enabled, keyboard-only users can access 
the truncated text as they Tab through the 
focus order, revealing the full text of each 
tooltip as they navigate the screen. For more 
information, see Enable keyboard focus on 
text that displays tooltip.

Voice input is automatically activated when 
the Now Assist  panel is activated. As of 
the Zurich Patch 4 release, voice input is 
configured in Additional chat features  and 
not with this option.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

33

https://www.servicenow.com/docs/access?context=additional-chat-features&version=zurich&pubname=zurich-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=additional-chat-features&version=zurich&pubname=zurich-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=additional-chat-features&version=zurich&pubname=zurich-conversational-interfaces&ft:locale=en-US


Field Description

Activates voice-to-text in the Now Assist 
panel. With this feature, use your voice to 
access Now Assist  skills in the Now Assist 
panel  in any supported language. For more 
information on this preference, see Enable 
voice input for the Now Assist panel.

Note: 
This preference appears only if your 
system administrator has enabled Now 
Assist  voice input for your instance. 
For more information, see Enable voice 
input for Now Assist panel .

Keeps page alerts visible until you 
acknowledge them. When this preference is 
turned off, page alerts may disappear after 
a certain amount of time depending on how 
the specific page alert is configured. For more 
information, see Do not auto-dismiss page 
alerts preference.

Note: 
Critical and warning alerts do not 
disappear. If focus is applied to the 
alert, the auto-dismiss feature will not 
apply.

Note: 
If users have configured operating system-specific settings, such as forced colors 
or contrast in Windows, those settings are not overridden by Next Experience  user 
preferences or themes. If those OS-specific settings are inactive, color and theme 
behaviors will revert to those behaviors defined in the Next Experience  UI.

Show date and time formats on forms preference

Learn more about the Show date and time formats on forms accessibility preference.

The purpose of this preference is to provide clear and consistent date and time information.

Preference details

Detail Description

Feature Clearly displays the expected date and 
time input format to help prevent errors and 
confusion.
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Preference details  (continued)

Detail Description

Why this feature matters When forms explicitly show the date and time 
format (like MM/DD/YYYY or DD/MM/YYYY), 
users see exactly how to enter the information 
correctly. This preference is especially helpful 
in global contexts where formats differ by 
region, reducing mistakes and improving form 
completion rates.

Who benefits • Users in different locales with varying date/
time formats

• Screen reader users needing clear input 
guidance

• Anyone filling out forms quickly

Visual representation of preference

Activated Deactivated

Date and time fields display the format in 
parentheses. For example, Date (YYYY-MM-
DD).

Date and time fields do not display the format.

Replace colors with patterns in charts and graphs preference

Learn more about the Replace colors with patterns in charts and graphs accessibility preference.

The purpose of this preference is to enhance the readability of charts and graphs.

Preference details

Detail Description

Feature Enhances chart clarity and ensures 
accessibility for users who have color-
blindness by incorporating patterns or labels, 
making visual data easy for everyone to 
interpret.
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Preference details  (continued)

Detail Description

Who benefits • Users with color vision deficiencies

• Black-and-white printing users

• Anyone needing extra clarity in data 
visualization

Visual representation of preference

Activated Deactivated

Charts and graphs display patterns such 
as stripes or dashed lines in addition to or 
instead of colors.

Charts and graphs rely solely on colors to 
differentiate segments.

Enable keyboard shortcuts preference

Learn more about the Enable keyboard shortcuts accessibility preference.

The purpose of this preference is to improve efficiency and productivity.

Preference details

Detail Description

Feature Navigate quickly on a page without relying 
on a mouse device or touchpad. Keyboard 
shortcuts speed up workflow, reduce strain, 
and make navigation more precise.
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Preference details  (continued)

Detail Description

Who benefits • Users with mobility impairments

• Users who want faster navigation

• Anyone working in high-efficiency 
environments

Visual representation of preference

Activated Deactivated

Keyboard shortcuts are active, and users can 
access a list of available shortcuts from the 
user menu.

Keyboard shortcuts are not available.

Show all buttons without the need to hover preference

Learn more about the Show all buttons without the need to hover accessibility preference.

The purpose of this preference is to improve discoverability and usability.

Learn more about this preference from the following tutorial:
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https://player.vimeo.com/video/1023392081?
h=0a7a772a6f&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Preference details

Detail Description

Feature Makes all interactive elements visible 
and discoverable. Visible controls remove 
guesswork and help users confidently take 
action.

Who benefits • Screen reader users

• Keyboard only navigators

• Anyone unfamiliar with hidden UI patterns

Visual representation of preference

Activated Deactivated

All buttons and interactive elements are visible 
without needing to hover.

Some buttons or elements are hidden until 
hovered over.

Enable data table for charts and graphs preference

Learn more about the Enable data table for charts and graphs accessibility preference.

The purpose of this preference is to provide accessible data for users with visual impairments.

Preference details

Detail Description

Feature Makes complex data readable and navigable 
with screen readers or by keyboard. Tables 
provide a linear, text-based format for easier 
exploration and exportation of data.
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Preference details  (continued)

Detail Description

Who benefits • Screen reader users

• Users who prefer data in structured formats

• Anyone needing to copy/paste data for 
reports

Visual representation of preference

Activated Deactivated

A data table is displayed alongside or instead 
of the chart/graph.

Only the chart/graph is displayed.

Reduce motion preference

Learn more about the Reduce motion accessibility preference.

The purpose of this preference is to minimize distractions and improve usability.

Preference details

Detail Description

Feature Reduces the speed of animations when 
switching between screens, mainly affecting 
login animations. Reducing motion helps 
people who experience discomfort or nausea 
from animated effects.
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Preference details  (continued)

Detail Description

Who benefits • Users with vestibular disorders or motion 
sensitivity

• Users who experience migraines triggered 
by animations

• Anyone preferring faster interaction

Visual representation
Activated:  Animations are slower or turned off.

Deactivated:  Animations occur at their normal 
speed.

Enable accessibility in Classic preference

Learn more about the Enable accessibility in Classic preference accessibility preference.

The purpose of this preference is to improve accessibility in the Classic UI. The classic 
environment refers to working in lists of records and on record forms directly. You can work in the 
classic environment with Next Experience  active, or with it inactive, which is referred to as Core 
UI. Turn this preference on to unlock additional accessibility options in Core UI.

Preference details

Detail Description

Feature Extends keyboard navigation and enables 
more tab stops in the classic environment.

Who benefits Anyone using the legacy Classic UI.

Visual representation
Activated:  Additional tab stops and keyboard 
navigation are available in Classic UI.

Deactivated:  Classic UI has limited keyboard 
navigation and tab stops.

Enable keyboard focus on text that displays tooltip

Learn more about the Enable keyboard focus on text that displays tooltip accessibility 
preference.
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The purpose of this preference is to provide access to truncated text.

Learn more about this preference from the following tutorial:

https://player.vimeo.com/video/1011128718?
h=4c5a512d5a&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Preference details

Detail Description

Feature Makes hidden text accessible when navigating 
with a keyboard. Ensures that full context is 
available without relying on mouse device 
hover.

Who benefits • Keyboard-only users

• Screen reader users

• Anyone preferring to tab quickly through 
interfaces

Visual representation
Activated:  Truncated text is accessible via 
keyboard focus, revealing full text.

Deactivated:  Truncated text requires mouse 
device hover to view full text.

Enable voice input for the Now Assist  panel

Learn more about the Enable voice input for the Now Assist  panel accessibility preference.

Note: 
Voice input is automatically activated when the Now Assist  panel is activated. As of the 
Zurich Patch 4 release, voice input is configured in Enable additional chat features  and 
not with this option.

The purpose of this preference is to provide an alternative input method.

Note: 
This preference appears only if your system administrator has enabled Now Assist  voice 
input for your instance. For more information, see Enable voice input for Now Assist panel .

Learn more about this preference from the following tutorial:

https://player.vimeo.com/video/1064509623?
h=452a5a584a&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Preference details

Detail Description

Feature Hands-free navigation and data entry. Voice 
input enables users to control their device and 
enter text using speech.

Who benefits • Users with mobility or dexterity limitations

• Users who want to work hands-free

• Anyone experiencing temporary injuries

Visual representation of preference

Activated Deactivated

The Now Assist  panel includes a microphone 
button for voice input.

The microphone button isn’t available in the 
Now Assist  panel.

Do not auto-dismiss page alerts preference

Learn more about the Do not auto-dismiss page alerts accessibility preference.

The purpose of this preference is to verify users are aware of critical information and can take 
necessary actions.

Preference details

Detail Description

Feature Keeps page alerts visible until acknowledged.

Who benefits Users who require explicit notification of 
important information.

Visual representation
Activated:  Page alerts remain visible until 
manually dismissed.

Deactivated:  Page alerts may disappear after 
a certain time.

Configure Next Experience  debugging preferences

Debug your Next Experience  instance to detect and remove existing and potential errors in your 
Next Experience  components and scripts.
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Before you begin
Role required: admin

Procedure

1. Navigate to User Menu  > Preferences  > Debugging.

2. Select one of the debugging options.

Debugging

Field Description

Script Debugger Opens a JavaScript debugger with a 
script tracer and a session log. For more 
information, see Debugging scripts .

UX Source Maps Enables you to perform debugging using UX 
source maps in your browser. For example, 
when used with Firefox v102+, the user can 
set a break point in component code and, 
when the browser stops at that break point, 
variable names should appear in the scope 
section.

Note: 
When you are not debugging using 
UX source maps, it is best to toggle 
this user preference off as it can 
cause performance degradation of the 
instance.

Automated Test Framework Page Inspector Enables you to identify and inspect pages 
created in classic custom UI pages using the 
page inspector. For more information, see 
Page Inspector .

Seismic Developer Tool Opens a link to the Chrome web store 
Seismic Developer Tools download page. The 
Seismic Dev Tools (SDT) Chrome Extension 
is a tool that helps Seismic developers 
effectively identify, diagnose, and resolve 
defects and performance issues.

Note: 
This option can be removed 
from the Debugging user 
preferences by setting the 
glide.ui.next_experience.seismic_developer_tool_user_pref_enabled 
system property to false.

Configure Next Experience  language and region preferences

Configure Next Experience  language and region preferences to achieve the UI that works best for 
you.

Before you begin
Role required: admin
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Procedure

1. Navigate to User Menu  > Preferences  > Language & Region.

2. Select the preferences that you want to configure.

Display preferences

Option Description

Sets the format in which dates and times 
appear. The options include:

a. YYYY-MM-DD 09:00:01 5 min ago

b. YYYY-MM-DD 09:00 5 min ago

c. YYYY-MM-DD 09:00:01

d. YYYY-MM-DD 09:00

e. 5 min ago

Note: 
If you select YYYY-MM-DD 09:00 5 
min ago  or YYYY-MM-DD 09:00  for the 
current year, the current year (YYYY) will 
be omitted. The option 5 min ago  refers 
to a relative time format that displays 
how much time has passed since a 
specific event has occurred.

Determines the time zone or returns to the 
default time zone for the current session. 
Upon the next login, the time zone setting 
reverts to the system default, or user profile 
setting for time zone.

Sets the language used for your instance 
when you have access to more than one 
language. This preference displays only if 
the language plugin is installed. For more 
information, see Activate a language .

Select a theme in Next Experience

Personalize your Next Experience  instance by selecting a theme and it's variant or alternate color 
palette in the user preferences menu.

Before you begin

Note: 
An administrator must enable at least one theme before you can select one as described in 
this task. For information about theme variants and alternate color palettes, see Core styles, 
colors, variants, and alternate color palettes.

Role required: none
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Procedure

1. Navigate to User Menu  > Preferences  > Theme.

2. Select an available theme.
The themes that are displayed in your Theme user preference depend on the customizations 
that were made by your administrator.

Each theme card displays the core theme and all variants or alternative color palettes that 
are associated with that core theme. Hover over the circles beneath the core theme to view a 
preview of the variant or alternate color palette. A colored border appears around the theme 
card that has been applied to your instance.

Configure Next Experience  notification preferences

Set up how you receive in-product and system notifications in Next Experience.

Before you begin
Role required: none

Procedure

1. Navigate to User Menu  > Preferences  > Notifications.

2. Select the General  tab.

3. Configure your preferences for system notifications outside of the platform.
For more information about advanced notification preferences, see System and custom 
notification and delivery channel preferences in Next Experience .

4. Select the Next Experience  tab.

5. Configure your preferences for in-product notifications.

Configure Next Experience  Workspace  preferences

Set up your Workspace  display preferences.

Before you begin
Workspace  preferences display only if you have access to a Workspace  and the Workspace  is in 
focus.

Role required: none
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Procedure

1. Navigate to User Menu  > Preferences  > Workspace.

2. Select the toggle next to each option to turn the preference on or off.

Workspaces

Field Description

Shows the ribbon widget by default when the 
form loads.

Shows the contextual side panel by default 
when the form loads.

Expands all activities in the activity stream 
automatically.

Loads all content on a page dynamically, as 
needed. Disable this preference to load all 
content immediately.

Configure Next Experience  user experience preferences

Configure your user experience preferences for your Next Experience  instance.

Before you begin
Role required: none

Procedure

1. Navigate to User Menu  > Preferences  > User Experience.

2. Select the preference that you want.

Note: 
The preferences that are described in the following table might not be available to all 
users. The items that appear are determined by the user access and the customizations 
from your administrator.

User Experience

Field Description

Start page that appears when users log in to their Next 
Experience  instances. For more information on start page 
options, see Configure a user-selected start page.
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Field Description

Option that lets you turn on or off usage analytics tracking on 
your Next Experience  instance.

Option that lets you turn off the Next Experience  UI on your 
instance. The Core UI  appears when you turn off the Next 
Experience  UI on your instance.

Note: 
Administrators can enable this option by setting the 
glide.ui.polaris.on_off_user_pref_enabled 
to true.

Next Experience  keyboard shortcuts

You can use keyboard shortcuts to quickly perform common actions in the user interface.

The keyboard shortcuts that display in the modal are specific to the screen you’re viewing. 
Keyboard shortcuts depend on the browser and operating system that you’re using. The Linux 
operating system is not currently supported.

To enable keyboard shortcuts for your instance, see Configure Next Experience accessibility 
preferences.

To customize the Next Experience  keyboard shortcuts for your instance, see Customize the Next 
Experience keyboard shortcuts.

Learn more about Next Experience  keyboard shortcuts from the following tutorial:

https://player.vimeo.com/video/1080716309?
badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

The keyboard shortcut modal contains a search field which searches available keyboard 
shortcuts specific to the screen you're viewing. The available shortcuts are grouped by category: 
Page Action, Page Navigation, Global Navigation, and General.
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Keyboard shortcut modal

Common Next Experience  keyboard shortcuts

The most common key combinations for Microsoft  Windows  and macOS  keyboards are listed in 
the following table.

Common Next Experience  keyboard shortcuts

Action
Windows  keyboard 
shortcut

macOS  keyboard 
shortcut

Show the shortcuts for the page that you’re 
viewing in a modal

Control+/ Command+/

Compose an email Control+Alt+e Command+Option
+e

Create a new record Shift+Alt+n Shift+Option+n

Favorite or unfavorite the current page Control+Shift+f Command+Shift+f

Impersonate a user Control+Shift+i Command+Shift+i

Open the instance landing page Control+Alt+z Command+Option
+z

Open the instance toolbar to change domains Control+Alt+t Command+Option
+t

Refresh the list Shift+Alt+r Shift+Option+r

Save the record Control+s Command+s
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Next Experience  keyboard shortcuts for showing menus

The keyboard shortcuts for showing menus for Microsoft  Windows  and macOS  are listed in the 
following table.

Next Experience  keyboard shortcuts for showing menus

Open this menu
Windows 
keyboard 
shortcut

macOS 
keyboard 
shortcut

All menu Control
+Alt+a

Command
+Option
+a

Admin menu Control
+Shift+a

Command
+Shift+a

Favorites menu Control
+Alt+f

Command
+Option+f

Help menu Control
+Shift+/

Command
+Shift+/

History menu Control
+Alt+h

Command
+Option
+h

Workspaces menu Control
+Alt+w

Command
+Option
+w

Notifications menu Control
+Shift+k

Command
+Shift+k

Now Assist  menu (text entry mode) Alt+Shift
+a

Option
+Shift+a

Now Assist  menu (voice input mode)

Note: 
Availability of voice input mode in the Now Assist  menu is 
controlled by a user preference. For more information, see 
Configure Next Experience accessibility preferences.

Alt+Shift
+v

Option
+Shift+v

User profile menu Control
+Shift+u

Command
+Shift+u

Next Experience  keyboard shortcuts for applying focus

The keyboard shortcuts for applying focus for Microsoft  Windows  and macOS  are listed in the 
following table.
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Next Experience  keyboard shortcuts for applying focus

Apply focus
Windows  keyboard 
shortcut

macOS  keyboard 
shortcut

Global search Control+Alt+g Command+Option
+g

Main content of a page Control+Alt+p Command+Option
+p

Breadcrumb navigation Control+Shift+c Command+Shift+c

Side navigation page Control+Alt+1 Command+Option
+1

Workspace tab Control+Alt+2 Command+Option
+2

Page tab Control+Alt+3 Command+Option
+3

Record tab Control+Alt+4 Command+Option
+4

Contextual sidebar Shift+Alt+x Shift+Option+x

Activity Stream Compose text field Shift+Alt+c Shift+Option+c

First action button Shift+Alt+t Shift+Option+t

First field in the form Shift+Alt+f Shift+Option+f

First tile in the Activity Stream Control+Alt+x Command+Option
+x

Move focus forward through major elements of 
the page

Control+j Command+j

Move focus backward through major elements of 
the page

Control+Shift+j Command+Shift+j

Move focus through the headings of the form Shift+Alt+h Shift+Option+h

Additional Next Experience  keyboard shortcuts

Additional keyboard shortcuts for Microsoft  Windows  and macOS  are listed in the following table.

Additional Next Experience  keyboard shortcuts

Action
Windows  keyboard 
shortcut

macOS  keyboard 
shortcut

Open the instance toolbar to change 
domains

Control+Alt+t Command+Option+t

Open the Agent inbox Shift+Alt+i Shift+Option+i

Open the sidebar discussions chat Shift+Alt+d Shift+Option+d

Open the list search Shift+Alt+s Shift+Option+s

Open the list filter Shift+Alt+b Shift+Option+b
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Additional Next Experience  keyboard shortcuts  (continued)

Action
Windows  keyboard 
shortcut

macOS  keyboard 
shortcut

Open the OpenFrame window Shift+Alt+z Shift+Option+z

Cycle through the page layouts Shift+Alt+l Shift+Option+l

Expand/collapse the resizable pane Shift+Alt+p Shift+Option+p

Reply to the most recent email 
correspondence

Shift+Alt+e Shift+Option+e

Customize the Next Experience  keyboard shortcuts

Customize the Next Experience  keyboard shortcuts to streamline your workflow and boost 
productivity.

Before you begin
Role required: none

About this task
Learn more about customizing keyboard shortcuts from the following tutorial:

https://player.vimeo.com/video/1082927783?
h=3263013a03&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to User Menu  > Keyboard shortcuts.
The keyboard shortcuts modal opens.
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Keyboard shortcuts modal

2. Select Remap keyboard shortcuts.

3. Find an existing keyboard shortcut that you want to customize by either scrolling or entering 
text.

◦ Scroll vertically through the list of available keyboard shortcuts.

◦ Enter text into the Search  field to search through the entire list of available keyboard 
shortcuts.

Note: 
The pencil icon  appears for those keyboard shortcuts that are customizable. 
Currently, not all existing shortcuts are customizable.

4. Open the keyboard shortcut field for editing by selecting the pencil icon .

5. Enter the key combination that you want to use as the keyboard shortcut and select the green 
check mark to accept and save your entry.

Note: 
A keyboard shortcut must include at least one modifier and one letter. For example, 
Command + K.

Acceptance of new keyboard shortcut
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Note: 
The modal notifies you if you enter a key combination that is already in use.

Keyboard shortcut already exists message

6. Optional:  If you decide not to save your new shortcut, select X  or Close  to cancel.

7. Optional:  To restore all remapped keyboard shortcuts to their original values, select Restore 
Defaults.
A dialog box appears for you to confirm or deny this request.

Follow records in Next Experience

Get notified when a work note or comment is added to a record by following it in the classic 
environment in Next Experience.

Before you begin
Role required: none

About this task
Following a record in Next Experience  is more streamlined. You receive instant confirmation 
when you start following or unfollowing a record via a banner message and persistent alerts 
under the notifications menu for updates such as Work Notes and Additional Comments.

Procedure

1. Navigate to a record in the classic environment.

For example, navigate to All  > Incident  > Assigned to me  and select an incident to follow.

Note: 
Following records from within a workspace isn’t supported.

2. Select Follow.

Note: 
To stop receiving notifications about a record, select Following/Unfollow.

Result
When comments or work notes are added to the record, you receive notifications as banners 
and in the Notifications menu according to your notification preferences. You can select the 
notification to open the record that was updated.
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The following example shows a sample notification.

Related topics

Configure Next Experience notification preferences

Configuring the Next Experience  UI

Set up your ServiceNow  Next Experience  to drive productivity, improve engagement, and reveal 
insights across the ServiceNow AI Platform.

Select the following links to learn about Next Experience  functionality with the admin role and 
configuring the Next Experience  UI. Configuration of the Next Experience  UI is available only to 
users with the admin role.

Considerations for activating Next Experience

Next Experience  delivers a next generation, intuitive, personalized experience to drive 
productivity, improve engagement, and surface insights across the ServiceNow AI Platform. Your 
path to activating Next Experience  may depend on your instance's level of customization.

Guidance and support from the engineers who helped you customize your instance, or another 
certified partner, will help to ensure that your move to Next Experience  goes smoothly.

Note: 
You must have UI16 installed before activating the Next Experience.

New customer starting on the Zurich  release

If you're a new customer, you automatically have Next Experience  enabled and you don't need to 
modify the UI to get the newest user interface.

Existing customer upgrading instance without UI customization

If you're an existing customer, but haven't implemented UI customizations or invested 
significantly in adopting Workspace, the Next Experience  UI is turned on when you upgrade.

Existing customer upgrading instance with UI customization

If you're an existing customer who has made any of the following modifications to your instance, 
you might need assistance from the modification authors, or an established partner, to ensure a 
seamless activation.

• Customized your user interface. For example, if you created hard-coded styles or implemented 
UI scripts.

• Adopted a classic Workspace  and want to adopt a new configurable workspace  alternative.

• Created custom components in a classic Workspace  and want to adopt a new configurable 
workspace  alternative.
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You can use the following tools and APIs with your implementation partner to help adjust your 
customizations to work well with the new Next Experience  theme:

• Scriptable PolarisUI API

• Next Experience client scripting globals

• Jelly tags

Existing customer opting out of the Next Experience  UI prior to an upgrade

If you are an existing ServiceNow  customer and decide that you do not want to turn on 
the Next Experience  UI during an upgrade, you can create a system property called 
glide.ui.next_experience.opt_out  and set the value to true.

During the upgrade, the Next Experience  UI is not turned on.

Functionality not supported

Important: 

Connect Chat  is not available in Next Experience. Starting with Zurich, certain Connect Chat 
functions are available in Next Experience  by using Sidebar. See KB1123615 – Moving from 
Connect Chat to Sidebar  for more information about the differences between Connect 
Chat  and Sidebar.

Connect Support  is not available in Next Experience  and is scheduled to be completely 
deprecated in Utah. If you want to automatically assign chat requests and other work items 
to agents in Next Experience, you must migrate to Advanced Work Assignment  and Agent 
Chat. For details, see Move from Connect Support to Advanced Work Assignment and 
Agent Chat .

These features and products are not currently supported with Next Experience:

• The functionality found in homepages, arranging information from your instance to tell a story 
about your data, is found in dashboards on new instances. On upgraded instances with Next 
Experience  enabled, users can view existing homepages if they have a direct URL, but they 
can't create or edit them. Responsive dashboards and Analytics Center  dashboards take over 
homepage functionality.  Use the Homepage deprecation help tool  to convert the homepages 
on your instance to responsive dashboards.

• Live Feed  is not supported.

• The JavaScript console log isn't supported in the Next Experience  framework.

• ATF doesn't support these elements of Next Experience, but support for these features is 
planned for future releases:

◦ Pages built with UI Builder, including pages with lists and form components.

◦ Configurable Workspaces

◦ Landing pages

Note: 
ATF still supports the Core UI, including Classic Environment (such as classic lists and 
forms).

For more information, see:
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• KB1156736 – Moving from Connect Chat to AWA and Agent Chat

• KB1123615 – Moving from Connect Chat to Sidebar

• KB1157068 – Live Feed Is Not Supported in Next Experience

Enable Next Experience

How to enable or disable the Next Experience  UI.

Before you begin
Role required: admin

About this task
As an administrator, you can enable Next Experience  for all users on your Zurich  instance, or let 
users enable or disable unified navigation for themselves.

If you're a new customer running the Zurich  release, Next Experience  is enabled by default. If 
you're upgrading, see the information at Considerations for activating Next Experience  before 
you enable Next Experience.

Warning: 
It's not recommended that you enable or disable the Next Experience  UI until you've 
learned the impact of how that might affect your instance functionality. You might need 
assistance from the modification authors or an established partner to ensure a seamless 
activation.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

56

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1156736
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1156736
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1156736
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1123615
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1123615
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1123615
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1157068
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1157068
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1157068


Procedure

1. On login, the Turn on Next Experience  modal displays. 

2. Select Get started.

3. Read and determine if Next Experience  is for your 

users.

Note: 
Be aware that enabling the Next Experience  UI will affect all users on your instance, not 
just the system administrator.

Note also that if the admin is on a production instance, a warning appears to notify them 
of functionalities not supported in Next Experience.
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4. Select Turn on Next Experience.
A banner displays to notify you that Next Experience  is successfully turned 

on.

5. Log out and back into your instance.

6. To disable Next Experience  in your instance, do the following:

a. Navigate to sys_properties.list.

b. Set the value of the glide.ui.polaris.experience  property to false  to disable Next 
Experience.

c. Reload your instance.

Next Experience Readiness Checker

The Next Experience  Readiness Checker assists users with deciding whether to turn on Next 
Experience  after an upgrade.

About the Next Experience  Readiness Checker

The Next Experience  Readiness Checker tool enables admin users to examine their instance to 
see if agents and other users are currently using applications that aren’t compatible with Next 
Experience. Based on the usage found, the tool makes a recommendation regarding turning on 
Next Experience  immediately or doing additional due diligence before turning it on.

To access the Next Experience  Readiness Checker, navigate to Now Experience Framework  > 
Next Experience Readiness Checker.

Results

The Next Experience  Readiness Checker results section displays the application cards for each 
of the applications that are checked for compatibility with Next Experience. The applications that 
are checked are as follows.

• Guided Tours

• Connect Chat

• Connect Support

• Live Feed

• Follow

Descriptions are provided below each card that tell you whether your application is supported 
in the Next Experience, and also provides links to alternatives available for the applications that 
aren’t yet or no longer supported.

Current version

The Next Experience  Readiness Checker tool calls out the current version of your instance.
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Run Compatibility Scan

Note: 
These section options are dynamic based on the current instance version that you’re 
running. If applications are available for your version, links to the documentation are 
provided.

The compatibility scan examines your instance for usage of applications that 
aren’t compatible with Next Experience. Usages instances are displayed after 
running the scan, and shows the number of usages for each application. You can 
select the View usage list  link to navigate to a list of the usage records for your 
application. You can perform list capabilities such as creating favorites or grouping 

records.

If there are no errors, select the Turn on Next Experience  button to enable Next Experience.

Working with themes in Next Experience

Themes enable you to tailor the visual experience for your users, helping to update the look and 
feel to be more like your brand.

Quickly create, edit, preview, and publish themes to your experiences using Theme Builder. See 
Configure Next Experience with Theme Builder  for more information.

Important: 
Theming applies to the classic environment in Lists, Forms, and Dashboards. Custom 
components don't reflect theming.

Theming at a glance

• Theming is the ability to customize the Next Experience Design System  to reflect your product 
or brand.

• Theming means styling various aspects of the ServiceNow®  platform while maintaining the 
overall look and feel.

• Theming typically involves changing the colors to your company brand colors but can also 
include typography, imagery, shape and form.

Next Experience  default themes

New customers launching on Zurich will have the Next Experience  Coral theme enabled by 
default on their instance.

Existing customers upgrading from a previous release will continue to see the theme they've 
applied to their instance prior to upgrade, for example the Next Experience  Polaris theme or a 
theme created in Theme Builder. Use Theme Builder to publish Coral theme to your instance  or 
add Coral theme to the Next Experience UX Parent App Theme table.
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Next Experience  default themes

Theme record

This image shows the default Polaris theme, which is read-only. You create your own themes and 
styles to be used by experiences in your instance by either cloning the Polaris or Coral theme or 
by cloning a Theme Builder  theme record. If you clone either the Polaris or Coral theme, you also 
must clone the styles under UX Theme Styles and make changes to those styles, as desired. At 
least one Core type style must be defined.

Theme styles

You can configure a theme to match your company brand look and feel in ServiceNow. When you 
configure a theme, you adjust the color schemes, fonts, and images of your applications. On the 
Theme Builder  Theme form, you configure Order, Style, and Type settings.

Order

Style records with higher-order values override styles with lower values. The base 
system styles all have the order 0. If you meet the Applicability constraint, styles 
with higher values override the base system styles. If not, the lower-value style is 
used.
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https://player.vimeo.com/video/1137797867?
h=9ad8860991&badge=0&autopause=0&player_id=0&app_id=58479%22

Theme Builder  main features

• Create and manage Next Experience  themes for your mobile and web experiences without 
needing to write code.

• Customize the look of your core theme by creating alternate color palettes, enabling users to 
select a version that suits their preferences.

• Preview your changes in real time before publishing your theme and easily revert to your 
original colors, if needed.

• Publish multiple themes to your web experience and enable users to select the one that suits 
them best, improving the overall user experience.

• Apply branding changes, such as colors, logos, and typography, across your instances.

• Use the Accessibility Inspector to verify sufficient contrast for text and backgrounds, which 
helps to comply with accessibility standards while enhancing user experience.

Theme Builder  includes an option on the home page that you can use to provide feedback to 
ServiceNow®  about your experience with the current product. All feedback is reviewed and may 
be used to improve the product.

Theme Builder  Home page

• Provides an introductory overview of Theme Builder

• Offers a Create a theme  option to begin the theme creation process

Theme Builder  Manager page

• Displays all themes created using Theme Builder

• Enables adding alternate color palettes to existing themes

• Enables publishing or unpublishing your themes to your experience
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Theme Builder  Editor page

• Customize your themes in the Editor page, including color palette customization, logo, 
typography, shape adjustment, and component editing

• Offers real-time preview of theme changes

Guided tours in Theme Builder

Learn about Theme Builder  guided tours, including how to access and take them to build your 
knowledge of Theme Builder.
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What guided tours are

Guided tours are part of the default ServiceNow AI Platform. There are tours available to take and 
you can use the Guided Tours  application to create custom tours yourself in your own instances.

Tours contain interactive steps to help train and teach users. Some tours show various features 
in the user interface, such as an overview of a homepage. Other tours help complete a task, such 
as creating an experience or previewing an experience page. For more information about what 
guided tours are and how to create them, see Exploring Guided Tours.

How to access and use Theme Builder  guided tours

Guided tours about Theme Builder  may launch automatically from the Editor page. You can also 
start them manually from the Editor page.

When a guided tour starts automatically, an introduction is displayed. Select Get started.

Guided tour modal

To begin a tour manually, navigate to the Editor page and select the Show guided tours icon  in 
the banner. From there, select which guided tour you prefer.

Guided tour selection modal

After a tour starts automatically or manually, you're led through a series of steps. Read the text for 
each step and perform the required actions or select Next  to continue the tour.
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To stop a tour at any time, select Skip tour  on a tour step. At the end of the guided tour, select 
Done.

Dark mode in Theme Builder

Learn how to switch to dark mode in Theme Builder.

Theme Builder  includes a dark mode option, offering an eye-friendly alternative to the default 

light mode. You can enable dark mode by selecting the Choose theme icon  in the banner.

Note: 
Dark mode applies to the Theme Builder  interface only and does not affect the appearance 
of individual themes.

Theme Builder  display mode options

Create a theme with Theme Builder

Create a theme record for your web or mobile experiences by using the Home view in the Theme 
Builder  application.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.
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Theme Builder  Home screen

2. Select Create a theme.

Note: 
If your instance uses Zurich Patch 7, the wizard starts immediately after selecting Create a 
theme.

The Before we get started wizard appears to guide you through your brand configurations, as 
described in the next steps. The theme record is saved automatically as you work.

Before we get started wizard
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3. Start defining your new theme by selecting Continue.

4. Enter the name and a description of your new theme, and select Next.

5. Select the Primary  tile, select your brand’s primary color, and review the simplified preview to 
see where the selected color displays in your instance.

Note: 
In the Color Name dialog box, you can select the color model that you prefer: HEX, RGB, 
or HSL.

6. After you identify the primary color of your brand, select Apply, and then select Next.
If your instance uses Zurich Patch 7, select your secondary color on the same screen before 
selecting Next. In ZP7, only primary and secondary brand colors are required.

7. If your brand includes a secondary color, repeat the previous step on the secondary color 
screen.

8. Repeat the previous step to define a neutral brand color for divider lines and surface 
containers.

9. Optional:  Choose additional colors for your brand and select Next.

10. Upload your brand logo and review the simplified preview to verify that it appears as expected 
with the primary color you chose, and then select Next.

Note: 
If you don’t add a logo, the ServiceNow logo is used.

11. Select the preferred font for your text and select Next.

12. Select the corner shape of your components in the interface, such as the buttons, modals, and 
drop-down menus, and select Next.

13. Review your selections and select Create theme.

Note: 
You can select Back  to make changes in the wizard before selecting Create theme. After 
creating a theme, any edits you make are automatically saved.

If your instance uses Zurich Patch 7, you can edit any part of the theme from this screen.

After creating your theme in the wizard, you’re directed to the Editor view of the theme where 
you can continue modifying  or publish your theme.

Theme creation with AI

Use AI to generate themes from images directly in Theme Builder  or from the Now Assist  panel. 
This feature is available for instances running Zurich Patch 7 or later.

Configuring Theme Builder  AI theme creation

The requirements for AI theme creation depend on where you start the workflow.

In order to start using AI theme creation from within Theme Builder, you must install Now Assist 
for Creator. See Install Now Assist for Creator . After you have installed Now Assist for Creator, 
see Create a theme with AI in Theme Builder.

In order to start using Theme Builder  AI theme creation workflow from the Now Assist  panel, you 
must install Now Assist for Creator  and turn on the Theme Creation Workflow in AI Agent Studio. 
For more information, see Turn on theme creation workflow for use in the Now Assist panel. After 
you have enabled the Theme Creation Workflow, see Create a theme using Now Assist.
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Turn on theme creation workflow for use in the Now Assist  panel

Turn on the theme creation workflow to generate themes using the Now Assist  panel.

Before you begin
Install the Now Assist for Creator application. See Install Now Assist for Creator .

Turn on the Now Assist  panel. See Activate the Now Assist panel standard chat

Role required: admin

About this task
This workflow is required to use the AI feature within the Now Assist  panel.

Important: 
The theme creation workflow requires a separate subscription to Now Assist for Creator.

Procedure

1. Navigate to All  > AI Agent Studio  > Overview.

2. Select the Theme Creation Workflow  card.

3. From the Agentic workflow table, select Theme Creation Workflow.

4. Choose Select channels and status.

5. Turn on Engage via the Now Assist panel.

6. Activate the theme workflow by selecting Test.
The workflow is enabled in the Now Assist  panel.

What to do next
Create a theme using Now Assist.

Create a theme using Now Assist

Use Now Assist  to generate themes from your brand image or brand guidelines. This AI-powered 
workflow extracts color palettes automatically, creating visually consistent themes without 
requiring brand color codes.

Before you begin
This feature requires:

• Now Assist for Creator  installed. See Install Now Assist for Creator

• A theme creation workflow enabled in AI Agent Studio. See Turn on theme creation workflow 
for use in the Now Assist panel.

• Now Assist  panel turned on. See Activate the Now Assist panel standard chat .

Roles required:

• admin

• now_assist_panel_user

Procedure

1. Select the Now Assist  sparkle icon  to display the Now Assist  panel.

2. In the chat window, enter Create a theme.

This triggers the AI-enabled Theme Builder  workflow.
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Now Assist  panel

3. Select Yes  when prompted to proceed.

4. Select Show  to open the theme creation wizard.

Launch theme creation wizard

5. Enter your theme name and a description, then select Next.

6. Choose how to define your theme colors.

Generate theme colors using AI or manual selection
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7. If you chose to upload a brand image or brand guidelines file, generate your theme colors 
using AI.

a. Upload your brand image or brand guidelines file.
Supported formats for image files are JPEG, JPG, PNG, and SVG with a maximum size of 
20 MB. Supported formats for brand guidelines are PDF with a maximum size of 20 MB. 

b. Select Generate Palette.

c. Review the AI generated primary and secondary colors, then use the simplified preview to 
see where the colors appear in your instance.

d. Optional:  Modify the palette by selecting either the Primary or Secondary tile and select the 
add (+)  button or choose from the AI-generated supporting colors.

Note: 
The AI detects up to eight colors from your image, with the two most dominant pre-
selected as the primary and secondary. Any additional detected colors are suggested 
as available options that you can swap in as needed.
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e. Optional:  Choose a new color from the color selector and select Apply.

f. Optional:  Select back  to return and choose a different image or to handpick your colors.

g. Select Next.

8. If you selected Handpick my colors, define your theme colors manually.
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a. Select the Primary tile and choose your brand’s primary color from the color selector or enter 
a value using HEX, RGB, or HSL.

Your brand's primary color

b. After you identify the primary color of your brand, select Apply.

c. Select the Secondary tile and choose your brand’s secondary color from the color selector.

d. Select Apply.

e. Optional:  Select Generate with AI instead  to return to the AI-generated palette step.

f. Select Next.

9. Upload your brand logo, confirm it appears correctly in the preview, and select Next.
If you don’t add a logo, the ServiceNow  logo is used.

10. Select the preferred font for your text and select Next.

11. Select the corner shape of your components in the interface, such as the buttons, modals, and 
drop-down menus, and select Next.

12. Review your selections and make any changes, if needed.
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Theme details and final preview before creation

13. Select Create theme.

Note: 
Themes aren't saved until Create theme  is selected. Leaving the chat or restarting the 
workflow discards the theme.

14. Select Personalize your theme  to customize or publish your theme from Theme Builder.

Result
Your theme is saved as a draft in Theme Builder  and appears in the Unpublished section of the 
Manager page.

What to do next
Customize and publish your theme in Theme Builder. See Manage or edit a theme with Theme 
Builder[Publish a theme] and Publish your themes with Theme Builder.

Create a theme with AI in Theme Builder

Use an AI-powered theme creation from within Theme Builder  to generate themes from brand 
images, preview, and refine results all within the updated Create a theme wizard.

Before you begin
This feature requires:

• Now Assist for Creator  installed. See Install Now Assist for Creator .

Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.
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Theme Builder Home screen

2. Select Create a theme.
The Create a theme wizard appears to guide you through your brand configurations, as 
described in the next steps.Your selections are saved automatically as you progress through 
the wizard.

3. Enter the name and a description of your new theme, and select Next.

4. Choose how to define your theme colors.

Generate theme colors using AI or manual selection

5. If you chose to upload a brand image, generate your theme colors using AI.
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a. Upload your brand image.
Supported formats are JPEG, JPG, PNG, and SVG with a maximum size of 1 

MB.

b. Select Generate Palette.

c. Review the AI generated primary and secondary colors, then use the simplified preview to 
see where the colors appear in your instance.

d. Optional:  Modify the palette by selecting either the Primary or Secondary tile and select the 
add (+)  button or choose from the AI-generated supporting colors.

Note: 
The AI detects up to eight colors from your image, with the two most dominant pre-
selected as the primary and secondary. Any additional detected colors are suggested 
as available options that you can swap in as needed.
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e. Optional:  Choose a new color from the color selector and select Apply.

f. Optional:  Select back  to return and choose a different image or to handpick your colors.

g. Select Next.

6. If you selected Handpick my colors, define your theme colors manually.
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a. Select the Primary tile and choose your brand’s primary color from the color selector or enter 
a value using HEX, RGB, or HSL.

Your brand's primary color

b. After you identify the primary color of your brand, select Apply.

c. Select the Secondary tile and choose your brand’s secondary color from the color selector.

d. Select Apply.

e. Optional:  Select Generate with AI instead  to return to the AI-generated palette step.

f. Select Next.

7. Upload your brand logo, confirm it appears correctly in the preview, and select Next.
If you don’t add a logo, the ServiceNow  logo is used.

8. Select the preferred font for your text and select Next.

9. Select the corner shape of your components in the interface, such as the buttons, modals, and 
drop-down menus, and select Next.

10. Review your selections and select Create theme.
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Note: 
From this screen, you can edit any part of the theme before selecting Create theme. After 
the theme is created, any changes you make are automatically saved.

Theme details and final preview before creation

Result
Your theme is saved as a draft in Theme Builder  and appears in the Unpublished section of the 
Manager page.

What to do next
After creating your theme in the wizard, you are directed to the Editor view of the theme where 
you can continue modifying  or publish your theme.

Manage or edit a theme with Theme Builder

Customize and manage your theme and styling in a time and cost efficient way. After 
customizing, publish your new theme to either a web or mobile implementation of your instance.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.
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Page menu

2. From the Home page view, select Manager page view to see all available themes.

From the Manager page view, you have the choice of viewing existing themes in two ways. You 
can choose the Grid view or the List view.

Note: 
In both the Grid and List views, your published and unpublished themes are grouped 
separately. The published themes are themes that appear in the user's theme preference. 
View your web and mobile themes by selecting either the Web  or Mobile  button.

Grid view
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List view

Use the More actions icon on a published theme to access these options:

◦ Duplicate: creates a copy of the theme for reuse or modification.

◦ Delete: permanently removes the theme from your list.

◦ Add alternate color palette: applies a different color scheme to the theme for variation.

◦ Unpublish: removes the theme from active use without deleting it, so you can edit or 
republish later.

◦ Mark as default: sets the theme as the first option shown in the Next Experience  Theme user 
preference. This option appears if the theme isn’t the current default theme.

Use the More actions icon on a published theme with an alternate color palette defined to 
access these options:

◦ Edit group name: renames the theme group, which includes the base theme and all its 
alternate color palettes.

◦ Duplicate: creates a copy of the theme for reuse or modification.

◦ Delete: permanently removes the theme from your list.

◦ Unpublish: removes the theme from active use without deleting it, so you can edit or 
republish later.

◦ Mark as default: sets the theme as the first option shown in the Next Experience  Theme user 
preference. This option appears if the theme isn’t the current default theme.

Use the More actions icon on an unpublished theme to access these options:

◦ Duplicate: creates a copy of the theme for reuse or modification.

◦ Delete: permanently removes the theme from your list.

◦ Add alternate color palette: applies a different color scheme to the theme for variation.

◦ Publish: makes the theme available for use.

3. Choose the theme you want to edit using one of the following ways.
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Note: 
When you select the theme you want to work on, verify that you selected the correct 
scope for the theme from the application scope picker.

Application Scope Picker

4. Review and update the Global styles, as needed.

Global styles overview
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Note: 
The following style records are generated with your theme:

◦ Your brand palette: Update the interface colors for your brand. For more information, 
see Edit your theme colors.

◦ Logo: Update the logo. You can upload the logo during the theme application from the 
Overview page. For more information, see Upload a new logo to your Theme Builder 
theme.

◦ Typography: Update the fonts applied globally to your experience. The fonts are used 
in headlines, titles, subtitles, body text, and captions. For more information, see Edit 
your default font.

◦ Shape: Update the corner shapes of on-screen components. For more information, see 
Edit corner shapes.

5. Optional:  Preview your theme before publishing.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview

An actual live instance appears with all the theme selections applied. You can preview it 
before implementing the selected themes on the actual instance.

Note: 
For published themes, data in the Experience preview is live data. The changes that 
you make in the preview are reflected on your instance.

6. Publish your theme.
For more information, see Publish your themes with Theme Builder.

Core styles, colors, variants, and alternate color palettes

You can tailor the look and feel of the Next Experience  UI for different users by configuring the 
core styles, variants, and alternate color palettes.

Core styles in Theme Builder

A core style is the base version of a style. Core styles include color, shape and form, typography, 
and imagery.
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Colors in Theme Builder

When editing components, use the color picker to change the background color of the canvas to 
view how the component colors will render on different backgrounds.

Note: 
Updating the canvas color doesn't apply to the instance. Only hooks specific to 
components are applied on the instance if you publish an edited theme to the instance.

When editing theme colors, you can view the contrast ratio in the color picker. The value updates 
when you change the color from the palette or My colors view.

Variants/Alternate color palettes in Theme Builder

Both variants and alternate color palettes are types of UX style records categorized as Variant.

A variant is an alternate version of an existing theme, usually designed for accessibility, that your 
users can select in preferences. An example of a variant is the Dark version of the default Polaris 
or Coral theme that is shipped with Next Experience. The Dark variant can be used to enhance 
accessibility for visually impaired users by replacing light backgrounds with darker ones and 
contrasting the text colors accordingly.

An alternate color palette is a modification that you can make to a theme's colors and is designed 
for cosmetic purposes. Alternate color palettes allow users to toggle between different visual 
styles like light and dark options without affecting the core theme. You can define this palette in 
the Theme Builder  Manager page for any theme, except for the default Polaris or default Coral 
themes. When you use an existing theme to create an alternate color palette, the alternate color 
palette is grouped with that primary theme, and initially shares its logo, color, typography, and 
shape styles. At first, the only difference from the primary theme is that you assign it a unique 
name.

Next, you define the primary color for the alternate color palette. This color is used to identify the 
navigation bar, menus, and other common components. Likewise, define a secondary color, if 
needed. If your interface doesn't require a secondary color, the primary color is used. Lastly, you 
define a neutral color to help define divider lines and containers. There are two base palettes 
available, light and dark.

Note: 
Secondary and neutral colors cannot be edited in the dark alternate color palette.

When the palette is created using the colors you selected, you have the option of renaming it. 
You can preview all the UI assets available on the ServiceNow AI Platform  to visualize how they 
are rendered when you apply them to your instance.

Note: 
Dark variants don’t apply to the Core UI, previously referred to as UI16. The Core UI  is the 
interface you use if Next Experience  is inactive. However, dark variants extend to most 
aspects of the Next Experience.

Add an alternate color palette

Customize a Theme Builder  theme by creating an alternate color palette for the theme and 
publishing it to your instance.

About this task
An alternate color palette enables you to create additional color schemes beyond the primary 
theme colors.
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Before you begin
Role required: admin

You can also watch a short video on how to create an alternate color palette.

https://player.vimeo.com/video/1156505216?
h=0b19f39277&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page displays in the Home page view.

Page menu

2. From the Home page view, select the Manager page view to see the themes you have created.

Important: 
When you have selected the theme you want to work on, verify that you have selected the 
correct scope for the theme from the application scope picker.
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Available published themes

3. Select the theme to which you want to add an alternate color palette to.

◦ For published or unpublished themes without an alternate color palette already 

defined, select the More actions icon ( ), and select Add alternate color 

palette.

◦ For a published or unpublished theme group, which has alternate color palettes defined, 
navigate to the Edit drop-down list and select Add an alternate color palette.

The alternate color palette wizard appears.
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4. Enter a Theme group name  and the Color Palette name, then choose from either Light Palette 
or Dark Palette.

5. Select Create color palette.

Note: 
The alternate color palette uses the same font, shapes, and logo as the primary theme. To 
edit those styles, edit the primary theme.

The Editor page for the current palette appears.

6. Optional:  On this screen, perform the following actions:

◦ In the Color palette name  field, change the color palette name.

◦ Select any of the three brand colors defined in this palette and change them from the color 
picker.

Note: 
For dark palettes, only the primary color can be edited. If you want to customize further, 
see Edit components.
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Result
The alternate color palette is added to your primary theme. The theme name now 
appears as a theme group with the palette recorded under the Color palette drop-down 

list.

If your theme is currently published, your alternate color palette is available for selection in the 
user's Theme preferences. For information on publishing your theme, see Publish your themes 
with Theme Builder.

Working with Global styles

Global styles enable you to edit and define core design elements like fonts, colors, and shapes 
that apply across your entire theme.

The Global styles panel is the central workspace for defining the foundational visual elements 
of your theme. It enables you to configure and preview key design tokens such as color palettes, 
typography, shape and form, and imagery that apply consistently across your entire experience.

The Global styles panel contains five tabs:

• Overview: Displays a snapshot of your theme's current settings for each core style category.

• Color: Define the primary, secondary, and neutral color palette for the theme. Automatically 
generated UI colors can be customized as needed.

• Imagery: Upload and configure logos for headers, login screens, and other branded areas.

• Typography: Update the fonts applied globally to your experience. The fonts are used in 
headlines, titles, subtitles, body text, and captions.

• Shape: Update the corner shapes of on-screen components.
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Edit your theme colors

Edit and update your theme's core colors to create visual consistency and align with your brand.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.

Editor page view

4. Under the Global styles  tab, select the Color palette icon  to access the color options.
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Global styles panel with Color tab selected

a. Update your brand colors by selecting either Primary, Secondary, or Neutral, then use the 
color picker to select another color.

b. Add additional brand colors, if needed.

Note: 
Additional brand colors are supporting colors and by default aren’t tied to any 
components.
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c. Update any auto-generated UI colors using the drop-down list next to each UI element, if 
needed.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. Select the Remove override symbol to revert your changes back to the 
original auto-generated colors.

Result
If your theme is published, your edits are visible to users who have your theme applied on 
refresh. For information on publishing your theme, see Publish your themes with Theme Builder.

Edit corner shapes

Edit and change the corner shapes applied globally to components such as buttons, modals, 
and drop-down menus throughout your Theme Builder  theme.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.
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Editor page view

4. From the Overview panel, navigate to the Shape section and select the current shape listed in 
the Corners  field.

Overview panel Shape section

Note: 
You can also change the shape directly from the Shape panel.

Shape panel

5. Select a new corner shape from the list of predefined shapes.
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Pick a corner shape modal

Note: 
Use the preview pane within the modal to view how the components look for each corner 
shape you select.

6. Select Save.

Result
If your theme is published, your edits are visible to users who have your theme applied on 
refresh. For information on publishing your theme, see Publish your themes with Theme Builder.

Edit your default font

Edit your default font family and choose from the predefined options in Theme Builder  or your 
own custom fonts.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

92



Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.

Editor page view

4. From the Global styles Overview panel, navigate to the Typography section and select the 
current font listed in the Default font family  field.

Overview panel Typography section
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Note: 
You can also change the font directly from the Typography panel.

Typography panel

5. Select a new font from the list of fonts.

Pick a default font modal

Note: 
Use the preview pane within the modal to view the font face variations of each font. Your 
uploaded custom fonts also appear as selectable options in the modal.

6. Select Save.

Result
Your new font is displayed as the Default font family and applied globally to your theme. If you 
want to upload a custom font, see Upload a custom font to your theme.

If your theme is published, your edits are visible to users who have your theme applied on 
refresh. For information on publishing your theme, see Publish your themes with Theme Builder.
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Upload a custom font to your theme

Upload and preview up to 10 custom font families and an unlimited number of associated font 
faces in your Theme Builder  theme.

Before you begin
Role required: admin

About this task
A font family is a grouping of fonts that share a common design and may include different font 
faces, like regular, bold, or italic. For example, Ariel is a font family and within the Ariel font family 
you may find font faces such as Ariel Regular, Ariel Bold, and Ariel Italic.

Upload only one font family at a time. Theme Builder  does not yet support variable type fonts.

Important: 
Only upload a font that you’re licensed to use. Depending on their size, custom fonts can 
inadvertently adjust the amount of text on the page. Always test and preview your fonts 
before publishing your theme to your instance.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.
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Editor page view

4. From the Overview panel, navigate to the Typography section and select Add custom font 
family.

Overview panel Typography section

Note: 
You can also upload a font directly from the Typography panel.

Typography panel

The Add custom font family modal appears.

5. Use one of the following options to upload your custom font family:

◦ Select Browse, choose your custom font family file from your computer's file browser, and 
select Open.

◦ Drag your custom font file from your computer's file browser and drop the file directly into the 
modal.
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Note: 
Make sure that the font family file meets the following guidelines or the file isn't saved.

◦ Under 2 MB

◦ WOFF, TTF, or ZIP format

Add custom font family modal with size and format limitations

6. Optional:  Use the arrow within the modal to view any font faces you have uploaded with your 
custom font family.

Note: 
Font faces can be applied individually to components, while the font family is applied 
globally.
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Add custom font family modal preview pane

7. Select Save.
Your new font family appears in the Typography section under Manage custom fonts, along 
with the associated font faces.
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Typography section with Custom font family listed

8. Optional:  Preview how your selected font family or font face appears using any of the 
following options.

◦ Use the UI styles preview  or Experience preview  tabs on the main stage to view how your 
new font appears globally throughout your theme.

◦ Open the preview modal by selecting the custom font family or font face name that you want 
to preview listed beneath the Manage custom fonts  header.

Result
Once you have uploaded your custom font, you can select it as your default font and apply it 
to your theme. For information, see Edit your default font. The most recently added font family 
appears at the bottom of the Manage custom fonts  list.

Add a font face

Add a new style such as bold or italic to your custom font family in Theme Builder.
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Before you begin
Role required: admin

Note: 
Upload a custom font family before adding individual font faces. This ensures each style is 
correctly grouped under its font family.

About this task
Font faces are applied individually to components, as needed. Theme Builder  does not yet 
support variable type fonts.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.

Editor page view

4. Under Manage custom fonts, locate and expand the font family where you want to add a font 
face.

Note: 
You can also add the font face directly from the Typography panel.
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Global styles Topography panel

5. From the Add font face  field, select the Plus sign.

Add font face

The Add font face modal appears.

6. Select Browse, choose your font face file from your computer's file browser, and select Open.
Alternatively, drag your font face file from your computer's file browser and drop the file directly 
into the modal.

Note: 
Make sure that the font face meets the following guidelines or the file isn’t saved.

◦ Under 2 MB

◦ WOFF, TTF format

7. Select Save.
The new font face is displayed under your custom font family.

Result
Now that you have added a font face, you can apply it to individual components for more precise 
styling. For information on deleting a font family or font face, see Delete a custom font from your 
theme.

Delete a custom font from your theme

Delete and remove a custom font family or font face you no longer need from your Theme Builder 
theme.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.
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Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
The Global styles  tab opens automatically with the Overview panel displayed.

Editor page view with custom font listed

4. Select the custom font family or font face that you want to delete listed beneath the Manage 
custom fonts  header.
The View custom font family  or View font face  modal appears.

5. Select Delete.
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Custom font family preview modal with delete option

Your font family or font face is no longer displayed.

Note: 
Deleting the last remaining font face removes the entire font family. If your custom font 
is your default font, then the default font automatically reverts to Source Sans Pro. If you 
delete a custom font family that is used for theming your components, Source Sans Pro is 
applied. If you delete a font face that is used for theming your components, the first font 
face of that font family is used. If none remain, Source Sans Pro Regular is applied.

Upload a new logo to your Theme Builder  theme

If you previously applied a custom or default ServiceNow  logo to your theme during theme 
creation, you can upload a new one in Theme Builder.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit.
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The Global styles  tab opens automatically with the Overview panel displayed.

Editor page view

4. From the Overview panel, navigate to the Logo section and select the upload icon  listed 
beside the Logo  field.

Note: 
You can also change the logo directly from the Imagery panel.

Imagery panel

The Upload logo modal appears.

5. Use one of the following options to upload your logo:

◦ Select Browse, choose your logo file from your computer's file browser, and select Open.

◦ Drag your logo file from your computer's file browser and drop the file directly into the modal.
Make sure that the logo meets the following guidelines or the file isn’t saved.

◦ No larger than 400 x 50 pixels

◦ Under 120 KB

◦ SVG, PNG, or JPG format
Your new logo displays within the preview pane of the modal.

6. Optional:  Use the UI styles preview  or Experience preview  tabs on the main stage to view 
how your new logo appears throughout your theme.
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UI styles and Experience preview tabs

7. Optional:  Select the undo icon  to delete your logo, if needed.
If you delete your logo, the ServiceNow  logo is used.

Resize a logo for your login screen

After you have uploaded a logo for your login screen, you can resize the logo by creating and 
setting a system property.

Before you begin
Role required: admin

Procedure

1. In the Unified Navigation  All menu, enter sys_properties.list  and press Enter.

Unified Navigation  All menu

The entire list of properties in the System Properties [sys_properties] table appears.

2. Add a system property  called glide.ui.polaris.login.logo.height.

3. Set the system property Value  to the maximum CSS height value for your logo.
For example, any of the following would be valid entries:

◦ 150px

◦ 6em

◦ 75%

◦ auto

If you select auto, the browser calculates a height for the specified element.

Note: 
An entry of 100% returns the logo to its original size.
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4. Save the system property.
At the next launch, your logo is resized based on how you configured the system property.

Working with Component styles

Component styles enable you to fine-tune the appearance of individual UI elements such as 
buttons, form controls, and navigation.

The Component styles panel provides control over how specific elements like buttons, inputs, 
and navigation items look and behave across different states such as hover, focus, and disabled. 
This panel enables tailoring the look of specific UI elements without affecting the broader theme.

A search and filter bar at the top of the panel lets you narrow down components by name or 
category.

Each component is represented as a tile and grouped by function such as Navigation, 
Messaging, Forms. Selecting a component tile opens a side panel with editable properties for 
that component and its subcomponents.

Component styles panel

Preview components

As you’re creating or managing your theme, you can preview the components available for 
inclusion on your instance.

Before you begin
Role required: admin

About this task
The components you can preview in Theme Builder  were created in the Now Design System. For 
more information, see Next Experience Components  on the ServiceNow  Developer Site.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page displays in the Home page view.

2. Use the Page  drop-down list to select the Editor page view.
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Page drop-down list

3. From the Theme drop-down list, select the theme that you want to view components for.

4. Select the Component styles  tab.
The component styles are graphically listed.

5. You can scroll through the list to view all available components, or filter the list to view specific 
types of components.
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a. Select the Filter icon .

b. Expand the categories of components that you want to view and select the specific 
components within those categories you want to view.

Note: 
For example, to view components for all primary buttons, open the Actionable  category 
then expand the Button  component list. Select the Primary, Primary positive, and 
Primary negative  components. The list shows the components that you selected.

6. To test how the components render using different background colors, select the Canvas color 
check box.

7. Select the Background color  you want to view and select Apply.
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Canvas color

What to do next
After previewing and selecting the desired components, edit their properties to fine-tune their 
appearance. For more information, see Edit components.

Edit components

Edit Theme Builder  individual components to better suit your brand and to meet accessibility 
conformance standards. The theme hooks that you can edit are specific to each type of 
component.

Before you begin
Role required: admin

About this task
The components that you can edit in Theme Builder  were created in the ServiceNow AI Platform 
Design System. For more information, see Next Experience Components  on the ServiceNow 
Developer Site.

For instructions on editing the Unified Navigation  component, see Align with your brand by using 
the Unified Navigation component.
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The total number of accessibility violations is indicated on the red numbered badge icon 
alongside the Accessibility inspector panel.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page displays in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Page drop-down list

3. From the Theme drop-down list, select the theme that you want to edit components for.

4. From the Editor page view, select the Component styles  tab.
The component styles are graphically listed.

5. Select the Editing  tab.

Note: 
The components that can be edited are displayed. For information on how to filter the list 
of components to locate the component you want to edit, see Preview components.

6. Select the component that you want to edit to access the Configurable Style panel.
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When you’re looking at the components listed in the Editing page, notice that some 
components may display the following symbol.

Note: 
The accessibility warning symbol indicates that the color contrast of the selected 
component doesn’t adhere to Web Content Accessibility Guidelines (WCAG) 2.1 
accessibility standards for color contrast. For information on editing components with 
accessibility violations, see Adjust a component to meet accessibility standards.

7. From the Configurable style panel, edit the theme hooks that are available for the selected 
component, as needed.

Configurable style panel

The editable theme hooks that are available depend on the type of component you selected. 
For example, if you select a Badge component, you can edit the colors and accessibility hooks 
for the badge. If you select a Text link component, you can edit the base color and accessibility 
hooks.

Note: 
After you update the component-specific hooks, any changes that you make from global 
styles won't affect your component edits. Component-specific styles take precedence 
over globally defined styles.
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8. If you select a color to be edited, the color picker opens.

Color picker

Note: 
By default, the color picker shows all the available colors for the component. Use the My 
Colors  tab to select from a predefined list of colors or choose the Custom  tab to select 
the specific color model that you prefer: HEX, RGB, or HSL.

9. When you have completed your color changes, select Save changes.

10. If you select a shape to be edited, use the selector modals to choose border width and corner 
radius.

11. When you have completed your shape changes, select Save changes.

12. If you select a font family or font face to be edited, the selector modal opens.
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Edit font family modal

Note: 
If you have uploaded a custom font, it will appear in the modal for selection. You can 
also upload a custom font directly from the selector modal making it available for use 
throughout your theme. For more information, see Upload a custom font to your theme.

13. When you have completed your font changes, select Save changes.

14. Optional:  Select the undo icon  to revert your font to Source Sans Pro, if needed.

15. Access the Component Editor where you can style various aspects of a component by using 
one of the two ways listed:

◦ Double-click the component tile.

◦ Select either the Style interactions, Style subcomponents, or Style variants  button within 
the configurable styles panel, depending on what is available for that specific component.
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Note: 
Not all components contain editable parts.

Component Editor

16. From the Component Editor, choose the interaction, variant, or subcomponent of the selected 
component, then edit the available theme hooks.

Note: 
After you save the changes to any of the color hooks, a Remove override symbol appears. 
The Remove override symbol enables you to revert your color changes back to the 
original auto-generated colors.

17. Optional:  Return to the Component Overview screen using the links within the navigational 
path.

Component editing breadcrumb navigation

Result
If your theme is published, your component edits are visible to users who have your theme 
applied on refresh. For information on publishing your theme, see Publish your themes with 
Theme Builder.
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Align with your brand by using the Unified Navigation  component

Align your experience more closely with your brand by editing the Unified Navigation  component 
and its subcomponents.

Before you begin
Role required: admin

About this task
The Unified Navigation  component is made up of several subcomponents that you must style 
individually. In the Theme Builder  5.0 release, editing of the Unified Navigation  is limited to the 
header and menus, although some styling may apply to all aspects of the Unified Navigation 
component and subcomponents.

Procedure

1. Navigate to All  > Now Experience Framework  > Themes  > Theme Builder.

2. From the Page drop-down list, select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit the Unified Navigation 
component for.

4. Select the Component styles  tab.

5. Select the Editing  tab.

6. Filter the list to view the Unified Navigation  component.
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a. Select the Filter icon ).

b. Expand the Navigation category and select the Unified Navigation  component.

Unified Navigation  component

7. Access the Component Editor where you can style various aspects of the Unified Navigation 
component by using one of the two ways listed:

◦ Double-click the Unified Navigation  component tile.

◦ From the Unified Navigation  editing panel, select Style subcomponents.

Unified Navigation  editing panel

8. Select the Header  or Menu  tile to open the configurable styles panel where you can edit the 
available theme hooks.
The editable theme hooks that are available depend on the type of subcomponent that 
you have selected. For example, if you select a Header subcomponent, you can edit the 
background colors for the Header. If you select a Menu subcomponent, you can edit the 
background, text, and icon colors.
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Note: 
After you save the changes to any of the color hooks, a Remove override symbol appears. 
Select the Remove override symbol to revert your changes to the original auto-generated 
colors.

9. Double-click the Header  or Menu  tile or select Style subcomponents  to edit the available 
subcomponents.
A Subcomponent is a smaller piece of a larger component. For example, the Unified Navigation 
Header or Menu subcomponent is a smaller piece of the Unified Navigation  component. 
An interaction describes the different ways the component or subcomponent behaves. For 
example, the Default or Hover interactions are interactions of the Menu Trigger subcomponent.

Unified Navigation  Header subcomponent editing options

10. Continue editing each subcomponent and interaction until you complete styling the Unified 
Navigation  component.
For example, after you double-click the Header Menu Trigger subcomponent, the interactions 
of the Menu Trigger are available for styling. Likewise, if you double-click the Menu 
subcomponent, the subcomponents and interactions for each menu are available.

Note: 
The canvas color feature automatically applies the background color from the parent 
subcomponent.

11. Optional:  When editing certain subcomponents, such as the Menu, choose which 
configuration you want to preview.
For example, when editing the Menu subcomponent, after you select Component config, 
you can select the specific menu that you want to edit from the Type drop-down list. After you 
select the desired menu, all available subcomponents for that particular menu are listed.
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Component config menu

12. Optional:  To return to a previous component editing screen, select one of the breadcrumb 
links.

Component editing breadcrumb navigation

Result
If your theme is published, your Unified Navigation  edits will be visible to users who have your 
theme applied upon refresh. For information on publishing your theme, see Publish your themes 
with Theme Builder.

Adjust a component to meet accessibility standards

Adjust a component to meet the Web Content Accessibility Guidelines (WCAG) 2.1. When 
you're editing a component in Theme Builder  and see a warning symbol, that indicates that the 
component doesn't conform with the guidelines for color contrast.

Before you begin
Role required: admin

About this task
When you're editing a component in Theme Builder, you may encounter a warning symbol 

( ), which indicates that the component doesn't comply with the Web Content Accessibility 
Guidelines (WCAG) 2.1 for color contrast. The WCAG 2.1 contrast ratio that Theme Builder  targets 
for content and UI variables is 3:1. This ratio determines the contrasts between brighter and 
darker screen colors and how they relate to the user interface. The first digit shows the level 
of bright colors, and the second digit shows the relative level of dark colors. The 3:1 threshold 
provides optimal visibility to visually challenged users. For more information, see the W3C 
Recommendation site for WCAG 2.1 .
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The total number of accessibility violations are indicated on the red numbered badge ( ) 
alongside the Accessibility inspector panel.

Procedure

1. From the Editor page, access the accessibility violations in one of the two ways listed in the 
following table.

2. Select the accessibility warning symbol in the Component Editor to obtain more information for 
fixing the issue.

3. Select from the link in the warning to fix the contrast issue.
The color picker opens.

Note: 
You can select the Hide inaccessible choices slider within the color picker to limit 
the color choices to those colors identified as accessible, based on Web Content 
Accessibility Guidelines (WCAG) guidelines.

4. Optional:  Select the undo symbol to revert your changes back to the original color, if needed.

5. When you complete your changes and the accessibility warning symbol is no longer visible, 
select Save changes.
For example, after you select a color that passes the contrast ratio violation, the warning 
symbol turns green in the color picker.
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Working with Image styles

Image styles enable you to experiment with different color schemes for illustrations and replace 
default illustrations with your own custom images. The Image styles feature provides flexibility in 
customizing the visual elements of your theme.

Image styles categories

As of Theme Builder  version 6.1, the following image styles are available for editing:

• Empty state illustrations

• Banners

• Cards

• Modals

• Tile icons

Banner illustrations in Theme Builder

Banner illustrations are used to increase user engagement or announce overall product 
experiences.

Default banner illustrations

A banner illustration is applied to a web page when there is a need to visually represent abstract 
concepts, reinforce branding, enhance user engagement, or maintain design consistency. 
Banner illustrations are theme-able, and adapt to the theme colors of your instance.

Important: 
Banner illustrations apply to Workspaces and are not supported in the Core UI.

Example of a default banner illustration

Custom images

Upload your custom images to Theme Builder  to replace the default banner illustrations.

To override the default banner illustrations with custom images, upload each image individually. 
The size and format limitations for custom images are as follows:
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Custom image size and format limitations

Field Description

Dimensions limit w572 x h160 px

Format SVG

File size limit 2 MB

Configure colors for banner illustrations

Configure and control the colors automatically applied to banner illustrations to keep your visual 
experience engaging while maintaining brand recognition.

Before you begin
Role required: admin

About this task
As a category, all banner illustrations share color hook mappings. Color hook mappings link 
theme colors to specific parts of an illustration. As a result, the colors that you apply to one 
banner illustration type are also applied to the entire banner illustration category.

Important: 
Configuring banner illustration colors applies to Workspaces and isn’t supported in the 
Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Banners.
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The banner illustrations available for editing are listed on the main stage.

5. Select any banner illustration type from the main stage.

Note: 
Customizing the colors of any banner illustration type applies the color change to the 
entire banner category, regardless of which type you select.

The property panel opens automatically.

Image styles tab with Banners selected

6. From the property panel, select the Colors  tab.

Note: 
The number of leading or supporting colors differs depending on the illustration category. 
For example, banner illustrations have one leading color, while card illustrations have 
three leading colors. Leading colors are the main colors in the illustration and supporting 
colors are accents. They’re listed from most prominent to least.

Property panel Colors tab

7. Select an image color to edit the color using the Color picker.
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Color picker

Note: 
By default, the My Colors tab shows all available colors for the illustration. You can also 
use the Custom tab to select a new color.

8. When you have completed your changes, select Save changes.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. The Remove override symbol enables you to revert your color changes back to 
the original auto-generated colors.

Result
The new colors are applied to all banner illustration types.

If your theme is published, your banner illustration edits are visible to users who have your theme 
applied on refresh. For information about publishing themes, see Publish your themes with 
Theme Builder.

Override banner illustrations with custom images

Modify or override the default banner illustrations with your own custom images to promote 
visual elements that reflect your company's branding.

Before you begin
Role required: admin

Verify that your custom images use the desired colors and meet your branding requirements 
before uploading to Theme Builder.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

123



About this task

Important: 
Custom images apply to Workspaces and aren’t supported in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Banners.

5. Use one of the following options to select the banner illustration that you want to override.

◦ Select the Filter icon  icon and expand the banner category to select the specific banner 
illustration that you want to override.

◦ Scroll through the list of banner illustrations within the main stage.
Once you have selected an illustration, the property panel opens.
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Image styles tab with Banners selected

6. From the property panel, select the Images  tab.

7. Select the default banner illustration file name.

The upload images modal appears.

8. Use one of the following options to upload your custom image:

◦ Select Browse, choose your custom image file from your computer's file browser, and select 
Open.

◦ Drag your custom image file from your computer's file browser and drop the image directly 
into the modal.

Refer to the upload image modal for size and format limitations. If your custom image doesn’t 
meet the required size and format, your image isn’t saved.

9. Preview your image in the modal and select Save.
Your custom image appears on the main stage within the banner type that you have chosen. 
The file name for your custom image is now listed in the property panel.
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Customer general banner type with custom image displayed

10. Optional:  Select the Remove override symbol if you want to restore the default banner 
illustration.

Remove override

11. Optional:  Preview your edits before publishing your theme to your instance.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview

Result
If your theme is published, your custom images are visible to users who have your theme applied 
on refresh. For more information about publishing themes, see Publish your themes with Theme 
Builder.

Card illustrations in Theme Builder

Card illustrations are used to improve the clarity or scannability of a feature.

Default card illustrations

Card illustrations are visual elements that highlight key information, enhancing scannability 
and facilitating action. Card illustrations are theme-able, and adapt to the theme colors of your 
instance.
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Important: 
Card illustrations apply to Workspaces and are not supported in the Core UI.

Example of a default card illustration

Custom images

Upload your custom images to Theme Builder  to replace the default card illustrations.

To override the default card illustrations with custom images, upload each image individually. The 
size and format limitations for custom images are as follows:

Custom image size and format limitations

Field Description

Dimensions limit w453 x h453 px

Format SVG

File size limit 2 MB

Configure colors for card illustrations

Configure and control the colors automatically applied to card illustrations images to keep your 
visual experience engaging while maintaining brand recognition.

Before you begin
Role required: admin

About this task
As a category, all card illustrations share color hook mappings. Color hook mappings link 
theme colors to specific parts of an illustration. As a result, the colors that you apply to one card 
illustration type are also applied to the entire card illustration category.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

127



Important: 
Configuring card illustration colors applies to Workspaces and isn’t supported in the Core 
UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Cards.
The card illustrations available for editing are listed by type on the main stage.

5. Select any card illustration type from the main stage.

Note: 
Customizing the colors of any card illustration type applies the color change to the entire 
card category, regardless of which type you select.

The property panel opens automatically.
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Image styles tab with Cards expanded and Focus important illustration 
selected

6. From the property panel, select the Colors  tab.

Note: 
The number of leading or supporting colors differs depending on the illustration category. 
For example, banner illustrations have one leading color, while card illustrations have 
three leading colors. Leading colors are the main colors in the illustration and supporting 
colors are accents. They’re listed from most prominent to least.

Property panel Colors tab

7. Select an image color to edit the color using the Color picker.
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Color picker

Note: 
By default, the My Colors tab shows all available colors for the illustration. You can also 
use the Custom tab to select a new color.

8. When you have completed your changes, select Save changes.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. The Remove override symbol enables you to revert your color changes back to 
the original auto-generated colors.

Result
The new colors are applied to all card illustration types.

If your theme is published, your card illustration edits are visible to users who have your theme 
applied on refresh. For information about publishing themes, see Publish your themes with 
Theme Builder.

Override card illustrations with custom images

Modify or override the default card illustrations with your own custom images to promote visual 
elements that reflect your company's branding.

Before you begin
Role required: admin

Verify that your custom images use the desired colors and meet your branding requirements 
before uploading to Theme Builder.
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About this task

Important: 
Custom images apply to Workspaces and aren’t supported in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Cards.

5. Use one of the following options to select the card illustration that you want to override.

◦ Select the Filter icon  icon and expand the card category to select the specific card 
illustration that you want to override.

◦ Scroll through the list of card illustrations within the main stage.
Once you have selected an illustration, the property panel opens.
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Image styles tab with Cards selected

6. From the property panel, select the Images  tab.

7. Select the default card illustration file name.

The upload images modal appears.

8. Use one of the following options to upload your custom image:

◦ Select Browse, choose your custom image file from your computer's file browser, and select 
Open.

◦ Drag your custom image file from your computer's file browser and drop the image directly 
into the modal.

Refer to the upload image modal for size and format limitations. If your custom image doesn’t 
meet the required size and format, your image isn’t saved.

9. Preview your image in the modal and select Save.
Your custom image appears on the main stage within the card type that you have chosen. The 
file name for your custom image is now listed in the property panel.
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Focus important card illustration type with custom image displayed

10. Optional:  Select the Remove override symbol if you want to restore the default card 
illustration.

Remove override

11. Optional:  Preview your edits before publishing your theme to your instance.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview
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Result
If your theme is published, your custom images are visible to users who have your theme applied 
on refresh. For more information about publishing themes, see Publish your themes with Theme 
Builder.

Modal illustrations in Theme Builder

Modal illustrations accompany user guidance or support messaging about added features.

Default modal illustrations

Modal illustrations provide a quick visual cue about a modal’s intent. Modal illustrations are 
theme-able, and adapt to the theme colors of your instance.

Important: 
Modal illustrations apply to Workspaces and are not supported in the Core UI.

Example of a default modal illustration

Custom images

Upload your custom images to Theme Builder  to replace the default modal illustrations.

To override the default modal illustrations with custom images, upload each image individually. 
The size and format limitations for custom images are as follows:

Custom image size and format limitations

Field Description

Dimensions limit w552 x h218 px

Format SVG

File size limit 2 MB

Configure colors for modal illustrations

Configure and control the colors automatically applied to modal illustrations to keep your visual 
experience engaging while maintaining brand recognition.

Before you begin
Role required: admin
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About this task
As a category, all modal illustrations share color hook mappings. Color hook mappings link 
theme colors to specific parts of an illustration. As a result, the colors that you apply to one modal 
illustration type are also applied to the entire modal illustration category.

Important: 
Configuring modal illustration colors applies to Workspaces and isn’t supported in the Core 
UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Modals.
The modal illustrations available for editing are listed by type on the main stage.

5. Select any modal illustration type from the main stage.

Note: 
Customizing the colors of any modal illustration type applies the color change to the 
entire modal category, regardless of which type you select.

The property panel opens automatically.
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Image styles tab with Modals expanded and Platform/Onboarding all 
illustration selected

6. From the property panel, select the Colors  tab.

Note: 
The number of leading or supporting colors differs depending on the illustration category. 
For example, banner illustrations have one leading color, while modal illustrations have 
two leading colors. Leading colors are the main colors in the illustration and supporting 
colors are accents. They’re listed from most prominent to least.

Property panel Colors tab

7. Select an image color to edit the color using the Color picker.
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Color picker

Note: 
By default, the My Colors tab shows all available colors for the illustration. You can also 
use the Custom tab to select a new color.

8. When you have completed your changes, select Save changes.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. The Remove override symbol enables you to revert your color changes back to 
the original auto-generated colors.

Result
The new colors are applied to all card illustration types.

If your theme is published, your card illustration edits are visible to users who have your theme 
applied on refresh. For information about publishing themes, see Publish your themes with 
Theme Builder.

Override modal illustrations with custom images

Modify or override the default modal illustrations with your own custom images to promote visual 
elements that reflect your company's branding.

Before you begin
Role required: admin

Verify that your custom images use the desired colors and meet your branding requirements 
before uploading to Theme Builder.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

137



About this task

Important: 
Custom images apply to Workspaces and aren’t supported in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Modals.

5. Use one of the following options to select the modal illustration that you want to override.

◦ Select the Filter icon  icon and expand the modal category to select the specific modal 
illustration that you want to override.

◦ Scroll through the list of modal illustrations within the main stage.
Once you have selected an illustration, the property panel opens.
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Image styles tab with Modals selected and Platform/Onboarding all illustration 
selected

6. From the property panel, select the Images  tab.

7. Select the default modal illustration file name.
For example, the file name listed for this illustration is onboarding-all-v2.svg.
The upload images modal appears.

8. Use one of the following options to upload your custom image:

◦ Select Browse, choose your custom image file from your computer's file browser, and select 
Open.

◦ Drag your custom image file from your computer's file browser and drop the image directly 
into the modal.

Refer to the upload image modal for size and format limitations. If your custom image doesn’t 
meet the required size and format, your image isn’t saved.

9. Preview your image and select Save.
Your custom image appears on the main stage within the modal type that you have chosen. 
The file name for your custom image is now listed in the property panel.
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Platform/Onboarding all modal illustration with custom image displayed

10. Optional:  Select the Remove override symbol if you want to restore the default modal 
illustration.

Remove override

11. Optional:  Preview your edits before publishing your theme to your instance.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview

Result
If your theme is published, your custom images are visible to users who have your theme applied 
on refresh. For more information about publishing themes, see Publish your themes with Theme 
Builder.

Empty state illustrations in Theme Builder

Empty state illustrations in Theme Builder  provide visually engaging placeholders for situations 
when content is missing.
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Default empty state illustrations

When a component or a part of your Next Experience  web page doesn’t contain data, an empty 
state illustration appears. Empty state illustrations are theme-able, and adapt to the theme colors 
of your instance.

Important: 
Empty state illustrations apply to Workspaces and are not supported in the Core UI.

Example of a default empty state illustration

Custom images

Upload your custom images to Theme Builder  to replace the default empty state illustrations.

To override the default empty state illustrations with custom images, upload each image size 
individually. You can choose to override just one size or all three sizes of an empty state type. The 
size and format limitations for each of the three file sizes are as follows:

Small image size and format limitations

Field Description

Dimensions limit w56 x h56 px

Format SVG

File size limit 2 MB

Medium image size and format limitations

Field Description

Dimensions limit w216 x h168 px

Format SVG

File size limit 2 MB
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Large image size and format limitations

Field Description

Dimensions limit w350 x h318 px

Format SVG

File size limit 2 MB

Configure the colors for empty state illustrations

Configure and control the colors automatically applied to empty state illustrations to keep your 
visual experience engaging while maintaining brand recognition.

Before you begin
Role required: admin

About this task
As a category, all empty state illustrations share color hook mappings. Color hook mappings link 
theme colors to specific parts of an illustration. As a result, the colors that you apply to one empty 
state illustration type are also applied to the entire empty state illustration category.

Important: 
Configuring empty state illustration colors applies to Workspaces and isn’t supported in the 
Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Empty States.
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The empty state illustrations available for editing are displayed on the main stage and grouped 
by type.

Image styles tab selected

5. Select any empty state illustration type from the main stage.

Note: 
Customizing the colors of any empty state illustration type applies the color change to the 
entire empty state category, regardless of which type you select.

The property panel opens automatically.

6. From the property panel, select the Colors  tab.

Note: 
The number of leading or supporting colors differs depending on the illustration category. 
For example, banner illustrations have one leading color, while empty state illustrations 
have two leading colors. Leading colors are the main colors in the illustration and 
supporting colors are accents. They’re listed from most prominent to least.

Property panel Colors tab

7. Select an image color to edit the color using the Color picker.
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Color picker

Note: 
By default, the My Colors tab shows all the available colors for the illustration. You can 
also use the Custom tab to select a new color.

8. When you have completed your changes, select Save changes.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. The Remove override symbol enables you to revert your color changes back to 
the original auto-generated colors.

Result
The new colors are applied to all empty state illustration types.

If your theme is published, your empty state illustration edits are visible to users who have your 
theme applied on refresh. For information about publishing themes, see Publish your themes 
with Theme Builder.

Override empty state illustrations with custom images

Modify or override the default empty state illustrations with your own custom images to promote 
visual elements that reflect your company's branding.

Before you begin
Role required: admin

Verify that your custom images use the desired colors and meet your branding requirements 
before uploading to Theme Builder.
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About this task

Important: 
Custom images apply to Workspaces and aren’t supported in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel.
The empty state illustrations are displayed on the main stage and grouped by type.

Image styles tab selected

5. Use one of the following options to select the empty state illustration that you want to override.
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◦ Select the Filter icon  icon and expand the empty states category to select the specific 
empty state illustration that you want to override.

◦ Scroll through the list of empty state illustrations within the main stage.
The property panel opens automatically.

6. From the property panel, select the Images  tab.

Property panel Images tab

7. Select either the large, medium, or small image file of the illustration you want to override.

Note: 
You can only override one image size at a time.

The upload images modal appears.
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Upload images modal

8. Use one of the following options to upload your custom image:

◦ Select Browse, choose your custom image file from your computer's file browser, and select 
Open.

◦ Drag your custom image file from your computer's file browser and drop the image directly 
into the modal.

Refer to the upload image modal for size and format limitations. If your custom image doesn’t 
meet the required size and format, your image isn’t saved.
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Upload image modal with size and format limitations

9. Select Save.
Your custom image appears on the main stage within the empty state category that you have 
chosen.

Add data empty state category with custom image displayed
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10. Optional:  Select the Remove override symbol if you want to restore the default empty state 
illustration.

Image Remove override

11. Optional:  Preview your edits before publishing your theme to your instance.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview

Result
If your theme is published, your custom images are visible to users who have your theme applied 
on refresh. For more information about publishing themes, see Publish your themes with Theme 
Builder.

Tile icon illustrations in Theme Builder

Tile icon illustrations are used to communicate a tile’s purpose using visual metaphors.

Default modal illustrations

A tile icon illustration is a small, purpose-driven graphic that visually represents the content or 
function of a tile, making navigation intuitive, reducing reliance on text. Tile icon illustrations are 
theme-able, and adapt to the theme colors of your instance.

Important: 
Tile icon illustrations apply to Workspaces and are not supported in the Core UI.
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Example of a default tile icon illustration

Custom images

Upload your custom images to Theme Builder  to replace the default tile icon illustrations.

To override the default tile icon illustrations with custom images, upload each image individually. 
The size and format limitations for custom images are as follows:

Custom image size and format limitations

Field Description

Dimensions limit w48 x h48 px

Format SVG

File size limit 2 MB

Configure colors for tile icon illustrations

Configure and control the colors automatically applied to tile icon illustrations to keep your visual 
experience engaging while maintaining brand recognition.

Before you begin
Role required: admin

About this task
As a category, all tile icon illustrations share color hook mappings. Color hook mappings link 
theme colors to specific parts of an illustration. As a result, the colors that you apply to one tile 
icon illustration type are also applied to the entire tile icon illustration category.

Important: 
Configuring tile icon illustration colors applies to Workspaces and isn’t supported in the 
Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.
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Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Tile icons.
The tile icon illustrations available for editing are listed by type on the main stage.

5. Select any tile icon illustration type from the main stage.

Note: 
Customizing the colors of any tile icon illustration type applies the color change to the 
entire tile icon category, regardless of which type you select.

The property panel opens automatically.
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Image styles tab with Tile icons expanded and Accessibility illustration 
selected

6. From the property panel, select the Colors  tab.

Note: 
The number of leading or supporting colors differs depending on the illustration category. 
For example, banner illustrations have one leading color, while tile icon illustrations have 
three leading colors. Leading colors are the main colors in the illustration and supporting 
colors are accents. They’re listed from most prominent to least.

Property panel Colors tab

7. Select an image color to edit the color using the Color picker.
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Color picker

Note: 
By default, the My Colors tab shows all available colors for the illustration. You can also 
use the Custom tab to select a new color.

8. When you have completed your changes, select Save changes.

Note: 
After you have saved changes to any of the color hooks, a Remove override symbol 
appears. The Remove override symbol enables you to revert your color changes back to 
the original auto-generated colors.

Result
The new colors are applied to all tile icon illustration types.

If your theme is published, your illustration edits are visible to users who have your theme 
applied on refresh. For information about publishing themes, see Publish your themes with 
Theme Builder.

Override tile icon illustrations with custom images

Modify or override the default tile icon illustrations with your own custom images to promote 
visual elements that reflect your company's branding.

Before you begin
Role required: admin

Verify that your custom images use the desired colors and meet your branding requirements 
before uploading to Theme Builder.
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About this task

Important: 
Custom images apply to Workspaces and aren’t supported in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page opens in a new tab and is displayed in the Home page view.

2. Use the Page drop-down list to select the Editor page view.

Editor page view

3. From the Theme drop-down list, select the theme that you want to edit.

4. Select the Image styles  tab from the general styles panel and expand Tile icons.

5. Use one of the following options to select the tile icon illustration that you want to override.

◦ Select the Filter icon  icon and expand the tile icon category to select the specific 
illustration that you want to override.

◦ Scroll through the list of tile icon illustrations within the main stage.
Once you have selected an illustration, the property panel opens.
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Image styles tab with Tile icons expanded

6. From the property panel, select the Images  tab.

7. Select the default tile icon illustration file name.
The upload images modal appears.

8. Use one of the following options to upload your custom image:

◦ Select Browse, choose your custom image file from your computer's file browser, and select 
Open.

◦ Drag your custom image file from your computer's file browser and drop the image directly 
into the modal.

Refer to the upload image modal for size and format limitations. If your custom image doesn’t 
meet the required size and format, your image isn’t saved.

9. Preview your image in the modal and select Save.

Upload image modal with custom image displayed

Once saved, your custom image appears on the main stage within the card category you have 
chosen. The file name for your custom image is now listed in the property panel.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

155



10. Optional:  Select the Remove override symbol if you want to restore the default tile icon 
illustration.

Remove override

11. Optional:  Preview your edits before publishing your theme to your instance.

a. Select the Experience preview  tab from the Global styles panel.

b. Select the experience that you want to preview from the Experience drop-down list.

c. Select the Open in new tab icon  to open the experience in a new tab.

Experience preview

Result
If your theme is published, your custom images are visible to users who have your theme applied 
on refresh. For more information about publishing themes, see Publish your themes with Theme 
Builder.

Publish your themes with Theme Builder

Publish multiple themes to your web instance or a single theme to your mobile instance to reflect 
your company's brand.

Before you begin
Role required: admin

About this task
Currently, mobile instances can only accommodate one published theme at a time.

If you want to publish a theme to specific mobile applications, you can use Mobile App Builder . 
Any themes that are created using Theme Builder  are available for publishing in Mobile App 
Builder .

Next Experience  Polaris and Coral themes are available for publishing from Theme Builder.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. From the Home page view, select the Manager page view to see the themes that you have 
created.

3. Decide which theme you want to publish from the Unpublished section.
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Note: 
When you have selected the theme that you want to publish, verify that you 
have selected the correct scope for the theme from the application scope 

picker.

4. To publish your themes, complete any of the following actions.

5. Select Publish  in the confirmation dialog box.

The theme appears in the Published section of the Manager page.

Note: 
After you have published your theme to your instance, users must select the theme from 
their Theme preference.

6. Optional:  Select one theme as the default if you have published multiple themes to your web 
instance.

(Optional) If you have published only one theme to your web instance, that theme is the 
default theme. The default theme appears first in the user's Theme preference. For more 
information, see Set the default theme.

7. Optional:  Set the presentation order of your themes if you have published multiple themes to 
your web instance.

Note: 
The presentation order determines how the themes appear in the user's Theme 
preference.
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For more information on setting the order of your themes using the List view drag-and-drop 
feature, see Set the presentation order of your Theme Builder themes.

For information on setting order using the Next Experience, see Publish multiple themes in 
Next Experience.

8. Refresh your browser to view the new theme published to your instance.

Note: 
Only themes that are created in Theme Builder  can be edited and published using 
Theme Builder. Web and mobile themes you may have created outside of Next 
Experience  (for example, in the mobile legacy UI or Core UI) can’t be viewed or edited 
within Theme Builder. To reuse these legacy themes, you must re-create them in Theme 
Builder.

Additionally, if you created and published themes outside of Theme Builder, and you 
want to revert them, you must navigate to the tables that they’re stored in and reapply 
them. If, however, you want to change themes in individual mobile applications, you can 
do so using Mobile App Builder .

Set the default theme

Set a preferred Theme Builder  theme as the default for your web experiences when multiple 
themes are published.

Before you begin
Role required: admin

About this task
If you have published only one theme to your web instance, that theme is automatically set as 
the default theme.

The default theme is treated as the first theme that is displayed in the Next Experience  Theme 
user preference. If a user has not made a selection from the Theme user preference, the default 
theme is displayed.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. From the Home page view, select the Manager page view to see the themes that you have 
created.

3. Choose the theme that you want to set as the default from the Published section.

Note: 
When you have selected the theme that you want to set as the default, verify that you 
have selected the correct scope for the theme from the application scope picker.

4. Select the More actions icon from the theme that you have selected, and select Mark as 
default.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

158

https://www.servicenow.com/docs/access?context=mab-concept&version=zurich&pubname=zurich-mobile&ft:locale=en-US
https://www.servicenow.com/docs/access?context=mab-concept&version=zurich&pubname=zurich-mobile&ft:locale=en-US
https://www.servicenow.com/docs/access?context=mab-concept&version=zurich&pubname=zurich-mobile&ft:locale=en-US


The theme is listed as the Default within the Published section. The default theme is treated as 
the first theme and each theme listed after the default theme follows a sequential order.
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5. Refresh your browser to view the new theme.
The default theme appears first in the user's Theme preference.

Set the presentation order of your Theme Builder  themes

Set the order of your Theme Builder  themes to configure how they’re displayed in the user's 
Theme preferences.

Before you begin

• Before setting the order of your themes, verify that you have more than one theme published. 
For more information on publishing your Theme Builder  themes, see Publish your themes with 
Theme Builder.

• Verify that you have selected the correct scope for the theme from the application scope 
picker.

Role required: admin

About this task
Setting the order to your Theme Builder  themes enables you to control how your themes are 
displayed in the Next Experience  Theme user preference.

Currently, setting order to your themes is only available to web instances. Mobile instances can 
only accommodate one published theme at a time.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Builder.
The Theme Builder  landing page appears in the Home page view.

2. From the Home page view, select the Manager page view to see the themes that you have 
created.

3. Select the List view to view a list of your published and unpublished themes.

List view

4. From the Published section, hover over your chosen theme and drag the theme into the order 
you prefer.
The default theme is treated as the first theme that is displayed in the Next Experience  Theme 
user preference. If you delete or move the default theme from its position, then the next theme 
listed becomes the default. If a user has not made a selection from the Theme user preference, 
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the default theme is displayed. Each theme listed after the default theme follows a sequential 
order and is displayed in that order in the user's Theme preference.

Note: 
If you have themes that are created outside of Theme Builder, the order displayed might 
not be reflective of all the themes available in the Theme user preference.

Theme Builder  and domain separation

Domain separation enables you to separate data, processes, and administrative tasks into 
logical groupings called domains. You can control several aspects of this separation, including 
which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Working with the dark theme

The dark theme emits less blue light, making the display easier for your eyes and less disturbing 
in low-light settings. The dark theme is supported for configurable workspaces, lists, forms, 
dashboards, and reports.

The Next Experience  Coral and Polaris themes have a dark variant that is enabled by default, but 
dark variants may not apply to all experiences.

Note: 
Some custom pages don’t inherit the dark theme, which may create visual inconsistencies 
in the classic environment. This behavior is expected and it’s the responsibility of 
your administrator to exclude the dark theme from your classic environment if the 
inconsistencies are unacceptable for your company.

Open the theme menu

Use the Next Experience  Theme menu to quickly change your theme.

Before you begin
Role required: admin

About this task
When you select which theme record is active for the instance, any associated variants and 
alternate color palettes are displayed in the Themes menu. Your users can select from the 
available variants and alternate color palettes that are associated with the current theme from 
the Themes menu.

Procedure

1. Select the user menu, represented by your user icon or initials in the Next Experience  Unified 
Navigation.

2. Select Preferences.
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Preferences

3. Select the Theme  tile.

Next Experience  themes

Note: 
The theme images that are displayed depend on the theme record that you selected for 
the instance. Your users can select the variant or alternate color palette that are attached 
to that theme record they want to use for their own work environment.

Each theme card displays the core theme and all variants or alternative color palettes that 
are associated with that core theme. Hover over the circles beneath the core theme to view a 
preview of the variant or alternate color palette.

Your users can select the  variant or alternate color palette   that they want to adopt for their 
instance.
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Enable the Next Experience  dark theme for limited classic environment and configurable 
workspaces

Enable the Next Experience  dark theme for limited classic environment and configurable 
workspaces by using system properties.

Before you begin
Role required: admin

Procedure

1. Navigate to All  and then in the filter navigator, search for sys_properties.list.

2. In the list search bar, search for glide.ui.polaris.dark_themes_enabled.

3. Enable the dark theme for use in your Next Experience  limited classic 
environment and configurable workspace instances by setting 
glide.ui.polaris.dark_themes_enabled  to True.

Disable the dark theme in all Next Experience  instances

Disable the Next Experience  dark theme in all of Next Experience  instances.

Before you begin
Role required: admin

Procedure

1. Navigate to All  and then in the filter navigator, search for sys_properties.list.

2. In the list search bar, search for glide.ui.polaris.dark_themes_enabled.

3. Disable the dark theme in all of your Next Experience  instances by setting 
glide.ui.polaris.dark_themes_enabled  to False.

Enable the dark theme only in configurable workspaces

Enable the Next Experience  dark theme in configurable workspaces only, and not for the classic 
environment. The dark theme emits less blue light, making the display easier for your eyes and 
less disturbing in low-light settings.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  and in the filter navigator, search for sys_properties.list.

2. In the list search bar, search for glide.ui.polaris.dark_themes_enabled.

3. Enable the dark theme in all of your Next Experience  configurable workspaces by setting 
glide.ui.polaris.dark_themes_enabled  to True.

4. In the list search bar, search for glide.ui.polaris.core_ui_exclude_dark_mode.

5. Exclude the dark theme in the classic environment by setting 
glide.ui.polaris.core_ui_exclude_dark_mode  to True.

Note: 
If you select the dark theme, the dark theme only applies to the configurable workspaces. 
The classic environment remains in the default theme.

Working with theme-able empty state images

Add theme-able empty state images to customize empty states and improve the user 
experience. Empty states include guidance or actions for users to add or create content.

When a component or a part of your Next Experience  web page doesn’t contain data, an empty 
state image appears. Empty state images are theme-able, and adapt to the theme colors of your 
instance.

Empty state image

There are 12 empty state image types available, each including a small, medium, and large 
version. When creating a theme using Theme Builder  a UX Styles Imagery record is created 
however, the record is empty. In this case, your theme defaults to using a base system empty 
state theme-able images. If you choose to override these images, see Customize theme-able 
empty state images for your theme.

You can insert an empty state image into your custom experience by using the Illustration 
component in UI Builder. The Illustration component displays all available empty state images. 
For more information on the Illustration component, see Horizon Design System Empty State .

You can also add custom images using the Custom Illustration component in UI Builder.
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Theme-able empty state image with theme hooks

The following images represent the No Search Results empty state image along with the theme 
hooks required for each variation.

No Search Results (accent solid)

The theme hook required for this variation is $now-color_interactive-1.
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No Search Results (accent outline)

The theme hook required for this variation is $now-color_interactive-3.
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No Search Results (subtle outlines)

The theme hook required for this variation is $now-color_border-
secondary.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

167



No Search Results (subject dark detail)

The theme hook required for this variation is $now-color_border-tertiary.
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No Search Results (subject light detail)

The theme hook required for this variation is $now-color_background-
secondary.
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No Search Results (subject fill)

The theme hook required for this variation is $now-color_background-
primary.
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No Search Results (subject outline)

The theme hook required for this variation is $now-color_border-
secondary.
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No Search Results (subject shadows)

The theme hook required for this variation is $now-color_border-
secondary.

Empty state light mode tokens

Main Object empty state image

The theme hooks used to override the main object empty state image.

• now-illustration--empty-state--main-object--outline

• now-illustration--empty-state--main-object--fill
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Primary object empty state image

The theme hooks used to override the primary object empty state image.

• now-illustration--empty-state--primary-object--outline

• now-illustration--empty-state--primary-object--primary-fill

• now-illustration--empty-state--primary-object--tertiary-fill

• now-illustration--empty-state--primary-object--main-detail

• now-illustration--empty-state--primary-object--detail

• now-illustration--empty-state--primary-object--shadow

Tertiary object empty state image

The theme hooks used to override the tertiary object empty state image.

• now-illustration--empty-state--tertiary-object--outline

• now-illustration--empty-state--tertiary-object--primary-fill

• now-illustration--empty-state--tertiary-object--tertiary-fill

• now-illustration--empty-state--tertiary-object--main-detail

• now-illustration--empty-state--tertiary-object--detail

• now-illustration--empty-state--tertiary-object--shadow
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Background empty state image

The theme hooks used to override the background empty state image.

• now-illustration--empty-state--background--lines

• now-illustration--empty-state--background--tertiary-lines

• now-illustration--empty-state--background--object-outline

• now-illustration--empty-state--background--object-detail

• now-illustration--empty-state--background--object-shadow

• now-illustration--empty-state--background--object-fill

Empty state light mode fallbacks

Empty state light mode fallback style declarations

Object Style declaration

 .main-object--outline {
 
 fill:rgb(var(--empty-state--m
ain-object--outline),
     
 var(--main-object--outline), 
 var(--now-color--interactive-
3), 51,53,123);
}

Main object

 .main-object--fill {
 
 fill:rgb(var(--empty-state--m
ain-object--fill),
     
 var(--main-object--fill), 
 var(--now-color--interactive-
1), 144,146,213);
}
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Empty state light mode fallback style declarations  (continued)

Object Style declaration

 .primary-object--outline {
 
 fill:rgb(var(--empty-state--p
rimary-object--outline),
     
 var(--primary-object--outlin
e), 
 var(--now-color--border--seco
ndary),
    176,181,191);
}

 .primary-object--primary-fill 
 {
     
 fill:rgb(var(--empty-state--p
rimary-object--primary-fill),
     
 var(--primary-object--primary
-fill), 
 var(--now-color--backgroun
d--primary),
      255,255,255);
}

 .primary-object--tertiary-f
ill {
     
 fill:rgb(var(--empty-state--p
rimary-object--tertiary-fill),
     
 var(--primary-object--tertiar
y-fill), 
 var(--now-color--backgroun
d--secondary),
      246,246,248);
}

Primary object

 .primary-object--main-detail 
 {
     
 fill:rgb(var(--empty-state--p
rimary-object--main-detail), 
 var(--primary-object--main-de
tail),
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Empty state light mode fallback style declarations  (continued)

Object Style declaration

     
 var(--now-color--border--seco
ndary), 176,181,191);
}

 .primary-object--detail {
 
 fill:rgb(var(--empty-state--p
rimary-object--detail ),
     
 var(--primary-object--detai
l ), 
 var(--now-color--border--tert
iary),
    211,214,220);
}

 .primary-object--shadow {
 
 fill:rgb(var(--empty-state--p
rimary-object--shadow),
     
 var(--primary-object--shado
w), 
 var(--now-color--backgroun
d--tertiary),
    228,230,234);
}

 .tertiary-object--outline {
 
 fill:rgb(var(--empty-state--t
ertiary-object--outline),
     
 var(--tertiary-object--outlin
e), 
 var(--now-color--border--seco
ndary), 176,181,191);
}
      

Tertiary object

 .tertiary-object--primary-f
ill {
     
 fill:rgb(var(--empty-state--t
ertiary-object--primary-fill),
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Empty state light mode fallback style declarations  (continued)

Object Style declaration

     
 var(--tertiary-object--primar
y-fill), 
 var(--now-color--backgroun
d--primary),
      255,255,255);
}

 .tertiary-object--tertiary-f
ill {
     
 fill:rgb(var(--empty-state--t
ertiary-object--tertiary-fil
l),
     
 var(--tertiary-object--tertia
ry-fill), 
 var(--now-color--backgroun
d--secondary),
      246,246,248);
}

 .tertiary-object--main-detail 
 {
     
 fill:rgb(var(--empty-state--t
ertiary-object--main-detail),
     
 var(--tertiary-object--main-d
etail), 
 var(--now-color--border--seco
ndary),
      176,181,191);
}

 .tertiary-object--detail {
 
 fill:rgb(var(--empty-state--p
rimary-object--detail ),
     
 var(--primary-object--detai
l ), 
 var(--now-color--border--tert
iary),
    211,214,220);
}
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Empty state light mode fallback style declarations  (continued)

Object Style declaration

 .tertiary-object--shadow {
 
 fill:rgb(var(--empty-state--t
ertiary-object--shadow),
     
 var(--tertiary-object--shado
w), 
 var(--now-color--backgroun
d--tertiary),
    228,230,234);
}

 .background--lines {
 
 fill:rgb(var(--empty-state--b
ackground--lines),
     
 var(--background--lines), 
 var(--now-color--border--tert
iary), 211,214,220);
}

 .background--tertiary-lines {
     
 fill:rgb(var(--empty-state--b
ackground--tertiary-lines), 
 var(--background--tertiary-li
nes),
     
 var(--now-color--border--tert
iary), 211,214,220);
}

Background object

 .background--object-outline {
     
 fill:rgb(var(--empty-state--b
ackground--object-outline), 
 var(--background--object-outl
ine),
     
 var(--now-color--border--tert
iary), 211,214,220);
}
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Empty state light mode fallback style declarations  (continued)

Object Style declaration

 .background--object-detail {
 
 fill:rgb(var(--empty-state--b
ackground--object-detail),
     
 var(--background--object-deta
il), 
 var(--now-color--border--tert
iary),
    211,214,220);
}

 .background--object-shadow {
 
 fill:rgb(var(--empty-state--b
ackground--object-shadow),
     
 var(--background--object-shad
ow), 
 var(--now-color--backgroun
d--tertiary),
      228,230,234);
}

 .background--object-fill {
 
 fill:rgb(var(--empty-state--b
ackground--object-fill),
     
 var(--background--object-fil
l), 
 var(--now-color--backgroun
d--primary),
    255,255,255);
}

Customize theme-able empty state images for your theme

Customize default theme-able empty state images for your Next Experience  and Theme Builder 
themes using the theme's Imagery record.

Before you begin
Role required: admin
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About this task

Important: 
You can customize empty state images for Workspaces, but customization is not supported 
in the Core UI.

Procedure

1. Navigate to All  > Now Experience Framework  > Themes  > UX Themes.

2. Select your theme from the UX Themes table.
The UX Theme record for your chosen theme appears.

3. From the Compositional App Theme  tab, select the Imagery  record.

4. From the Imagery style record, enter the following empty state image theme hooks into the 
Style  field.

{
    "properties": {
        "--now-illustration--add-attachment-sm--url": "",
        "--now-illustration--add-attachment-md--url": "",
        "--now-illustration--add-attachment-lg--url": "",
        "--now-illustration--add-data-sm--url": "",
        "--now-illustration--add-data-md--url": "",
        "--now-illustration--add-data-lg--url": "",
        "--now-illustration--completed-tasks-sm--url": "",
        "--now-illustration--completed-tasks-md--url": "",
        "--now-illustration--completed-tasks-lg--url": "",
        "--now-illustration--error-sm--url": "",
        "--now-illustration--error-md--url": "",
        "--now-illustration--error-lg--url": "",
        "--now-illustration--first-time-user-sm--url": "",
        "--now-illustration--first-time-user-md--url": ""
        "--now-illustration--first-time-user-lg--url": "",
        "--now-illustration--interrupted-sm--url": "",
        "--now-illustration--interrupted-md--url": "",
        "--now-illustration--interrupted-lg--url": "",
        "--now-illustration--no-data-sm--url": "",
        "--now-illustration--no-data-md--url": "",
        "--now-illustration--no-data-lg--url": "",
        "--now-illustration--no-search-results-sm--url": "",
        "--now-illustration--no-search-results-md--url": "",
        "--now-illustration--no-search-results-lg--url": "",
        "--now-illustration--offline-sm--url": "",
        "--now-illustration--offline-md--url": "",
        "--now-illustration--offline-lg--url": "",
        "--now-illustration--permissions-sm--url": "",
        "--now-illustration--permissions-md--url": "",
        "--now-illustration--permissions-lg--url": "",
        "--now-illustration--unconfigured-sm--url": "",
        "--now-illustration--unconfigured-md--url": "",
        "--now-illustration--unconfigured-lg--url": "",
        "--now-illustration--no-activities-sm--url": "",
        "--now-illustration--no-activities-md--url": "",
        "--now-illustration--no-activities-lg--url": "",
    }
}
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5. Add your custom image in one of the following ways.

◦ Add image to UX Style Assets list.

a. On the UX Style Assets  tab, select New.

b. Select the search icon next to the Asset  item.

c. In the UX Theme Assets list, select New.

d. Select the Manage Attachments icon  to add an image.

e. When the image asset is uploaded, close the Attachments window.

Note: 
Verify that your image is in SVG format.

f. Enter the file name of the asset in the Name  field and select Submit. The asset is added to 
the UX Style Assets list.

g. Select and hold (or right-click) on the asset from the UX Style Assets list, and select Copy 
sys_id.

h. Enter the sys_id into the Style field using the following format:  "/uxta/
ENTERYOURSYSID.assetx"

◦ Add your custom image to the Images [db_images_list.do] table.

Note: 
Verify that your image is in SVG format.

a. For detailed instructions, see Upload one or more images.

b. From the Imagery style record, enter the image file name into the Style  field using the 
following format:  "/FILENAME.svg".

6. Select Update.
The custom images appear in your theme.

7. Optional:  Customize the colors of your empty state images using the UX Style color record 
associated with your theme to override the default theme hooks.

(Optional) For a step-by-step tutorial on editing your UX Style color record, see Exercise 3, 
Activity 2 and 3 of the Next Experience Workshop  in the ServiceNow Community.

Note: 
Using the default theme hooks is recommended.

Configuring Next Experience  themes and preferences

Theming in Next Experience  applies to individual experiences. As an admin user, you can 
configure the variables for colors, shapes, fonts, and other aspects of the user experience.

To configure a theme, you create one or more styles with overrides to the default styles. Your 
new style records override the default Polaris or default Coral style. For example, the default 
Next Experience  font is Lato. To override this font, you would upload a font asset and change the 
associated font properties in the style that you create.
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Note: 

Usually, you are working with the Compositional Theme. The exceptions are when the 
experience you are configuring does not have a parent app or it uses an app shell UI other 
than the Breadcrumb App Shell or the Agent Workspace App Shell. If you are configuring a 
theme for one of these exceptions, see Manage the visual style of UI Builder experiences .

Create a custom theme by cloning a Theme Builder  theme record

Create a custom theme in the Next Experience  more efficiently using a published Theme Builder 
theme record.

Before you begin
In order to clone a Theme Builder  theme, the theme must be published. For information on 
publishing your Theme Builder  theme, see Publish your themes with Theme Builder.

Role required: admin

About this task
To avoid your work from being overwritten, your new cloned theme isn’t editable in Theme 
Builder.

Procedure

1. Navigate to All  > Now Experience Framework  > Themes.
The UX Themes table appears.

2. Under the Name column, search for the Theme Builder  theme you want to clone and select the 
record.

3. Clone the five UX Theme style records.

a. From the Compositional: App Theme  tab, select and hold (or right-click) the Mobile Colors 
style record and select Open link in new tab.

b. In the Name  field, enter your theme name.
For example, ABC Company - Mobile Colors.

c. Select and hold (or right-click) the header bar and select Insert and Stay.
This action creates a copy of the style record and redirects the information to the new style 
record.

Cloned Mobile Colors style record

d. Close the open tab.

e. Repeat this process for the Shape and Form, Colors, Imagery, and Typography style records.
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Note: 
The cloned style records don’t appear in the current theme record and this behavior is 
expected.

4. Clone the UX theme record.

a. From the Name  field, change the name of the theme record.
For example, Custom ABC Company.

b. Select and hold (or right-click) the header bar and select Insert and Stay.
Your new UX theme record appears. The style records within this theme are empty and this 
behavior is expected.

Newly created UX Theme record

5. Add the newly created style records to your theme.

a. Double-click under the Style column to expose the lookup field.

b. Search for and select one of your new style records from the drop-down.

c. Save your selection by selecting the green checkmark.

d. Double-click under the Type column to expose the drop-down list and select Core.

Style Type drop-down list

e. Save your selection by selecting the green checkmark.

This action associates your style record to the current theme.

f. Repeat this process for the remaining four style records.
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g. Select and hold (or right-click) the header bar and select Save.
If the changes haven't been saved, green bars are displayed next to the style records that 
you have added.

UX Theme record before the record is saved

6. Publish your custom theme.
To publish your custom theme, see Publish multiple themes in Next Experience.
Now that your custom theme is published, you’re ready to customize your theme. For a step-by-
step tutorial for editing your UX Style color record, see Exercise 3, Activity 2 and 3 of the Next 
Experience  Workshop  in the ServiceNow  Community.

Create a Next Experience  style

When you create or modify a Next Experience  theme, you create and edit one or more styles. 
Styles include typefaces, colors, images, and shapes and forms. The new style records you 
create override the default Polaris or default Coral theme in Next Experience.

Before you begin
Role required: admin
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About this task
When you edit Next Experience  styles, you work in raw JSON code. Edit with care.

You upload new typefaces or images in a separate process. See Add Next Experience font and 
image assets.

Procedure

1. In the filter navigator field, enter sys_ux_style.do  to create a style record.

2. Name the style and specify whether it’s a Core style or a Variant.

Note: 
The Dark theme is the only variant shipped with Next Experience.

3. In the Style  field, add the base and properties blocks to contain overrides in the style record.

{
  "base": {
},
  "properties":{
  }
 }

4. Optional:  To save your work between steps, select the additional actions icon  and choose 
Save.

5. In the Style  field, edit the JSON code to reflect the overrides you want the style to contain.

a. Add or edit your main colors in the base section of the JSON code.
Use RGB values.

The following example shows sample color overrides.

b. Edit versions of the colors in the properties section of the JSON code.

c. Add or edit shapes in the properties section of the JSON code.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

185



The following example shows sample shape overrides.

6. Add fonts, images, and other theme assets.
For more information, see Add Next Experience font and image assets.

7. If you have uploaded fonts, add or edit typefaces in the properties section of the JSON code 
and select Update.

Result
The updated colors, shapes, and typefaces are visible in your theme.

Configure a Next Experience  theme

Add the styles that you have created to your Next Experience  theme to modify the look and feel 
of the user experience.

Before you begin
Ensure that the following system properties that are located in sys_properties.list  are 
set to True:

• glide.ui.polaris.experience

• glide.ui.polaris.dark_themes_enabled: To reuse the Next Experience  dark 
variant in this theme.

Role required: admin
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About this task
The Next Experience  includes two themes, Polaris and Coral. You can reuse or customize either 
theme as a starting point when you create or modify your own themes.

About this task

Note: 
If you're customizing a theme that you created with Theme Builder  and enter invalid 
JSON code, you can't save your theme record. While working in the UX theme record, you 
can navigate to the Editor page by using the Open in Theme Builder  button. For more 
information, see Manage or edit a theme with Theme Builder.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Management  > Themes.

2. Create a theme record by selecting New.

3. Enter a name and a description for your 

theme.

4. Select the additional actions icon  and select Save.

5. On the Compositional: App Theme  tab, insert rows to add styles that are associated with your 
theme.
You assign values in four columns:

Applicability

Overrides the base theme. Users who meet the applicability constraints see 
those overrides in their theme rather than the base style. For example, a style 
with different fonts can be applied to managers. Users who meet the manager 
applicability see the different fonts in the Next Experience  UI, which overrides the 
base system theme values. Administrators do not have to copy or create an entire 
theme with changes for the applicable audience.

Note: 
Leaving the Applicability constraint to empty will apply the style to all users.

Order

Specifies when the style is applied. The higher the order means that the greater 
its priority is.

Note: 
If you want to use a custom style, make sure that your style order number is 
higher than the standard Polaris or Coral style.

Style

Configures four main styles. You can't edit the style names that are used in 
the provided Polaris or Coral themes, but you can copy the JSON code that is 
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associated with each style from either theme and paste and edit it in your custom 
style's form.

◦ Colors:  Specifies the color properties of the theme and any base variants that 
you want to add. In the base section of the color style, a subset of the colors 
that the theme uses are defined with Red, Green, Blue (RGB) values. The theme 
generates more than 20 gradients of those colors in the application.

◦ Shape and Form:  Specifies the look and feel of the borders as well as the 
buttons and other UI controls.

◦ Imagery:  Adds images that are used in your application's theme.

◦ Typography:  Specifies the fonts that are used throughout the application.

Type

Specifies two types: Core and Variant. The Core styles include the color, shape 
and form, typography, and imagery. Variants specify a different version of the 
theme, such as the different colors that users can select. The most common 
variant is a dark version of the theme. The Dark theme is the only variant that is 
shipped with Next Experience. For more information, see Working with themes in 
Next Experience.

6. Select the Style  field and select the search icon .

7. Select New.

8. Select Primary, Secondary, and Neutral colors.

Note: 
A theme is made up of multiple variables, so you may notice the default Polaris or Coral 
theme coloring coming through in different places.

9. When you have your organization's branding colors, navigate to the color generator at https://
theme.deoprototypes.com/color-generator-algo-v1 .

10. Select the Auto Generate  button.

A modal pops up and asks you to enter in the three colors from your organization.

11. Enter your hex code values for your organization's colors.

12. Select Generate.

13. Gather your CSS variables by selecting Copy JSON.
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14. Fill in the UX style 

form.

Field Description

Name Name of your UX style.

Type ◦ Core

◦ Variant
For more information on types, see Difference 
between core styles and variants.

Style Values for the colors, shapes, and forms. 
Some of the values are colors and some, like 
borders, are pixel values.

Important: 
JSON code must be wrapped 
as shown in the following 

example.

Application Scope of the UX style.

15. Select Submit.

16. Select Update.

What to do next
To publish your custom theme, see Publish multiple themes in Next Experience.

Add Next Experience  font and image assets

Add assets to your Next Experience  themes and styles to store extra information associated with 
a theme, including fonts and images.
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Before you begin
Role required: admin

About this task
Upload images associated with your theme including banner images and logos. Add typefaces to 
match Next Experience  to your corporate look and feel.

Note: 
You can't add assets or otherwise edit the styles associated with the default theme.

Procedure

1. In the filter navigator field, enter sys_ux_theme_asset_list.do.

2. In the UX Theme Assets list, select New.

3. Select the Manage Attachments icon  to add an image or font.
Your font asset may have separate files for different characteristics such as bold or italic. 
Upload each of these files. Verify that your image is in SVG format.

4. When the asset is uploaded, close the Attachments window.

5. Type the file name of the asset in the Name  field and select 

Submit.

6. Optional:  Add a script to the asset in the Asset Properties  box.

7. Select Submit.

Result
The font or image is available to use in your theme.

Change instance banner logo in Next Experience

Change the instance banner logo displayed on the Unified Navigation  and the login page to 
reflect your company logo.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > My Company.

2. To upload your company logo, select Update  beside UI16 Banner Image.
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3. Select Choose file  and select the file, and then select OK.
To use an image URL instead of a file on your hard drive, enter the URL in the file upload 
window.

Note: 
The image can be high resolution, but when it displays it is scaled based on the aspect 
ratio. It scales to a maximum of 20px high.

4. Select Update.

5. Optional:  If new banner image doesn't display, perform a cache.do  and logout.do  and 
log back into your instance.

6. Optional:  To restore the default instance logo, update the 
glide.product.image.light  system property value to now-next-experience-logo.svg.

Override the Next Experience  default theme

Override the Next Experience  theme with your custom theme.

Before you begin
Prior to the Xanadu release, overriding the Next Experience  theme using the 
glide.ui.polaris.theme.custom  system property was the primary way to apply a 
custom look globally. As of Xanadu, you are able to publish multiple themes and select a theme 
for the Next Experience. The glide.ui.polaris.theme.custom  system property is 
only considered if the UX Parent App Themes table is empty. For more information, see Publish 
multiple themes in Next Experience. Use override only if you need to enforce a single theme 
across your instance.

Role required: admin

About this task
Override the default Next Experience  theme while keeping the Next Experience  UI.

Procedure

1. In the filter navigator field, type sys_ux_theme.list  and press Enter.

2. Select the theme you want to override the Next Experience  theme with.

3. Right-click the header and select Copy sys_id.
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4. In the application navigator field, type sys_properties.list  and press Enter.

5. Select New.

6. Fill in the System Property form.

◦ Name the system property glide.ui.polaris.theme.custom.

◦ Set the type value to string.

◦ In the value field, paste the sys_id you copied in step 3.

◦ A Suffix  field will appear on the System Property form when you want to apply a custom 
theme to a specific application scope. This field is required.

7. Select Submit.
Your custom theme appears. If necessary, refresh your browser.

Note: 
If, for any reason, you decide to revert back to the Polaris theme, repeat steps 4 through 7, 
replacing the sys_id in the Value  field with the sys_id of the Polaris theme.
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Set the location of a notification toast banner

A toast message provides simple feedback about an operation in a small pop-up. Choose which 
corner of the screen that you would like your notification toast message banners to appear in for 
the purpose of improving usability.

Before you begin
Role required: admin

Procedure

1. In your instance, select the User Menu  .

2. From the user menu list, select Preferences.

3. Select Notifications.

4. Select the Next Experience  tab.

Next Experience  notification preferences

5. In Notification toast banner location, choose your preferred location for banners:

◦ Top left

◦ Top right

◦ Bottom left

◦ Bottom right

Note: 
The default location is in the top right of your instance. If the banner doesn't appear in the 
expected location, try refreshing your browser.

Preserve your custom Next Experience  theme during a clone

Preserve your custom Next Experience  theme during a clone by using a data preserver.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Clone  > Clone Definition  > Preserve Data.

2. Select New.

3. On the form, fill in the fields.
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Clone Data Preserver form

Field Description

Name Unique name for your data preserver. 
An example is Next Experience Theme 
Properties.

Theme Option to determine whether this preserver is 
theme-related. In this case, select the option 
to mark it as true.

Table Table that is affected by this data preserver. 
In this case, use System property 
[sys_properties].

Conditions Conditions that this data preserver acts 
on. Build the condition as Name is 
glide.ui.polaris.theme.custom.

4. Right-click the header and select Save.
The Clone Profiles related list appears.

5. Create a new record for each of the following tables, and leave the condition field empty.

◦ sys_ux_theme

◦ sys_ux_style

◦ m2m_theme_style

◦ m2m_style_asset

◦ sys_ux_theme_asset

◦ sys_ux_theme_m2m_asset

◦ sys_ux_theme_customization

◦ m2m_app_theme

6. Create a new record for each of the table, including the associated condition.

Clone Data Preserver for table and condition fields

Table Conditions

sys_properties Name is 
glide.ui.polaris.theme_builder.override_logo.

sys_user_preference Name is glide.ui.polaris.theme.

sys_user_preference Name is glide.ui.polaris.theme.variant.

Add this table for themes 
with custom logos: 
sys_attachment

Name or unique identifier of the sys_attachment record on the 
target.

7. Optional:  If you have a clone profile you would like to add, select Edit, move your clone profile 
to your data preserver, and select Save.

Note: 
A clone profile enables you to store predefined target and clone options. If you don’t have 
a clone profile, or don’t need one, skip this step.
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Multi-theme management

Next Experience  multi-theme management offers a more personalized experience by enabling 
users to choose a theme that aligns with their personal preferences.

Multi-theme management is available for custom Next Experience  themes and themes created 
with Theme Builder.

• Publish multiple themes to your web experience and make your themes available to users 
for selection within the Next Experience  Theme user preference. For more information, see 
Publish multiple themes in Next Experience  and Publish your themes with Theme Builder.

• Themes are stored and managed within the UX Parent App [m2m_app_theme]  table. 
Themes created with Theme Builder  are automatically added to this table after publishing.

• Set one theme as the default to display first in the user's theme preference if they haven't 
made a selection.

• Control the order in which themes appear in the user's theme preference.

Publish multiple themes in Next Experience

Publish multiple themes and set the order of your Next Experience  custom and Theme Builder 
themes to configure how they’re displayed in the user's Theme preferences.

Before you begin
Role required: admin

About this task
Publishing multiple themes applies to web instances only.

Procedure

1. In the filter navigator, enter m2m_app_theme.list  and press Enter.
The UX Parent App Theme table appears. This table is used to store the association between 
multiple themes and a parent application.

2. Select New.

3. On the form, fill in the fields.

Note: 
Themes created with Theme Builder  are automatically added to the UX Parent App 
Theme table during publishing and don’t require a new record form. To create a theme 
with Theme Builder  see Create a theme with Theme Builder.

UX Parent App Theme record form

Field Description

Applicability Audience that the theme should apply to. For example, you might want to 
specify that the theme appears only for those users with an admin role.
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Field Description

Note: 
Leaving the Applicability  field empty applies the theme to all users.

Theme Theme that you want to add to the table.

Order Order in which the theme is displayed in the Next Experience  Theme user 
preference.

Note: 
The applicable theme with the lowest order is considered as the default 
and appears first in the Next Experience  Theme user preference. If the 
user has not made a selection from their Theme user preference, the 
theme with the lowest order in the UX Parent App Theme table is set as 
the default theme.

Application Application scope.

UX App Parent application that you want the theme to apply to.

4. Select Submit.
After the record has been added to the UX Parent App Themes table, you’re able to change the 
Applicability, Order, and UX App  fields, as needed. If no records are listed in the table and the 
glide.ui.polaris.theme.custom  value is empty, the Unified Navigation  base theme 
is displayed.

Configure login theming in Next Experience

Configure Next Experience  login illustrations and welcome text to provide a login experience that 
reflects your branding.

Before you begin
Role required: admin

About this task
This procedure is specific to login pages and does not apply if you are using Single Sign-On 
(SSO).

Procedure

1. In the filter navigator field, enter sys_properties.list.

2. Prevent the login screen from showing any illustrations by setting the property 
glide.ui.polaris.login.show_illustrations  to false.

3. Show welcome text by set the property glide.ui.polaris.login.show_welcome  to 
true.
If this property doesn't exist, add it as a true/false property. For more information, see Add a 
system property .

4. Edit the welcome page text.

a. Navigate to System UI  > Welcome Page Content.

b. Select New  to create a welcome page content record or open an existing one that you want 
to display on the login page.
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c. In the Condition field, enter !gs.getSession().isLoggedIn()the content displays 
only on the login page before a user signs in
The content displays only on the login page before a user signs in.

d. In the Text field, enter the welcome message or login information you want users to see.

e. Select the Active check box.

f. Select Update.

Result
The welcome text appears on the Next Experience  login page when users are not logged in and 
is hidden after authentication.

Customize the Next Experience  login background illustration

Customize and change the background illustration applied to your Next Experience  login page.

Before you begin
Role required: admin

About this task
This procedure is specific to login pages and does not apply if you are using Single Sign-On 
(SSO).

The background illustration that you upload automatically scales to fit the screen.

Procedure

1. Navigate to All  > System UI  > Images.

2. Select New  to create an image record.

3. On the new image record, enter a file name such as login_background.jpg

Note: 
Image names must end with .gif, .png, .jpg, .ico, .svg or .bmp.

4. Select Click to add  image.

Image record form

5. Choose your image file.

6. Select Update.
The Images table displays.

7. Enter your file name in the Name  field to confirm your new image is listed.

8. Navigate to the All  menu and enter sys_properties.list  in the filter navigator.

9. Select New  to create a system property.
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10. In the Name  field, enter glide.ui.login.style.background.image.

11. In the Value  field, enter your image file name.

12. In the Type  drop-down list, select String.

13. Verify that the Ignore cache option is selected.

14. Select Submit.

System property record

What to do next
Log out of your experience to view the new login page background.

Customize the Next Experience  login background color

Customize and change the background color applied to your Next Experience login page.

Before you begin
Role required: admin

If a background illustration is set, this image overrides any custom background color. Before 
proceeding, delete the glide.ui.login.style.background.image  system property if 
it exists. If you'd prefer to add an illustration to your Next Experience  login page, see Customize 
the Next Experience login background illustration.

About this task
This procedure is specific to login pages and does not apply if you are using Single Sign-On 
(SSO).

Set any RGB value for the background color. However, the login modal continues to display 
the default theme colors. The default theme is the theme that appears first in a user's Theme 
preference. When multiple themes are published and the user selects a theme other than the 
default, the login modal displays the default theme colors. For information setting the default 
theme for your Theme Builder  themes, see Set the default theme. For information setting the 
default theme for Theme Builder  and themes created manually using Next Experience, see 
Publish multiple themes in Next Experience.

Procedure

1. Navigate to the All  menu and enter sys_properties.list  in the filter navigator.

2. Select New  to create a system property.

3. In the Name  field, enter glide.ui.polaris.login.style.background.

4. In the Type  drop-down list, select String.

5. In the Value  field, enter an RGB value.
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An RGB value defines a color by combining red, green, and blue components, each 
represented by a number from 0 to 255, in the format R, G, B.

6. Verify that the Ignore cache option is selected.

7. Select Submit.

What to do next
Log out of your experience to view the new login page background color.

Remove the gradient from the Next Experience  login page

Remove the gradient from the Next Experience  login page and restore the solid color of your 
default theme.

Before you begin
Role required: admin

Before starting, delete any system properties you've created for background illustrations or 
custom background colors. These settings override the gradient color and must be removed to 
apply changes successfully.

• Background illustration system property: 
glide.ui.login.style.background.image

• Custom background color system 
property:glide.ui.polaris.login.style.background

About this task
The gradient feature inherits the colors of the default theme, which is the theme that appears first 
in the user's Theme preference menu when multiple themes are published, or it is automatically 
applied across the instance when only one theme is available. When the gradient is removed, 
the login page displays a solid color based on the default theme. This color does not reflect the 
theme the user selects manually if it differs from the default. For information setting the default 
theme for your Theme Builder  themes, see Set the default theme. For information setting the 
default theme for Theme Builder  and themes created manually using Next Experience, see 
Publish multiple themes in Next Experience.

Procedure

1. Navigate to the All  menu and enter sys_properties.list  in the filter navigator.

2. In the Name  field, enter glide.ui.polaris.login.show_illustrations.

3. In the Value  field, enter false  and select the green check mark to save your selection.

What to do next
Log out of your experience to view the new login page background color.

Next Experience  landing pages

Modify the landing pages on your Next Experience  instance so that users see a landing page 
tailored to their experience in ServiceNow.

In Next Experience, you can configure multiple landing pages. Next Experience  landing pages 
provide the information you need to start working. These landing pages typically present content 
specific to your role and tasks. Landing pages can include lists, Performance Analytics and 
Reporting (PAR) information, and other features to access your new and prioritized tasks from 
one location.
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By default, users on new Next Experience  instances see the Next Experience  landing page. 
Users on upgraded instances see the landing pages they had before in the Next Experience  UI. 
You can also set a Core UI  landing page for all users and configure user-specific landing pages.

Note: 
If you want to turn off the welcome splash screen after upgrading your instance, see Turn off 
the Next Experience welcome screen after upgrading your instance.

Create a Next Experience  landing page

Provide users the information that they need to start working by creating custom Next Experience 
landing pages for different audiences.

Before you begin
Creating custom Next Experience  landing pages requires configuring page components in 
UI Builder. For a quick tutorial on using UI Builder, see UI Builder quick start  in the UI Builder 
documentation.

Role required: ui_builder_admin or admin

About this task
Administrators can set various types of pages as the start pages that different users see when 
they log in to an instance. By default, a Next Experience  landing page is the start page for all 
users.

To customize a Next Experience  landing page for different audiences and use cases, you can 
create a variant of the default Next Experience  landing page using UI Builder, as described in this 
procedure. You can also create a Next Experience  landing page from scratch by creating a new 
page in UI Builder.

Note: 
This procedure doesn’t apply to creating landing pages for Configurable Workspaces.

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. From the Experiences list, select Unified Navigation App.

3. In the Pages and variants list, under Home, select either Next Experience Landing Page  or 
Next Experience Landing Page - Admin Role.
The Next Experience Landing page is the default landing page for non-admin users, and the 
Next Experience Landing Page - Admin Role is the default landing page for admin users. Select 
the page that aligns with the audience for which you need to create a custom landing page.

4. Optional:  From the top bar, change the application scope you work in by selecting the 
application scope from the application picker.

5. Create a variant of the default landing page by duplicating it.
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a. From the left vertical bar, select the context menu and then select Duplicate variant.

Example 

b. In the Name  field, enter a name for the page variant.

c. Optional:  Next to the Audiences  field, select Add  and then select an audience from the list.

(Optional) The audience defines who can see a page. By default, all users can see a page. 
For more information about audiences, see Learn about audiences  in the UI Builder 
documentation.

d. Optional:  In the Conditions  field, add criteria for when to display the page by entering an 
encoded query string.

Example 
For example, the query string table=incident^sysId!=-1  will only show this page 
variant if the table field is incident and the sysId field isn’t -1.

e. Select Create.

6. Customize the components on the page according to the needs of your audience.

You can customize what components are included on the page, the data they connect to, their 
style, and event mappings. To learn more about how to customize components on a page, refer 
to Customize UI Builder pages using components  in the UI Builder  documentation.

To enable a footer for the page, see Configure a Next Experience landing page footer.
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Customize a landing page in UI Builder

7. Select Save.

8. Set this page variant as the start page for the selected audience.

a. From the top bar, select Settings.

b. In the Order  field, set the priority order of the page variant to a lower number than the order 
of the default Next Experience  landing page.

By default, the order of the default Next Experience Landing page is set to 1000, and the 
order of the Next Experience Landing Page – Admin is set to 99. The lower the number, the 
higher the priority.

c. Select Save.

Configure per-user landing pages in Next Experience

Users on new Next Experience  instances see the Next Experience  landing page. Users on 
upgraded instances see the landing pages that they had before, in the Next Experience  UI. You 
can also configure user-specific landing pages.

Before you begin
Role required: admin

About this task
Next Experience  landing pages provide the information you need to start working. These landing 
pages typically present content specific to your role and tasks. Landing pages can include lists, 
Performance Analytics and Reporting (PAR) information, and other features to access your new 
and prioritized tasks from one location.

Procedure

1. Navigate to User Administration  > User Preferences.

2. Select New.

3. In the Name  field, enter my_home_navigation_page.
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4. In the User  field, select the search icon and assign a user.
You can have multiple entries of this preference for different users.

5. Specify the value of the landing page.
For example, to use the Visual Task Board overview as the landing page, enter $vtb.do. The 
value for any selected landing page is found within the URL. To assign a specific VTB, enter the 
portion of the URL from $vtb.do  onward.

Note: 
When you copy the URL information, replace any HTML entities with their decoded 
values. For example, replace the entity %24  with $.

6. Select Update.

Result
The user sees the specified landing page when they log on to ServiceNow®  or when they select 
the company logo.

Configure a user-selected start page

Configure a user-selected start page to override the administrator‑configured  default landing 
page to appear when you log in to ServiceNow.

Before you begin
Ensure you have enabled the Next Experience  prior to beginning this task. For more information, 
see Considerations for activating Next Experience.

Role required: none

Procedure

1. The admin must enable the 
glide.next_experience.user_selected_landing_page_enabled  system 
property.

a. Select All  to open the navigation filter, enter sys_properties.list, and press Enter to 
view the System Property table in list view.

b. Locate and open the 
glide.next_experience.user_selected_landing_page_enabled  property.

c. Verify that Value  is set to true.

2. In your instance, select the user menu .
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3. In the user menu list, select Preferences.

4. Select the User Experience  tile.

5. Select the Current start page  list.

6. Choose your start page from these options.

Current start page list

Field Description

Use the default The default landing page as configured by 
the administrator.

Use Dashboards If using Core UI responsive dashboards, the 
start page is set to the last dashboard you 
visited.

Use the page that I'm on now Set the current page as your default start 
page.

Continue where I last left off Set the last page you visited in ServiceNow 
as the start page when you next log in.

Configure a Core UI global landing page in Next Experience  enabled instances

Set a Core UI landing page for all users so users on instances with Next Experience  enabled see 
the same landing page as users on upgraded instances. Upgraded users see the landing pages 
they had before in the Next Experience  UI.

Before you begin
Role required: admin

About this task
Next Experience  landing pages provide the information you need to start working. These landing 
pages typically present content specific to your role and tasks. Landing pages can include lists, 
Performance Analytics and Reporting (PAR) information, and other features to access your new 
and prioritized tasks from one location.

Values in the user preference my_home_navigation_page  override the 
value in the glide.login.home  system property. If no user is specified in 
my_home_navigation_page, the value in the preference overrides glide.login.home 
for all users.

Procedure

1. In the filter navigator field, enter sys_properties.list.

2. Edit the value of the glide.login.home  system property to set an instance-wide Core UI 
landing page.
For example, to assign the Dashboards Overview as the landing page, you would enter 
$pa_dashboard.do. To assign a specific dashboard as the landing page, you would enter 
the portion of the URL from $pa_dashboard.do  onward.

Note: 
When you copy the URL information, be sure to replace HTML entities with their decoded 
values. For example, replace the entity %24  with $.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

204



3. Select Update.
You will not see the new landing page until you log out and log back in again.

Result
When users log in, they see the selected landing page instead of the default.

Configure a Next Experience  landing page footer

Display useful links in the footer of your Next Experience  landing pages. The footer contains two 
fully configurable link set components.

Before you begin
Role required: admin

About this task
Next Experience  landing pages provide the information you need to start working. These landing 
pages typically present content specific to your role and tasks. Landing pages can include lists, 
Performance Analytics and Reporting (PAR) information, and other features to access your new 
and prioritized tasks from one location.

The footer is hidden by default. To configure the footer, you enable it in UI Builder and then edit 
the link set components.

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. From the UI Builder home page, select Experiences.

3. In the search experiences field, enter Unified Navigation App.

4. In the Variants section, select the More options icon  for the Next Experience Landing Page - 
Admin Role and select Duplicate.
The main variant of the landing page is read-only. To edit, you work in a copy.
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5. In the variant creation modal, keep all fields as-is and select Create.

6. In the Next Experience Landing Page - Admin Role Copy Content Body outline, select Client 
State Parameters.

7. In the Client state parameters section, clear the hideResourcesSection  initial value check box.
This action enables the landing page footer.

8. Select the Apply.
The default footer is visible with two link sets: Frequent visits and Learn more.

9. To configure the links in the footer, select Link set 1 or Link set 2 under Container 5.

10. In the Config section, edit the links.
For more information, see Link set UIB Setup  in the ServiceNow  Developer documentation.

Next Experience  default admin landing page

Use the default admin landing page to see your admin-specific work at a glance and identify 
items that need attention including open tasks, security issues, and approvals.

As an admin, a variant of the landing page for admins displays for you. Admin landing pages 
might include the following items:

• Number of installed apps that have updated versions available

• Number of entitled but not activated or not installed apps

• Real-time security notifications

• Lists and visualizations of your assignments

• More resources to learn about features
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New Customers

New customers launching on San Diego  or customers that have performed a zBoot on 
their instance will have the Next Experience  UI automatically enabled on their instance. 
These customers also have the Default landing page that ships with the Next Experience  UI 
automatically enabled.
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Existing Customers

Existing customers upgrading from a previous release will not see the default landing page upon 
activating the Next Experience UI. Existing customers will continue to see their existing start 
page (Homepage or Dashboard). By utilizing existing start pages, this provides administrators 
the ability to turn on the Next Experience UI and allow for users to begin using the new user 
interface, and provides administrators the time to create organization specific landing pages. 
Existing customers can use the Default Landing Page by modifying the glide.login.home  system 
property, though it is recommended to perform testing on the Default Landing Page in a sub-
product instance to verify it meets current user needs.

Performing admin user functions in Next Experience

Use admin functions in the Next Experience  user menu to elevate roles, impersonate users, and 
configure a workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to User Menu

2. Select one of these user menu options for admins.

Field Description

Impersonate user Option to impersonate other authenticated 
users for testing purposes and to view 
impersonation logs. For more information, 
see Impersonate a user .

Elevate role Option to elevate to a privileged role to 
gain access to the features of High Security 
Settings for the current session. For more 
information, see Elevated privilege roles .

Note: 
Users granted the admin role can't 
elevate to a privileged role. Only the 
base system admin can be elevated.

Configure Workspace Dynamic links to configuration pages to 
access configurations relevant to lists or 
forms more easily. These items display in the 
user menu when a workspace is in focus.

◦ Configure workspace: Link to configure 
the workspace in UI Builder.

◦ Configure page: Menu to configure page 
elements in the classic environment. The 
items display dynamically to show items 
that pertain to lists and items that pertain to 
forms.
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Configure custom menus for Unified Navigation

Create custom menus in the Next Experience  Unified Navigation  that contain just what the users 
need to increase productivity and efficiency.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Unified Navigation Menus.

2. Select New.

3. On the form, fill in the fields.

Unified Navigation  Menu form

Field Description

Name Name of your Unified Navigation  Menu.

Menu Active Menu that is active when checked.

Order Order that the menu appears in place of 
other menus.

Application Scope of the menu. Global  is the default.

Hidden Roles Roles that this menu is hidden from.

Visible Roles Roles that this menu is visible to.

4. Select Submit.

5. To configure Unified Navigation  configurable menu items, select your menu from the Unified 
Navigation Menus list.

6. Select New. The form displays the Application  or Module  field, depending on your selection.

7. On the form, fill in the fields.

Unified Navigation  configurable menu items form

Field Description

Menu Name of the menu that you are adding the 
new menu items to.

Type Type of menu item that you are creating.

◦ Application

◦ Module

Application or Module Application  or Module  that you are adding 
as a menu item.

Application (scope) Scope of the menu item. The default is 
Global.

Order Order that the menu item appears in the 
menu list.

8. Select Submit.
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9. Select Save  or Update.
The new menu is displayed. If it does not appear, ensure that active is marked and then refresh 
your instance.

Add a workspace to the Unified Navigation  Workspaces menu

Configure the Unified Navigation  to display a workspace in the Workspaces menu.

Before you begin
Role required: admin

About this task
The available workspace displays in the Unified Navigation  when you have access to at least 
one workspace. Multiple workspaces display in the Workspaces menu when you have access to 
more than one workspace.

Procedure

1. Navigate to All  > Now Experience Framework  > Experiences.

2. Select the application that you want to add to the Workspaces menu on the Unified Navigation.

3. In related lists, select the UX Application Category M2Ms  tab.

4. Select New  in the UX Application Category M2Ms list.

Note: 
The New  button only displays if you have access to the selected application.

5. Select Workspace  in the Experience Category column.

6. On the form, fill in the fields.

UX Application Category M2M form

Field Description

Experience Category Category of the experience added to the 
Unified Navigation. Select Workspace.

Application Application that the experience applies to. 
Global is the default application and applies 
across the organization.

UX Application UX application that you want to add to the 
Workspaces  menu. Select the Workspace 
you want to display in the Workspaces menu.

Order Order in which the Workspace  you select is 
displayed in the Workspaces menu.
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Field Description

Note: 
This option is enabled once the 
glide.ui.next_experience.workspace_sorting 
system property has been created. 
For more information, see Set the 
order of your workspaces in the Unified 
Navigation Workspaces menu.

7. Select Submit.

8. Refresh your browser to access the new workspace from the Workspaces menu.

Set the order of your workspaces in the Unified Navigation  Workspaces menu

Set the order of your workspaces and control how they appear in the Unified Navigation 
Workspaces menu.

Before you begin
To enable ordering of your workspaces, you must create a system property 
glide.ui.next_experience.workspace_sorting  and set the value to Order. For 
more information, see Add a system property .

Role required: admin

Procedure

1. In the filter navigator field, enter sys_ux_registry_m2m_category_list.do  and 
press Enter.
The UX Application Category M2Ms table appears. This table is used to store the association 
between an application and the experience category.

2. Select the Preview record icon  for the workspace that you want to order.

3. Select Open Record  to open the UX Application Category M2M form.

4. In the Order  field, enter a numerical value.

Note: 
The lowest ordered workspace appears first in the Workspaces menu.

5. Select Update.

Configuring search in Next Experience

Administrators can customize Next Experience  search settings. Add new searchable tables, 
modify the fields displayed for search results from a table, or add workspace applications to the 
search context menu for users.

Next Experience  search is enabled by default in the Unified Navigation.

Add a searchable table

A search source specifies a table to include in Next Experience  search. The search results page 
displays matching records and their counts on a per-table basis. Users can select a table to filter 
their search results, displaying only matching records from the selected table.
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To make a table searchable in Next Experience, add it as a new search source. For details on this 
procedure, see Add a search source for Next Experience .

For the list of tables searchable by default in the base system, see Default global search sources 
for Next Experience .

Modify the fields displayed for each search result from a table

The text_search list view for a searchable table determines which fields the system uses to 
populate the title, field list, and description for each result from that table.

To learn how the system uses fields in the text_search list view to populate search result entries, 
see Text search views control format of global search results for tables .

For the list of fields included in the base system's text_search list views for the default 
searchable tables, see Default display fields for global search tables .

Add a workspace application to the search context menu

The search context menu enables users to view and open search results in available workspace 
applications as well as in global search.

To add a workspace application to the search context menu, see Add a workspace application to 
the Unified Navigation  search context menu .
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For details on using the search context menu, see View and open search results using 
workspace applications in Next Experience  Unified Navigation .

For more information on configuring search settings in Next Experience, see Global search finds 
records from multiple tables .

Create custom notifications in Next Experience

Provide better context and information about users' work by creating custom content for in-
product notifications in Next Experience.

Before you begin
Role required: admin

About this task
Create notifications with custom title and message content for your applications and use cases. 
Next Experience  notifications appear as toast banners and in the Notifications menu.

Note: 
Next Experience  notifications aren’t supported in the legacy Agent Workspace.

Procedure

1. Navigate to All  > System Notification  > Provider  > Notifications.

2. Select New.

3. On the form, fill in the fields.

Notifications form

Field Description

Name Name of the notification.

Application Application scope of the notification.

Active Option to activate the notification. The notification is active by 
default.

When to send

Trigger System action that triggers the notification. You can send the 
notification after a record is changed or after an event is triggered.

Inserted
Option to send the notification after a record is inserted.

This field appears when you select Record Change  in the Trigger 
field.

Updated
Option to send the notification after a record is updated.

This field appears when you select Record Change  in the Trigger 
field.

Event
Event that triggers the notification. For example, to send a notification 
after an incident is closed or resolved, you would select the 
incident.inactive  event. By default, this event is logged in the 
system each time a user resolves or closes an incident.
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Field Description

Note: 
You can select only an event that shares the same table as the 
notification.

This field appears when you select Event  in the Trigger  field.

Table Table to receive notifications about.

Conditions Filter to specify the table records that users receive notifications 
about. For example, to send notifications about top-priority incidents, 
you would select Incident [incident]  in the Table  field and set the 
conditions to [Priority] [is] [1 - Critical].

Who will receive

Users Users who receive the notification.

Note: 
Notifications in messaging channels are sent only to users 
with ServiceNow  accounts (sys_user profiles). Consumers and 
customer contacts are considered as guests and can’t receive 
notifications in messaging channels.

Recipients listed in 
fields

Record fields that include users who receive the notification. For 
example, to send the notification to the record assignee, select 
Assigned to.

Note: 
This field shows up only if you select a table.

Include the person 
whose action 
triggered the 
notification

Option to include the user who changed the record or triggered the 
event.

Recipient(s) listed in 
event parm1

Option to select whether Parm 1 contains a list of comma-separated 
sys_ids. For more information, see Classic Events .

Recipient(s) listed in 
event parm2

Option to select if Parm 2 contains a list of comma-separated sys_ids

Table containing 
recipients from event 
parm1

Table that is used to resolve the sys_id of the recipient

Note: 
This field appears only when you select Event parm 1.

Table containing 
recipients from event 
parm1

Table that is used to resolve the sys_id of the recipient

Note: 
This field appears only when you select Event parm 2.

Advanced event 
condition

Option to select when the recipients are from more than two tables. 
These are dynamic conditions.

4. From the form context menu, select Save.
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5. Select the Contents  tab and then select New Provider Content.

6. Select Next Experience  as the content provider.

7. On the form, fill in the fields.

Notification Next Experience Content form

Field Description

Name An internal name for the notification content.

Notification The notification trigger that sends the notification content.

Active Option for whether the notification is sent when triggered.

Table Table to receive notifications about.

Route Next Experience Route

Message 
Heading

Header text at the top of the message. From the Select variables list, you can 
select variables to include your message heading.

Message Secondary text of the message that follows the heading. From the Select 
variables list, you can select variables to include your message body.

Example 

The following example shows the values for a notification with custom content that references 
the number and short description of an incident.

Field Value

Name Incident record update content

Notification Incident records

Active true

Message Heading ${number} changed

Message Short description: ${short_description}

8. Select Submit.

Result
When triggered, users configured to receive the notifications see notifications with custom 
content as banners and in the Notifications menu in the Next Experience  Unified Navigation.

The UI Notification Inbox [ui_notification_inbox] table lists all sent notifications and their 
recipients.

Trouble? 

If users receive duplicate notifications, verify that the notification trigger has only one content 
provider. If the notification has both a Next Experience  and Workspace content provider, remove 
the Workspace content provider from the notification trigger to send only the Next Experience 
notification with custom content.
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Next Experience  in-product help

Providing instructions that display in your Next Experience  UI can help orient your users to the UI 
and provide information about their tasks.

In-product help enables you to provide various types of instruction that appear in the UI to 
help users perform their work. These instructions include information about the UI page the 
user is looking at, embedded help content based on roles, onboarding users through a guided 
tour of the UI, and assistance setting up products. You can modify the content that appears in 
the Unified Navigation  onboarding or create your own onboarding. For more information, see 
Adoption services.

Next Experience  banner announcements

Banner announcements enable you to communicate planned maintenance, unplanned outages, 
or important events like ESPP stock plans or benefits enrollment to those affected or to everyone. 
You can target specific experiences or all experiences.

Note: 
Beginning with the San Diego  release, configure banner announcements instead of 
updating the glide.product.description  system property.

You can configure the following aspects of banner announcements:

• Use colors and icons to communicate the type of announcement and the importance of the 
banner announcement.

• Provide a link for information or to complete a task.

• Schedule banner announcements for a specific time.

Note: 
If a user dismisses a banner announcement during a session and the announcement is 
still active, it will re-appear once the user logs out and back in to a new session.

Configure Next Experience  banner announcements

Configure banner announcements to communicate important information to your users while 
they are in an experience.

Before you begin
Role required: announcement_admin or admin

Procedure

1. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX Banner 
Announcements  to create an announcement.

2. Select New.

3. On the form, fill in the fields.

Banner Announcements form

Field Description

Heading Unique name for your banner announcement 
mapping that displays as the title.
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Field Description

Note: 
The heading character limit is 100 
characters.

Summary Optional additional banner content that 
displays below the Heading.

Note: 
The summary character limit is 200 
characters.

Start Date and time the banner announcement 
begins displaying in the UI.

End Date and time the banner announcement 
stops displaying in the UI.

Color Color to show the importance or urgency of 
the banner announcement.

Add a link
Option to provide a link in the banner 
announcement.

Note: 
The link label character limit is 50 
characters.

Enabling this option displays the following 
link configuration fields:

◦ Select behavior: Behavior of the link when 
selected, either opening in the same 
window or a new window.

◦ Label: Text displayed with the link.

◦ URL: URL of the link.

Non-dismissible Option to make the banner non-dismissible 
by users. Non-dismissible banners cannot be 
closed.

Non-stackable Option to make the banner non-stackable. 
Non-stackable banners are displayed 
individually in the banner announcement 
area.

Show for Scope of the banner announcement display, 
either for all logged-in users, users with 
specific roles or groups, or anonymous plus 
all logged-in users.

Icon Icon to depict the urgency or category of 
the banner announcement. For example, a 
flame icon shows increased urgency and a 
graduation cap icon notifies of continuing 
learning opportunities.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

217



Field Description

Icon tooltip Text describing the icon.

Content position Options for the horizontal position of the 
banner content.

4. Right-click the form header and select Save.
The Associated to Configurations related list displays at the bottom of the form.

5. In the Associated to Configurations related list, select New.

Associated to Configurations related list

6. In the Announcement Config field, select the search icon .

7. Select Unified Navigation  from the Banner Announcement Configs list.

Banner Announcement Configs list

8. Optional:  On the Banner Announcement Mapping form, set the order of the banner 
announcement mapping.
The lower the order of the banner announcement mapping, the higher the priority is of the 
banner announcement mapping.

9. On the Banner Announcement Mapping form, select Submit.

10. On the Banner Announcement form, select Update.

Exploring Next Experience  pickers

Next Experience  scope pickers provide easy consistent scope selection across your instance.
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The scope selection menu icon ( ) displays in the Unified Navigation  for users with roles that 
provide access to the application, domain, and update set scope pickers.

Any non-Global application scope displays a red circle on the scope selector menu icon ( ).

The instance tools icon ( ) displays the application scope and current 
update set in a horizontal row beneath the other tool icons in the Unified 
Navigation. To enable this feature, you must create a system property called 
glide.ui.next_experience.instance_tools_disabled  and set it to False. When 
this feature is enabled, the scope selector icon is hidden.

• Application scope: Enables application developers to view and select the application where 
their changes apply. For more information, see Application scope .

• Domain scope: Defines what users can access. Only users with access to domain separation 
see the domain scope picker. For more information, see Domain scope .

• Update set: Enables admin users to choose an update set for making and tracking 
customizations. For more information, see Exploring System Update Sets .

• Crypto module selector: Enables users with more than one cryptographic 
module to select a module when entering data. This picker displays instead of the 
encryption context selector when the Key Management Framework  is enabled 
through the com.glide.kmf.global  system property and the system property 
glide_encryption.cle_replatforming_with_kmf sys_prop  is set to opt_in. 
For more information, see Create a cryptographic module .

Keyboard shortcuts for the scope selector menu

Add keyboard shortcuts for scope selector menus to be able to navigate scope selectors using 
your keyboard.

Keyboard shortcuts for scope selector menus must be configured. They aren't available by 
default.

Note: 
Each of the pickers below includes two system properties that the admin must create. The 
Value  field of the first one must be set to true. The Value  field of the second one must be 
set to the keyboard combo for the picker.

Scope selector menu keyboard shortcuts

Picker Properties Default key shortcut

Application • glide.ui.keyboard.shortcuts.polaris.application_picker.enabled

• glide.ui.keyboard.shortcuts.polaris.application_picker.key_combo

ctrl+alt+a

Domain • glide.ui.keyboard.shortcuts.polaris.domain_separation_picker.enabled

• glide.ui.keyboard.shortcuts.polaris.domain_separation_picker.key_combo

ctrl+alt+d
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Scope selector menu keyboard shortcuts  (continued)

Picker Properties Default key shortcut

Update set • glide.ui.keyboard.shortcuts.polaris.update_set_picker.enabled

• glide.ui.keyboard.shortcuts.polaris.update_set_picker.key_combo

ctrl+alt+u

Next Experience  client-side scripting global variables

Next Experience  global variables are used in client scripts to determine whether Next Experience 
is applied to a page.

NOW.isUsingPolaris

Returns true  if Next Experience  is applied to the current page.

NOW.isPolarisWrapper

Returns true  if the page is running in the Next Experience  Unified Navigation. This 
global variable exists only in the Unified Navigation.

For more information about the Unified Navigation, see Using the Next Experience 
Unified Navigation.

Client script:

// Reload the current page in the unified navigator if not 
 currently in the unified nav
if (NOW.isUsingPolaris && (!top.NOW || 
 top.NOW.isPolarisWrapper !== "true")) {
    var currentPath = window.location.pathname + 
 window.location.search;
    top.window.location.href = 
 "/now/nav/ui/classic/params/target/" + 
 encodeURIComponent(currentPath)
}

Related topics

PolarisUI API - Scoped

Next Experience  system properties

List of system properties related to the Next Experience  UI.

Next Experience  UI system properties

Property Type Default value Description

glide.ui.polarisberg true | false true Disables 
the Core UI 
styles for lists 
and forms 
in the Next 
Experience.

glide.ui.polaris.core_ui_exclude_dark_mode true | false true Excludes 
dark theme 
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Next Experience  UI system properties  (continued)

Property Type Default value Description

in the classic 
environment.

glide.ui.polaris.dark_themes_enabled true | false true Enables dark 
theming.

glide.ui.polaris.experience true | false true Enables 
the Unified 
Navigation 
experience on 
platform.

glide.ui.polaris.global_search true | false true Toggle the 
Unified 
Navigation 
search 
functionality 
in the header.

glide.ui.polaris.history.url.param_blocklist string ["tinyId"] URL 
parameters to 
ignore when 
removing 
duplicate 
URLs from the 
History menu.

glide.ui.polaris.list_style.enable_highlighted_value_styletrue | false true Enable the 
highlighted 
value style 
on list cells. 
When false, a 
dot displays 
next to 
values in lists 
rather than a 
highlight color 
over the value.

glide.ui.polaris.style.hide_empty_list_image true | false true Hide the 
graphic that 
appears when 
a screen with 
no records is 
selected.

Note: 
This 
system 
property 
applies 
only to 
the Core 
UI.
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Next Experience  UI system properties  (continued)

Property Type Default value Description

glide.ui.polaris.menus true | false true Toggle the 
Unified 
Navigation 
menus in the 
header.

Note: 
If false is 
needed, 
it’s 
recommended 
to hide 
menus 
from 
specific 
roles.

glide.ui.polaris.login.show_illustrations string true Enables the 
display of 
illustrative 
graphics on 
the default 
login page.

glide.ui.polaris.login.style.background RGB colors Changes 
the login 
background 
color.

glide.ui.polaris.login.style.background_gradient_beginRGB colors Changes the 
colors of the 
beginning 
of the login 
background 
gradient.

glide.ui.polaris.login.style.background_gradient_endRGB colors Changes 
the colors 
of the end 
of the login 
background 
gradient.

glide.ui.polaris.login.style.mountain_primary RGB colors Changes the 
primary colors 
of the login 
mountain 
graphic.

glide.ui.polaris.login.style.mountain_secondary RGB colors Changes the 
secondary 
colors of 
the login 
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Next Experience  UI system properties  (continued)

Property Type Default value Description

mountain 
graphic.

overview_help.visited.navui string true Determines if 
the pop-up for 
Onboarding 
appears 
when the 
user logs in to 
an instance 
using Next 
Experience 
UI for the first 
time.

glide.ui.polaris.nav_filter_accuracy_score integer 75 Controls 
accuracy of 
the filtering 
in the Unified 
Navigation 
menus. The 
higher the 
number, the 
more accurate 
the match 
must be. A 
value of 100 
means an 
exact match is 
required.

Measuring the performance of your instance in Next Experience

View the performance-based information, including the UI loading times, for any recently 
accessed Next Experience  page by using the client interaction table.

Key Benefits

• Monitor your instance performance proactively and view this information for up to seven days.

• Identify and investigate performance issues, such as slow UI load times.

• View the server response times.

The following table lists the performance data that you can view in the client interaction table. 
You can find this table by navigating to All  > System Logs  > Client Interactions.

Next Experience  client interaction table

Header items Description

Created Date and time that the record was created.

Total UI Time Time, in milliseconds, that the page takes to 
load.
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Next Experience  client interaction table  (continued)

Header items Description

Content Download Time Time, in milliseconds, that the content takes to 
get from the server to the client.

UXF Screen Route Route that is used to load the page for the 
given experience. For example, if you’re 
accessing the page from a list or form, Classic 
is displayed. If you’re accessing a workspace, 
the route that is defined in UI Builder  is 
displayed.

Referrer URL being accessed.

Application Application that the URL belongs to.

Type Interaction that is being measured. Type 
options include:

• PAGE_LOAD: Indicates that the interaction 
was a full page load.

• NAVIGATION: Indicates that the interaction 
was routed within a single page application.

• IN-PAGE: Indicates the time that the 
interaction within the page has taken and is 
captured for limited interactions.

Interruption Type of page load interruption and information 
about the type of interruption. If there was no 
interruption, the record displays none. The 
page load interruptions can impact the total UI 
time metric.

Name Contextual information for in-page 
interactions.

Data Contextual information for in-page 
interactions.

View the server response time

View the server response times that are associated with your Next Experience  instance by using 
the client interaction table.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Logs  > Client Interactions.

2. Select the personalized list icon ( ) within the Unified Navigation banner frame.

3. Select the Interaction ID from the Available column and move it to the Selected column.

4. Select OK.
The client interaction table reloads to show the changes.

5. Copy the interaction ID for the URL that you want to investigate.
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6. From the filter navigator, enter syslog_transaction.list  in the search field.

7. From the transaction table, select the personalize list icon , within the banner frame.

8. From the Available column, select the Client Interaction ID and move it to the Selected column.

9. Select OK.

10. In the Transaction log list, select the Client Interaction ID and paste the interaction ID into the 
Search  field.

11. Press Enter.
The server response times for that particular interaction are displayed.

Configurable Workspace  UI
The Configurable Workspace  UI provides a suite of tools in a single, focused work area to help 
you answer customer questions and resolve issues.

Get started

Explore

Learn about Configurable 
Workspace concepts 

and features.

Configure

Set up your Configurable 
Workspace environments, 

tools, and access.

Administer

Manage and 
customize your 

Configurable Workspace.

Work

Use your Configurable 
Workspace to answer 
customer questions 
and resolve issues.

Reference

Get additional 
information about the 

Configurable Workspace.

Exploring Configurable Workspace

Get an overview of Configurable Workspace  so you can understand how to configure and use it 
for your organization.

Configurable Workspace  overview

A workspace  provides a suite of tools in a single, focused work area that enables an agent to 
complete an entire job efficiently.
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For example, an agent can receive an incoming case, review its details, communicate with the 
requester, and close the case within a single interface.

Configurable Workspace  is a workspace app shell  provided by the ServiceNow AI Platform®.

ServiceNow  offers prebuilt Configurable Workspace  experiences to target specific users and 
issues. For a list of workspaces ServiceNow  offers, see List of workspaces.

UI Builder  and Configurable Workspace

Admins  use UI Builder  to create a Configurable Workspace  experience from scratch or to modify 
prebuilt workspaces to match their workflows, branding, and data needs.

UI Builder  is a WYSIWYG web user interface builder that uses Next Experience Components  as 
the building blocks for Configurable Workspace  pages. Each component  provides a specific 
function like showing a list of records or displaying a form.

Parts within a Configurable Workspace

Configurable Workspace  experiences are made up of several parts that help agents navigate, 
manage, and work on records.

Lists

Lists display multiple records in a Configurable Workspace, such as cases, task, or 
incidents, so that agents can find and work on records quickly.

Forms

Forms enable agents to view, enter, and update details about the record.

Activity stream

The Activity stream  helps agents stay informed by displaying a running history of 
updates and communications within a record.

Compose

The Compose area in a record page enables agents to communicate with 
customers and other agents through comments, work notes, and emails.

Tabs sidebar

The tabs sidebar is a flexible panel on a record page that provides agents with 
additional tools and information displayed as tabs like Agent assist  and form 
templates.

Lists

Learn about the components in UI Builder  that enable admins to create and customize lists and 
list pages for a Configurable Workspace.

Lists overview

A list  is a content page that displays zero or more records from a database table. The list has 
rows and columns. Each row is a record, and each column is a field from the record.

Lists display multiple records in a Configurable Workspace, such as cases, task, or incidents, so 
that agents can find and work on records quickly.
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List pages in Configurable Workspace

A list page is a workspace page designed to help agents navigate, filter, and manage records. List 
pages for Configurable Workspace  are created with the List page template in UI Builder. The List 
page template includes the Record List component bundle and List menu component.

Record List component bundle

The Record List component bundle includes the following components.

Record List Header

The Record List Header shows contextual information about the list.

Presentational List

The Presentational List displays the actual list of records from any data source in a 
tabular format.

The Record List component bundle is configured by admins in UI Builder.

List menu component

The List menu component displays all available and saved lists for the selected source. It's not 
included in the Record List component bundle itself but exists within a list page.

The List menu component includes the following tabs.

Default lists

The Default lists tab displays all available lists based on the selected source. These 
lists gives agents quick access to relevant records.

My lists

The My lists tab enables agents to access their saved lists that help streamline 
repeat workflows and create their own lists from an existing list or by selecting a new 
source.

The List menu component is configured by admins in UI Builder. For information on List menu 
component configurations, see List menu UIB Setup .

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

227

https://developer.servicenow.com/dev.do#!/reference/next-experience/yokohama/now-components/now-record-list-menu-connected/uib-setup
https://developer.servicenow.com/dev.do#!/reference/next-experience/yokohama/now-components/now-record-list-menu-connected/uib-setup
https://developer.servicenow.com/dev.do#!/reference/next-experience/yokohama/now-components/now-record-list-menu-connected/uib-setup


Predicate Builder

The Predicate Builder component enables agents to set conditions from the list header to filter 
which records appear in a list.

The Predicate Builder is configured by admins in UI Builder.

Forms

Learn about the components in UI Builder  that enable admins to create and customize forms for 
a Configurable Workspace.

Forms overview

A form  is a content page that displays fields and values for a single record from a database table.

Within a Configurable Workspace  record, the form enables agents to view, enter, and update 
details about the record.

For example, an agent can update the short description, priority, assignment group, and status 
within an incident record form.

Form component bundle

The Form component bundle in UI Builder  displays record data and enables interaction with 
fields. It includes the Form component connected to the Form controller.
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The standard record page template in UI Builder  uses the Form component bundle alongside 
other components that create a record page. While the standard record page template offers a 
useful starting point, admins can customize or build their own record pages as needed.

The Form component bundle is configured and customized by admins in UI Builder. For 
information on Form component configurations, see Form UIB Setup .

Related lists

While the form displays field-level data for a single record, related lists  show records from other 
tables that are linked to the current record like tasks or associated incidents.

The standard record page template in UI Builder  often displays related lists as tabs alongside the 
form that provides details about a record.

The Record List component bundle enables related lists as a list type and is configured and 
customized by admins in UI Builder.

Activity stream

Learn about the components in UI Builder  that enable admins to create and customize the 
Activity stream  for a Configurable Workspace.

Activity stream overview

The Activity stream  helps agents stay informed by displaying a running history of updates and 
communications within a Configurable Workspace  record like field changes, comments, work 
notes, and emails.

Activity Stream component

The Activity Stream component in UI Builder  displays a list of changes made to a record.

The standard record page template in UI Builder  uses the Activity Stream component alongside 
other components that create a record page. While the standard record page template offers a 
useful starting point, admins can customize or build their own record pages as needed.

The Activity Stream component is configured and customized by admins in UI Builder. For 
information on Activity Stream component configurations, see Activity Stream UIB Setup .
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Compose

Learn about the components in UI Builder  that enable admins to create and customize the 
Compose section for a Configurable Workspace.

Compose overview

The Compose area in a Configurable Workspace  record page enables agents to communicate 
with customers and other agents through comments, work notes, and emails.

Activity Stream Compose component

The Activity Stream Compose component enables agents to create new journal entries for the 
Activity stream  and is configured and customized by admins in UI Builder. For information on 
Activity Stream Compose component configurations, see Activity Stream Compose UIB Setup .

Email components for Compose

Email composer

The Email composer component enables agents to draft and send emails from a 
separate workspace tab using the full email composer.

The Email composer component is configured and customized by admins in UI 
Builder. For information on Email composer component configurations, see Email 
composer UIB Setup .

Email composer (mini)

The Email composer (mini) component enables agents to draft and send emails 
directly from the record page using the mini email composer.

The Email composer (mini) component is configured and customized by admins in 
UI Builder. For information on Email composer (mini) component configurations, see 
Email composer (mini) UIB Setup .

Tabs sidebar

Learn about the components in UI Builder  that enable admins to create and customize the tabs 
sidebar for a Configurable Workspace.
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Tabs sidebar overview

The tabs sidebar is a flexible panel on a record page that provides agents with additional tools 
and information displayed as tabs.

Tabs component

The Tabs component displays tabs for the contextual sidebar is configured and customized by 
admins in UI Builder. For information on Tabs component configurations, see Tabs UIB Setup .

Standard record page tabs

The standard record page template in UI Builder  displays some tabs by default. If you're using 
a prebuilt workspace like CSM Configurable Workspace  or Service Operations Workspace, 
additional tabs may be configured for you based on the needs of that product.

The following components are added as tabs for the standard record page template.

Agent assist

Agent assist  helps an agent resolve issues by providing a list of resources related to 
an open record's short description.

Attachments

The Attachments tab enables an agent to add, preview, download, or remove files 
from the current record.

Form templates

Form templates simplify the process of submitting new records by populating fields 
automatically.

Agent assist

Learn about the Agent assist  component in the tabs sidebar for a Configurable Workspace 
record page.

Agent assist  helps an agent resolve issues by providing a list of resources related to an open 
record's short description.

It appears as a tab within the tabs sidebar for a standard record page.
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The Agent assist component is configured and customized by admins in UI Builder. For 
information on Agent assist component configurations, see Agent assist UIB Setup .

Attachments

Learn about the Attachments component in the tabs sidebar for a Configurable Workspace 
record page.

The Attachments tab enables an agent to add, preview, download, or remove files from the 
current record.

It appears within the tabs sidebar for a standard record page.
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The Attachments component is configured and customized by admins in UI Builder. For 
information on Attachments component configurations, see Attachments UIB Setup .

Form templates

Learn about the Form Templates component in the tabs sidebar for a Configurable Workspace 
record page.

Form templates simplify the process of submitting new records by populating fields 
automatically. Agents can create form templates and update existing form templates to automate 
data entry on reoccurring records.

It appears as a tab within the tabs sidebar for a standard record page.
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The Form Templates component enables agents to create and update form templates. It's 
configured and customized by admins in UI Builder. For information on Form Templates 
component configurations, see Form Templates UIB Setup .

Configuring Configurable Workspace

Configure a Configurable Workspace  using UI Builder.
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Note: 

ServiceNow  offers prebuilt Configurable Workspace  experiences to target specific users 
and issues like CSM Configurable Workspace.

These prebuilt workspaces can be updated and modified in UI Builder  instead of creating 
an experience from scratch.

For a list of prebuilt workspaces ServiceNow  offers, see List of workspaces.

To update an existing Configurable Workspace  experience, see Open a Configurable 
Workspace experience

Create a Configurable Workspace  experience

Create a Configurable Workspace  experience from scratch using UI Builder  and the 
Workspace App Shell.

Create a Configurable Workspace  page

Create a Configurable Workspace  page from scratch or with a page template in UI 
Builder.

UI Builder

Receive additional, detailed documentation on configuring and using UI Builder.

Create a Configurable Workspace  experience

Create a Configurable Workspace  experience from scratch using UI Builder  and the Workspace 
App Shell.

Before you begin
Role required: ui_builder_admin, admin

Note: 

ServiceNow  offers prebuilt Configurable Workspace  experiences to target specific users 
and issues like CSM Configurable Workspace.

These prebuilt workspaces can be updated and modified in UI Builder  instead of creating 
an experience from scratch.

For a list of prebuilt workspaces ServiceNow  offers, see List of workspaces.

To update an existing Configurable Workspace  experience, see Open a Configurable 
Workspace experience

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. Create an experience by selecting Create  > Experience.
A modal opens with fields to create an experience.

3. Complete the following fields in the modal.

Name

Enter a name for the experience.

App shell UI

Select the Workspace App Shell  from the menu.

URL path
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The URL path is created automatically based on the experience name.

Landing path

The landing path is a prefix used to reach the experience home page. It appears 
automatically as home.

Roles

Define the roles that can access the experience. If you leave this field empty, the 
experience is open to all logged-in users by default.

4. Select Create.
A modal opens that confirms the experience is created.

5. Select Open your experience.

Result
Your Configurable Workspace  experience opens in UI Builder.

What to do next
Create a Configurable Workspace  page

Create a Configurable Workspace  page

Create a Configurable Workspace  page from scratch or with a page template in UI Builder.

Before you begin
Role required: ui_builder_admin, admin

Create a Configurable Workspace experience

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. Select Experiences, and select your experience from the list.
Your experience opens in UI Builder.

3. Select Create a new page.

4. Select a page template or Create from scratch instead.
Templates enable you to create pages quickly by providing the framework for common 
Configurable Workspace  pages, such as a standard record page or list page.

5. Enter a name and URL path for your page, and select Continue.

6. Review the URL parameters, and select Looks good.

7. Create the variant  for your page by completing the following fields.
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A page variant in UI Builder  is a variation of a page that exists at the same path and targets 
different audiences depending on audience criteria.

Name

Enter a name for your variant.

Audiences

Add the roles that you want to provide access to the variant. When the field is 
empty, everyone with access to the experience can also access the variant.

Conditions (optional)

Create a query string to specify when to display the variant.

8. Select Create.

Result
Your Configurable Workspace  page opens in UI Builder.

Administering Configurable Workspace

Admins can enable additional features and make changes that affect the Configurable 
Workspace  experience for agents.

Open a Configurable Workspace  experience in UI Builder

Access your Configurable Workspace  experience in UI Builder  for editing.

Administering lists for Configurable Workspace

Administer list features that aren't configured in UI Builder  with components.

Administering forms for Configurable Workspace

Administer form features that aren't configured in UI Builder  with components.

Administering Activity stream for Configurable Workspace

Administer Activity stream  features that aren't configured in UI Builder  with 
components.

Administering emails in Configurable Workspace

Administer email features that aren't configured in UI Builder  with components.
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Customizing Configurable Workspace  with declarative actions

Engage with your Configurable Workspace  forms, fields, lists, and related list pages 
by adding custom actions.

Reflow for Configurable Workspace

Reflow enables pages and content to be zoomed up to 400% through your browser 
settings without loss of content or functionality.

Configure a browser warning for unsaved changes

Configure a browser warning to display when you navigate away from a 
Configurable Workspace  page with unsaved changes.

Resize record page modals in Configurable Workspace

Enable resizing for record page modals in your Configurable Workspace

Enable asynchronous record addition for the multi-record associator

Load large record selections in the background when adding them to related lists.

Open a Configurable Workspace  experience

Access your Configurable Workspace  experience in UI Builder  for editing.

Before you begin
Role required: ui_builder_admin or admin

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. Select Experiences.

3. Select your experience.

Result
Your Configurable Workspace  experience opens in UI Builder.

Administering lists for Configurable Workspace

Administer list features that aren't configured in UI Builder  with components.

Configure live updates

Configure live updates for lists by adding the 
glide.lists.live_list_enabled  system property.

Configure live updates at the list page level without affecting other lists in your 
Configurable Workspace.

Export to Google Sheets

Configure lists in Configurable Workspace  to export directly to Google Sheets.

Configure record count background loading

Configure lists created from large tables to load the 
list record count in the background by using the 
glide.ui.fetch.list.record.count.asynchronously  property.

Configure live updates for lists

Add a system property that enables you to configure live updates for lists.

Before you begin
Role required: admin
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About this task
Live updates enable list data to refresh automatically or manually without reloading the page.

To configure live updates, you must enable the glide.lists.live_list_enabled 
system property.

Once enabled, you can configure live updates using the following options:

Template-level configuration

Configure live updates at the template level in UI Builder.

UI Builder  enables you to choose how live updates behave across a list template in 
your Configurable Workspace. The property Let users control live updates  provides 
three options:

• Never

The default selection that disables live updates.

• Only by refreshing

An indicator displays on the refresh button when updates are available. The list 
will only update once refreshed manually.

• Automatically

Live updates display automatically without refreshing.

Page-level configuration

Configure live updates at for a list page without affecting other lists in your 
workspace. This configuration uses the sys_ux_list  table.

Use this procedure to enable the system property required to configure live updates for lists.

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named glide.lists.live_list_enabled.
For more information on adding a system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

What to do next
Configure live updates for a page without affecting other lists in your workspace. For instructions, 
see Configure live updates for a list page.

Configure live updates for individual list pages

Configure live updates at the list page level without affecting other lists in your Configurable 
Workspace.

Before you begin
To configure live updates for lists, you must enable the 
glide.lists.live_list_enabled  system property. For instructions, see Configure live 
updates.
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Role required: admin

About this task
Live updates enable list data to refresh automatically or manually without reloading the page.

To configure live updates, you must enable the glide.lists.live_list_enabled 
system property.

Once enabled, you can configure live updates using the following options:

Template-level configuration

Configure live updates at the template level in UI Builder.

UI Builder  enables you to choose how live updates behave across a list template in 
your Configurable Workspace. The property Let users control live updates  provides 
three options:

• Never

The default selection that disables live updates.

• Only by refreshing

An indicator displays on the refresh button when updates are available. The list 
will only update once refreshed manually.

• Automatically

Live updates display automatically without refreshing.

Page-level configuration

Configure live updates at for a list page without affecting other lists in your 
workspace. This configuration uses the sys_ux_list  table.

Use this procedure to configure live updates for a list page.

Procedure

1. Navigate to sys_ux_list.list.
The entire list of UX lists in the UX Lists [sys_ux_list] table opens.

2. From the UX Lists list, select the list page you want to edit.
A UX List record opens.

3. Select the Extensible List Feature Flags  tab.

4. In the Live Updates field, select an option for live updates.

Off

Disables live updates.

Manual refresh

An indicator displays on the refresh button when updates are available. The list 
will only update once refreshed manually.

Automatic refresh

Live updates display automatically without refreshing.

5. Select Update.
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Exporting lists to Google Sheets

Configure lists in Configurable Workspace  to export directly to Google Sheets.

You can export data from lists in your Configurable Workspace  directly to Google Sheets if your 
instance is integrated with Google Sheets via OAuth.

To configure and use this functionality, follow these steps:

1. Set up the OAuth application on the Google Sheets API

Set up the OAuth application on the Google Sheets API so that you can authenticate requests 
from your ServiceNow instance to access Google Sheets.

2. Create an application registry for Google Sheets on a ServiceNow instance

Register the Google Drive application in your ServiceNow instance to enable OAuth 
authorization for exporting table records directly to Google Sheets.

3. Configure ServiceNow connection and credential aliases for Google sheets

Configure connection and credential aliases to authenticate an integration between your 
ServiceNow instance and Google Drive.

Once configured, exporting a list to Google Sheets displays as an option in Configurable 
Workspace  list export as Export  > Google Sheets.

Configure list record count to load in the background

Configure lists created from large tables to load the list record count in the background.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named 
glide.ui.fetch.list.record.count.asynchronously.

For more information on adding system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Configure related list background loading

Configure large selections of records added to a related list to load in the background for your 
entire workspace experience.

Before you begin
Role required: admin

About this task
When you select a large number of records to add to a related list, you can focus on other tasks 
while the records are added in the background.
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If background loading isn’t required for all modals, configure individual modals to load related list 
records in the background using declarative actions. For instructions, see Configure background 
loading for a modal.

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add the glide.ui.mra.async  system property.

For more information on adding system property, see Add a system property .

a. Set the Value to true.

b. Select Submit.

3. Add the glide.ui.mra.threshold  system property.

For more information on adding system property, see Add a system property .

a. Specify how many records can be added before asynchronous record addition occurs.
The default is 100 records.

b. Select Submit.

Result
When you select any number of records beyond the threshold, a notification informs you that the 
records will load in the background.

When you add the selected records, the modal closes, and a notification confirms that the 
records are loading in the background.

After the records are added, a notification informs you that the records were added successfully.

Administering forms for Configurable Workspace

Administer form features that aren't configured in UI Builder  with components.

Configure a form header

Configure a form header in Configurable Workspace.

Configure highlighted values

Configure fields to appear as highlighted values in a Configurable Workspace  form.

Configure script fields

Configure Configurable Workspace  forms to support script fields.

Configure a character counter

Configure a character counter to display the number of remaining characters in a 
journal field.
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Configure string field guidance and validation

Configure guidance text to display in string fields with format requirements such as 
account ID, SSN, or SIN. Use regular expression inline validation to display an error 
message if the input doesn't meet format requirements.

Configure automatic resizing

Configure fields to display multiple lines of content automatically without scrolling.

Configure access-based @mention suggestions

Configure @mentions that display suggestions based on recipients with access to 
view the record.

Configure interaction record tab titles

Configure field values, such as contact or consumer names, as titles on interaction 
record tabs in Configurable Workspace.

Disable Personalize Form

Disable the Personalize Form menu by using the 
glide.ui.personalize_form  system property.

Configure Personalize Form access

Configure which roles can access the Personalize Form menu by using the 
glide.ui.personalize_form_role  system property.

Configure advanced view rules

Use client scripts to determine who can view a form variant in your Configurable 
Workspace.

Configure a browser warning for unsaved changes

Configure a browser warning to display when you navigate away from a Configurable Workspace 
page with unsaved changes.

Before you begin
Role required: admin

About this task
When you navigate away from a Configurable Workspace  page using back or forward buttons, a 
browser warning can display to alert you of unsaved changes.

This browser warning relies on popstate event handling to detect browser navigation actions. It 
applies to the entire page, not only the form. For example, even if all form fields are saved, the 
warning would still appear if other components such as the email composer or Activity stream 
contain unsaved data.

Procedure

1. Navigate to sys_ux_page_property.list.
The entire list of page properties from the UX Page Property [sys_ux_page_property] table 
opens.

2. Select New.

3. Complete the following fields:

Page

Select your workspace.

Name

Enter confirmPopStateNavigationWhenDirty.
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Type

Select true | false.

Value

Enter true.

4. Select Submit.

Disable reflow for Configurable Workspace

Disable reflow for an instance, experience, or page.

Before you begin
Role required: admin

About this task

Important: 
Configurable Workspace  pages must use the latest layout system for reflow to be available. 
For more information, see Upgrading layouts in UI Builder

Reflow helps users with low vision or who have trouble seeing web content in a browser due to 
monitor size, device type, poor lighting, or other situations by transforming page layouts into a 
vertical, stacked view automatically when users increase browser zoom to 400%. Additionally, 
content can be enlarged without scrolling in two dimensions at a width equivalent to 320 CSS 
pixels or a height equivalent to 256 CSS pixels.

A width of 320 CSS pixels is equivalent to a starting viewport width of 1280 CSS pixels at 400% 
zoom. For web content designed to scroll horizontally, a height of 256 CSS pixels is equivalent to 
a starting viewport height of 1024 CSS pixels at 400% zoom.

Although reflow is available by default, you can disable it for instances, experiences, and pages.

Procedure

1. Disable reflow for an instance.

a. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table appears.

b. From the System Properties list, select the glide.ux.autoreflow.disable  system 
property.
A System Property record opens.

c. Set the Value to true.

d. Select Update.

2. Disable reflow for an experience.

a. Navigate to sys_ux_app_config.list.
The entire list of UX app configurations from the UX App Config [sys_ux_app_config] table 
opens.

b. From the UX App Configurations list, select an experience.
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A UX App Configuration record opens.

c. Select Disable Auto Reflow.

d. Select Update.

3. Disable reflow for a page within an experience.

a. Navigate to sys_ux_screen.list.
The entire list of UX screens from the UX Screen [sys_ux_screen] table opens.

b. From the UX Screens list, select a page.
A UX Screen record opens.

c. Select Disable Auto Reflow.

d. Select Update.

Configure a form header for a workspace

Create a form header and add it to a workspace's form configuration.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
After creating a form header, you must add it to your workspace's form header configuration.

One form header configuration is included with each workspace. You can use this configuration 
without completing any additional steps.

Procedure

1. Create a form header.

a. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX Form Header.

b. Select New.
A new Form Header record opens.

c. Complete the following fields:

Table

Select the table where the form header will apply.

Primary field

Select a primary field for the form header.

Subheading

Select a subheading for the form header.

Header Image

Select a header image for the form header.

d. Select Submit.
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2. Add the form header to the form header configuration.

a. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX Header 
Configurations.

b. Select the header configuration for your workspace.
The UX Header Configuration record opens.

c. From the Workspace Form Headers related list, select Edit.

Note: 
You may need to configure the form to display the Workspace Form Headers related 
list.

d. Add the form header.

e. Select OK.

Configure a highlighted value for a form header

Configure a highlighted value for a form header in a workspace.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
After creating a highlighted value, you must add it to your workspace's highlighted value 
configuration.

Procedure

1. Create a highlighted value.

a. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX Highlighted 
Values.

b. Select New.
A new Highlighted Value record opens.

c. Complete the following fields:

Table

Select the table where the highlighted value will apply.

Field

Select the field where the highlighted value will apply.

d. Select Submit.

2. Add the highlighted value to the highlighted value configuration.
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a. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX Highlighted 
Values Configurations.

b. From the UX Highlighted Value Configurations list, select the configuration for your 
workspace.
A UX Highlighted Value Configuration record opens.

c. From the Highlighted Values related list, select Edit.

d. Add the highlighted value.

e. Select OK.

Configure script field types for a workspace

Configure a Configurable Workspace  to support script fields.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Show script fields in forms with a code editor component.

a. Add a system property named 
glide.ui.workspace.script.code_editor.enable.

For more information on adding system property, see Add a system property .

b. Set the Value to true.

c. Select Submit.

3. Configure the line number after which the scroll bar should appear for the code editor 
component.

a. Add a system property named 
glide.ui.workspace.script.code_editor.autoresize_line_limit.

For more information on adding system property, see Add a system property .

b. Select Submit.

Configure a character counter for journal fields

Configure a character counter to display the number of remaining characters in a journal field.

Before you begin
Role required: admin
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Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named glide.ui.textarea.character_counter.

For more information on adding system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Configure inline validation for string fields

Configure guidance text to display in string fields with format requirements such as account ID, 
SSN, or SIN. Use regular expression inline validation to display an error message if the input 
doesn't meet format requirements.

Before you begin
Role required: admin

About this task
Guidance text helps you enter data correctly into string fields with format requirements such as 
account ID, SSN, or SIN. Inline validation uses a regular expression (regex) pattern to enforce 
format requirements. If the input doesn't match the required format, an error message displays.

The process for configuring string fields with guidance text and inline validation requires two 
steps:

1. Create a regex pattern for a required input format.

2. Map the regex pattern and add guidance text to a string field.

Procedure

1. Create a regex pattern for a required input format.

a. Navigate to sys_ui_regex.list.
The entire list of regex tables from the Regex Tables [sys_ui_regex] table opens.

b. Select New.
A new Regex Table record opens.

c. Complete the following fields:

Name

Create a descriptive name for the regex pattern. For example, if you're creating 
a regex pattern for an account number, enter Account Number.

Pattern

Enter the regex pattern that defines the required input format. This field is 
required. For example, you might use ^\d{10}$  to require a 10-digit number.

d. Select Submit.

2. Map the regex pattern and add guidance text to a string field.
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a. Navigate to sys_ui_field_regex_mapping.list.
The entire list of mapping tables from the Field Regex Mapping Tables 
[sys_ui_field_regex_mapping] table opens.

b. Select New.
A new Field Regex Mapping Table record opens.

c. Complete the following fields:

Table

Select the table that contains the string field you want to apply validation and 
guidance to.

Field name

Select the string field from the list.

Placeholder Text

Enter sample text to display in the field as an example of the required format.

Guidance Text

Enter guidance text that explains the format requirement or gives additional 
instructions.

Type

Select the type of guidance text to indicate whether it's a suggestion, 
information, warning, positive message, or critical.

Pattern

Select the regex pattern that matches the required format.

Order

Enter a number to set the display priority of the guidance text. Lower numbers 
appear first.

Active

Select this check box to enable the validation and guidance text.

Inherited

Select this check box to apply the validation and guidance text to child tables 
with the same field.

d. Select Submit.

Configure automatic resizing

Configure fields to display multiple lines of content automatically without scrolling.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Use system properties to enable automatic resizing and set a line limit.
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System properties for automatic resizing

Configure system properties for automatic resizing to display fields with multiple lines of content 
automatically without scrolling.

glide.ui.textarea.autoresize_line_limit

Determines the line number after which the scroll bar should appear for the text 
area component in all text area fields.

Enter a maximum value for text area fields to automatically resize.

glide.ui.journal.use_html

Converts all journal fields with a text area subtype to HTML editor fields.

Set the Value field to true.

glide.ui.journal.html.editor.autoresize

Activates the autoresize plugin in all journal fields with the HTML subtype.

Set the Value field to true.

glide.ui.journal.html.editor.autoresize_line_limit

Determines the line number after which the scroll bar should appear for the HTML 
editor component in all journal fields with the HTML subtype.

Effective if glide.ui.journal.html.editor.autoresize  is set to true. 
Enter a maximum value for journal fields to automatically resize.

glide.ui.html.editor.autoresize_line_limit

Determines the line number after which the scroll bar should appear for the HTML 
editor component in all HTML fields.

Effective if automatic resizing is added to 
glide.ui.html.editor.v5.enabled_plugins. Enter a maximum value 
for HTML fields to resize automatically.

glide.ui.html.editor.v5.enabled_plugins

Determines the line number after which the scroll bar should appear for the text 
area component in all Activity stream  textarea fields.

Enter a maximum value for text area fields to resize automatically.

glide.activity.compose.html.autoresize_line_limit

Determines the line number after which the scroll bar should appear for the HTML 
editor component in all Activity stream  journal fields with the HTML subtype.

Effective if glide.activity.compose.html.autoresize  is set to true. 
Enter a maximum value for journal fields to resize automatically.

glide.activity.compose.html.autoresize

Activates the automatic resizing plugin in all Activity stream  journal fields with the 
HTML subtype.

Set the Value field to true.
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Configure mention suggestions

Configure @mentions that display suggestions based on recipients with access to view the 
record.

Before you begin
Role required: admin

About this task
An @mention is any posted update that contains @username anywhere in the body of the 
message.

When you use @mentions, context-based suggestions display a list of recipients with access to 
view the record.

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named glide.ui.mentions.check_record_visibility.

For more information on adding system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Hide the Personalize Form menu

Disable the Personalize Form menu by using the glide.ui.personalize_form  system 
property.

Before you begin
Role required: admin

About this task

The Personalize Form menu ( ) in the form header enables you to customize which fields 
display on the form. You can use the glide.ui.personalize_form  system property to 
disable the Personalize Form menu.

Procedure

1. Navigate to sys_properties.list.

2. Add a system property named glide.ui.personalize_form.
For more information on adding a system property, see Add a system property .

3. Set the Value to false.

4. Select Submit.

Configure role-based access to the Personalize Form menu

Configure which roles can access the Personalize Form menu.

Before you begin
Role required: admin
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About this task

The Personalize Form menu ( ) in the form header enables you to customize which fields 
display on the form. You can use the glide.ui.personalize_form_role  system 
property to define which roles can access the Personalize Form menu.

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named glide.ui.personalize_form_role.
For more information on adding a system property, see Add a system property .

3. In the Value field, enter a list of roles that can access the Personalize Form menu.

4. Select Submit.

Configure advanced view rules for forms

Use client scripts to determine who can view a form variant in your workspace.

Before you begin
Role required: admin

About this task
You can create page variants in UI Builder  to display different versions of a page based on 
roles. If you need to switch views dynamically based on custom logic, then you can configure 
advanced view rules.

Advanced view rules enable you to define a client script that determines dynamically which 
variant to show at runtime. This configuration provides you with more flexibility than static, role-
based access in UI Builder, enabling for complex conditions evaluated directly in your session.

Procedure

1. Navigate to sysrule_view_workspace.list.

The entire list of view rules in the View Rules [sysrule_view_workspace] table opens.

2. Select a workspace page variant.

3. Select the Advanced  check box.

4. Toggle Turn on ECMAScript 2021 (ES12) mode  to use the latest supported JavaScript 
features.

5. In the Script field, enter a client script to define the conditions for switching views.

6. Select Update.

Resize modals

Configure a property in UI Builder  to resize all modals on a record page.

Before you begin
Role required: admin

Procedure

1. Open your workspace experience in UI Builder.
For instructions, see Open a Configurable Workspace  experience in UI Builder.
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2. Select or create a record page.
For instructions on creating a workspace page in UI Builder, see Create a Configurable 
Workspace  page.

3. From the Content tree, select Modals  > Modal Container.

4. Select the Configure  tab.

5. Select Enable Resize.

6. In the Minimum Resize Height and Minimum Resize Width fields, enter a minimum value.

7. In the Maximum Resize Height and Maximum Resize Width fields, enter a maximum value.

8. Select Save.

If resizing isn’t required for all modals on the record page, use declarative actions to resize 
individual modals. For instructions, see Resize a modal.

Administering Activity stream  for Configurable Workspace

Administer Activity stream  features that aren't configured in UI Builder  with components.

Configure stacked view

Configure a stacked view option for journal fields in the Activity stream.

Configure rich text editor

Configure a rich text editor for journal fields in the Activity stream.

Configure Post button

Configure the Post  button in the Activity stream 
to display and function continuously by using the 
glide.activity.compose.can_post_mandatory_fields  system 
property.

Configure tile avatars

Configure Activity stream  tiles to display avatars by using the 
glide.activity.show_tile_icons  system property.

Configure tile icons

Configure custom icons for tiles in the Activity stream.

Create tags

Configure custom tags to filter through entries in the Activity stream.

Configure filter set access

Configure access to create filter sets in the Activity stream  by restricting specified 
users.

Configure most recent reply

Configure the Activity stream  to reduce visual clutter by displaying the most recent 
reply first.

Configure stacked view for the Activity stream

Configure a stacked view option for journal fields in the Activity stream.

Before you begin
Role required: admin
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Procedure

1. Navigate to sys_properties.list.

2. Add the glide.ui.activity.journal.stacked  system property.
For more information on adding a system property, see Add a system property .

3. Set the Value to true.

Important: 
Ensure there are no mandatory fields. Mandatory fields in the Activity stream  prevent the 
stacked view option from displaying.

4. To give agents the option of using a rich text editor, search for and set the 
glide.ui.journal.use_html  property to true .

Configure rich text editor for the Activity stream

Configure a rich text editor for journal fields in the Activity stream.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

2. Add the glide.ui.journal.use_html  system property.
For more information on adding a system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Configure the Post button to display continuously

Configure the Post  button in the Activity stream  to display and function continuously.

Before you begin
The Post  button disappears by default when the Comments or Work Notes fields are made 
mandatory by a UI Policy on the incident_task table. You can configure the Post  button to appear 
and function even when mandatory fields aren't filled.

Role required: admin

Procedure

1. Navigate to sys_properties.list.

2. Add the glide.activity.compose.can_post_mandatory_fields  system property.
For more information on adding a system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Configure avatars for Activity stream  tiles

Configure Activity stream  tiles to display avatars by using the 
glide.activity.show_tile_icons  system property.

Before you begin
Role required: admin
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Procedure

1. Navigate to sys_properties.list.

2. Add the glide.activity.show_tile_icons  system property.

For more information on adding system property, see Add a system property .

3. Set the Value to true.

4. Select Submit.

Configure journal field tile icons and colors in Configurable Workspace

Configure custom icons for tiles in the Activity stream.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Dictionary.

2. Select the table for your Configurable Workspace  page.

3. From Related Links, select the Attributes  tab.

4. Select New.

5. Select an icon attribute from the following options.

◦ Workspace activity stream background

◦ Workspace activity stream tile icon

◦ Workspace activity stream icon color

6. In the Value field, select a background, icon, or color.

7. Select Submit.

Configure tags for the Activity stream

Configure custom tags to filter through entries in the Activity stream.

Before you begin
Role required: admin

About this task
Tags enable you to filter entries in the Activity stream  by dynamic and static states not offered in 
filter lists.

Important: 
Tags are not available until you configure and create them.
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Procedure

1. Open your Configurable Workspace  experience in UI Builder.
For instructions, Open experience.

2. Select a page from your experience.

3. In the content panel, select the Activity Stream component.

4. From the Configure panel, select Tags  to expand the section.

5. In the Data Source field, select a data source for your tags.

6. Select Add  to create a new tag.

7. Customize the tag in the Add Tag modal.

Label

Enter a label for the tag.

Icon

Select an icon for the tag.

Color

Select a color for the tag from the list.

Table

Select a table for the tag from the list.

Description

Enter a description for the tag.

8. Select Save.

9. Select the slider icon ( ) for a tag to edit it.

10. Change the order displayed to agents by dragging tags with the drag dots icon ( ).
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Result
All tags you create appear under the Tags section.

Configure access to create filter sets in the Activity stream

Configure access to create filter sets in the Activity stream  by restricting specified users.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_user.list.

2. Select a user.

3. From Related Links, select the Roles  tab.

4. Select Edit.

5. Add workspace.activity_stream_restrict_create_filter_set  to the Roles 
List.

6. Select Save.

Result
The restricted user profile can no longer create filter sets in the Activity stream.

Display the most recent reply in the Activity stream

Configure the Activity stream  to reduce visual clutter by displaying the most recent reply first.
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Before you begin
Role required: admin

About this task
By default, the Activity stream  displays all entries including every reply and update. To reduce 
visual clutter, you can configure the Activity stream  to display the most recent reply.

Displaying the most recent reply in the Activity stream  relies on two types of configuration:

System properties

The 
glide.activity.last_viewed_timestamp.local_storage_limit 
and 
glide.activity.last_viewed_timestamp.local_storage_retention_days 
system properties control how many and how long timestamps are stored locally for 
displaying the most recent reply.

UI Builder  properties

The properties for the Activity Stream component in UI Builder  control whether the 
Activity stream  should show all replies or the most recent one. For information on 
Activity Stream component properties in UI Builder, see Activity Stream UIB Setup .

Procedure

1. Navigate to sys_properties.list.

2. Add a system property named 
glide.activity.last_viewed_timestamp.local_storage_limit.
For more information on adding a system property, see Add a system property .

3. Set the Value to the maximum number of timestamps to store locally for displaying the most 
recent reply.

4. Select Submit.

5. Add a system property named 
glide.activity.last_viewed_timestamp.local_storage_retention_days.

6. Set the Value to the number of days to store timestamps locally for displaying the most recent 
reply.

7. Select Submit.

Administering emails in Configurable Workspace

Administer email features that aren't configured in UI Builder  with components.

Digital signature and encryption

Configure emails that send a digital signature to verify you as an authentic sender 
and an email encryption to certify authentic recipients.

Configure email templates

Configure email templates in Configurable Workspace  to quickly create emails for 
common issues.

Configure collapsible templates

Configure email templates with collapsed content by hiding it behind an ellipsis.

Disable response templates

Disable response templates for journal fields in Configurable Workspace.
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Configuring digital signature and encryption for emails

Configure emails that send a digital signature to verify you as an authentic sender and an email 
encryption to certify authentic recipients.

A digital signature verifies the email sender and assures recipients that the email came from a 
trusted source and wasn't altered. In the email composer for Configurable Workspace, you can 
select a check box to digitally sign outbound emails.

Encryption makes the email unreadable to anyone except the intended recipient. In the email 
composer for Configurable Workspace, you can select a check box to encrypt outbound emails.

Digital signature and encryption configuration

To use digital signature or encryption for emails in Configurable Workspace, configure S/MIME 
for your instance. For information on S/MIME and instructions to configure S/MIME for emails, 
see Setting up S/MIME for email .

Configuring S/MIME for emails requires the following steps:

Import an S/MIME key pair

Import an S/MIME key pair consisting of the private key and certificate to sign 
outbound emails or decrypt emails.

Upload a CA certificate

Upload a digital CA (Certificate Authority) certificate to validate email certificates for 
secure communication.

Upload an email certificate

Upload an email certificate to validate a signature for inbound email or encrypt an 
outbound email or both for secure communication.

Enable S/MIME

Configure S/MIME settings for inbound and outbound email.

Configure an email template

Configure email templates to quickly create emails for common issues.

Before you begin
Role required: email_client_admin

Procedure

1. Navigate to All  > Email Client  > Email Client Templates.

2. Select New.
A new Email Client Template record opens.

3. Complete the following fields:

Name

Enter a name for the email template.

Table

Select the table where the email template will apply.

Conditions

Select conditions to determine when the email template will apply.

4. From the Content  tab, enter the content that will apply to the email template.
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5. From the Recipients  tab, enter recipients that will apply to the email template.

6. Select Submit.

Configure an email template with collapsed content

Configure email templates with collapsed content by hiding it behind an ellipsis.

Before you begin
Role required: email_client_admin

Procedure

1. Navigate to All  > Email Client  > Email Client Templates.

2. From the Email Client Templates list, select an email template or create a new one.
For instructions on creating an email template, see Configure an email template.

3. Select the Content  tab.

4. In the Content Type field, select HTML.

5. In the Body HTML field, add the content you want to display.

6. Collapse additional email content behind an ellipsis.

Important: 
Since the ellipsis will only display at the end of the email, add collapsed content at the 
end of the email template body.

a. Enter the opening tag <div id:collapsible-content>.

b. Add all content you want collapsed after the opening tag.

c. Enter the closing tag <div id:collapsible-content>.

7. Select Update  or Submit.

Result
The email template's content is hidden behind an ellipsis.

Note: 
Once you expand collapsed content by selecting the ellipsis, it's not possible to collapse 
the content again.
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Disable response templates

Disable response templates for journal fields.

Before you begin
Role required: admin

Procedure

1. Navigate to sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table opens.

2. Add a system property named glide.ui.enable_response_templates.
For instructions on adding a system property, see Add a system property .

3. Set the Value to false.

4. Select Submit.

Customizing Configurable Workspace  with declarative actions

Engage with your Configurable Workspace  forms, fields, lists, and related list pages by adding 
custom actions.

Declarative actions enable work to flow on forms and lists throughout your configurable 
workspace experience. Use actions to add custom functionality that extends pages without 
taking ownership.

With declarative actions, you form a smoother upgrade experience by creating the necessary 
records needed in your own application scope instead of customizing a base system UI Builder 
page.

Declarative actions in the navigation filter

The navigation filter lists the options for declarative actions that you can create to customize your 
pages:
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Option Description

Create New Action Create a brand new list, related list, form, field 
decorator, or attachment action from scratch.

Action Configurations Action configurations tie groups of actions to 
your configurable experience.

Form Action Layouts Multiple form layout items and groups are 
combined in a single table-based layout for 
configuration.

Form Action Layout Items Form action layout items define the look and 
feel of individual action buttons that appear in 
the action bar component on the form.

Form Action Layout Groups Form action layout groups combine multiple 
actions in the same button on forms by using 
split buttons or menu buttons.

Form Actions Form actions define what happens after an 
action button is selected on forms.

List Actions List actions define actions that appear within 
the action bar at the top of lists.

Related List Actions Related list actions define actions that appear 
within the action bar at the top of related lists.

List Action Groups List action groups combine multiple actions in 
the same button on lists by using split buttons.

Field Decorators Field decorators define actions that appear 
within fields as icons.

Note: 
Field decorators can only be configured 
for single-line string fields. Multi-line 
fields do not support field decorators.

Attachment Actions Attachment actions define actions that appear 
within form actions.

Creating declarative action buttons

Create a declarative action and add the button to a workspace.

Create a form action button

Create a form action and add the button to a workspace.

Create a list or related list action button

Create a list or related list action and add the button to a workspace.

Create an attachment action

Create an attachment action and add the button to workspace.

Create a field decorator action

Create a field decorator action and add the button to a workspace.
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Create a form action button

Create a form action and add the button to a workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Declarative Actions  > Create new action.

2. Select Form.
A new Action Assignment record opens.

3. Complete the following fields:

Action label

Enter a label for the action.

Action name

This field will populate automatically with the action label in all lowercase and with 
spaces replaced with underscores.

Implemented as

Select Server Script  to apply the action to the server or database as JavaScript.

Select UXF Client Action  to apply the action as a UI Builder  page event.

Select Client Script  to apply the action to the web browser as JavaScript.

Table

Select a table for the action button to appear on.

View

Select a UI view for the action button to appear on.

4. Select the Additional actions icon ( ) and Save.

5. From the Layout Items related list, select your action.
You can also select the UX Form Layout Item  link in the form message.
A UX Form Actions Layout Item record opens.

6. Complete the following fields to update the look and feel of the button:

Icon

Select an icon for the action.

Color

Select a color for the action. You have access to choose any color the button 
component supports.

7. Select Update.

Result
The form action button appears within the workspace you specified.

What to do next
Configure a button to apply an action in the following ways:

Configure a form action to open a custom modal
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Configure a declarative action to open a custom modal that provides information or 
interactive elements without navigating away from the current page.

Create a list or related list action button

Create a list or related list action and add the button to a workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Declarative Actions  > Create new action.

2. Select List  or Related List.
A new Action Assignment record opens.

3. Complete the following fields:

Action label

Enter a label for the action.

Action name

This field will populate automatically with the action label in all lowercase and with 
spaces replaced with underscores.

Implemented as

Select Server Script  to apply the action to the server or database as JavaScript.

Select UXF Client Action  to apply the action as a UI Builder  page event.

Select Client Script  to apply the action to the web browser as JavaScript.

Table

Select a table for the action button to appear on.

View

Select a UI view for the action button to appear on.

4. Select Submit.

Result
The list or related list action button appears within the workspace you specified.

What to do next
Configure a button to apply an action in the following ways:

Configure dynamic conditions for a list action

Configure a list or related list action to perform an action only when it satisfies 
dynamic conditions.

Create an attachment action button

Create an attachment action and add the button to a workspace.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Declarative Actions  > Create new action.

2. Select Attachment.
A new Action Assignment record opens.

3. Complete the following fields:

Action label

Enter a label for the action.

Action name

This field will populate automatically with the action label in all lowercase and with 
spaces replaced with underscores.

Implemented as

Select Server Script  to apply the action to the server or database as JavaScript.

Select UXF Client Action  to apply the action as a UI Builder  page event.

Select Client Script  to apply the action to the web browser as JavaScript.

Table

Select a table for the action button to appear on.

View

Select a UI view for the action button to appear on.

4. Select Submit.

Result
The attachment action button appears within the workspace you specified.

Create a field decorator action button

Create a field decorator action and add the button to a workspace.

Before you begin
Role required: admin

Note: 
Field decorators can only be configured for single-line string fields. Multi-line fields do not 
support field decorators.

Procedure

1. Navigate to All  > Declarative Actions  > Create new action.

2. Select Field decorator.
A new Action Assignment record opens.

3. Complete the following fields:

Action label

Enter a label for the action.

Action name

This field will populate automatically with the action label in all lowercase and with 
spaces replaced with underscores.

Implemented as
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Select Server Script  to apply the action to the server or database as JavaScript.

Select UXF Client Action  to apply the action as a UI Builder  page event.

Select Client Script  to apply the action to the web browser as JavaScript.

Table

Select a table for the action button to appear on.

View

Select a UI view for the action button to appear on.

4. Select Submit.

Result
The field decorator action button appears within the workspace you specified.

Configuring declarative action buttons

Configure declarative action buttons to perform actions.

Configure a declarative action with the Now Assist  icon

Configure a declarative action button with the Now Assist  icon ( ) and hover 
animation.

Configure a form action layout on a workspace page

Add a UX Form Actions Layout to a workspace page in UI Builder.

Configure a form action to open a custom modal

Configure a declarative action to open a custom modal that provides information or 
interactive elements without navigating away from the current page.

Configure modal background loading

Configure a modal to load large selections of records added to a related list in the 
background.

Resize a modal

Use declarative actions to resize a modal in your workspace.

Configure dynamic conditions for a list action

Configure a list or related list action to perform an action only when it satisfies 
dynamic conditions.

Configure an action configuration record

Create an action configuration record for a form or list action and copy the action 
configuration record's sys_id.

Configure a declarative action with the Now Assist  icon

Configure a declarative action button with the Now Assist  icon ( ) and hover animation.

Before you begin
Create a declarative action and add the button to a workspace. For instructions, see Creating 
declarative action buttons.

Role required: admin
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About this task
The Now Assist  icon ( ) with hover animation is supported for buttons and split buttons. If the 
action falls into the overflow or acts as a subitem in a split button, the hover animation doesn't 
work.

Procedure

1. Navigate to All  > Declarative Actions  and select the action type that matches your action.

2. From the Action Assignment list, select an action.

3. In the Icon field, selecting ai-sparkle-fill  to add the Now Assist  icon ( ).

Important: 
For adding the Now Assist  icon ( ) to a form action, find the Icon field by first selecting a 
layout item from the Layout Items related list.

Layout items control how declarative actions appear relative to other actions in a table 
layout. If your action is associated with multiple layouts, you might see multiple entries.

4. Add hover animation to the icon by selecting Animate icon.

5. Select Update.

Configure a form action layout on a workspace page

Add a form action layout to a workspace page in UI Builder.

Before you begin
Role required: admin

About this task
A form action layout combines multiple form action layout items  and form action layout groups 
into a single table-based layout that determines which actions appear on the form.

The form action layout chosen to appear on the form is determined in the following ways:

Form Controller

If a form action layout is assigned directly to the Form Controller in UI Builder, that 
layout is used.

Specificity

If a form action layout isn't assigned to the Form Controller, the layout is chosen 
based on specificity calculated from the layout's table and action configuration.

When two form action layouts have identical specificity values, the layout with the 
lower Order field is chosen.

Procedure

1. Open your workspace experience in UI Builder.
For instructions, see Open a Configurable Workspace  experience in UI Builder.

2. Select or create a page that contains the Form component.
For example, select a record page.

For instructions on creating a workspace page in UI Builder, see Create a Configurable 
Workspace  page.

3. From the Data and scripts tree, select the Form Controller.
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4. Select the Configure  tab and expand the Advanced  section.

5. In the Action layout property, select a UX Form Actions Layout record.

6. Select Save.

Result
The actions specified in the form action layout appear on the workspace page.

Configuring a form action to open a custom modal

Configure a form action to open a custom modal that provides information or interactive 
elements without navigating away from the current page.

Buttons execute actions in your configurable workspace. Custom modals provide information 
or interactive elements without navigating away from the current page through pop-up boxes. 
Integrating custom modals with action buttons creates a seamless and interactive experience, 
enabling you to perform actions intuitively.

Processes for creating a custom modal

Configuring an action button to open a custom modal involves several processes:

1. Adding the action button to the form:

Creating an action adds the button to the form without assigning it to do anything when 
selected. For more information, see Create a form action.

2. Activating Customer Service Management:

Adding the Customer Service plugin provides demo data and activates related plugins that are 
not already active. For more information, see Activate Customer Service Management .

3. Opening your record page in UI Builder:

Accessing your record page in UI Builder enables you to design and configure the page variant 
with a custom modal. For more information, see Create a page variant .

4. Designing the page variant in UI Builder:

Using UI Builder to design a page variant passes the modal into the workspace record page. 
For more information, see Design a page variant in UIB.

5. Configuring the page variant as a modal in UI Builder:

Using UI Builder to configure the page variant defines the modal to appear in the workspace 
record page. For more information, see Configure a page variant as a modal in UIB.

6. Creating a UX add-on event mapping:

Setting up a UX add-on event mapping connects the action button to your custom modal. For 
more information, see Create a UX add-on event mapping.

7. Defining the payload for a custom modal:

Configuring the payload sets the action button to open the custom modal in your workspace. 
For more information, see Define the payload for a custom modal.
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Customize a page variant in UI Builder

Configure a UI Builder  page variant to pass from a workspace modal into the variant. This step 
acts as part of the process to configure an action button to open a custom modal.

Before you begin
Complete the following actions:

• Create a form action

• Activate Customer Service Management

• Open your record page in UI Builder  or create a page variant in UI Builder

Role required: admin

Procedure

1. Open your page variant.

2. Add components to display on the page by selecting +Add component  under the Body 
element.

3. Select the added component and select the Table  field.

4. Switch the setting to Bind data  and dot-walk to the table prop by entering 
@context.props.table.

5. Select the Title  field, and switch to Script  mode.

6. Enter the following script and pass the sysID received through the URL parameter as a JS 
template variable.

function evaluateProperty({ api, helpers }) {
 return `Only ${api.context.props.sysId}`;
}

7. Select Apply  for the script and select Save.

Result
The table and sysID variables are configured to be passed from the modal through the URL into 
the variant.

Configure a page variant as a modal in UI Builder

Define your page variant to appear as a modal using UI Builder  configurations. This step acts as 
part of the process to configure an action button to open a custom modal.

Before you begin
Complete the following actions:

• Create a form action

• Activate Customer Service Management

• Open your record page in UI Builder  or create a page variant in UI Builder

• Customize a page variant in UI Builder

Role required: admin
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Procedure

1. Open your page variant.

2. Open the sys_ux_screen_type  by selecting the menu icon ( ) and navigating to 
Developer  > Open variant collection record.

3. Select the UX App Route  tab under Related Lists and select your page variant.

4. Open UI Builder  in a new browser tab and open your configurable workspace experience.

5. Find the page that you want your modal to appear by opening the overview of records for the 
experience and selecting the page.

6. Select the menu icon ( ) and navigate to Open page definition.

7. Select Copy sys_id.

8. Return to the browser tab with the sys_ux_app_route.

9. Open the page's machine-readable value in a browser alert modal by double-selecting the 
Parent Macroponent  field and selecting OK.

10. Define the variant to appear in a modal by entering modalContainerViewport  in the 
Parent Macroponent Composition Element ID  field.

11. Select Update.

Create a UX add-on event mapping

Connect a button to a modal using UX add-on event mapping in order for an action button to 
open a custom modal.

Before you begin
Complete the following actions:

• Create a form action

• Activate Customer Service Management

• Open your record page in UIB or create a page variant in UI Builder

• Customize your page variant in UI Builder

• Configure your page variant as a modal in UI Builder

Role required: admin

Procedure

1. Open the add-on event mapping <instance-name>.service-now.com/
sys_ux_addon_event_mapping_list.do  into your browser.

2. Create a new record by selecting New.

3. Enter a name for your map.

4. Select ui_action_bar  for the Source element ID field.

5. Select the action name for your declarative action for the Source Declarative Action field.

6. Set the macroponent to the workspace record macroponent using the sysID copied from the 
record's page definition.
For more information, see Configure a page variant as a modal in UIB.

7. Trigger the event to open a modal by selecting [Record Page] Open modal  in the Target Event 
field.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

270

https://www.servicenow.com/docs/access?context=t_ActivateCustomerService&version=zurich&pubname=zurich-customer-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ActivateCustomerService&version=zurich&pubname=zurich-customer-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ActivateCustomerService&version=zurich&pubname=zurich-customer-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-variant&version=zurich&pubname=zurich-application-development&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-variant&version=zurich&pubname=zurich-application-development&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-variant&version=zurich&pubname=zurich-application-development&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-variant&version=zurich&pubname=zurich-application-development&ft:locale=en-US


8. Define the fields to send to the modal by pasting the JSON object into the Target Payload 
Mapping field.

{
 "type": "MAP_CONTAINER",
 "container": {
  "route": {
   "type": "EVENT_PAYLOAD_BINDING",
   "binding": {
    "address": ["route"]
   }
  },
  "size": {
   "type": "EVENT_PAYLOAD_BINDING",
   "binding": {
    "address": ["size"]
   }
  },
  "fields": {
   "type": "EVENT_PAYLOAD_BINDING",
   "binding": {
    "address": ["fields"]
   }
  },
  "params": {
   "type": "EVENT_PAYLOAD_BINDING",
   "binding": {
    "address": ["params"]
   }
  }
 }
}

9. Select Submit.

Define the payload for a custom modal

Set your action button to open a custom modal by defining the payload parameters.

Before you begin

• Create a form action

• Activate Customer Service Management

• Open your record page in UIB or create a page variant in UI Builder

• Customize your page variant in UI Builder

• Configure your page variant as a modal in UI Builder

• Create a UX add-on event mapping

Role required: admin

Procedure

1. In the navigation filter, navigate to All  > Declarative Actions  > Form Actions.

2. Select the form action where you want to add the custom modal.
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3. Open the Specify client action  field by selecting the record preview icon ( ) and Open 
Record.

4. Mark the location of your page by entering the page's action name as the route key of the 
Payload  field.

5. Pass variables from the current context by entering the table and sysID values in the fields  key.

 {
   "route": "action-name",
   "fields": {
     "table": "{{table}}",
     "sysId": "{{sysId}}"
   }
 }

6. Select Update.

7. Open a record in your configurable workspace.

8. Test your button by selecting it.
Your button opens the custom modal.

Configure modal background loading

Configure a modal to load large selections of records added to a related list in the background.

Before you begin
Role required: admin

About this task
If background loading isn’t required for all modals, configure individual modals to load related list 
records in the background using declarative actions.

Declarative actions take higher precedence than system properties.

Procedure

1. Navigate to All  > Declarative Actions  > Related List Actions.

2. From the Action Assignments list, select a related list action.
An Action Assignment record opens.

3. From the Specify client action field, select Open Record.
An Action Payload Definition record opens.

4. In the Payload field, add the following snippet before the closing bracket.

  "asyncProperties": {
    "enableAsync": true,
    "relatedListLabelName": "Affected CIs",
     "asyncThreshold": 100
     }

◦ enableAsync: Set to true to enable background loading.

◦ asyncThreshold: The number of records needed to switch to background loading. The 
value should equal to or greater than one. The default value is 100 records.

◦ relatedListLabelName: The display name for the background loading notification.

5. Select Update.
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The Action Assignment record for the related list action opens.

6. From the UX Add-on Event Mappings related list, select an event mapping.
A UX Add-on Event Mapping record opens.

7. In the Target Payload Mapping field, enter the following snippet under “container”: {.

                     "asyncProperties": {
                       "binding": {
                                                "address": [
                                            "asyncProperties"
                                         ]
                            },
                "type": "EVENT_PAYLOAD_BINDING"
                        }

8. Select Update.

Result
When you select any number of records beyond the threshold, a notification informs you that the 
records will load in the background.

When you add the selected records, the modal closes, and a notification confirms that the 
records are loading in the background.

After the records are added, a notification informs you that the records were added successfully.

Resize a modal

Use declarative actions to resize a modal in your workspace.

Before you begin
Role required: admin

About this task
If resizing isn’t required for all record page modals, use declarative actions to resize individual 
modals.

Declarative actions take higher precedence than system properties.

Procedure

1. Navigate to All  > Declarative Actions  > Related List Actions.

2. From the Action Assignments list, select a related list action.
An Action Assignment record opens.

3. From UX Add-on Event Mappings related list, select the event mapping for opening a modal.
A UX Add-on Event Mapping record opens.

4. In the Target Payload Mapping field, enter the following snippet under “container”: {.

                                "resizableConfig": {
 "enableResizable": true
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},

5. Specify the modal’s default size by appending the following snippet.

"customSize": {
            "height": "590px",
            "width": "1500px"
        },
 
"size": {
            "type": "JSON_LITERAL",
            "value": "custom"
}

6. Select Update.

Configure dynamic conditions for a list action

Configure a list or related list action to perform an action only when it satisfies dynamic 
conditions.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Declarative Actions  and select either List 
Actions  or Related List Actions.

2. From the Action Assignment list, select an action.
An Action Assignment record opens.

3. Select the Record Selection Required  checkbox.

4. Select the Experience Restricted  checkbox.

5. From the Conditions section, complete the following fields:

Enable Dynamic Evaluation

Select the checkbox.

Dynamic Script Condition

Write a scripted condition for dynamic evaluation.

Dynamic Record Conditions

Add conditions for dynamic evaluation if you don't want to write a scripted 
condition.

6. Select Update.

Result
The action will only be available when selected list items satisfy the dynamic conditions.

Note: 
You may experience slowness and unresponsiveness if this feature is used in combination 
with Select All, which selects all records in a list, as conditions must be evaluated for all of 
the selected records.
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Configure an action configuration record

Create an action configuration record for a form or list action and copy the action configuration 
record's sys_id.

Before you begin
Role required: admin

About this task
An action configuration is a record that defines how and where a declarative action is used in a 
Configurable Workspace.

Procedure

1. Navigate to All  > Now Experience Framework  > Declarative Actions  and select either Form 
Actions  or List Actions.
An Action Assignment record opens.

2. Select the Action Configurations  related list tab.

3. Select New.
A new UX Actions Configuration record opens.

4. Complete the following fields:

Name

Enter a name for the action configuration.

Description

Enter a description for the action configuration.

5. Select the Additional actions icon ( ), and select Copy sys_id.
The action configuration record’s sys_id is copied to clipboard. You’ll need to use the sys_id in 
UI Builder  to display the action on a workspace page.

For example, you can display a restricted global list action on a specified workspace page. For 
instructions, see Restrict a global list action to a workspace page.

6. Select Submit.

Result
An action configuration record is created for the form or list action, and the action configuration 
record's sys_id is copied to clipboard.

Managing global action visibility

Configure global actions to exclude specified tables, views, pages, workspaces, or experiences.

Hide a global form or list action from a table or view

Configure a global form or list action to exclude a specified table and view.

Hide a global form action from a page layout

Configure a global form action to exclude a specified page or experience.

Restrict a global list action to a workspace page

Configure a global list action to display only on a specified workspace page.

Hide a global form or list action from a table or view

Configure a global form or list action to exclude a specified table or view.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Declarative Actions  and select either Form 
Actions  or List Actions.

2. From the Action Assignments list, select an action.
An Action Assignment record opens.

3. Select the Action Exclusions  related list tab.

4. Select New.
An Action Exclusion record opens.

5. Complete the following fields:

Action assignment

Select the action the exclusion will apply to.

Table

Select a table to exclude the action from.

Exclude this table

Select to exclude the action from the selected table.

Exclude all child tables

Select to exclude the action from all child tables.

View

Select a view to exclude from action from.

Note: 

◦ You’re required to select either a table or view to submit an Action Exclusion record.

◦ If you select a table, you must select Exclude this table  or Exclude all child tables  for 
an exclusion to occur.

◦ If you specify both a table and view, the action is only excluded from the corresponding 
table within the specified view.

◦ If you only select a view, the action is excluded from the specified view regardless of 
the table.

6. Select Submit.

Result
The global form or list action is excluded from the specified table or view.

Hide a global form action from a page layout

Configure a global form action to exclude a specified page or experience.

Before you begin
Add a UX Form Actions Layout to a workspace page in UI Builder. The UX Form Action Layout 
record configured on the workspace page must contain the form action you want to hide from the 
page. For instructions, see Configure an action layout for a workspace page.

Role required: admin

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

276



Procedure

1. Navigate to All  > Now Experience Framework  > Declarative Actions  > Form Actions.

2. Select the form action you want to hide.
An Action Assignment record opens.

3. Select the Form Action Layouts  related list tab.

4. Select the layout configured on the workspace page.

The scope must match the application of the record.

Important: 
Any UX Form Actions Layout records created in Washington DC  or later are unified 
automatically. You will need to manually associate any form actions created in releases 
earlier than Washington DC.

A UX Form Actions Layout record opens.

5. Select the UX Form Action Layout Items  related list tab.

6. Locate the form action you want to hide and change the Active field to false.

7. Select Update.

Result
When the UX Form Actions Layout is configured on a workspace page in UI Builder, only enabled 
actions will appear on the page.

Restrict a global list action to a workspace page

Configure a global list action to display only on a specified workspace page.

Before you begin
Configure an action configuration record for a list action, and copy the action configuration 
record's sys_id. For instructions, see Configure an action configuration record.

Role required: admin

About this task
List actions are global and appear in all Configurable Workspace  experiences by default. The 
action assignment record for a list action has a Experience Restricted  field that is set to false by 
default.

When the Experience Restricted  field is set to false, the list action appears on all list pages 
regardless of the Configurable Workspace  experience.

When the Experience Restricted  field is set to true, the list action doesn't appear in any list page 
across any Configurable Workspace  experience. To display the list action, the workspace page in 
UI Builder  must be configured with the action configuration record tied to the list action.

Procedure

1. Navigate to All  > Declarative Actions  > List Actions.

2. Select the list action you want to restrict.
An Action Assignment record opens.

3. Select the Experience Restricted  checkbox to set it to true.

4. Select Update.

5. Open your workspace experience in UI Builder.
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For instructions, see Open a Configurable Workspace  experience in UI Builder.

6. Select or create a list page.
For instructions on creating a workspace page in UI Builder, see Create a Configurable 
Workspace  page.

7. From the Content tree, select the Record List Header.

8. Select the Configure  tab and expand the Declarative actions  section.

9. In the Action configurations for declarative actions property, paste the sys_id for the action 
configuration record tied to the list action you want to display.

Result
The global list action displays only on the workspace page configured with the action 
configuration record's sys_id.

Declarative actions glossary

Refer to this glossary for definitions to terminology associated with declarative actions.

Action assignment fields

Action assignment field Description Action model field appears

Action label Displays the default label on 
the button at runtime.

Required

• Attachment

• Form

• List

• Field decorator

• Related list

Action name Populates a unique identifier 
for the action automatically 
based on the action label.

• Attachment

• Form

• List

• Field decorator

• Related list

Active Determines whether an action 
appears.

Default: true

Required

• Attachment

• Form

• List

• Field decorator

• Related list

Application Associates the action with an 
application scope.

Defaults to your current 
application scope.

• Attachment

• Form

• List
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Action assignment fields  (continued)

Action assignment field Description Action model field appears

Required • Field decorator

• Related list

Button type Determines which button 
variant displays at runtime.

Default: Primary

• List

• Related List

Client Script
Applicable when the 
Implemented as field is set to 
Client Script.

Executes client-side scripts 
that join form or list functions.

• Attachment

• Form

• List

• Field decorator

• Related list

Decorator applies to Determines where the 
decorator should appear. Only 
three decorators may appear 
on a single field at one time.

Default: Field type

Required

Field decorator

Description Describes what the action 
does for future reference.

• Attachment

• Form

• List

• Field decorator

• Related list

Enable for all configurable 
experiences

Determines if an action should 
appear in all experiences or 
only in specified experiences. 
If true, the action appears 
in any applicable form 
regardless of experience.

Default: false

Form

Experience restricted Determines if an action should 
appear in all experiences or 
only in specified experiences. 
If true, the action only appears 
in specified experiences.

Default: false

• List

• Related list

• Field decorator
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Action assignment fields  (continued)

Action assignment field Description Action model field appears

Field Name
Applicable when the 
Decorator applies to field is 
set to Specific field.

Determines the specific 
field that should have the 
decorator appear.

Available options are limited 
to columns available on the 
selected table.

Required

Field decorator

Field type
Applicable when the 
Decorator applies to field is 
set to Field type.

Determines which field type 
displays the decorator.

Available field types:

• Domain ID

• List

• Price

• Date

• Date/Time

• Decimal

• Document ID

• Email

• Floating point number

• Integer

• Password (1-way encrypted)

• Phone Number

• Phone Number (E164)

• Reference

• String

Field decorators don't support 
string fields that appear as 
multiple line text fields at 
runtime.

Required

Field decorator
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Action assignment fields  (continued)

Action assignment field Description Action model field appears

Group Applicable when the Group By 
field is set to true.

Determines which group to 
add the action to.

Required

• List

• Related List

Group By Determines whether to 
add the action to a group 
displayed as a split button at 
runtime.

Default: false

• List

• Related List

Implemented as Determines whether the 
action is a server script, client 
script, or UXF client action.

Required

• Attachment

• Form

• List

• Field decorator

• Related list

Order Sets the display order of the 
action. An action with an order 
lower than other actions will 
appear closer to the front.

Default: 0

• Attachment

• Form

• List

• Field decorator

• Related list

Server Script Applicable when the 
Implemented as field is set to 
Server Script.

Executes server-side scripts 
such as creating, deleting, or 
reassigning a record.

• Attachment

• Form

• List

• Field decorator

• Related list

Specify client action Applicable when the 
Implemented as field is set to 
UXF Client Action.

Determines the payload 
dispatched when the action is 
triggered.

Required

• Attachment

• Form

• List

• Field decorator

• Related list
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Action assignment fields  (continued)

Action assignment field Description Action model field appears

Table Determines the table where 
the action appears. If set to 
Global [global], the action 
appears regardless of the 
table.

Required

• Attachment

• Form

• List

• Field decorator

• Related list

Tooltip Displays text when you hover 
over the action.

• Attachment

• Form

• Field decorator

• Related list

UI interaction Applicable when the 
Implemented as field is set to 
UI interaction.

Determines the UI interaction 
to execute when the action is 
triggered.

Required

• Form

• List

• Related List

UXF Client Action Applicable when the 
Implemented as field is set to 
UXF Client Action.

Executes a page-level event in 
UI Builder.

• Attachment

• Field decorator

• Form

• List

• Related List

View Determines the view where 
the action appears. If left 
empty, the action appears 
regardless of view.

• Attachment

• Form

• List

• Field decorator

• Related list
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Condition fields

Condition field Description Action model field appears

Client Conditions Defines the client-side 
conditions that evaluate 
whether the action appears.

• Attachment

• Field decorator

• Form

Dynamic Record Conditions Applicable when the Enable 
Dynamic Evaluation field is set 
to true.

Defines record-based 
conditions based on 
the table's columns that 
determine whether the action 
appears.

• List

• Related List

Dynamic Script Conditions Applicable when the Enable 
Dynamic Evaluation field is set 
to true.

Defines a client-side 
JavaScript expression that 
determines whether the 
action appears. List actions 
have access to the current 
record. Related list actions 
have access to the parent 
record.

• List

• Related List

Enable Dynamic Evaluation Applicable when the 
Experience Restricted and 
Record Selection Required 
fields are set to true.

Determines whether dynamic 
script and record conditions 
can evaluate whether the 
action appears.

• List

• Related List

Record Conditions Defines record-based 
conditions that determine 
whether the action is returned 
to the client.

• Attachment

• Field decorator

• Form

Required user role names Determines which roles can 
view the action.

Default: snc_internal

• Attachment

• Field decorator

• Form

• List

• Related List
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Condition fields  (continued)

Condition field Description Action model field appears

Requires create access Requires you to have create 
access to view the action.

Default: false

• Attachment

• Field decorator

• Form

• List

• Related List

Requires delete access Requires you to have delete 
access to view the action.

Default: false

• Attachment

• Field decorator

• Form

• List

• Related List

Requires read access Requires you to have read 
access to view the action.

Default: true

• Attachment

• Field decorator

• Form

• List

• Related List

Required write access Requires you to have write 
access to view the action.

Default: false

• Attachment

• Field decorator

• Form

• List

• Related List

Script Condition Defines a server-side script 
that determines whether the 
action is returned to the client 
for rendering.

Form actions have access 
to the current record, script 
includes, and the GlideRecord 
API. Related list actions have 
access to the parent record.

• Attachment

• Field decorator

• Form

• List

• Related List

Scripted Client Condition Defines a client-side 
JavaScript expression that 
dynamically determines 
whether the action appears. 
Supports dot-walking and 

• Form

• Field decorator
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Condition fields  (continued)

Condition field Description Action model field appears

string interpolation using 
{{variable}}  syntax.

Related lists

Related list Description Action model field appears

Action Configurations Groups actions in an 
experience. Must be 
referenced on the 
corresponding form or list 
page to display the actions.

• Attachment

• Field decorator

• Form

• List

• Related List

Action Exclusions Defines the tables and views 
where the action is hidden.

• Attachment

• Field decorator

• Form

• List

• Related List

Action Model Fields Provides contextual runtime 
data based on the action 
model.

• Attachment

• Field decorator

• Form

• List

• Related List

Form Action Layout Item Determines how the action 
appears at runtime. Created 
automatically for any new 
form actions formatted for 
Configurable Workspace.

Form

UX Add-on Event Mappings Applicable when the 
Implemented as field is set to 
UXF Client Action.

Maps an action to a UXF 
event on a specific page or 
controller. Can remap the 
payload to a new structure.

• Attachment

• Field decorator

• Form

• List

• Related List

Using Configurable Workspace

Get familiar with your ServiceNow  workspace.
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A workspace is a suite of tools that provides agents, case managers, help desk professionals, 
and managers with tools to help answer customer questions and resolve customer problems. 
ServiceNow  provides many workspaces, each is targeted at a specific user. For example, 
workspaces are designed for tier 1 agents who solve internal or external customer issues.

Workspaces include all the tools that agents need to find, research, and resolve issues. 
ServiceNow  provides different workspaces for different issue types. For example, agents using 
IT Service Management Workspace (ITSM) track and resolve IT issues. Agents using Customer 
Service Management Workspace (CSM) resolve customer cases, such as sending a piece of 
computer hardware to fulfill a customer's request.

Key features

Single-pane view

Agents can see all details that are related to an issue in one place.

Integrated communication channels

Agents can communicate in real time with customers by Agent Chat  or phone in the 
same interface.
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Integrated email client

Agents can read and respond to emails side by side.

Agent assistance
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Agents can close cases and incidents faster with artificial-intelligence-assisted 
recommendations.

Playbook

Agents can accomplish business process workflows in a simple, task-oriented view.

Dynamic Translation

Support for dynamic translation for string, text area, and wide text is available in 
Workspace.

Functionality not supported

Guided Tours

Guided Tours is not supported in Workspace.

Starting in your Workspace

Use workspace to find and resolve internal or external requester issues.

The following video shows an example of how to resolve an incident using workspace.
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Using Agent Workspace

Your general workflow using workspace is:

1. Find an issue to work on.

2. Work on the issue to find a solution.

3. Communicate the resolution to the requester.

Next

Get started using workspace by working through some tutorials.

Learn how to use your Workspace

Use the tutorials to walk through many parts of workspace that you will use on a regular basis.

The following tutorials are included for you to get a sense of how workspace works:

• Work on issues that are already in the database.

• Work on issues that come in through phone calls or chats.

Note: 
UI may vary between classic Workspace and UIB Workspace, but the functionality of the 
features is the same.

Once you complete both tutorials, you should have a feeling for what workspace does. The 
topics after the tutorials provide detailed instructions about how to use all of the functionality in 
workspace.

Workspace tutorial for agents starting with a record

Perform the steps in this tutorial to get an idea how you can use Workspace when you begin with 
a task already stored in the database.

Before you begin
Role required: agent

About this task
Use Workspace to:

1. Find a task to work on.

2. Do research to resolve the task.

3. Communicate the solution to the requester or enter notes for yourself and other agents that 
document your progress in finding a solution.

The following graphic provides a quick overview of finding and solving an issue.

Procedure

1. Open your workspace by selecting your Workspace from the Workspace menu.

Note: 
In the previous image, you can see Agent Workspace Home  in the application modules. 
You can click that to open Workspace. The following steps are for you if you're using a 
different workspace.

2. Click the name of your workspace and then under Related Links, click Open workspace.
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Your workspace opens.

3. Log in to your workspace.

The first thing to do is find out what to work on. You can do that by looking at what's on the 
landing page, as shown in this image. Or, you can go directly to the list of open issues to solve. 
Let's see how to do both.

4. View P1 incidents that haven't been solved by clicking Open P1 Incidents  on the landing page.
A list of P1 incidents open.

This display is called the List view. It's a list of records, in this case, incident records. Normally, 
you'd click one of the records to open it. Before you do, let's see how else you can start from a 
list to find a task to work on.

5. Click the list icon ( ) in the left, edge menu.
In the Lists tab, you see the groups of records you can open as lists. For example, you could 
open All problems  or All change requests.

6. In the Lists tab, under Incidents, click Open.
A list of open incidents appears. Let's find out what the problem is and solve it.

7. Click an incident.
The record opens in what is called Record view.

From top to bottom, here's what to notice:
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◦ This record is on a tab labeled INC000905. You can open other incidents without closing 

this one. How? Click the list icon ( ) and click another incident. You can always jump from 
record to record by clicking the tabs.

◦ The form header shows the record's short description, "Email server is down." The form 
header is like the title of the incident record.

◦ Underneath that title in the form header is high-level information, including the importance 
of the task (Priority), whether it's been worked on (State), and the kind of incident this is 
(Category).

◦ On the bottom, the Details  tab shows many details in the record. This section is called the 
form pane. Notice that you can scroll this section. You can enter information in this section, 
for example when you get additional information from the requester.

Basically, the Activity  pane is where you communicate with the requester or make notes to 
yourself or other agents about your progress in dealing with this incident. On the far side, the 
Contextual Side panel is where you do your research to find solutions for the task at hand.

8. Click through the tabs next to the Details  tab to get information related to the open record, 
such as the service level agreement (Task SLAs) for this task, continuous integrations (Affected 
CIs) that might be affected, services impacted by the incident, related incidents, outages, and 
so on.
These items that work like tabs are called the Related items menu.

9. Click Assign to me  to work on this incident.

10. Scroll down the stack of cards in Agent assist  to solve this issue.
The stack of cards is located on the side. If you don't see a card that suggests a solution, you 

could enter a search term beside the search icon ( ). Notice that workspace automatically 
entered the value of the Short Description field from the record in the search field and used 
that to search.

11. Click the card if It looks like the Reboot Windows Server  card might be the solution that you 
want.

Agent assist  gives you the opportunity to order a reboot.

12. Click Helpful  to provide guidance to the predictive intelligence software that this was a good 
solution for this incident.

13. Click Order  to issue a change request to reboot the Windows server.
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Notice a new tab appears as a child tab of the same incident tab. These child tabs enable you 
to accomplish multiple tasks on one screen. All of the child tabs relate to the same incident, 
which is shown on the tab at the top.

14. If you were really solving this issue, you'd click Submit  and then click the option to save the 
change request.
The system would then create the change request, which someone would then perform.

15. Document what you've done.

In Activity, in the Compose  field, click Comments  and enter a note to the requester explaining 
what you did.

16. Click Post Comments.
Workspace  sends your comment to the requester and also adds it to the Activity Stream, 
which is the history of communications and actions you've taken.
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17. Click Work notes (Private), enter a comment, and click Post Comments  to save information 
that's only seen by fellow agents.
You might use this internal commenting feature if you've not completely resolved an issue but 
want to document what you've done for other agents or yourself when you come back to the 
issue later.

18. In the form pane, scroll to the section, Resolution Information, and do the following.

a. In Resolution code, click on one of the choices from the menu, for example, Solved 
(Permanently).

b. In Resolution notes, enter a description of your resolution.

c. In Resolved by, select your name.

d. In Resolved, select the date and time of the resolution.
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This information becomes part of the record.

19. If you haven't resolved the issue but want to save your progress, click Save.

20. If you've resolve the issue, click Resolved.
The incident no longer appears in the list of open records.

What to do next
You've walked through finding and solving an incident that was in the database. Next, walk 
through solving an issue that comes in through a phone call or a chat.

Workspace tutorial for agents starting with a chat

Walk through this tutorial to get an idea how you can use workspace when you receive a task by 
phone or chat.

Before you begin
Role required: agent

About this task
This tutorial starts with an agent working on a request that started with a chat. The workflow 
would be almost identical if the issue started with a phone call.

Procedure

1. Open your workspace by navigating to Workspace Experience  > Administration  > All 
Workspaces  and clicking the name of your workspace.

2. Click the name of your workspace and then under Related Links, click Open workspace.
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3. Log into your workspace.

4. Click the inbox icon ( ) and set your status to Available.

The green circle at the top left of the icon shows your status is Available. A number appears at 

the top, right of the icon  when there are one or more chats available to answer.

5. Click the inbox to open a chat.
You're given the opportunity to accept the chat.

The Time to accept  counter shows how much time you have to accept the chat. When the 
counter reaches zero, the chat opportunity disappears from your inbox.

6. Click Accept.
The chat pane appears and workspace automatically creates an interaction record, assigns it 
to you, and enters it in the database.

7. Chat with the requester to find out what the issue is.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

295



8. Add information about the customer and issue to the interaction record.
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9. Optional:  You can verify the customer's information by clicking the Verify contact  or Verify 
customer  UI action button.

Note: 
Not all workspaces have these buttons.

A modal appears that displays personal information about the contact or customer. You can 
ask the requester for this information to confirm their identity.

10. Optional:  You can transfer the chat to another agent who has more experience with the issue.
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a. From the Action toolbar in the Active chat panel, click the Transfer Agent icon ( ).

b. In the Transfer to Agent window, select the agent to receive the chat and enter a message to 
that agent.

Note: 
Only the current owner of a chat may transfer the chat to another agent. The transfer 
button is otherwise disabled.

The transferred chat is listed in the Queues panel for the receiving agent. The receiving 
agent can accept or decline the transfer request. When the agent accepts the request, you 
get a confirmation.

11. After chatting, you might decide to create an incident out of this interaction record. Click 
Create incident  to create an incident and transfer the information from the interaction to the 
incident record.
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The incident is automatically assigned to you.

12. Click Save  to save the incident.

13. Look at the information in the ribbon to get information about the requester and the record.

14. Click several of the items in the related items menu to see what other records might be linked 
to the one that's open.

For example, clicking Outages  shows related system failures, and Child incidents  shows 
incidents related to this one.

15. Use Agent assist  to research the incident.

If the suggestions in Agent assist  don't provide answers for the incident, enter a search term.
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16. Document what you've done. In Activity, in the Compose  field, click Comments  and enter a 
note to the requester explaining what you did.

17. Click Post Comments.
Workspace  sends your comment to the requester and also adds it to the Activity Stream, which 
is the history of communications and actions you've taken.
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18. Click Work notes (Private), enter a comment, and click Post Comments  to save information 
that's only seen by fellow agents. You might use this internal commenting feature if you've 
not completely resolved an issue but want to document what you've done for other agents or 
yourself when you come back to the issue later.

19. Click Save  or Resolve, depending on whether or not you've completed your work on this 
incident.

Finding issues to work on in your Workspace

Use workspace to find the issues to work on.

The first step in your workflow is finding issues to solve. You can find issues to work on in the 
following ways:
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• Landing page—Provides a high-level overview of tasks that need to get done.

Clicking a link takes you either to list view or a specific record. You get to the landing page by 

clicking the home icon ( ). For more information, see Use the landing page to find issues to 
work on.

• List view—Displays lists of records to work on. Records are grouped by the table they're in, for 
example, Task, SLA, Incident.

Clicking a link takes you to the record so you can work on it. You get to list view by clicking the 

list icon ( ). For more information about list view, see Use lists to find work to do.

• Chat inbox—Interact in real time with requesters using chat.

Accepting a chat request automatically creates a record for you to record the work you do to 

solve the issue. You get to chats by clicking the agent inbox icon ( ). For more information 
about chatting with requesters, see Getting work from chats.

• Phone inbox—Interact in real time with requesters by phone.

Accepting a phone call automatically creates a record for you to record the work you do to 

solve the issue. You answer and make phone calls by clicking the phone icon ( ). For more 
information about using phones in workspace, see Get work by phone in workspace.

• Share a record—See a record another agent is working on so you can help.

Next

Learn how to use the landing page to find work to do.

Use the landing page to find issues to work on

Use the landing page to get an overall view of work that needs to get done.

Before you begin
Role required: agent
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About this task
The landing page is the first page you land on when opening a workspace. It can contain high-
level information, such as unassigned, high-priority tasks, or tasks assigned to you. For example, 
the following landing page shows unassigned, high priority cases, such as open P1 incidents. 
The page also shows tasks assigned to you under My Work.

Landing pages are configurable by your system administrator so yours might look different.

Procedure

1. Navigate to All  > Workspace Experience  > Workspaces  and click your workspace.
Your landing page opens.

2. Click any of the links on the landing page to select an issue to work on.
If you click a group of records, such as, open P1 incidents, list view opens and you see a list of 
P1 incidents that you can choose to work on. If you click the link to a specific record, such as 
INC0018313, that record opens in record view.

What to do next
Learn how to find work do to in list view. Once you click a record in a list, it opens in record view.

Using lists to find work to do

Use lists in workspace to see high-priority issues and which issues are assigned to you.

To get to list view, click the list icon ( ).

You see two tabs of lists: Lists  and My Lists. The system administrator creates the list categories 
in Lists. You create the list categories in My Lists.

List categories

List categories  in the previous image are Tasks, SLAs, and Incidents. List categories are not 
clickable and therefore serve mainly as headings for the list filters beneath them. For example, 
under the list category, Tasks, are the list filters, My Work  and My Group's Work.

Your system administrator sets up the list categories, which typically correspond with the tables 
in the database. For example, all incidents are stored in the incident table. All interactions are 
stored in the interaction table. The list categories your system administrator chooses to display 
in list view correspond to the kinds of issues you work on. If you work on incidents, your system 
administrator shows incidents in the Lists  column. If you work on cases, the Lists  column shows 
cases.

You can use the up arrowhead icon ( ) to display the list filters under each list category. Clicking 

the down arrowhead icon ( ) collapses the list categories to make it easier to scroll through the 
list categories.
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You cannot have a list category without list filters.

List filters

List filters  are the subsections under list categories. In the previous image, under Tasks, you see 
My Work  and My Group's Work. Each list filter provides a helpful grouping of records typically 
from one table. For example, My Cases  enables you to quickly find cases assigned to you. Your 
system administrator creates the list filters.

Clicking a list filter opens the corresponding list of records in list view. A list filter must belong to a 
list category in the Lists  tab.

My Lists

Any lists that you create appear in this section. Lists in this section are only visible to you. For 
more information about creating your own list categories and list filters, see Create My Lists in 
workspace.

Next

Learn how to work with lists in list view.

Work with lists in workspace

Open a list of records in workspace so you can choose one to work on.

Before you begin
Role required: workspace_user

About this task
List view enables you to see high-level information for all records in a list filter. Normally, clicking 
a field in a record in a list opens that record. If the field is clickable (a reference, document ID, 
or URL), clicking it does not open the record, it opens the record or URL that the clickable field 
points to.

Last refreshed  indicates how long ago the values in the list were last refreshed. To refresh 
the values, refresh the page.

Each list has an associated URL. You can bookmark a list to enable quick access to it.

Here's how to open a list to find records you want to work on.
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Procedure

1. Click the list icon ( ).

2. Find a list category that contains the records you want to work on, for example, Tasks.

3. Click one of the list filters under it.

For example, under Tasks, you might click on a list filter called My Work. That would open up 
a list of task records assigned to you. The list filter title and the number of records in the list 
appear at the top of the list. In the previous image, the All  list contains 8383 records.

4. Optional:  To preview a record before opening it, move your mouse over a record and click the 

information icon ( ).

A side panel opens that shows the record.

5. Optional:  To move to a different page of records, click a page number or one of the arrows to 
move forward or backwards a page, or to the first or last page of records.

(Optional)

6. Optional:  To change the number of records displayed on a page, click the number beside 
rows per page and select a number from the menu.

7. Click a record number to open it.

8. Optional:  To export the records in a list in one of the following formats: CSV, XLSX, JSON, or 

PDF, click the gear icon  and select Export.

What to do next
Now that you know how to open a list and the records in it, find out how to edit records in list 
view.

Edit records in list view

Make updates to a record directly from a list, without leaving the list.

Before you begin
Role required: agent_workspace_user

About this task
You can revise one or more records while in list view. To learn more about a record before editing 
it, view and revise it in record view.
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Procedure

1. Revise a single record from a list.

a. Click the Open Preview icon .

The record opens.

b. Revise the values in the fields and click Update.

2. Optional:  Revise multiple records at once.

a. In list view, click the boxes to the left of all the records you want to revise.

b. Click Edit.
A preview pane opens and shows you the fields you can edit in the selected records.
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(Optional)

c. Revise the values in the fields and click Update.

What to do next
Now that you know how to edit a record in list view, find out how to sort and filter the records 
displayed in a list.

Sort records in lists

Sort the records displayed in list view to more easily find the records you want to work on.

Before you begin
Role required: agent_workspace_user

About this task
Filtered lists can contain thousands of records. Sorting them by field values can help you find the 
records you want to work on. You can sort the entire list based on any of the columns in the list.

Procedure

1. To change the field the records are sorted by, double click a column heading.
An arrowhead icon ( ) appears to the right of the column heading you clicked and workspace 
sorts the list of records based on the values in that column. An arrowhead pointed down 
means the values are sorted from highest to lowest values.

2. Optional:  To reverse the sorting order, click the arrowhead icon so the arrowhead reverses 
direction.

What to do next
Instead of sorting records, you might want to Filter records in lists  to reduce the number of 
records displayed in list view.
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Filter records in lists

Filter the records to reduce the number of records displayed in list view so you can find the 
records you want to work on.

Before you begin
Role required: agent_workspace_user

About this task
Filtering removes records from a list so you can view only those records you're interested in 
working on.

Workspace provides the following ways of filtering records displayed in a list:

• Use the filter icon ( ).

• Filter directly in the list using the column heading.

• Filter directly in the list using the values in the columns.

Procedure

1. To filter out records using the filter icon ( ):

a. Click the filter icon ( ).

b. Click Advanced View.

c. Use the condition builder to specify the conditions one or more field values must meet for a 
record to appear in the list.
For example, [Active][is][true], and [Urgency][is][1- High].

d. Optional:  To add more conditions, click New condition set  and supply a condition.

e. Optional:  Select Save Filter, enter a filter name, and choose permissions to determine who 
can use the filter.
Retrieve the filter by selecting Use existing filter  and select the filter.

f. Click Update.

The list filter icon  shows the number of conditions that apply to the current list.

2. Filter records based on field values displayed.
You can work directly with list columns to filter out records.

a. Click the More UI Actions  icon  to the right of a column heading.

b. Click the downward pointing arrowhead icon ( ) and select a filter condition, such as is not, 
starts with, or contains.
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c. Enter the field value to filter the list on the bottom line and click Apply.
In the following example, the only records that appear have Caller  values that start with 
David.

Note: 
Not all field types support column filtering. You can use the Advanced Filter  panel 
and condition builder to create a filter for those field types.

d. If the values come from the sys_choice table, the possible values (choices) appear with 
boxes beside them.
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If there are more than ten fields, workspace displays a Filter, as shown here, so you don't 
have to scroll to find a field value. If there are less than ten choices, there's no entry filter 
under Filter.

You can click All  to select all of the fields or None  to uncheck all of the fields. All  selects 
all of the field values that meet the filter conditions, not just those shown in the pop up. 
Likewise, None  unchecks all of the fields that meet the filter conditions, not just those shown 
in the pop up. You can combine these functions. For example, you can filter on Windows 
and select All, and then filter on 2000  and select None  and wind up with rows that contain 
Windows but not Windows 2000.

You cannot configure the number of fields (10) that makes the Filter  entry field appear.

e. Optional:  To remove the filter and restore all of the records, click the More UI Actions  icon 

( ) and click Clear.

3. Filter out records based on field values.
This feature is similar to the one in the previous step but you can't enter a term to filter the 
records.
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a. Click a field in the record.

b. Click the More UI Actions icon ( ).

c. To remove all records that don't have the same field value, click Show Matching.

d. To remove all records in the list that have the same field value, click Filter Out.
By default, a column sorts in an ascending order unless the column data type is a date. 
Dates sort in a descending order.

What to do next
Instead of filtering records, you might like to group records  in list view.

Group records in lists

Group the records displayed in list view to more easily find the records you want to work on.

Before you begin
Role required: agent_workspace_user

About this task
You can group records that have the same values in a column so you can see similar records.

Procedure

1. Move the mouse over a column heading and click the More Options icon ( ).

2. Click the first option, Group by <column-heading-name>  where <column-heading-name> is 
the name of the column you're clicking in.
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The records are grouped based on the values in the selected column.

The display shows the number of records in each group.

3. Open a group by clicking its arrowhead icon ( ).

4. Optional:  To ungroup the records, mouse over the same column heading, click the More 

Options icon ( ) and click Ungroup by <column-heading-name>.

What to do next
Instead of grouping records, you might like to Filter records in lists.

Create My Lists in workspace

Create your own filtered lists in workspace to monitor your issues, tasks, or problems, under My 
Lists.

Before you begin
Role required: agent_workspace_user

About this task
Create different groupings of records than those provided by your system administrator under 
the Lists  tab. For example, you might like to group all records that pertain to incidents associated 
with a specific company. You can create another version of an existing list, or create an entirely 
new one. Those lists are only visible to you. To access your lists, select My Lists.
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As you can see, My Lists  doesn't have list categories, only list filters.

Procedure

1. Navigate to All  > Workspace Experience  > Workspaces  and select your workspace.
Your workspace opens.

2. Select My Lists.

3. Select +New list.

4. On the form, fill in the fields.

New List

Type Field Description

List Existing list that you want to 
modify. The menu displays all 
available admin defined lists 
for selection.

List Name Name for your list. By default 
this field appends _Copy 
to the list selected in the 
previous menu.

Select columns Record fields to include in list 
view. Columns from the list 
you selected appear. Add or 
remove columns to create the 
list you like as needed.

Start from existing

Add Filters Condition builder to create 
filters that appear in your 
My Lists tab. By default the 
conditions applied to the list 
selected appear.

List Name Name for your list.

Select Source Table the records come from.

Create your own

Select columns Record fields to include in list 
view. Select the columns that 
display in the list. By default 
this field populates with 
columns from a Workspace 
list view if one exists. If a 
Workspace list doesn't exist, 
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Type Field Description

the columns are populated 
with the Default list view of 
the table selected.

Add filters Condition builder that is 
applied to the list.

5. Select Create.
The list appears on the My Lists  tab.

6. Optional:  To change the order of your lists, select Reorder, then drag each list into the order 
that you want and select Done.

7. Optional:  To modify or delete any of your lists, select the gear icon ( ) and select one of the 
following:

Rename

Enables you to rename a list.

Personalize Columns

Enables you to alter the columns that are displayed in the list.

Save

Saves the current list and underlying filters.

Save as

Saves and renames the current list and underlying filters under My List.

Export

Export My List  in a variety of formats.

Delete

Removes a list from My List.

Edit your Workspace  list columns and save the list

Edit which columns appear in your list and how they're ordered, and save the list to My Lists.

Before you begin
Role required: agent

Note: 
Column personalization must be enabled for agents.

Procedure

1. In a Workspace  list, select the List Actions Icon ( ).

2. Select Edit columns  from the menu.

3. In the Edit List modal, move the columns over that you want to display from Available columns 
to Selected Columns.
The selected columns display from left to right with the first column displaying on the far left.

4. Select the List Actions Icon ( ).

5. Select Save.
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Your list configuration is now accessible in the My Lists  tab. You can rename the list or delete 
the list from the options in the List Actions menu.

Personalize your Workspace  list columns by dragging them to the order you want

Drag your list columns to where how you want them.

Before you begin
Column personalization must be enabled.
Role required: agent

Procedure

1. Drag a column using your mouse.

a. In a Workspace  list, select and hold the grab icon ( ) in the column header of the column 
you want to drag.

b. Drag the column and place it between the two columns where you want to place it.

2. Drag a column using your keyboard.

a. In a Workspace  list, select the column header of the column you want to drag and press 
Enter  on your keyboard.

b. Press Enter  again on your keyboard to select the grab icon ( ).

c. Use your arrow keys to move the column to the location you want.

d. Press Enter  on your keyboard to place the column.

Inline edit one or multiple cells in a list

Inline edit one or multiple cells from the same column of a list to simultaneously change the 
value of the selected cells.

Inline editing enables you to change a field in a list instead of opening the record and changing it 
on the form. Edited cells must be in the same column when editing multiple cells.
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• Edited cells must be in the same column when editing multiple cells.

• Edit the following fields inline:

◦ Boolean

◦ Choice

◦ Date

◦ Date/time

◦ Decimal

◦ Duration

◦ Float

◦ Integer

◦ Phone

◦ Phone e164

◦ Reference

◦ String

◦ Table name

◦ Tags

◦ URL

Inline edit using a mouse

Inline edit one or multiple cells from the same column using a mouse.

Before you begin
Role required: none

Procedure

1. Edit a single cell.

a. Double click a cell.

b. Enter the value you want and press Enter.
To cancel the inline edit, press esc  or Cancel  on the keyboard, or click outside the cell.

2. Select consecutive cells.

a. Place focus on a cell.

b. Hold shift  on the keyboard and select the final cell you want to change.

c. Double click the cell.

d. Enter the value you want.
To cancel the inline edit, press esc  or Cancel  on the keyboard, or click outside the cell.

e. Press Enter.
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3. Select non-consecutive cells in a column

a. Place focus on a cell.

b. Hold down the command  key (or windows  key) and select the cells you want to edit.
The cells must be in the same column.

c. Double click the cell.

d. Enter the value you want.

e. Press enter.

Result
The selected cells display the new field value.

Inline edit using a keyboard

Inline edit one or multiple cells from the same column using a keyboard.

Before you begin
Role required: none

Procedure

1. Edit a single cell.

a. With focus on a cell, press shift  and Enter  on the keyboard.

b. Enter the value you want.
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To cancel the inline edit, press esc  or Cancel  on the keyboard, or click outside the cell.

c. Press enter.

2. Select consecutive cells.

a. With focus on a cell, hold shift  on the keyboard.

b. Use the arrow keys to select consecutive cells in a column.

c. Press shift  and Enter  on the keyboard.

d. Enter the value you want.
To cancel the inline edit, press esc  or Cancel  on the keyboard, or click outside the cell.

e. Press Enter.

Result
The selected cells display the new field value.

Get work by phone in Workspace

Use workspace to make inbound and outbound telephone calls if your instance is integrated with 
your telephony system.

Before you begin
Role required: workspace_user

About this task
You can do the following with the Workspace  phone:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

318



• Make an outgoing call

• Receive an incoming call

• Transfer a call to another user within the system

• Place a call on hold or on mute

• Set your availability status

Procedure

1. Do one of the following.

Option Description

Click the phone icon in the main navigation 
bar.

Enter the phone number in the Number  field 
and click Call.

Click the phone icon next to the Contact  or 
Consumer  fields on the form.

For your contacts who may have multiple 
phone numbers:

◦ If only one phone field is populated, a call is 
placed to that number.

◦ If you see a dialog box that displays more 
than one number, click the number that you 
want and then close the dialog box.

2. Click End  to end the call.

Getting work from chats

Use the agent inbox to manage your incoming work items, such as chats, cases, incidents, and 
more.

To open the agent inbox, select the Inbox  icon in the navigation bar. When you accept a chat, 
an interaction record is automatically created and captures the work done in that session.

Inbox responsibilities

Agent responsibilities Description

Monitor your inbox Use designated service channels to route work items to available 
agents, such as incoming chat requests, case assignments, and 
incidents.

Start a chat session Accept a chat from your inbox. You have a time limit to accept a 
chat before it reroutes to another agent. The chat associates to an 
interaction record  that captures the conversation and work done during 
the session.

During a chat session, you can:

• Add attachments using the Action toolbar.

• Transfer the chat to another agent.

• Add another agent to the chat.
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Inbox responsibilities  (continued)

Agent responsibilities Description

• Perform other support tasks, such as create an incident or case.

• Use workspace tools, such as the ribbon to glance at information or 
the activity stream to review related work.

Agent inbox features

Feature Description

(A) Agent 
inbox

Display the queues that are assigned to you, the number of active chats in each 
queue, and the average wait time for chats in the queue.

(B) Active 
chat panel Display your active chat session. Chat actions appear beneath the chat and allow 

your agents to attach a file, add an agent, transfer the chat, and more. Depending 
on your configuration, these may display:

• Conversation history: messages from previous conversations appear. Only 
previous conversations between you and the requester appear.

• Cross-channel conversation history: messages from all channels (including 
Facebook Messenger, LINE, Slack, Twilio SMS, Microsoft Teams, WhatsApp, 
and Voice) will appear.

• Customer sentiments: feelings of the customer (positive, neutral, negative, null 
(no value assessed)). Customer sentiments let you identify if a user's sentiment 
is moving from neutral/positive to negative so you can take action to move 
them back to a more positive sentiment.

• Start and end messages that include icons indicating the channel used for the 
conversation (chat, phone, or messaging):

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

320



Feature Description

(C) Toolbar Display buttons for available actions:

• Quick actions   - select to display the quick action menu.

• Transfer to queue  - select to transfer the conversation to the queue.

• Transfer to agent  - select to transfer the conversation to an agent.

• Attach  - select to add an attachment to the conversation.

• Dynamic Translation for Agent Chat  enabled  - displays if DTAC  is enabled.

• Overflow  - select to display any additional actions.

Note: 
Not all buttons may be available.

(D) 
Interaction 
record

Display the interaction record (IMS). The IMS initiates from a chat or phone call 
and lists the initial information about the customer and the communication. You 
can archive this interaction as a log of communication, or you can create an 
incident or a case that is based on the customer needs.

(E) Buttons Perform an action by selecting a button:

• Create Incident

• End Conversation

• Save

• End Chat

• Assign to Me

Note: 
Not all buttons may be available.

(F) 
Attachments 
panel

Add attachments to the interaction. For example, you can add supporting 
information to a customer issue. If templates are available, they appear in the 
template section of this panel.

Ongoing messages

The Ongoing messages tab displays when you have access to at least one presence state which 
includes a messaging-based service channel.
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Select the clock  icon to display cards for ongoing messages. If the clock icon has a 

number in the upper right-hand corner , this number indicates the number of messaging 
conversations with unread messages. If a card has a green dot, there is a new message for 
that messaging conversation. The card also displays the interaction number and when the last 
update was made on the conversation.

Accept a chat session

Begin a conversation with a customer by selecting a chat queue in the chat session. You can 
work on multiple chats in different queues simultaneously.

Before you begin
Role required: workspace_user

Procedure

1. Navigate to All  > Workspace Home  > Inbox.

2. From your inbox, accept or reject a chat.

You are automatically connected to the first customer in the chat queue, which is the oldest 
request in the queue. The Active Chat panel displays a pre-chat message acknowledging the 
customer chat request. You can review the customer information before you enter a response 
in the Active Chat panel.

Note: 
If your session has long-running transactions, there may be a delay in assigning a work 
item to you and the inbox cards may display a "delayed transactions" message.

In the chat workspace, an interaction parent tab with a details child tab open for the session. 
The details child tab offers more information on the chat request and provides contextual 
options for performing related operations during the chat session.

3. Use chat tools for managing the chat and contextual options to perform related tasks.

Option Description

Manage your chat

Do the following actions from the Actions tool­
bar:

◦ Add an attachment.

◦ Transfer a chat to another queue.

◦ Transfer a chat to another agent.

Perform additional support tasks
Engage in other support work during the chat 
session by using the contextual options in the 
Details  tab. For example, you can:
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Option Description

◦ Update chat information.

◦ Create a new case or incident.

From the sub-tab, you can select other 
contextual options to work on a resolution 
for the case or incident. For example, you 
might need to escalate the issue.

◦ Choose a related task in the More options 
(….), such as send email.

◦ Search for relevant information in the knowl­
edge base.

4. To close the chat session, close the tab or select Close  in the Details  tab of the interaction.
Ending the chat saves the conversation history and closes out the interaction. If you close 
the chat by closing the tab, you lose all of the conversation history and you cannot save the 
information in the interaction record. If the wrap up feature is enabled, you can enter details or 
wrap up codes in the interaction record.

Transfer a chat to another queue

Route a chat to another queue. Any agent who belongs to the associated queue can accept the 
chat.

Before you begin
Role required: workspace_user

Procedure

1. Navigate to All  > Workspace Home  > Inbox.

2. On the Action toolbar, select the transfer to queue icon ( ).

3. In the Transfer to Queue panel, select the queue to transfer the chat to.
When you transfer a chat, the current work item associated with the interaction is marked as 
closed complete. A new work item is associated with the new queue and the chat is added 
to the selected queue. When a receiving agent accepts the transfer, that agent sees the 
conversation and the chat history in the Active Chat panel. When you’re transferred from a live 
agent back to a queue, the logic doesn’t check for live agents, and the chat goes to the queue 
to be picked up by an agent.

Transfer a chat to another agent

Route a chat to another agent in the same service channel. You cannot route a chat to another 
agent in a different service channel, even if the channels have identical routing conditions.

Before you begin
Role required: workspace_user

Procedure

1. From the Action toolbar in the Active chat panel, select the Transfer Agent icon ( ).

2. In the Transfer to Agent window, select the agent to receive the chat.
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Note: 
Only the current owner of a chat may transfer the chat to another agent. The transfer 
button is otherwise disabled.

The transferred chat is listed in the Queues panel for the receiving agent. The receiving agent 
can accept or decline the transfer request.

Add an attachment to a chat

Agents may have documents or image files that provide additional information for a case. 
These documents and image files can be added as attachments to the conversation for future 
reference.

Before you begin
Role required: agent_workspace_user

Procedure

1. Use one of these methods to add an attachment:

◦ From the Action toolbar, select the attachment icon ( ) then select the file.

◦ Drag and drop a file from your local computer to the chat window.

2. If you add an attachment during a chat, the attachment is automatically transferred from the 
live chat to the interaction.
If the interaction leads to the creation of a case/incident, then the attachment is automatically 
transferred to the case/incident.

Change your status in the chat panel

Change your status while you are on a break or offline so no new chats are assigned to you. 
When you return, you can update your status to let everyone know you are back.

Before you begin
Role required: agent_workspace_user

Procedure

1. Navigate to All  > Agent Workspace Home  > Chat.

2. In the chat panel, from the status list, select your current status.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

324



◦ Available: You are available to receive new chats.

◦ Away: You are not available to receive new chats.

◦ Offline: You are not available to receive new chats.

What to do next
Adjust your status depending on your availability.

Set up a new chat or work item alert

Set up an audible alert to notify you when a new chat or work item arrives in your Agent 
Workspace  inbox. Only agents who are subscribed to the corresponding service channel can 
change the settings.

Before you begin

• Install the Agent Chat plugin (com.glide.interaction.awa).

• Enable Desktop Notifications for browser.

Role required: agent

About this task
Note: 
Notifications play a crucial role in an agent's workflow. However, as browsers continue 
optimizing resource usage, they may pause or suppress notifications in certain 
environments or scenarios. To ensure agents receive timely alerts, we recommend 
thorough testing and adjustments to user settings and behavior. Keep in mind that each 
browser has its own implementation and restrictions, so what works in one may not work in 
another.

Procedure

1. In your Agent Workspace  inbox, select the settings ( ) icon.

2. To receive desktop notifications for new items in your inbox, turn on Inbox Desktop 
Notifications.
These notifications are delivered if the Agent Workspace  browser tab is open but not currently 
in focus.

3. To receive audible alerts for new items in your inbox, turn on Inbox Audio Alerts.
These alerts are delivered if the Agent Workspace  browser tab open, it doesn't matter whether 
the tab is in focus or in the background.

4. To receive desktop notifications for new conversations in your inbox, turn on Conversation 
Desktop Notifications.
These notifications are delivered if the Agent Workspace  browser tab is open but not currently 
in focus.

5. To receive audible alerts for new chats in your inbox, turn on Conversation Audio Alerts.
These notifications are delivered if the Agent Workspace  browser tab is open, it doesn't matter 
whether the tab is in focus or in the background.

6. To receive browser notifications, you must have this set-up:

a. Chrome as your browser.

b. Configured to receive Conversation Desktop Notifications.
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c. Workspace browser tab is not in focus.

d. There is a new message on a conversation assigned to you.

For additional information, see Setting up Agent Chat .

Monitor chat conversations

Chat supervisors can view ongoing chat conversations and join them to assist agents and 
requesters in Workspace  Agent Chat.

Before you begin
Role required: awa_manager

Procedure

1. Navigate to All  > Lists  > Interactions  > Active Chat Interactions.

2. Select an active chat interaction from the list.

3. If Agent Whisper  is installed, an agent can ask for help by typing /help  in the Active Chat 
window.
A message is sent only to the chat supervisor, the requester does not see this message.

4. In the Active Chat panel, click Join.

A notification lets the agent and requester know that you've entered the chat. Messages that 
you submit are visible to the agent and requester.

Note: 
Your presence is not known until you join a chat.

5. If Agent Whisper  is installed, click Send Private Message  to send a message to the agent.
The requester does not see this message, only the agent sees the message.

Interaction records in Workspace

Using an interaction record, agents can create or reference customer information from a 
customer contact. Agents can then decide if the conversation is an incident, case, or request.

An interaction represents a request for assistance made through a chat, phone call, or walk-
up. Interactions can be routed to queues for assignment or assigned to agents directly. Support 
agents can create cases, requests, or incidents from the interaction. Interactions can also 
be used to capture one-and-done type requests where an agent might not want to create 
associated tasks.
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Feature Description

Details, Related Tasks, User's 
Interactions forms

Details  tab that shows detailed information from the 
interaction record. Related Tasks  show tasks related 
to the interaction in the form pane, for example, a new 
incident. User's Interactions  tab shows all interactions 
related to specific users.

Number Number is associated to each customer interaction.

Type Logs the type of channel communication, such as chat, 
phone, walk-up, or messaging.

Note: 
Phone  is an available type of channel 
communication when the OpenFrame plugin 
(com.sn_openframe) is activated.

State State of the interaction record:

• New

• Work in Progress

• Closed Complete

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

327



Feature Description

• Closed Abandoned

• On Hold

State reason Reason for the current state of the interaction record:

• Waiting on customer

• Waiting internal

• null

This field appears only for messaging type 
interactions.

Opened for Customer who initiates or receives the communication.

Duration Tracks the amount of time an agent spends working on 
an interaction.

Assigned to Agent the interaction record is assigned to.

Wait time Time it takes to initially respond to the customer.

Short Description Short description of the interaction.

Note: 
The short description field is empty by default, 
but it cannot be empty when the record is closed, 
saved, or associated to a related task. Populate 
the short description and then close, save, or 
associate the record, or you cannot archive the 
record.

While you are on an interaction, tasks that are viewed or created under the interaction are 
automatically logged on the Interaction Related tasks.

Associating user profiles on messaging interactions

When a requester sends a message, the system checks whether the identifier matches 
an existing channel user profile. Channel user profiles are used to track the identities of 
conversation participants using an identifier associated with the source of the message. For SMS 
messages, the identifier is the phone number from which the message was sent.

If there is a matching channel user profile • A new interaction is started.

• Or the message is associated with an 
ongoing interaction for the matching 
channel user profile.

If there is no matching channel user profile • A new channel user profile is created.

• A new interaction referencing the new 
channel user profile is created.
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• If the identifier matches a user, it populates 
the User document field of the channel 
user profile and the Opened for field of the 
interaction with a reference to that user.

Create a problem from an interaction

You can create a problem record directly from an Interaction when the customer makes contact 
regarding an issue and you need to investigate.

Before you begin

• Role required: workspace_user or admin

• Activate the Problem Management Best Practice — com.snc.best_practice.problem plugin

• Select the Allow Problem creation from Interaction 
(glide.problem.interaction.allow_create) problem property

Note: 
The Interaction feature is a more efficient way to create a problem from an interaction than 
the New Call feature from Service Desk Call (com.snc.service_desk_call) plugin that you 
might have used previously.

Procedure

1. Navigate to All  > Workspace Experience  > Workspaces  > Workspace Home.

2. Click the list icon ( ) and click the Interaction list.

3. Click the interaction record from which you want to create a problem.

4. On the interaction page, click the more actions icon ( ) and select Create Problem.

5. On the form, fill in the fields.

Problem form

Field Description

Number Auto-generated. Number that identifies the problem record.

First reported by Task that first identified this problem.

Category and Subcategory Group to which the problem belongs to such as software or 
hardware. After selecting the category, select the subcategory, 
if applicable.

Service Business service that the problem applies to.

Configuration item Configuration item (CI) that the problem applies to. The CI 
class of the selected configuration item identifies the type of 
problem, for example, hardware, network, or database.

State State management process. The field value changes as the 
problem proceeds from one state to another state. The states 
available are: New, Assess, Root Cause Analysis, Fix in 
Progress, Resolved, and Closed.
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Field Description

Note: 
To access the new state management process, activate 
the Problem Management Best Practice — Madrid 
(com.snc.best_practice.problem.madrid) plugin.

Impact Effect that the problem has on business operations, for 
example, Major revenue loss.

Urgency Extent to which the problem resolution can bear delay.

Priority How quickly the service desk should address the problem. The 
Priority  field is automatically set to the Impact  and Urgency 
values.

Assignment group Group to which the problem is assigned.

Assigned to Problem coordinator to whom the problem is assigned. If 
an assignment rule applies, the problem is automatically 
assigned to the appropriate user or group.

Problem statement Brief description of the problem.

Note: 
Activate the Problem Management Best Practice — 
Madrid (com.snc.best_practice.problem.madrid) plugin.

Description Detailed description of the problem.

Notes

Work notes list Users who receive notification when work notes are added to 
the problem.

Work notes Informative notes about the work performed on the problem.

Analysis Information

Workaround Method used to overcome the issue.if no resolution is 
available yet.

Cause notes The cause of the problem.

Resolution information

Resolved Auto-generated. Date and time when the user resolved the 
problem.

Resolved by Auto-generated. The user who resolved the problem.

Fix notes How the problem was fixed.

Auto-generated information

Opened Auto-generated. Date and time when the user opened the 
problem.

Opened by Auto-generated. User who opened the problem.

Confirmed Auto-generated. Date and time when the issue was confirmed 
as a problem.
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Field Description

Confirmed by Auto-generated. User who accessed the issue and confirmed 
that it was a problem.

6. Click Save.
A problem record is created and the record appears in the Related tasks related list on the 
Interaction form.

Create a standard change from an Interaction

Create a standard change record directly from an Interaction Management  to implement a pre-
approved, low-risk change without having to go through the Change Management  module to 
implement it.

Before you begin
Role required: workspace_user or admin

Procedure

1. Navigate to All  > Workspace  > Workspace Home.

2. Open the interaction record from which you want to create a standard change.

3. On the Interaction form, click the more actions icon  and then click Create Standard 
Change.

4. On the New Catalog Item page, select the standard change and click Submit.
A standard change is created and the record appears in the Related tasks related list on the 
Interaction Management  form.

Getting notifications in workspace

You can receive workspace notifications to get immediate updates about records you're working 
on without leaving workspace.

Notifications present updates about records you're working on or being assigned to regardless 
of whether or not the record is open in workspace. For example, a notification might show that 
you've been assigned in incident.

You can click the notification to open the record.

You can open all of your notifications by clicking on the notifications tray icon ( ).
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The badge number indicates the number of unread notifications.

Workspace deletes notifications after seven days.

Platform Analytics  in your Workspace

Distribute and consume Platform Analytics  through data visualizations and dashboards with 
optional filters. Explore KPIs and receive insights into significant events in the data.

Within the Platform Analytics Workspace, you’re able to:

• Ask a natural language question and be shown the relevant analytics in a visualization.

• View any Next Experience dashboard that you own or has been shared with you.

• Create dashboards and data visualizations from your workspace runtime.

• Drill down into your KPIs, applying filters to slice your data and applying aggregations and 
statistical tools.

For more information, see Performance Analytics and Reporting for Workspace

Working on records in your Workspace

Use Workspace  records to and provide information to your customers and process requests.

Callback features

If callback feature is enabled, customers can request a callback instead of waiting for the 
Agent to become available. Agents get the Callback Interactions routed to them, when they 
are available. For phone callbacks, auto-dialout will happen upon accepting the work item in 
the Inbox. However, the Agent can also use the phone icon in workspace to call the customer 
directly if the auto-dial did not succeed. Agents can perform the following actions in the 
workspace.

Note: 
Agents can see the customers name on the Inbox callback card.

Callback actions

Field Description

Reattempt callback Agents can reattempt a callback by selecting 
the More actions  button and then selecting 
Re-attempt Callback. The Reason  menu 
displays and agents have the following 
options to choose from.

• Dead Air

• VoiceMail

• Customer is Busy

• Other

Closing callback If the issue is resolved, Agents can close the 
callback. If closed, the system does not retry 
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Callback actions  (continued)

Field Description

callbacks, and the callback task is closed. 
Agents can choose from the following options 
to close a callback.

• Resolved

• Other

When a callback is closed, Agents can see the 
transcript and a recording of the conversation 
in the Conversations  tab.

Note: 
The recording is also added to the 
Activity  stream and the Attachment  tab.

Create a record in workspace

Create a record in workspace from the Record tab menu or from a list.

Before you begin
Role required: workspace_user

About this task
You might create a record to capture work you're doing. For example, after a phone call, you 
might create an interaction or incident record. In the record, you capture the information you 
obtained in the phone call.

The kinds of records you can create is configured by your system administrator. The default is an 

interaction record. If you place your mouse over the plus sign icon ( ), the list of records you 
can create appears.

Procedure

1. Click the plus sign icon ( ).

Notice that the record type appears when you place your mouse over the icon.

If you can only create one type of record, a blank form of the record appears. If your system 
administrator configured workspace so you can create multiple record types, workspace 
displays a list of those record types. You then select the type you want to create and that blank 
record type appears.

Note: 
If you have access to more than one domain, filling in a caller or company on the record 
form associates the record with the domain of the caller or company.

2. On the form, fill in the fields and click Save.

Working on callback records in your workspace

Use Workspace  to work on callback records originating from Omnichannel Callback
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overview

Omnichannel Callback  is a ServiceNow AI Platform®  capability that provides an option for 
users to opt for a callback instead of waiting in the queue for an available agent. Advanced 
Work Assignment  routes the callback work items to available agents and interaction records are 
created for each callback work request. The interaction records appear in the Workspace  for 
agents to work on.

Agents can work on the records for the following callback scenarios.

• Recurring callback: AWA  routes a callback work item to an available agent based on the 
predefined callback attempt interval. The agent then receives a Callback  work item. When 
the agent accepts the callback work item, auto-dial initiates a call to the user. Based on the 
resolution, the agent can either close the interaction or requeue the callback.

• Click to call: The agent can directly call the end user using the phone icon in the interaction 
record if auto-dial is not enabled or the initial call did not succeed.

• Scheduled voice callback: When a user requests a voice callback at their preferred date and 
time, an interaction record with callback details is created a minute before the scheduled call 
time and an agent receives the callback work item. When the agent accepts the callback work 
item, auto-dial initiates a call to the user. Based on the outcome, the agent can either close the 
interaction as Closed Complete  or Closed Abandoned.

• Scheduled video callback: When a user requests a video callback at their preferred date and 
time, an interaction record with callback details is created which includes a URL to initiate 
the video call. Based on the outcome, the agent can either close the interaction as Closed 
Complete  or Closed Abandoned.

Callback actions

Field Description

Reattempt callback Agents can reattempt a callback by selecting 
the More actions  button and then selecting 
Re-attempt Callback. The Reason  menu 
displays and agents have the following 
options to choose from.

• Dead Air

• VoiceMail

• Customer is Busy

• Other

Closing callback If the issue is resolved, agents can close the 
callback. If closed, the system does not retry 
callbacks, and the callback task is closed. 
Agents can choose from the following options 
to close a callback.

• Resolved

• Other

When a callback is closed, agents can see the 
transcript and a recording of the conversation 
in the Conversations  tab.
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Callback actions  (continued)

Field Description

Note: 
The recording is also added to the 
Activity  stream and the Attachment  tab.

Dynamic Translation  support in your Workspace

Dynamic Translation  support in Workspace  enables on-demand translation of text in comments 
and work notes, in the Activity stream, and on forms.

Configuring Dynamic Translation

To enable and configure Dynamic Translation  for Activity stream, do the following.

1. Activate the Dynamic Translation  (com.glide.dynamic_translation) plugin. For more information 
see Activate Dynamic Translation .

2. Configure Dynamic Translation  for the translation service provider. For more information, see 
Integration with other translation services .

Translation button in the Activity Stream

The Translate  icon appears in the Activity stream  for comments 
and work notes, next to text that is in a language other than your 

own. .
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The translation result displays below the original text. If the translation isn’t configured properly, 

an error message displays. 

Translation button on forms

Dynamic Translation  can also be configured for forms in Workspace. 

To configure Dynamic Translation  for form fields, do the following.

1. Navigate to a record that needs translation enabled.

2. Right-click a form field that needs translation and select Configure Dictionary.

3. In the Attributes  related list, select New.

4. On the form, fill in the fields as follows.

◦ In the Attribute  field, search for Dynamic Translation Enabled.

◦ In the Value  field, enter true.

5. Select Submit.
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Getting or adding information to a record

Use the form pane to discover detailed information about a record, information related to the 
open record, and to make entries in the record.

Getting detailed record information

To get detailed record information about a record, click the Details  tab. The contents, which 
appear in the form pane, are many of the fields in a record. Your administrator configures which 
fields you see.

You can vary the width of the form pane by dragging the right side of it.

You can scroll through all the fields or jump to a section in the Detail  tab. To jump to a section, 
click the menu icon ( ) to the left of the record type to display the sections in the form pane. 
Click the section title you want to jump to. For example, in the following image, if you click Notes, 
the record fields scroll up to the Notes  section.
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Getting information related to the open record

The Related items menu provides tabs that display information related to the open record.

Click these tabs to understand what this record might be affecting. For example, clicking 
Impacted Services  displays the services affected by the incident in the open record. For more 
information, see Get information related to the open record.

Adding information to a record

When working on a record, you might add or revise some of the fields in the record. You can do 
that on the Details  tab. For example, on the Details  tab, you might change the Urgency  value 
of the record to 1 - late, or, after solving an issue, enter a resolution summary in the Resolution 
notes  section. After entering or changing information in the form pane, click Save.

Additional record functionality

• Template value field:–-. For more information, see Configure a template value field.

• Field name field type

• Doc ID field type

Updating records using templated information

Select one of the templates to add standard information to open records to save yourself some 
work.

Before you begin
Role required: workspace_user

About this task
Templates set field values in the open record to the values specified in the template. For 
example, the major incident template might set the Impact  field in the open record to 1 - High, 
and the Urgency  field to 1 - High. Templates reduce the work you have to do and make actions 
taken more consistent.
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Procedure

1. In Workspace, open an existing record.

2. In the Contextual side panel, click the template icon ( ).

The available templates appear.

3. From the list of templates, select a template to apply to the open record.

Field values included in the template automatically populate the record in the Details  tab of 
the form pane. Workspace provides a pop up of the updated fields.

4. Optional:  To undo the changes that were made in the open record when you selected the 
template, navigate away from the form without saving.

5. Fill in the remaining fields in the Details  tab of the Form pane.

6. Click Save  to save your progress or Resolve  to mark the issue as resolved.

What to do next
Communicate your progress or the solution  with the requester.

Manage custom form templates

Manage custom form templates by creating, editing, and deleting templates.

Before you begin
Create a custom form template that fits the workflow of a customer or activity. Custom form 
templates enable you to retrieve a form with the fields you want to save time resolving the 
workflow. They can also be edited to adapt to new demands or similar cases.
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Form templates can also be domain aware. For more information about specifying a domain for 
your form template, see:

Role required: agent

About this task
Custom form templates are controlled by group assignments.

Procedure

1. In Workspace, select a record.

2. Select the Template icon ( ) in the contextual side panel.

Two  lists display in the contextual side panel. All  displays all available templates, and My 
Templates  displays your custom form templates.

3. Create a custom form template.

a. On the Templates pane in the contextual side panel, select the plus icon ( ).

b. Enter a name for your custom form template.

c. Select the fields you want for your template and delete the ones you don't want.

d. Select Save.

4. Select the option icon ( ) to Edit  or Delete  a template.
Templates that are deleted can't be retrieved.

Specify a domain for a form template

Associate a form template with a domain other than global and specify the users and groups the 
template applies to.

Before you begin
Role required: admin

Procedure

1. In the Filter navigator, enter sys_template.do.

2. On the form, fill in the fields.

Template form

Field Description

Name Name for your form template.

Table Table associated with your form template. For 
example Incident  or Case.

Active Option to enable or disable the form 
template.

Application Application for the form template. The form is 
Global  by default.

Domain Domain you want to associate the record 
with.
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Field Description

◦ This field only displays if you have access 
to more than one domain.

◦ Templates are global unless a domain is 
specified.

◦ Templates spawned from this record retain 
the domain of the record.

User The user or role this template is specified for.

Groups Groups that have access to this form 
template.

Global Option to provide the form template globally.

3. Select Submit.

Undo a form template

Undo a form template to the state prior to the application of the template.

Before you begin

• Only the last form template added is reversed.

• Form field values are reverted back to the state prior to the application of the template.

• Work you've performed isn't changed or deleted by undoing a template.

Role required: agent

Procedure

1. Select the Templates icon ( ) in the Contextual Sidepanel.

2. On the Templates pane, select Undo.

A modal appears displaying changes to the form as a result of removing the template.
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3. Select Undo.

Make form templates available for multiple groups

Specify one or more groups that have access to the form template you created.

Before you begin
Role required: admin

Procedure

1. In the contextual side panel of a record, select the Templates icon ( ).

2. In the Templates pane, select the Create Templates icon ( ).

3. Select the Groups field, and enter the groups you want this form to be available to.

Configure a template value field

Select desired fields to create a form template in the Template section of a form.

Before you begin
Role required: user

About this task
Template value field selections sync with live updates.
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Procedure

1. Open a record.

2. In the Template section of the form, select the associated table.
For example, Incident.

3. In the Template field, select a field and a value for your template.

Note: 
The table you selected determines which template value fields are available.

4. Select Save.

Result
The template value fields are visible on the form in the Template section.

Example:
Selecting field template values.

1. In the Template section of the form, select the Incident  from the Table field.

2. In the Template field, select Description  and enter Test text. A description is added to the 
template.

3. Select Approval  from the Template field. A list displays with approval values.

4. Select Caller  from the Template field. A list displays to select a caller.

5. Select Active  from the Template field. The option appears to activate or deactivate the record.

6. Select Save.

Getting information related to the open record

Use related items to gather information about and to enter information into the open record.

Title

The items in the Related items menu behave like tabs. When you click one, the corresponding 
content appears in the form pane. Workspace underlines the item that's active in the form pane. 
What items appear in the menu, what order they're in, and which one opens automatically are 
configurable by your system administrator.

The items contain information related to the record open in the form pane. You click the different 
items to get contextual information. For example, if the open incident is about a failed service, 
you might click Impacted Services/CIs  to see if other services are also down. If the incident is a 
power outage, you might click Outages  to see if there are outages in other locations.
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The Details  item usually displays first by default. It is the only item that contains details of the 
open record. It also provides text fields that you can edit. For example, when you solve an 
issue, you should enter the resolution description in the section, Resolution notes. Your system 
administrator determines which fields from a record appear in the form pane.

Your configuration of workspace might include the following related items.

Related items

Item Description

Details Detailed information about the open record and text fields for you to enter 
information. The system administrator specifies the record fields that 
appear in the form pane. You use this item to read about the open record 
and to make entries in the record.

Task SLAs Service level agreements (SLAs) for a task. Expected deadlines for 
resolving a task of this type.

Affected CIs Configuration items (CIs) related to an incident. Often, an incident 
is related to one or more specific configuration items (CIs). If the 
configuration management database (CMDB) is populated, the CI 
records hold valuable information to help resolve incidents. You can 
associate configuration items to an incident to see how the incident affects 
dependent CIs.

Impacted 
Services/CIs

Services and configuration items (CIs) affected by this incident.

Child incidents Child incidents are incidents related to the parent incident, the incident 
open in record view. All work notes or comments in a parent incident are 
copied into a child incident. When a parent incident is resolved, the child 
incidents are resolved.

Outages Service outages related to the incident open in record view.

User's Calls The User’s Calls  related list displays historical calls between a requester 
and Service Desk  agents. This feature is available to the users who 
has the Service Desk  Call plugin (com.snc.service_desk_call) already 
activated.

Note: 
The customer name in the Opened for  field in Interaction 
is matched with the Caller  field in Service Desk  calls and 
records are retrieved based on the number of days mentioned 
in the interaction property Number of days (integer) for 
which past user call records are retrieved. The default 
value is seven (7). A setting of zero (0) disables this feature. 
(glide.new_call.interaction.records_age).

User's Task When a requester contacts an agent through chat, phone call, request, or 
walk-in, the User’s Task  related list shows the agent all of the other tasks 
(incident, problem, change request, request, and so on) that have been 
created for the requester. For example, if a requester calls about the status 
of a request that was made the previous day, the User’s Task  related list 
shows the request. Workspace includes the other tasks in the User’s Task 
related list when the value for the Opened for  field in the interaction record 
matches the:
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Related items  (continued)

Item Description

• Caller  field in an incident record

• Opened by  field in a problem record

• Requested by  field in a change record

• Requested for  field in a Service Catalog  record

Domain separation for Workspace  records

Workspace  supports standard domain separation. In a record, you can safely create another 
record in the correct domain, change the domain that the record associates with, and temporarily 
expand the domain scope of a record to a domain outside the record session.

Workspace  uses Cross-Tenant Intelligence to automatically handle the data, metadata, business 
logic, and processing context for tenants that have access to additional tenant data. Cross-
tenant intelligence enables the following behavior when you create a record.

• Records created from another record inherit the domain of the originating record.

• Records created with a UI action from a record carry over the domain of the originating record.

• Records created from a parent record, for example a related list, carry over the domain of the 
parent record.

For more information on Cross-Tenant Intelligence in Domain Separation, see What is Domain 
Separation? .

Toggle domain scope of a record

Expand the domain scope of a record temporarily to a domain outside the record session. The 
record expands to include related lists and reference field queries. This enables you to create a 
main record that applies to issues for more than one domain.

Before you begin
You must first have permission to access the domain that you want to toggle.

Role required: domain_expand_scope user role

Procedure

1. Navigate to All  > Workspace.

2. Select a record.

3. Click the overflow UI action icon ( ) in the record and select Toggle Domain Scope.
You can now access related lists and reference field queries.
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Note: 
Domain scope doesn't toggle when the record is in the global domain or when your 
domain and the record domain match.

4. Click the overflow UI action icon ( ) in the record and select Toggle Domain Scope  to return 
the domain scope to the domain associated with the record.

Create a record in a domain without a parent

Create a new record when the domain of the record is unknown and you have access to multiple 
domains.

Before you begin
Change a domain by modifying the selection of the caller or company on the form of the record.

Role required: user

Procedure

1. Navigate to All  > Workspace  > New record menu.

2. On the form, fill in the fields.

The company or caller selected associates the record with the corresponding domain.

Note: 
Data available for auto-population is limited to the domains you have access to.

3. Click Next.

Result
The new record includes data and rules specific to the domain.

Group and find records using tags in workspace

Add tags to records to group and organize them.

Before you begin
Role required: agent

About this task

Tags are labels you can add to records. The tag icon ( ) appears next to the primary value in 
the form header.

Tags enable you to group and organize records. You create the tag name, which should name the 
reason for the tag. You can make the tags visible to everyone, some people, or just yourself. The 
visibility setting specifies who can use the tags to search for records.
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An unfilled tag icon ( ) means that no tags have been assigned to the record. When tags are 

assigned and they're visible to you, the tag icon is filled ( ).

After tagging records, you can use the tags to search for records in the global search field  or 

using the filter icon ( ) in List view.

Procedure

1. Navigate to any open record in a workspace.

For example, click the list icon ( ), click a list filter, such as Open incidents, and click a 
record.

2. Click the Tag icon ( ) next to the primary value in the form header.

3. In Add Tag, enter a tag name.
The tag name should reveal the organization principal of the tag, for example, all records 
stemming from a particular incident.

4. Click Enter  to save the tag with the record.
You can add more tags.
The tag visibility setting defaults to private, which means the tag is only visible to the person 
who created the tag. So, only that person can use the tag to search for records labeled with 
that tag.

5. To change the visibility setting of the tag, click the tag and change the Viewable by  setting.

Option Description

Me
Tag is visible only to the person who created 
the tag. Only that person can use the tag to 
search for records. This setting is the default.

Groups and Users
Tag is visible to specific groups or users. You 
can specify the groups and users who can 
view this tag.

Everyone Tag is visible to everyone.
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Option Description

Note: 
This visibility setting is only available to 
an admin or tags_admin role.

A record can have multiple tags and each can have a different visibility setting.

6. Optional:  To remove a tag from a record, click a filled tag icon ( ) to open the list of tags, 
then click the X  next to the tag you want to remove.

7. Optional:  Search for your tag using the global search field.

Using the multi-record associator

Use the multi-record associator to add records to related lists.

The multi-record associator enables you to view and select records within tables and associate 
those records to a related list.

The multi-record associator supports one-to-many (o2m) and many-to-many (m2m) tables.

• An o2m table enables a parent record in a table to reference multiple child records.

• An m2m tables enables multiple records in a table to reference multiple records in another 
table.

For information on adding records to related lists using the multi-record associator, see Add 
records to related lists.
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Add records to related lists

Provide information related to an incident by adding records to related lists.

Before you begin
Role required: agent

About this task
If there’s an Add  button on your Related Items menu, you can add records to related lists. Add 
records to related lists when you find a record that's related to the record that’s open.

For example, the open record documents a power outage in one location. When there's a power 
outage in a second location, you can add that outage's record to the related list for the first 
record.

Note: 
Not all workspaces have the Add  button. It's added by your administrator.
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Procedure

1. Navigate to All  > Incident  > Open.

2. Select an incident to open it.

3. Choose a related list within the record and select Add.
The multi-record associator opens as a modal displaying a list of records.

4. In the multi-record associator, select the records that you want to add to the open incident.

◦ The record data is read-only.

◦ Filter the records in a related list by using the filter ( ) and the condition builder.

◦ Select multiple records at once by selecting the check box for each record.

◦ Select all records by selecting the check box in the row header.

◦ Records selected on one page remain selected as you move to other pages.

◦ Choose how many records to view on each page by selecting an option from the rows per 
page  menu.

5. Select Add Selected.

Result
The records you selected appear in the related list for the incident.

AI field recommendations

Use AI field recommendations for a list of top recommendations or to fill fields automatically in a 
Workspace  form.

AI predicts a field's value based on the data in the form. AI recommendations can appear in the 
following ways based on the field configuration:

• Recommendations can appear as a list, and you can select a value from the list of top 
recommendations.

• A top recommendation can auto-fill into the field.

The sparkle icon ( ) marks any field that provides AI recommendations.

Get information on the recommendation's prediction source by pointing your mouse device on 

the sparkle icon ( ).

Use Screen Summarization

Screen Summarization is a feature that supports visually impaired and low-vision users by 
providing AI-generated summaries of workspace pages and their sections. The summaries can 
be read aloud with a screen reader.

Before you begin
Install Screen Summarization by requesting it from the ServiceNow®  Store. Visit the 

ServiceNow®  Store  to view all the available apps and information about submitting requests to 
the store.

Role required: workspace_user
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Procedure

1. Open a workspace page in your instance.

2. Press Command+U (Mac) or Control+U (Windows) to open the Screen summarization modal.
The Screen Summarization modal opens.

3. Choose between the following actions:

◦ Press Option+P (Mac) or Alt+P (Windows) for an AI-generated summary of the entire page.

◦ Press Option+S (Mac) or Alt+S (Windows) for an AI-generated summary of the highlighted 
section.

Result
The Screen Summarization modal generates a summary and can read it aloud with a screen 
reader.

Hide journal fields on Workspace  forms

Disable journal fields on Workspace  forms so that work notes and comments only appear in the 
Activity Stream.

Before you begin
Hiding journal fields is not supported for new records. New records display journal input fields 
because Activity Stream doesn't display. 
Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Configuration Settings  > UX View Rules 
Configurations.

2. Select the Workspace Experience  that contains the record page with the work notes you want 
to hide.

3. Select a Workspace View Rule from the Workspace View Rules related list.

4. On the View Rule form, select the Form Settings  tab.

5. In the Form Settings tab, select Hide Journal Input Fields.

6. Select Update.

Search Activity stream

Search using keywords activity stream to find results in work notes, emails and comments more 
efficiently.

Before you begin
Role required: workspace_user
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Procedure

1. Select  in Activity stream.

2. Note: 
Keywords will only highlight in work notes, comments and emails. Activity stream entries 
that do not match the keyword criteria will filter out as you type. Keyword searches for 
attachments is also available, but will not highlight, attachments will instead be displayed 
in activity stream.

Search using keywords in the Search Activity Stream  search bar to find your 

results.

Filter activities with tags

Use tags to filter through the Activity stream.

Before you begin
Role required: workspace_user

About this task
Tags enable you to filter your activities in the Activity stream  by dynamic and static states not 
offered in filter lists.

Important: 
Tags are enabled and created by your system administrator. To enable and add tags 
for agents as a system administrator, see Create tags for the Activity stream  for more 
information.

Procedure

1. Open a Workspace  record in your instance.

2. In the Activity stream, select the filter icon ( ).

3. Select the Tags  list, and select tags related to activities you want to view.

Result
Activities with the tags you selected are displayed in the Activity stream.
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Expand all Activity stream tiles by default

Expand all tiles in the Activity stream  across cases and user sessions by default.

Before you begin
Role required: workspace_user

Procedure

1. Open your workspace.

2. Open the preferences for your workspace by selecting your profile image ( ) and 
Preferences  > Workspace.

3. Select the toggle for the Expand activity stream items by default  preference.

Result
All activities in your Activity stream  expand by default.
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Use AI filter assist

AI filter assist enables you to convert everyday language into an AI-generated encoded query.

Before you begin

Important: 
The AI filter assist feature is available with ServiceNow®  Pro Plus licensing. Discuss 
licensing with your ServiceNow®  account representative for information specific to your 
contract.

Role required: workspace_user

Procedure

1. Open a workspace list in your instance.

2. From the list header, select the filter button ( ).
A dialog box opens for generating filters.

3. Select one of the following options from the menu.

◦ Select Add to existing filters  to add additional conditions onto the filter that's currently 
applied.

◦ Select Edit existing filters  to refine the filter that's currently applied.

◦ Select Start new  to generate a new filter.

4. Create a query with everyday language using one of the following options.
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◦ Enter a query manually.

◦ Select the microphone icon ( ) and speak a query out loud.

5. Select the submit icon ( ) to generate the filters.
A dialog box opens to display the generated filters.

6. Review the generated filters and select one of the following options.

◦ Select the edit icon ( ) to make changes to the generated filters.

◦ Select Apply  to submit the filters.

7. Show the conditions panel by selecting the filter button drop-down arrow ( ) and 
Advanced Filter.

8. View a list of filters you generated recently by selecting the history icon ( ).

Use condition builder in reference lists

Use condition builder in reference lists to filter results.

Before you begin
Role required: workspace_user

Procedure

1. Select Search for Record  icon  in the record field.

2. Select 

3. Add the conditions you would like to filter your record search 

by.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

355



4. To add additional conditions, select + New condition set.

5. Select Run.

Use more form options

Select more form options to use additional functionality on your Workspace  form. You can export 
a form, reload a form, copy a URL or Sys ID, and show the form XML.

Before you begin

Role required: agent

Procedure

1. Select the menu icon ( ) on a form.

2. Select the form functionality you want from the More form options  menu.

◦ Toggle Annotations Off/On: Select to toggle form annotations.

◦ Reload form: Select to reload the form.

◦ Export: Select to export the form to a PDF or XML export type. Orient your PDF export to a 
portrait or landscape output.

◦ Copy URL: Select to copy the form URL to the clipboard.

◦ Copy sys_id: Select to copy the sys_id to the clipboard. This action is only available for 
admins.

◦ Show XML: Select to show the document tree of the form. This action is only available for 
admins.

◦ Personalize form: Select to personalize your form by adding or removing fields you wish to 
display.

3. Note: 
Right click actions are only available upon clicking the form header.
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To utilize right click actions in your workspace, right click the form header.
The jump to section navigation and more form options list appears.

4. You can also jump to a section by right clicking the header or using the More form options 
menu.

◦ Incident

◦ Notes

◦ Related Records

◦ Resolution Information

Use personalize form

Select personalize form to add or remove fields that appear on your form view according to your 
preferences.

Before you begin

Role required: agent

Procedure

1. Note: 
You can also utilize right click actions, and right click the form header to display More 
form options  list.

Select the menu icon ( ) on a form.

2. Select Personalize Form  from the More form options  list.
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3.

4. Select Update Form  to submit your changes.

Resize modals

Resize modals to view content without scrolling horizontally and vertically.

Before you begin
Role required: workspace_user

Procedure

1. Open a record in your instance.

2. Select the search icon ( ) within a field.

3. In the modal, point the mouse over the edges and corners of the modal.

A double arrow ( ) appears.

4. Use the double arrow to drag the edges and corners of the modal to a custom size.

Responding to issues in an open record in Workspace

Use the following sections to discover answers to the issues you're dealing with in an open 
record.

Depending on the issue at hand, you might be ordering a hardware component for a requester, 
issuing a server restart to solve an issue, or creating and assigning an incident record to remedy 
a software issue.
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When you use the landing page or list view to open a record, workspace provides a lot of 
information about the record. Here's how you might look at the different parts of workspace to 
understand and resolve an issue.

1. In the Form Header, read the record's short description, priority, status, and issue category.

2. In the Ribbon, read about the requester, how long the issue has been open, and what the SLA 
is in solving the issue.

3. In the Form pane, on the Details  tab, scroll through detailed information about the issue.

4. In the Related Items menu, click the tabs to see information related to the open record, such as 
related incidents. The information appears in the Form pane.

5. In the Contextual side panel, read the search results automatically pulled up by Agent assist 
that might help solve the issue.

6. In the Activity Stream, read about the history of actions you or other agents have taken in 
solving this issue.

7. In the Compose section of the Activity Stream pane, write a comment to the requester or make 
notes to yourself and other agents about your progress in resolving the issue.

Next

Now that you understand how to look through the parts of workspace to get contextual 
information about an issue, let's see how to find a solution.

Communicating via email in Workspace

Email requesters and agents while working on issues in Workspace.

With the Workspace  email client, you can email callers or fellow agents. There are two versions of 
the email client you can use.

Full email composer

The full email composer enables you to draft and send emails from a separate workspace tab.
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Mini email composer

The mini email composer enables you to draft and send emails directly from the record page.

Compose emails from the full email composer

Compose an email to send to requesters and agents within a separate workspace tab.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the full email composer by selecting the More actions icon ( ) from the record view, 
and then select Compose Email.
An email draft opens in a new workspace tab.
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3. If available, complete the Reply To  or From  field.

This field specifies who the recipient can reply to after receiving your email. You may choose to 
specify an entity apart from yourself. For example, the IT service desk.

4. In the To  field, add an email recipient.
You can also add Cc and Bcc recipients by selecting Cc/Bcc.

5. In the Subject  field, enter a subject line.

6. Optional:  Hide the email header including all recipient fields by selecting the chevron icon 

( ).

7. Create the email body.
You can insert a quick message in the email body. For more information, see Insert a quick 
message from the full email composer.

You can attach a file to the email. For more information, see Add a file to an email from the full 
email composer

8. Select Send.
Drafts save automatically after a set number of seconds. For more information on finding email 
drafts, see Review email drafts from the full email composer.

Result
You can find the sent email in the Emails list. For more information, see Review emails.

Use email templates in the full email composer

Quickly compose emails for common issues by selecting an email template in the Compose 
Email page instead of manually drafting an email.

Before you begin
Role required: email_composer
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Procedure

1. Open a Workspace  record in your instance.

2. Open the Compose Email page by selecting the More actions icon ( ) and Compose Email.

3. Apply an email template from the Agent Assist panel.

a. From the Agent Assist panel, select the Email Templates icon ( ).
A list of response templates opens in the Agent Assist panel.

Note: 
Find the email template you need by using the search bar in the Email Templates list.

b. Select an email template from the Email Templates panel.

c. Select the More actions icon ( ), and select Apply Template.

4. Apply an email template from the email footer.

a. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.
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b. Select the Email templates  tab.

c. Select an email template from the list.

Note: 
Find the email template you need by using the search bar in the Email templates tab.

A preview of the selected email template opens.

d. Add the template to your email by selecting Apply.

Use response templates in the full email composer

Insert common responses into your emails by using response templates in the Compose Email 
page instead of manually drafting a response.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the Compose Email page by selecting the More actions icon ( ) and Compose Email.

3. Apply a response template from the Agent Assist panel.

a. From the Agent Assist panel, select the Response Templates icon ( ).
A list of response templates opens in the Agent Assist panel.
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Note: 
Find the response template you need by using the search bar in the Response 
Templates list.

b. Copy a response template without viewing its full contents by selecting the More actions 

icon ( ) and selecting Copy to Clipboard.

c. Copy a response template after viewing its full contents by selecting a template from the list 
and selecting Copy to Clipboard.

d. Paste the response template into your email.

4. Apply a response template from the email footer.

a. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.
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b. Select the Response templates  tab.

c. Select a response template from the list.

Note: 
Find the response template you need by using the search bar in the Response 
templates tab.

d. Add the template to your email by selecting Insert.

5. Apply a response template with a keyboard shortcut.
For instructions on applying a response template with a keyboard shortcut, see Add response 
templates with a keyboard shortcut.

Insert a quick message from the full email composer

Insert predefined content into email messages from the full email composer.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the Compose Email page by selecting the More actions icon ( ) and Compose Email.

3. Apply a quick message from the Agent Assist panel.

a. From the Agent Assist panel, select the Quick Messages icon ( ).
A list of quick messages opens in the Agent Assist panel.
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Note: 
Find the quick messages you need by using the search bar in the Quick Messages list.

b. Add a quick message without viewing its full contents by selecting the Insert icon ( ).

c. Add a quick message after viewing its full contents by selecting a message from the list and 
selecting Insert.

4. Apply a quick message from the email footer.

a. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.
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b. Select the Quick messages  tab.

c. Select a quick message from the list.

Note: 
Find the quick message you need by using the search bar in the Quick messages tab.

d. Add the template to your email by selecting Insert.

Add a file to an email from the full email composer

Send a file from your computer or related record to a requester or agent from the full email 
composer by attaching it to an email.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the full email composer by selecting the More actions icon ( ) from the record view, 
and then select Compose Email.

3. Optional:  Attach a file from your computer.

a. Select the Attach file icon ( ) from email footer.

b. Select From computer.

c. Select a file from your computer.
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You can select multiple files at a time. The system uploads the files simultaneously.

(Optional) Alternatively, you can drag files from your computer onto Workspace. You can't 
attach a folder.

4. Optional:  Attach a file from the related record.

a. Select Attach file icon ( ) from the email footer.

b. Select From record.

c. On the window, select the files to attach.

d. Select Add.

What to do next
Optionally, you can hide or show attachments in your email drafts by selecting Hide attachments 
when not hidden and Show attachments  when hidden. You can also perform additional actions 

by selecting the menu icon ( ) next to each attached file:

• Download: Download the file to your computer.

• Rename: Rename the attached file. Only the first 100 characters of a file name are displayed.

• Remove: Remove the attachment from the email.

Review email drafts from the full email composer

View emails saved for later or create a new email while saving your current draft automatically 
from the full email composer.

Before you begin
Role required: workspace_user

Procedure

1. Open a Workspace  record in your instance.

2. Open the full email composer by selecting the More actions icon ( ) from the record view, 
and then select Compose Email.

3. Note: 
Instead of a button to save email drafts manually, drafts save automatically.

Access your drafts by selecting the drafts icon ( ) from the email footer.
A modal opens with a list of actions and email drafts.
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4. Select an action or recent draft.

◦ View all of your email drafts by selecting Manage drafts.

◦ Create a new draft while saving your current draft automatically by selecting Create new 
email.

5. Create a new draft while saving your current draft automatically by selecting Create new email.

6. Open a draft after previewing it.

a. Select a draft from the Email drafts list.
A preview of the draft opens.

b. Select Apply.

7. Open a draft from the Manage drafts modal.

a. Open the Manage drafts modal by selecting Manage drafts  from the menu.

b. Select a draft from the list.

8. Delete multiple drafts from the Manage drafts modal.

a. Open the Manage drafts modal by selecting Manage drafts  from the menu.

b. Select drafts from the list.

c. Select Delete.

Compose emails from the mini email composer

Send emails without leaving the record.

Before you begin
Role required: email_composer
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Procedure

1. Open a Workspace  record in your instance.

2. Select the Email  tab in Compose.
An email draft opens with the same functionality as creating an email from a new workspace 
tab.

3. If available, complete the Reply To  or From  field.

This field specifies who the recipient can reply to after receiving your email. You may choose to 
specify an entity apart from yourself. For example, the IT service desk.

4. In the To  field, add an email recipient.
You can also add Cc and Bcc recipients by selecting Cc/Bcc.

5. In the Subject  field, enter a subject line.

6. Optional:  Hide the email header including all recipient fields by selecting the chevron icon 

( ).

7. Create the email body.
You can insert an email template into the email body. For more information, see Use email 
templates in the mini email composer.

You can attach a file to the email. For more information, see Add a file to an email from the mini 
email composer.

8. Select Send.
Drafts save automatically after a set number of seconds. For more information on finding email 
drafts, see Review email drafts from the mini email composer.

Result
You can find the sent email in the Emails list. For more information, see Review emails.
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Use email templates in the mini email composer

Quickly compose emails for common issues by selecting an email template in the record view 
instead of manually drafting an email.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the mini email composer by selecting the Email  tab under the Compose panel.

3. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.

4. Select the Email templates  tab.

5. Select an email template from the list.

Note: 
Find the email template you need by using the search bar in the Email templates tab.

A preview of the selected email template opens.

6. Add the template to your email by selecting Apply.

Use response templates in the mini email composer

Insert common responses into your emails by using response templates in the mini email 
composer instead of manually drafting a response.

Before you begin
Role required: email_composer
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Procedure

1. Open a Workspace  record in your instance.

2. Open the mini email composer by selecting the Email  tab under the Compose panel.

3. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.

4. Select the Response templates  tab.

5. Select a response template from the list.

Note: 
Find the response template you need by using the search bar in the Response templates 
tab.

6. Add the template to your email by selecting Insert.

7. Apply a response template with a keyboard shortcut.
For instructions on applying a response template with a keyboard shortcut, see Add response 
templates with a keyboard shortcut.

Insert a quick message from the mini email composer

Insert predefined content into email messages from the mini email composer.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the mini email composer by selecting the Email  tab under the Compose panel.

3. From the email footer, select the Apply templates icon ( ).
A modal opens with different types of templates.
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4. Select the Quick messages  tab.

5. Select a quick message from the list.

Note: 
Find the quick message you need by using the search bar in the Quick messages tab.

6. Add the template to your email by selecting Insert.

Add a file to an email from the mini email composer

Send a file from your computer or related record to a requester or agent from the mini email 
composer by attaching it to an email.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open an email draft by selecting the Email  tab in Compose.

3. Optional:  Attach a file from your computer.

a. Select Attach file icon ( ).

b. Select From computer.

c. Select a file from your computer.
You can select multiple files at a time. The system uploads the files simultaneously.

(Optional) Alternatively, you can drag files from your computer onto Workspace. You can't 
attach a folder.
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4. Optional:  Attach a file from the related record.

a. Select the Attach file icon ( ) in the record.

b. Select From record.

c. On the window, select the files to attach.

d. Select Add.

What to do next
Optionally, you can hide or show attachments in your email drafts by selecting Hide attachments 
when not hidden and Show attachments  when hidden. You can also perform additional actions 

by selecting the menu icon ( ) next to each attached file:

• Download: Download the file to your computer.

• Rename: Rename the attached file. Only the first 100 characters of a file name are displayed.

• Remove: Remove the attachment from the email.

Review email drafts from the mini email composer

View emails saved for later or create a new email while saving your current draft automatically 
from the full email composer.

Before you begin
Role required: email_composer

Procedure

1. Open a Workspace  record in your instance.

2. Open the mini email composer by selecting the Email  tab under the Compose panel.

3. Note: 
Instead of a button to save email drafts manually, drafts save automatically.

Access your drafts by selecting the drafts icon ( ) from the email footer.
A modal opens with a list of actions and email drafts.
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4. Select an action or recent draft.

◦ View all of your email drafts by selecting Manage drafts.

◦ Create a new draft while saving your current draft automatically by selecting Create new 
email.

5. Create a new draft while saving your current draft automatically by selecting Create new email.

6. Open a draft after previewing it.

a. Select a draft from the Email drafts list.
A preview of the draft opens.

b. Select Apply.

7. Open a draft from the Manage drafts modal.

a. Open the Manage drafts modal by selecting Manage drafts  from the menu.

b. Select a draft from the list.

8. Delete multiple drafts from the Manage drafts modal.

a. Open the Manage drafts modal by selecting Manage drafts  from the menu.

b. Select drafts from the list.

c. Select Delete.

Edit and move email recipients

Edit and move recipients across the To, Cc, and Bcc email fields instead of manually removing 
and adding individual recipients.

Before you begin
Role required: email_composer
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Procedure

1. Open a record.

2. Select the Email  tab of the Compose panel in the record view, or open the Compose Email 
page.

3. Add recipients to the desired email fields by copying and pasting email addresses or entering 
recipients' email addresses manually.
Email recipients consist of individual pill icons ( ).

When you enter an invalid email address, an exclamation icon ( ) appears within the email 
address' pill and the Send email  button is inactive.

When you enter a blocked email address, a blocked icon ( ) appears within the email 
address' pill and the Send email  button is inactive.

4. Move a recipient to a different field by dragging the pill icon.

5. Right-select a recipient.
You can edit a recipient's email address by selecting Edit, copy and paste recipients with Copy 
and Cut, and remove recipients with Remove.

6. Optional:  To select multiple recipients, use keyboard and mouse device shortcuts.
For reference, see Keyboard and mouse device shortcuts for adding recipients to email fields.

Keyboard and mouse device shortcuts for adding email recipients

Add and remove recipients in the To, Cc, and Bcc email fields by using keyboard and mouse 
device shortcuts instead of adding individual recipients.

Keyboard shortcuts

• Move across recipients: Left  or Right

• Select multiple recipients: Shift + Left  or Shift + Right

• Select every recipient in a field: Cmd + A  (Mac) or Ctrl + A  (Windows)

Mouse device shortcuts

• Select multiple recipients: Cmd + Click  (Mac) or Ctrl + Click  (Windows)

• Select custom range of recipients: Click  first recipient in range and Shift + Click  last recipient 
in range

Add response templates with a keyboard shortcut

Use a keyboard shortcut to insert common responses into your emails with response templates.
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Before you begin
Role required: email_composer

Procedure

1. Open a record.

2. Open the mini email composer or the full email composer.

◦ Open the mini email composer by selecting the Email  tab under the Compose panel.

◦ Open the full email composer by selecting the More Actions  icon ( ) and Compose Email.

3. Enter /r  into the email body.
A list of response templates appears.

4. Enter a keyword after /r  to search for the response template you need.

5. Add a response template to your email by selecting it.

Review emails

Review emails that you’ve sent and received.

Before you begin
Create a Workspace  list for the Email [sys_email] table. For more information on creating 
Workspace  lists, see Create My Lists in workspace.

Role required: workspace_user

Procedure

1. Open the list view by selecting the list icon ( ).

2. Select My Lists, and open your emails list.

3. Find an email by filtering the list or sorting columns.
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For more information on using Workspace  lists, see Work with lists in workspace.

4. Open an email to review.

What to do next
You can reply to or forward the email by selecting Reply, Reply All, or Forward.

Note: 
If you reply, reply all, or forward from the Activity stream, selecting Compose Email  in 
the header causes different UI behavior. For more information, see Communicating with 
requesters and agents using Compose.

Communicating with requesters and agents using Compose

You use Compose to communicate with requesters and to enter comments about the work that 
you do on issues that only fellow agents can read.

Composing comments

After researching an issue, you might want to get more information from a requester, 
communicate a solution, or write an internal note to yourself or other agents to record your 
progress in solving an issue. To do that, you use the Compose  feature. How you enter comments 
or work notes depends on the configuration.

• If you use a single text field, you select Comments  or Work Notes, enter your comment in the 
text field, and select Post Comments.

Use the Comments  text field to communicate with external requesters. Use the Work Notes 
field to document your progress on an issue. Work notes are not sent to external requesters 
and are visible only to you and other internal personnel, such as fellow agents who might also 
work on the issue.

• In stacked view, where there are two text fields, enter text in the appropriate field and select 
Post Comments  or Post Work notes (Private).

You can view emails in the Activity Stream. The Email  tab appears in Compose  when you reply, 
reply all, or forward an email from an existing email in the Activity Stream.

If you configured Compose  to use the rich text editor, you can use the icons at the top of the field 
to stylize the text. With the rich text editor, you can paste an image directly into the text field.

When you post your comment in Compose, the comment moves into the Activity Stream, which 
preserves the entire communication history. Only emails that are user-generated appear, for 
example existing emails that you write or reply to.
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Other communications

In addition to sending comments to requesters, you can also:

• Use the attachment feature ( ) in the Contextual side panel, for example, to add a knowledge 
article to a comment.

• Select the links in some of the cards in Agent assist  that, for example, add a knowledge article 
to a comment.

Configuring Compose

You can configure Compose  to appear as a single text field or two text fields. You configure 

Compose  by selecting the configuration icon ( ).

You can also view Compose  and the Activity Stream side by side to enable you to write work 
notes and comments while scrolling the activity stream. The Compose UI displays next to the 
Activity Stream when column space is adjusted to accommodate the side by side UI. You can 

enable or disable this feature by selecting the configuration icon ( ) and then selecting Side by 
side. This option appears in the UI when column spacing is wide enough to support side by side 
(700 pixels or more). This feature may not be supported in older versions of Safari.

Writing Knowledge articles to share solutions

To share a solution you've found with the community of workspace users, you can create and 
publish a knowledge article. The Knowledge Management  Service Portal enables users to view 
knowledge base articles. It is available by default. For more information about creating, editing, 
and viewing articles, see Knowledge article authoring in Workspace .

Attach a file to a record

Attach a file to a Configurable Workspace  record. The Attachments panel provides a list of 
attached files.

Before you begin
Role required: none

Procedure

1. Open a Configurable Workspace  record in your instance.

2. Open the Attachments panel from the sidebar by selecting the Attachment icon ( ).

3. Select the Add file icon ( ) and open a file from your local computer.
You can also drag and drop the file into the Attachments panel.

4. In the Upload a file modal, review the file details.
You can edit the file name and add an encryption module to the attachment.

5. Select Upload.

Encrypt an attachment in a record

Secure sensitive files by encrypting the files as they are attached to Core UI  and Workspace 
records.

Before you begin
Role required: agent
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About this task
Encrypted attachments enable you to do the following:

• Choose which encryption context is to be used for file encryption when you have access to 
more than one context.

• View which encryption context is used after the file is attached to a record.

For more information on encryption, see Encryption .

Procedure

1. Log in as a user with at least one encryption context.

2. Navigate to a form that needs an attachment added, such as the Incident or Problem form, and 
click the attachment icon to open the Attachments dialog box.

3. Select the file to be attached.
If you have more that one encryption context, you will see an option to select a context to use.

4. Close the Attachments dialog box to upload the file attachment.
Attached files are listed across the top of the form. A special icon identifies encrypted files. 
Pointing to the icon shows the name of the encryption context. Note that you can see only 
encrypted files for which you have the encryption context.

Result
Only users with the same context used to encrypt the attachment can see the attachment in the 
Activity Formatter. Users without the appropriate context won't see the Activity Formatter entry 
associated with the encrypted attachment.

Send an article to a requester

Use Agent Assist  to send articles to requesters to solve their issues.

Before you begin
Role required: agent_workspace_user

About this task
Agent Assist  search results can include links to knowledge articles that you can send to a 
requester.

Procedure

1. Open a Workspace  record in your instance.

2. Open an incident record from the list view.

3. In the Agent Assist  panel, search for an article.

4. Select the menu icon ( )  > Add link in email.

Order a catalog item for a requester

Order a catalog item for a requester from Agent Assist  search results.

Before you begin
Role required: agent_workspace_user

Procedure

1. Open a Workspace  record in your instance.

2. Open an incident record in list view.
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3. In the Agent Assist  panel, select the Agent Assist icon ( ).

4. Select a catalog item, and select Order.

The form for the catalog item opens in a new tab.

5. Order the catalog item by completing and submitting the form.

Result
Ordering the catalog item creates a service catalog request.

Finding solutions by using Agent assist

Find the information that you need to resolve issues by using the Agent assist  search engine.

Agent assist  appears in the Contextual side panel by default and when you select the graduation 
cap icon ( ). It's possible for you to have icons for more than one Agent assist  search engines. 
If so, each one would search a different set of information sources.

When you open a record, Agent assist  automatically does a search based on a field in the open 
record. The field value used for the search term is configurable by your administrator but it's 
typically the value for the record's short description field.

The following example shows the search results for the short description "HDMI port is not 
working." The search results return as cards. In the following example, the card returned links 
to an article with the title "HDMI port is not working on my PC" and that was search was last 
updated 14 days ago. In the following example, you see two different colored graduation caps, 
which means that the Agent assist  search engines are available.
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The default number of search results is 10. If more than 10 results are displayed, that number 
appears as 10+.

Agent assist  is preconfigured to search the Incident, Problem, Change, Knowledge, and Case 
tables for solutions. Your administrator can configure Agent assist  to search the additional 
information sources, such as the service catalog.

You can use Agent assist  in the following ways to find solutions to the record that you opened:

• Select a card to go to the search result.

The search result might provide the answer you need, which you can then send to the 
requester by using the Compose editor in Activity stream.

• Enter a new search term in the search field next to the search icon ( ) to get different search 
results.

If the search results that automatically appear don't show relevant results, enter a new search 
term to get better search results.

• Filter the search results.

By default, Agent assist  returns the search results from all of its information sources. You may 
get too many results though. To see the search results from a subset of those information 

sources, select the configuration icon ( ) and then select an information source.
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• Send a solution to the requester by selecting a link in the card.

The following example shows the Link to Problem  link, that, when selected, adds the link to 
a similar problem in the Compose editor that you can then send to the requester. For more 
information, see Compose editor.

• If the card is an article, select it, then select the Attach  link to send the article to the requester.

For more information, see Send an article to a requester.

• If the card links to an item in the service catalog, select the card to order the item.

For more information, see Order a catalog item for a requester.

• Select a different Agent assist  icon and repeat the search.
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If you have more than one Agent assist  search engine in the Contextual side panel, each one 
searches through a different set of information resources. Your administrator configures the 
icon to click for additional Agent assist  search engines.

• If your administrator enables Search as  on your instance, you can change the search results 
by changing the field values in the form pane.

On the Details  tab, you may be able to replace the value for Caller, to change the search 
results that are based on that value. For example, if you create cases on behalf of a customer 
or employee, when you enter a customer's identity in the Caller  field in the form pane returns 
Agent assist  search results, fsuch as 401k information, that match the customer instead of you.

• Place a catalog order by selecting a catalog item that is shown on a card.

• Add a knowledge article to the Compose editor by selecting the Attach  icon ( ) in Agent 
assist.

No search term

Your administrator can configure Agent assist  to conduct a search without using a search term. 
The search result is all the records from a particular information source, such as employee 
records. You then can get the record of a particular employee by entering the employee's name 
in the search field.

About Playbook Experience

Interact with a business workflow in real time from within Workspace. Agents can use Playbook 
Experience  to update records, upload attachments, and complete tasks across multiple workflow 
activities.

Playbook Experience  overview

Playbooks are built by admins in Workflow Studio, customized by admins in UI Builder  and more, 
and embedded in Workspace, Configurable Workspace, Service Portal  and more. The Playbook 
Experience  for fulfillers during runtime provides visibility into cross-business workflows and the 
actionable tasks used to complete these business workflows.

• Playbooks may appear in the side panel or in the related items of records configured with 
playbook.

• Activities that you must perform to complete the business workflow are displayed. Some 
activities may be performed by an AI Agent instead. You're able to see what you of an AI Agent 
has done and what still must be done to complete the playbook. You can collapse activities to 
display relevant activities, and expand them again.

• Activities are typically performed sequentially. You can go back to those activities to complete 
them later. Complete an activity and go to the next activity, or complete the playbook.

Playbook UI
Playbooks contain helpful UI features.

Header

Shows the title of a Playbook. A header exists for each playbook attached to a 
record. Selecting a Playbook header expands the stages nested under it.

Stages

Click a stage title to view its activities. By default, all activity cards are collapsed 
except for the first card in a stage.
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The stage progress updates as activities are completed. A checkmark inside the 
playbook header indicates that the stage is complete.

Use the stage filter ( ) to filter a playbook.

Use the ellipses action menu icon ( ) to perform select actions at the playbook 
and stage level.

Activity cards
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Playbook activity cards display details about an activity, which may include the 
status, SLA timer, form data, and attachments. Use playbook activity cards to 
complete tasks by filling in forms, completing checklists, and adding attachments.

Add a playbook

Add a playbook to a record in agent workspace.

Before you begin
Role required: agent

About this task
A playbook can be added to a record with no playbook or a record with existing playbooks. The 
example below shows how a playbook can be added to a record using an Add Playbook  button.

Procedure

1. Open a record.

2. Select the Add Playbook  drop down

3. Select the playbook you would like to add to the record.

Result
The Playbook  tab displays when the playbook was successfully added.

Add an activity to a playbook

Add pre-selected optional activities to a playbook if available.

Before you begin
Role required: agent

About this task
Add and complete optional playbook activities in a running playbook. This example shows how 
an optional activity can be added to a playbook. Playbook admins must pre-configure optional 
activities. You cannot insert an optional activity as the first activity in a stage or between two 
finished activities. Some optional activities can be added to any stage while others can only 
be added to a single stage. If optional activities are not configured for a playbook, no optional 
activities will be available.

Procedure

1. Open a playbook in workspace.

2. Select the action menu icon ( ).

3. Select Add Activity.
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Note: 
Add Activity  will not display if no optional activities available in this stage.

4. Select + Add activity here  in the location you want to add the activity to the playbook.

5. Select the activity you would like to add to the playbook.
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6. Select Done.
The selected optional activity appears in your playbook.

Result
The selected optional activity appears in your playbook.

Cancel a playbook

Cancel a playbook to stop a business workflow when no longer valid.

Before you begin
Role required: agent or pd_cancel

If your playbook admin has added a cancel action to your playbook experience, you can typically 
find the cancel action under the playbook actions menu.

Note: 
Certain activities within a playbook cannot be canceled once they have started.

Procedure

1. Open a playbook in workspace.

2. Click the ellipses action menu icon ( ) in the playbook header.

3. Click Cancel Playbook.

4. Provide a reason for canceling the playbook.
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5. Click Cancel Playbook.
A canceled banner appears below the playbook header confirming that the playbook has 
been canceled.

Open full lists within playbook

Open a full list within playbook cards to view and update list items.

To open a full list within playbook, click the Open List  icon ( ).
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Card view

A new tab opens to show a full list.

Using activity stream within playbook

Use activity stream within playbook to add comments or notes, and view communication and 
task history for the parent or associated record.

Activities may contain a button, icon, or dropdown item to view a record’s activity stream.

Playbook activity stream examples

To open the activity stream within playbook, click the View activity  button or select View History 
from the dropdown list.

Activity stream button

Activity stream dropdown
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Activity stream modal

You can see tabs for comments and work notes related to a parent or associated record. You can 
use the Compose  text box to post new comments or work notes.

You can view previous activity by scrolling down to the Activity  section.

Global search in Workspace

Search across all cases, incidents, problems, knowledge articles, community questions, 
customers, users, and change requests to find answers.

Global search feature

Search results include all the items the search term appears in, for example, in the short 
description, content, or attached files. By default, global search results can include:

• Cases

• Customers or Users

• ServiceNow Community  Questions

• Incidents

• Change Requests

• Problems

• Knowledge Articles

To enter search terms, click the search icon ( ) and enter the search term in the search field.
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Search results appear in a separate tab. Links lead to a record or a list of records.

Searching for a customer or user

You can search for a requester by name, for example, Beth:

Global search results show the number of search results by category:

Clicking Users  shows the search results for users that have the name Beth:
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Searching for a case or incident

You can use case or incident numbers to search for specific cases or incidents. Or, you can 
search using other values related to the cases or incidents. In the previous example, if you click 
Incidents, Workspace  displays all the incidents that have the name Beth  in one or more record 
fields.

Managing teams and schedules in your workspace

Use Workforce Optimization  to optimize your workforce and manage your teams efficiently. 
Coach your teams so that they gain the skills that let you address the demands from your 
customers. Efficiently schedule your teams to provide better coverage with integrated channel 
management.

As a manager, you can monitor the demand for agents and skills in your organization to resolve 
issues. Assess agent skills, identify areas where they need improvement and provide training to 
enhance their skills set. Track your teams performance, and manage the schedule of all agents in 
your assignment group—all from a unified location.

As an agent, you can manage your own schedule, access the schedule of your peers and 
request time off or shift swaps.

Workforce Optimization  Overview

Get an overview of how you can set up Workforce Optimization for ITSM  in this video.

Workforce Optimization for ITSM  Setup

Get an overview of how managers can monitor the status of incidents and the KPIs for 
organizational performance in this video.

Workforce Optimization for ITSM  landing page
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Channel Management

Monitor your teams in real time and jump in to help when there is a need.

Using this application, you can also:

• Route work to specific groups based on agent skills

• Review real-time performance as the team is actively working on tasks across channels

• Monitor pending work items in a queue

Scheduling

Access your teams' calendar to know which agents are scheduled for coverage and which 
agents have taken time-off.

Using the application, you can also:

• Assign agents to shifts

• Define break time

• Preview and publish team schedule

• Approve agent time-off or shift-swap requests

Teams

Monitor performance trends for your teams using KPI groups. Create a set of KPIs and apply 
them to all groups within a team and assess team performance from one location.

Using the application, you can also:

• Identify all the teams you manage as well as the ones you have visibility into

• Analyze KPIs that are crucial for your team

• Drill into agents within each team and monitor their performance

• Access each agent's profile to view details such as their manager, peers, and assignment 
groups

• Drill down into each agent's skills or recommend them for coaching

Coaching and Skills Assessment

Enhance the quality of work done by your agents using Coaching. Use Predictive Intelligence 
to recommend skills based on issues the agents have resolved. Create coaching opportunities 
based on the recommendation and train the agents to acquire those skills.

Using this application, you can also:

• Automate the scoring, grading, and assessment of agent skills

• Use coaching opportunities to create assessments

• Track training assigned to agents based on their assessments

• Analyze skill gap and recommend training
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Global Search in Workforce Optimization for ITSM

Important: 
This feature is available with the Workforce Optimization  Content Pack for ITSM 
(sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce 
Optimization for ITSM Reference .

As an agent or a manager, you can perform a search for users, groups, shifts, schedules, or tasks 

using the search icon  in Workforce Optimization for ITSM  to easily find the information you 
need.

Note: 
To search shifts and schedules, you must generate the text index  for the following tables 
before you start performing the search for shifts and schedules:

• Schedule [sn_shift_planning_schedule_plan]

• Shift Plan [sn_shift_planning_shift_plan]

Platform Analytics  in your Workspace

Distribute and consume Platform Analytics  through data visualizations and dashboards with 
optional filters. Explore KPIs and receive insights into significant events in the data.

Within the Platform Analytics Workspace, you’re able to:

• Ask a natural language question and be shown the relevant analytics in a visualization.

• View any Next Experience dashboard that you own or has been shared with you.

• Create dashboards and data visualizations from your workspace runtime.

• Drill down into your KPIs, applying filters to slice your data and applying aggregations and 
statistical tools.

For more information, see Performance Analytics and Reporting for Workspace

Configurable Workspace  reference

Find additional details and support about creating, customizing, and using your Configurable 
Workspace.

Get help with Configurable Workspace

To get help with Configurable Workspace, your ServiceNow  instance, plugins, 
permissions, and more, watch a short video to contact the ServiceNow  admin who 
works in your company.

Configurable Workspace glossary

Learn about the terms and concepts used in Configurable Workspace.

Get help with Configurable Workspace

To get help with Configurable Workspace, your ServiceNow  instance, plugins, permissions, and 
more, watch a short video to contact the ServiceNow  admin who works in your company.

Get help now from your Now Support  administrator

The ServiceNow  admin in your company can help you with things like activating plugins, kicking 
off upgrades, unlocking accounts, updating user permissions, and much more.
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Digital Portfolio Management Workspace

Manage and maintain all your solutions (services, service offerings, business 
applications, and application services) from a single location using the ServiceNow 
Digital Portfolio Management (DPM) Workspace. DPM pulls in data from across the 
ServiceNow platform so you see impacts in the context of solutions that you own or 
care about.

DEX Application & Device Health

DEX Application & Device Health is a centralized workspace, dedicated to 
monitoring the performance, security, and compliance of the digital workplace.

Enterprise Architecture Workspace

The Enterprise Architecture Workspace is part of the Application Portfolio 
Management (APM) application. The workspace is a unified interface with multiple 
views that help you manage your portfolio efficiently. You can use these views to 
stay up to date with your tasks, insights, tasks that need attention, portfolio health, 
and dashboards.

Platform Analytics Workspace

Platform Analytics Workspace provides an Analytics Center for managing all Next 
Experience analytics.

Resource Management Workspace

Resource Management Workspace helps Resource Managers have a centralized 
view of all work across all resources.

Service Operations Workspace for ITSM

Service Operations Workspace is a configurable workspace that provides a unified 
experience for multiple IT Service Management and IT Operations Management 
workflows. Configure your agent experience using the easy-to-navigate interface of 
Service Operations Workspace for ITSM.

Service Operations Workspace for ITOM

Service Operations Workspace is a configurable workspace that provides a unified 
experience for multiple IT Operations Management workflows. Configure your 
experience using the easy-to-navigate interface of Service Operations Workspace.

Vendor Management Workspace

Monitor the performance of your company's vendors and manage all vendor-related 
information using the Vendor Management Workspace. Assess the performance 
of your vendors using key performance indicators (KPIs) that you can configure to 
create vendor metrics.

Workforce Optimization for ITSM

Manage and maintain the productivity of your workforce from a single location using 
Workforce Optimization for ITSM. Using this application, you can efficiently manage 
your team's skills and schedules, route work assignments to your team, and monitor 
their performance.

Configurable Workspace  glossary

Learn about the terms and concepts used in Configurable Workspace.

Activity Stream

Component that shows the list of changes made to a record, including journal entries, 
emails, and attachments.
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Activity Stream Compose

Component that enables agents to create new journal entries for the Activity Stream.

Attachments

Component that appears in the contextual sidebar and enables agents to add, preview, 
download, or remove attachments from a related record.

Agent chat

Component that provides a way for agents to chat with customers. Agents can send and 
receive messages, documents, and image files.

Contextual sidebar

A column of content that relates to the main content of the page. For example, you 
can include the agent assist component to show possible solutions for a case in view. 
Components are stacked vertically as tabs.

declarative actions

Declarative actions add custom functionality to your workspace forms, fields, lists, and 
related lists without writing custom scripts or learning APIs. Declarative actions include 
form actions, list actions, related list actions, and field decorators.

form action layout group

A combination of multiple actions into a split or menu button.

form action layout item

A record that defines the look and feel of an action button.

form header

Displays the title of the form and provides several controls.

form record presence

Displays the avatars of users viewing the same record.

full email composer

The Email Composer component associated with a record that enables an agent to 
compose emails and communicate with customers within a separate workspace tab.

landing page

Page that appears when an agent opens their workspace that provides an overview of new, 
assigned, and high priority cases in addition to the cases assigned to their groups.

mini email composer

The Email Composer (mini) component that enables agents to compose emails and 
communicate with customers within the record page instead of a separate workspace tab.

Predicate Builder

Component that enables you to visually assemble condition statements with a series of 
contextually-generated fields.

Record List

Component bundle that contains the components necessary to display a list of Glide 
records, including the header, list, and pagination.
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ribbon

Ribbons provide contextual information about the record displayed in the form, allowing 
users to quickly scan relevant information about the record.

Working in Core UI
Learn about the features of the Core UI  that predated Next Experience.

Core UI

The Core UI  predates the Next Experience  UI.

This video covers the user menu, help, global search, connect chat, system settings for logged-in 
user, and banner logo and text.

Watch the video above to learn about the elements of the Core UI.

Notable features include real-time form updates, user presence, a pinned application navigator 
with tabs for favorites and history, and activity streams.

Core UI

Core UI  components

Component Description

Banner 
frame

Runs across the top of every page and contains a logo and the following 
information, controls, and tools.

• User menu provides options to access your profile and preferences. 
Administrators can impersonate users and elevate their security role.

• Connect sidebar icon  ( ): Lets you begin or continue conversations. This 
icon is available if Connect is enabled.

• Global text search  icon ( ): Finds records from multiple tables.
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Core UI  components  (continued)

Component Description

• Help icon ( ): Opens the help panel with embedded help, where available. If 
there is no embedded help, it offers help search options.

• Gear icon ( ): Opens the System settings for the Core UI.

Application 
navigator

Also called the left-navigation bar. Provides links to all applications and modules. 
See Core UI application navigator.

Content 
frame

Displays information such as lists, forms, dashboards, and wizards.

The Edge The Edge is removed in Core UI. The collapsed view of the Core UI application 
navigator is similar to the Edge.

Related topics

Configure logo, colors, and system defaults for Core UI

Activate Core UI

Core UI  can be activated with the Core UI  plugin (com.glide.ui.ui16) if you have the admin role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Core UI  application navigator

The Core UI  application navigator appears at the left of the interface and provides access to all 
available applications and modules, favorites, and recently viewed items.

Use the application navigator to quickly find information and services.

The application navigator consists of a navigation filter and the following tabs.
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Core UI  application navigator tabs

Tab Description

All 
applications

Displays all application menus and modules. Each application appears as a 
section in the application navigator denoted by an application label. The tab lists 
modules by name under each application label.

All applications tab

Favorites Displays items you have added as favorites.

Favorites tab

History Displays items you have recently accessed.
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Core UI  application navigator tabs  (continued)

Tab Description

History tab

Enter text in the navigation filter to show matching applications, modules, and favorites. Matching 
favorites appear at the top of the results. You can also use the navigation filter to quickly access a 
specific table. For more information, see Navigate directly to a table.

Use the Core UI  navigator

Everyone can collapse and expand the navigator, work with favorites, and view navigation history 
in Core UI.

Before you begin
Role required: admin

About this task
Complete any of the following tasks to work with the navigator in Core UI.

Collapse or expand information in the Core UI  application navigator

You can collapse or expand information in the application navigator to display only what you 
want to see.

Before you begin
Role required: none

Procedure

Perform one of the following actions.

Option Description

Collapse or expand an application or applica­
tion section

Click the application or application section la­
bel.
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Option Description

Collapse or expand all applications Double-click the all applications tab icon ( ).

Collapse or expand the application navigator

Click the arrow icon at the bottom of the ap­
plication navigator. In the collapsed view, the 
application navigator displays favorites only. 
Click the filter icon or the arrow icon in the col­
lapsed view to expand the application naviga­
tor.

Collapsed navigator

Add or edit favorites in Core UI

You can add, edit, or delete favorites for frequently accessed items in the application navigator.

Before you begin
Role required: none

About this task
Items you add as favorites appear in the favorites tab of the application navigator, represented by 
a star icon.

Favorites also appear in the collapsed view of the application navigator as icons.
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Procedure

1. Add a favorite in one of the following ways.

Option Description

Add a module as a favorite
In the application navigator, click the star icon 
by a module.

Add all the modules under an application as 
favorites

In the application navigator, click the star icon 
by an application.

Add a list as a favorite using the list context 
menu

a. Open a list.

b. Click the list context menu icon ( ) by the 
list title.

c. Select Create Favorite.

d. In the flyout, edit the name and icon as 
needed.

Add a list as a favorite by dragging and drop­
ping

a. Open a list.

b. Drag a breadcrumb to the Favorites  tab of 
the application navigator.

Add a record as a favorite using the form 
context menu

a. Open a record.

b. Click the form context menu icon ( ) by 
the form title.

c. Select Create Favorite.

d. In the flyout, edit the name and icon as 
needed.

Add a record as a favorite by dragging and 
dropping

a. Open a record.

b. Drag the record title to the Favorites  tab of 
the application navigator.

Add a different type of link as a favorite

Drag a supported link type to the Favorites 
tab of the application navigator. You can drag 
any of the following links:

◦ Breadcrumbs

◦ Links in lists

◦ Reports

Note: 
You may not be able to create book­
marks with other types of links.

Add a knowledge base article as a favorite
a. Open a knowledge article.

b. In the header at the top left, click the star 
icon.
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Option Description

c. In the Create Favorite  dialog box, edit the 
name and icon as needed.

d. Click Done.

You can add a different favorite for each view of a list or form.
The favorite is added to the Favorites  tab of the application navigator.

2. To edit or delete a favorite, complete any of the following actions.

Option Description

Reorder favorites in the list

a. At the bottom of the application navigator, 
click Edit Favorites.

b. Drag a favorite to a new location in the list.

c. Click Done  or Edit Favorites.

Customize the name or icon for a favorite

a. At the bottom of the application navigator, 
click Edit Favorites.

b. Click a favorite.

c. Customize the name and icon as needed.

d. Click Done  or Edit Favorites.

Delete a favorite
a. Point to the favorite.

b. Click the remove favorite icon ( ).

View your navigation history in Core UI

In Core UI, you can view your navigation history in the application navigator.

Before you begin
Role required: none

About this task
Items you have accessed recently appear in the history tab of the application navigator, which 
is represented by a clock icon. Items appear in chronological order from most to least recently 
accessed.
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History tab

History entries are stored in the Navigator History [sys_ui_navigator_history] table. The system 
creates history entries for many types of content, including lists, records, and dashboards. Some 
content types are not tracked in the history, such as UI pages and other non-standard interfaces.

Procedure

1. In the application navigator, click the history tab, which is represented by a clock.

2. Click an item to open it.

Configure the number of history entries displayed in the application navigator

A system property sets the maximum number of history entries displayed in the history tab of the 
application navigator.

Before you begin
Role required: admin

About this task
By default, the application navigator shows 30 history entries. You can configure the 
glide.ui.nav.history_length  property to change this value.

Procedure

1. Navigate to sys_properties.list.

2. Locate the glide.ui.nav.history_length  property.

3. Edit the property Value.

System settings for the Core UI

You can define system settings to customize the Core UI  for yourself. The gear icon, located 
within the banner frame, displays the system settings window.

The system settings are organized by tab.
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Note: 
This information is applicable to the Core UI. For information about adjusting system 
settings with Next Experience  enabled, see Next Experience preferences.

System settings

Control Description

General tab

Accessibility 
enabled

More advanced accessibility features are activated when this setting is enabled. 
The platform is designed to be accessible by default. Enabling this feature 
makes more accessibility features available.

Accessible 
tooltips on 
forms

Displays a help icon next to each field that has a tooltip. This user preference 
can be enabled only if Accessibility is also enabled.

Data 
visualization 
patterns 
enabled

Adds pattern as well as colors to any color-based graphs or diagrams.

Compact 
the user 
interface

The UI is optimized to display more information in the browser window when this 
setting is enabled.

Compact list 
date/time

Date and time values appear in a compact format when this setting is enabled. 
The year isn’t shown for date values within the current year, and seconds are not 
shown for time values. This setting isn’t available if the Date/Time  selection is 
Time Ago.

Keyboard 
shortcuts 
enabled

Determines whether a user can access parts of the platform using keyboard 
shortcuts. For more information on available keyboard shortcuts, see Core UI 
keyboard shortcuts.

Home Determines whether the Home module opens Homepages  or Dashboards.

Important: 

The functionality found in homepages, arranging information from your 
instance to tell a story about your data, is found in dashboards on new 
instances. On upgraded instances with Next Experience  enabled, users 
can view existing homepages if they have a direct URL, but they can't 
create or edit them. Responsive dashboards and Analytics Center 
dashboards take over homepage functionality.

Use the Homepage deprecation help tool  to convert the homepages on 
your instance to responsive dashboards.

For more information, see:

• Dashboards in the Analytics Center .

• Working with responsive dashboards .

Date/Time The format in which dates and times appear depends on this setting. Select 
Calendar  (for example, 2015-11-13, 15:58:58), Time Ago  (for example, 11 minutes 
ago), or Both.
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System settings  (continued)

Control Description

Language Select a language or return to the default language ( ). This setting is available 
if a language plugin has been activated. For more information, see Activate a 
language .

Time zone Select a time zone or return to the default time zone ( ) for the current session. 
Upon the next login, the time zone setting reverts to the system default, or user 
profile setting for time zone.

Domain Specifies the currently selected domain for organizations that are using domain 
separation. The user must have the domain_admin or admin role to see this 
setting.

Show 
domain 
picker in 
header

Places a domain picker in the banner frame, next to the user menu, when this 
setting is enabled.

Printer 
friendly 

version ( )

Opens a printer friendly version of the current content frame.

Theme tab

Theme Select a theme for the user interface. Select the System  theme to return to the 
default theme.

Lists tab

Wrap longer 
text in list 
columns

Long strings wrap in list columns instead of appearing as one long line when this 
setting is enabled.

Forms tab

Tabbed 
forms

Form sections and related lists appear in tabs when this setting is enabled.

Related list 
loading

Determines when related lists load on forms. For more information, see 
Configure when a related list loads.

Notifications tab

Search Search bar for finding notifications.

To find a notification:

• Enter the name of the notification you are searching for. When you type the 
first three characters, the system automatically returns a list of notifications 
matching the characters entered.

• Enter two asterisks to return a list of all notifications in alphabetic order (the 
notifications are not organized by category).

Allow 
notifications

Global switch for enabling or disabling all notifications.

Notification 
channels

List of your channels for receiving notifications. Use this section to:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

408

https://www.servicenow.com/docs/access?context=t_ActivateALanguage&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ActivateALanguage&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ActivateALanguage&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ActivateALanguage&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


System settings  (continued)

Control Description

• Enable or disable a channel by using its toggle switch. If you disable a 
channel, notifications are not delivered through that channel.

• Add channels  using the Create Channel  option.

• Modify channel information . Click the channel row or the right arrow (>) next 
to the appropriate channel to edit or delete it.

Notifications 
by category

List of notification categories that identify and group related notifications. Each 
category contains the notifications that you can subscribe to.

To view the notifications in a given category, click the category row or the right 
arrow (>) next to the appropriate category. You can:

• Edit settings for a notification:

◦ Enable or disable channels for the selected notification.

◦ Apply notification conditions , such as schedules and filters, that affect the 
delivery of the notification.

• Create personal notifications , which are subscriptions to specific 
notifications that matter to you.

Developer tab

Application (Administrators only) Provides a link to the application picker, the Applications 

list ( ), and the currently selected application ( ).

Show 
application 
picker in 
header

Places an application picker in the banner frame, next to the user menu, when 
this setting is enabled.

Update Set (Administrators only) Provides a link to the update sets list, the update set picker, 
and the currently selected update set.

Show 
update set 
picker in 
header

Places the update set picker in the banner frame, next to the user menu, when 
this setting is enabled.

JavaScript 
Log and 
Field 
Watcher

(Administrators only) Opens the client-side JavaScript debug window .

Automated 
Test 
Framework 
Page 
Inspector

Places the inspect icon in the banner frame when this setting is enabled. 
Enables page developers and test designers to identify page components on 
customized user interfaces available for custom UI testing in the Automated Test 
Framework.
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System Settings window, General tab

Working in the classic environment

In the classic environment, use lists and forms to get your work done.

Note: 
This content pertains to the classic environment, which refers to working in lists of records 
and on record forms directly, not in the Configurable Workspace interface. You can work in 
the classic environment with Next Experience  active, or with it inactive, which is referred to 
as Core UI  (formerly known as UI16).

Lists in the classic environment

A list displays a set of records from a table.

Note: 
This content pertains to the Classic Environment, which refers to working in lists of records 
and on record forms directly, not in the Configurable Workspace interface. You can work in 
the Classic Environment with Next Experience active, or with it inactive, which is referred to 
as Core UI, (formerly known as UI16).

Users can search, sort, filter, and edit data in lists. Lists may be embedded in forms and may be 
hierarchical (have sublists).

The list interface consists of a title bar, filters and breadcrumbs, columns of data, and a footer. 
Each column in a list corresponds to a field on the table.

A Response time indicator  ( ) may appear at the bottom right of some lists to indicate the 
processing time required to display the list.
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Record list

List features and actions

The list interface consists of a title bar, filters and breadcrumbs, and columns of data. Each of 
these components provides features and lets you act on the list and the displayed records.

Features, menus, and actions

Hierarchical lists

Hierarchical lists allow users to view records from related lists directly without navigating to a 
form.

Lists can have sublists in a hierarchy that can also be accessed in list view. To expand or 
collapse the related lists on a record in a hierarchical list, click the arrow ( ) beside the reference 
icon.

Hierarchical list
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Administrators can enable hierarchical lists for a table. For more information, see Enable a 
hierarchical list  .

Detail rows

Detail rows, when enabled, appear below the field row for each record and display the value of a 
specified field. For example, the detail row might display the short description for each incident 
in a list. Detail rows support the same functionality as fields, including links, editing capabilities, 
and access to the context menu.

Note: 
When a field is designated as the source for the list detail rows, the system hides the list 
column for that field.

Detail rows

Administrators can enable detail rows and add them to lists. For more information, see 
Administer detail rows .

List fields

Fields display data and provide certain functions.

Note: 
Some of the options displayed in the field context menu depend on the user role and the 
installed features.

Field functions

Title Description

Links Open the associated record in form view. Click the first column field to open the 
current record. You can also click a link to a related record in other columns to go to 
that record.

Editing Changes the information in one or more records. For more information, see 
Methods for list edits.

Reference 

icon ( )

Provides a preview of the record.

Click the icon to open a preview of the record. To open or edit the record, click the 
Open Record  button in the record preview.

Pressing shift and pointing to the reference icon only displays the tool tip for the 
reference icon.

Context 
menu Also called a right-click menu, offers several options, including:
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Field functions  (continued)

Title Description

• Quick filter  options, such as Show Matching  and Filter Out.

• The option to copy the record URL to the clipboard.

• The option to copy the sys_id of the record to the clipboard (administrators only).

• Quick edit  options, such as Assign to me, Approve, and Reject.

• The option to edit the record tags, which provide quick access to frequently 
referenced or urgent information. When a tag is assigned to a record, the record 
is displayed on the Tagged Documents page.

• Options specific to features such as Live Feed  and Visual Task Boards.

Configure and use list functions

All users can interact with lists for the tables their role permits them to access. Some list and 
column header menu options are controlled by permissions grated to the user role.

Before you begin
Role required: admin

About this task
The following procedures describe functions that users can configure or use with lists.

Sort a list

You can quickly find information in a list by sorting the list. The method that the system uses to 
sort a list depends on the type of record in the sort column.

Before you begin
Role required: none

About this task
Consider the example record: Label=Requested Item; Value=sc_req_item. Field types other 
than choice list types are sorted based on the label. The example record label, Requested Item, 
would be sorted with records whose labels start with "r."

A choice list field lets the user select from a pre-defined set of choices. Choice list fields are 
sorted by the underlying dictionary entry value of the field, not by the label. The example record 
value, sc_req_item  would be sorted with records whose values start with "s."

Sorting by value can be useful. For example, choices for the State  of tasks are ordered New 
> Work in Progress  > Closed. Based on the label, the sort would be Closed  > New  > Work in 
Progress.

An arrow next to the column name indicates the current sort order. A downward pointing arrow 
indicates that the column is sorted in descending order. Only the primary sort order is indicated.

Note: 
The following sorting rules apply to lists:

• In a translated instance, only translated_text, translated_field, and translated_html type 
columns support sorting.

• The column label should be created in English first then translated accordingly.

• You cannot sort a list by an array-based field, such as a Glide list.
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To sort a list, use one of the following methods:

Procedure

• Click a column name to sort the list in ascending order.
Click again to sort in reverse order.

• Right-click a column name and select Sort (a to z)  or Sort (z to a)  to sort in ascending or 
descending order, respectively.

• Specify a sort order with a filter.
Filters provide for sorting by more than one column (for example, by Category and then 
Subcategory).

Related topics

Choice lists

Integer values for default choice lists

Configure field status indicators

You can enable or disable modern cell coloring for list field status indicators. This setting is 
available when you personalize a list. This setting is available in your system settings.

Before you begin
Role required: none

About this task
Field status indicators on lists are displayed with modern cell coloring, as a colored circle on the 
left side of the field. You can select the style of the field status indicator. You can revert to using a 
field background color by disabling modern cell coloring.

Modern cell coloring on

Procedure

The process depends on the version.

a. Click the personalize list icon ( ) in the list.

b. Select the Modern cell coloring  check box to use the style field status indicator.

c. Click OK.

For more information, see Creating Personal Lists.

Customize the number of list rows per page

You can customize the number of records, or rows, to display on each page of a list. The default is 
20 rows per page.

Before you begin
Role required: none

About this task
When you customize the number of rows, it applies to all lists that you can access.
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Procedure

1. Open a list.

2. Right-click the list title and select Show  > <Number> rows per page.
The list refreshes to display the number of records selected, or, if there are fewer than the 
number of rows you are displaying, the total number of records. The page control is updated to 
show your selected number of records ( ).

Switch between list views

A view defines the elements that appear when a user opens a list.

Before you begin
Role required: none

About this task
You can switch between list views to which you have access.

Procedure

1. Open the list.

2. Open the list title menu and select View  > (view name).
The page refreshes with in the selected view.

Speed up loading large lists

Remove the calculation of the total number of records in a list to speed up loading lists.

Before you begin
Role required: admin

About this task
Calculating the total number of records to be included in a list filtered from extremely large tables 
can take a long time.

To improve performance, you can remove that calculation for all or specified views.

Procedure

1. On a list, click the menu icon ( ) and navigate to Configure  > List Control.

2. On the List Control page, select a check box:

◦ Remove pagination count—Removes pagination calculation from all views.

◦ Remove pagination count for specified views—Removes pagination calculation from 
specified views.

3. Optional:  If you selected Remove pagination count for specified views, click the lock icon 

( ) and select the views that suppress displaying the number of pages in the list.

4. Verify that the pagination is not calculated for your view by switching to that view.

On a list, click the menu icon ( ) and navigate to View  > <a view>.

The pagination calculation should not appear and the fast forward icon ( ) should be grayed 
out.

Perform actions on selected items in a list

Action check boxes enable you to perform actions on one or more items in a list.
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Before you begin
Role required: admin

About this task

Procedure

1. Select the check boxes beside the records you want to affect.
To select all records on the page, select the check box at the top of the list.

2. Apply the desired action.

◦ In the column context menu, select Update Selected  to update all the selected records.

◦ In the Action on selected rows menu, select an action such as Delete  (administrators only), 
or Add to Visual Task Board. The available actions vary depending on the list and which 
plugins are activated.

Embedded lists

Some lists may be embedded in forms. Use list controls to work with records in an embedded list 
within a form.

Use these controls to work with an embedded list. For more information, see Edit a form.

Working with embedded lists

Task Icon Action

Expand an 
embedded 
list

Click the expand icon in the list 
header.

Collapse 
an 
embedded 
list

Click the collapse icon in the list 
header.

Insert a 
new row

Select Add  and identify the record 
you want to add to the embedded 
list.

Edit a row Double-click in an empty area of 
that field. See Use the list editor.

Delete a 
row

Click the delete icon beside 
the row. New rows are removed 
immediately. Existing rows are 
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Working with embedded lists  (continued)

Task Icon Action

designated for deletion when 
the record is saved. To clear this 
designation, click the delete icon 
again.

Embedded list

Activity streams in list view

Stream live activity information for all records on the current list.

To view the activity stream information, click the list activity stream icon ( ) in the list title bar. 
This icon appears in the title bar for all task tables.

The activity stream information appears in a flyout window, and is the same information that 
appears in the activity formatter  for a record. The short description appears as the title for the 
entry. Activity stream items on the task table use the task number as the title. The information in 
the flyout window updates automatically with audit and journal entries. Click the >>  icon at the 
top to close the activity stream.

You can add a comment to any item in the activity stream. When you point to the item with your 
cursor, a Comment  button appears.
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You can click an item to open the activity stream for that record. The record activity stream lets 
you open the task record, post additional comments or work notes, or preview images. Click the < 
icon at the top to close the record activity screen.

Note: 
The activity stream window is not the same interface as the activity formatter which appears 
on forms. Modifications and property settings user to change the behavior on the activity 
formatter are not applied to the activity stream window.

Search a list

You can search a list to find information quickly. The list title bar includes options for searching 
the list. Administrators can enable text searches for any list.

Before you begin
Role required: none

About this task
There are two options for searching the list: for a string in a selected field, or for a text string 
found in any field. These options are labeled Go to  and Search.

• The Go to  option sorts the list by the selected field and returns records where the field value 
is equal to or greater than the search term. For the Number  field, which is a string type field, 
it finds the records that have a number ending with the number that you enter. For example, 
searching a list of incidents by selecting Number  and entering 4  shows records with numbers 
like INC0000004  and INC0000014.

• The Search  option appears when you select for text. It returns records that contain the search 
term in any field in the list table. If you added a related list condition, the search does not 
include records in the related table.

Each option in a choice list is defined with a column label and a value. For example, the incident 
State  field contains several options, such as New  and Closed. These labels are column labels, 
and each one has an underlying value. For incidents, the default value for New  is 1  and the 
default value for Closed  is 7. You can search a column for either the column label or the value 
with the following results.

• Enter the column label to list matching records, for example, all incident records in the New 
state.

• Enter the value to find records that have a state greater than or equal to (=>) the specified 
value. For example, enter 6  to list incident records in the Resolved  and Closed  states.

Procedure

1. Navigate to a list of records.

2. If necessary, personalize the list to add the desired fields.

3. Select a field or select for text.

4. Enter the search text.
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Use wildcards to further refine list searches.

5. Press the Enter key to execute the search.

Available list search wildcards

The platform supports several wildcard characters to expand and refine search results.

Available list search wildcards

Wildcard Description

*search-term

%search-term%

Search for values that contain search-term.

%search-term Search for values that end with search-term.

search-term% Search for values that start with search-term.

=search-term Search for values that equal search-term.

!*search-term Search for values that don't contain search-term.

!%search-term Search for values that start end with search-term.

!=search-term Search for values that don't equal search-term.

Note: 
Reference fields support a different set of wildcard operators. For details on using wildcards 
to search reference field auto-complete values, see Auto-complete for reference fields .

Configure the default search behavior

The default search behavior in a list is to search for values that are greater than or equal to the 
value you enter. Administrators can add properties to change the search behavior to use either a 
contains search or a starts with search by default, instead of a greater than search.

Before you begin
Role required: admin

About this task
If you enter text in the search box without using a wildcard, the search is performed for values 
greater than or equal to the value you enter. For text data-type-fields, this means that the search 
first sorts the records on the selected field, then finds the first record that starts with the text and 
all following records. For numeric data-type-fields, this means that the search finds all records 
where the number field ends with the entered number.

Note: 
The system treats some string fields that contain record numbers as numeric fields. Any 
field named number  or u_number  is treated as a numeric field.

Changing the default search behavior to contains  or starts with  can cause performance 
issues as both search options return more results than a greater than search.

Procedure

1. Navigate to the list of system properties by typing sys_properties.list  into the 
navigation filter.

2. Add one of the following properties depending on your default search behavior preferences.
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Default search behavior property

Name Description

glide.ui.goto_use_contains Changes the default search behavior for a list 
to a contains  search.

◦ Type: true | false

◦ Value: true

glide.ui.goto_use_starts_with Changes the default search behavior for a list 
to a starts with  search.

◦ Type: true | false

◦ Value: true

3. Click Submit.

Related topics

Add a property

Configure default search behavior using a dictionary attribute

Change the default search behavior at the field level by adding an attribute to a field using the 
system dictionary.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Dictionary.

2. Search for the field in a table that you want to apply the default search attribute to.

3. In the Attributes field, add one of the following attributes.

Note: 
You may need to switch to the advanced view for the dictionary entry to see the attributes 
field.

Attribute Description

goto_use_starts_with=true Changes the default search behavior to use 
the starts with  operator for a specific 
field. Applying starts with  to a non-
text field returns any data starting with that 
search, which can cause performance 
degradation.

Grouped lists

Grouping aggregates a list by a field and displays the record count per group. Grouping can help 
you find data quickly by organizing and providing a summary of search or filter results.

For example, this picture shows active incidents grouped by caller.
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List grouped by caller

• Groups are named for the values of the field selected for grouping. For example, if you group 
by the assigned user, each group is a user's name.

• The record count for each group appears next to the group name.

• The total number of items in the list (all groups combined) appears near the paging controls in 
the list. This total displays only when the list is grouped on a field.

Use a grouped list

You can find information by grouping a list by a particular field. After grouping items in a list, 
several options let you focus on a particular group or set of groups.

Before you begin
Role required: none

Procedure

1. Use one of the following methods to group and ungroup items in a list.

◦ On the title bar, click the context menu and select Group By. Select the field by which to 
group the list. To remove a grouping, select -- None --.

◦ Right-click the column name and select Group By. To remove a grouping, select Ungroup.

For example, this picture shows active incidents grouped by caller.
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Group by

2. Use any of the following actions to expand the groups.

Option Description

To expand or collapse a group Click the arrow ( ) next to the group name.

To expand or collapse all groups Click the arrow at the top of the list.

To open the full list for a group Click the group name.

To see all records for a given group Open the full list.

Note: 

◦ The maximum number of records shown per group is the number of records per page 
in list view.

◦ Grouped lists with a script include in the filter may cause slowness.
The maximum number of records shown per group is the number of records per page in 
list view.

Filters and breadcrumbs

A filter is a set of conditions applied to a table to help you find and work with a subset of the data 
in that table.

You can apply, modify, create, and save filters. A hierarchical list of conditions at the top of the 
table — breadcrumbs — indicates the current filter.

Breadcrumbs offer a quick form of filter navigation. They are ordered from left to right. The left 
condition is the most general, and the right condition is the most specific. Clicking a breadcrumb 
removes all the conditions to its right. Clicking the condition separator (>) before a condition 
removes only that condition.

By default, a user with no roles cannot see the breadcrumbs or filter. Administrators can 
configure the ESS portal to allow unauthenticated users to see breadcrumbs and filters by using 
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a script include. For more information on using script includes to suppress breadcrumbs and 
filters, see Use script includes to suppress filters and breadcrumbs  .

Breadcrumbs, List v2

Examples:

• Clicking Priority = 2  removes the condition Category = Software  and returns all active 
incidents with a priority of 2.

• Clicking the condition separator (>) before Priority = 2  removes the condition Priority = 2  and 
returns all active incidents in the software category.

• Clicking All  removes all conditions and returns all incidents in the system.

Click a breadcrumb to refresh the list of records and show the latest information for those 
records.

Note: 
Clicking the New  button in a filtered list automatically applies the same filter to the new 
record. For example, clicking New  in the Resolved Incidents list opens a record preset with 
State  set to Resolved. In a list filtered for active, priority 1 incidents, clicking New  opens a 
record preset with Active  selected and Priority  set to 1 - Critical.

You can change the preset values on the form as needed. If there is a field you do not want 
to have populated in this way, you can add the following dictionary attribute to the field: 
ignore_filter_on_new=true.

Additional navigational functions are available when you right-click a breadcrumb.

Breadcrumb right-click options

Option Description

Open 
new 
window

Opens the results list for the breadcrumb in a new tab or window.

Copy 
URL

Copies the URL to the clipboard for the results list of the breadcrumb. Follow browser 
instructions if browser security measures restrict this function.

Copy 
query

Copies the encoded query to the clipboard for the breadcrumb. You can use this 
query in the URL of an instance or in the reference qualifier field of a dictionary entry.

For example, if you are viewing a list of all active incidents with a high 
or medium impact, right-click the breadcrumb and copy the query 
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Breadcrumb right-click options  (continued)

Option Description

active=true^impact=1^ORimpact=2. You can append this query to the end of the 
instance URL as follows:

https://{instance_name}/incident_list.do?
sysparm_query=active=true^impact=1^ORimpact=2

This selection is not available for the All  breadcrumb.

Related topics

Dictionary attributes

Generate an encoded query string through a filter

Quick filters

To quickly filter a list using a value in a field, right-click in the field and select Show Matching  or 
Filter Out. For date fields, choose from Show Before, Show After, and Filter Out.

These functions add a condition to the right in the breadcrumb of the current filter.

Quick filter

In this example, right-clicking In Progress  and selecting Show Matching  adds the condition 
State = In Progress  as the most specific condition of the filter. By contrast, right-clicking In 
Progress  and selecting Filter Out  adds the condition State != In Progress  as the most specific 
condition of the filter.

For date and date-time fields, you can also use Show After  or Show Before  to define a time-
based filter.

Using the quick filter method to filter out a particular value builds the following conditions: [field] 
[is not] [value] or [field] [is] [empty]. Records that contain empty or null values still display in 
the filtered list. If you manually create a filter, it does not automatically include the OR condition 
[field] [is] [empty], so records that have an empty or null value do not display in the filtered list.

Filters

A filter restricts what records appear in a list by providing a set of conditions each record must 
meet to be included in the list.

A condition consists of the following parts.
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• Field: Each field contains data from a particular column in the table. Selecting a reference field 
enables you to dot-walk to data from other tables.

• Operator: Each field type has its own set of valid operators. The operator determines if a value 
is needed.

• Value: Each field has its own set of valid values determined by the field type. Reference fields 
have access to auto-complete, and choice lists provide a list of options.

• Grouping: Each condition line is grouped with either an AND or OR connector. The filter 
requires all condition lines linked with an AND connector to be met. The filter separately 
evaluates each condition line linked with an OR connector.

List v3 provides the Related Lists Conditions section that enables you to include a condition 
based on a related table.

Note: 
If you open a list for a table you have create permissions for, apply a filter for a field, and 
click New  in the list header. The same field is automatically populated with the value you 
set in the filter on the new record.

Create filters on a list using the condition builder.

Related list conditions in List v3

By default, all lists enables you to filter on the current table data, which includes dot-walking 
to fields in referenced tables. In v3 lists, another type of condition, Related Lists Conditions, is 
available in the condition builder. For more information, see Add related list conditions.

Pin a filter in List v2

To make the condition builder appear every time you open the list, click the pin/unpin filter icon 

( ). This functionality is not supported in List v3.

Related topics

Dot-walking to data in related tables

Field types

Operators available for filters and queries

Create a filter in List

You can create a filter to restrict what records appear in a list by providing a set of conditions. 
When you run the filter, only records that meet the specified conditions are listed.

Before you begin
Role required: none

Procedure

1. Open the condition builder by clicking the show/hide filter icon ( ).
If the icon is disabled and the breadcrumb has a related list condition in it, you must remove 
the related list condition to open the filter. The condition was created when the List v3 was 
enabled for this list. List v2 does not support related list conditions. For more information about 
related list conditions, see Add related list conditions.

2. Select a field from the list.
The field type determines the available operators and values. For example, the Active  field 
can have a value of true, false, or empty, while a text field can have many different values. 
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Similarly, the greater than  operator does not apply to the Active  field, but it does apply to the 
Priority  field. For more information, see Condition builder.

3. Select an operator  from the list.

4. Select or enter a value, if appropriate.

5. Add or remove conditions to construct the desired filter by completing one or more of the 
following steps.

Option Description

To add a top-level condition
Click AND  or OR  on the condition builder tool­
bar, above the conditions.

To add a dependent condition Click AND  or OR  beside the condition.

To remove a condition Click x  beside the condition.

Note: 
To find all records that do not contain the specified value, create a filter with two 
conditions: [field] [is not] [value]  or [field] [is] [empty].

6. To specify the sort order of the results, click Add Sort  and then select a field to sort by and a 
sort order.

7. Optional:  Click Save  to keep the filter for future use.
For more information, see Save and use filters in a list view.

8. Click Run  to apply the filter.

Related topics

Dot-walking to data in related tables

Field types

Operators available for filters and queries

Add related list conditions

Related list conditions allow you to include a relationship with another table in the filter. Related 
list conditions are supported in both List v3 and the Report interface.

Before you begin
Role required: none

About this task
You can optionally include conditions on the related table. For example, you can filter active 
problems with one or more related incidents that are in the Canceled  state. Another example is 
to filter incidents with a breached service level agreement (SLA).

The List v3 filter contains two sections, one for the current table conditions and one for related 
lists conditions. You can include only one related table in the query, however, you can add 
multiple conditions for that table.
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Problem filter for open problems

The easiest way to understand the parts of a related list condition is to use an example. The 
steps below use the example of open problems with some number of related incidents. You can 
perform these steps for any list view that supports List v3.

Procedure

1. For this example, navigate to Problems  > Open.

2. Open the list filter and select the conditions for the current (Problem) table.
The [State] [is] [Open]  condition is already added.

3. Select RELATED LISTS CONDITIONS  to expand the section.

4. From the choice list, select the table relationship to include in the query.
For this example, select Incident>Problem. You can select any table that you have access to 
view.

5. To select a quantifier, select Greater Than Or Equal To 1.
The Quantity popover opens.

6. Select a quantity, enter number of records in the related table that must match, and then 
selectX  to close the popover.
The default number is 1. Following are descriptions and examples of each quantifier for this 
example.

◦ Greater Than Or Equal To: Returns problem records where the number of related incidents 
is greater than or equal to the number you enter. A value of 5  includes problems with five or 
more related incidents. Problem records with 4 or fewer incidents are not returned.

◦ Greater Than: Returns problem records that have more than this number of related 
incidents.
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◦ Less Than Or Equal To: Returns problem records that have the number or fewer than the 
specified number of related incidents. A value of 1  includes problem records with one or no 
related incidents.

◦ Less Than: Returns problem records with fewer than the number of related incidents. A 
value of 1  returns problems with no related incidents.

◦ Equal To: Returns problems with this number of related incidents. A value of 5  includes 
problem records with exactly five related incidents.

◦ None: Returns problems that do not match the specified table relationship. A selection of 
None  returns problems with no related incidents.

◦ Between: Returns problems with any number of related incidents that is between the two 
numbers you enter. Between  values of 5  and 10  include problem records with 5, 6, 7, 8, 9, or 
10 related incidents.

7. Optional:  Enter one or more conditions for the related table.
Select New Criteria  to add another condition.

Example 
The following image shows the example of filtering for problem records with more than two 
related incidents that are critical priority.

Note: 
You cannot perform a keyword search in a related table condition.

8. Select Run  to execute the filter query.

Result
The breadcrumb displays Related List condition.... Open the filter to view the related list query 
statement.

List breadcrumb and the related list condition query statement
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Note: 
If List v3 is disabled for a list with a related list condition query in the default filter, the filter 
edit function is disabled. Remove the related list condition to enable list filter editing.

OR conditions

The condition builder uses two different types of OR conditions: top-level and dependent.

Using a dependent OR condition, you can specify alternative criteria to a single operation. 
Dependent OR conditions work in the manner A and (B or C). When you have an OR condition in 
the query, the magnifying glass is no longer available. The conditions you put in the quick search 
headers are ANDed together. Having an OR makes it ambiguous as to where the new condition 
should go, for example before the OR, or after the OR.

For example, to return a list of all unassigned problem and incident records from the Task table, 
create a filter with a dependent OR on the Number  field.

[Assigned to] [is] [empty]  AND [Number] [begins with] [PRB]  OR [Number] [begins with] 
[INC].

Dependent OR

A top-level OR condition allows you to display the results of multiple filter criteria in a single list. 
Top level OR conditions work in the manner (A and B) or (C and D).

For example, to return a single list of all active incidents with a category of hardware, and all 
inactive incidents with a category of software, create two condition sets separated by a top-level 
OR condition.

• [Active] [is] [true]  AND [Category] [is] [Hardware]

• Top level OR condition

• [Active] [is] [false]  AND [Category] [is] [Software]
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Top level OR

Top-level and dependent OR conditions can be used together. Filters using both types of OR 
conditions work in the manner (A or B) or (C or D). By mixing AND conditions with top-level and 
dependent OR conditions, you can create very specific filters.

Filter on multiple string values

For a string field, you can create a filter that searches for multiple values by creating a comma-
delimited list.

Before you begin
Role required: admin

About this task
This feature enables administrators to copy and paste search criteria from a Microsoft  Excel 
spreadsheet into a filter, for example.

Note: 
Do not use the [is one of]  operator on fields that contain commas, as the query does not 
return the expected set of records. Instead, create a filter using multiple [or]  statements.

Procedure

1. Create the filter with the [is one of]  or [is not one of]  operator.
Depending on the selected field, a choice list or a text box appears.

2. Select one or more of the options by using multiple selection key commands.

The choice list remains visible.
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Alternatively, for text or number fields, type your search options. Separate the options by 
commas or put each option on a separate line, and do not enclose the selections in brackets.

3. Click Run  to filter the list.
The filter conditions appear as a comma-delimited string at the top of the results list.

Comma-delimited filter string

Dynamic operators

The dynamic operator, is (dynamic), lists predefined dynamic filter options where the condition 
value is computed from a value in a reference field.

The following dynamic filter options are available by default.

Note: 
Administrators can create new dynamic filter options.

Default dynamic filter options

Target table of 
reference field

Option label Description

User [sys_user] Me The reference field contains the current user.
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Default dynamic filter options  (continued)

Target table of 
reference field

Option label Description

One of My 
Assignments

The reference field contains the current user or someone for 
whom the current user is a delegate for assignments.

One of My 
Approvals

The reference field contains the current user or someone for 
whom the current user is a delegate for approvals.

Users With 
Roles

The reference field contains users that have any role.

Group 
[sys_user_group]

One of My 
Groups

The reference field contains a group to which the current user 
belongs.

The following table contains examples and descriptions of dynamic filter conditions.

Example of using the dynamic operator

Field Operator
Dynamic 
filter option

Description

Caller is 
(dynamic)

Me Computes the value of Caller based on the current user 
viewing the list.

Assignment 
group

is 
(dynamic)

One of My 
Groups

Computes the value of Assignment group based on the 
current user viewing the list.

Save and use filters in a list view

Depending on your access rights, you may save filters for everyone, a user group, or yourself. You 
can apply saved filters and edit or delete them.

Before you begin
Role required: varies depending on action. See procedure.

Note: 
A new Create ACL allows all users to save filters by default. This ACL overrides any custom 
ACLs in place if administrators are restricting filter access. The new ACL gives all users 
access to the User field by default, and access to the Group field only if users have the 
filter_group role and are in the currently selected group.

Procedure

1. Navigate to a list and create or modify a filter as described in Create a filter in List.

2. Select Save....

Additional options for saving the filter display.

3. Enter a name for the filter in the Save as:  field.
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4. Select one of the following visibility options.

Option Description

Me

Creates a personal filter, which only you can 
access. If you don’t have Write access to the 
User field, this option isn't available. See your 
administrator for more information.

Everyone
Creates a global filter, which all users can ac­
cess. This option is available to users with the 
filter_global role.

Group

Creates a group filter, which only members 
of the user group you select can access. This 
option is available to users with the filter_­
group role. If you don’t have Write access to 
the Group field, this option isn’t available. See 
your administrator for more information.

5. Select Save.

6. Optional:  To use your saved filter, return to the list, select the List control menu ( ), and 
select your filter from the Filters submenu.

7. Optional:  To edit or delete your personal filters, return to the list, select the List control menu 

( ), and select Edit personal filters  from the Filters menu.

a. Review the Filters list and select the title of the filter to edit.

If no results display, select the Show/hide filter icon ( ) and remove any applied filters.

b. Update the filter title or add or remove conditions.

c. Optional:  To delete the filter, select Delete  and confirm deletion.

d. If you edited the filter, select Update.

Filter admin functions

Administrators can work with filters in the Filters table [sys_filter], including creating, editing, and 
deleting filters.

Administrators can also create scripted filters that cannot be created in the condition builder. 
Scripted filters required a knowledge of JavaScript. Scripted filters can be used to create 
additional dynamic filter options.

Create and edit filters

Set up and edit an admin-configured filter.

Before you begin
Role required: admin

Note: 
The following procedure is intended for administrators. Users with other role types should 
instead refer to Save and use filters in a list view.
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Procedure

1. Navigate to All  > System Definition  > Filters.

2. To create a filter, select New  and complete the following steps on the Filter record.

a. Enter a Title  and select the Table.

b. Add filter conditions.

c. Select Submit.

3. To edit a saved filter, select the filter from the Filters list to edit and complete the following 
steps on the Filter record.

a. Modify the Filter  conditions as necessary.

b. Select Update.

Related topics

Create a filter in List

Delete filters

You can delete any saved filter, including global, group, or personal filters.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Filters.

2. Optional:  To see who created the filter and when, personalize the list to add the created_by 
and created  fields to the list.

3. Optional:  To see who has access to the filter, configure the list to add the user, group, or 
domain  fields.
Filters that are not assigned to a user or group are global.

4. Select the filter to delete.

5. Click Delete  and confirm the deletion.

Related topics

Personal lists

Configure the list layout
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Create scripted filters

The condition builder alone cannot create some filters, such as displaying a record set that 
depends on an unrelated table. If you know JavaScript, you can create JavaScript functions for 
use in advanced filters.

Before you begin
Role required: admin

Procedure

1. Create a new script include.

a. Navigate to All  > System Definition  > Script Includes.

b. Click New.

c. Fill out the form, and then select Submit.

2. Open the script include and, in the Script  field, create a JavaScript function that returns an 
array of sys_ids.

◦ Ensure that the function uses the same name as the script include.

◦ Ensure that the script include is Active  and Client callable.

3. Call the JavaScript function from the condition builder.
For more information, see GlideRecord  queries and Script includes .

Note: 
Grouped lists with a script include in the filter may cause slowness.

Example:
A company provides intensive care for a group of customers. To track these services, the service 
manager needs a high-level journal and links to all incidents that the customers raise.
The company creates an application, Intensive Care, and a table, [u_intensive_care]. While the 
table contains a reference field for the customer name, there is no direct link to the user table. 
Thus, the manager cannot set up an incident list filter using the condition builder for customers 
who are under intensive care.

The solution is to write a JavaScript function that uses a GlideRecord query to build an array 
of user sys_ids in the [u_intensive_care] table, as shown in the sample code below. Call the 
function from the condition builder in the Incident table ([Caller] [is] [javascript:myFunction()]).

function myFunction(){
    var arrUsers = [];
    var gr = new GlideRecord('u_intensive_care');
    gr.query();
    while(gr.next()){
        arrUsers.push(gr.u_customer.toString());
    }
    return arrUsers;
}

Create a dynamic filter option

Dynamic filter options enhance filtering by allowing users to run existing script includes or 
JavaScript against a reference field within condition builders and dynamic reference qualifiers.

Before you begin
Role required: admin
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About this task
This task describes how to create a new dynamic filter option and an associated script include .

Dynamic filter options "objectize" script includes/JavaScript, enabling them to be reused in 
multiple condition builders  and dynamic Reference qualifiers . This type of filter enables you to 
modify a script once and have the changes automatically take effect everywhere the dynamic 
filter option is used.

When defining a dynamic filter, you can:

• use an existing is (dynamic)  dynamic filter option (condition builder only)

• use an existing dynamic filter option (OOB or custom)

• create a new dynamic filter option and script include/JavaScript

All condition builder dynamic filters use the is (dynamic)  operator and call a dynamic filter 
option. In the following example, the pre-existing dynamic filter option Me  is being used. For a list 
of available pre-existing condition builder dynamic filter options, see Dynamic operators.

Note: 
Dynamic filters are supported in scoped applications, but they are not supported in UI 
policy conditions.

Dynamic operands

Procedure

1. Create a scripted filter  as a client-callable script include or business rule.

2. Navigate to System Definition  > Dynamic Filter Options.

3. Select New.

4. Complete the form.

Dynamic filter options

Field Description

Label Enter a descriptive name for the dynamic filter option.

Script Enter the name of the function you created, JavaScript (no script include 
needed), or the complete script include/business rule call, such as new 
GlobalCanvasUtil().refQualPaTabs().

Field type Select Reference.

Referenced 
table

Select the table to which this dynamic filter option applies.

Order Enter a number to designate the placement of this dynamic filter option in the 
filter option choice list.

Roles Select the role a user must have to see this option.
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Field Description

Active Enable or disable the option.

Reference 
script

Optional. Select the client-callable script include or business rule you created 
for the scripted filter. If the Script  field contains JavaScript, an encoded query, 
or the entire script include/business rule reference, this field can be empty.

Available 
for filter

Select this option to display the dynamic filter option as a filter breadcrumb.

Available 
for default

Select this option to allow dynamic filter option to be a default in a dictionary 
entry.

Available 
for ref qual

Select this option to allow dynamic filter option to be selected as a dynamic 
reference qualifier.

Note: 
Dynamic filters using Table API GET methods in scripts only work when using the same 
user configured in the basic authentication profile. To allow multiple users access to the 
dynamic filters, use global JavaScript APIs such as GlideRecord and GlideQuery APIs 
instead.

5. Select Submit.

Encoded query strings

An encoded query string represents a complex filter on a list of records.

Use encoded query strings to include a filter as part of a URL parameter, such as the Navigate to 
a record or module using a URL, or as a reference qualifier  to restrict the data that is selectable 
for a reference field.

To construct an encoded query string, generate a list query and then copy it from the list filter. 
This is the preferred method because the alternative is to create the string manually.

In order to create an encoded query string manually, you need to know the relevant table and 
field names and operators.

Encoded query string examples

Title Example

Referring 
to 
Boolean 
or string 
values

To create a query string on Boolean fields, use this syntax: field=true or field=false. 
For example, to return only active records in a table, use:

active=true

To create a query string with a field that has a specific string value, use this syntax: 
field=value. For example, to return incident records where the category is network, 
use:

category=network

Referring 
to 
reference 
fields

To create a query string that refers to a reference field in another table, use this 
syntax: field_in_referenced_table=value. For example, to return users with the itil 
role in the Assigned to  reference field on the Incident form, use:

Assigned_to.roles=itil
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Encoded query string examples  (continued)

Title Example

Referring 
to choice 
list values

To create a query string that refers to a choice list  option, use the value of the 
choice list, not the label, with this syntax: choice list field=value. For example, to 
return configuration items (CIs) with the status Installed, which has a value of 1 in 
the choice list, use:

install_status=1

See Values to associate with choice labels for scripting  to find the options for the 
values.

Using 
multiple 
conditions

To use two conditions joined by an AND operator, use the carat ^ symbol in this 
syntax: field1=value1^field2=value2. For example, to return all active users with the 
"itil" role, use:

active=true^roles=itil

To use two conditions joined by an OR operator, use the carat symbol with OR with 
this syntax: field1=value1^ORfield1=value2. For example, to return all users with 
either the "itil" or "admin" roles, use:

roles=itil^ORroles=admin

To use condition by the LIKE operator, use the syntax:fieldLIKEsubstring. For 
example, to return all users with roles containing the string "it", use:

rolesLIKEit

To use condition by an IN operator, use the syntax: fieldINvalue1,value2,value3. For 
example, to return all users with roles that are either "itil", "admin", or "user", use:

rolesINitil,admin,user

To add multiple conditions where one condition is a JavaScript function, use 
this syntax: javascript:'field=value^' + function(). The function must return a 
string that can be concatenated with the first string to produce a valid query 
string. For example, to return all active users and meet the conditions of the 
getGroupQualifier() function, use:

javascript:'active=true^' + getGroupQualifier()

Listing 
values in 
order

To sort data by a specific field, use the ORDERBY condition with the following 
syntax: field1=value^ORDERBYfield2.

For example, to return the days of the week in order from the Day of the Week 
[sys_cal_unit] table, use:

unit_name=day^ORDERBYvalue

In the Day of the Week table, unit_name is the field that specifies day, week, or 
month, and value is a numerical value for each day from 1 (Monday) to 7 (Sunday). 
The query string returns a list of the days of the week in order from the lowest 
value, which represents Monday, to the largest value, which represents Sunday.
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Encoded query string examples  (continued)

Title Example

Note: 
Reference qualifiers do not support the ORDERBY condition. In reference 
qualifiers, you can sort the reference lookup list by using standard list 
controls. To specify the order of an auto-complete list for a reference field, 
use the ref_ac_order_by dictionary attribute.

Including 
a related 
list query

At the end of the query statement, enclose the related list information with 
^RLQUERY and ^ENDRLQUERY and the quantity. For example, in a query on the 
Problem table that includes problems with at least one related incident, use:

^RLQUERYincident.problem_id,>=1^ENDRLQUERY

You can also specify conditions on the related table. For example, to include the 
condition that at least one of the related incidents is critical priority, use:

^RLQUERYincident.problem_id,>=1,priority=1^ENDRLQUERY

Note: 
Related list queries must be enabled in System Properties  List v3. Select the 
Allow related list query conditions to be added through the filter  check box 
to enable it.

You can build a related list query for a list that uses List v2, however, the filter 
conditions cannot be modified until you removed the related list condition in 
the breadcrumb.

Including 
a search 
term 
query

To include a search term in a query, use the 123TEXTQUERY321 reserved variable. 
For example, to return results with the 'email' search term, use this encoded query 
string.

123TEXTQUERY321=email

Including 
a text 
index 
group 
query

To include a text index group in a query, use the 123TEXTINDEXGROUP321 
reserved variable. For example, to return results within the portal_index_group text 
index group in the Text Index Groups [ts_index_group] table, use this encoded 
query string.

123TEXTINDEXGROUP321=portal_index_group

Generate an encoded query string through a filter

You can generate an encoded query string through a filter on any list and paste the string into a 
URL query or a reference qualifier.

Before you begin
Role required: none

Procedure

1. Open a list of records.

2. Construct the filter.

3. Click Run.
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4. Right-click the end of the filter breadcrumb and select Copy query  from the context menu.

Copy the query from the breadcrumb

If you are in split mode in List v3, right-click the blue filter text in the left pane.

5. Copy the query to your system clipboard.

6. Use the query string to Navigate to a record or module using a URL  or an Reference qualifiers .
When you use the CONTAINS operator on a list filter, the system translates the filter to a 
LIKE query. For example, if you filter for active records with numbers that contain 123, the 
URL is https://InstanceName.service-now.com/incident_list.do?
sysparm_query=active%3Dtrue%5EGOTOnumberLIKE123.

Related topics

Reference qualifiers

Navigate to a record or module using a URL

Methods for list edits

Users can edit data in lists using various methods.

Quick edit functions

To edit a record in a list using quick edit functions, right-click a field and select the appropriate 
function.

Assign to me

For records that use assignments, places the name of the logged-in user into the 
Assigned to  field.

Approve

For records that use approvals, changes the approval state of the record to 
Approved.

Reject

For records that use approvals, changes the approval state of the record to 
Rejected.

Assign tag

For records you want to track based on a user-defined label, lets you select an 
existing tag or add a tag.

List editor

The list editor lets you edit field values in a list without opening a form. Administrators can 
configure the list editor. By default, list editing is disabled for some tables. Fields of certain 
types  cannot be edited from lists.
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Multiple record edits

You can edit more than one record at the same time using the list editor or an editing form.

Use the list editor

The list editor enables you to edit field values directly from a list without navigating to a form.

https://player.vimeo.com/video/995178051?
badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: none

About this task
The list editor lets you edit field values in a list without opening a form. Administrators can 
configure the list editor. By default, list editing is disabled for some tables. Fields of certain 
types  cannot be edited from lists.

Before the list editor opens, access rights to edit the field are verified. If this process takes 
longer than expected, a loading indicator appears. If the field has a dependency relationship 
(for example, Category and Subcategory), then a composite editor opens to enable editing of all 
dependent fields. You must have permissions to edit all dependent fields to use the list editor.

Procedure

1. Double-click in an empty area of the field.
The appropriate editor for the field type opens.

Note: 
You can enable single-click editing from the list personalization interface. You can also 
use keyboard navigation to access the list editor.

2. Enter the appropriate values.
To clear a list field configuration, refresh your browser session by reloading the page, and the 
original list field configuration returns.

3. Save the records by performing the appropriate action for your list version.

Select the save icon ( ). Select the cancel icon ( ) or press the Escape key to retain the 
original value.

List editor
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4. To use keyboard navigation, press the Tab key until the first field in the list is selected, and then 
select the field to edit in one of the following ways.

◦ Move right: Tab or the Right Arrow key.

◦ Move left: Shift + Tab or the Left Arrow key.

◦ Move down: the Down Arrow key.

◦ Move up: the Up Arrow key.
To select multiple fields in the same column, hold Shift and press the Down Arrow or the Up 
Arrow key.

5. Press the Enter key to open the list editor.

6. Enter a new value.
To add another line in a multi-line text field, press Shift + Enter.

7. Save or cancel your changes in one of the following ways:

◦ Press the Enter key. The new value is saved and the field below the edited field becomes 
selected.

◦ Press the Tab key. If the list is configured to save immediately, the new value is saved. If the 
list is configured to save data by rows, an indicator appears beside the value and the list 
editor opens for the next field. The row is saved only when you navigate away from the row or 
select the check mark icon beside the row.

◦ Press Ctrl + Enter keys. If the list is configured to save immediately, the new value is saved. 
If the list is configured to save data by rows, an indicator appears beside the value and the 
current field remains selected.

◦ Press the Esc key. The list editor closes without saving changes and the field remains 
selected.

Note: 
Certain browsers use different key combinations to edit certain field values. For example, 
to edit a list using Chrome, press the Spacebar.

Edit multiple records in a list using the list editor

You can edit multiple records at the same time using the list editor. If you want to update a single 
field on multiple records to have the same value, the list editor is the quickest method.

Before you begin
Role required: none

Procedure

1. Select the records that you want to edit by performing one of the following actions.

◦ To select multiple consecutive fields, hold Shift and drag in the desired fields, or select a cell 
and then press Shift + Up Arrow or Shift + Down Arrow.

◦ To select multiple non-consecutive fields, hold Ctrl and click on each desired field 
individually (On Mac, use Cmd and select instead).

2. Open the list editor by double-clicking (or clicking, depending on setup) in an empty area of 
the field.
The number of selected rows that you’re editing is indicated. If any rows can’t be edited due to 
security constraints, that is indicated.
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Selected fields are highlighted in blue

3. Enter the appropriate values and select Save.

Edit multiple records in a list using an editing form

You can edit multiple records at the same time using an editing form. If you want to edit multiple 
fields or fields that don’t appear in the list view, use an editing form.

Before you begin
Role required: list_updater

Depending on your ACL settings, some of these options might not be available even with the 
right role. For example, if the list is task.list and users try to select multiple incident records from 
that task list, the form uses the task form and not the incident form so ACLs on task are enforced 
instead. Since users would not have access to tasks specifically, the form wouldn’t show any 
fields.

Procedure

1. Perform one of the following actions.

Option Description

Update selected records

a. Select the check box by each row that you 
want to edit.

b. Select and hold (or right-click) any column 
header and select Update Selected.

Update all records in the list

a. Filter the list so it contains only the rows 
you want to edit.

b. Select and hold (or right-click) any column 
header and select Update All.

2. Enter appropriate values in any of the fields and select Update  to save your changes in all 
selected records.

Personal lists

You can create personal lists to customize which columns appear and the order in which they 
appear. Personal lists modify a specific list view according to your individual preferences.

Personal list customizations don’t affect what other users see in their lists. Administrators can 
manage  the personal lists function.
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Personalize a list

You can personalize a specific list view based on your individual preferences.

Before you begin
Role required: personalize_list or admin

Procedure

1. Open the list.

2. Select the personalize list icon ( ) in the right corner.

3. Select the columns and the desired order.

Note: 

◦ Values in the first column appear as links. If the first column isn’t a reference field, the 
link opens the record from the list, as expected. If the first column is a reference field, 
the link opens the record from the referenced table. This behavior can be confusing. 
For this reason, avoid using a reference field as the first column.

◦ If an inactive field is removed from an admin-configured default view, any personal lists 
will reset to follow the default view, thus removing the inactive field from the personal 
list.

4. Select display options.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

444



Note: 
These options apply to all lists, not just the view you’re personalizing.

Option Description

Display long text on more than one line

Select the Wrap column text  check box. 
Clear the check box to display text on one 
line.

In Core UI, this option is also available in the 
Lists  section of the system settings.

Condense the vertical space between rows
Select the Compact rows  check box. Clear 
the check box to use standard row spacing.

Highlight list rows as the cursor passes 
over them

Select the Active row highlighting  check box. 
Clear the check box to restore the static, alter­
nate row highlighting.

Use updated field status indicators

Select the Modern cell coloring  check box.

In Core UI, this option is also available in the 
Lists  section of the system settings.

5. Select list editing options (requires you to configure the list editor).

Note: 
These options apply to all lists, not just the view you’re personalizing.

Option Description

Allow the list editor to open for the list
Select the Enable list edit  check box. Clear 
the check box to prevent the list editor from 
opening for the list.

Open the list editor with a double-click
Select the Double click to edit  check box. 
Clear the check box to open the list editor us­
ing a single select.

6. Select OK.
The list reloads to show the changes.

What to do next
To reset a list to the default layout, select the personalize list icon and select the Reset to column 
defaults  button.

Forms in the classic environment

A form displays information from one record in a data table.

Note: 
This content pertains to the classic environment, which refers to working in lists of records 
and on record forms directly, not in the Configurable Workspace interface. You can work in 
the classic environment with Next Experience  active, or with it inactive, which is referred to 
as Core UI  (formerly known as UI16).

The specific information on a form depends on the type of record displayed. Users can view and 
edit records in forms. Administrators can configure what appears on forms. Watch this ten-minute 
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video for an overview of the features and functions of ServiceNow  forms:  User Interface | Forms 
including fields, related lists, views, personalization, activity stream, attachments, formatters, 
following records, and other form header options.

Form elements
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Form elements

Form 
element

Function

Form 
header

Provides navigation tools and actions related to the record.

Fields Stores specific data about the record.

Sections Groups related information on the form. To enable or disable form tabs, click the 

gear icon in the banner frame ( ) and toggle the Tabbed forms  option.

Users can use icons to collapse ( ) or expand ( ) form sections when tabbed 
forms are disabled. When you collapse or expand a form section, your selection is 
saved as a user preference. The next time you access a record that uses the same 
form, the same sections are collapsed or expanded.

Related 
links

Provides access to additional functions based on record type and system setup. 
Administrators can add related links to forms using UI actions.

Related 
lists

Displays records in other tables that have relationships to the current record.

Embedded 
lists

Allows for editing related lists without having to navigate away from the form. 
Changes are saved when the form is saved.

Response 
time 
indicator

Appears at the bottom of some forms to indicate the processing time required to 
display the form.

Form headers for UI versions

Core UI  and UI15 each have a different form header that offers different navigation icons.

Learn about form header navigation by selecting the form header topic that corresponds to the 
UI version your organization uses.

Core UI  form header

The form header displays the title of the form (table) and provides several controls.

The Core UI  form header includes the following controls.

Form header Core UI
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Core UI  form header controls

Control Icon Description

Back Navigates to the previously viewed page without saving changes.

Form 
context 
menu

Appears when a user clicks the menu icon beside the form title or right-
clicks the form header. This menu is also called a right-click menu.

Attachments Allows users to view and add attachments to the record. For more 
information, see Add and manage attachments.

Show 
activity 
stream

Moves focus to the journal entry section of the form. If the journal fields are 
not on the form, the activity stream opens in a fly-out window.

Personalize 
form

Opens the form personalization menu. For more information, see 
Personalize a form.

More options

Email Opens an email window.

Template 
bar

Opens a bar at the bottom of the form and lists available templates.

Annotations Displays on-form annotations. For more information, see Administering 
form annotations .

Tags Displays the option to create custom tags and categorize documents. For 
more information, see Tags.

Remaining controls

Submit or 
Update

Saves changes and returns to the previously viewed page.

Related 
actions

Provides standard actions in the form header for some tables, such as 
Close Incident or Resolve Incident in incident.

Delete Deletes the record from the list.

Previous 
and Next

Opens the previous and next record on the list from which the record was 
accessed.

Form context menu

The form context menu provides controls based on the table and user access rights. 
Administrators can customize some of the options available on a context menu using UI actions.

Access the form context menu by clicking an icon beside the form title or by right-clicking the 

form header ( ).

The form context menu includes the following options.

Note: 
Some of the options displayed on the form context menu depend on the user role, installed 
applications, and version of the UI.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

448

https://www.servicenow.com/docs/access?context=c_FormAnnotation&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_FormAnnotation&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_FormAnnotation&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_FormAnnotation&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Form context menu options

Option Description

Save Saves changes without leaving the form view.

Related 
actions

Provides standard actions in the form context menu for some tables, such as Add to 
Visual Task Board  or Create Change  in incident.

Insert Saves the data as a new record and returns to the previously viewed page.

Insert 
and Stay

Saves and displays the new record. For more information about inserting records, 
see Edit a form.

Configure Provides administrative functions, such as configuring forms.

Export Exports data to PDF. Administrators can also export to XML. For more information, 
see Export data .

View Changes fields to a predefined layout. Switching views submits the form, which 
saves all changes. Administrators can customize views.

Create 
Favorite

(Core UI  only) Adds the current record to your favorites list, represented by a star 
icon on the tab.

Copy 
URL

Copies to the clipboard the URL for the form view of the record. Follow browser 
instructions if browser security measures restrict this function.

Copy 
sys_id

Administrators only. Copies to the clipboard the sys_id of the record. Follow browser 
instructions if browser security measures restrict this function.

Show 
XML

Administrators only. Displays record data in XML format.

History Administrators only. Displays audit history for the record, which must be enabled for 
the table. For more information, see Enable auditing for a table .

Reload 
Form

Reloads information from the database to refresh the form view.

Related topics

UI actions

Form fields

A field represents an individual item of data on a record.

Users can view and modify field data on a form. For more detailed information, see Field 
administration .

Field status indicators

Indicators are used on some fields to denote a special field type.

A field status indicator is a colored asterisk that may appear to the left of mandatory fields. Field 
status indicators change colors to represent different states of mandatory fields.

Field status indicators

Indicator Description

Unpopulated Required field is empty. The user must enter a value to save the form. 
Default color is red.
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Field status indicators  (continued)

Indicator Description

Populated — 
saved

Populated — 
unsaved

Required field contains a value that was saved or must be saved. Default 
color is gray.

Core UI  field status indicators

Related topics

Define field styles

Navigate to a record or module using a URL

Users can navigate to a record or module directly by using a URL. This topic explains the URL 
schema by which the system renders pages.

Before you begin
Role required: admin

About this task
Note: 
The sysparm_query  page parameter behaves differently for a list versus a form.

• List: Returns records that match the query conditions.

• Form (with sys_id=-1 specified): Applies the values to the new record.

Procedure

1. To access the unique, secure web address for each instance, enter the default format: 
https://<instancename>.service-now.com.

Note: 
To display a custom base URL in email notifications, set the 
glide.email.override.url  property. For more information, see Advanced email 
properties .

2. For other URL displays, enter one of the following schemas:
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Action Schema

To display 
the page 
in the 
standard 
interface, 
with the 
banner 
frame 
on top 
and the 
application 
navigator 
on the left

nav_to.do?uri=

To open a 
form, list, 
UI page, or 
other page

<page name>.do?

To view a 
list

<table name>_list.do

To open a 
record in 
form view

<sys_id>

To create a 
new record

sys_id  is -1.

To specify 
a query, 
view, 
redirection 
page, and 
more.

<page parameters>

Parameters include the following examples:

◦ sysparm_view=ess: Specifies a view (ess).

◦ sysparm_query=number=INC00040: Specifies a query (number is 
INC00040).

◦ sysparm_query=priority=2^active=true: Specifies a complex query 
with two terms (priority is 2 and active is true).

◦ sysparm_query=priority=2^active=true^EQ^GROUPBYcategory: 
Groups query results (by category).

◦ sysparm_order=number: Specifies the field by which to sort (number).

◦ sysparm_order_direction=desc: Specifies a sort order (descending).

◦ sysparm_force_row_count=5: Limits the maximum number of results (5 
records).

◦ sysparm_result_view=viewname: Specifies the view for search results.

To specify 
a file 
format. 
(CSV, 
XML, PDF, 

%26CSV
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Action Schema

or UNL 
(Unload))

To 
separate 
page 
parameters

&

To build 
multiple 
term 
queries 
or specify 
multiple 
field values

^(carat)

Related topics

Page navigation by URL

Enable tiny URL support

The default URLs by which the system renders pages may exceed the character limit of some 
browsers, resulting in an error message. You can enable tiny URL support, which generates 
shortened internal URLs, to help prevent this error.

Before you begin
Role required: admin

About this task
The Tiny URL Support plugin is activated and enabled automatically. Confirm that this plugin is 
enabled if you receive a failure to open page error during routine operations in the ServiceNow AI 
Platform.

Note: 
The system doesn’t convert all URLs to tiny URLs. Only some URLs the system generates 
as redirects are converted. For example, the URL that the browser generates when a user 
opens a record isn’t converted to a tiny URL.

Procedure

1. Navigate to All  > System Properties  > System.

2. Select the Use tiny URLs when a redirect URL becomes too large. This ensures that URLs 
that are too large for IE (greater than 2083) are not used. Instead, they are converted to a 
tiny URL to work around the IE issue.  (glide.use_tiny_urls  property).

3. Optional:  Update the value in the Minimum length of a redirect URL that is turned into a tiny 
URL (default=1024)  (glide.tiny_url_min_length  property), if desired.

4. Select Save.

Examples of navigating by URL

A list of example URLs that demonstrate ways to open pages in the ServiceNow  application.
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Open a form with preset values

Schema: https://<baseURL>/nav_to.do?uri=<table name>.do?
sys_id=-1&sysparm_query=<field=value>

Description Example

Opens 
a new 
Incident 
form in the 
standard 
interface 
with a 
priority of 
1  and an 
incident 
state of 
Awaiting 
Problem.

https://<instance name>.service-now.com/nav_to.do?uri=incident.do?
sys_id=-1&sysparm_query=priority=1^incident_state=3

You can 
also use 
JavaScript 
to access 
GlideSystem
methods. 
The 
following 
example 
creates the 
same type 
of incident 
as above, 
and also 
populates 
the caller 
ID with the 
current user 
ID.

https://<instance name>.service-now.com/nav_to.do?uri=incident.do?
sys_id=-1&sysparm_query=priority=1^incident_state=3^caller_id=javascript:gs.getUserID()

Open an existing record with preset values

Schema: https://<baseURL>/nav_to.do?uri=<table name>.do?
sys_id=<sys_id>

Description Example

Opens the incident record with the sys_id 
966c9a414f5593001f6eac118110c75c

https://<instance 
name>.service-
now.com/incident.do?
sys_id=966c9a414f5593001f6eac118110c75c

Opens the incident record with the number 
INC0010001

https://<instance 
name>.service-
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Description Example

now.com/incident.do?
sysparm_query=number=INC0010001

View a list of incidents

Schemas for the following examples:

• https://<baseURL>/nav_to.do?uri=<table name>_list.do

• https://<baseURL>/<table name>_list.do

Description Example

Opens a list of all incidents with 
(example 1) the navigation frame.

https://<instance name>.service-
now.com/nav_to.do?uri=incident_list.do

Opens a list of all incidents without 
the navigation frame.

https://<instance name>.service-
now.com/incident_list.do

View a list of attachments

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do

Description Example

Opens the Attachments 
table in list view.

https://<instance name>.service-now.com/
sys_attachment_list.do

View a filtered list

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do?
sysparm_query=<field=value>

Description Example

Returns a list of active 
incidents with high escalation 
in the standard interface.

https://<instance name>.service-
now.com/nav_to.do?uri=incident_list.do?
sysparm_query=active=true^escalation=2

Return a file

Schema: https://<baseURL>/nav_to.do?uri=<table name>_list.do?
sysparm_<sysparmTypeOrField=value>&CSV

Description Example

Returns a comma-separated value 
file of records in the Incident table 
that meet the query conditions.

https://<instance name>.service-
now.com/nav_to.do?
uri=incident_list.do?
sysparm_query=active=false&CSV
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Configure the activity filter

The activity formatter contains a filter that lets users select which of the available fields to show 
in the activity list.

Before you begin
Role required: none

About this task
All fields on the activity list display in alphabetical order by default. You can change the order 
that fields appear on the form by using the Configure available fields  option in the activity 
formatter.

Use the activity filter

Use the activity filter to show or hide fields that you want to display activity.

Before you begin
Role required: admin

About this task
The activity formatter contains a filter that enables you select which of the available fields to 
show in the activity list.

All fields on the activity list display in alphabetical order by default. You can change the order 
that fields appear on the form by using the Configure available fields  option in the activity 
formatter.

Procedure

1. Open the filter by clicking the activity filter icon ( ) in the Activity  header.

2. Select the fields for which you want to display activity.
Fields are added or removed dynamically as the selection is made.

3. Click the activity filter icon again to close the filter.

Embedded lists or Related lists

Some forms may show related lists as embedded. Changes to embedded lists are saved when 
the form is saved.

Use these controls to work with an embedded list. For more information, see Edit a form.

Working with embedded lists

Task Icon Action

Expand an 
embedded 
list

Click the expand icon in the list 
header.

Collapse 
an 
embedded 
list

Click the collapse icon in the list 
header.

Insert a 
new row

Select Add  and identify the record 
you want to add to the embedded 
list.
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Working with embedded lists  (continued)

Task Icon Action

Edit a row Double-click in an empty area of 
that field. See Use the list editor.

Delete a 
row

Click the delete icon beside 
the row. New rows are removed 
immediately. Existing rows are 
designated for deletion when 
the record is saved. To clear this 
designation, click the delete icon 
again.

Embedded list

Related lists

Related lists appear on forms and show records in tables that have relationships to the current 
record.

Users can view and modify information in related lists like any other list. Administrators can 
configure related lists to appear on forms and in hierarchical lists by configuring a form . Related 
lists do not have a size limit.
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Note: 

Creating a record using a related list applies the list filter to the record and auto-populates 
the related field. This behavior applies to reference, string, Boolean, and menu fields when 
the criteria in the filter is set to is  or =.

Related topics

Configure form layout

Lists in the classic environment

Select or create records in a related list

When a form contains a related list, such as the Incidents  related list in the problem form, you 
can select existing records or add new ones in the related list.

Before you begin
Role required: none

Procedure

1. Open the record to work with records in a related list, such as a problem record.

2. Locate the related list, for example, Incidents.

3. To select existing records, complete the following steps.

a. Click Edit.

b. Using the slushbucket, select the records to associate with the current record.
When you select a record, information about it appears below the Collection  list to help you 
identify the record to select.

c. Click Save.

4. To create a new related record, complete the following steps.

a. Click New.
A new form for the related table opens, for example, the incident form.

b. Complete the form and click Submit.
The new record is added to the related table and to the related list of the record.

Configure when a related list loads

If there are many related lists on a form or many records in the related lists, the form may load 
slowly. You can improve form response times by configuring related lists to load manually, on 
demand, or automatically, after the rest of the form loads.

Before you begin
Role required: none

About this task

Procedure

1. Navigate to  User Menu  > Preferences  > Display.

2. Select one of the following options from the Loads related lists in classic forms  menu.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

457

https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Option Description

With the Form

Related lists load when you open the form, 
which is the default setting.

When selected, it sets the value of the glide.ui­
.related_list_timing user preference to de­
fault.

After Form Loads

Related lists load after the rest of the form 
loads.

When selected, it sets the value of the glide.ui­
.related_list_timing user preference to de­
ferred.

On-demand

Related lists load on demand. When this op­
tion is selected, a Load Related Lists  button 
appears at the bottom of each form that con­
tains related lists. Select the button to load re­
lated lists.

When selected, it sets the value of the glide.ui­
.related_list_timing user preference to onde­
mand.

3. Close the display preferences menu.

Create a default filter for a related list

Create a default filter for the records that load when your related list displays.

Before you begin
Role required: admin

About this task
Note: 
This functionality is not supported in List v3 related lists.

Procedure

1. Navigate to the related list (example, Incidents  on a problem record).

2. Create the desired filter using the condition builder (example, [Active] [is] [true]).

3. Click Set as Default Filter.
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Configure the edit option

You can configure the edit option that allows users to add records to related lists in forms.

Before you begin
Role required: admin

About this task
The Edit  button is available for related lists that represent many-to-many and one-to-many 
relationships. Defined related lists may not have an Edit  button, as related records are added to 
these lists automatically based on the relationship between the records.

Procedure

1. Navigate to the related list, such as the Incidents  related list on a problem record.

2. Perform the appropriate action for the list version.

3. Perform one of the following actions.

Option Description

Show the Edit option Clear the Omit edit button  check box.

Hide the Edit option Select the Omit edit button  check box.

Show the Edit option if the check box is 
cleared and the button does not appear.

Click Enable Edit.

4. If the list represents a one-to-many relationship (example, incidents can be associated 
with only one problem, but problems can be associated with many incidents), complete the 
following steps.

a. Open a record in the target table (example, Incident).

b. Right-click the header and select Configure  > Dictionary.

c. Open the dictionary entry for the reference field (example, Problem ID  on Incident).
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d. In the Reference Specification section, select the Reference floats  check box.

5. Click Update.

Create defined related lists

You can add default related lists to the form for all users to see when viewing records.

Before you begin
Role required: admin

About this task
For example, you may include a list of related incidents at the bottom of a problem record, or a 
list of members at the bottom of a group record. This functionality depends on reference fields 
or many-to-many table relationships. If two tables are related via the system dictionary, one can 
appear as a related list on the other.

Defined related lists allow relationships between arbitrary tables to be expressed as a related list. 
Any two tables that can have a logical relationship can appear as a parent/child pair via a related 
list. The following are some examples.

• On an incident record, show all incidents opened by the same caller.

• On a user record, show the last 20 transactions that user has made.

• On an incident record, show all problems opened on the reported CI.

These relationships are beyond the relationships normally defined in the system dictionary 
through reference fields and many-to-many relationships.

Every related list requires a relationship record. Before creating a relationship, verify that there 
is not an existing relationship record that already provides the needed information. Use the 
following steps to create a relationship record.

Procedure

1. Click System Definition  > Relationships.

2. Click New.

3. Specify the relationship record fields.
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Relationship record fields

Field Description

Name Type the name of the related list. The form configuration page displays this name 
in the list of available lists.

Advanced Select this check box to use JavaScript in place of the Applies to table  and 
Queries from table  fields.

Applies to 
table

Select the table on which the related list appears.

For example, to add a related list to the user form, select the User [sys_user] 
table.

This field is hidden in Advanced relationship records.

Queries 
from table

Select the table from which this related list retrieves data.

For example, to add related task records to the related list, select the Task [task] 
table.

This field is hidden in Advanced relationship records.

Apply to Type a script that sets the answer  variable to true  when a user opens a form on 
the desired table. This field is only visible with the Advanced  check box selected.

Query 
from

Type a script that sets the answer  variable to the name of the table from which 
the related list retrieves data. This field is only visible with the Advanced  check 
box selected.

Query 
with

Specify the records to include by typing a script.

For example:

current.addQuery('opened_by', parent.sys_id);

◦ The current  object specifies the current record on which the script is 
triggered.

◦ The addQuery  method adds a filter that returns records meeting a specified 
condition.

◦ The opened_by  variable is the field name you're querying in the table from 
Queries from table.

◦ The parent.sys_id  variable refers to the Applies to table  and the ID of the 
record being displayed.

Insert 
Callback

Type a script to run after a successful insert action. This field is only visible with 
the Advanced  check box selected.

4. Click Submit.

Add incidents by same caller related list

This example adds the existing relationship, Incidents by Same Caller, to incident forms.

Before you begin
Role required: admin
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About this task

• Applies to table: This list appears as an available related list when viewing an incident record.

• Queries from table: This list displays a list of incidents.

• Query with: This script selects records where the caller_id  matches the caller_id  of the parent 
record (the incident you are viewing).

Procedure

1. Open an incident.

2. Right-click the header and select Configure  > Related Lists.
The name of the existing relationships appears in your list of available lists.

3. Move the Incidents by Same Caller  list to the Selected  list.
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4. Click Save.

What to do next
Notes and limitations:

• Creating a record using a related list applies the list filter to the record and auto-populates the 
related field. This behavior applies to reference, string, Boolean, and menu fields when the 
criteria in the filter is set to is  or =.

• For example, if you click the New  button on one of these new relationships, the system 
attempts to ensure that the new record matches the list conditions. For example, clicking 
New  on the example list results in an incident where the caller_id  is pre-populated with Bud 
Richman.

• When scripting your condition, current  is the record to which you want to add queries while 
parent  is the main record being displayed.

• These relationships do not refresh until you update a form. In the example, if you changed the 
caller from Bud Richman  to Fred Luddy, the list at the bottom of the screen still displays the 
incidents belonging to Bud Richman until you save the incident.

• You are not limited to a single query condition. It is, for example, possible to have a related list 
of all incidents opened by the same caller in the last week, or all open  incidents opened by the 
same caller.

• The current  and parent  objects cannot be used with the Queries from  field. Instead, the gs 
object is available for GlideSystem calls.

• The Edit  button is not available on defined relationships, as the relationship is scripted.

Additional use case: You can enable a similar relationship for the Request table to display 
Requests by the Same Caller  using Requested For  on the Request table.
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Related topics

GlideSystem

Add transactions by user related list

This example adds a relationship, Last 20 transactions, to the user form.

Before you begin
Role required: admin

About this task
The new relationship creates a list of task records opened by the current user.

Procedure

1. Navigate to All  > System Definition  > Relationships.

2. Click New.

3. Create a relationship with the following values.

Option Description

Name Last 20 transactions

Applies to table User [sys_user]

Queries from table Task [task]

Queries with
current.addQuery('opened_by', 
 parent.sys_id);

4. Click Submit.

5. Navigate to User Administration  > Users.

6. Select any user.

Example 
For example, select David Loo.

7. Configure the related lists for the user form and add the related list Last 20 transactions.

8. Navigate to User Administration  > Users.

9. Select any user.

Example 
For example, select David Loo.

10. The Last 20 transactions  related list displays all task records opened by the current user.

What to do next
Notes and limitations:

• This query returns all task records opened by the user. The related list defaults to displaying 20 
task records per page.

• The parent variable refers to the Applies to table. In this case, it applies to the User [sys_user] 
table.

• Querying against a record sys_id is a common query method for relationships.
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Related topics

Add a related list to a form

Add fields to selections in a related list

When you click Edit  in a related list and select an item, information about the item appears below 
the list. You can expand the fields that appear for the item to provide more information.

Before you begin
Role required: admin

About this task

Fields listed for selected record

To add fields to selections in a related list, record the exact field name, or element, not the label 
name. This example demonstrates adding fields to the Groups  related list [sys_user_group].

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

465

https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&section=t_AddARelatedList&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&section=t_AddARelatedList&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&section=t_AddARelatedList&ft:locale=en-US


Procedure

1. Navigate to All  > System UI  > Views.

2. Select sys_ref_list.

3. To add fields from the Group table, in the Lists  related list, select sys_user_group.

4. In the List Elements  related list, click New.

5. Enter the field name and its relative position when it appears in the description.
Fields appear from top to bottom, lowest to highest number.

6. Click Submit.

Create a default filter for list selector records

You can set a default filter to restrict which related records users can select when editing a 
reference field. Default filters are simple to set up but lack a dynamic filtering element, which 
prevents the end user from changing the default filter.

Before you begin
Role required: personalize_list

About this task
A filter is used to restrict the records that are listed in the slushbucket that displays when a user 
clicks Edit  in a related list.

Procedure

1. Right-click any column heading and select Configure  > List Control.

2. Configure the List Control form to add the Edit default filter  field, if necessary.

3. In the Edit default filter  field, use the condition builder to create a default filter.

4. Select Update.
When users click the Edit  button in the related list, the list of records they can select is filtered 
according to the default filter.

Related topics

Configure reference qualifiers

Condition builder

Edit a form

You can edit a record in the form view. You can also insert a record, apply a template, and cancel 
changes to the record.

Before you begin
Role required: none

Procedure

1. Navigate to the form.
If another user is looking at the same record, you see their avatar with a green dot in the form 
header. If more than one user is viewing the record, the avatar is a number, and you can point 
your cursor to it to see the names.

2. Enter appropriate data.
Depending on system setup, the data entered in a form can affect other options on the form or 
change its appearance. For example, if you select a status of Closed  for an incident, a required 
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Close Notes  field may appear. Administrators can create custom form effects in various ways, 
including UI policies and client scripts.

3. Save the record using one of these methods:

◦ Click Submit  or Update  to save changes and return to the previously viewed page.

◦ Right-click the form header and select Save  to save changes without leaving form view.
On Core UI  forms, fields update dynamically and display a field update icon  to indicate 
changes made by other users. You can point to the field update icon to see which user made 
the update. This dynamic indication helps to prevent users from accidentally overwriting each 
other's work.

Note: 
If you entered a different value from the value saved by the other user, the system does 
not update the field automatically. Change your value manually to match value entered by 
the other user. Otherwise, you overwrite the change when you save the record.

Insert a record

Insert provides a method for creating multiple similar items, such as email notifications, users, 
groups, or business rules.

Before you begin
Role required: none

About this task
Administrators can enable the Insert  function for task records. For more information, see Allow 
insert options on task records .

Procedure

1. Open a similar item.

2. Edit the item and give it a new Name.

3. Right-click the form header and select one of the following options.

Option Description

Insert
Saves the item as a new record and returns to 
the previously viewed page.

Insert and Stay Saves and views the new record.

Apply a template in a form

Your organization may use templates to help with frequently requested tasks. A template 
contains prepopulated fields that default when the template is selected.
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Before you begin
Role required: none

Procedure

1. Navigate to the form.

2. Do the appropriate action for your version of the UI.

a. Click the more options icon ( ) in the form header.

b. Select Toggle Template Bar.

3. Select the template to apply.
If there is a conflict between the selected template and the form, a conflict message appears 
with a link to view the details of the conflict. For example, if a field that does not appear on 
the form is populated in the template, the conflict message details identify the missing field 
and the value is not set. If you have a conflict message, review the details and notify your 
administrator if necessary.
Specific fields are populated with values from the template.

4. Complete the form.
You can change any value that was populated from the template.

5. Click Submit  to create the record.

Cancel changes to a form

Cancel changes to a form by navigating away from the form without saving.

Before you begin
Role required: none

Procedure

1. Navigate away from the form view without saving the record.

2. If a message appears, click Leave this Page  to confirm cancellation.

Note: 
Administrators can disable the confirmation message by setting the 
glide.ui.dirty_form_support  property to false.

Personalize a form

When the form personalization feature is activated, users can personalize fields to appear on a 
specific form view according to individual preferences. Form personalization is available in Core 
UI.

Before you begin
Role required: itil, personalize_form, or admin

About this task
Personal form customizations do not affect what other users see on their forms.

In contrast to configuring a form, personalizing a form does not enable users to perform the 
following actions:

• Change the order of fields on the form.

• Add fields that are not configured to appear on the form.

• Hide mandatory fields.
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Note: 
Personalizing a form in this way modifies the form for you only. To make changes to a form 
that are visible to all users, you must configure the form .

Procedure

1. Open any record.

2. In the form header, click the personalize form icon.
The Personalize Form menu appears and hide field icons appear on the form.

Personalize the form

A cleared gray check box indicates fields that you previously hid.

Note: 
Only the fields that the form is configured to display are available in the Personalize Form 
menu. To add fields to the form, you must configure the form layout.

3. Clear a check box or click the hide field icon ( ) by a field.
Some check boxes are gray and selected. These check boxes indicate fields that cannot be 
hidden because they are required or are already hidden by UI policies or client scripts.
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4. Click outside the Personalize Form menu to save your changes.
If you navigate away from the form, the next time you personalize the form you must reset your 
customizations to show fields that you have hidden.

5. To restore the default form view, personalize the form and click Reset.

Related topics

Administering form personalization

Add users to a watch list

Watch lists enable you and others to subscribe to notifications of a task.

Before you begin
Role required: none

Procedure

1. Navigate to a record that you want to add watchers to.

Note: 
Not all records have watch lists. If you’re unable to see a watch list, you may need to 
adjust your form view  or ask your administrator to update the form to add a watch list.

2. Expand the watch list by selecting the lock icon ( ).

3. Select users with the list controls (see table).

Glide controls

Icon Function

Add yourself to the watchlist

Remove the highlighted user

Open the highlighted user's record (active only when a user record exists)

Open the Edit Members window to add or remove multiple users (not available until a 
record has initially been saved)

Indicates that the watch list is unlocked; select the icon to lock the watch list

Open the Users list in a new window to select a single user

Enter an email address for users who aren’t in the User [sys_user] table or don’t have an 
email address defined in their user record

Configure email notifications for watch lists

Watch lists (glide_list field type) allow multiple users to subscribe to notifications of a task. You 
can specify conditions in an email notification to send email notifications to the members when 
the conditions are met.

Before you begin
Role required: admin
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About this task
To receive these notifications, users must define an email address in their user record or enter an 
email address into the watch list email field.

Important: 
Administrators configure email notifications for watch lists.

An advanced configuration using watch lists involves placing two watch lists on a form, one 
for the general comments on a task and another for work notes or non-public comments. By 
configuring separate email notifications, separate users on each watch list can be notified about 
different information.

If users on a watch list are getting more than one email for each update to an incident, it can be 
because other recipients are replying all to an email notification. Recipients may be receiving 
email through their email system (Outlook, Groupwise, and so on) and through the base system. 
To stop this duplication, remove the names of other users from the email or the watch list.

Procedure

1. Open the notification to configure.

2. In the Who will receive section, select the icon beside Users/groups in fields.

3. Double-click Watch list  in the Available  column to move it to the Selected  column.

4. Click Update.

Related topics

Configure email notifications for watch lists

Email and SMS notifications

Hide email addresses in a watch list

You can remove the email address text entry element from a watch list by modifying the 
dictionary.

Before you begin
Role required: admin

Procedure

1. Open a task record that displays the Watch list  field.

2. Right-click the label and select Configure Dictionary.

3. In the Attributes  related list, click New.

4. Enter or select the no_email  attribute and enter true  in the Value  field.

5. Click Submit.

Result
The email entry field is hidden. Users can select users from the reference field to add to the 
watchlist.

Related topics

Altering tables and fields using dictionary attributes
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Configure order buttons on the watch list slushbucket

When you add multiple users to a glide_list, such as a watch list, the slushbucket does not 
display the order buttons for the list of selected members. You can set a dictionary attribute to 
display the order buttons.

Before you begin
Role required: admin

About this task
The slushbucket opens when the user clicks the add/remove multiple users icon.

By default, the order buttons on the right are not displayed. Follow the procedure to display the 
order buttons.

Procedure

1. Open a task record that displays the Watch list  field.

2. Right-click the label and select Configure Dictionary.
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3. Under Related Links, click Advanced view.

4. In the Attributes  field, enter maintain_order=true  separated by a comma if necessary.

5. Click Update.

Related topics

Altering tables and fields using dictionary attributes

Add and manage attachments

You can upload a file as an attachment to an incident, a knowledge article, a change request, or 
to another type of record.

Before you begin
Role required: admin

About this task
Administrators can configure attachments and how they work in the system. For more 
information, see Administering attachments .

The default maximum size limit for an attachment file that can be added to a record on the 
ServiceNow AI Platform  is 1024MB for a new out-of-box instance. If the field is left blank the 
default limit (currently set at 1GB) will be used as the maximum attachment file size.

Note: 
Do not use the Upload File  module in the System Definition  application. It is not 
compatible with multi-node instances.

Procedure

1. Navigate to the record.
For example, an incident record.

2. Click the attachments icon ( ).

3. Click Choose Files  or Browse, depending on your browser, and navigate to a file.

4. Optional:  Upload multiple files in one of the following ways.

◦ Select multiple files at the same time in the file browser. Internet Explorer does not support 
this feature.

◦ Add each file on a separate line by clicking Add Another Attachment, and then clicking 
Choose Files  on the next line. Repeat until all desired files are selected. This feature is 
available in all supported browsers.

5. Click Attach.
Attached files appear in the Current file attachments  list and at the top of the form. There are 
several common error messages that a user might receive in certain cases when attempting 
to upload an attachment to a record on a ServiceNow instance. Common examples of these 
errors are as follows.

◦ When attempting to add an attachment to a specific record, the user may receive an error 
that the file contains a prohibited file extension.

◦ When attempting to upload an attachment to a record the user receives a message a file 
type is not permitted or MIME type not matching with the actual file name.

◦ When attempting to add an attachment to a record on an instance, the user receives a file 
size error.

6. Optional:  To correct these errors, navigate to System Properties  > Security.
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a. For a disallowed file type error, attempt to save the file in a different format.
The .zip file extension is often included as an allowed file extension and a file can be 
compressed and then attached.

b. For a file type not permitted or mime type error, locate This property must be set to 
activate MIME type checking for uploads (All version Eureka and up). Enables (true) or 
disables (false) mime type validation for file attachments. File extensions configured via 
glide.attachment.extensions will be checked for MIME type during upload.  and activate 
the property by checking Yes.

Note: 
The default setting for this property on an out-of-box instance is No (unchecked).

c. For a file size error, see Manage attachments.

7. Close the pop-up window to return to the form.

What to do next
Limit the users who can view attachments by applying ACL rules. For more information on ACL 
rules, see Access control list rules .

Manage attachments

View, rename, and remove the attachments on a record and adjust the maximum allowable size 
of attachments.

Before you begin
Role required: admin

Procedure

1. Navigate to the record (example, an incident record), the existing attachment are visible at the 
top.

2. Select the attachments icon ( ) or the Manage Attachments  link if files are already attached.
The number of attachments for a record is listed on the Manage Attachments  link.

3. To add attachments, complete the following steps.

a. Select Choose Files.

b. Select the file to attach and select Open.

4. To rename an attachment, complete the following steps.

a. Select [rename]  beside the file name at the top of the form.

b. Edit the file name, move your mouse device anywhere on the screen, and press your mouse 
device once to save the changes.

Note: 
To cancel rename and return to the main screen, press the Esc key or the X.

5. To remove attachments, select the Manage Attachments  link and complete the following 
steps.
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a. Select the attachments icon ( ).

b. Select the check boxes next to the attachments.

c. Select Remove.
The attachment disappears and the pop-up window remains open.

Note: 
After a record has been closed, you can't delete the attachments for that record.

6. Close the pop-up window to return to the form.

7. To adjust the maximum allowable size of an attachment to a record, complete the following 
steps.

a. Navigate to System Properties  > Security.

b. Locate Maximum file attachment size in megabytes:  and enter the file size.

Note: 
The default maximum size limit for an attachment file that can be added to a record on 
the ServiceNow AI Platform  is 1024 MB for a new base system instance. If the field is 
left empty, the default limit (currently set at 1 GB) is the maximum attachment file size.

c. Select Save.

Attach files with drag-and-drop

You can drag files from your local computer into your browser window to attach them to the 
current record.

Before you begin
Role required: admin

About this task
This functionality is supported in Firefox 3.6 or later and Chrome. Support will be added for other 
web browsers as they implement the HTML5 specification.

Procedure

1. Navigate to the record.

2. On your computer, browse to the files to attach.

3. Select the files in the file browser, and then drag them over the form.

4. Release the mouse button to begin the upload.

When the upload is complete, the file name is added to the attachments header. Upload speed 
depends on the file size and the speed of your network connection.

Warning: 
Do not navigate away from the record while an upload is in progress. The upload must be 
completed for the file to be attached.
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Set up the Next Experience  email client in the Core UI

Access email features from the Next Experience  in the Core UI.

Before you begin
Role required: admin

About this task
The glide.ui.load_seismic_email_client  system property provides access to the 
latest email client features from the Next Experience  in the Core UI.

Note: 
You may need to rewrite on-load business rules related to the email client table. For 
example, if any business rules affect UI, you must rewrite those business rules and tag them 
to the sys_email_draft  table.

There's two places you can access the Next Experience email client from the Core UI.

• Access the email client from the More Actions menu ( ).

• Access the email client from an Activity stream  email card by selecting Reply, Reply All, or 
Forward.

The Next Experience  email client provides these features in the Core UI.

• Draft management and automatic draft saving

• Email templates, response templates, and quick messages

• Now Assist  features

These Core UI  email client features aren’t available after enabling the Next Experience  email 
client.

• Downloading or removing multiple attachments at once

• Sending S/MIME and SMS

• Customized email components

Procedure

1. Navigate to sys_properties.list.

2. Add a system property named glide.ui.load_seismic_email_client.

For more information on adding system property, see Add a system property .

3. Set the Value field to true.

4. Select Submit.

Document Viewer

Document Viewer  enables you to view documents directly in the ServiceNow AI Platform  rather 
than having to download them.

Document Viewer  supports viewing various file types in the platform including a UTF-8 character 
encoded PDF file. The maximum document file size is 50 MB. To use Document Viewer, enable it 
at instance level and for the tables for which you want to use it.

Note: 
Document Viewer  also supports FedRAMP instances.
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You can view the following file types:

• MS Word (.doc) and (.docx)

• MS PowerPoint (.ppt) and (pptx)

• MS Excel (.xls) and (.xlsx)

• PDF

• PNG

• JPEG

Note: 
The rotate option doesn’t work for images.

Other document types, for example, .zip or .exe files, are automatically downloaded without 
requiring Document Viewer. Document viewer converts word documents and spreadsheets to 
pdf first in order to view them. This might take some time to render the file the first time.

PDF view in Document Viewer

Note: 

You can only download PDF attachments with in the document.

The following table describes the icons used in Document Viewer.

Icons in Document Viewer

Icon Description

Toggle the sidebar to see a preview of all the 
pages in the document.

Download the attachment.
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Icons in Document Viewer  (continued)

Icon Description

Page up or down using the arrow buttons. You 
can also scroll or use your keyboard arrow 
keys.

Rotate the page to the right.

Rotate the page to the left.

Zoom in or out of the document.

Increase the page to the full width of 
Document Viewer.

Search for keywords in the document. Use the 
arrows to toggle to the next search result.

Related topics

View attachments with Document Viewer

Enable Document Viewer

Enable Document Viewer

Enable Document Viewer to view documents directly rather than download them to view them in 
their native applications.

Before you begin
Role required: admin

About this task
Document Viewer is enabled by default. Activate it at the instance level and then enable it 
at the table level for the tables where you want to use it. Ensure that the system property 
com.snc.documentviewer.enable_document_viewer  is set to true or create it if it 
does not already exist. To de-activate Document Viewer, create the system property 
com.snc.documentviewer.enable_document_viewer  manually and set it to false.

Procedure

1. Activate Document Viewer  at the instance level

a. Navigate to All  > System Definition  > All Available Applications  > All.

b. Enter ServiceNow Document Viewer  or com.snc.documentviewer  in the 
Search field.

c. Select Install.

2. Activate Document Viewer  for the tables where you want to use it.

a. Navigate to System Definition  > Dictionary.

b. Search for the table, open the record with the type field Collection.

c. Enter Use Document Viewer  in the Attribute  field.

d. Enter true  in the Value  field.
Document Viewer is enabled at the table level. Repeat this procedure for each table for which 
you want to enable Document Viewer.
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Related topics

Disable Document Viewer

Document Viewer  plugins

With Document Viewer, you can view documents directly in the ServiceNow  Platform rather than 
having to download them. Two new plugins enhance the experience and provide more options 
for document viewing. You can collaborate with other people, copy, delete, restore, and view 
version history directly in a ServiceNow  instance.

Overview

In previous ServiceNow  releases, not all documents could be shared and used for team 
collaboration. With new plugins for the Platform Document Viewer, now you can:

• Collaborate (edit, share) with Microsoft OneDrive  and copy documents to your ServiceNow 
instance. 

• Upload a policy document authored in your ServiceNow  instance as a Microsoft 365  document 
in Microsoft 365  SharePoint.​

• Attach shared links to a record. Clicking the link opens the document in Microsoft 365 
SharePoint.

•◦ The link can be shared with a co-worker, who can view and edit the document in real time.​

◦ The current version is also viewable in the ServiceNow  instance.​

• Use collaboration tools such as Microsoft 365  for review and co-authoring documents.​

Plugins

To use this feature, install the following plugins:

• Microsoft OneDrive  Spoke​

• Microsoft OneDrive  document service Spoke

• Microsoft Azure  AD Spoke for Integration Hub

• Multi Provider Document Service Framework

See List of plugins (Rome)  for a complete list of ServiceNow  plugins.

After installation, you can use the base system subflows or customize them. Configure the 
subflows in the Document actions table. Once configured, they can be invoked as UI actions 
from List views or can be invoked through Script Include APIs.​

Microsoft OneDrive  integration plugin

Collaborate in Microsoft OneDrive  and perform copy, delete, restore, and version 
actions on documents directly in a ServiceNow  instance. This integration is bi-
directional (performs in both directions): Changes are reflected in both Microsoft 
OneDrive  and in the instance.

Microsoft Azure AD Spoke for IntegrationHub

The Microsoft Azure AD Spoke  for Integration Hub  provides actions that a Process 
Analyst can use when designing flows. The actions allow them to automate the 
management of users, security groups, and office groups. User management 
includes applying licenses that result in user provisioning into Office 365.

Multi Provider Document Service Framework plugin (glide plugin)
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Plugin contains the data model needed to integrate with third-party document 
service providers.

Note: 
To activate a plugin:

1. Navigate to System Definition  > Plugin.

2. Enter the plugin name in the Search field.

3. Select install.

Tables

mp_provider_details

• Provider Details Name

• Provider Name

• Attributes

mp_document_version

• Version 

• Document

• Version Modified By​

• Version Last Modified​

mp_document_activity​

• Document Name​

• Document sys_id​

• Document Version sys_id

• Document Action​

• Provider Detail​

• Notes

mp_documents

• Document name​

• Provider Details

• Attachment

• URL

• Description

mp_document_action​

• document_action_name​

• provider_detail​

• subflow

• provider_permission​

mp_permission_configuration​
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• Entity_type​

• Entity_id

• Attributes

• Provider_group_id​

• Provider_group_name​

• permission

mp_provider_permission​

• permission

• provider

• Attributes

• description

mp_collaborator​

• collaborator_attributes​

• collaborator_email​

• collaborator_id​

• collaborator_name​

• Provider_detail​

• user

Related topics

Document Viewer

View attachments with Document Viewer

View documents within the platform using Document Viewer  rather than having to download 
them to your own file system.

Before you begin
Make sure that Document Viewer  is enabled for the table containing the record. For more 
information, see Enable Document Viewer.

Role required: none

About this task
Document Viewer  supports inline viewing of certain document types  within the platform.

Procedure

1. Navigate to a record (incident, form, list, and so on) with an attachment.

2. Click View next to the file attachment name.

Document Viewer  displays the document.

If the document does not display, Document Viewer  does not support inline viewing in your 
situation and a message instructs you to download the document. The possible reasons are:
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◦ The document uploaded is platform encrypted or edge encrypted.

◦ The file size exceeds the maximum allowed value of 50 MB.

◦ The document is password-protected but it is not a PDF file.

Click Download Document  to view the document in the relevant external application.

Related topics

Enable Document Viewer

Disable Document Viewer

Disable Document Viewer  at the instance level to disable it or at table level to disable it for 
specific tables within the instance.

Before you begin
Ensure the Add a system property  (com.snc.documentviewer.enable_document_viewer) exists 
in your instance.

Role required: admin

Procedure

Disable Document Viewer  at the instance level or for specific tables.

Related topics

Enable Document Viewer

Checklists

Checklists provide a simple way to track the progress of tasks without creating additional 
records. Checklists can be added to the form view of any table that extends Task [task].

For example, if a support agent is assigned an incident task to investigate a wireless issue, a 
checklist can be used to document the individual steps taken.

Checklists are added to records after they are submitted. You cannot add a checklist as you 
create a record.
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Sample checklist

Enabling checklists in forms

To enable checklists, navigate to the form and add the Checklist  formatter. For instructions, see 
Add a formatter .

Using checklists

You can add, remove, or rearrange checklist items. You can also save a checklist as a template 
for future use on other records. Any user can create or edit a checklist and check off completed 
items.

Activate checklists

Checklists are active by default on new instances. For instances upgrading from a previous 
version, the Checklist plugin must be activated.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Checklist plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Create a checklist

You can create a unique checklist for each task record. You can quickly create a checklist from a 
previously created template.

Before you begin
The Checklist formatter must be added to the form  by a user with the personalize_form role.

Role required: for the write role, read role, and delete role, the logged in user must be 
sys_created_by.

Note: 
If the Explicit roles plugin is installed, the sn_internal role is required by the Customer 
Service Management and the Vendor Risk Management plugins (and possibly others.) The 
Explicit roles plugin automatically creates the sn_internal role and assigns it to all users.

About this task
A template saves time by creating checklist items automatically. You can add, edit, or remove 
checklist items without impacting the template. You can use any checklist template, even if it was 
created on a different table.

Procedure

1. Navigate to a record that does not already contain a checklist.

2. Click the down arrow beside the Checklist  formatter.

3. Complete one of the following steps.

Option Description

To create a new checklist Select Create new.

To create a checklist by using a template

Under Create from template, select a tem­
plate. The checklist items in the template ap­
pear. Use any of the following steps to man­
age items in the checklist.

4. Click Add Item.

5. Enter text for the checklist item.

6. Press the Enter key to add the checklist item.

7. Create as many additional checklist items as desired.

8. Optional:  Click the minus (-) icon to delete a checklist item.

9. Optional:  Click the drag icon ( ) and drag a checklist item to a different position in the list.

10. Optional:  Save the checklist as a template for easy reuse.
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a. Click the down arrow beside the Checklist  formatter.

b. Select Save as Template.
A dialog box appears.

c. Enter a descriptive template name to identify the checklist.
When a user creates a checklist from a template, all templates are listed in alphabetical 
order and there is no way to filter which templates appear. To provide a better user 
experience, consider implementing a naming system for checklist templates. For example, 
include the name of the table or another identifier to clarify how the checklist should be 
used.

d. From the User Group list, select a group to limit the checklist template to.
Only members of the selected group and the user who created the checklist can use the 
checklist as a template. Leaving this field blank prevents anyone but the template creator 
from using the checklist template.

e. Click Save.

11. Save the form.

Delete checklist or a template

You can remove a checklist from a record, and delete checklist templates you no longer need.

Before you begin
Role required: for the write role, read role, and delete role, the logged in user must be 
sys_created_by.

Note: 
If the Explicit roles plugin is installed, the sn_internal role is required by the Customer 
Service Management and the Vendor Risk Management plugins (and possibly others.) The 
Explicit roles plugin automatically creates the sn_internal role and assigns it to all users.

About this task
Deleting a checklist template has no effect on checklists created from that template.

Procedure

1. To delete a checklist, navigate to the record that contains the checklist.

2. Click the down arrow beside the Checklist  formatter.

3. Select Remove Checklist.
A confirmation dialog box appears.

4. Click Delete.

5. Complete the following steps to delete a checklist template.

a. In the navigation filter, enter checklist_template.list.

b. Select the check box by the checklist template you want to delete.

c. In the actions choice list, select Delete, found at the bottom of the page.

d. In the confirmation dialog box, click Delete.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

485



Common UI elements

This page lists common UI elements for the standard user interface.

Log in to an instance

Each ServiceNow  instance has a unique, secure web address. The base URL for each instance 
has the default format: https://<instancename>.service-now.com.

Before you begin
Role required: none

About this task
Users log in to the instance from a web browser. Administrators can associate a custom URL , 
such as support.myurl.com, that resolves to point to instancename.service-now.com.

Note: 
ServiceNow  does not support any other methodologies to associate a custom or vanity 
URL. If you have a custom or vanity URL associated with an instance prior to the Madrid 
release, contact Support.

Procedure

1. Enter the base URL in any web browser.

◦ If your system uses external authentication, you are automatically logged in. For example, 
you may log in to company services when you log in to your computer.

◦ If your system does not use external authentication, the Welcome page appears.

2. Enter your user name and password.

3. Optional:  Select the Remember Me  check box to remain logged in until you manually log out.
The administrator can enable or disable this option. For more information, see Change settings 
for the Remember me check box and cookie .

4. Press the Enter key or click Login.

Navigate directly to a table

You can use commands in the navigation filter to navigate directly to the list, form, or 
configuration view of a table.

Before you begin
Role required: none

About this task
Commands work only for tables you are permitted to access.

Note: 
The table name must match the name in the dictionary entry for the table.

Procedure

1. In the navigation filter of the application navigator, enter one of the following commands.

Command Behavior

<table name>.list Opens the list view of the table in the same 
window or tab.
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Command Behavior

<table name>.form or <table name>.do Opens the form view of the table in the same 
window or tab.

<table name>.config Opens the configuration view 
[personalize_all.do] of the table in the same 
window or tab.

<table name>.filter Opens an empty list view of the table in the 
same window or tab, so that you can apply 
filters without loading the list. This is helpful 
for large lists that take a long time to load.

For example, enter change_request.form  to open a new change request.

Note: 
You can also enter any of the commands above in uppercase to open the list or form 
in a new window or tab. For example, enter change_request.FORM  to open a new 
change request in a new window or tab.

2. In Core UI, press the Enter key.

Tree picker

The tree picker is a special reference lookup that you can add as an attribute to a form. Add the 
tree picker to the classic environment or to workspaces.

The tree picker is a special reference lookup for the following items.

• Configuration Items (CIs) for a field that depends on another CI field.

• Reference elements for any hierarchical table. A hierarchical table is any table that has a 
parent field pointing back at itself.

• Values for a user reference that depends on the group.

Related topics

Reference lookup

Add the tree picker attribute

A limit of 1000 has been placed on the number of nodes returned to the tree picker. This limit is 
configurable with the glide.ui.group_heirarchy.max_nodes  property.

Before you begin
Role required: personalize_dictionary

About this task
Note: 
The tree display hierarchy does not appear in reference fields when using mobile 
applications.

Procedure

1. Open the Dictionary attributes  for the field.

2. Add tree_picker=true  to the Attributes  field.
If there are multiple attributes, use a comma to separate them without any spaces between.
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Dot-walking to data in related tables

Dot-walking provides access to fields on related tables from a form, list, or script.

If the current table contains a reference to another table, any field on the referenced table can be 
accessed using dot-walking.

Dot-walking references a field by building a chain of field names separated by dots (periods). 
For instance,  incident.assigned_to.company  references the company of the user 
assigned to an incident. The recommended limit for chain length is three levels.

Dot-walking examples

Access fields on a related table from a form, list, or script by dot-walking. This topic includes 
examples of the different ways that you can dot-walk.

List fields

You can dot-walk to related fields in a list, such as the field list in a filter. This example 
demonstrates how to filter the Incident [incident] table by the company of the caller who 
registered the incident.

When you open the list of fields that you want to filter, you see the list of available Incident table 
fields. The reference fields are followed by the related fields. For example, Caller  is followed by 
Caller  > User fields, which means that Caller  is a reference field, and the related fields are user 
fields on the Caller  record.

If the related fields are not present in the list, select Show Related Fields  at the bottom of the list. 
When you select Show Related Fields, the menu reloads to display related fields.
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When you select a related field, the menu reloads with the fields of the related table. For 
example, when you select Company  under Caller → User fields, the field then becomes 
Caller.CompanyEach selected reference is stored at the top of the fields menu, and the number 
of dots preceding the field label indicate how many dots from the initial record the user has 
reached.

The following example image shows that the user is at Incident.Caller.Company. You can return 
to higher levels in the hierarchy by selecting fields located at the top of the menu. For instance, 
selecting Incident fields  returns to the list of incident fields.

The related fields can be removed by selecting Remove Related Fields  at the bottom of the list.
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Condition builders

You can make a detailed query on a table by dot-walking in the condition builder.

To dot-walk in a condition builder, first select Show Related Fields  on the fields menu. This action 
allows you to add fields from related tables to your query.

For example, you could dot-walk fields in a condition builder to find all Incident records assigned 
to one specific user, Beth Anglin.To do so, navigate to Incident  > Open, and then open the 
condition builder. In the fields menu, selects Show Related Fields  and then open the fields 
menu again to select Assigned to → User fields. Opens the fields menu again to select Last 
name. Then, build the following condition: [Last name] [is] [Anglin]. Finally, select Run. The 
Incident list displays only the records assigned to Beth Anglin.

List collectors

When selecting a list of fields from a list collector (for example, when you're configuring a form), 
you can dot-walk to fields from other forms.

To see which fields are reference fields and can be dot-walked, look for fields with a plus symbol.
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Once a reference field is highlighted, the expand icon ( ) appears above the add icon.

Selecting the expand icon opens the list of fields from the related list in the Available  pane. The 
following example shows that the Assigned to  fields were selected. The previous lists of fields 
appear at the top of the list.

Once the field is added to the Selected  pane, it appears with its full dot-walked syntax. (For 
example, Assigned to.Active).

Scripts

You can dot-walk within a script by invoking the dot-walk syntax. This functionality requires a 
knowledge of JavaScript.

For scripts that run on the server side, such as business rules, it is necessary to add current.

The following script, for example, is a scripted approval rule that requests an approval from the 
manager of the user who opened the ticket.

try{
  current.opened_by.manager;
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}
catch(err){}

For scripts that run on the client side, such as client scripts, current  is not necessary. For 
instance, the following Highlight VIP Caller script runs on the client side.

function onChange(control, oldValue, newValue, isLoading){
  //wait until there is a valid record in the field
  if(newValue){
    //get the caller object so we can access fields
    var caller = g_form. getReference('caller_id');
    var callerLabel = 
 document.getElementById('label.incident.caller_id');
    var callerField = 
 document.getElementById('sys_display.incident.caller_id');
 
  //check for VIP status
  if(caller.vip == 'true') {
    //change the caller label to red background
    //style object is CSSStyleDeclaration, style names are not 
 standard css names
  if(callerLabel)
   
 document.getElementById('label.incident.caller_id').style.backg
roundColor = 'red';
 
  //change the caller's name field to red text
  if(callerField)
    
 document.getElementById('sys_display.incident.caller_id').style
.color = 'red';
  }
    else { //not a VIP, remove temporary styles if(callerLabel)
    
 document.getElementById('label.incident.caller_id').style.backg
roundColor = '';
 
    if(callerField)
     
 document.getElementById('sys_display.incident.caller_id').style
.color = '';
    }
  }
}

Variables

Often, you can add variables into templates, notifications, or other forms where a value is being 
called from the form.

For example, ${assigned_to}  is the variable for the Assigned to  field.

As shown in the example, you can dot-walk to fields on the original record of any reference 
field. It is possible to dot-walk to any field on the assigned_to record, for example, 
${assigned_to.manager}.

When you dot-walk, you can have a longer chain if you need it, as in this example: 
${assigned_to.department.manager.mobile_phone}.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

492



Sometimes, you can select this variable from a tree picker.

Tree pickers

The tree picker interface has an expandable, hierarchical view that you can use to look up the 
following items:

• Configuration Items (CIs) that are subordinate to another, higher-level CI.

• Members of a certain group. For example, you would use a tree picker to look up a user in the 
Service Desk group.

• Reference elements for any hierarchical table. A hierarchical table is any table that has a 
parent field pointing back at itself. The Group [sys_user_group] table, for example, would be 
considered a hierarchical table because certain groups are children of parent groups.

Note: 
You can configure the tree picker to pick up to 1,000 nodes when you configure the 
glide.ui.group_heirarchy.max_nodes  property. To set the property, open the 
Dictionary attributes  for the field, and add tree_picker=true  to the Attributes  field. If 
there are multiple attributes, use a comma to separate them without any spaces between.

Configure items on forms or in lists using a list collector

Use a list collector to add, remove, or move items in a form or list. List collectors allow you to 
select multiple items from a list of available items and to remove items from a list of selected 
items. Some list collectors provide filter and search controls for available items, such as adding 
items to related lists.

Before you begin
Role required: admin

About this task
Use list collectors to personalize lists, add items to related lists, and Service Catalog  list collector 
variables. Some list collectors allow users to customize the order of selections, such as when you 
are configuring a form or list.

The list collector interface has two columns: the available items on the left and the selected 
items on the right.

Information fields for the highlighted available item appear beneath some list collectors. The 
information fields are the same as the reference lookup for a reference field on a form. To modify 
which fields appear, configure the reference lookup list.

Procedure

• To add items to the selection, double-click an available item on the left or select an item and 
click the add icon (>).
The new item is added at the bottom of the selected items column on the right.

• To remove items from the selection, double-click the item on the right, or select the item and 
click the remove icon (<).

• To select multiple consecutive items, hold the Shift key and click the first and last item.

• To select multiple non-consecutive items, hold the Ctrl key (Command key on Mac) and click 
the desired items.

• To accessibly select multiple items, tab to each item and press the spacebar to select each 
item.
Use the arrow key or tab to the Add  button to move items from one list to another.

• To filter available items, create conditions using the condition builder and click Run filter.
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• To search available items, enter text in the Search  field.

The list of available items is filtered as you type.

• To move items one position, select the items and click the up or down icon.

• To move an item multiple positions, select consecutive items above or below the item then 
click the up or down icon.  In this example, to move Assigned to  to the top of the selections 
order, complete the following steps.

1. Hold the Shift key and click Short description  then Number.

2. Click the down icon.

Related topics

Personal lists

Set the number of list collector items visible in the available column

You can modify the glide.xmlhttp.excessive  property to change the number of items 
that appear in the Available  column of the list collector.

Before you begin
Role required: admin

Procedure

1. Add the property to the System Properties [sys_properties] table.

2. Change the Type  to Integer.

3. Enter a number in the Value  field.

Warning: 
The default value is 100. Selecting a number significantly higher than 100 can lead to 
performance issues on your instance as the data is loaded into the list collector.

4. Save the property.

Related topics

Add a property

Activity streams

An activity stream is a list of entries in records and conversations, such as journal fields, 
comments, and work notes that display in task records and Sidebar  conversations. Activity 
streams are available Core UI.

The three types of activity streams are as follows:

List activity stream

Streams live activity information for all records on the current list. For more 
information, see Activity streams in list view. You can click an item to open the 
record activity stream without opening the record.

Record activity stream

Appears in forms that are configured with the activity formatter  . You can 
customize the activities to include in this type of stream.
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When you follow a record to view it in the Connect Chat interface, the conversation 
contains the same information as the record activity stream. Comments that are 
entered in the Connect Chat window update the record activity stream.

Visual Task Board

Streams live activity information for all task cards in the current task board. You can 
click an item in the activity stream to open the task card  and view the activity stream 
of the record.

Attachments and images

You can add and preview attachments and images in the activity stream by doing the following 
actions:

• Paste an image into a journal field and enter the inline text.

• Click an attachment to preview it. Use the download option to download the attachment locally.

• Use antivirus scanning to protect against virus infections that can be introduced by file 
attachments. After being uploaded, the system automatically scans all files for viruses. If a file 
is infected, you can't view or download the file.

@ Mentions

Get someone's attention on a record by mentioning them with the @ character in an activity 
stream.

Note: 
Emails sent for @Mention run against the live_notification table and are not added to the 
journal field of the parent table.

Any user can use activity stream mentions in the following places:

• On a form, in the activity formatter  (Core UI  only).

• In a list, in the activity stream  for a record.

• On a Visual Task Board card, in the card details.

• In a Connect record conversation .

To mention someone, enter the @  character in a supported activity stream. Next, select a user 
from the suggestion list to select any user in the instance. You can see which users have access 
to the record and, if presence is enabled, who is online. Enter any other text and post to the 
activity stream. The following example shows an  Mention on a form.
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Activity stream mention on a form

By default, you receive an email notification when someone mentions you. You can disable 
this behavior by unsubscribing from the Activity Stream @Mention Email notification on your 
notification preferences .

If Connect is enabled, you can receive additional notifications, depending on whether you 
follow the record in Connect . When someone mentions you in a record that you do not follow 
in Connect, you receive whichever Connect notifications you enabled globally, as well as the 
Activity Stream @Mention Email notification. If you do follow the record in Connect, you only 
receive notifications according to your notification preferences  for the record conversation. In 
this case, you do not receive the Activity Stream @Mention Email notification.

Note: 
The system creates a record on the notification [live_notification] table each time a user is 
mentioned. The record stores the information required to generate notifications.

You can filter out emails in the activity stream, for example, auto-generated and correspondence 

emails, by selecting the . Select Post types  to check or clear the boxes of the types of emails 
and posts that display in your activity stream.
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Note: 
The activity stream displays either a user's first and last name or their user name/user id, 
depending on the system property glide.ui.activity.displayname. It is possible 
that old entries in the activity stream will display a different user name/user id for the same 
user, if the value has changed. For more information, see KB1706641 .

Create a condition statement using the condition builder

A condition builder constructs a condition statement with a series of contextually generated 
fields. Condition builders are used in many operations, such as creating filters, administering 
surveys, and administering access control.

Before you begin
Role required: admin

About this task
A condition consists of three parts: field, operator, and value.

Part Description

Field A choice list based on the table and user access rights. The choice list can include 
fields on related tables by dot-walking.

Operator A choice list based on the field type. For example, in the Incident [incident] table, 
the greater than operator does not apply to the Active  field but it does apply to the 
Priority  field.

Value A text entry field or a choice list, depending on field type. For example, in the 
Incident [incident] table, the Active  field offers a choice list with the values true, 
false, and empty, while the Short Description  field offers a text entry field.

Procedure

1. To add a dependent condition, select AND  or OR  next to the condition.

2. To add a top-level condition, select AND  or OR  on the condition builder toolbar above the 
conditions.
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3. To remove a condition, select the delete icon (X) next to the condition.

Example AND condition

Condition builder

A condition builder constructs a condition statement with a series of contextually generated 
fields. Condition builders are used in many operations, such as creating filters, administering 
surveys, and administering access control.

Condition builder format

A condition consists of three parts:

• Field: a choice list based on the table and user access rights. The choice list can include fields 
on related tables by dot-walking.

• Operator: a choice list based on the field type. For example, in the Incident [incident] table, the 
greater than operator does not apply to the Active  field but it does apply to the Priority  field.

• Value: a text entry field or a choice list, depending on field type. For example, in the Incident 
[incident] table, the Active  field offers a choice list with the values true, false, and empty, 
while the Short Description  field offers a text entry field.

The conditions display above lists in Core UI  as a breadcrumb, summarizing what you have 
selected.

Note: 
The condition builder breadcrumb in Core UI  list view can be truncated depending on the 
values of two system properties:

• glide.ui.breadcrumb_max_entries: specifies the maximum number of items 
displayed in the breadcrumb, with a default of 10.

• glide.ui.export.choice_list_max_characters: specifies the maximum 
number of characters displayed for a choice list within the breadcrumb, with a default of 
80.

For more information, see KB1962280 .
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Condition builder actions

You can add a dependent condition by clicking AND  or OR  next to the condition. You can add a 
top-level condition by clicking AND  or OR  on the condition builder toolbar above the conditions. 
You can remove a condition by clicking the delete icon (X) next to the condition.

Example AND condition in filter

For an example of a scripted filter see the KB article Creating dynamic JavaScript filters in 
reports .

Related topics

OR conditions

Filters

Dot-walking to data in related tables

Filtering on empty fields

Most filter operations do not return empty fields in their result set. You can create a filter that 
displays records with an empty field value in addition to records that match the initial filter 
conditions.

About this task
For example, when viewing all records that are assigned to the Hardware group, to include 
records with an empty Assignment group  field, complete the following steps.

Procedure

1. Create the filter condition [Assignment group] [is] [Hardware].

Note: 
This condition does not return those records where the Assignment group  field is empty.

2. Click OR  next to the original filter condition.

3. Create another filter condition of [Assignment group] [is empty].

4. Run the filter.

Values for date/time fields

When you filter on fields of type date/time, such as the Created  field on any task record, several 
time-related options are available, such as Today, This week, Last 3 months, and so on.

For example, at 12:00 on June 1, a user in New York filters a list of incidents using the Created 
on Today  condition. The resulting list shows all incidents created during the last twelve hours: 
between midnight (00:00:00) and the user's current time, noon (12:00:00), on June 1. A filter for 
This week  returns incidents created between the previous Monday at midnight to the current 
day and time.
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A filter for Last 3 months  returns incidents between midnight on the first of the month three full 
months ago and the current day and time. For example, if you choose the Last 3 months  filter 
on April 15, the results show records created since January 1 up until April 15. A filter for Last 12 
months  returns results from January to January.

A filter for Last week  returns incidents from midnight on Sunday the week previous ending 
the following Sunday at midnight. It does not include up to the present day. For example, if you 
choose the Last week  filter on Thursday August 17, the results show records created Sunday 
August 6 up until Sunday August 13.

For the at or before  and at or after  filters, use midnight as a start or end point. For example, if 
you filter a list of incidents created [at or after] [Yesterday], the resulting list shows all incidents 
created at midnight yesterday or later. If it is Thursday, August 7, and you filter a list of incidents 
created [at or before] [Last week], the resulting list shows all incidents created at and before 
midnight on Sunday August 3, which is the end of last week.

Operators and values available for date and time fields

You can filter date and time fields using the operators and values listed here.

Operators available for date/time fields

Operator Definition Example

after Returns records after the 
specified time period.

A filter run [after] [Next Month]  on April 18, 2018 
will return records from June 1 and later.

at or 
after

Returns records during and after 
the specified time period.

A filter run [at or after] [Next Month]  on April 18, 
2018 will return records from May 1 and later.

at or 
before

Returns records during and 
before the specified time period.

A filter run [at or before] [Next Month]  on April 
18, 2018 will return records from May 31 and 
earlier.

before Returns records before the 
specified time period.

A filter run [before] [Next Month]  on April 18, 
2018 will return records from before May 1.

between Returns records between to 
specified dates.

A filter run [between]  April 18, 2018 (00:00:00) 
and April 19, 2018 (23:59:59) will return records 
on or between the two dates.

is 
anything

Returns all records, including 
records with empty values in the 
specified field.

A list of incident records filtered on [Created] [is 
anything]  returns all incidents.

is 
different

Returns records within a different 
time frame from another field.

A list of incident records filtered on [Created] [is 
different] [year] from [Closed]  returns records 
where the values in the [Created]  and [Closed] 
field are in different years.

is empty Returns records where the 
specified field has no value.

A list of incident records filtered on Closed [is 
empty]  returns records where the Closed field 
has no value.

is less 
than

Returns records where a field is 
within specified time frame when 
compared to another field.

A list of incident records filtered on [Closed] [is 
less than] [2] [hours] [after] [Created]  will return 
results where the [Closed]  value is less than 2 
hours after the [Created]  value.

is more 
than

Returns records where a field is 
beyond the specified time frame 
when compared to another field.

A list of incident records filtered on [Closed] 
[is more than] [2] [hours] [after] [Created]  will 
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Operators available for date/time fields  (continued)

Operator Definition Example

return results where the [Closed]  value is more 
than 2 hours after the [Created]value.

is not 
empty

Returns records where the 
specified field has a value.

A list of incident records filtered on [Closed] [is 
not empty]  returns results where the Closed field 
has a value.

is same Returns records where the two 
fields share a specified time 
frame.

A list of incidents filtered on [Created] [is same] 
[hour] as [Closed]  returns records where the 
record [Created]  and [Closed]  fields are within 
the same hour.

not on Returns records that do not match 
the specified value.

A filter of [not on] [Today]  returns records that do 
not match the current date.

on Returns records on the specified 
value.

A filter run [on] [Today]  on April 18, 2018 will 
return records from April 18.

relative Returns records with a specified 
time frame before or after the 
current time.

A filter run on [Created] [relative] [before] [5] 
[minutes] [ago]  run at 12:00:00 returns records 
from before 11:55:00 of the same date.

trend Returns records on, after and/or 
before a specified hour of the day, 
day of the week, week of the year, 
month, quarter, or year.

A filter of [Created] [trend] [Monday]  returns 
records where the [Created]  date falls on a 
Monday.

Values available for date/time fields

Value Definition Example

Current hour/
minute

Returns records matching the 
current hour or minute

A filter run [on] [Current hour]  on April 
18 (12:02:00), would return records 
from April 18 (12:00:00) to April 18 
(12:59:59)

Last n  minutes/
hours/days/
weeks/months/
quarters/years

Returns records within the 
previous selected time period, 
starting with the beginning of that 
time frame.

A filter run [on] [Last 3 months]  on 
April 18, would return records from 
January 1 up until April 18.

Note: 
Years returns results from January 
to January.

Next n  weeks/
months/
quarters/years

Returns records within the next 
selected time period, including 
records with values up to the end 
of that time frame.

A filter run [on] [Next year]  on April 18, 
2018 will return any records with a date 
in 2019, including dates in 2019 after 
April 18.

One year ago Returns records from the current 
time, one year ago to the end of 
the current month

A filter run [on] [One year ago]  on April 
18, 2018 (12:00:00) will return records 
from April 18, 2017 (12:00:00) to April 
30 (23:59:59)
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Values available for date/time fields  (continued)

Value Definition Example

This week/
month/quarter/
year

Returns records with the current 
selected time period.

A filter run [on] [This week]  on April 18, 
2018 will return records from April 15 
(00:00:00) to April 21 (23:59:59)

Today Returns records between midnight 
of the current day and midnight of 
the next day

A filter run [on] [Today]  on April 18, 
2018 will return records from April 18 
(00:00:00) to April 18 (23:59:59)

Tomorrow Returns records between midnight 
(00:00:00) and the current time.

A filter run [on] [Tomorrow]  on April 18, 
2018 will return records from April 19 
(00:00:00) to April 19 (23:59:59)

Yesterday Returns records between midnight 
of the previous day and midnight 
of the current day.

A filter run [on] [Yesterday]  on April 18, 
2018 will return records from April 17 
(00:00:00) to April 17 (23:59:59)

Comparing field values

Field comparison allows users to evaluate equality between fields on the same table or on 
related tables by using operators in the condition builder.

Also, you can compare date type fields to determine whether the values are within a certain 
range of each other. For example, you can compare the planned start date of a task to the actual 
start date. You can use field comparisons in a list view and to generate reports.

The primary function of field comparison is evaluating whether two fields on a record or related 
record have identical values. For example, you can create a filter to display all incidents whose 
Caller  field references the same user record as the Closed by  field.

Available operators

Field comparison provides several filter operators for comparing field values.

• [is same]  if two field values are the same, evaluates to true.

• [is different]  if two field values are not the same, evaluates to true.

• [is less than]  if two date values are within a user-defined range of each other, evaluates to true.

• [is more than]  if two date values are not within a user-defined range of each other, evaluates to 
true.

Comparing choice list values

Field comparison compares the dictionary Value  field of a choice list, not the Label  value. For 
example, a high priority incident has a priority value of 1, not 1 - High. To find the Value  of a 
choice, right-click the field label and select Configure Dictionary. The Choices  related list shows 
the Value  for each choice.

Comparing empty fields

By default, most filter operations do not return empty fields in their result set. To include records 
with empty fields in a result set, add a filter condition for the left operand with an operator of [is 
empty]. For more information, see Filtering on empty fields.
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Using operators and operands

When comparing fields, the two fields being compared are called the left operand and right 
operand. The type of field selected in the left operand, and the operator selected, determine 
which right operands are available. When using the [is same]  or [is different]  operators, the right 
operand choices include only fields of the same field type, such as String  or Integer, as the left 
operand.

For example, a filter on the Task [task] table with a left operand of [Opened by]  and an operator 
of [is same], only allows you to choose user reference fields, such as the [Closed by]  field, in the 
right operand.

The [is more than]  and [is less than]  operators are only available with date type fields.

This example filter returns records where the user who opened the record also closed the record.

Example filter

Comparable fields

Field comparison supports the comparison of several fields. The fields that are comparable 
include the following types:

• String, choice, integer, and boolean fields: Return true if both values match.

• Reference fields: Return true if both reference fields refer to the same record.

• Date and time fields: Can match date values based on hour, day, week, month, quarter, or year. 
Also, you can evaluate whether two dates fall within a certain range of each other.

Note: 
Field comparison does not support journal, keyword, script, duration, list, or HTML fields.

Comparing dates

Date comparison allows you to evaluate equality between two components of the date, such as 
the hour of the day or the date within a month. Also, you can evaluate if two dates fall within a 
certain range of each other.

Date comparisons are based on the active user's time zone. For example, as a user in the PST 
time zone, a filter of [Created] [is same] [Day] as [Closed]  evaluates true for an incident created 
at 6 AM PST and closed at 3:00 PM PST as both times are within the same day. However, a user 
in the GMT time zone would not see this same incident record in response to the example filter; 
in GMT those times do not fall on the same date.

You can Evaluate equality between date values  and you can evaluate unequal dates within a 
range.

Evaluate unequal dates within a range

You can compare unequal date field values by evaluating whether two dates fall within a certain 
range of each other. For example, you can create a filter of [Created on] [is more than] [3] 
[Months] [before] Closed]  to display all records that were created at least three months before 
they were closed. The numerical value specified, such as the value 3  in the example, must be 
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an integer of no more than two digits. For evaluations of differences larger than 99 units, select a 
less granular unit of time, such as Months  instead of Days.

Unequal dates field comparison

Choice field date comparison choices

Choice field Date Comparison Choices

Operator is more than, is less than

Unit of time Hours, Days, Weeks, Months, Quarters, Years

Relative position of dates before, after, before or after

Evaluate equality between date values

Date comparison evaluates a match for one of several date increments.

Before you begin
Role required: none

About this task
You can specify granularity to the hour, day, week, month, quarter, or year. For example, the 
filter [Created on] [is same] [Week] as [Closed]  returns records that were closed in the same 
week that they were opened. When you run this type of filter, be sure to specify the year in an 
additional filter condition of [Created] [is same] [Year] as [Closed]  to eliminate records that were 
created a year before they were closed.

Date field comparison

Procedure

1. In the condition builder, create a new condition.

2. Select a date field from the left operand choice list.

3. Select [is same]  or [is different]  from the operator choice list.
An additional choice list appears.

4. Select the granularity from the date range choice list.
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Date range descriptions

Date 
Range

Description

Hour Filters on the hour of the day.

Day Filters on the day of the month, not the date. For example, a Day value of the 1 of 
August matches with a Day value of the 1 of September.

Week Filters on the week of the year. ServiceNow defines a week as Sunday through 
Saturday for the purposes of Field Comparison.

Month Filters on the month of the year. For example, any date within December returns the 
12 month of the year.

Quarter Filters on the quarter of the year.

Year Filters on the year.

5. Select a different date field from the right operand choice list.

6. Click Run.

Operators available for filters and queries

The system provides a set of operators for use with filters, condition builders, and encoded 
queries. The data type of a field determines what operators are available for it.

Operators available for condition builders

Operators available for condition builders

Operator label Example condition
Equivalent query 
operator

Example query Example output

AND [Active][is][True]
[AND][Caller][is 
not empty]

^ active=true^CallerISNOTEMPTYAll records that 
have both of the 
following:

• Active  field is 
True

• Caller  field has 
any value

OR condition [Short 
description]
[is empty][OR]
[Description][is 
empty]

^OR short_descriptionISEMPTY^ORdescriptionISEMPTYAll records that 
have at least one 
of the following:

• Short 
description 
field has no 
value

• Description 
field has no 
value
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Operators available for condition builders  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

OR filter
All these 
conditions must 
be met

[Short 
description][is 
empty]

OR all these 
conditions must 
be met

[Description][is 
not empty]

^NQ

new query

short_descriptionISEMPTY^NQdescriptionISNOTEMPTYAll records that 
have at least one 
of the following:

• Short 
description 
field has no 
value

• Description 
field has no 
value

Operators available for string fields

Operators available for string fields

Operator label Example condition
Equivalent query 
operator

Example query Example output

starts with [Short 
description]
[starts with][SAP]

STARTSWITH short_descriptionSTARTSWITHSAPAll records 
in which the 
characters 
"SAP" appear at 
the beginning 
of the value 
for the Short 
description  field.

ends with [Short 
description][ends 
with][outage]

• %

• ENDSWITH

short_descriptionENDSWITHoutageAll records 
in which the 
string "outage" 
appears at the 
end of the value 
for the Short 
description  field.

contains [Short 
description]
[contains][SAP]

• *

• LIKE

short_descriptionLIKESAPAll records 
in which the 
characters "SAP" 
appear anywhere 
in the value 
for the Short 
description  field.

does not contain [Short 
description][does 
not contain][SAP]

• !*

• NOT LIKE

short_descriptionNOT 
LIKESAP

All records 
in which the 
characters 
"SAP" do not 
appear anywhere 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

506



Operators available for string fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

in the value 
for the Short 
description  field.

is [Short 
description][is]
[Network storage 
unavailable]

= short_description=Network 
storage 
unavailable

All records in 
which the Short 
description  says 
nothing else but 
"Network storage 
is unavailable."

is not [Short 
description][is 
not][Network 
storage 
unavailable]

!= short_description!
=Network storage 
unavailable

All records in 
which the value 
for the Short 
description  field 
says anything but 
"Network storage 
is unavailable."

is empty [Short 
description][is 
empty]

ISEMPTY short_descriptionISEMPTYAll records in 
which there is no 
value in the Short 
description  field.

is not empty [Short 
description][is 
not empty]

ISNOTEMPTY short_descriptionISNOTEMPTYAll records in 
which there 
is any value 
in the Short 
description  field.

is anything [Short 
description][is 
anything]

ANYTHING short_descriptionANYTHINGAll records in 
which the Short 
description  field 
is one of the 
following:

• any value

• empty

• NULL

is empty string [Short 
description][is 
empty string]

EMPTYSTRING short_descriptionEMPTYSTRINGAll records in 
which there is no 
value in the Short 
description  field.

less than or is [Short 
description][less 
than or is][s]

<= short_descriptionlt;=sAll records in 
which the string 
in the Short 
description  field 
is one of the 
following:
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Operators available for string fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• the first letter 
is any letter 
between "a" 
and "s"

• the exact value 
is "s"

greater than or is [Short 
description]
[greater than or 
is][s]

>= short_description>=sAll records in 
which the string 
in the Short 
description  field 
is one of the 
following:

• the first letter 
is any letter 
between "s" 
and "z"

• the exact value 
is "s"

between [Short 
description]
[between][q] and 
[t]

BETWEEN short_descriptionBETWEENq@tAll records in 
which the first 
letter in the Short 
description  field 
is "q," "r," "s," or "t."

is same [Short 
description]
[is same] as 
[Description]

SAMEAS short_descriptionSAMEASdescriptionAll records in 
which there exist 
matching values 
for the Short 
description  and 
Description 
fields.

is different [Short 
description][is 
different] from 
[Description]

NSAMEAS short_descriptionNSAMEASdescriptionAll records in 
which there exist 
differing values 
for the Short 
description  and 
Description 
fields.
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Operators available for reference fields

Operators available for reference fields

Operator label Example condition
Equivalent query 
operator

Example query Example output

is [Caller][is][Don 
Goodliffe]

= caller_id=9ee1b13dc6112271007f9d0efdb69cd0All records in 
which the Caller 
is no one else but 
Don Goodliffe.

is not [Caller][is not]
[Don Goodliffe]

!= caller_id!
=9ee1b13dc6112271007f9d0efdb69cd0

All records in 
which the Caller 
field is populated 
by any user 
record but Don 
Goodliffe.

is empty [Caller][is empty] ISEMPTY caller_idISEMPTY All records in 
which the Caller 
field has no 
value.

is not empty [Caller][is not 
empty]

ISNOTEMPTY caller_idISNOTEMPTYAll records in 
which there is 
any value in the 
Caller  field.

starts with [Caller][starts 
with][Don]

STARTSWITH caller_idSTARTSWITHDonAll records in 
which the name 
in the Caller 
field begins with 
"Don."

ends with [Caller][ends 
with][liffe]

• %

• ENDSWITH

caller_idENDSWITHliffeAll records in 
which the name 
in the Caller  field 
has the letters 
"liffe" at the end.

contains [Caller][contains]
[on]

• *

• LIKE

caller_idLIKEon All records 
in which the 
characters "on" 
appear anywhere 
in the name for 
the Caller  field.

does not contain [Caller][does not 
contain][on]

• !*

• NOTLIKE

caller_idNOT 
LIKEon

All records 
in which the 
characters "on" 
do not appear 
anywhere in the 
name for the 
Caller  field.

is anything [Caller][is 
anything]

ANYTHING caller_idANYTHINGAll records in 
which the Caller 
field is one of the 
following:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

509



Operators available for reference fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• any value

• empty

• NULL

is same [Caller][is same] 
as [Assigned to]

SAMEAS caller_idSAMEASassigned_toAll records in 
which the same 
user record is 
referenced in 
the Caller  and 
Assigned to 
fields.

is different [Caller][is 
different] from 
[Assigned to]

NSAMEAS caller_idNSAMEASassigned_toAll records 
in which the 
user records 
in the Caller 
and Assigned 
to  fields do no 
match.

is empty string [Caller][is empty 
string]

EMPTYSTRING caller_idEMPTYSTRINGAll records in 
which the Caller 
field has no 
value.

is (dynamic) [Caller][is 
(dynamic)][Me]

DYNAMIC caller_idDYNAMIC54635e965f510100a9ad2572f2b4774cAll records in 
which your user 
record populates 
the Caller  field.

is in hierarchy [Manager][is 
in hierarchy]
[Manager 
Hierarchy] 
starting at [Don 
Goodliffe] which 
is [Included]

IN_HIERARCHY managerIN_HIERARCHYfdd0fa0f93f5d2505bd0bd886cba1015%409ee1b13dc6112271007f9d0efdb69cd0All records 
throughout 
the Manager 
hierarchy in 
which the 
manager is Don 
Goodliffe or a 
user reporting up 
to Don Goodliffe.

is in hierarchy 
(dynamic)

[Manager][is 
in hierarchy 
(dynamic)]
[Manager 
Hierarchy] 
starting at 
[Me] which is 
[Included]

IN_HIERARCHY_DYNAMICmanagerIN_HIERARCHY_DYNAMICfdd0fa0f93f5d2505bd0bd886cba1015%4090d1921e5f510100a9ad2572f2b477feAll records 
throughout 
the Manager 
hierarchy in 
which the 
manager is you or 
a user reporting 
up to you.
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Operators available for reference fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

Note: 
A record 
hierarchy 
between 
related 
records 
in the 
same table 
must be 
established 
before you 
can use this 
operator. 
See 
Building 
hierarchical 
queries .

Note: 
Not all operators are available for all reference types. Depending on the reference you 
select, you may see a shorter list of operators.

Operators available for choice fields containing strings

Operators available for choice fields containing strings

Operator label Example condition
Equivalent query 
operator

Example query Example output

is [Subcategory][is]
[Email]

= subcategory=emailAll records 
in which the 
Subcategory  is 
nothing else but 
Email.

is not [Subcategory][is 
not][Email]

!= subcategory!
=email

All records 
in which the 
Subcategory 
field is populated 
by any value 
except Email.

is one of [Subcategory]
[is one of][DB2, 
MS SQL Server, 
Oraclel]

IN subcategoryINdb2,sql 
server,oracle

All records 
in which the 
Subcategory 
field is populated 
by one of the 
following values:
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Operators available for choice fields containing strings  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• DB2

• MS SQL Server

• Oraclel

is not one of [Subcategory][is 
not one of][DB2, 
MS SQL Server, 
Oraclel]

NOT IN subcategoryNOT 
INdb2,sql 
server,oracle

All records 
in which the 
Subcategory 
field is populated 
by anything 
except the 
following values:

• DB2

• MS SQL Server

• Oraclel

contains [Subcategory]
[contains][Em]

LIKE subcategoryLIKEemAll records 
in which the 
characters "Em" 
appear anywhere 
in the value for 
the Subcategory 
field.

starts with [Subcategory]
[starts with][Em]

STARTSWITH subcategorySTARTSWITHemAll records 
in which the 
characters "Em" 
appear at the 
beginning of 
the value for the 
Subcategory 
field.

ends with [Subcategory]
[ends with][il]

• %

• ENDSWITH

subcategoryENDSWITHilAll records 
in which the 
characters "il" 
appear at the end 
of the value for 
the Subcategory 
field.

does not contain [Subcategory]
[does not 
contain][Em]

NOT LIKE subcategoryNOT 
LIKEem

All records 
in which the 
characters "Em" 
do not appear 
anywhere in the 
value for the 
Subcategory 
field.
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Operators available for choice fields containing strings  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

is anything [Subcategory][is 
anything]

ANYTHING subcategoryANYTHINGAll records 
in which the 
Subcategory 
field is one of the 
following:

• any value

• empty

• NULL

is same [Subcategory]
[is same] as 
[Category]

SAMEAS subcategorySAMEAScategoryAll records in 
which there 
exist matching 
values for the 
Subcategory  and 
Category  fields.

is different [Subcategory][is 
different] from 
[Category]

NSAMEAS subcategoryNSAMEAScategoryAll records in 
which there 
exist differing 
values for the 
Subcategory  and 
Category  fields.

Operators available for choice fields containing integers

Operators available for choice fields containing integers

Operator label Example condition
Equivalent query 
operator

Example query Example output

is [Impact][is][1 - 
High]

= impact=1 All records in 
which the value 
in the Impact 
field is nothing 
else but 1 - High.

is not [Impact][is not][1 
- High]

!= impact!=1 All records in 
which the value 
in the Impact 
field is anything 
but 1 - High.

is one of [Impact][is one 
of][1 - High, 2 - 
Medium]

IN impactIN1,2 All records in 
which the Impact 
field is populated 
by one of the 
following values:
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Operators available for choice fields containing integers  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• 1 - High

• 2 - Medium

is not one of [Impact][is not 
one of][1 - High, 2 
- Medium]

NOT IN impactNOT IN1,2 All records 
in which the 
Impact  field is 
populated by 
anything except 
the following 
values:

• 1 - High

• 2 - Medium

is empty [Impact][is 
empty]

EMPTY impactISEMPTY All records in 
which the Impact 
field has no 
value.

is not empty [Impact][is not 
empty]

NOTEMPTY impactISNOTEMPTYAll records in 
which the Impact 
field has any 
value.

less than [Impact][less 
than][2 - Medium]

< impact<2 All records in 
which the Impact 
field has a value 
of 1 - High.

greater than [Impact][greater 
than][2 - Medium]

> impact>2 All records in 
which the Impact 
field has a value 
of 3 - Low

less than or is [Impact][less 
than or is][2 - 
Medium]

<= impact<=2 All records in 
which the Impact 
field has a value 
of 1 - High  or 2 - 
Medium.

greater than or is [Impact][greater 
than or is][2 - 
Medium]

>= impact>=2 All records in 
which the Impact 
field has a value 
of 2 - Medium  or 
3 - Low.

between [Impact]
[between][1 - 
High] and [3 - 
Low]

BETWEEN impactBETWEEN1@2All records in 
which the Impact 
field has one 
of the following 
values:
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Operators available for choice fields containing integers  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• 1 - High

• 2 - Medium

• 3 - Low

.

is anything [Impact][is 
anything]

ANYTHING impactANYTHING All records in 
which the Impact 
field is one of the 
following:

• any value

• empty

• NULL

is same [Impact][is same] 
as [Urgency]

SAMEAS impactSAMEASurgencyAll records in 
which there exist 
matching values 
for the Impact 
and Urgency 
fields.

is different [Impact][is 
different] from 
[Urgency]

NSAMEAS impactNSAMEASurgencyAll records in 
which there exist 
differing values 
for the Impact 
and Urgency 
fields.

Note: 
The operators ‘less than or is’ and ‘greater than or is’ are not supported for integer fields in 
the condition builder. Use a scripted condition instead.

Operators available for date-time fields

Operators available for date-time fields

Operator label Example condition
Equivalent query 
operator

Example query Example output

on [SLA due][on]
[Today]

ONToday sla_dueONToday@javascript:gs.daysAgoStart(0)@javascript:gs.daysAgoEnd(0)All records in 
which the value 
for the SLA due 
field matches the 
date for today.

not on [SLA due][not on]
[Today]

NOTONToday sla_dueNOTONToday@javascript:gs.daysAgoStart(0)@javascript:gs.daysAgoEnd(0)All records in 
which the value 
for the SLA due 
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Operators available for date-time fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

field is any other 
date but today.

before [SLA due][before]
[Today]

< sla_due<javascript:gs.daysAgoStart(0)All records in 
which the value 
for the SLA due 
field is any date 
previous to today.

at or before [SLA due][at or 
before][Today]

<= sla_due<=javascript:gs.daysAgoEnd(0)All records in 
which the value 
for the SLA due 
field is one of the 
following:

• any date 
previous to 
today

• today

after [SLA due][after]
[Today]

> sla_due>javascript:gs.daysAgoEnd(0)All records in 
which the value 
for the SLA due 
field is any date 
after today.

at or after [SLA due][at or 
after][Today]

>= sla_due>=javascript:gs.daysAgoStart(0)All records in 
which the date 
value for the SLA 
due  field is one of 
the following:

• today

• any date after 
today

between [SLA due]
[between]
[Yesterday] and 
[Today]

BETWEEN sla_dueBETWEENjavascript:gs.daysAgoStart(1)@javascript:gs.daysAgoEnd(0)All records in 
which the value 
for the SLA due 
field is either 
yesterday's or 
today's date.

trend (on or after) [SLA due][trend]
[on or after]
[Monday]

DATEPART sla_dueDATEPARTMonday@javascript:gs.datePart('dayofweek','monday','GE')All records in 
which the date in 
the SLA due  field 
is on any day of 
the week except 
a Sunday.

trend (on or 
before)

[SLA due][trend]
[on or before]
[Monday]

DATEPART sla_dueDATEPARTMonday@javascript:gs.datePart('dayofweek','monday','LE')All records in 
which the date 
in the SLA due 
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Operators available for date-time fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

field is on either 
a Sunday or a 
Monday.

trend (after) [SLA due][trend]
[after][Monday]

DATEPART sla_dueDATEPARTMonday@javascript:gs.datePart('dayofweek','monday','GT')All records in 
which the date in 
the SLA due  field 
is on any day of 
the week except 
a Sunday or a 
Monday.

trend (before) [SLA due][trend]
[before][Monday]

DATEPART sla_dueDATEPARTMonday@javascript:gs.datePart('dayofweek','monday','LT')All records in 
which the date in 
the SLA due  field 
is on a Sunday.

trend (on) [SLA due][trend]
[on][Monday]

DATEPART sla_dueDATEPARTMonday@javascript:gs.datePart('dayofweek','monday','EE')All records in 
which the date in 
the SLA due  field 
is on a Monday.

relative (after) [SLA due]
[relative][after][1]
[Hours][ago]

RELATIVEGT sla_dueRELATIVEGT@hour@ago@1All records in 
which the time 
on the SLA due 
field is no more 
than an hour 
before the time 
that you entered 
the query.

relative (before) [SLA due]
[relative][before]
[1][Hours][ago]

RELATIVELT sla_dueRELATIVELT@hour@ago@1All records in 
which the time 
on the SLA due 
field is less than 
an hour before 
the time that 
you entered the 
query.

is empty [SLA due][is 
empty]

ISEMPTY sla_dueISEMPTY All records in 
which the SLA 
due  field has no 
value.

is not empty [SLA due][is not 
empty]

ISNOTEMPTY sla_dueISNOTEMPTYAll records in 
which the SLA 
due  is populated 
by any value.

is anything [SLA due][is 
anything]

ANYTHING sla_dueANYTHING All records in 
which the SLA 
due  field is one of 
the following:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

517



Operators available for date-time fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• any value

• empty

• NULL

is same [SLA due][is 
same] as [Activity 
due]

SAMEAS sla_dueSAMEASactivity_due@dayAll records in 
which there are 
matching values 
for the SLA due 
and Activity due 
fields.

is different [SLA due][is 
different] from 
[Activity due]

NSAMEAS sla_dueNSAMEASactivity_due@dayAll records in 
which there are 
differing values 
for the SLA due 
and Activity due 
fields.

is more than [SLA due][is more 
than][1][Days]
[before][Activity 
due]

MORETHAN sla_dueMORETHANactivity_due@day@before@1All records in 
which the date 
value for the 
SLA due  field 
is two or more 
days previous to 
the date in the 
Activity due  field.

is less than [SLA due][is less 
than][3][Days]
[before][Activity 
due]

LESSTHAN sla_dueLESSTHANactivity_due@day@before@3All records in 
which the date 
value for the SLA 
due  field is no 
more than three 
days prior to 
the date in the 
Activity due  field.

Operators available for numeric fields

Operators available for numeric fields

Operator label Example condition
Equivalent query 
operator

Example query Example output

is [Reassignment 
count][is][0]

= reassignment_count=0All records 
in which the 
Reassignment 
count  is nothing 
else but 0.

is not [Reassignment 
count][is not][0]

!= reassignment_count!
=0

All records 
in which the 
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Operators available for numeric fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

value for the 
Reassignment 
count  is any 
number but 0.

is empty [Reassignment 
count][is empty]

EMPTY reassignment_countISEMPTYAll records in 
which there is 
no value in the 
Reassignment 
count  field.

is not empty [Reassignment 
count][is not 
empty]

NOTEMPTY reassignment_countISNOTEMPTYAll records 
in which 
there is any 
number in the 
Reassignment 
count  field.

less than [Reassignment 
count][less than]
[2]

< reassignment_count<2All records 
in which the 
value in the 
Reassignment 
count  field is any 
number less than 
(but not equal to) 
2.

greater than [Reassignment 
count][greater 
than][2]

> reassignment_count>2All records 
in which the 
value in the 
Reassignment 
count  field is any 
number greater 
than (but not 
equal to) 2.

less than or is [Reassignment 
count][less than 
or is][2]

<= reassignment_count<=2All records 
in which the 
value in the 
Reassignment 
count  field is one 
of the following:

• a number less 
than 2

• 2

greater than or is [Reassignment 
count][greater 
than or is][2]

>= reassignment_count>=2All records 
in which the 
value in the 
Reassignment 
count  field is one 
of the following:
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Operators available for numeric fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

• 2

• a number 
greater than 2

between [Reassignment 
count][between]
[1] and [3]

BETWEEN reassignment_countBETWEEN1@3All records 
in which the 
number in the 
Reassignment 
count  is either 1, 
2, or 3.

is anything [Reassignment 
count][is 
anything]

ANYTHING reassignment_countANYTHINGAll records 
in which the 
Reassignment 
count  field is one 
of the following:

• any value

• empty

• NULL

is same [Reassignment 
count][is same] 
as [Reopen 
count]

SAMEAS reassignment_countSAMEASreopen_countAll records in 
which there 
are matching 
numbers for the 
Reassignment 
count  and 
Reopen count 
fields.

is different [Reassignment 
count][is 
different] from 
[Reopen count]

NSAMEAS reassignment_countNSAMEASreopen_countAll records in 
which there are 
differing values 
between the 
Reassignment 
count  and 
Reopen count 
fields.

greater than field [Reassignment 
count][greater 
than field]
[Reopen count]

GT_FIELD reassignment_countGT_FIELDreopen_countAll records 
in which the 
number in the 
Reassignment 
count  field is 
greater than (but 
not equal to) the 
number in the 
Reopen count 
field.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

520



Operators available for numeric fields  (continued)

Operator label Example condition
Equivalent query 
operator

Example query Example output

less than field [Reassignment 
count][less than 
field][Reopen 
count]

LT_FIELD reassignment_countLT_FIELDreopen_countAll records 
in which the 
number in the 
Reassignment 
count  field is 
less than (but 
not equal to) the 
number in the 
Reopen count 
field.

greater than or is 
field

[Reassignment 
count][greater 
than or is field]
[Reopen count]

GT_OR_EQUALS_FIELDreassignment_countGT_OR_EQUALS_FIELDreopen_countAll records 
in which the 
number in the 
Reassignment 
count  field is one 
of the following:

• greater than 
the number in 
the Reopen 
count  field

• equal to the 
number in the 
Reopen count 
field

less than or is 
field

[Reassignment 
count][less 
than or is field]
[Reopen count]

LT_OR_EQUALS_FIELDreassignment_countLT_OR_EQUALS_FIELDreopen_countAll records 
in which the 
number in the 
Reassignment 
count  field is one 
of the following:

• less than the 
number in the 
Reopen count 
field

• equal to the 
number in the 
Reopen count 
field
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Operators available for Boolean fields

Operators available for Boolean fields

Operator label Example condition
Equivalent query 
operator

Example query Example output

is [Active][is][true] = active=true All records in 
which the Active 
field is True.

is not [Active][is not]
[true]

!= active!=true All records in 
which the Active 
field is False, 
empty, or NULL.

is empty [Active][is empty] ISEMPTY activeISEMPTY All records in 
which there is 
no value in the 
Active  field.

is not empty [Active][is not 
empty]

ISNOTEMPTY activeISNOTEMPTYAll records in 
which the Active 
field is either 
True  or False.

is anything [Active][is 
anything]

ANYTHING activeANYTHING All records in 
which the Active 
field is one of the 
following:

• True

• False

• empty

• NULL

is same [Active][is same] 
as [Made SLA]

SAMEAS activeSAMEASmade_slaAll records in 
which there are 
matching values 
for the Active 
and Made SLA 
fields.

is different [Active][is 
different] from 
[Made SLA]

NSAMEAS activeNSAMEASmade_slaAll records in 
which there are 
differing values 
for the Active 
and Made SLA 
fields.
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Operators available for email notifications

Operators available for email notifications

Operator label Example condition
Equivalent query 
operator

Example query Example output

changes [State][changes] VALCHANGES stateVALCHANGESAll records in 
which the State 
field is updated.

changes from [State][changes 
from][Awaiting 
User Info]

CHANGESFROM stateCHANGESFROM4All records in 
which the State 
field is updated 
to another value 
after previously 
being Awaiting 
User Info  (4).

changes to [State][changes 
to][Awaiting User 
Info]

CHANGESTO stateCHANGESTO4All records in 
which the State 
field is updated 
to Awaiting User 
Info  (4) after 
previously being 
any other value.

Operators available for tags

Operators available for tags

Operator label Example condition
Equivalent query 
operator

Example query Example output

have [Tag][have][Most 
Active]

= sys_tags.6c361e12471331007f47563dbb9a7135=6c361e12471331007f47563dbb9a7135All records that 
have the Tag  in 
the value field.

does not have [Tag][does not 
have][Most 
Active]

DOESNOTHAVE sys_tags.6c361e12471331007f47563dbb9a7135DOESNOTHAVE6c361e12471331007f47563dbb9a7135Any records 
that has a Tag 
except for the tag 
mentioned in the 
value field.

excluding [Tag][excluding]
[Most Active]

EXCLUDING sys_tags.6c361e12471331007f47563dbb9a7135EXCLUDING6c361e12471331007f47563dbb9a7135All records with 
and without 
the Tag  except 
for the tag 
mentioned in the 
value field.

Enable or disable an application menu or module

You can enable (show) or disable (hide) an application menu or module in the application 
navigator.

Before you begin
Role required: admin

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

523



Note: 
Application menu items that are marked Read only, have a Protection Policy, or are within a 
Private scope cannot be updated.

Procedure

1. Navigate to All  > System Definition  > Application Menus.

2. If you are enabling an application menu, click All  in the breadcrumbs to display both active 
and inactive application menus (remove the default filter condition).

3. Click the desired title.
The application menu record opens and the Modules  related list shows the modules that 
appear in the application navigator.

4. Enable or disable the application menu and modules as desired.

Option Description

Enable or disable a specific module in the 
application

a. Double-click the Active  field beside the 
module name in the Modules  related list.

b. Set Active  to true  (show) or false  (hide).

Enable or disable multiple modules at the 
same time

a. Select the check boxes next to the module 
names.

b. Select Change active state  from the Ac­
tions  choice list.

Enable or disable the entire application 
menu (for example, Incident or Service Cata­
log)

Select or clear the Active  check box.

Restrict the application menu to specific 
roles

Use the Roles  field.

5. Click Update.
When you change application menus or modules, the application navigator automatically 
refreshes to display the changes.

Tags

Tags are text labels that you can associate with items like records and pages. Tags enable you 
to group and organize the items. Tags can be visible to any user (global), visible only to specific 
groups or users (shared), or visible to a single user (private).

Tags are stored in the Tag [label] table. To view tags in a list, navigate to System Definition  > Tags 
or Self-Service  > My Tags.

Tag sharing levels
The tag sharing level enables other users to use the tag. The Viewable by  property setting for a 
tag controls the sharing level.

Sharing level Description

Me Private  tag, visible only to the owner.

Groups and Users Shared  tag, visible to the owner and specific groups or users.
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Sharing level Description

Everyone Global  tag, visible to everyone. This option is available to 
users with the admin or tags_admin role.

Tag name conflicts
Conflicts can occur if multiple tags have the same name.

• If a private tag and a shared or global tag have the same name, the system appends [private] 
to the name of the private tag. For example, Sample tag [private].

• There cannot be multiple shared or global tags with the same name. If a user attempts to 
create a shared or global tag with a name that is already in use, an error message appears and 
the system prevents the tag from being saved.

Administering tags

If you have an administrator role, you can configure and manage all tags, even tags created by 
other users. You can also configure notifications, auto-assignment, and Zing indexing for tags.

You must have the tags_admin role for these administrative tasks.

Create a tag from the Tags list

You can create a tag directly from the Tags list.

Before you begin
Role required: tags_admin

Procedure

1. Navigate to All  > System Definition  > Tags  or Self-Service  > My Tags.

2. Click New.

3. Enter a name for the tag in the Name  field.

4. Optional:  Modify tag settings.

Field Description

Owner Specifies the owner of the tag. Users are allowed to change the ownership of the 
tag to someone else.

Type Specifies the type of tag.

◦ Standard:  is controlled by users who have access to the tag. These users can 
add or remove records from the tag.

◦ Most Active:  displays the most frequently accessed modules and is 
automatically maintained by the system. There is no maximum duration a 
module can remain as most active.

◦ Most Recent:  displays the most recently accessed modules and is 
automatically maintained by the system.

◦ Most Active Record:  displays the most frequently viewed records and is 
automatically maintained by the system. There is no maximum duration a record 
can remain as most active.

◦ Most Recent Record:  displays the most recently viewed records and is 
automatically maintained by the system.
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Field Description

Only tags of the Standard  or Most Recent Record  types appear on the Tagged 
Documents page.

Viewable 
by

Specifies the sharing level. By default tags are visible only to the user (Me), but 
you can share tags with Groups and Users. Users with the tags_admin role are the 
only users who can create global tags shared with Everyone.

Active Specifies whether the tag is enabled or disabled.

Edit tags from the Tags module

From the Tags module, you can edit all tags.

Before you begin
Role required: tags_admin

About this task
Note: 
Tag names are case-insensitive and must not include punctuation.

Procedure

1. Navigate to All  > System Definition  > Tags.

2. Open a tag.

3. Make the necessary changes.

4. Click Update.

Configure tags to assign automatically

Configure the system to automatically assign a tag to records that match conditions defined in 
the tag record.

Before you begin
Role required: tags_admin, however for users with the tags_admin role to be able to create 
conditions for labels, you need to create the following ACLs. Creating ACLs requires the 
security_admin elevated role. Include tags_admin as a required role for each ACL. For more 
information on creating an ACL, see Create an ACL rule .

ACLs required for the tags_admin role

Name Operation

label_table read

label_table write

label_table create

label_auto read

label_auto write

label_auto create

(Optional) label_table delete

(Optional) label_auto delete
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About this task
Use automatically assigned tags to group high urgency incidents, overdue incidents, canceled 
changes, or any other set of records. The system automatically assigns the tag to records that 
match the criteria and removes the tag from records that no longer match the criteria.

Note: 
Tags can't be automatically assigned to a record when its condition includes a dot-walked 
field.

Procedure

1. Navigate to All  > System Definition  > Tags.

2. Open the tag that you want to assign automatically.

3. Configure the form to add the Conditions for Labels  embedded list.

4. Create a row in the Conditions for Labels  list.

5. Click the reference icon in the Table  column.
The Label Table list opens in a pop-up window.

6. Click New.

7. Enter a Name, select a Table, and add conditions for the automatic assignment of the tag.

8. Click Submit.

9. Click the check mark icon to save the new row.

10. Click Update.

Configure notifications for tagged records

You can enable the system to send a notification when a record with a certain tag is updated.

Before you begin
Role required: tags_admin

Procedure

1. Navigate to All  > System Definition  > Tags.

2. Open a tag.

3. In the Label Entries  related list, open the record for which you want notifications.

4. Select the Notify onchange  check box to be notified any time the record is modified.

5. Use the Notify when  condition builder to specify the conditions that must be true to trigger the 
notification.

6. Select a business rule in the Notify script  field.

7. Save the record.

Configure Zing tag indexing for text search

Zing text indexing is available for tags on records.

Before you begin
Text indexing must be enabled for the table that you want to index tags for. For instructions for 
this procedure, see Configure a table for indexing and searching .

Role required: admin
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About this task
By default, the Zing text indexing and search engine does not index tag text for search. You can 
enable text indexing of tags on a table-by-table basis. Private tags are never indexed.

When you enable text indexing for a table's tags, Zing stores search data for the tags in its text 
index for that table. This increases the text index's size. The exact increase depends on the 
number of indexable tags present in records on the table.

Procedure

1. Navigate to All  > System Definition  > Dictionary  and edit the dictionary entry for the table you 
want to enable tag indexing for.
The dictionary entry for a table is the record with the table's name as its Table  field value, an 
empty Column name  field, and a Type  value of Collection.

2. In the Attributes related list, select New.

3. Select the Lookup using list icon ( ) to see all available attributes.

4. Select the Text Index Tags  attribute (text_index_tags).

5. For the attribute value, enter one of the following options.

Simple table

Option Description

everyone_only Only tags shared with everyone are indexed.

all_shared All shared tags (Everyone, Groups and 
Users) are indexed.

6. Select Submit.

7. In the Dictionary Entry form's Related Links section, select Generate Text Index  to reindex the 
table.

What to do next
After you turn on text indexing for tags on a table, records on the table are reindexed when any of 
the following actions occurs.

• When you add or remove tags.

• When you modify a tag, as long as fewer than 100 records are affected. If there are more 
records, you must manually reindex.

• When you manually reindex an entire table (required after initial tag indexing setup).

Assigning tags

You can assign tags to records from the form or list view. You can also add tags to a homepage. 
Tags enable you to group and organize the items.

The list view provides multiple ways of assigning tags. You can assign tags with inline field 
editing, the action menu, the context menu, or the edit tags icon.

Note: 
Tag names are case-insensitive and must not include punctuation.

Assign a tag from the list view using inline field editing

You can assign one or more tags to a record directly from the list view.
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Before you begin
Role required: none

Procedure

1. Navigate to a list.

2. Personalize the list to display the Tags  column.

3. Click in to the Add Tag  field.

4. To assign an existing tag, begin typing the tag name and select the tag from the list.

5. To create a tag, enter a new tag name.

Result
The tag is added to the record.

Assign a tag from a list using the action menu

You can assign one or more tags to a record using the action menu in a list.

Before you begin
Role required: none

Procedure

1. Navigate to a list.

2. Select the check box beside one or more records.

3. Select Actions on selected rows.

4. Scroll to the Assign tag  listing.

5. To assign an existing tag, select the tag listed.

6. To create a tag, select New, enter the tag name, select the sharing level, and then select Save.

Result
The tag is added to the record.

Assign a tag from the list context menu

You can assign one or more tags from the list context menu.

Before you begin
Role required: none

Procedure

1. Navigate to a list.

2. Select and hold (or right-click) a record.

3. To assign an existing tag, select Assign Tag  > [Tag Name].

4. To create a tag, complete the following steps.

a. Select Assign Tag  > New Tag.

a. Enter a new tag name and select the appropriate sharing level.

a. Select Save.
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Assign a tag from a form

You can assign one or more tags to a record using the More options menu in the form header.

Before you begin
Role required: none

Procedure

1. Navigate to a form.

2. Select the more options icon ( ) in the form header.

3. Select Add Tag.

4. Click in to the Add Tag  field.

5. Perform one of the following actions.

Option Description

Assign an existing tag Begin typing the tag name and select the tag.

Create a tag Enter a new tag name.

The tag is added to the record.

Editing tags

You can edit tags that you created from the list and form views, the My Tags  module, and the 
Tagged Documents page. You can also merge tags from the My Tags  module.

Note: 
Tag names are case-insensitive and must not include punctuation.

Edit tags from the list view

In the list view, you can edit tags that you created.

Before you begin
Personalize the list to display the Tags  column.

Role required: none

About this task

Procedure

1. Navigate to a list that contains records you have previously tagged.

2. Click the edit tag audience icon ( ) beside the tag name.
The Tag Details dialog box opens.

3. Edit the Name  field as necessary.

4. Select an option for the Viewable by  field to set the sharing level.

5. Click Save.
All records associated with the tag are updated to reflect the change.

Edit tags from the form view

From the form view, you can edit tags that you created.
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Before you begin
Role required: none

Procedure

1. Navigate to a record you have tagged.

2. Perform the appropriate action for your version of the UI.

3. Select the more options icon ( ) in the form header.

4. Select the edit tag audience icon ( ) beside the tag name.

5. In the Tag Details dialog box, edit the Name  field as necessary.

6. Edit the Viewable by  field to set the sharing level.

7. Select Save.
All records associated with the tag are updated to reflect the change.

Edit tags from the My Tags module

From the My Tags module, you can edit the tags you have created.

Before you begin
Role required: none

About this task
Note: 
Tag names are case-insensitive and must not include punctuation.

Procedure

1. Navigate to All  > Self-Service  > My Tags.

2. Open a tag.

3. Make the necessary changes.

4. Select Update.
All records associated with the tag are updated to reflect the change.

Edit tags from the Tagged Documents page

You can edit tags from the Tagged Documents page.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self-Service  > My Tagged Documents.

2. Select Edit Tags.
A list of tags you have created appears.

3. Open a tag.

4. Make the necessary changes.

5. Select Update.
All records associated with the tag are updated to reflect the change.
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Merge tags

You can merge one or more tags with another tag. For example, when you merge Tag A with Tag 
B, Tag A is deleted and all associated records are reassigned to Tag B.

Before you begin
Role required: A user with the admin or tags_admin role can merge any tag into any other tag.
All other users can merge tags they created into tags that are visible to them.

Procedure

1. Navigate to All  > Self-Service  > My Tags.

2. Select the check box for each tag you want to merge with another tag.

3. Select Actions on selected rows  > Merge Tags.

4. Enter the tag to merge other tags with.

5. Select OK.

Using tags

Use tags to filter records and view tagged documents. Remove a tag when it is no longer useful.

Note: 
Conditions that use the Tags  field are not supported in reports or data visualizations based 
on database views.

Filter records by tag

You can filter records on a table by tags you have access to.

Before you begin
Role required: none

Procedure

Filter records by tag in any of the following ways.

Option Description

Filter from the form view

Select the more options icon ( ), and then se­
lect the tag in the menu that opens. A new tab 
or window opens and displays a list of records 
that contain the tag.

Filter from the list view using the Tags  col­
umn

With the Tags  column visible, select the tag 
name. Selecting two or more tags filters the 
tags together with the AND operator and 
shows records containing all the selected tags.

Filter from the list view using the list filter Select the show/hide filter icon ( ), select 
Tags  from the field list and enter the tag name.

View tagged documents

The Tagged Documents page displays recently viewed documents or user-tagged documents in 
the content frame.
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Before you begin
Role required: none

About this task
An administrator can configure the fields that appear on the tagged document cards by 
configuring the mobile view of the task, for example, the mobile view of the Incident form. If 
there isn’t a mobile view available for the page, the record reverts to the default view. For more 
information, see Create and delete views.

Procedure

1. Navigate to All  > Self-Service  > My Tagged Documents.

2. Optional:  Select Show Global Tags  to display global tags.

3. Perform one of the following actions.

Option Description

Display most recently viewed 
documents

Select Most Recent  in the sidebar.

Display documents associated 
with a tag

Select the tag name in the sidebar.

Remove a tag from a record Select the x  in the corner of the document preview.

Open the form for a tagged docu­
ment

Select the title of the document preview.

Remove a tag from a record

There are many ways to remove a tag from a record.

Before you begin
Role required: none

Note: 
Anyone with access granted to a tag can add or remove the tag from a record.

Procedure

Perform any of the following actions.

Option Description

Remove a tag from a record in the list view us­
ing the Tags  column

Confirm that the Tags  column is visible and 
select the remove tag icon (x) beside the tag 
name.

Remove a tag from one or more records in 
the list view using the action menu

Select the check box for one or more records, 
then select Actions on selected rows  > Re­
move Tag:  > [Tag name].

Remove a tag from a record in the form view
Select the more options icon ( ) in the form 
header, then select the remove tag icon (x).

Remove a tag from a record in the Tagged 
Documents page

Select the removed tag icon (x) in the corner of 
the document preview.
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If a tag is automatically applied to a record based on specific conditions, the tag is automatically 
removed when those conditions no longer apply. For more information, see Administering tags.

User presence

User presence is a Core UI  feature that lets you see who is online when you are working in an 
instance.

Your avatar appears in the form header next to your name, and in multiple other places such as in 
activity streams, Visual Task Boards, live feeds, and Connect conversations. A dot on the avatar 
of the user represents online status.

• Green dot if the user is logged in.

• No dot if the user is not logged in.

• Orange dot if the user recently logged out.

Users can add an avatar image to their live feed profile. If no image is uploaded to the live feed 
profile, the avatar is the user's initials.

Note: 
Live Feed does not use images uploaded to User (sys_user) records.

When you are viewing a record in a form, such as an incident, you can see if other users are 
viewing the same record.

User presence in a form

If multiple users are viewing the record, the avatar is represented by the number of users. Point 
your cursor to the number to see the names and avatars of the users.

When you are in a Connect conversation or entering comments in an activity stream, you can see 
information about the activity of the other participant, for example if they are viewing or typing.

An administrator can disable user presence globally.

Disable user presence

You can disable user presence globally by enabling a system property.
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Before you begin
Role required: admin

About this task
Enabling the property turns off all user presence features.

Procedure

1. Navigate to sys_properties.list.

2. Locate the property named glide.ui.presence.disabled.

3. Set the Value  to true.

Disable live form features

User presence includes several new live form features for Core UI. You can show or hide these 
features using the glide.ui16.live_forms.enabled  property.

Before you begin
Role required: admin

About this task
The glide.ui16.live_forms.enabled  property is included automatically with Core UI 
(UI16) as part of the com.glide.ui.form_presence  plugin. It controls the following form 
features:

• Live form updates

• Form presence

• Activity formatter appearance

• Attachments displaying in the activity stream

Procedure

1. Enter sys_properties.list  in the Navigation filter.

2. In the system properties list, search for the glide.ui16.live_forms.enabled 
property.

3. In the Value field, type false.

Configure time intervals for user presence

User presence shows that users are viewing a record sometimes after they have already left. The 
system only checks for user presence every two minutes by default. You can allow the system to 
check more frequently by configuring some system properties.

Before you begin
Role required: admin

About this task
These properties control how often the system checks for updates or caches user presence.

• glide.ui.presence.cache_seconds

• glide.ui.presence.time_back_minutes

You can configure each property to check more or less frequently. Checking more frequently 
might slow performance.
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Procedure

1. Navigate to the system properties list by typing sys_properties.list  in the navigation 
filter.

2. Search for each of the properties to make sure they do not already exist in the list.

3. Click New.

4. To control how often the system checks for updates, configure the following property.

Time back property

Field Description

Name glide.ui.presence.time_back_minutes

Type integer

Value How often in minutes you want the system to 
check for user presence. The default number 
is 2.

5. To control how often the system caches logged in user information, configure the following 
property.

Cache property

Field Description

Name glide.ui.presence.cache_seconds

Type integer

Value How often in seconds, the system caches 
the user presence information. The default 
number is 5.

6. Click Submit.

Browser support

Browser support varies for each version of the user interface (UI). Some features have additional 
browser requirements, which are noted in the appropriate documentation.

Note: 
Starting with the Washington release, Internet Explorer and Internet Explorer mode in 
Edge  are no longer supported.

Browser support for each UI version

Browser Next Experience Workspace Core UI Service Portal

Chrome Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Firefox 
and 

Latest public 
release of Firefox 

Latest public 
release of Firefox 

Latest public 
release of Firefox 

Latest public 
release of Firefox 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

536

https://support.microsoft.com/en-us/microsoft-edge/internet-explorer-mode-in-microsoft-edge-6604162f-e38a-48b2-acd2-682dbac6f0de#:~:text=To%20turn%20on%20Internet%20Explorer,Restart%20Microsoft%20Edge.
https://support.microsoft.com/en-us/microsoft-edge/internet-explorer-mode-in-microsoft-edge-6604162f-e38a-48b2-acd2-682dbac6f0de#:~:text=To%20turn%20on%20Internet%20Explorer,Restart%20Microsoft%20Edge.
https://support.microsoft.com/en-us/microsoft-edge/internet-explorer-mode-in-microsoft-edge-6604162f-e38a-48b2-acd2-682dbac6f0de#:~:text=To%20turn%20on%20Internet%20Explorer,Restart%20Microsoft%20Edge.
https://support.microsoft.com/en-us/microsoft-edge/internet-explorer-mode-in-microsoft-edge-6604162f-e38a-48b2-acd2-682dbac6f0de#:~:text=To%20turn%20on%20Internet%20Explorer,Restart%20Microsoft%20Edge.


Browser support for each UI version  (continued)

Browser Next Experience Workspace Core UI Service Portal

Firefox 
ESR

and Firefox ESR, 
and the two 
previous releases

and Firefox ESR, 
and the two 
previous releases

and Firefox ESR, 
and the two 
previous releases

and Firefox ESR, 
and the two 
previous releases

Internet 
Explorer

Not supported Not supported Not supported Not supported

Microsoft 
Edge 
Chromium

Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Latest public 
release of the 
browser, and 
the two previous 
releases

Safari Safari 17.5 and up Safari 17.5 and up Safari 17.5 and up Safari 17.5 and up

Tablet 
Mobile

Not supported Not supported Supported Latest version of 
iOS and Safari

Latest version 
of Android and 
Chrome

Phone 
Mobile*

Not supported Not supported Not supported Latest version of 
iOS and Safari

Latest version 
of Android and 
Chrome

*Mobile phone browsers do not support the desktop version of the UI. Instead, mobile browsers 
use the mobile UI .

Firefox

The iOS version of Firefox does not support ServiceNow Community  or other Service Portal 
pages.

Core UI  keyboard shortcuts

You can use keyboard shortcuts to quickly perform common actions in the user interface.

Keyboard shortcuts are key combinations that include access keys, or keys like Control  or 
Command  that modify the action of other keys when pressed in combination. Press access keys 
in conjunction with other alphanumeric or navigation keys to perform the keyboard shortcut.

Access keys depend on the browser and operating system you are using. Available keyboard 
shortcuts are based on the UI version. The most common access key combinations are listed 
in the table. If the key combinations do not work, you may need to use a different access key 
depending on your browser and operating system.

For information about using keyword shortcuts in Next Experience, see Next Experience 
keyboard shortcuts.
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Core UI  keyboard shortcuts

Action Windows keyboard shortcut Mac keyboard shortcut

Activate global search field Alt+Ctrl+G Control+Option+G

Toggle application navigator Alt+ Ctrl+C Control+Option+C

Activate navigation filter field Alt+Ctrl+F Control+Option+F

Impersonate user Alt+Ctrl+I Control+Option+I

Navigate to the main content on the page Alt+Ctrl+P Control+Option+P

Enable keyboard shortcuts

You can enable or disable keyboard shortcuts from the system settings menu.

Before you begin
Role required: none

For a list of available keyboard shortcuts, see Core UI keyboard shortcuts.

Procedure

1. Select the user menu, and then select Preferences.

2. Select Accessibility.

3. Select or clear the Enable keyboard shortcuts  option.

4. Close the Preferences window.

Disable keyboard shortcuts globally

Keyboard shortcuts are enabled by default. You can disable all keyboard shortcuts globally or 
disable certain shortcuts using different user preferences.

Before you begin
Role required: admin

For a list of available keyboard shortcuts, see Core UI keyboard shortcuts.

Procedure

1. To disable all keyboard shortcuts globally for all users, navigate to All  > User Administration  > 
User preferences.

a. Search for the glide.ui.keyboard.shortcuts.enabled  user preference.

b. Make sure the System check box is selected.

c. Change the value to false.

d. Select Update.

2. To disable a specific keyboard shortcut for all users, navigate to the list of user preferences 
and search for user preferences ending in enabled.
For example, glide.ui.keyboard.shortcuts.<shortcut_name>.enabled.

a. Make sure the System check box is selected.

b. Change the value to false.

c. Select Update.
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Configure keys for keyboard shortcuts

Determine which shortcut key pairings users can use to access elements in an instance.

Before you begin
Role required: admin

For a list of available keyboard shortcuts, see Core UI keyboard shortcuts.

Procedure

1. Navigate to All  > User Administration  > User Preferences.

2. Search for the user preference you want to change the key combination for.
You can change any of the following options:

Keyboard shortcuts

Shortcut property Description

glide.ui.keyboard.shortcuts.global_search.key_comboEnables keyboard shortcut to activate global 
search

glide.ui.keyboard.shortcuts.impersonator.key_comboSets keyboard shortcut for impersonating a 
user

glide.ui.keyboard.shortcuts.main_frame.key_comboEnables keyboard shortcut to jump to start of 
main content

glide.ui.keyboard.shortcuts.navigator_filter.key_comboEnables keyboard shortcut to activate 
navigation filter

glide.ui.keyboard.shortcuts.navigator_toggle.key_comboEnables keyboard shortcut to expand or 
collapse navigator

3. In the Value field, change the value to one of the following combinations:
Include two access keys such as Control, Command, Alt, or Option as the start keys to any of 
the following keys. For example, ctrl+alt+p.

0, 1, 2, 3, 4, 5, 6, 7, 8, 9, a, b, c, d, e,
f, g, h, i, j, k, l, m, n, o, p, q, r, s, t,
u, v, w, x, y, z, num0, num1, num2, num3, num4, num5, num6, 
 num7,
num8, num9, f1, f2, f3, f4, f5, f6, f7, f8, f9, f10, f11, f12, 
 num,
 semicolon, equal, equalsign, comma, dash, period, slash, 
 forwardslash,
graveaccent, openbracket, backslash, closebracket, singlequote, 
 space, spacebar

4. Select Update.

User interface configuration

Change appearance, navigation menus, CSS, and utilize cutting edge interface tools.

Response time indicator

A response time indicator may appear at the bottom right of forms and in the list view for List v2.
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This indicator provides the processing time, including the total time and the time 
for each step, for a completed transaction. In List v3, the administrator can add the 
glide.ui.list_v3.client.timings.roles to allow specified roles to see the response time.

The following example shows the response time for retrieving a filtered v2 list in a demo instance.

Response time in v2 lists

The response time text is:

Response time(ms): 985, Network: 22, server: 849, browser: 114

In this example, the transaction took the following amount of processing time.

• 985 milliseconds total time

• 22 milliseconds moving data across the network

• 849 milliseconds on the server

• 114 milliseconds in the browser, rendering the HTML and parsing and executing JavaScript

Use the expand option to see more details for the response time indicator.

Response time indicator expanded

In List v3, the response time appears on the lower left for users whose role is specified in the 
system property.
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Response time in v3 lists

Response time appears on most pages. However, it does not appear for simple operations, such 
as paging through a set of records or changing the sort order of a list, or for the first transaction in 
a session.

To hide the response time in List v2 or forms, click the clock icon. Click the clock icon again to 
show the response time.

Point to the clock to view a tooltip with the response time.

To view a detailed breakdown of the browser processing time on forms, click browser.

Detailed response time information

Administrators can disable the response time by setting the glide.ui.response_time 
property to false.

Navigation stack

The navigation stack is the portion of the ServiceNow  suite of applications that determines where 
a user is redirected after the update of a record.

An administrator can cause page references to be manually inserted into the navigation stack 
when a link in the Navigation Page  is clicked. This is done by modifying a module definition 
to include an argument of  sysparm_stack  with a string value equal to the URL reference 
to the page to be inserted into the stack. The administrator can also override the redirection 
determined by the stack by creating a business rule or editing an existing one to include 
gs.setRedirect("http://redirect_page.com").

Operating parameters of the navigation stack

The navigation stack can be thought of a user's navigation history in the instance. It is updated 
every time a user views a new page. The navigation stack is referenced when users press the 
page back button. It is also referenced when a user submits or updates a record, at which point 
users are redirected to their last page in the navigation stack.
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Back and Submit or Update

Inserting pages to the navigation stack

The administrator can insert page references manually into the navigation stack when a link 
in the navigation page is clicked. The module definition is modified to include an argument of 
sysparm_stack  with a string value equal to the URL reference  to the page to insert into the 
stack. The following image shows the system definition for the Incident  > Create New  module. By 
passing an argument of "sysparm_stack=incident_list.do", the list view of incidents 
(incident_list.do) is added to the stack. After submitting an incident, the user is directed to this 
page.

Sysparm stack example

Overriding the redirection behaviors of the navigation stack with onEvent 
business rules

The redirection behaviors that occur as a result of navigation stack behaviors can be 
overridden using onEvent business rules. This override is performed by using the function 
gs.setRedirect. Doing so overrides the redirection as determined by the navigation stack, 
when the specified event occurs. The function gs.setRedirect  takes a string argument 
that is a URL for the page that the user is redirected to. This URL can be external, for example: 
gs.setRedirect('http://www.google.com').

Navigation action cancellation

The Request Manager allows users to cancel any navigation action they select from the 
application navigator by clicking another application navigator link. System properties work with 
settings for the table to allow navigation action cancellation.

This allows users to cancel slow loading transactions without having to wait for the previous 
transaction to complete.
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One of the following conditions must be true for the Request Manager to cancel a transaction.

• Both the original transaction and new transaction are cancelable (both transactions have the 
setting sysparm_cancelable=true).

• The original transaction is a member of the always cancelable allow list (the module is listed 
in the glide.request_manager.always_cancel  system property) and the new 
transaction is cancelable (has the setting sysparm_cancelable=true).

• Both the original and new transaction produce an auto-completer query in a reference field.

Cancellation workflow

The Request Manager uses the following workflow to determine whether to cancel a transaction.

Cancel navigation actions

Navigation cancellation system properties

Property Description

glide.request_manager.cancel_other_transaction Enables or disables 
automatic cancellation 
behaviors. When true, 
users can cancel one 
navigation action with 
another navigation action.

Type:  true | false

Default value:  true

Location:  sys_properties 
table

glide.request_manager.always_cancel A comma-separated list 
of URIs that users can 
always cancel by clicking 
another navigation action. 
Typically items on this list 
are modules that provide 
read-only data such as 
dashboards, reports, or 
knowledge articles.

Type:  string
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Navigation cancellation system properties  (continued)

Property Description

Default value: 
home,sys_report_template

Location:  sys_properties 
table

glide.request_manager.cancel_reference_completer Cancels a user query in 
a reference field when 
the user enters more 
information. For example, 
if the user starts an AJAX 
search in the Problem 
number field by entering 
PRB  and then enters 
PRB000, the second 
query cancels the first 
query.

Type:  true | false

Default value:  true

Location:  sys_properties 
table

Use cases

There are three use cases where administrators can control user cancellation actions.

1. A user clicks a module, such as the homepage (home.do), and while 
waiting for the module to load decides to navigate to another module, such 
as the list of open incidents (incident_list.do). The system property 
glide.request_manager.cancel_other_transaction  controls this use case.

2. A user clicks a module that displays read-only data, such as a report 
(sys_report_template.do?sysparm=sysid), and while waiting 
for the module to load decides to navigate to another module, such as 
the list of open incidents (incident_list.do). The system properties 
glide.request_manager.cancel_other_transaction  and 
glide.request_manager.always_cancel  control this use case.

3. A user starts typing a query in a reference field, such as entering PRB  in the 
related Problem field and while waiting for the auto-completer to display results, 
decides to enter more information, such as PRB000. The system properties 
glide.request_manager.cancel_other_transaction  and 
glide.request_manager.cancel_reference_completer  control this use case.

Add sites to the always cancel list

You can add UI pages or other links to the always cancel list so that users can cancel actions on 
these pages by navigating to another module or link.

Before you begin
Role required: admin
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About this task
User actions can always cancel items on the list. You should only add items to the list that 
provide read-only data to the user, such as a dashboard or a report.

Procedure

1. Enter sys_properties.list  in the navigation filter and press the Enter key.

2. In the Go to  field, select Name, enter glide.request_manager.always_cancel, and 
select Go.

3. Select the property name to open it.

4. In the Value  field, add a comma-separated list of URIs you want to allow users to cancel.

5. Select Update.

Prevent users from canceling module transactions

You can explicitly prevent users from canceling the activity of a module by updating the module 
definition.

Before you begin
Role required: admin

Procedure

1. Point to the application menu you want to add the module to and click the edit application 
(pencil) icon.

2. In the Modules  related list, click the module you want to prevent users from canceling.

3. Configuring the form layout  layout and add the field Uncancelable by Other Modules .

4. Select the check box for Uncancelable by Other Modules.

5. Click Update.

Context-sensitive help

By default, the help link available in the product opens the welcome page of the help system, 
allowing you to enter search criteria for the information you want to find. With context-sensitive 
help, you can set a base URL for an external help system. The context-sensitive system 
properties define the base URLs for the default and custom help systems.

The ServiceNow  system provides several preconfigured help contexts connected to this link 
that display the exact information you need for the current list, form, or record. You can define 
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your own help topics and configure them to appear when you click the help icon in a ServiceNow 
record.

Users click the help icon to open the default help pages provided in the base system. For any 
page that does not have context-sensitive help defined, the instance displays the help system 
welcome page. Users can use the search feature or the index to find the correct help topic. The 
location of the help icon depends on the user interface version you are using.

Core UI

Click the help icon in the right corner of the header bar and select Search Product 
Documentation  from the menu.

Context help access in Core UI

Alternatively, administrators can create custom context-sensitive help to suit the needs of their 
organizations. Create a help context that links the help icon to a topic describing a list, form, or 
specific record. You may initially want to set a base URL to direct to a help system other than the 
default ServiceNow  help system.

Set base URLs

To create numerous help contexts that direct to a single server other than the ServiceNow  help 
system, enter the base URL in the help.base.default  property.
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Base URL for custom help contexts

On the Help Context form, when the ServiceNow Product Documentation  check box is cleared 
and you enter a value in the URL or page name  field that does not contain the string ://, that 
value is appended to the base URL defined by help.base.default  property.

Note: 
When the ServiceNow Product Documentation  check box is cleared and the URL or page 
name  field contains an absolute URL (distinguished by the string ://  in the value), the 
value in the help.base.default  property is ignored. This allows you to create help 
contexts that link to several different servers.

Context-sensitive help properties

To access the context-sensitive help properties, navigate to sys_properties.list  and filter by 
Name. You can edit a property value from the list or by opening the property record.

Property Name Description Default Value

glide.help.default.page The default URL the help icon directs to when no 
help context is specified. This is the base URL of the 
ServiceNow  help system and opens to the welcome 
page. Do not change this value.

http://
servicenow.com/
docs/

help.base.default The base URL for custom help contexts in which the 
ServiceNow Product Documentation  check box is 
cleared, and an absolute URL is not specified.

When the base URL is set, the system creates the 
address of a help conext record by appending the 
target page or file name to the base URL. Custom 
help contexts using this base URL overwrite the 
help provided by default in your instance for the 
same table. For details, see set base URLs.

http://
servicenow.com/
docs/?context=

help.base.servicenow The base URL for help contexts in which the 
ServiceNow Wiki  check box is selected.

http://
servicenow.com/
docs/?context=
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Property Name Description Default Value

This is the base URL for the help provided in your 
instance by default. Do not change this value. For 
details, see Create a new help context.

Create a new help context

You can create new help contexts to supplement or replace the default help contexts. For 
example, if your organization has heavily customized a form, you might create a new help context 
for that form. The customized help context could link to more relevant information, such as a 
company knowledge base article.

Before you begin
Role required: none

Procedure

1. Navigate to All  > System UI  > Help Contexts.

2. Click New.

3. Complete the Help Context form from the fields in the table.

Help context form

Field Description

Type
Select Form, List, or Record.

If you select Record, the Table name  field is replaced by the Document 
field.

Table name
Select the table for which the help context is being defined.

If the Type  is Record, this field is replaced by the Document  field.

Note: 
The list shows only tables and database views that are in the same 
scope as the help context.

Document

Click the reference lookup icon ( ) to open the document selection dialog 
box (pictured). Select the table and document (record) for this help context.

This field is only visible if you have selected Record  as the Type.

Language
Select the language of the help page to which you are linking. The choices 
available depend on which I18n Translation plugins you have activated. For 
more information, see Activate a language .
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Field Description

This field allows you to create multiple help contexts for the same form, 
list, or record, each directing to a help page in a different language. For 
example, you might have two help contexts for Form X: one for English and 
the other for Spanish. If a user whose language is set to Spanish clicks the 
help icon while viewing Form X, the help page defined in the Spanish help 
context opens.

Active Select this check box to have the system use the help context. This check 
box is selected by default for new help contexts.

ServiceNow 
Product 
Documentation

Indicates if this help was created by a customer or was provided 
by ServiceNow. Clear this check box to create custom help for your 
organization.

Do not attempt to modify existing help topics provided by ServiceNow  for 
your own use. The system is configured to use your custom records rather 
than the default help contexts, even when they are created on the same 
table.

URL or page 
name

Identifies the topic to display when a user clicks the help icon while viewing 
a form, list, or record.

You can enter the complete URL of the help page or just the target file name 
if you set a base URL  in the help.base.default  system property.

Note: 
If you reconfigure the fields on the form, you see the available fields Plugin ID  and 
System Property Base URL. Do not use these fields. They are for internal use only.

4. Click Submit.

Related topics

Context-sensitive help

Help context types and prioritization

You can create a help context with the type Form, List, or Record, and link it to a particular table 
in your ServiceNow  instance. If you have multiple help contexts, prioritization determines which 
help contexts apply to what a user views.

Help context types

When a user clicks the help icon, the system analyzes the relevant help contexts to determine 
which help page to display.

• Record-level help applies to only one specific record, not the list or form for that table.

For example, if a Record  type help context exists for the Validate Number  record in the 
Business Rule table, the help icon only directs to the page specified when a user views that 
record.

• List-level help applies to the list for a table. If no form-level help is defined, list-level help also 
applies to the form for the same table.
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For example, if a List  type but not a Form  type help context exists for the Business Rule table, 
the help icon directs to the page specified by the List  type help context when a user views any 
list or record (if record-level help is not defined for it) in the Business Rule table.

• Form-level help applies to the form for a table. If no list-level help is defined, the form-level help 
also applies to the list for the same table.

For example, if a Form  type but not a List  type help context exists for the Business Rule table, 
the help icon directs to the page specified by the Form  type help context when you view any 
record (if record-level help is not defined for it) or list in the Business Rule table.

• If both list- and form-level help are defined for a table, the appropriate help is displayed for the 
list and the form.

For example, if a List  type and a Form  type help context exist for the Business Rule table, the 
help icon directs to the page specified by the List  type help context when a user views the 
Business Rules list. The help icon directs to the page specified by the Form  type help context 
when a user views any record (if record-level help is not defined for it) in the Business Rule 
table.

Important: 
If you create a help context for a base table list or record, the help system opens that target 
topic for any list or record in a table that extends the base table if no other help context is 
created in that extended table.

Help context prioritization

When there are several matching help context records, the following rules determine which help 
context is used, in descending order of priority.

1. A customer-created help context is used instead of a default help context provided in the 
instance for the same table.

2. A help context that matches the user's language setting is used instead of a help context in the 
default language of the instance. See the Language  field on the Help Context form.

3. A help context for a closer table in an extended table hierarchy is used instead of a help 
context for a further table.

Consider the case of the Linux Server [cmdb_ci_linux_server] table, which has the following 
parentage: cmdbi_ci > cmdb_ci_hardware > cmdb_ci_computer > cmdb_ci_server > 
cmdb_ci_linux_server. If help contexts exist for both the cmdb_ci_server table and the cmdb_ci 
table, the help icon directs to the page specified by the cmdb_ci_server help context when you 
view a record in the cmdb_ci_linux_server table.

Overview help pages

The overview help feature included with the base system displays slides with introductory 
information on new features offered in the ServiceNow®  platform. An administrator can hide the 
option from the help menu.

To learn about the latest features in your version, click the What's New  link in the Core UI  help 
sidebar.
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Overview help link

The Overview Help Page [sys_ui_overview_help] table contains the records for each panel that 
appears, including images, icons, descriptions, and condition statements that control display. 
By default, the instance displays panels describing notable features of the current release, but 
users can modify this page to display panels for customized features in their own instance and 
then define who can see these panels.

Users scroll through the panels by clicking the buttons provided or by clicking the directional 
arrows at the bottom of the page, depending on how the page was configured.

Note: 
Administrators can edit the default help page to modify, add, or delete existing panels from 
this page to match the features in your system.

Overview help slide

Hide the What's New option

Administrators can hide the What's New option using a system property.

To find the property, type sys_properties.list  in the application navigator. Find the 
glide.product.show_what_is_new  property and change the value to false.
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What's New option hidden

Create custom overview help

You can edit existing overview help pages to display your own custom panels to selected users.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > Overview Help  and edit the help page for your version.

2. Modify the Overview Help Page form using the fields in the table.

Overview help page fields

Field Description

Title Unique title of this page.

Subtitle General introduction for the subject of 
this page. This content appears as the 
description of the first panel that users see.

Application Scope of this help page. All overview help 
pages are created in the global scope, so that 
they are visible from anywhere in the system. 
This field is read-only.

3. Save the page.

4. Click New  in the Overview Help Panel  related list and complete the form using the fields in the 
table.

5. Click Submit.

Overview help panel fields

Field Description

Title Unique name for this panel. This name is the 
title of the panel shown to users.

Page Names the overview page to which this panel 
is connected.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

552



Field Description

Order Controls the sequence of the panels in the 
page. When using icon buttons, the button for 
the lowest order number appears on the left, 
and the button for the highest order number 
appears on the right. When icon buttons are 
disabled, the lowest order number panel 
begins the scrolling sequence.

Roles Names all the user roles that are entitled to 
see this panel.

Condition Defines the conditions under which this 
panel is viewable. For example, you can 
configure this panel to display only when a 
specific plugin is activated.

Image Background image to use when this panel is 
displayed. Supported image formats are:

◦ .jpg

◦ .png

◦ .bmp

◦ .gif

◦ .jpeg

◦ .ico

◦ .svg

Icon Icon used as the access button for this 
panel from the page. This field is read-only. 
You cannot specify an icon for your custom 
panels.

Is title Controls the display of the title on the initial 
slide. The field is not used for panels.

Show title Controls the display of the title on the initial 
slide. This field is read-only and is not 
available for panels.

Text Text describing what is shown in the image 
for this panel. This content appears below the 
panel title.

Example of adding a panel to an existing overview help page

This example adds panels to the existing overview help page that display only for users with 
specific roles and when a specific plugin is activated.

Before you begin
Role required: admin

About this task
You can create a panel that displays a screenshot of auditing gauges to users with the 
sn_audit.manager role, when the GRC: Audit Management plugin is activated. Create another 
panel visible only to users with the activity_admin role that displays a view of the Custom  tab 
in the Workflow Editor. Add the panels to the overview help page for the current version. Use 
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the condition on a panel to specify the plugin and a slushbucket to select the roles required for 
access.

Procedure

1. Navigate to All  > System UI  > Overview Help.

2. Open the help page for the current version.

3. In the Overview Help Panels  related list, click New.

4. Create a panel with these values:

◦ Title: Custom Orchestration Activities. The title is the label that appears on the panel when 
it is displayed to the user.

◦ Order: 20. This order number is the lowest for any of the panels in this page, and means that 
this button appears on the left side of the page.

◦ Roles: activity_admin. Only users with this role are able to see this panel.

◦ Image: This is a view of the Workflow Editor and the Custom  tab that best introduces the 
feature to users.

◦ Text: Enter a description of the feature, emphasizing the highlights in this version. In this 
example, the text describes the ability to create activities and share them in the ServiceNow 
store.

Note: 
Buttons for custom panels do not have icons on them.

5. Save the record.

6. Create another panel with these values:

◦ Title: Assessment Reports.  The title is the label that appears on the panel when it is 
displayed to the user.

◦ Order: 60. This order number is the highest for any of the panels in this page, and means 
that this button appears on the right side of the page.

◦ Roles: assessment_admin. Only users with this role are able to see this panel.

◦ Image: This is an example of a bubble chart that you want the assessment administrators to 
see.

◦ Text: Enter a description of the chart to display to the users, emphasizing the advantages of 
this type of chart.

7. Save the record.

8. Log in as a user with the assessment_admin role.

9. Click the help icon in the form header, and then click What's New  in the help sidebar.
The overview help page for the current version appears, with the control button for the auditing 
dashboard displayed for the user in the order configured.

10. Click the button to display the assessment report panel.
The image you selected for your custom panel appears with the title and description you 
defined.

11. Log out and log in again as a user with the activity_admin role.

12. Click the help icon in the form header, and then click What's New  in the help sidebar.
The overview help page for the current version appears, with the control button for the 
Workflow Editor tabs displayed for the user in the order configured.
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13. Click the button to display the Orchestration activities panel.
The image you selected for your custom panel appears with the title and description you 
defined.

System user guide

The system user guide enables you to create end user help documentation that is specific to the 
policies and procedures of your organization. A default help page is provided in the base system 
that displays Core UI  help documents for system navigation and other basic operations.

The user guide provides the tools for designing help portal pages containing feature-specific 
help documents. You can create custom help pages and deploy them in various ways using 
controls in the system. User guide documents are grouped in relevant sections on a help page, 
using a two-column format. You can display the sections and the documents within them in any 
order. You can display a section on more than one help page. The user guide is supported in 
Core UI .

A default help page is provided in the base system that displays help documents for system 
navigation and other basic operations. This page is accessible from the help icon in the header 
bar for Core UI  users. To make this page available to users of other supported UI versions, you 
must create a programmatic entry point.

Note: 
The default help page can be used as a template for your own help content. To personalize 
pages, sections, or documents in the User Guide, simply edit the ServiceNow®  records 
to suit your needs. Remember that any records you customize are not updated when you 
upgrade your instance to a new version. Review any changes on a development system first 
and then decide whether to accept the updated content into your customized User Guide.

Create user guide help

User guide help documents are grouped in appropriate sections on the page and listed in a 
configurable order. Add your sections to a help page.

Before you begin
Create all your help documents from within the section record. This allows you to refine their 
titles, adjust their placement, and decide if they are appropriate for the section.
Role required: admin

Procedure

1. Create a page.

a. Navigate to System User Guide  > Administration  > Help Pages  and click New.

b. Complete the form.

Help page field definitions

Field Description

ID Page identification used by the system to create a help URL.

Application Application scope for this help page. This field is read-only and defaults to the 
Global  scope.
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Field Description

Title Display title for this page.

c. Click Submit.

2. Create help page sections and associate them with the page.

a. Navigate to System User Guide  > Administration  > Help Page Sections  and click New.

b. Give your section a unique and concise title, and then click Submit.
The view returns to the list of sections.

c. Create additional sections for your help page.

d. Navigate to System User Guide  > Administration  > Help Pages  and open your new page.

e. In the Page to Sections  related list, click New.

f. Complete the form.

Page to Section field definitions

Field Description

Column Column location on the page for this section. The first column is designated 
as 0  and the second column is designated as 1. There must be at least one 
entry for column 0  for the sections to display.

Order Order in which the sections display in the columns on the page. If no order 
number is defined, the system lists the sections in alphabetical order.

Application Application scope for this record. This field is read-only and defaults to the 
Global  scope.

Page Help page on which this section appears. You can use the lookup field to 
change the page on which a section appears.

Section Name of the section to display on the selected page.

g. Click Submit.

h. Optional:  Add sections to the help page as needed.

3. Create one or more documents.

a. Navigate to System User Guide  > Administration  > Help Page Sections.

b. Open a section record you created.

c. In the Help  related list, click New  to create a help document for that section.

d. Complete the form.
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Help document field definitions

Field Description

Number Document number generated automatically by the system.

Section Section in which this document appears.

Order Listing order for this document in the selected section.

Published Date this document was created.

Updated Date this document was last updated.

Short 
description

Brief description of the content of this document. This description is used as 
the title for the document on the help page.

Text Document content, including graphics and tables. You can format your entry, 
create bulleted or numbered lists, and attach images.

e. Click Submit.

f. Repeat the process to create the necessary help documents for that section.

User guide help URLs

You can create entry points in your instance for help generated with the system user guide by 
providing the correct address parameters in the target URL.

Help pages generated with the user guide can be displayed to end users from configurable 
entry points in the system, including application modules and UI actions . To create these entry 
points, you must express a target URL using these parameters:

URL entry points for displaying user help

Parameter Provides

$h.do Processor that renders the banner frame at 
the top of the page.

$sys_product_help.do Displays a page containing links to all the 
help in the user guide. This includes the basic 
help system and any custom help pages 
you have created. An example URL would 
be https://myinstance.service-
now.com/$sys_product_help.do.

$h.do?sysparm_id=basics Displays the basic help page included with 
the system. To create a target for a custom 
user guide, replace id=basic  with the ID 
for your custom page, such as id=surveys. 
An example of this would be https://
myinstance.service-now.com/
$h.do?sysparm_id=surveys.

$h.do?sysparm_doc=<document number> Displays help for a specific document. 
This URL displays the help document in 
the basic page that provides instructions 
for using ServiceNow  forms: https://
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URL entry points for displaying user help  (continued)

Parameter Provides

myinstance.service-now.com/
$h.do?sysparm_doc=DOC0010005.

Manage audio files

You can upload and store .mp3  or .ogg  audio files. Once uploaded, you can reference audio 
files using HTML.

Before you begin
Role required: image_admin

About this task
The Database Storage for Audio Files (com.glide.db_audio) feature must be activated to store 
audio files. The plugin is activated by default on new instances. For upgraded instances, you can 
activate the plugin if you have the admin role. For more information on activating a plugin, see 
Activate a plugin .

Procedure

1. Navigate to All  > System UI  > Audio Files.

2. Click New.

3. Enter a Name  for the audio file, including the file extension.

4. Add the Audio  file.

5. Save the record.

6. Optional:  Complete the following steps to reference audio files using HTML.

a. Use the <audio>  HTML tag and set the src  attribute to the name of the file as set by the 
Name  field of the Audio record.

b. Use the controls  attribute to display the audio controls.

Example 
Use the following HTML.

<audio src="Beep.mp3" title="Beep" control="control"/>

Storing images in the database

Administrators and users with the image_admin or content_admin role can upload and store 
images in the database. These images are saved in the Images [db_image] table. Uploading an 
image to the database allows it to be referenced from HTML fields by appending the name of the 
image to the URL of the instance.

Note: 
The db_image table is a public table that does not have any security restrictions. 
Unauthenticated users have full access to images uploaded to the db_image table.

Images vs attachments

If you want to access an image from a record, or if you want to prevent users from appending the 
image name to the URL of the instance, upload it as an attachment instead. When you upload 
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an image as an attachment, the image is saved in the Attachments [sys_attachment] table. See 
Administer attachments  and Add and manage attachments  for more information.

Acceptable image file types

Upload image files with the following extensions:

• .gif

• .jpg

• .png

• .bmp

Note: 
The system does not support uploading zip files that contain .bmp images.

If you upload an image that may not be supported in Internet Explorer browsers, a warning 
message appears.

The system does not support uploading images in the .ico format through this interface. 
Microsoft  Internet Explorer requires the .ico format for favorite icons. To upload an .ico image, 
attach the .ico image to a record instead of using the standard image upload interface.

To understand how to insert an image into a form record, see the Insert an image into your article, 
incident, or other form record  blog post in the ServiceNow Community.

Update an existing image

You can change an existing image to an updated version.

Before you begin
Role required: image_admin or content_admin

Procedure

1. Navigate to All  > System UI  > Images.

2. In the Images list, click the name of the image to be replaced.

3. In the Image  field, click the [Update]  link.

4. Click Browse  and navigate to the desired image file.

5. Click Open, and then click OK.

The new file is uploaded into the instance database, replacing the previous file. It is used in all 
locations that reference the file name.

Note: 
If the new image does not appear as expected, clear the browser cache.

Upload one or more images

You can upload one image or multiple images at one time.

Before you begin
Role required: image_admin or content_admin
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Procedure

1. To upload one image at a time, complete the following steps:

a. Navigate to System UI  > Images  to see the list of images stored in the database.

b. Click New  to add a new image.

c. Complete the form.

Images form

Field Input

Name Enter the file name by which to reference the image in HTML.

Active Select the check box to allow the image to be referenced in HTML.

Category Select a category in which to organize the image file.

Image Select Click to add...  to upload an image. If an image is already 
uploaded, click [Update]  to upload a new version of the image or 
[Delete]  to remove the image.

Format, Size 
bytes, Height, 
and Width

View current image metadata. This information is automatically 
populated when the image is uploaded.

2. To upload multiple images at once, complete the following steps:

a. Create a .zip file that contains only acceptable image file types.

Note: 
The system does not support uploading zip files that contain .bmp images.

b. Navigate to System UI  > Image Zip Upload.

c. Click Choose File  then select the file.

d. Click Upload.

A message indicates that the files are uploaded to the database, and the images list is sorted 
by updated date in descending order (the uploaded images appear first).

Note: 

◦ If the .zip file contains a folder structure, the resulting image names are the path name 
with underscores in place of the slashes. For example, if the .zip contains myimages/
image1.gif then the resulting image is named myimages_image1.gif.

◦ Image names cannot exceed 100 characters in length, including folder structure. Files 
with excessively long names are rejected.

◦ Uploads are logged in the system. View system logs to see whether files are uploaded 
or rejected.

Related topics

System log
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Restrict file extensions

Use the glide.ui.strict_content_types to restrict the image file extensions that appear in the UI.

Before you begin
Role required: admin

Procedure

1. Enter sys_properties.list  in the Navigation filter.

2. Verify that the property does not exist by searching for the property name.

3. Click New.

4. Complete the system property using the following table.

File extension system properties

Field Description

Name glide.ui.strict_content_types

Type string

Value Comma-separated list of acceptable image 
file names. Use any of the following file types: 
ico,gif,png,jpg,jpeg,bmp,js,css,htm,html,ogg,mp3,eot,woff,woff2,svg,ttf,swf,cur,map

Note: 
Any files that use a file extension that is not included in the list of values appear broken in 
the UI.

User preferences

Users can configure many UI features, such as the number of rows per page in a list or whether 
the response time displays at the bottom of a list or form. Administrators can modify or delete 
these preferences as needed.

User customizations are stored as records in the User preferences  [sys_user_preference] table, 
and are updated each time the user changes the setting. The UI displays according to each 
user's preferences.

For example, the response time may appear at the bottom of lists and forms by default. If a user 
hides the response time, a user preference record is created for them showing that the response 
time indicator as hidden. During the user's future sessions, the response time indicator is hidden. 
If the user later decides to display the response time, the user preference record is updated 
appropriately, and future sessions open with the response time indicator visible.

For more information about the preferences available to users, see User preference settings  and 
Next Experience preferences.

Viewing and troubleshooting user preferences

Navigate to User Administration  > User Preferences  for a list of user preference records. Select 
a preference name to display that preference in the form view. If troubleshooting for a user, 
search for their user name to find all of their customizations, and then select a preference name 
to view.
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Note: 
Up to 10,000 user preferences can exist for each user. Exceeding this limit causes system 
degradation and UI performance issues.

User preference fields

Field Description

Name The name of the feature or functionality.

Description An optional short description of the feature or functionality.

System Shows whether this record indicates the system-wide default (TRUE), or not 
(FALSE).

Type Shows the data type of entry accepted for the Value. For example, you can select 
string  or integer.

User Shows the name of the user for whom the setting is customized. If User  is empty, 
the record is for a system-wide default.

Value The current setting for this record. Compare this value to the User  field and 
System  field to determine whether the value shown is a system-wide default or a 
specific user’s preference.

You can identify user preference records for system-wide values, also called the default or global 
values, by the following values:

• System=TRUE

• User=blank

Whenever a user customizes a feature, a separate user preference record is created with the 
following values:

• System=FALSE

• User=<username>

As a result, the same customizable UI feature may have multiple user preference records.

Note: 
For some features, the system-wide record doesn’t appear in the User preferences  module 
until a user customizes it, causing a new record to be added to the User preferences.

If a user encounters an unexplained behavior in the user interface, you can check their user 
preferences by searching the User preferences  list for their user name. Then, delete or update 
the user preference record that affects the behavior in question.

Note: 
When an administrator manually changes a user's preference value through this module, 
the user's next session uses the administrator's setting. However, the user can customize 
the features again through the UI, which updates their user preference record. If the 
administrator deletes the user preference record for a particular user, that user's next 
session uses the system-wide value for that feature. When the user later customizes the 
feature, the system creates a user preference record for the user.
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Global user preferences

Create system-wide or global user preferences to set a default preference for your users. To 
make a preference the default, create a preference, check the System  check box, and leave the 
User  field empty.

Important: 
You should never have more than one preference with the same name set as a global user 
preference.

User preferences and update sets

User preference records for system-wide values, also called the default or global values, are 
stored in update sets. Any changes are implemented when you import the update set and affect 
all users who have not customized the feature. User preference records for specific users aren’t 
stored in update sets, so user customizations are retained when you import an update set. For 
more information, see System update sets .

User preference settings

User preferences primarily track the way individual users interact with various features so that 
new sessions activate the user's last settings. For example, user preferences track whether the 
user activates the tabbed or scrolling interface for multi-section forms. Other user preference 
records enable users with the admin role to adjust certain feature settings.

View settings

To view the user preference settings, navigate to User Administration  > User Preferences.

User preference list

This table describes user preference records in the base system.

User 
preference 
record

Description

User Only User action sets and updates the value. Manual changes through the User 
Preference record don't affect the user experience.

Admin 
Only

The administrator can change the value through the User Preference record to 
modify the user experience.

Admin or 
User

User action sets and updates the value, but the administrator can change the user 
experience by manually updating the User Preference record.

System 
Only

The system sets and updates the value. Administrators should not modify these 
records.

This table provides the default value and a description for each preference. The Updated By 
column indicates how the preference is set.
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User preferences

Preference Category
Updated 
by

Details

<table>.db.order List Sort Admin 
or User

For the identified table, indicates which column 
is used to sort the records in a list. This record 
updates automatically each time the user 
changes the sort order for the table.

Type: String

Default value: User selection or the Number 
column if the user doesn't select a column. If the 
Number  column is empty, the Name  field is used 
to sort the records.

<table>.db.order.direction List Sort Admin 
or User

For the identified table, indicates whether 
the list shows records in ascending (ASC) or 
descending (DESC) order by the field identified in 
<table>.db.order. This record is updates each time 
the user changes the sort direction for the table.

Type: String

Default value: None

bsm_map.default_ci BSM User 
Only

Contains the sys_id of the last configuration 
item the user viewed in the business service 
management (BSM) map. This record updates 
automatically each time the user views a new 
configuration item in the BSM map.

Type: String

Default value: None

ci_manage_relationships_filter_hint.cmdb_ci CMDB Admin 
Only

Constrains what appears in the Available CIs  list 
when defining a relationship for a configuration 
item. The value is in the format of an encoded 
query string.

Type: String

Default value: 
locationANYTHING^operational_statusANYTHING

ci_manage_relationships_filter_hint.sys_user CMDB Admin 
Only

Constrains what appears in the Available 
User  list when defining a relationship for a 
configuration item. The value is in the format of an 
encoded query string.

Type: String

Default value:active=true

ci_manage_relationships_filter_hint.sys_user_group CMDB Admin 
Only

Constrains what appears in the Available 
Groups  list when defining a relationship for a 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

564



User preferences  (continued)

Preference Category
Updated 
by

Details

configuration item. The value is in the format of an 
encoded query string.

Type: String

Default value: active=true

collapse.<related table>.<related field> Forms User 
Only

Indicates that a related list is collapsed. The 
same related list is collapsed when the user's 
next session begins. This record updates 
automatically whenever the user expands or 
collapses the same related list.

True  = collapse the identified related list.

False  = expand the identified related list.

Type: String

Default value: None

collapse.section.<sys_id> Forms User 
Only

Indicates the sys_id of a form section that is 
collapsed. The same form section is collapsed 
when the user's next session begins. This 
record updates automatically whenever the user 
expands or collapses the same section of the 
same form.

True  = collapse the identified section.

False  (or blank) = expand the identified section.

Type: True/False

Default value: False or blank

glide.debugger.log_messages_limit UI Admin 
or User

Specifies the maximum number of messages to 
be displayed in the script debugger Session Log 
UI.

glide.debugger.console.cached_stmt_limit UI Admin 
or User

Specifies the maximum number of statements 
to be cached in the browser for Script Debugger 
Console.

glide.debugger.log.transaction.count UI Admin 
or User

Specifies the maximum number of transactions 
displayed in the script debugger Session Log  UI.

glide.ui11.use UI11 Admin 
or User

Indicates whether UI11 is active for this user. UI11 
is no longer available.

glide.ui.navpage_state Menus System 
Only

DO NOT MODIFY.Indicates the user's UI11 
configuration.

Type: String
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User preferences  (continued)

Preference Category
Updated 
by

Details

Default value: None

glide.ui.javascript_editor UI Admin 
or User

Indicates whether the JavaScript editor and 
formatting controls are enabled or disabled for 

the user. The JavaScript editor icon ( ) and 
formatting controls are available only in instances 
where the Syntax Editor plugin is active. This 
record updates automatically when a user clicks 
the icon to enable or disable script editing. For 
more information, see JavaScript syntax editor .

True  = enable script editor.

False  = disable script editor.

Type: True/False

Default value: True  (if syntax editor feature is 
active)

glide.ui.response_ time UI Admin 
or User

Determines whether the response time 
information is expanded or collapsed at the 
bottom of a list or form. This record updates 
automatically whenever the user clicks the 

response time indicator icon  at the bottom of 
a v2 list or form.

True  = expand the response time information.

False  = collapse the response time information.

Type: String

False: False

homepage Homepages Admin 
or User

Indicates which dashboard appears when a 
user first logs in to the instance or clicks the 

homepage icon ( ). The value indicates the 
sys_id of the selected dashboard.

Type: String

Default value: None

knowledge.search.sort.field List Sort Admin 
or User

Determines the sort order for results when 
searching the knowledge base. This record 
updates each time the user selects a different 
Sort by  option in the search results header. 
Available options are: Number of Views (views), 
Relevancy (relevancy), and Last Modified 
(sys_updated_on).

Type: String
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User preferences  (continued)

Preference Category
Updated 
by

Details

Default value: Views

list_edit_double Lists Admin 
or User

Indicates what action opens the list editor in List 
v2. This record updates automatically when the 
user personalizes any v2 list and changes the 
Double click to edit  setting. For more information, 
see List editor administration  . This preference 
does not apply to v3 lists. Single-click list editing 
is not supported in List v3.

True  = open the list editor when the user double-
clicks a field in a v2 list.

False  = open the list editor when the user single-
clicks a field in a v2 list.

Type: True/False

Default value: True

list_edit_enable Lists Admin 
or User

Indicates whether the list editor is available for 
editing fields directly in a list. This record updates 
automatically when the user personalizes any 

list (gear icon ( ) above the first column in the 
list) and changes the Enable list edit  setting. This 
preference doesn't apply to v3 lists.

True  = enable use of the list editor.

False  = disable use of the list editor.

Type: True/False

Default value: True

live_message.feed.last_display Live Admin 
or User

Stores the last feed the user viewed: My Feed 
(sysparm_feed_type=myfeed) or Company Feed 
(sysparm_feed_type=company_feed). This record 
updates automatically each time the user selects 
a different feed.

Type: String

Default value: 
sysparm_feed_type=company_feed

live_tag.feed.order Live Admin 
or User

Tracks the user's choice of sorting for tag display. 
This record updates automatically when a user 
selects a different Tag Option  in Live. Available 
options are Order by Created(sys_created_on) 
and Order by Last Activity  (last_activity).

Type: String
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User preferences  (continued)

Preference Category
Updated 
by

Details

Default value: None  (defaults to sys_created_on)

menu.<identifier>.expanded Menus User 
Only

Indicates the sys_id of a section of the 
application navigator menu that is open 
(expanded) for the user. The same section is 
open when the user's next session begins. This 
record updates automatically each time the user 
expands or collapses the same section of the 
application navigator.

Type: String

Default value: None

mobile_rowcount Mobile Admin 
or User

Indicates the number of rows displayed in a 
list on a mobile device. This record updates 
automatically each time the user chooses a 
different number of rows per page from the 
mobile screen.

Type: Integer

Default value: 20

mobile_use_full.android Mobile Admin 
or User

Indicates which user interface appears on 
the user's Android mobile device. This record 
updates automatically each time the user clicks 

the gear icon ( ) above the mobile homepage 
to display the full desktop interface, or clicks the 
cell phone icon in the welcome bar to display the 
mobile interface.

True  = display the full desktop interface on 
Android mobile devices.

False  = display the mobile interface on Android 
mobile devices.

Type: True/False

Default value: False

mobile_use_full.iphone Mobile Admin 
or User

Indicates which user interface appears on the 
user's iPhone mobile device. This record updates 
automatically each time the user clicks the gear 

icon ( ) above the mobile homepage to display 
the full desktop interface or clicks the cell phone 
icon in the welcome bar to display the mobile 
interface.

True  = display the full desktop interface on an 
iPhone mobile device.
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User preferences  (continued)

Preference Category
Updated 
by

Details

False  = display the mobile user interface on an 
iPhone mobile device.

Type: True/False

Default value: False

module Menus User 
Only

Records the sys_id of the last module the user 
accessed.

Type: String

Default value: sys_id

owned_by_indicator.form Update Sets Admin 
Only

Shows or hides the update indicator icon In form 
headers when customer updates to that form are 
being tracked by update sets.

True  = show the customer updates indicator icon.

False  = hide the customer updates indicator icon.

Type: True/False

Default value: False

recent.impersonations Administration User 
Only

DO NOT MODIFY.  Shows who the administrator 
most recently impersonated. For more 
information, see Impersonate a user .

Type: String

Default value: None

report.expanded Reporting Admin 
or User

Works with the UI property List of roles (comma-
separated) that can expand the report header 
to determine whether the report header is open 
when viewing a report.

For users whose role permits them to access 
the report header, the report.expanded  user 
preference indicates whether reports open with 
the header expanded or collapsed. Expanding 
the report header reveals the report builder 
which is used to modify the report definition. This 
user preference record updates automatically 
each time the user expands or collapses the 
report header. If the user's role doesn't have 
permission to view the report header, the report 
header is never accessible, regardless of this 
user preference setting.

True  = expand the report header when displaying 
a report.
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User preferences  (continued)

Preference Category
Updated 
by

Details

False  = collapse the report header when 
displaying a report.

Type: String

Default value: True

rowcount Lists User 
Only

Indicates the maximum number of rows that 
display on a single page in a list. This value also 
determines the maximum number of records that 
display in a list report on a dashboard. This record 
updates automatically when a user chooses a 
different number.

Type: Integer

Default value: 20

sys_update_set Update Sets User 
Only

DO NOT MODIFY.  Indicates the update set that is 
currently active. This value update automatically 
when a user selects a different update set.

Type: GUID

Default value: sys_id of default update set

tabbed.forms Forms User 
Only

Indicates whether forms that contain more than 
two sections use a tabbed interface or a scrolling 
list of sections. This setting applies to all forms. 
It's not set on a form-by-form basis. This record 
updates automatically when a user clicks the 
Toggle Tabs icon in the banner bar. For more 
information, see Configure the form layout  .

True  = display multi-section forms as tabs.

False  or blank = display multi-section forms as a 
scrolling list of sections.

Type: True/False

Default value: False

table.compact Lists User 
Only

Indicates whether lists appear with more or less 
blank space above and below each row. This 
setting applies to all lists. It's not set on a list-
by-list basis. This record updates automatically 
when a user personalizes any list and changes 
the Compact rows  option.

True  = reduce the blank space above and below 
each row in a list to show more rows on the 
screen at one time.
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User preferences  (continued)

Preference Category
Updated 
by

Details

False  = add blank space above and below each 
row in a list to improve readability.

Type: True/False

Default value: False

table.wrap Lists User 
Only

Indicates whether long text in a list is wrapped 
onto multiple lines or truncated. This setting 
applies to all lists. This setting is not set on a list-
by-list basis. This record updates automatically 
when a user changes the Wrap column text 
option in the List v2 personalization interface or 
the Wrap longer text in list columns  option in the 
Core UI  system settings.

True  = wrap long text in a list. All text is seen in 
list view, but each row may occupy more vertical 
space.

False  = don't wrap the long text in a list. Text is 
truncated in list view, but each row takes less 
vertical space. Full text can be seen in form view.

Type: True/False

Default value: True

ts.match Text Search Admin 
or User

Indicates whether the task record should be 
returned by a global text search in which the 
search text exactly matches a task number. This 
record updates automatically when a user clicks 
the Search tips and preferences  link on the 
search results page and changes the Return task 
record if searching for exact number  setting. For 
more information, see Global text search finds 
records from multiple tables .

True  = return the task record. A link is provided for 
full search results.

False  = return full search results, even if the 
search term matches a task number.

Type: True/False

Default value: True

ts.remember.expanded Text Search Admin 
or User

Indicates whether to remember which search 
groups were expanded and collapsed during 
the previous search. The search groups 
available depend on the user's access rights and 
selections. This record updates automatically 
when the user clicks the Search tips and 
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User preferences  (continued)

Preference Category
Updated 
by

Details

preferences  link on the search results page and 
changes the Use remembered expand / collapse 
preferences  setting.

True  = remember the expand/collapse setting 
and use it for subsequent searches.

False  = do not remember the expand/collapse 
setting. Expand all groups for subsequent 
searches.

Type: String

Default value: True

ts.show_empty_groups Text Search Admin 
or User

Indicates whether global text search results 
include groups with no matches. The search 
groups available depend on the user's access 
rights. This record updates automatically when 
the user clicks the Search tips and preferences 
link on the search results page and changes the 
Show groups with no search matches  setting.

True  = include empty groups when displaying 
global text search results.

False  = hide empty groups when displaying 
global text search results.

Type: String

Default value: True

ts.show_negative_result_info Text Search Admin 
or User

Indicates whether group headers in the global 
text search results page should identify tables 
that had no matches. The search groups available 
depend on the user's access rights. This record 
updates automatically when the user clicks the 
Search tips and preferences  link on the search 
results page and changes the In search group 
header, list tables with no search matches 
setting.

True  = show tables that returned no matches in 
the group header.

False  = hide tables that returned no matches in 
the group header.

Type: String

Default value: True
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User preferences  (continued)

Preference Category
Updated 
by

Details

ts.show_search_groups Text Search Admin 
or User

Indicates whether the global text search results 
page includes check boxes that let the user 
indicate which groups to search and display. The 
search groups available depend on the user's 
access rights and settings. This record updates 
automatically when the user clicks the Search 
tips and preferences  link on the search results 
page and changes theShow selectable search 
groups  setting.

True  = show the check boxes for enabling or 
disabling individual search groups.

False  = hide the check boxes for enabling or 
disabling individual search groups.

Type: String

Default value: True

user.can.logout Security Admin 
Only

Indicates whether users see a Logout  button. 
If this is False, users are automatically logged 
out when their session times out. This user 
preference does not apply to Core UI.

True  = show the Logout  button, which enables 
manual logout.

False  = hide the Logout  button, which disables 
manual logout.

Type: True/False

Default value: True

use.concourse Core UI Admin 
Only

Indicates whether users see UI15 or Core UI 
(UI16). The Core UI  plugin [com.glide.ui.ui16] must 
be enabled for users to see Core UI.

True  = show Core UI  by default

False= show legacy UI15 by default

Type: String

Default value: True

Turn off the Next Experience welcome screen after upgrading your instance

You can turn off the Next Experience  welcome splash screen that appears in the Core UI  after 
upgrading your instance by creating a user preference.

Before you begin
Role required: admin
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About this task
A Next Experience  welcome splash screen appears in the Core UI  when you upgrade your 
instance but haven't turned on the Next Experience  UI on the instance.

This welcome splash screen appears for admins only. It informs you about the Next Experience 
UI so you can enable it. After the welcome splash screen has notified you about the Next 
Experience  UI, you can use the following steps to turn off the splash screen.

Procedure

1. Navigate to All  > User Administration  > User Preferences.

2. Click New.

3. Enter the following values.

Option Description

Description
A description of the user preference. For ex­
ample, Remove the welcome splash 
screen.

User

The user that the splash screen is turned off 
for.

To turn off the splash screen for all users, 
leave this field empty.

To turn off the splash screen for specific 

users, user the search icon ( ) to find the 
user and select them in the search results.

Name

User preference name. To turn off the wel­
come splash screen, enter the following 
name:

overview_help.visited.NextExpe­
rience

Value
Enter true  to enable this user preference, 
which turns off the welcome splash screen.

Type Select string.

System
Select this check box to apply this user prefer­
ence system wide.

4. Click Submit.
The welcome splash screen is marked as Visited. When the welcome splash screen is marked 
as Visited, the screen is turned off on your instance for specified users or all users depending 
on how you configured the User  option.

Note: 
In the User Preferences table, verify that there is only one user preference record where 
the System  field and Value  field is set to true.
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Configure available keyboard shortcuts

Administrators can configure which keyboard shortcuts are available to users.

Before you begin
Role required: admin

About this task
For a list of available keyboard shortcuts, see Core UI keyboard shortcuts. 
You can enable or disable keyboard shortcuts universally by searching for the 
glide.ui.keyboard.shorcuts.enabled  user preference. Then select the System 
checkbox and set the value to False.

You can also use the user preferences to determine which keyboard shortcuts are available to 
users and what the key combinations are.

Procedure

1. Navigate to All  > User Administration  > User Preferences.

2. From the search bar, select Name.

3. Type *keyboard  to do a contains search for all user preferences containing keyboard in the 
name.

4. To allow users to use keyboard shortcuts while typing in a field, set the value for the 
glide.ui.keyboard.shortcuts.allow_in_input_fields  user preference to 
true.

5. Disable any of the following keyboard shortcuts by changing the value to False.

Keyboard shortcuts

User preference Description Keyboard shortcut

glide.ui.keyboard.shortcuts.main_frameMove keyboard focus to the 
main content on the page.

ctrl+alt+p

glide.ui.keyboard.shortcuts.global_searchMove keyboard focus to 
the global search bar in the 
banner frame.

glide.ui.keyboard.shortcuts.impersonatorOpen the impersonator 
window.

glide.ui.keyboard.shortcuts.navigator_filterMove keyboard focus to 
the filter in the application 
navigator.

glide.ui.keyboard.shortcuts.navigator_toggleToggle the application 
navigator open or closed.

6. Use the value for any user preference that ends with key_combo to change the key 
combination for that particular keyboard shortcut.

View management

A view defines the elements that appear when a user opens a form or a list, and you can switch 
the view from the default for lists and forms.

When the system displays a form or list it usually displays only a subset of the fields belonging to 
the underlying table.
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Administrators and users with the personalize role have permission to perform the key tasks 
related to views:

• create views for any list and form

• determine which view is visible by default

• delete views they have created

• create and modify view rules determining which views are available depending on the values 
of the fields of the underlying table

• create rules that determine which views pertain to specific user roles

Users with the admin or view_changer roles can change views.

Several views are included with the base system, including the Default view and Advanced view.

Warning: 
Do not delete any of the base system views.

Switching views

To switch between list views, click the list context menu at the top left corner of the list, and then 
select View  > [Desired View].

Switching views submits the form, which saves all changes and triggers any onSubmit  client 
scripts that apply. You cannot switch form views on a new form that has not been saved yet.

When a user switches views, the selected view is saved as a user preference so the user 
sees the same view by default when the form opens. When a user has a view saved as a user 
preference and then opens a URL to a record that specifies another view, the form displays in 
the view saved in the user preference, not the URL. For example, if a user selects the Mobile view 
on an Incident record and then tries to open the following link, which specifies the visual task 
board view, the form still opens in the Mobile view: https://{instance}/nav_to.do?
uri=incident.do?sys_id={sys_ID}sysparm_view=vtb

The sysparm_view parameter specifies the view to be used for a list or a form, and can be 
overwritten by a user’s stored preference for a view. You can override this behavior by setting the 
sysparm_view_forced  parameter to true.

Create and delete views

Administrators can create views and delete any views they have created. You can create or 
delete views from either the list view or the form view.

Before you begin
Role required: admin

Procedure

1. Navigate to the application or module you want to create or delete the view for.

2. Select and hold (or right-click) the header and select Configure  > List Layout.

3. If you're creating a view for a form, open a record, then select and hold (or right-click) the 
header and select Configure  > Form Layout.

4. Under the List View section, select the view on which you want to base your new view.
The fields visible for that view appear in the Selected  list.

5. From the list, select New.
The Create New View form appears.
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6. Enter the descriptive name of the view.
View names should be unique and cannot use special characters or spaces. The following 
characters are permitted: A-Z, a-z, 0-9 and _.

7. Select OK.
The fields in the Available  column are the same as the first view you based the new view on.

8. Select the fields to appear in this view by adding or removing the fields from the Selected 
column, or you can adjust the order they appear on the form by moving the fields up or down.
If you're creating a view for a form, you can select a form section and configure the fields for 
that section. You can also create views in the same manner when you configure a related list.

9. To delete a view, navigate to System UI  > Views.

10. Select the view to delete.

11. Select Delete  on the form header.

Warning: 
In the views list, you may see multiple entries formatted as rpt-
temp<sys_id><user>. The instance creates these views to store the current state of 
reports. Avoid deleting these records, as it may impact the state of active reports.

Do not delete the base system views.

Create a view rule

When a user switches views, the selected view is saved as a user preference so the user 
sees the same view by default when the form opens. With a view rule, you can override this 
functionality to force a specified view to be used.

Before you begin
Role required: admin

About this task
View rules do not always apply if there are existing user preference entries on the instance. 
Delete the user preference entry and clear the system cache to make sure the respective view 
rule applies. You can clear the system cache by appending cache.do  to the instance URL. For 
example, instance_name.service-now.com/cache.do.

Important: 
Clearing the system cache can affect overall performance, and degrade system response 
times. Do not run cache flushes during business hours, and do not trigger cache flushes 
automatically.

Procedure

1. Navigate to All  > System UI  > View Rules.

2. Select New.

3. Complete the form, using the fields in the table.

View rule form

Field Input value

Name Specify an identifying name for the rule.

Active Select this option to apply the view rule according to the conditions you 
specified. If unchecked, the view rule is not be applied.
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Field Input value

Advanced Select this option to specify a code-based condition instead of using the 
condition builder. Selecting this option displays the Script  field and hides the 
Match conditions, Conditions, and View  fields.

Match 
Conditions

Select whether Any  or All  of the conditions need to be met. The system hides 
this field when you create an advanced View Rule.

Conditions Use the condition builder to determine when the view is applied. The system 
hides this field when you create an advanced View Rule.

Application Displays the application to which the View Rule record belongs.

Table Select the table on which this view rule will be applied. The list shows only 
tables and database views that are in the same scope as the view rule

Device 
type

Select which interface this view rule applies to.

View Enter the name of the View you're creating a rule for. The system hides this field 
when you create an advanced View Rule. This field is case-sensitive and must 
match exactly the view name.

Script Enter a script to determine when to display a particular view. The system only 
displays this field when you create an advanced View Rule.

4. Select Submit.

Control when the system displays a view

Administrators can create rules that determine the conditions for when the system should 
display a form or list in a specified view. Administrators can also restrict views by user role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > View Rules.

2. Select New.

3. Complete the form.

View rule form

Field Input value

Name Specify an identifying name for the rule. This field is case-sensitive and must 
match exactly the view name.

Active Select this option to apply the view rule according to the conditions you 
specified. If unchecked, the view rule is not be applied.

Advanced Select this option to specify a code-based condition instead of using the 
condition builder. Selecting this option displays the Script  field and hides the 
Match conditions, Conditions, and View  fields.

Match 
Conditions

Select whether Any  or All  of the conditions must be met. The system hides this 
field when you create an advanced View Rule.
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Field Input value

Conditions Use the condition builder to determine when the view is applied. The system 
hides this field when you create an advanced View Rule.

Application Displays the application to which the View Rule record belongs.

Table Select the table on which this view rule is applied. The list shows only tables 
and database views that are in the same scope as the view rule

Device 
type

Select which interface this view rule applies to.

View Enter the name of the View you're creating a rule for. The system hides this field 
when you create an advanced View Rule.

Script Enter a script to determine when to display a particular view. The system only 
displays this field when you create an advanced View Rule.

4. Select Submit.

Restrict view by role

You can use a script to control the form view used by different roles.

Warning: 
The customization described here was developed for use in specific instances, and is not 
supported by Now Support. This method is provided as-is and should be tested thoroughly 
before implementation. Post all questions and comments regarding this customization to 
our community forum .

Name: Restrict View by Role

Type: System UI  > View Rules

Table: Any

Description: Generally the view used on a form is controlled by either specifying the 
sysparm_view  parameter in the url or module properties, or by inheriting the view from the 
previous form or list. Sometimes this does not apply, such as when opening a referenced field 
form from a record producer. In this case, you may want to control the view of the form based on 
roles. This script assumes there is a view called ess  available to the current table.

Parameters:

• view  - A string containing the name of the current view.

• is_list  - A Boolean value indicating whether this is a list view.

Script:

(function overrideView(view, is_list) {
//Force non-itil users to use the ess view
if (gs.hasRole("itil"))
{return;}
if (view.startsWith("ess"))
{return;}
// do not change view if it starts with sys_ (e.g. sys_ref_list)
if (view.startsWith("sys_"))
{return;}
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answer = "ess"; // set the new view to answer
})(view, is_list);

Navigation handler

A navigation handler is a scripted view rule and runs each time data from the specified table is 
requested in the form view.

Create a navigation handler

The Navigation Handler [sys_navigator] table contains the navigation handlers on your instance. 
Access this table by entering sys_navigator.list  in the filter navigator. Navigation handler 
records contain a Table  field to specify which table the navigation handler applies to, and a 
Script  field containing the scripted view rule.

The following script comes from navigation handler included with the HR plugin. The script forces 
records from the table in the Table  field to use ESS view for users with no roles, and default view 
for all other users.

var now_GR = new GlideRecord(hr.TABLE_CASE);
if (gr.get(g_uri.get('sys_id'))) {
     if (!gs.getUser().hasRoles())
          g_uri.set('sysparm_view', 'ess');
     else
          g_uri.set('sysparm_view', '');
}
 
 
answer =  g_uri.toString('hr_case.do'); 

Run navigation handlers before or after view rules

Use the glide.ui.view_rule.check_after_nav_handler  system property to control 
the order in which view rules and navigation handlers are applied. Set the property value to True 
to process view rules after navigation handlers. If the system property does not exist in your 
instance, the navigation handler always takes precedence.

The system property only overrides the navigation handler if the navigation handler scripted 
function does not return an answer. In the example script above, the property has no effect. 
This is because this navigation handler always returns an answer due to the answer  line being 
outside of the if  statement.

To force the navigation handler script in the preceding example to honor view rules, take the 
following steps:

1. Create the glide.ui.view_rule.check_after_nav_handler  system property.

2. Set the value of the property to true.

3. Update the navigation handler script to only return an answer  when the view must be 
changed or forced.

This example is a modified version of the previous script. In this case, the answer  line only 
occurs when the user has no roles. If the user has roles, answer  is never reached, and view 
rules on the same table, if any, are applied.

var now_GR = new GlideRecord(hr.TABLE_CASE);
if (gr.get(g_url.get('sys_id'))) {
     if (!gs.getUser().hasRoles()) {
          g_url.set('sysparm_view'),'ess');
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          answer = g_url.toString('hr_case.do');
     }
} 

Welcome pages

The welcome page contains instructions and any important information you would like to convey 
to your customers each time they log in to use the system.

The base system login page content is customizable by the administrator of the system.

Note: 
This information is only relevant for instances using Core UI  instead of the Next Experience. 
For information about similar options available for Next Experience, see Configure login 
theming in Next Experience.

Welcome page sections

Welcome pages can contain different sections, including:

• Welcome:  General information

• Using:Some tips and tricks for using the system

• Login:  Login information

• Demonstration:  Information about logging in to a base system demo system

• More Information:  A link to the ServiceNow  documentation

View, create, and configure the welcome page sections by navigating to System UI  > Welcome 
Page Content. You can edit any item by clicking its short description. Sections that are not 
needed can be removed.

Welcome page section fields

Field Description

Short 
Description

A description of the section.

Active Mark the section active to display it on the welcome page. Inactive sections are 
not visible.

Display 
order

A number representing the order in which sections are displayed. Lower 
numbered sections are displayed above higher numbered sections.

Application The application to which the section belongs.

Language The section appears when the logged in users language matches this value. If no 
user is logged in, the guest user's language preference is used.

Condition The section appears on the welcome page when the script in this field evaluates 
to true.

Published The published date of the section.

Text The content of the section.

Create company-specific welcome page content

You can create company-specific welcome page content.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > Welcome Page Content.

2. To create a new section, click New.

3. Enter the following in the Condition  field, where Company is the name of the company whose 
users see this section.

Example 

gs.getUser().getCompanyRecord().name.toString() == "Company"

4. Complete the form.

5. Click Submit.

Enabling accessibility features

You can configure accessibility features globally or for specific users. Users can also individually 
enable user preferences for themselves to meet their specific accessibility needs.

The platform includes features that support Web Content Accessibility Guidelines (WCAG) 2.0 
AA and WCAG 2.1 AA (for some products) to make the interface more accessible to all users. 
These features improve the user experience when accessing the instance with screen readers 
and keyboard navigation.

Accessibility features are not enabled by default because some features are user specific. 
Administrators have the flexibility to enable features globally or for individual users.

All of these options can be configured globally or for specific users.

• Enable the accessibility option.

• Enable the high contrast theme.

• Use skip links.

• Turn off first field focus

Enable accessibility mode

Enable accessibility mode on your instance.

Before you begin
Role required: none

About this task
Administrators can enable accessibility mode for specific users by navigating to User 
Administration  > User Preferences  and searching for the glide.ui.accessibility  user 
preference. For more information on configuring user preferences, see User preferences.

Procedure

1. Navigate to User Administration  > User Preferences.

2. Click the gear icon ( ) in the banner frame to open the System Settings window.

3. From the General tab, select the Accessibility enabled  option.
Accessible tooltips on forms is enabled automatically the first time you enable accessibility 
mode.
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What to do next
Alternatively, enable accessibility mode using the Enable Accessibility skip link. For more 
information on skip links, see Use skip links.

Enable accessibility skip link

Enable the high contrast theme

In Core UI, administrators can enable the Contrast UI theme for users who need a greater 
contrast in color.

Before you begin
Role required: admin

About this task
Individual users can enable the contrast theme for themselves by navigating to the Theme tab of 
the system settings  menu. From the Theme tab, select the Contrast UI  theme.

Procedure

1. Navigate to All  > User Administration  > User preferences.

2. Click New  then configure the following fields.

User preferences fields

Field Description

Name glide.css.theme.ui16

System Make sure that the check box is cleared.

User Name of the user you want to enable the 
contrast UI theme for. Add a user preference 
for each user you want to enable the theme 
for.

Type string

Value The sys_id of the contrast UI theme. You can 
find the sys_id by navigating to System UI 
> Themes. Then right-click Contrast UI  and 
click Copy sys_id.

3. Click Submit.
The user may have to sign out and sign back in for the theme to take effect.
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Turn off first field focus

When a form loads, the system automatically sends focus to the first field on the form. For 
accessibility reasons, you can disable this option so that focus starts on the first element on the 
top of the page.

Before you begin
Role required: admin

About this task
Sending focus to the first field on a form is useful to most users however, it presents challenges 
for users with certain disabilities. For example, a user using the system with a screen reader may 
not realize there is additional content above the field that receives focus.

Procedure

1. Navigate to All  > System Properties  > UI Properties.

2. Locate the On form load, focus on first writable element. 
(glide.ui.focus_first_element)  property.

3. Clear the checkbox to turn off first field focus.

Note: 
If your instance has list v3 enabled, instead navigate to All  > 
User Administration  > User Preferences  instead and update the 
glide.ui.accessibility.focus_first_field

Enable the accessible form tooltips feature

The accessible tooltips user preference adds a tooltip icon that users can tab to, to view a tooltip 
for a field.

Before you begin
Role required: admin

About this task
Some fields on forms have associated tooltips that contain additional information. By default, 
these tooltips are accessible by pointing to the field label or mandatory indicator asterisk. 
However, a user who relies on keyboard navigation cannot point to the field to access the tooltip. 
The accessible form tooltip feature solves this problem by adding a keyboard-accessible icon 
next to each field that has a tooltip. Tabbing or pointing to the icon shows the tooltip.
Administrators can enable accessible form tooltips for specific users by 
navigating to User Administration  > User Preferences  and searching for the 
glide.ui.accessibility.accessible.tooltips  user preference. For more 
information on configuring user preferences, see User preferences.

Accessibility must be enabled for the accessible form tooltips user preference to work.

Procedure

1. Click the gear icon ( ) in the banner frame to open the System Settings window.

2. From the General tab, select the Accessibility enabled  option.
The Accessible tooltips on forms option is enabled automatically the first time you enable 
accessibility mode.

3. Optional:  Clear the Accessible tooltips on forms  option to disable the accessible tooltips.
If you disable accessibility mode and re-enable it, Accessible tooltips on forms will remain 
disabled.
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Configure a Windows 64-bit host to use 32-bit NVDA with Java applications

The NVDA Assistive Technology screen reader is a 32-bit application that, when the Java Access 
bridge has been enabled, reads aloud Java applications built to support accessibility. If you 
encounter a problem using NVDA to access Java applications on a 64-bit Windows host, you 
must configure the Java Access bridge.

Before you begin
Role required: local or domain administrator on the host Windows machine

About this task
The following example assumes:

• The 32-bit and 64-bit Oracle Java jdk versions 8u171 are being installed in the default location.

• A Windows command prompt with administrative privileges is used to execute command line 
utilities.

• Executable statements are prefixed with the PROMPT>  string.

Note: 

• This configuration was used on a Windows 7 VM host to test the NVDA and JAWS screen 
readers.

• This example refers to Java version 8u171. If you are using a later version of Java, 
substitute that version.

Procedure

1. On the Oracle Java SE downloads page , download the Oracle Java jdk for 32-bit and 64-bit 
Windows environments.

◦ 32-bit: jdk-8u171-windows-i586.exe

◦ 64-bit: jdk-8u171-windows-x64.exe
To access and download the files listed in the above example, go to the Oracle Java SE jdk 
download page .

2. Install the 64-bit version of the Oracle Java jdk in the default location.

PROMPT> jdk-8u171-windows-x64.exe

Verify that the installation process installed the following:

◦ Java 64-bit jdk in the C:\Program Files\Java\jdk1.8.0_171  directory.

◦ WindowsAccessBridge-64.dll  in the C:\Windows\System32  directory.

3. Enable the Java Access bridge for 64-bit applications using the 64-bit jabswitch application 
located in the 64-bit Java jdk bin directory.

PROMPT> cd "C:\Program Files\Java\jdk1.8.0_171\bin"
PROMPT> jabswitch -enable

4. Copy the WindowsAccessBridge-64.dll  located in the C:\Windows\System32 
directory to the 32-bit C:\Windows\SysWOW64  directory.

PROMPT> cd C:\Windows\System32
PROMPT> copy WindowsAccessBridge-64.dll C:\Windows\SysWOW64

Verify that the copied WindowsAccessBridge-64.dll  exists in the 32-bit C:\Windows
\SysWOW64  directory.
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5. Install the 32-bit version of the Oracle Java jdk in the default location.

PROMPT> jdk-8u171-windows-i586.exe

Verify that the installation process installed the following:

◦ Java 32-bit jdk in the C:\Program Files (x86)\Java\jdk1.8.0_171  directory.

◦ WindowsAccessBridge-32.dll  in the C:\Windows\SysWOW64  directory.

6. Enable the Java Access bridge for 32-bit applications using the 32-bit jabswitch application 
located in the 32-bit Java jdk bin directory.

PROMPT> cd "C:\Program Files (x86)\Java\jdk1.8.0_171\bin"
PROMPT> jabswitch -enable

7. Restart the NVDA Assistive Technology software through the task bar or the NVDA menu.

◦ Select the NVDA shortcut pinned to the task bar, pinned to the start menu, or located on the 
desktop.

◦ Navigate to the Start  > All Programs  > NVDA  > NVDA  menu selection.

8. On an administrative command prompt terminal, launch the Edge Encryption Interactive 
Installer.

PROMPT> java -jar <edge encryption interactive file name>.jar

Using accessibility features

Accessibility features include keyboard navigation, color and style settings, using a screen 
reader, and search methods.

Keyboard accessibility

The ServiceNow AI Platform  is designed to be as accessible as possible without user 
modification or setting changes. Users can tab through the platform UI without enabling 
accessibility. However, without accessibility enabled, tabbing goes from input to input and skips 
other items on a form, such as reference icons.

Tab-through provides the following options:

• Use skip links to shift focus to different parts of the page without tabbing through every 
element.

• On edit pages such as forms, the keyboard focus starts at the first editable field on the page.

• If the glide.ui.focus_first_element  user preference is enabled, page focus starts 
at the first input field at the top of the page content section. In a table, this field is usually the 
search option. In a form, the field is the first input field in the form. For more information about 
disabling initial field focus to improve accessibility, see Turn off first field focus.

• Use tab-through and arrow keys to move items around in a slushbucket.

• When focused on tabs, use right/left arrow keys to switch tabs.

• Arrows keys work within menus to navigate between entries.

• On tab-through for a list, the option to enable the Edit table data inline  appears, so you can 
use the list editor, rather than opening the form.

◦ When inline edit mode is enabled, screen focus shifts to the first cell in the table.

◦ Press the Escape key while a cell is selected to exit inline edit mode. Focus remains on the 
cell.
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◦ Press the spacebar to open the context menu for the selected item.

◦ Use the arrow keys (in addition to tabbing) to move around the list in inline edit mode.

• Properties pages, such as System Properties  > UI Properties, include an icon with the 
property name. Screen readers read the property name when the icon is in focus.

• Fields on a form include a tooltip icon. Screen readers read the tooltip when the icon is in 
focus.

• In the application navigator when accessibility is enabled, tabbing moves you through each 
element for every module, including the Edit application/module  and Add to favorites  icons. 
Use the arrow keys to move through the application navigator without focusing on these 
additional elements.

• If accessibility mode is enabled, a help icon appears with the HTML field. The help icon 
indicates how to access and escape the HTML field toolbar.

Use skip links

Skip links allow users to quickly navigate to the main content on a page, list, or form, bypassing 
icons, banner text, navigation links, and other elements. Skip links are not visible until you tab to 
them.

Before you begin
Role required: none

About this task
The user interface includes skip links to the navigation menu, and the main content pane. If 
accessibility is not enabled, users can also use skip links to activate accessibility.

Skip link

• Enable Accessibility: Enables accessibility. This skip link only appears if the user has not yet 
enabled accessibility. Pressing enter prompts you to reload the page with accessibility mode 
enabled.

• Skip to navigator: Skips to the navigation filter in the application navigator.

• Skip to main content: Skips to the main content page.

• Edit table data inline: Skips to the first field in a table. When the field is selected, press Enter to 
edit the field. Press the spacebar to open the field context menu. Press the Escape key to exit 
inline edit mode.

Skip links are usually the first item in the tab order for a page or frame.

Procedure

• Use the Tab and Shift+Tab keys to move forward and back through the skip links and other 
selectable fields.

• When a skip link receives focus, press Enter to select the link.
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Color and style accessibility

There are several color and style changes that make the platform more accessible.

Enable the Contrast UI theme

In the system settings, on the themes tab, select the Contrast UI theme. The Contrast UI theme 
provides a higher contrast range of colors for the platform UI.

In Service Portal, you can apply the Stock — High Contrast theme to a portal for a higher contrast 
color range. Portal users can enable a contrast theme using the Accessibility  option in the User 
Profile widget.

Patterned charts and graphs

View charts and graphs that rely heavily on color with patterns in addition to colors. Navigate to 
System settings  > General, then select Data visualization patterns enabled.

Accessibility enabled graph

Screen reader accessibility

Screen elements in the platform have enhancements that make them accessible to screen 
readers.

Use NVDA, JAWS, or VoiceOver for non-visual access to the platform.

Skip links allow you to tab straight to the main content instead of tabbing through all the other 
elements on the page.

When a page reloads or search results display, screen readers inform the user.

Important images and field indicators (for example, status indicators for avatars in list v3) have 
alternative text for screen readers to read.
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To reduce confusion when tabbing through modules, the edit application/edit module and add to 
favorites icons are accessible to screen readers by tabbing. To skip the Edit application/module 
and Add to favorites  icons, use the up and down arrows on the keyboard.

In Service Portal, users can add alternative text to containers in their own portal for screen 
readers to read.

Elements such as links or button are listed as such for screen reader awareness.

Properties pages, such as System Properties  > UI Properties, include an icon with the property 
name. Screen readers read the property name when the icon is in focus.

Forms include accessible tooltips that screen readers read when the tooltip is in focus.

Accessibility search methods

There are several ways to search for information in the user interface.

• When a list opens, focus starts in the search field. Press the Tab key or the shift+tab keys to 
navigate away from the search, or start typing while focus is in the search field.

• List views include a Go to  search field in the list title bar. Using the * wildcard character in the 
search text allows you to perform a contains  search rather than a starts with  search. This 
type of query may take longer to run but can save keystrokes. You can also use several other 
wildcards with list searches.

• The navigation filter in the application navigator filters the applications and modules that 
appear in the navigator based on the entered text. Tab through or use skip links to navigate 
directly to the navigation filter. To open a module, click the module name, or press the Down 
Arrow to highlight the module name, and then press Enter.

See Available search options  for more information about these search methods.

View card details in a Visual Task Board

With accessibility mode enabled, tab through cards in a task board. Use the card details button 
to view task card details.

Before you begin
Enable accessibility from the General tab of the system settings menu.
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open an existing task board.

3. Press the Tab key to navigate through the board to get to a task card.

4. Press the Tab key to navigate through the card until the Open Card Details button appears.

Card details

5. Press Enter  to open the card.

6. To exit the card, press Escape.

Map pages

Map pages display ServiceNow  data graphically on a Google  map page based on location data 
that you provide.
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You can create as many map pages as required to define the types of data to display, the links to 
show, and the appearance of the map. After creating the map pages, you can create modules to 
display the map pages.

Note: 
Map pages are subject to the non-production access limitations. See Set up Google Maps 
API  for details.

Map locations

Locations are used by various applications to locate users, facilities, or configuration items (CI) 
and are stored in the Location [cmn_location] table. You can configure different levels of location 
in a parent-child hierarchy. For example, an email server might be associated with a location of 
Second Floor, whereas the email business service might be associated with New York City.

Each level of this hierarchy contains a separate location record, with the next higher level 
specified as a parent.

The location is also used to generate a full identifier in the Full name  field, which is available by 
configuring the form. For more information, see Show or hide fields on a form .

How locations are defined

To create a location, navigate to User Administration  > Locations  and select New.

Define a location

Field Description

Name The name of the location. This name is the display value that the system uses when 
referencing this location on a form.

Street The street address of the location.

City The city of the location.

State / 
Province

State or province of the location.

Zip / 
Postal 
Code

The zip or postal code of the location.

Country The country of the location.

Contact Name of a user who is the contact for this location.

Phone The phone number for the location.

Fax 
phone

The fax number for the location.
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Define a location  (continued)

Field Description

Parent Name of the parent location for this location. Location hierarchies are described 
earlier.

Latitude The latitude of the location.

The get_lat_long  business rule automatically populates this field and the 
Longitude  field described below when the form contains enough information, such 
as an address or city name and a postal code.

Deactivate this business rule to avoid the system overwriting any values entered 
manually into these fields.

Longitude The longitude of the location.

Fields that can be added by configuring the form:

Company A reference field to the Company  [core_company]  table.

Full name A read-only, calculated field that assembles the parent hierarchy of the location into 
a full name.

Stock 
room

A Boolean field that identifies whether the location is being used as a stock room.

Time 
zone

The time zone of the location. By default, the location uses the system time zone.

Latitude and longitude

When a Company  or Location  record is created, or has one of its address fields changed 
[street, city, state, zip or country], the get_lat_long  business rule 
is triggered. This business rule uses the GoogleMapsHelper  script include to create 
sys_geocoding_request  records.

The scheduled job Process Geocoding Request  must be enabled to process 
sys_geocoding_request  records. Process Geocoding Request  uses the Google  Map 
service to populate the latitude and longitude fields of the changed or created Company  and 
Location  records.

After the latitude and longitude are populated, Map Pages can be defined that display locations 
in an interactive map.

Note: 
Latitude and longitude are expressed as a floating point data type. Previous releases 
expressed this information as a string. During an upgrade, the system converts the data 
where possible.

Set up Google Maps API

You enable the geolocation feature using the appropriate entries from a Google  Maps API for 
Business license, or a Google  Maps JavaScript API Key.

Before you begin
Role required: admin
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About this task
You can generate maps using basic JavaScript, and they are flexible enough to display even 
the most complicated of queries. These maps use standard Google  Maps API for Business or 
Google  Maps JavaScript API Key mapping features, including various link types to records in 
your instance. Use of this feature requires installation of the Google  Maps plugin.

Important: 
Starting May 2026, Google is deprecating the use of Client ID for authenticating 
requests to Google Maps. From this date onward, API keys will be the only supported 
authentication method. If your application continues to use client-id (for example, via 
the google.maps.method property), Google Maps requests will fail. For more 
information, see Client ID Migration Guide .

Update your configuration to authenticate using an API key only (that is, set 
google.maps.method  to key). Refer to the descriptions of google.maps.key  and 
google.maps.key.geocoding  properties for more information on API key–based 
authentication.

Procedure

1. Google  Maps APIs for Business licenses are no longer available from Google, so, depending 
on whether have an existing license, use one of the following procedures.

Note: 
You are required to use your own Google Maps JavaScript API Key from Google  and not 
use any ServiceNow AI Platform®  generated key.

To learn more about Google  Maps API for Business, and Google  Maps JavaScript API Key, see 
https://developers.google.com/maps/gmp-get-started .

2. After you complete and save the configuration, create Map pages, or use the default pages 
included with the plugin.
Map pages define what data appears on the map, and the appearance of the links. For a 
tutorial on how to view all of the markers that link to your records, see the Display Map Markers 
on Google Maps  blog post on the ServiceNow Community.

Property Description

google.maps.method Defines which method of authentication should be used for 
Google Maps.

◦ Type: string

◦ Default value: key

◦ Location: System Properties  > Google Maps

google.maps.auto_close If true, automatically closes a map information window before 
opening a new one.

◦ Type: true/false

◦ Default value: true

◦ Location: System Properties  > Google Maps

google.maps.client Client ID for Google  Maps API for Business.

◦ Type: string

◦ Default value: gme-servicenow

◦ Location: System Properties  > Google Maps
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Property Description

google.maps.map_id Map ID for Google Maps used for the cloud-based maps 
styling, vector maps, and advanced markers. To obtain your 
Map ID, see How to create map IDs .

◦ Type: string

◦ Default value: empty

◦ Location: System Properties  > Google Maps

google.maps.client.key Private key for Google  Maps API for Business. This key 
activates the geolocation feature, which locates users in the 
system precisely, using data from their mobile devices.

◦ Type: string

◦ Default value: empty

◦ Location: System Properties  > Google Maps

google.maps.version Version number of the current installation of Google  Maps API 
for Business.

◦ Type: string

◦ Default value: current version number

◦ Location: System Properties  > Google Maps

google.maps.key Google  Maps API for Business or Google  Maps JavaScript 
API Key that ties to the URL of the server. This key authorizes 
development use of Google  Maps API.

◦ Type: string

◦ Default value: empty

◦ Location: System Properties  > Google Maps

google.maps.key.geocoding Google Maps API for business or Google Maps JavaScript 
API key that ties to the URL of the server. This key is used for 
making geocoding requests.

◦ Type: string

◦ Default value: empty

◦ Location: System Properties  > Google Maps

google.maps.latitude Starting latitude of the map. This value determines the starting 
position displayed in Google  Maps.

◦ Type: string

◦ Default value: 36.008522

◦ Location: System Properties  > Google Maps

google.maps.longitude Starting longitude of the map. This value determines the 
starting position displayed in Google  Maps pages.

◦ Type: string

◦ Default value: -95.221764

◦ Location: System Properties  > Google Maps

google.maps.max_items Maximum number of items to display on the map.
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Property Description

◦ Type: integer

◦ Default value: 500

◦ Location: System Properties  > Google Maps

google.maps.table Table used by the map. The table needs the following fields: 
name, longitude, latitude.

◦ Type: string

◦ Default value: cmn_location

◦ Location: System Properties  > Google Maps

google.maps.zoom Starting zoom level of the map (1 is the lowest)

◦ Type: string

◦ Default value: 4

◦ Location: System Properties  > Google Maps

3. Perform these configurations:

a. Navigate to System Properties  > All.

b. Set values for these system properties:

System property Description

google.maps.refresh.latlong.duration Number of days after which the location 
details are updated.

Note: 
The maximum value is 30.

google.maps.refresh.latlong.record_count_per_tableMaximum number of records in a table that 
can be processed using the scheduled job 
in one refresh.

c. Specify the tables that store the location details in the Map Coordinates Refresh 
Configuration [cmn_coordinate_refresh_config] table.

d. If there are no fields to track when the coordinates are last retrieved in your tables:

i. Create the coordinates_retrieved_on  field of the type Date/Time  in your tables.

ii. Ensure that the value of the field that tracks time when the coordinates 
are last retrieved, is populated correctly in the Map Coordinates Refresh 
Configuration [cmn_coordinate_refresh_config] table. Refer to the sample fix 
script Update coordinates updated on field  to update values in the 
coordinates_retrieved_on  field.

e. Navigate to System Definition  > Scheduled Jobs.

f. Open the record, Refresh Latitude Longitude info of Records.
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g. Select the Active  check box.

h. Specify the frequency at which the location details should be refreshed by providing 
frequency details in Run  and Repeat Interval.

Note: 
Ensure that you refresh the location details at least once every 30 days.

4. Optional:  To access Google  Maps from the ServiceNow  instance based on your region, 
perform these configurations.

a. Navigate to User Administration  > Users.

b. Select and assign the relevant Country Code  for the required user.

Note: 
If the required Country Code  isn't available, add the dictionary entry. Ensure that you 
use the ISO 3166-1 country codes. For example, the country code of Morocco is MA.

c. Navigate to System Properties  > Google Maps.

d. Select the Yes  check box for Enable this property only when you want to alter the Google 
map's behavior based on a region. The region is populated from the current User's 
'Country code' field value in sys_user record. The Country code value on the sys_user 
record should be consistent with the expectations from the Google Map's region code. 
Most Unicode region identifiers are identical to ISO 3166-1 codes, with some notable 
exceptions. Check the codes properly before making any changes.

e. Click Save.

Create a map page

Your ServiceNow  instance provides several default map pages. You can also create custom map 
pages with the script examples described in this page.

Before you begin
Role required: admin

About this task
The default map page record displays critical incidents on a Google  map page.

Procedure

1. Navigate to All  > System Map Page  > Map Pages.

2. Click New.

3. Complete the form using the fields in the table.

Field Description

Name Enter a unique name to identify the map.
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Field Description

Center map 
on

Enter the location for centering the map using the decimal form of latitude 
and longitude. For example, to center the map on the statue of liberty, enter 
40.689865, -74.045235.

Initial zoom Set the zoom level of the map on opening.

Refresh on 
zoom

Enable or disable to refresh map on zoom.

Use 
advanced 
configuration

Select to configure a map with lists and forms. The script hides and M2M 
forms display to configure your map.

Note: 
Advanced configuration does not support mobile.

Application Select an application scope for the map.

Controls size Select whether the Google navigation icons on the map should be large or 
small.

Type Select a map background style: Satellite, Hybrid, Normal, or Terrain.

Type 
selection

Select which type of Google icons to display on the map: Buttons  or Menu.

Map 
overview

Enable or disable a wide view map window for navigation.

Show device 
location

Enable or disable to show device locations.

Script Create a script to define the type of data to display on this map. For more 
information, see Scripting for map pages.

4. Save the record.

Create a map page module

You can create a new application module for desktop or smartphone users to display a Google 
map page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Modules  and click New.

2. Select the appropriate application for the module.
For example, if you are planning to display critical incidents, add a module to the Incident 
application menu.

3. Point to the application menu you want to add the module to and click the edit application 
(pencil) icon.

4. Select the Link Type  tab and select the type of link you want for the module.
For example, you can create a module that opens a map page directly, or one that links through 
a URL.

5. Complete the form, as appropriate.
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Field Description

Title Enter a name for the module in the application navigator.

Order Enter a number to define the sequence this condition should be evaluated if 
more than one matching condition exists. The order is evaluated from the lowest 
value to the highest value.

Application 
menu

Select the application menu where you want this module to appear. By default, 
this field displays the application menu that you opened to create the module.

Hint Enter a brief description to display when a user points to the module name in 
the application navigator.

Active Select the check box to activate this module. Only active modules appear in the 
application menu.

Image Select an icon to display with this module in the application navigator. If this 
field is blank, a default icon is used.

Link type Select the desired link type from the list. This selection changes the available 
fields in the form.

Map page Select the pre-configured map page to use for this module. For example, 
Critical Incidents.

Roles Select the roles that are permitted to access this module. If this field is blank, all 
roles can access the module.

Arguments Define the URL for this module in the format map_page.do?
sysparm_name=<map page name>. This field is available when the Link 
type  is URL (from Arguments).

Note: 
If the map page title has a space in it, replace the space with %20  for the 
correct syntax. For example, a map page called Critical Incidents becomes 
Critical%20Incidents%20  in a URL.

6. Click Submit.

Create an advanced Map Page

Use advanced configuration to set up Map Pages without scripting.

Before you begin
Role required: admin

About this task
When clicked, lists and forms display for codeless user experience, facilitating upgrades to 
future releases. Advanced Map Pages do not support mobile. To display Map Pages on mobile 
devices, use the classic Map Page or the mobile map applet in the Now®  Mobile  app instead.

Procedure

1. Navigate to All  > System Map Page  > Map Pages.

2. Click New.

3. On the Map Page form, select the Use advanced configuration  check box.
The script hides and an M2M record appears.
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Note: 
Double-click the record to use the M2M record.

4. In the Name  field, enter a unique name for your Map Page.

5. Click the menu icon ( ) and select Save.
Related links appear at the bottom of the form.

What to do next
Click the Create Map Data Item  related link, and complete the form.

Configure map data items

Add map data items to render data on your Map Page using the Classic Environment.

Before you begin
Role required: admin

About this task
Create a container for your map data items first, then configure and select the data items for your 
Map Page.

Procedure

1. Navigate to All  > System Map Page  > Map Data Items.

2. Click New.

3. On the form, fill in the fields.

Map Data Item form

Field Description

Name Name for the map data item.

Table Table for the condition. For example, select 
the Choice [sys_choice] table.

Condition type Condition using declarative or scripted 
conditions.

Conditions Declarative conditions for your map data 
item.

Application Optional application scope for the map 
marker, if other than Global.

4. Click Submit.

Example: Map Data Item form
Select the options in the table to successfully create a map data item. Use this configuration with 
the examples in Add a map filter  and Configure a map filter data mapping  to successfully create a 
map filter.

Field Description

Name Enter Incident state.
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Field Description

Table Select Choice [sys_choice].

Condition type Select Declarative.

Conditions Input the following into the fields: Element 
is state  and Table is task.

Application Skip this field.

What to do next
Create map markers  for your map.

Create a map marker

Add a map marker icon and define the click behavior to differentiate between data on your Map 
Page using the Classic Environmentlis.

Before you begin
Set up a map data item  before you accomplish this task.

Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Coordinate Definitions.

2. Click New.

3. On the form, fill in the fields.

Map Coordinate Definition form

Field Description

Name Name for your map coordinate definition.

Type Type of map coordinate definition. Select 
Field, which uses the Classic Environment 
(lists and forms), or Script.

Table Table for the condition. For example, incident 
[incident].

Latitude field Latitude field to define map coordinates. 
SelectLocation, then Latitude.

Longitude field Longitude field to define map coordinates. 
Select Location, then Longitude.

Application Optional application scope for your map 
coordinate definition, if other than Global.

4. Click Submit.

5. Navigate to System Map Page  > Map Markers.

6. Click New.

7. On the form, fill in the fields.
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Map Page Marker form

Field Description

Name Name for your map marker.

Data item Data item for your map marker. Select the 
map data item that you previously configured.

Coordinate definition Coordinate definitions for your map marker. 
Select the map coordinate definition that you 
previously configured.

Map Marker Icons M2M map marker icons record. Set up map 
marker icons, or create new ones.

Note: 
Complete all the steps to set up map 
marker icons.

Map Marker Click Actions M2M map marker click actions record. Select 
map marker click actions, or create new ones.

Note: 
Complete all the steps to set up map 
marker click actions.

Application Optional application scope for your map 
marker, if other than Global.

8. Click the menu icon ( ) and select Save.

What to do next
Set up map marker icons and map marker click actions to finish configuring map markers.

Set up map marker icons

Select a relative or absolute URL for a map marker icon to display a data item on the Map Page, 
and determine the map marker priority on the Map Page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Marker Icons.

2. Click New.

3. On the form, fill in the fields.

Map Marker Icon form

Field Description

Name Name for your map marker icon.

Level Marker priority on your Map Page. When 
multiple markers share coordinates, the 
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Field Description

lowest level marker is displayed on your Map 
Page.

Application Optional application scope for you map 
marker icon, if other than Global.

Single icon URL Icon for a single data item from a map 
coordinate on your Map Page. Select a 
relative or absolute link.

Co-located icon URL Icon for multiple data items from a map 
coordinate on your Map Page. Select a 
relative or absolute link.

Scripted condition Optional scripting for map markers.

4. Click Submit.

5. Navigate to System Map Page  > Map Markers.

6. Select your map page marker.

7. In the Map Marker Icons  field, double-click the record and click the search icon ( ).

8. Select your map marker icon, then click the check mark icon ( ).

9. Click the menu icon ( ) and select Save.

What to do next
Continue to the next task to define map marker click actions.

Define map marker click actions

Define the click actions for your Map Page marker. Click actions enable you to define what 
happens when you click a map marker on your Map Page.

Before you begin
Role required: admin

About this task
Select a dialog box that displays form details, or script your own click actions.

Procedure

1. Navigate to All  > System Map Page  > Map Marker Click Actions.

2. Click New.

3. On the form, fill in the fields.

Map Marker Click Action form

Field Description

Name Name for the map marker click action.

Action type Action type for the click action. Select 
Display dialog form  or Script.
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Field Description

Title Title for the map marker click action. The title 
is displayed on the dialog form on your Map 
Page.

Application Optional application scope for your map 
marker click action, if other than Global.

Form View Form view used for the dialog box UI on your 
Map Page.

4. Click Submit.

5. Navigate to System Map Page  > Map Markers.

6. Select your Map Page marker.

7. In the Map Marker Click Actions  field, double-click the record and click the search icon ( ).

8. Select your map marker click action, then click the check mark icon ( ).

9. Click the menu icon ( ) and select Save.

What to do next
Continue to the next task to complete your map marker setup.

Select map markers

Choose a Map Page where you want to apply your map marker.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Pages.

2. Select your Map Page.

3. In the Map Page Markers  field, double-click the record and click the search icon ( ).

4. Select your map marker, then click the check mark icon ( ).

5. Click the menu icon ( ) and select Save.

What to do next
You've set up a map marker. Click Try it  on the Map Pages form to ensure that your map marker 
is set up correctly. After that, create a map filter to show the map markers that you want to see on 
your Map Page.

Note: 
If data is not available, map markers don't show.

Add a map filter

Add a map filter to display filtered map markers. This filter enables you to see only the map 
markers for the data that you want.
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Before you begin
A map data item  should be configured before accomplishing this task. The example map data 
item can work with the example map filter tables below to successfully set up a map filter.

Role required: admin

About this task
Map filters can be configured using lists and forms, or scripting. Create a container for your map 
filters first, configure filter items, and then choose a Map Page for your filter.

Procedure

1. Navigate to All  > System Map Page  > Map Filters.

2. Click New.

3. In the Name  field, enter a name for the map filter.

4. In the Application  field, define the application scope, if other than Global.

5. Click the menu icon ( ) and select Save.

6. In the Map filter item  field, double-click the record and click the search icon ( ).

7. To create a Map Page filter item, click New.

8. On the form, fill in the fields.

Map Page Filter Item form

Field Description

Name Name for your Map Page filter item.

Label Title for your Map Page filter item that's 
displayed in the map filter in your Map Page.

UI Type UI type for your Map Page filter item. This 
determines how your filter displays on the 
map page. Select Single selection, Multiple 
selection, or Date picker. When you select 
Date picker, the data item fields hide and the 
default value script appears.
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Field Description

Data type Data type for your Map Page filter item. Select 
Data item  or Scripted  for the data type. A 
data item enables you to configure or select 
data items using lists and forms.

Application Application scope for your Map Page filter 
item, if other than Global.

Note: 
This field is optional.

Data item Data item for your Map Page filter item. Select 
the data item that you previously configured.

Data item table Data item table for your Map Page filter item.

Note: 
This field is automatically populated 
when a data item is selected.

Data item value field Data item value field for your Map Page filter 
item. Choose how data is used in a table.

Default value script Scripting field for your Map Page filter item.

9. Click Submit.

10. When you return to the Map Page Filter form, click the check mark icon ( ).
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The name of the Map Page filter item that you created is displayed in the field.

11. Click the menu icon ( ) and select Save.

Example: Map Page Filter Item form
Select the options in the table to successfully create your Map Page filter item. This setup works 
with the map data item example.

Field Description

Name Enter Incident.

Label Enter Incident.

UI Type Select Single selection.

Data type Select the data item.

Application Skip this field.

Data item Select Incident state.

Note: 
This data item is the map data item you 
created in the map data item example.

Data item table Skip this field.

Note: 
This field is automatically populated 
when a data item is selected.

Data item value field Select Value.

Default value script Skip this field.

What to do next
Continue to the next task to configure a map filter data mapping.

Configure a map filter data mapping

Choose a Map Page for your map filter, and determine how it functions on the Map Page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Filters.

2. Select your map filter.

3. On the Map Page Filter record, select your map filter item.

4. On the Map Page Filter Item record, locate the Map Filter Data Mappings related list and select 
New.

5. On the form, fill in the fields.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

605



Map Filter Data Mapping form

Field Description

Map page Map Page where your map filter is applied.

Data item Data item for your map filter data mapping. 
Select the data item that you previously 
configured.

Application Optional application scope for your map filter 
data mapping.

Filter item Filter item for your map filter data mapping. 
Select the filter item that you previously 
configured.

Note: 
This field is automatically populated 
with the filter item.

Table Table for your map filter data mapping.

Note: 
This field is automatically populated 
when a data item is selected.

Field Data is retrieved from this field in the table 
that you selected.

6. Select Submit.

Example: Map Filter Data Mapping form
Select the options in the table to create your map filter data mapping. This setup works with the 
map data item example.

Field Description

Map page Select the Map Page that you created.

Data item Select Incident  state.

Note: 
This data item is the map data item 
that you created in the map data item 
example.

Application Skip this field.

Filter item Skip this field.

Note: 
This field is automatically populated 
when a data item is selected.

Table Skip this field.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

606



Field Description

Note: 
This field is automatically populated with 
the Choice [sys_choice] selection.

Field Select Value.

What to do next
Continue to the next task to select your map filter, and complete the map filter setup.

Select map filters

Select your map filter to complete the Map Page filter setup. This setup applies the map filter to 
your Map Page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Pages.

2. Select the Map Page that you want to apply your map filter to.

3. Select the Use advanced configuration  check box.

4. In the Filter  field, click the search icon ( ) and select the map filter that you created.

5. Click the menu icon ( ) and select Save.

What to do next
You've set up your map filter. Continue to the next task  to see that you have successfully created 
it.

Check your map filter

Check to see that your map filter was successfully created in your Map Page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Map Page  > Map Pages.

2. Select your Map Page.

3. Select Try It.

4. In your Map Page, select Filter.
Your map filter displays.

Set map application scope

Enable map application scope to specify which application can modify your Map Page 
configuration.

Before you begin
Role required: admin
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Procedure

1. In the banner, select the Application scope icon ( ).

2. Select Application scope: Global.

3. From the Application list, select the required application.

Create a smartphone map page module

You can create a custom smartphone module that links directly to a map page.

Before you begin
Role required: admin

Procedure

1. Obtain the sys_id of the map page.
The sys_id is required when you create the module.

2. Navigate to System Mobile UI  > Navigator Apps.

3. Open the application menu where you want the new module to appear.

4. In the Modules  related list, click New.

5. Complete the form, as appropriate.

Field Description

Name Enter a name for the module.

Order Enter a number to specify the order of the module within the application menu. 
For example, an entry of 100  would place this module before one with an Order 
entry of 200.

Application 
menu

Select the application menu where you want this module to appear. By default, 
this field displays the application menu that you opened to create the module.

Table Do not select a table.

Updated Displays the date and time when the module record is updated.

Roles Select the roles that are permitted to access this module. If this field is blank, all 
roles can access the module.

Active Select the check box to activate this module. Only active modules appear in the 
application menu.

Filter Do not add a filter condition.

Path Enter map/  followed by the sys_id of the map page. For example: map/
c86c5feac0a80a6600706f0102968196

6. Click Submit.

Scripting for map pages

The Script field on the Map Page form allows the use of attributes or custom code to define map 
characteristics, such as marker appearance, display information, and more.

Scripting map item attributes
The following attributes are available.
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Note: 
To create an item on the map, use the map.addItem(glideRecord)  method. Pass a 
valid GlideRecord to addItem().

Attribute Description

name Name used for identification.

latitude If you define an address, latitude is not necessary.

longitude If you define an address, longitude is not necessary.

icon URL of the icon to display for the marker. If a custom icon is not specified, the 
default Google marker is used.

icon_width Width of the icon. The default is 32.

icon_height Height of the icon. The default is 32.

table_name Table whose records display when the marker icon is clicked. Used with the 
sys_id  attribute.

sys_id Sys_id of the record that displays when the marker icon is clicked. Used with 
the table_name  attribute.

view View of the form displayed in the dialog box when the marker icon is clicked.

html Arbitrary HTML code for the pop-up window. If used, this value overrides the 
dialog box.

marker_label Optional marker icon label text.

label_offset_left Optional attribute that is used with marker_label  to define the horizontal 
position of the marker label. The default is 0.

label_offset_top Optional attribute that is used with marker_label  to define the vertical 
position of the marker label. The default is 0.

Scripting custom map page behavior for smartphone
If you plan to access the map page from a smartphone, you may want to set custom smartphone 
interface behavior using the isMobile  variable. You can use the isMobile  variable to set 
custom behavior for the smartphone view of the map. For example, you might set different values 
for the icon_width  and icon_height  attributes when isMobile  is true.

Basic map page script

This script displays all active, critical incident locations.

//setup new GlideRecord query on the incident table
var now_GR = new GlideRecord("incident");
//add condition for priority 1
gr.addQuery('priority', '1');
//add condition for active incidents
gr.addActiveQuery();
//execute the query
gr.query();
 
//loop through the list of incidents returned by the query
while (gr.next()) {
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 //create a new map item to display - linked to the current 
 incident record
 var item = map.addItem(now_GR);
 //add the latitude value from the incident's location
 item.latitude = gr.location.latitude;
 //add the longitude value from the incident's location
 item.longitude = gr.location.longitude;
 //link to the icon image
 item.icon = 
 "http://maps.google.com/mapfiles/kml/pal3/icon51.png";
 //set the icon size
 item.icon_width = "16";
 item.icon_height = "16";
}

isMobile map page script

This script displays all active, critical incident locations with custom settings for smartphone 
users.

//setup new GlideRecord query on the incident table
var now_GR = new GlideRecord("incident");
//add condition for priority 1
gr.addQuery('priority', '1');
//add condition for active incidents
gr.addActiveQuery();
//execute the query
gr.query();
 
//loop through the list of incidents returned by the query
while (gr.next()) {
 
 //create a new map item to display - linked to the current 
 incident record
 var item = map.addItem(now_GR);
 //add the latitude value from the incident's location
 item.latitude = gr.location.latitude;
 //add the longitude value from the incident's location
 item.longitude = gr.location.longitude;
 //link to the icon image
 item.icon = 
 "http://maps.google.com/mapfiles/kml/pal3/icon51.png";
 
 //set the icon size (use smaller icons for smartphone users)
 if (isMobile) {
   item.icon_width = "12";
   item.icon_height = "12";
 }
 else {
   item.icon_width = "16";
   item.icon_height = "16";
 }
}
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Advanced map page script
This script displays the number of open incidents by location. It varies the size of the icon based 
on the number of open incidents for the location. Using the html parameter, it also displays the 
location name and number of incidents, as well as a link to the list of related incidents.

//get the instances url so we can link back to it
var uri = gs.getProperty("glide.servlet.uri");
//create an aggregate query on the incident table
var count = new GlideAggregate('incident');
//set condition for active incidents
count.addQuery('active', 'true');
//set aggregate field to location to get count by location
count.addAggregate('COUNT', 'location');
//execute the query
count.query();
 
//loop through the results
while (count.next()) {
 
 //get the current record's location
 var loc = count.location;
 //get the count of incidents for this location
 var locCount = count.getAggregate('COUNT', 'location');
 //only display location is there are active incidents
 if (locCount > 0) {
 //create new new map item for this location
 var item = map.addItem(count);
 //set lat/long from the location record
 item.latitude = loc.latitude;
 item.longitude = loc.longitude;
 //build the link to the list of incidents for the location
 var link = 'href=' + uri + 
 'incident_list.do?sysparm_query=active%3Dtrue^location%3D' + 
 loc;
 //build the html value to be displayed when you click the map 
 icon
 item.html='<a ' + link + '>' + loc.getDisplayValue() + ' (' + 
 locCount + ')</a>';
 //link to the icon image
 item.icon = 
 "http://maps.google.com/mapfiles/kml/pal3/icon51.png";
 //set the size of the icon based on the number of active 
 incidents
 if (locCount < 5) {
 item.icon_width = "12";
 item.icon_height = "12";
 }
 else if (locCount < 15) {
 item.icon_width = "16";
 item.icon_height = "16";
 }
 else {
 item.icon_width = "32";
 item.icon_height = "32";
 }
 }
}
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Map page marker label script
Marker labels allow you to add dynamic text to markers. This example displays the active incident 
count at each location.

//get the instances url so we can link back to it
var uri = gs.getProperty("glide.servlet.uri");
//create an aggregate query on the incident table
var count = new GlideAggregate('incident');
//set condition for active incidents
count.addQuery('active', 'true');
//set aggregate field to location to get count by location
count.addAggregate('COUNT', 'location');
//execute the query
count.query();
 
//loop through the results
while (count.next()) {
 
 //get the current record's location
 var loc = count.location;
 //get the count of incidents for this location
 var locCount = count.getAggregate('COUNT', 'location');
 //only display location is there are active incidents
 if (locCount > 0) {
 //create new new map item for this location
 var item = map.addItem(count);
 //set lat/long from the location record
 item.latitude = loc.latitude;
 item.longitude = loc.longitude;
 
 //create a marker label with the count
 item.marker_label = locCount;
 //define label offset for proper position
 item.label_offset_left = -4;
 item.label_offset_top = -20;
 
 //option to define table and record for label hyperlink
 //setting table and sys_id will override the use of html 
 parameter
 //item.table = 'cmn_location';
 //item.sys_id = loc;
 
 //build the link to the list of incidents for the location
 var link = 'href=' + uri + 
 'incident_list.do?sysparm_query=active%3Dtrue^location%3D' + 
 loc;
 //build the html value to be displayed when you click the map 
 icon
 item.html='<a ' + link + '>' + loc.getDisplayValue() + ' (' + 
 locCount + ')</a>';
 
 //link to the icon image
 item.icon = "images/red_marker.png";
 //set the size of the icon based on the number of active 
 incidents
 item.icon_width = 24;
 item.icon_height = 24;
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 }
}

Customizing instance appearance

An administrator can change global CSS or system properties to alter the look and feel of the 
default instance interface. Functionality is not affected.

For example, organizations often use multiple instances to separate development, testing, 
and production activities. To help users avoid accidentally changing the wrong instance, 
administrators can configure each with a visually distinct theme. Several approaches are 
available for defining an instance theme.

CSS Properties

Navigate to System Properties  > CSS.

The following properties are available through CSS Properties.

Note: 
Colors are specified using predefined color names , RGB decimals, or RGB hexadecimals.

• Banner text color

• Banner and list caption background color

• Font used in forms and lists (this is a global font setting)

• Button styles (background color, border color, border width, text color)

• Field status indicator colors (including the indicators for Changed, Mandatory Populated, 
Mandatory Unpopulated, and Read-only)

• List cell vertical alignment

• Navigator menu styles (text font size, background color, text color)

• Header font name and size

• List and form caption color override

• Global text search background color (both for catalog results and knowledge base results)

UI properties

Navigate to System Properties  > UI Properties.

The following properties are available through UI Properties.

• Icons used in the activity formatter

• Background colors for Additional Comments and Work Notes

• Button placement on forms

• Icons used in the Task Activity formatter

• Background colors for Incident Additional Comments and Work Notes

CSS class support

In Core UI  (UI16), CSS properties and how they affect the platform UI change depending on the 
release.
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Note: 
Settings configured from the Basic Configuration UI16 page are not applicable to instances 
with Next Experience  enabled.

Supported CSS classes

CSS class Description How to configure

$navpage-header-bg Header background color Navigate to System 
Properties  > Basic 
Configuration UI16  > Header 
background color

$navpage-header-color Color for header text and the 
global search icon

Navigate to System 
Properties  > Basic 
Configuration UI16  > Banner 
text color

$navpage-header-button-
color

Color for logged in user name 
text, and the global search 
Connect, Help, and settings 
icons

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$navpage-header-divider-
color

Header divider color Navigate to System 
Properties  > Basic 
Configuration UI16  > Header 
divider stripe color

$navpage-button-color Color for the following icons in 
the sidebars

• Expand/collapse

• Create a conversation (in 
the Connect  sidebar)

• Open Connect  workspace

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$navpage-button-color-hover Color for the following icons 
when a user points to the 
control:

• Global search

• Help

• Settings

• Clear text icon in the 
navigation filter

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$search-text-color Color of the search text, both 
in the navigation filter and the 
global search fields

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$navpage-nav-border Border color for the navigation 
filter and the conversation 
filter

Navigate to System 
Properties  > Basic 
Configuration UI16  > Border 
color for UI16
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Supported CSS classes  (continued)

CSS class Description How to configure

$nav-highlight-main Highlights the module after 
the user has clicked it. In 
the Connect  workspace, 
highlights the selected 
conversation.

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$subnav-background-color Background for expanded 
navigation items

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation background 
expanded items

$navpage-nav-bg Header and footer for 
navigator and sidebars.

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation header/footer

$navpage-nav-bg-sub Background for navigator and 
sidebars

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Background for navigators 
and sidebars

$navpage-nav-color-sub Text color for modules in the 
main navigation

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$navpage-nav-mod-text-hover Text color when hovering over 
items in the main navigation

Not supported

$nav-hr-color Navigator separator color Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation separator color

$nav-highlight-bar-active Line under the active tab in 
the application navigator. This 
color is also used as part of 
the theme preview on the 
Themes tab under system 
settings.

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation selected tab 
divider bar color

$nav-highlight-bar-inactive Line under the inactive tabs in 
the application navigator

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation unselected tab 
divider bar color

$navpage-nav-selected-bg Navigation selected tab 
background color

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Navigation selected tab 
background color

$navpage-nav-selected-color Currently selected Navigation 
tab icon color

Navigate to System 
Properties  > Basic 
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Supported CSS classes  (continued)

CSS class Description How to configure

Configuration UI16 
> Currently selected 
Navigation tab color for UI16

$navpage-nav-unselected-
color

Unselected navigation tab 
icon and favorite icons color

Navigate to System 
Properties  > Basic 
Configuration UI16  > 
Unselected navigation tab 
icon and favorite icons color

$connect-latest-message Color of the currently selected 
message in Connect

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$nav-timeago-header-color Timestamp header 
backgrounds in History tab

Not supported

$navpage-nav-app-text Core content text color for 
items such as applications 
and the empty state text for 
the Connect  sidebar.

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

$navpage-nav-app-text-hover Text color for a selected 
module

Add the CSS property to the 
CSS field of a theme. For more 
information, see Create or 
customize a theme.

Configure logo, colors, and system defaults for Core UI

You can use the Basic Configuration Core UI  module to brand your instance with your company 
logo and colors and set basic system defaults. This place is the best starting point if you are 
setting up your instance for the first time or if you have recently enabled Core UI.

Before you begin
Gather the following:

• Obtain the company banner image to use in the header. The image can be high resolution, but 
when it displays it’s scaled based on the aspect ratio. It scales to a maximum of 20 px high.

• Get the brand color hex or RGB numbers of your company, typically from your marketing 
department. Use them to decide how to configure the UI background colors.

Role required: admin

About this task
Each color selection option provides a color picker to select a color. The text box beside the color 
picker lets you enter the value of the color as any of the following CSS formats:

• Name: predefined color names, such as red, green, or blue

• RGB decimal: RGB (102, 153, 204)

• RGB hex:  223344

Refer to HTML Color Names (W3CSchools)  for information about HTML color names.
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Note: 
This information is only applicable for instances that do not have Next Experience  enabled. 
For theming information for Next Experience, see Working with themes in Next Experience.

Procedure

1. Navigate to All  > System Properties  > Basic Configuration UI16.

2. Complete the configuration by changing any of the following settings:

Basic system configuration properties

Label Property Description

Page 
header 
caption

glide.product.description Change the text that appears next to your logo.

Browser tab 
title

glide.product.name Change the text that appears on the browser tab.

System 
timezone 
for all users 
unless 
overridden 
in the 
user's 
record

glide.sys.default.tz Select the time zone in the list.

Select Configure available time zones  to select the time 
zones that your users can select from in user preferences.

Banner 
image for 
Core UI

glide.product.image.light Select +  next to the image and upload your logo.

Date format

Time format

glide.sys.date_format

glide.sys.time_format

Select the date and time format from the choice lists.

Header 
background 
color

css.$navpage-header-bg Select or enter the color.

This color is also used as part of the theme preview on the 
Themes tab under system settings.

Banner text 
color

css.$navpage-header-color Select or enter the color.

This color is also used as part of the theme preview on the 
Themes tab under system settings.

Header 
divider 
stripe color

css.$navpage-header-divider-color Select or enter the color.
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Label Property Description

Navigation 
header/
footer

css.$navpage-nav-bg Select or enter the color.

Navigation 
background 
expanded 
items

css.$subnav-background-color Select or enter the color.

Module text 
color for 
the Core UI 
application 
navigator

css.$navpage-nav-color-sub Select or enter the color.

Navigation 
selected 
tab 
background 
color

css.$navpage-nav-selected-bg Select or enter the color.

Navigation 
selected 
tab divider 
bar color

css.$nav-highlight-bar-active

This color is also used as part of the theme preview on the 
Themes tab under system settings.
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Label Property Description

Navigation 
unselected 
tab divider 
bar color

css.$nav-highlight-bar-inactive

Navigation 
separator 
color

css.$nav-hr-color Select or enter the color.

Background 
for 
navigator 
and 
sidebars

css.$navpage-nav-bg-sub Select or enter the color.

Currently 
selected 
Navigation 
tab icon 
color for 
Core UI

css.$navpage-nav-selected-color Select or enter the color.

Unselected 
navigation 
tab icon 
and favorite 
icons color

css.$navpage-nav-unselected-color Select or enter the color.
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Label Property Description

Border 
color for 
Core UI

css.$navpage-nav-border Select or enter the color. Also affects the border of the 
Filter conversations  search box in the Connect Chat 
sidebar.

Selected 
base theme

glide.ui.base_theme.selected_theme Switches the main content (everything other than the 
application navigator and the header) between the La Jolla 
and Cobalt themes.

For most of the settings, as you make changes, the page refreshes with a preview of the 
change. Only you see these changes. Some settings require you to log out and log back in 
again to see the change.

3. Select Save  at the top or bottom of the page.

Result
After you save the configuration changes, all users who select the System  theme in their UI 
personalization options see the new configuration colors.

La Jolla and cobalt theme comparison

The La Jolla theme is the new brand theme for ServiceNow. When you upgrade to Madrid, your 
theme is automatically upgraded to the La Jolla theme. Any customizations you have made to 
the system theme will not be upgraded. Use the styles in the list below to upgrade or revert any 
styles to the new or old theme.

Make changes to any of these styles by navigating to System Properties  > Basic Configuration 
UI16.

La Jolla and Cobalt theme styles

Property La Jolla style Cobalt style

Header background color

css.$navpage-header-bg

 ffffff  303a46

Header divider stripe color

css.$navpage-header-divider-
color

 5a7f71  455464

Navigation header/footer

css.$navpage-nav-bg

 293e40  303A46

Navigation background 
expanded items

css.$subnav-background-
color

 213234  303a46
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La Jolla and Cobalt theme styles  (continued)

Property La Jolla style Cobalt style

Module text color for UI16

css.$navpage-nav-color-sub

 bec1c6  bec1c6

Navigation selected tab 
background color

css.$navpage-nav-selected-
bg

 2f4fe  4b545f

Navigation selected tab 
divider bar color

css.$nav-highlight-bar-active

 82c9b8  278efc

Navigation unselected tab 
divider bar color

css.$nav-highlight-bar-
inactive

 213234  81878e

Navigation separator color

css.$nav-hr-color

 293e40  303a46

Background for navigator and 
sidebars

css.$navpage-nav-bg-sub

 293e40  455464

Currently selected Navigation 
tab icon color for UI16

css.$navpage-nav-selected-
color

 82c9b8  ffffff

Unselected navigation tab 
icon and favorite icons color

css.$navpage-nav-
unselected-color

 bec1c6  bec1c6

Border color for UI16

css.$navpage-nav-border

 7a828a  ddd

Selected Base Theme

glide.ui.base_theme.selected_theme

La Jolla SysID: 
c92c1ee153002300dda1ddeeff7b125b

Cobalt SysID: 
6f3c9ae153002300dda1ddeeff7b124a

Select a theme in Core UI

You can switch between different themes for the user interface.
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Before you begin
Role required: admin

About this task
Themes are user-specific. Each user can select a different theme and the selection is stored as a 
user preference.

This topic applies only when the Next Experience  is not enabled. For information about selecting 
a theme with Next Experience, see Select a theme in Next Experience.

Procedure

1. Select the gear icon ( ) in the banner frame to access the System Settings window.

2. Select the Theme  tab, and then select the theme.

Customize menu categories

Use menu categories to apply CSS styles to application labels.

Before you begin
Menu categories are deprecated in Core UI.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Menu Categories.

2. Fill in the fields on the form, as appropriate.

Description

Administration Applications in this category have a light blue background.

Style: border-color:  a7cded; background-color:  e3f3ff;

Custom 
Applications

Applications in this category have a light gray background.

border: 1px solid  96bcdc; background-color:  FBFBFB;

Label Applications in this category have a blue background.

border-color: blue; background-color: rgb(102, 153, 204); color: white

Maint Applications in this category have a blue background.

Style: border-color: blue; background-color: rgb(102, 153, 204); color: 
white

SocialIT Applications in this category have a blue background.

border-color: blue; background-color: rgb(102, 153, 204); color: white

3. Optional:  To add an application to a category, add it in the related list of applications at the 
bottom of the category record, or specify the category on the application record.
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Change survey question header colors

The Classic Environment uses a header color from the base color, which allows theming from 
CSS properties.

About this task
One notable exception is the survey, which has its own CSS. It is possible to change the CSS by 
adding a property.

Procedure

1. Enter sys_properties.form  into the navigation filter and press the Enter key.
A new Property form displays.

2. Name the new property css.list.row.survey.background.color.

3. Enter the hexadecimal value of the desired color into the Value  field.

4. Click Submit.
The survey should now use the desired color.

CSS theme support

Themes give the user interface a specific look and feel by using different color combinations.

System administrators can create themes or customize the existing themes for an instance. To 
see existing themes, navigate to System UI  > Themes.

Activating CSS theme support

There are different plugins that activate CSS themes support.

Activate the following plugins to use themes, based on the version of the UI you use.

Core UI:  CSS Theme support See Activate a plugin .

Create or customize a theme

You can create themes or customize existing themes.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > Themes.

2. Choose from the following options.

◦ To create a new theme, click New.

◦ To customize an existing theme, click the theme name.

3. Enter a name for the theme in the Name  field.

4. Add any of the default CSS styles  in the CSS  field.
Sometimes the default style is not the only style definition for an object. In such cases, 
you can use the CSS important rule  format to override any other style definitions with the 
default definition. For example, this definition overrides the text color in the main navigation: 
$navpage-nav-color-sub: ➚fff !important.

5. Select the Active  check box.

6. Select one of the following from the Device  choice list to identify the user interface version for 
the theme.
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7. Click Submit.

What to do next
Refresh the page to see the new theme in the theme picker. The theme picker displays only 
themes that are compatible with the current version of the UI.

Default CSS styles

You can use CSS styles to control the appearance of elements in a theme.

Your version of the UI determines which CSS styles you can use.

Default CSS styles for Core UI  (UI16)

$search-text-color: ➚ffffff
$navpage-header-bg: ➚293e40
$navpage-header-color: ➚ffffff
$navpage-header-divider-color: ➚5A7F71
$navpage-header-button-color: ➚ffffff
$nav-highlight-main: ➚576667
$subnav-background-color: ➚213234
$navpage-nav-bg: ➚293e40
$navpage-nav-bg-sub: ➚293e40
$navpage-nav-color-sub: ➚d1d6d8
$nav-hr-color: ➚192628
 
$nav-highlight-bar-active: ➚82c9b8
$nav-highlight-bar-inactive: ➚213234
$navpage-nav-selected-bg: ➚2f4f4e
$navpage-nav-selected-color: ➚82c9b8
$navpage-nav-unselected-color: ➚d1d6d8
 
$connect-latest-message: ➚B8E0D7
$navpage-nav-app-text: ➚ffffff
$navpage-nav-border: ➚7a828a
$navpage-button-color: ➚ffffff
$navpage-button-color-hover: ➚82C9B8
    

Create a company profile

To customize the ServiceNow  instance for your company, you can enter information such as 
contact phone numbers, street address, and additional notes. You can also customize the 
company logo and banner text your end users see at the top of each page.

Before you begin
Role required: admin

About this task
Much of the company information that you enter is reference information that administrators can 
view. All users see the company logo and banner text. To see all company information, verify that 
you are in the My Company  view.
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My Company view selection

Procedure

1. Navigate to All  > System Properties  > My Company.

2. To change the banner text, update the Banner text  field.

3. Select the Primary  check box to indicate if this company is the primary company.
If needed, configure the form  to add the Primary  check box. Designate only one company in 
your system as the primary company.

4. To upload your company logo, select Click to add  or Update  beside UI16 Banner Image.
If you leave the banner image blank in Core UI  (UI16), the system uses the image used in 
System Properties  > Basic Configuration  > Banner image  [glide.product.image] as the 
default.

5. Click Choose file  and select the file, and then click OK.
To use an image URL instead of a file on your hard drive, enter the URL in the file upload 
window.
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6. Complete the form with remaining company information.

7. Click Update.

Banner logo link

Properties are available to control the URL and target frame used when clicking the banner logo.

• glide.banner.image.url: URL used when clicking the banner image

• glide.banner.image.url_target: Target frame used when clicking the banner image

◦ gsft_main  for the main frame

◦ _topto replace the current browser window

◦ _blank  for a new window/tab

Customize the banner logo in Core UI

Use the glide.product.image  and glide.product.description  properties to 
change the banner logo and description in Core UI.

Before you begin
Role required: admin

About this task
To update the banner image in the System Properties  > System  page, you must first upload the 
image.

Note: 
Setting a banner image in the company profile overrides the image selected in System 
Properties  > System.

Procedure

1. To upload the image, complete the following steps.

a. Navigate to System UI  > Images  and click New.

b. Enter a Name  for your image.
Valid names must end in .gif, .png, .jpg, or .bmp.

c. Click the Click to add  link in the Image  field, and select and upload the image.

d. Click Update.

2. To set the uploaded image to the banner image, complete the following steps.

a. Navigate to System Properties  > System.

b. In the Banner image  field, enter the file name of the uploaded image.

c. Click Save.

Note: 
The system limits banner images to 50px.
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Customize the favicon

Use the glide.product.icon  property to change the icon that appears in bookmarks and 
the browser address bar.

Before you begin
Before you can update the favicon, you must upload the image into the database.
Role required: admin

Procedure

1. To upload the image, complete the following steps.

a. Navigate to System UI  > Images  and click New.

b. Enter a Name  for your image.
Valid names must end in .gif, .png, .jpg, .ico, or .bmp.

c. Click the Click to add  link in the Image  field, then select and upload the image.

d. Click Update.

2. To set the uploaded image to the favicon, complete the following steps.

a. Navigate to System Properties  > System.

b. In the Icon image displayed in the bookmarks and browser address bar  field, enter the file 
name of the uploaded image.

c. Click Save.

Result
The favicon appears in the bookmarks and browser address bar for the platform or the Content 
Management System (CMS). For more information on how to change the favicon for Service 
Portal, see Create a portal.

Examples of how to modify the banner

There are various ways that you can modify the banner on your instances.

Note: 
From the San Diego  release on, configure banner announcements instead of updating 
glide.product.description. For more information, see Configure Next Experience 
banner announcements.

Label multiple instances differently

• On all instances, leave glide.product.description  <blank>

• On PROD instance, set glide.product.name  to <My Company>

• On DEV instance, set glide.product.name  to <My Company - DEV>

Control the window title

Since the window title is composed of glide.product.name  and 
glide.product.description, the following gives you complete control over the banner 
and the window title.
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• glide.product.name  set to <Window Title that you want>

• glide.product.name.style  set to <display: none>

• glide.product.description  set to <blank>

The company record Banner Image  and Banner Text  are used to set the banner image and text 
since the company banner text is not used in the window title.

Use HTML in the banner text

• glide.product.name  set to <My Company>

• glide.product.name.style  set to <display: none>

• glide.product.description  set to <Some text <a href="some_url">Click here</a>>

Position banner text over the banner image

• glide.product.name  set to <My Company>

• glide.product.name.style  set to <display: none>

• glide.product.image  set to <your company logo.gif>

• glide.product.description  set to <Some text for the description>

• glide.product.description.style  set to <position:absolute; top:5px; left:100px> 
(position values may vary based on specified needs)

Apply a background image to the banner

Often corporate guidelines require more in-depth branding of the ServiceNow  interface. Using 
the tiling technique, you can modify your logo image to have a transparent background, so that 
you can apply another image to the banner beneath the logo.

Upload an image to the image manager and then create a new property named 
css.banner.background.image, so that you can call the image. The value should look 
like this.

css.banner.background.image  value url('./images/MasterBG.jpgx')

Write CSS rules that apply this change

/** BACKGROUND - These properties allow you use to 
 add a background tile to the header of the instance 
 ***************************/
TD.bannerLeft,TD.bannerCenter,TD.bannerRight, 
 TR➚banner_row{background-color: ${banner.background.color};
background-image: ${banner.background.image};
background-position: ${banner.background.position};
background-repeat: ${banner.background.repeat};}

Note: 
The banner image and banner text associated with the primary company or 
specific companies may be used instead of the glide.product.image  and 
glide.product.description  properties to get the same effect.
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Modify the banner

The banner is displayed at the top of the page and is rendered using certain system properties.

Note: 
From the San Diego  release on, configure banner announcements instead of updating 
glide.product.description, which is not used when Next Experience  is enabled.

For more information, see Configure Next Experience banner announcements.

• glide.product.image

• <div>glide.product.name</div>

• <div>glide.product.description</div>

The DIV that contains the glide.product.name  property is only shown if the property 
contains a value, otherwise, it is not used when rendering the banner. Also, the property 
glide.banner.image.title  controls the tooltip that appears when the cursor is over the 
banner.

Note: 
The My Company record overrides the properties.

Window title

These properties are used to set the window title as follows:

glide.product.name  glide.product.description

If glide.product.name  is blank, then the ServiceNow  name is used as the product name for 
the window title.

My Company

The banner text and banner image defined for the Company that a user is assigned to may be 
used to override the glide.product.image  and glide.product.description. The 
banner text, if specified, is used instead of the glide.product.description  property. 
The banner image, if specified, is used instead of the glide.product.image  property.

Add help to a field label on a form

You can create field-level help in forms by placing help icons in individual fields and converting 
the field labels to links to external or internal URLs.

Before you begin
Role required: personalize_dictionary

About this task
You can link to any type of file, document, or wiki, and open it in a separate browser window. The 
following is an example of a form with field label help enabled.
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Field label help enabled

Procedure

1. Open the form.

2. Right-click the label for the field and select Configure Label.

3. Complete the form.

Field Input value

Hint Type text to use as a tooltip that appears when a user places the cursor on the field 
label.

URL Enter the URL of the target file to open when the field label or icon is clicked. This can 
be a complete URL to a file outside the instance, or a relative URL to a target on the 
instance.

Note: 
Links aren't supported in Workspace.

URL 
target

Not used. The help file opens in a new tab regardless of the URL target  value.

4. Click Update.

Content Management System
The Content Management System (CMS) is a ServiceNow  application that enables users to 
create a custom interface for the ServiceNow  platform and ServiceNow  applications.

Important: 
Use Service Portal  for new development instead of CMS. Service Portal  is an alternative to 
CMS with a refined user experience, and is active by default in the base system. For more 
information, see Service Portal  and Content Management and Service Portal.

A CMS typically requires a systems administrator or a web developer to set up and add features. 
Non-technical users can use the CMS application as a tool for website maintenance. You also 
want to consider the timing of the addition of content management, and the maturity level of 
ServiceNow  data. For more information, see CMS Planning.

Following are several CMS project ideas:

• Design a company-wide service catalog that offers a collection of services.

• Present a customized UI for a knowledge base.
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• Create customized login pages, search pages, views of lists, tables, charts, or graphs.

• Design a complete website.

• Integrate ServiceNow  with other company applications.

• Build a tailored self-service portal for end users that is in compliance with a corporate style 
guide.

Example CMS sites

There are two common interface approaches within the ServiceNow  community:

• An image and text-based interface similar to Amazon.com

• A search-based interface similar to Google

Both approaches have been used successfully. The approach you select depends on the needs 
of the people using the data and how easy it is to train them. While the two design philosophies 
are different, both approaches share the common goal of UI simplicity.

Content Management design

Before building a website in the CMS, it is important to have a good understanding of what to 
build and who the audience is.

A high volume of content can heavily influence the look and feel of the site and the site hierarchy. 
When deciding the content, design for ease of maintenance for the people who take care of the 
system. This level of planning can be time-consuming, but is important.

Review website design prerequisites to help you set expectations, scope deliverables, and 
define reasonable time lines. Consider both the planning and execution of site design, to 
understand how sites are built, and to provide a working overview of the CMS.

Timing is important when considering the addition of content management. Successful 
deployments of the content management system usually take place after phase 1 processes (for 
example, Incident, Problem, Change, Catalog, and Knowledge) are in place. This is especially 
true if the team has limited website design experience. Waiting until phase 2 of deployment gives 
administrators time to work in ServiceNow  and to understand how the organization uses the 
system and what business needs it meets.

Also consider the maturity level of data in the ServiceNow  system. Depending on the ITIL 
processes used, content management is only useful and effective once the data within 
ServiceNow  is established. Ensure that hierarchies, tasks, and workflows are well-defined. For 
example, before creating a catalog interface, confirm that the service catalog has been in place 
for some time, has been used, and contains data. The same is true for a knowledge management 
interface, particularly when high ratings or view counts define article placement on the page.

Content organization

Before you begin to build the CMS website, list all the content that you want to include and take 
the time to organize it.

A site created in CMS relies on two different types of content.

• CMS site information, such as site pages, images, and menus

• System information, such as knowledge base articles and catalog items
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CMS content

Begin by listing all the content you want to host on the CMS pages. Examples include help 
pages, My Requests, My Approvals, and specific catalog items. Think about current solutions 
that you can implement immediately, and note ideas for future implementation phases.

Within CMS, you group pages to define the top-down menu structure. You establish a home or 
starting page, and other pages in the site reference the home page in the Parent Page  reference 
field.

There are several ways to group, such as by audience or the purpose of the website. After listing 
the content to host, group it logically and identify a common name for each group, as shown in 
the following examples.

IT environment groups

Content built for Common name

End user End User Page

IT professional IT Professional Page

General groups

Purpose of site Common name

Reports Reporting Page

Help and knowledge Knowledge page

System content

Organize the content so the interface is easy to navigate and understandable to the user. 
Determine the organization based on the data that you are leveraging, both in the CMS (using 
sites, parent pages, pages, and navigational menus) and throughout the rest of the system. For 
example, within the catalog you have "category," and in the knowledge base you have "category" 
and "subcategory." You can use these hierarchies with filtered lists for good search results.

Organizing CMS content logically is important for long-term maintenance of the site, however, 
the data typically comes from other ServiceNow  applications. Communicate with the 
administrators for these applications, such as the knowledge base, service catalog, and 
business service portfolio. Work with them to offer the application data appropriately through the 
CMS pages you create. For example, the team that created the ServiceNow  corporate website in 
CMS began by evaluating the naming conventions used in the corporate knowledge base.

Branding elements

Branding refers to the logo, name, colors, and symbols that identify an organization. It imposes 
consistency in design and use of terms. Your marketing department defines branding elements 
and can provide them to you as you plan your CMS pages. Consider how to incorporate the 
following branding elements.

• Logos

• Color palette

• Tag line
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• Trademarked elements

• Graphics

Site design

During planning, consider providing a core set of features with a standard appearance 
throughout the site. The following web design elements are often used to create a consistent 
look.

• Page templates

• Navigation schemes

• Header

• Breadcrumbs

• Footer

• Forms

ServiceNow  features

Analyze and organize the following ServiceNow  features in your instance if you plan on using any 
of them with CMS pages.

• Account settings

• Email

• Workflow approvals

• Filters

Team member identification

Identify the team members who assist you with website design, branding, and development.

Engage team members for each listed function before you begin to build pages for the CMS 
website. Each function can be performed by the same or different people.

• Gather corporate style design guidelines.

• Define the written terminology and content for the site.

• Gather and define the site flow.

• Manage the CMS project as the webmaster. The CMS webmaster is responsible for executing 
the design and making the site work. The following skills are required:

◦ Basic ServiceNow  administration skills

◦ HTML

◦ CSS

◦ Graphic design

◦ Web design

After you identify the project team members, establish who is responsible to complete the tasks 
involved in building the CMS website.
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• Determine who owns each page.

• Set a page update schedule so owners do not overwrite each other.

• Formalize content management processes, including content review and page updates.

Data preparation

It is important that there is enough data in the ServiceNow  instance before you begin to build the 
CMS website.

Ensure that the necessary data and content are available in the instance by taking the following 
actions.

• Review the ITIL processes that you intend to implement in the CMS. Ensure that the data in 
the instance is a mature representation of the applications being used, for example, service 
catalog, knowledge management, and incident management.

• Review the defined hierarchies, such as the categories and subcategories for the knowledge 
base or service catalog. You use these categories to design the entry page into the application.

Corporate style guide

When you build a CMS website, you design the look and feel based on guidelines in the 
corporate style guide.

A corporate style guide provides detailed information for designing any corporate interface, 
including corporate websites.

Corporate design team

Many organizations have a web development team that designed the corporate 
website. Contact this team and involve the designers early in the planning, as they 
provide help and give their approval to the interface you design. Without approval, 
there is the risk of having to redesign the entire site because it does not adhere to 
the organizational guidelines.

Corporate style guide

A corporate style guide takes the guesswork out of designing the CMS website. The 
example style guide shown is defined down to the pixel. Creating a site with the 
style guide makes it easy to create clean CSS and HTML. Without the style guide, 
building the site can take a great deal of time.

Design considerations

Some modifications to the base design for forms may be necessary. The content 
area of any CMS design should be no smaller than 860px, or service catalog forms 
are clipped. The sample style guide entry specifies the content area to be 576px, 
which clips service catalog forms.
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Example style guide entry

Prototypes and rapid web design

Many user interface designers use prototypes and rapid web design techniques to visualize the 
final product before it is developed.

Design revisions are the most time consuming and expensive phase of site design. When the 
team analyzes and then uses prototypes to create pages, revisions to the published pages are 
minimal.

Develop the prototype and print it. Review the design with the appropriate team members and 
annotate the prototype, and annotate what to update on each page.

Define the following elements within the prototype.
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• The site map for the entire site.

• A detailed prototype of every intended page, including elements such as links, link 
destinations, content, page names, and page descriptions.

Content Management navigation

After you design the hierarchical structure of the site, begin planning site navigation.

Consider the following as you plan site navigation.

• Placing navigation elements on every page.

• Locating navigation elements in the same place on every page.

• Using either text or images for navigation.

• Providing visitors with an easy way to understand where they are in the site, for example, with 
breadcrumbs or a specific color scheme.

• Adding a site map, which is a one-page, hyperlinked, hierarchical outline of the site.

• Providing a link to the home page from every site page, as visitors often enter the site on a 
page other than the home page.

• Designing navigation to help visitors find information quickly with as few clicks as possible.

In the CMS, navigation menus define your site navigation. Build menus as navigational blocks to 
create navigation paths. The menu chosen for the task depends on the size and complexity of 
your site. Available menu options include the following items.

• List menus

• Two types of tab menus

• Vertical, clickable list, usually placed on the left side

• Horizontal blocks

• Vertical blocks

• Super menu (a menu of menus)

System content management

Most of the content in a CMS site is managed in different locations throughout the system.

For example, if you are building a knowledge website, the pages and blocks exist in CMS, but the 
knowledge articles are authored and managed in the Knowledge application. The same is true for 
any other type of content you plan to leverage. It is important to take time to understand the table 
structure of data to become acquainted with content.

Links to content are typically static, however, take time to look at the document tree and review 
how field values are formatted for use within the CMS. To understand the information provided 
below, right-click within forms in the platform and select Show XML  to view the document tree 
for the referenced table. To see the table values for each field, right-click the form label and 
choose Show - (field name)  or Configure Dictionary  for reference.

Look at several internet news sites for ideas on how to format dynamic list data and also the full 
article detail. Research blog sites, shopping sites, and any other site you find easy to use, as 
layout and usability design can be time-consuming. If you find a site that inspires you, emulate it 
in your design.
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• This New York Times example  has two separate list formats.

• The CNN example  has several list formats on the page.

• Several different list formats are used on the ServiceNow  website.

Knowledge articles - kb_knowledge table

When you right-click and select Show XML  on any form within the system, the document tree for 
the referenced database table becomes reference-able. Review the following selected subset 
of the document tree so you can acquaint yourself with the content readily available to your site 
design.

<kb_knowledge>
  <active>true </active>
  <author display_value= "First Last Name" >Use this field value 
 if author name is important </author>
  <short_description>Use this field value as the link to the 
 full article detail </short_description>
  <description>Provide this field value as a 1-2 sentence 
 summary of the article </description>
  <number>Unique ID can be leveraged in a number of different 
 ways </number>
  <published>Published time stamp of the article  </published>
  <rating>This field value provides a 1 to 5 star rating similar 
 to iTunes </rating>
  <sys_updated_on>Add to supplement article published timestamp 
 </sys_updated_on>
  <sys_view_count>8 </sys_view_count>
  <topic>Useful field value in creating hierarchical breadcrumbs 
 </topic>
  <category>Also useful in organizing articles hierarchically 
 </category>
  <use_count>Use this similar to Facebook's "like" feedback, 
 answer to the question was this useful </use_count>
</ kb_knowledge>

<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" 
 xmlns:j2 = "null" xmlns:g2 = "null" >
 
<div class = "cms_knowledge_list customer_success" >
 <g:for_each_record file = "${current}" max = 
 "${jvar_max_entries}" ><br /><table cellspacing = "0" 
 cellpadding = "0" border = "0" class = "background_transparent" 
 >
  <tr><td class = "cms_knowledge_list_image" >
  <j:if test = "${current.u_logo.getDisplayValue() != ''}" >
   <div class = "knowledge_article_logo" >
     <a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_i
d}" >
       <img src = "${current.u_logo.getDisplayValue()}" alt = 
 "${current.text}" width = "110px" />
     </a>
   </div>
  </j:if>
  </td>
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  <td width = "100%" >
  <a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_i
d}" target = "_top" >
    <span class = "cms_knowledge_list_link" 
 >${current.short_description}</span>
  </a>
  <p class = "kb_description" > "${current.description}"
  <!--${SP}-${SP}<span 
 class="cms_knowledge_list_author">${current.author.first_name}$
{SP}${current.author.last_name}</span>-->
  </p>
  </td></tr><tr>
  <td width = "100%" colspan = "2" class = "kb_learn_more" >
  <p class = "kb_learn_more" >
    <a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${current.sys_i
d}" >Learn More</a>
  </p></td></tr></table>
 
</g:for_each_record></div>
 
</j:jelly>

Domain separation and the Content Management System

Domain separation is supported in the Content Management System. Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Configure Content Management sites

Planning a CMS site involves obtaining resources, communicating with others about design, and 
gathering content.

Before you begin
Role required: content_admin or admin

About this task
The following steps are a high-level overview of how to set up a site.

Procedure

1. Plan and design your content.

2. Create a site.
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The site is the container that holds all the content. To simplify your process, you can copy an 
existing site and edit its components. For more information on creating a site, see Create a site. 
For more information on copying a site, see Copy a site.

3. Add pages to the site.
Pages contain blocks of information for the site. For more information, see Create a content 
page.

4. Create content blocks to customize the layout, headers, menu navigation, lists, and static and 
dynamic content.
Content blocks are chunks of actual HTML that make up the content page. There are various 
content block types available to help with your customization. For more information, see 
Content blocks.

5. Add style to your site using themes, style sheets, and frames.
Neither content sites or content pages reference style sheets directly. Configure them using 
the Themes or Style Sheets options. For more information, see Style in Content Management.

6. Test the site.
After you create or modify a site, test the site to ensure that content displays properly and all 
links work correctly. For more information, see Test the site.

Related topics

Content Management design

Content sites

A content site is a group of related content pages that have the same basic theme, layout, and 
URL suffix.

Content sites are made up of a series of basic building blocks. The Employee Self-Service site 
is an out-of-box sample site that is included in the CMS activation. It provides existing, working 
examples or each CMS component, which you can use like a template to build your own site.

Site components
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Create a site

Configure a site by either creating a new site with CMS or by editing a copy of either the ESS 
Portal or the Service Management Portal.

Before you begin
Role required: content_admin or admin

About this task
If you are creating a catalog site in CMS, see Using the content management system with the 
Service Catalog .

Procedure

1. Navigate to All  > Content Management  > Sites.

2. Click New.

3. Complete the form.
Since you have not yet created pages, you cannot select the Home, Search, Login, and Gauge 
target pages. Add them to the site record after you create them.

Site fields

Field Description

Name A unique name for the site.

URL suffix The URL suffix that identifies the site. The URL suffix is case-sensitive, the suffix 
you enter impacts the CMS site URL used to launch the site. It is incorporated 
into the URL as follows:

http://<instance name>.service-now.com/url_suffix/
page.do

Note: 
Do not use portal  and cms  in the URL suffix. They are reserved terms 
and return a Page not found  if you use them.

Home 
page

The page to display when the user does not specify a page name in their URL:

http://<instance name>.service-now.com/url_suffix/

Search 
page

The page that displays search results when a user searches from any page 
within the site.

Login page The page to use for logging in to the site. If specified, users must log in to 
access the pages on the site. If left blank, no login is required to access the 
pages within the site.

Gauge 
target page

The page that displays gauge content. When the user clicks a gauge on the new 
site, the gauge target page opens to show the gauge content. The gauge target 
page replaces the CMS page in the current tab.

Title A title for the site. The title can be the same as or different from the Name.

Description A full description of the site.

Default 
layout

The layout for pages to use by default. Any page in the site that has a blank 
Layout  field uses the layout selected in this field.

Default 
theme

The theme for pages to use by default. Any page in the site that has a blank 
Theme  field uses the theme selected in this field.
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Field Description

Simple 
catalog 
display

Selecting this option simplifies catalog pages in the site by hiding the search 
bar, breadcrumbs, and the results per page choice list. It also prevents you from 
adding attachments from record producers to your CMS site.

Use 
external 
cart

Option to omit the default cart when rendering catalog pages within a site that 
contains catalog pages. Provide a catalog cart block  somewhere on the site to 
allow users to make catalog requests.

Note: 
If you use an external cart, the no cart check box on a service catalog item 
has no effect. The external cart appears for all items.

4. Click Submit.

Example:
The following is the site record for the ESS 

Portal:

Related topics

Copy a site

Copy a site

To create a new site quickly, you can copy an existing site.

Before you begin
Role required: content_admin or admin

About this task
The site copy option creates a complete standalone copy of the site and all its resources. If you 
are copying a site to create a second site, use this option after the first site is complete, tested, 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

641



and production ready. This consideration is important because the blocks, CSS, and pages are 
duplicated to support the new site. There are various reasons why site copying is useful, such as 
site versioning, branding, or creating a backup.

Images are not included when you use the Copy Site option. They are stored separately in the 
sys_attachments table.

To copy just a few pages without duplicating all the resources (CSS, blocks, menus), use the 
page copy option. Page copy duplicates the page but not the resources used in the page. For 
more information, see Copy a page.

Procedure

1. Navigate to All  > Content Management  > Sites  > [Site Name].

2. On the Site form, click Copy.

3. In the dialog box that opens, type a name for the new site.
This name is a prefix for all the site elements that are duplicated. Do not use Portal  or CMS  in 
the site name.

A progress bar shows the copy process. When the process is complete, the Site form shows 
information for the new site.

Related topics

Create a site

Content Management security

There are several methods for securing CMS sites and pages. Site security is set in the Login 
page field on the site record. You can control if a page is public or private through the URL.

Every content page has its own URL that users can access outside of the platform. Depending on 
how the Login page or roles are defined, the URL may or may not be public.

• If the content page has no defined Read  role or there is no defined Login page, any internet 
user can navigate to the URL and view the content page.

• If there is a defined Read  role, then anyone who goes to the URL is asked to log in before they 
can view the site.

• If there is a defined Login page on the site record, all pages in the site are private.

Content Management URLs

The format for Content Management URLs is as follows.

<path to the instance> + /<site suffix> + /<page suffix> + .do

The <site suffix> is defined by the URL Suffix  field on the site form. The <page suffix> is defined 
by the URL Suffix  field in the page form. The URL suffix is case-sensitive.

For example, the page Austere - Site Entry  has a site URL Suffix  of austere  and a page URL 
Suffix  of entry. The constructed URL looks like the following URL.

<instance name>.service-now.com/austere/entry.do

If the site URL Suffix  field is left blank, the <site suffix> is cms, as shown in this example:

instance.service-now.com/cms/page.do

If the page URL Suffix  is left blank, the name of the page is used as shown in this example:
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instance.service-now.com/austere/Page Name.do

Special characters in the name of the page have to be escaped.

Login pages instead of login rules

You set a login page on the site record to allow users to log in or out directly through the content 
site.

Login rules were used in earlier versions to dictate what users saw after logging in, based on their 
roles or permissions. Login rules still work, but their use is deprecated.

Configure CMS sites to use single sign-on (SSO)

To configure CMS to use SSO, make the view_content page private.

Before you begin
Role required: content_admin or admin

About this task
Because public pages do not require login, and CMS sites are public by default, CMS pages do 
not use SSO. Use the following procedure to turn off public-facing content pages and enable 
SSO.

Procedure

1. Navigate to Public Pages [sys_public.list].

2. For the view_content page, set Active  to false.

Content pages in CMS

Content pages are the core of the Content Management System. A content page is a web page 
that displays blocks of content.

Pages are built from content blocks and organized into sites. Pages display as regular webpages 
that are rendered in HTML. Constructing a content page requires a basic knowledge of HTML. 
Content pages are formed by arranging content blocks in predefined layouts. They can be used 
to present login pages, search pages, or ServiceNow  content.

Create a content page

Pages are built from content blocks and organized into sites.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Sites.

2. Open the site to add the page.

3. In the Pages  related list, click New.

4. Complete the form.

Page form fields

Field Description

Name A unique name for the page.
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Field Description

Prefix each page name with the name of the site followed by a dash and the 
page function. For example, ESS - Catalog Detail  and ESS - Search Results  are 
page names within the ESS  site.

URL suffix The URL suffix that identifies the page. It is incorporated into the URL as follows:

http://instance name.service-now.com/site/
url_suffix.do

Parent 
page

The existing page that is the parent of the current page. Parent pages keep 
sections sortable on the site list of pages and are used to create breadcrumbs 
dynamically. Use CSS to define menus that give the Parent page context within 
the user interface.

Layout The layout to use for the page. Layouts define dropzones where content blocks 
can be added to the page.

If this field is left blank, the page inherits the default layout of the site. If the site 
does not have a default layout, there is a single dropzone for the entire page.

Content 
theme

The theme to use for the page. Themes bundle CSS style sheets that are 
applied to all content within the page.

If this field is left blank, the page inherits the default theme of the site. Use the 
default theme unless the page requires a different set of CSS style sheets from 
the other pages in the site.

Frame 
buster

Select the check box to remove any restrictions placed by frames that contain 
the page. This way you avoid frame-within-frame issues that sometimes occur 
with improper linking.

Content 
site

The site associated with the content page. If you created the page from 
the related list in the site, the value defaults. The content site provides the 
<site_suffix> in the page URL, as follows:

http://<instance name>.service-now.com/site_suffix/
page_suffix.do

Read roles Users with the selected roles can view the page. Click the lock icon to select 
roles.

Model 
document

A document ID of a record to display by default.

Page 
status

The status for the page, such as Draft  or Published.

Created by The user who created the page. If your role has higher privileges than your user 
name and you enter your user name, the field defaults to the role. For example, 
if you are logged in as an Admin and you type your name, which has lower 
privileges, this field displays Admin.

Title The title for the page. The title displays on the browser tab when the page is 
accessed.
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Field Description

Description Type a description of the page that displays for users when they access the 
page.

5. Click Submit.

Add content to a page

After you define the page settings, set the content of the page by adding content blocks. Setting 
content blocks is similar to how you add content to homepages.

Before you begin
Role required: content_admin or admin

Note: 
Do not add any type of report, such as a calendar, to iFrames. For more information on 
adding a report directly onto a page without using iFrames, see Embedding reports in 
Jelly .

Procedure

1. On the Page form, under Related Links  click Edit Page.

2. Click Add Content.

3. Select a content block from the picker.

4. Select the dropzone where the content goes.
Create content blocks by adding one of the content blocks named *New [block type]  to the 
page.

Related topics

Content blocks

Copy a page

Copying pages is an efficient way to avoid duplicating the same work and to create pages quickly 
from a guiding base template.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Sites  and select the site.

2. Select the page to copy.

3. Click Copy.

4. Rename the page.

Note: 
Do not use service_catalogto rename a page. It is already a valid page in the system.

5. Edit the page fields.

6. Click Update.
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Assign a page to a site

If you have created multiple sites, you can add pages from one site to another site.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Sites.

2. Select a site.

3. In the Pages  related list, click Edit.

4. Select other pages to include in the site.

5. Click Save.

6. Update  the site.

Add a page to an application

Homepages and content pages are not added automatically to update sets and applications. 
They must be manually added.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Pages.

2. Right-click a content page record.

3. Select Unload Portal Page.

The page is added to the current application and to the current update set.

Configure a private UI page for CMS links

With single sign-on (SSO) in place, you can generate email links that take users directly to tickets 
and applications through the CMS interface.

Before you begin
Role required: content_admin or admin

About this task
You accomplish this procedure by creating a private UI page to redirect CMS links. Because the 
page is not public, it requires authentication and redirects to SSO appropriately.

Procedure

1. Check that your CMS site is private by completing the following steps.

a. Navigate to Content Management  > Sites  > [Your Site]

b. Verify that the Login page  field has a page listed.

2. Create a new UI page by completing the following steps.

a. Navigate to System UI  > UI Pages.

b. Click New.
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c. Enter a Name, for example, redirector.

d. Enter the following Adobe Jelly code into the HTML  field.

<?xml version="1.0" encoding="utf-8"?><j:jelly trim="true" 
 xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null" 
 xmlns:g2="null"><script type="script/javascript">
  window.location.href="${sysparm_uri}";</script></j:jelly>

The CMS now supports email links with following format:

http://<path to instance>/<UI page>.do?uri=/<CMS suffix>/
<record type>.do%26sys_id=<record ID>

For example:

http://<instance name>.service-now.com/
redirector.do?sysparm_uri=/ess/incident.do
%26sys_id=46e3e949a9fe19810069b824ba2c761a

Note: 
If you are using SAML 2.0 update 1 for SSO, use the UI page saml_redirector  instead 
of creating a new UI page. For example, an email link to a SAML 2.0 redirector 
page would use the URL format:  http://<instance name>.service-
now.com/  saml_redirector.do  ?sysparm_uri=/ess/incident.do
%26sys_id=46e3e949a9fe19810069b824ba2c761a.

Content Management templates

Templates are content pages that are reused to provide a consistent look and feel.

Templates are useful when creating CMS sites for the following reasons.

Create new pages rapidly without risk by 
copying pages

Using a template to create new pages saves 
time because you do not have to keep 
repeating the same steps.

Provide a restore point for pages within the 
system

Have a working template available if 
something goes wrong in one of the blocks or 
in the theme CSS. It is often easier to start over 
from the template instead of trying to undo 
complex changes.

Provide a functional reference for editors on 
the site project

Having the template as a reference ensures 
that pages continue to conform to the style 
guide.

Page templates

Every page that is part of the site needs a template.
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Critical page reference fields

When you build a new site, there are four page reference fields on the site record that are critical. 
Understanding these pages and how they are used helps you define page templates and site 
defaults.

• Home page: landing page for the site. A home page is mandatory.

• Search page: page that displays search results when a user searches from any page within the 
site. A search page is mandatory for your site to have a Search Results block.

• Login page: a standalone login page, which is useful to force authentication for the entire CMS 
site.

• Gauge target page: page used to display the drill-through content from a gauge. When the user 
clicks a gauge, the gauge target page opens showing the drill-through content for that gauge.

Critical page reference fields

Detail pages

Depending on the data or tables that you plan to use, you may need detail pages. These detail 
pages use one of the content types in the following list.

• Knowledge detail page: displays a full knowledge article detail (mandatory for a knowledge 
site).

• Incident page: detail page for an incident record.

• Catalog page: detail page for all items, content items, order guides, and record producers.

Templates for creating sections

There are two page templates you can use when creating sections:

• Parent page: keeps sections within large sites organized and sortable on the site list of pages. 
Parent pages are also used to create breadcrumbs dynamically.

• Detail page: differs from the parent page in that the content area displays a full article or detail 
instead of a selection of related content. Detail pages must have a Current Document block.

These pages are mandatory if you plan on accessing system data. For example, if you plan on 
showing the service catalog in your CMS, you need the following items.

• A service catalog content type that references the [sc_cat_item table].

• A detail page that provides the full view of the item.
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New templates

If the base system sample site pages are not suitable, you can create a template from scratch. 
Create a page and then use it as a template. For more information, see Create a Content Page.

When you save a new template, include the word "template" in the page name.

Configure a base template

An easy way to create a base template is to copy the existing ESS sample site and customize it to 
suit your own needs. You can also configure a base template from scratch.

Before you begin
Role required: content_admin or admin

About this task
Follow these steps to create a single base page and generate all important components within 
the site.

Procedure

1. Design a layout.
Regardless of the interface, a site can be distilled into a few simple layouts.

2. Create a theme.
The theme defines the structure of the layouts in CSS and the base styles, such as fonts and 
colors. For more information, see Design themes.

3. Build the common blocks.
Pages are composed of content blocks. Most content blocks are reused on multiple pages. 
For the base template, create basic blocks such as a header, side navigation, and some basic 
content for the main content area of the page. More detailed content can be added later, but 
define content for reuse on many of the site pages here. For more information, see Content 
blocks.

4. Build a site entry page.
Use the common content blocks you just created to design the first page that users see when 
they enter the site. For more information, see Create a content page.

5. Build a detail page.
Design the detail pages to determine how pages such as knowledge articles, catalog items, 
and search results are displayed. You can build a detail page by copying the site entry page 
and adding additional content blocks. For more information, see Copy a page.

6. Assign the pages created to the new site.
Create the site and apply the layout and theme to the site defaults. Then, navigate to the All 
Pages  list and specify the base template site in the Site  column for each of the base template 
pages. For more information, see Create a site.

Customize a copy of a page template

One good source for templates is the base system sample site. It is easy to copy pages and 
restyle them into new page templates to meet different business requirements.

Before you begin
Role required: content_admin or admin

The Employee Self-Service portal is provided as a working example and design template in the 
following procedure.
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Procedure

1. Navigate to All  > Content Management  > Sites  > Employee Self-Service.

2. Select a page.
For example, to copy the ESS sample site homepage, select Portal.

3. Click Copy.

4. Rename the page.

5. Right-click in the header and select Save.

6. Under Related Links, click Edit Page.

7. Point your cursor to the content block to change and click the edit icon that appears on the 
right.
For example, change the menus, alter the layout, or add a different logo.

8. Click Update.

9. Use the page in other sites you created by assigning pages  to a site.

Content types

Content types provide site-specific control of how system data defined by templates is rendered.

In the site, one page displays a list of knowledge articles, and another page displays catalog 
items or incidents or a combination of the two. Different themes can be used for types of content 
and each theme can provide different user interaction. Content types define the pages that 
display content from a table. Each content type corresponds to a table.

Every type of document that the CMS displays has an associated content type. Changing the 
content type requires knowledge of Apache Jelly scripting. However, the common content types 
(such as service catalog or knowledge base) come in the base system. Content types can be 
associated with particular sites. This association allows different sites to use different detail 
pages for the same content type.

Content types define three features of associated documents.

• What does a link to one of these documents look like? For example, if a list of these documents 
is displayed on a page, how does each entry appear?

• What does a detailed view of one of these documents look like?

• What detail page is used to display the document? This decision is important and is often an 
area of confusion for new CMS users.

The document content type determines the page that a list of documents points to, the list itself 
does not determine the page. The content from a link is displayed in a detail content block on 
a page. The content type determines in which detail block on a page the document content is 
displayed.

For example, the list block Catalog Top 5  displays the top five items in the Service Catalog table 
[sc_cat_item]. Because the table is [sc_cat_item], the content type sc_cat_item  controls how the 
Catalog Top 5  list is displayed. Clicking any item in the list displays the Service Catalog Detail 
page with the item displayed on it according to the detail template script. These content types 
are applied:

• in search results to link to the correct page.

• in the Current Document block to display the current record.

• in links on lists and other places that link to record types.
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Several content types are available by default for tables such as Catalog Item [sc_cat_item], 
Gauge [sys_gauge], and Page [content_page].

Content type defaults that are set for CMS can be overridden for individual sites. Use the 
Content Types  related list on the site record to customize content types.

Configure a content type

Users with the content_admin role can create a content type.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Content Types.

2. Click New.

3. Complete the Content Type form.

Content Type form

Field Input Value

Type Select the table whose content will be rendered in Content Management.

Content 
site

Select the site that will use this content type.

Media 
type

Enter one of the following media types to use with this content type.

◦ m: Smartphone interface only (not for CMS use)

◦ tablet: Tablet interface only (not for CMS use)

Default 
detail 
page

Select which page loads after a user clicks a link.

Gauge 
page

Select which page is the drill-through target for any gauge. If you display a gauge 
on a CMS page, then clicking the links loads the page specified here.

Summary 
Template

Write an XML script that determines how the list is displayed in the list block, if 
the link is displayed in a list block.

Detail 
Template

Write an XML script that determines how to display the associated information 
after a user clicks the link.

CMS gauge support

Gauges are a graphical way to display information from an instance.

A gauge might, for example, show a bar chart breaking down all open incidents by category. 
Gauges are fully supported within the CMS system. This means:

1. You can put a gauge on a CMS page

2. You can control what will happen when a user clicks on a cell within that gauge

Put a gauge on a CMS page

You have control over the gauges on a CMS page.
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Before you begin
Role required: content_admin or admin

Procedure

1. Bring up the CMS page in edit mode.

2. Click Add Content.

3. Select the gauge you want to add.

4. Place the gauge on the page in the desired location.

Related topics

CMS gauge support

Control what happens on a click

Control what happens on a click

Since a CMS system uses multiple pages you have to tell the system which page to use to 
display drill through content.

In the normal (non CMS) system, when you click a bar in a bar chart or a wedge on a pie chart, 
you drill through and your current screen is replaced with a list of records meeting the chart's 
criteria. For example, if you have a gauge of Incidents by Category  and you click the bar labeled 
Hardware  you drill through to a list of all incidents with a category=hardware.

Within the CMS system, there is a similar drill through mechanism at work, but you must manually 
specify which page to display.

There are two different models of the drill through, use an in-place target frame to receive the 
content, or use another page to display the content.

Using an In-Place Target

An in-place target is a named iframe on the same CMS page as the gauge. When the gauge is 
clicked, the drill-through content appears within that iframe rather than changing out the CMS 
page. The gauge (and the rest of the page other than the target) remain in place and active.

Using a Gauge Target Page

A gauge target page is a separate CMS page that is used to display the drill-through content from 
a gauge. When a gauge is clicked, the current CMS page is replaced with the gauge target page 
and the drill-through content is rendered within that second page.

• Gauge Target Page

To set a site default, select Gauge Target Page, on the site configuration page. This page is 
used as the drill-through target for any gauges in the system that do not have a more specific 
gauge page specified in their content type.

• Gauge Page

To set a content-type specific page, you can specify a Gauge Page, on a content type page. 
Any gauges for this type of content then use that page for any drill through.

Note: 
The gauge target on a particular content type overrides the default, site level, gauge 
target.
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• Gauge Target block

A gauge target page is a normal CMS page, with one special requirement. Somewhere on that 
page, there must be a Gauge Target block. This market block tells the system where to output 
the drill through data.

Related topics

CMS gauge support

Put a gauge on a CMS page

View content types

The following is an example of where you might use Content Types.

Before you begin
This example uses the out-of-box Employee Self-Service (ESS) site as an example.
Role required: content_admin or admin

About this task
Use any out-of-box instance of a CMS site.

Procedure

1. Launch an out-of-box CMS site https://<instance name>.service-now.com/
ess.

2. Under Get Help, click Issue Status.
The Issue Status, or incident_status CMS page contains two content blocks: Common Answer 
and Current Issues. These content blocks both use Content Types to render results.

3. From https://<instance name>.service-now.com, navigate to Blocks  > Lists  > 
Portal - Common Answers.
This block matches the Common Answers section of the Issue Status page. The Table field 
describes the Content Type associated with Common Answers.

4. Use the link to view existing Content Types.

5. Click the Content Type to view the XML that determines how the list and record are rendered in 
CMS.
The Default Detail Page field indicates a CMS page that displays a record selected from a List 
of Content block.

6. Click the Information icon next to the Default Detail Page, to go to that page.

7. From the Default Detail Page, under Related Links, click Edit Page.
The Detail Block contains a content type formatter. When editing or viewing the page, it is 
looking for a URL to be passed to determine the record to display, which is why it says "Detail 
record could not be located".

8. Click the pencil icon to edit and view the Detailed Content block.
The Type drop down list has "Show the page's current document" selected, which indicates 
that the document_id must be passed to this block from the CMS pages, then it can display 
the record based on the content type listed in the document_id.

9. From the Common Answers block, on the Self Service page, select a record.
The page opens with a URL similar to: https://<intance 
name>.service-now.com/ess/knowledge.do?
sysparm_document_key=kb_knowledge,02255450d731310013ab49547e61038e

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

653



The table sysparm_document_key=kb_knowledge  and sys_id 
02255450d731310013ab49547e61038e  determine the record. The associated content 
type, kb_knowledge, renders the content on the Default Detail Page, Portal - Knowledge 
Detail / url_suffix=knowledge.

Content blocks

A block is a defined piece of content within the system that can be reused.

A content page is constructed by arranging customized blocks of content on a page. Content 
blocks are an important part of a CMS site. Existing content such as reports, gauges, and record 
lists are automatically available as content blocks and more can be created within the CMS.

After defining content blocks, use them on any content page by adding them to drop zones. For 
more information, see Add content to a page.

Create content blocks after sites and pages have been designed.

Related topics

View CMS block tags

Configure a header block

Configure a static HTML block

Format an image as a static HTML block

Configure dynamic blocks

Catalog cart block

Integrate Live Feed with CMS

Configure Flash movie blocks

Configure a detailed content block

Configure iFrames

Configure a content block

To configure a content block, define it in the appropriate form.

Before you begin
Role required: content_admin or admin

Procedure

1. Perform one of the following actions to create a content block.

◦ Navigate to Content Management  > Blocks  > [Block type]  > New. The form for creating the 
selected block type opens.

◦ Navigate to Content Management  > Blocks  > All  and select the type of content to create 
from the list.

◦ Edit a content page and add a stub block of the desired content block type. Click the link in 
the stub block.

2. Complete the content block form and save it.

3. Add the content block to any content page.
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Related topics

Configure a header block

Configure a static HTML block

Format an image as a static HTML block

Configure dynamic blocks

Catalog cart block

Integrate Live Feed with CMS

Configure Flash movie blocks

Configure a detailed content block

Configure iFrames

View CMS block tags

View CMS block tags, which are used for advanced block creation and site flexibility.

Before you begin
Role required: content_admin or admin

About this task
It is constructed as <g:content_block> {{Jelly_Tags|Jelly]]  and can be used in 
either of the following ways.

• To display a block inside a block

• To display a block inside a layout

The tag appears in the format, <g:content_block type="<type>" id="<sys_id>"/>.

An example of the block tag is included in the ESS Portal sample site.

Procedure

1. Navigate to All  > Content Management  > Design  > Frames.

2. Click cms_admin_home_frame.

3. View the code.

<style>
 
DIV.cms_administration_home {
 background: url(gray_${current_page.getURLSuffix()}.pngx) 
 no-repeat right top;
}
 
</style>
 
 
<div class="cms_administration_home">
   ${body}
<br/>
<!-- Would you like to pivot off of parent page instead?  try 
 this snippet
   <j:if 
 test="${current_page.getParentPage().getURLSuffix()=='administ
ration'}">
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      <g:content_block type="content_block_menu" 
 id="7afc342def002000914304167b2256ac"/>
   </j:if>
     The defaults use the page URL suffix to define sub menus
-->
   <j:if 
 test="${current_page.getURLSuffix()=='administration'}">
      <g:content_block type="content_block_menu" 
 id="7afc342def002000914304167b2256ac"/>
   </j:if>
   <j:if 
 test="${current_page.getURLSuffix()=='community_inspired'}">
      <g:requires name="ess.portal.globals.jsdbx" />
      <g:content_block type="content_block_menu" 
 id="ccd4b8c7efb70000914304167b22566e"/>
   </j:if>
<br/>
</div>

4. To see what the page looks like, navigate to the ESS Portal administration page.
For example, http://instance name.service-now.com/ess/
administration.do.

Related topics

Content blocks

Configure a header block

Configure a static HTML block

Format an image as a static HTML block

Configure dynamic blocks

Catalog cart block

Integrate Live Feed with CMS

Configure Flash movie blocks

Configure a detailed content block

Configure iFrames

Types of content blocks

Content blocks, which make up content pages, are reusable pieces of content defined within the 
system.

Each content block can be used for a different type of content.

Related topics

Format an image as a static HTML block

Catalog cart block

Integrate Live Feed with CMS

Configure a header block

A header block is a visual element placed at the top of pages. It provides a place for branding 
and other important site-wide functionality.
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Before you begin
Role required: content_admin or admin

About this task
Some of the options that are available in headers include, global search, text size toggle, menus 
for navigational purposes, and the user name with logout link.

Procedure

1. Navigate to All  > Content Management  > Blocks  > Headers.

2. Click New.

3. Complete the form.

Header form

Field Description

Name Type a unique name for the header block.

Background Select a background for the header logo and menus.

◦ None  - No background is rendered.

◦ Gradient/Image  - Specify an image or gradient image to serve as the 
background.

◦ Colored Bars  - Specify colors for three different sections of the header, top, 
middle, and bottom.

Image If Background  is Gradient/Image, upload an image for the header block 
background. For gradients, upload a gradient image.

Top bar 
color

If Background  is Colored Bars, enter a CSS color or color name to use as the 
background for the top menu.

Middle bar 
color

If Background  is Colored Bars, enter a CSS color or color name to use as the 
background for the logo and text.

Bottom bar 
color

If Background  is Colored Bars, enter a CSS color or color name to use as the 
background for the bottom menu.

Logo Select a logo image. The image is also a link to the main page.

Active Select this check box to make the block available for use.

Text Type the text to display beside the logo.

Conditional Select the check box and type any scripted conditions to apply in the 
Condition  script field that appears.

Category Select a category to provide organization for the header block. The category 
also determines the detail page in which header block links open. Detail pages 
often display information in different ways.

Top Menu Select a navigational menu block to use as a menu above the logo.

Bottom 
Menu

Select a navigational menu block to use as a menu below the logo.

Height Specify the height for the header.

Search Select this check box to add a search element in the header.

Font sizer Select this check box to include text sizing controls in the header.
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Field Description

Login Select this check box to include a login link in the header. If the user is logged 
in, this element displays the user name and a logout link. If you specify a login 
page on the site record, it is important to include a login link so users can enter 
their username and password.

Chat 
Queue

Select the chat queue that users access by clicking the Help Desk Chat  button 
in the header. Clear the field to remove the button. This field appears only if the 
Chat plugin is active.

Related topics

Configure a content block

Create a navigation menu block

Navigation menu blocks enable you to create a menu of links to different content pages.

Before you begin
Role required: content_admin or admin

About this task
The following three objects define navigation menus.

• Menu block: The menu block defines the entire menu block and how it displays.

• Menu section: The menu sections define groups of links displayed within the block.

• Menu item: The menu items define the links within each menu section.

Procedure

1. Navigate to All  > Content Management  > Navigation Menus.

2. Click New.
A gallery of available navigation menu blocks displays.

CMS menu options

3. Select the desired menu block style.
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4. Complete the Navigation Menu form to define the block.

Navigation Menu form

Field Description

Name Enter a unique name for the block.

Type Select the type of navigation menu, which determines how the links are 
displayed.

Frame Select a border style for the navigation menu block.

Conditional Select this check box to enable the use of scripted conditions. If selected, the 
Condition  and Logged On  fields appear.

Logged on Select this check box to display the navigation menu block only if the user is 
logged on. This field appears only if Conditional  is selected.

Condition Enter a script to define the conditions for the navigation menu block. This field 
appears only if Conditional  is selected.

Active Select this check box to make the block available for use.

Category Select a category to provide organization for the navigation menu block. The 
category also determines the detail page in which menu links open.

Related topics

Menu style customization

Configure menu sections

Menu sections define groups of links displayed within the navigation menu block.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Blocks  > Navigation Menus  and select a block.

2. In the Menu Sections  related list, click New.

3. Complete the Menu Section form.

Menu Section form

Field Description

Name Enter a unique name for the menu section.

Content 
block 
menu

Select the navigation menu on which this menu section appears.

Redirect 
to

Select what appears when a user clicks the menu section name and icon.

URL Click the lock icon to open the edit field, then enter the URL to display when a user 
clicks the menu section title and icon. This field is available only if Redirect to  is 
set to The specified URL.
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Field Description

Detail 
page

Select the content page to open when a user clicks the menu section title or icon. 
This field is available only if Redirect To  is set to A content page.

Left 
image 
DB

Right 
image 
DB

Select the image database where your site images are stored.

Left 
image

Right 
image

Select icons to appear on the left and on the right of the name.

Second 
level text

Enter a description to appear beside the menu section title.

Active Select this check box to make the menu section available for use.

Order Enter a number to indicate where this section appears on the menu relative to 
other menu sections.

Logged 
on

Select this check box to display the menu section only if the user is logged on.

Roles Click the lock to open a list, then select the roles that can access this menu 
section if you restrict access by role.

Category Select the category in which the menu section belongs.

Open In Select the behavior of clicked links.

iFrame Enter the name of the iFrame where the link opens when a user clicks the menu 
section title and icon. Make sure that there is an iFrame on the page where the link 
opens. This field is available only if Open In  is set to Named iFrame.

Header Enter header information for the menu section.

Footer Enter footer information for the menu section.

4. Click Submit.

Related topics

Menu types

Menu style customization

Configure menu items

Menu items are the links that appear within each menu section.

Before you begin
Role required: content_admin or admin

About this task
Not all navigation menu sections require menu items. Use menu items to link users to other 
pages or additional information. These steps use the ESS sample portal site as an example.
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Procedure

1. Navigate to All  > Content Management  > Blocks  > Navigation Menus  and select a navigation 
menu.

Example 
For example, select the Documentation Menu.

2. From the Menu Sections  related list, select a menu section.

Example 
For example, select Getting Started.

3. From the Menu Items  related list, click New.

4. Complete the form.

Menu Item form

Field Description

Name Type a unique name for the menu item.

Menu 
section

Select the menu section in which this item appears.

Redirect 
to

Select what appears when the menu item name and icon are clicked.

URL Click the lock icon to open the edit field, then enter the URL to open when the 
menu item title and icon are clicked. This field is available only if Redirect to  is set 
to The specified URL.

Detail 
page

Select the content page to open when the name or icon is clicked. This field is 
available only if Redirect To  is set to A content page.

Image Select an icon to appear with the name.

Active Select this check box to make the menu item available for use.

Order Enter a number to indicate where this item appears on the menu relative to other 
menu items.

Logged 
on

Select this check box to display the menu item only if the user is logged on.

Roles Click the lock to open a list, then select the roles that can access this menu item to 
restrict access by role.

Category Select the category in which the menu item belongs.

Open in Select the behavior of clicked links.

iFrame Type the name of the iFrame where the link opens when a user clicks the menu 
item name and icon. Make sure that there is an iFrame on the page. This field is 
available only if Open In  is set to Named iFrame.

5. Click Submit.

Related topics

Menu types

Menu style customization
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Menu types

By changing the Type  field on the navigation menu block, you can format the same menu in 
different ways.

Menu types

Type Image Description

Super 
Menu for 
Headers

The super menu is a hybrid between the 
drop-down menu and the tabbed system. 
The user can use a super menu to create a 
menu from any number of menus.

Drop-
Down 
Menu for 
Headers

The drop-down menu renders the menu 
sections as drop-down list. Use the mouse 
to point to the menu name and view the 
menu items.

Tab 
Menu for 
Headers

The tab menu renders the menu sections 
as tabs. Use the mouse to click the tab and 
view the menu items.

Horizontal 
Blocks

The horizontal blocks menu renders the 
menu sections as block headings with 
menu items as links within the blocks. The 
blocks are arranged horizontally.
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Menu types  (continued)

Type Image Description

Tab 
Content 
Block

The tab content block (horizontal) menu 
renders the menu sections as tabs with 
menu items as links within the block.

Vertical 
List

The vertical list menu renders the menu 
sections as headings with menu items as 
links below them.

Vertical 
Blocks

The vertical blocks menu renders the menu 
sections as block headings with menu 
items as links within the block. The blocks 
are arranged vertically.

Menu style customization

You can customize menu styles in the style sheets your site uses.

Navigate to Content Management  > Design  > Style Sheets  to customize style sheets.

Supplementary page navigation menu example code

In the following example, look at the CSS class selectors and rules. Also, review how the 
block containers (div.cms_menu_section_blocks) are defined based on the outer container 
(TD.layout_content_submenu_column). The outer container is actually a part of the site layout.

This concept is clearer if you compare the styles to the styles used in the super menu further 
down in the example. This example shows that there is no need to make a completely new menu 
system. You can use CSS to change the look and feel of existing menus.

/***************************************************************
****************************************************************
**************************
   SUB MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks 
 Menu (cms_menu_section_blocks UI Macro)
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****************************************************************
****************************************************************
*************************/
TD.layout_content_submenu_column DIV.cms_menu_section_blocks {
    width: 156px;
    height: auto;
    float: left;
    position: relative;
    border-style: solid;
    margin: 0px 0px 0px 0px;
    border: 0px solid ➚e0e0e0;
    padding: 0px;
    background: none;
    padding: 24px 12px 0px 12px;
}
 
TD.layout_content_submenu_column DIV.sub_menu_section {
    width: 156px;
    height: 20px;
    float: left;
    border-style: solid;
    border: 0px solid ➚e0e0e0;
    padding: 0px;
    background: none;
    padding: 0px 12px 0px 12px;
}
 
SPAN.cms_sub_menu_list_link, TD.submenu_cell A   {
    color: ➚FFF;
}
 
TD.layout_content_submenu_column IMG.menu_bullet{
 display: none;
}
 
TD.cms_menu_section_blocks_title h2, 
 TD.cms_menu_section_blocks_title h2 a, 
 TD.cms_menu_tab_blocks_text h2 {
    margin:0;
    padding: 0px;
    font-size: 11px;
    text-transform: uppercase;
    color: ➚42C4DD;
    font-weight: normal;
    white-space: nowrap;
}
 
TD.layout_content_submenu_column a.cms_menu_block_item {
    margin:0;
    padding: 0px;
    font-size:11px;
    color:➚FFF;
}
 
TR.layout_content_submenu_row TD.layout_content_submenu_column{
 background: transparent url(sub_menu_background.gifx) repeat-y 
 center top !important;
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}

Super menu sections example code

The following menu is a simple float grid. The defaults are written first. Then, below the "SUPER 
MENU VARIATIONS..." comment, the defaults are overwritten by adding a containing div 
with a unique class. In the code that renders the header for the base system, the bottom 
menu resides in a table cell with the class of cms_header_bottom_menu  (refer to the 
TD.cms_header_bottom_menu CSS selector).

/***************************************************************
****************************************************************
**************************
   SUB MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks 
 Menu (cms_menu_section_blocks UI Macro)
****************************************************************
****************************************************************
*************************/
 
TD.layout_content_submenu_column DIV.cms_menu_section_blocks {
    width: 156px;
    height: auto;
    float: left;
    position: relative;
    border-style: solid;
    margin: 0px 0px 0px 0px;
    border: 0px solid ➚e0e0e0;
    padding: 0px;
    background: none;
    padding: 24px 12px 0px 12px;
}
 
TD.layout_content_submenu_column DIV.sub_menu_section {
    width: 156px;
    height: 20px;
    float: left;
    border-style: solid;
    border: 0px solid ➚e0e0e0;
    padding: 0px;
    background: none;
    padding: 0px 12px 0px 12px;
}
 
SPAN.cms_sub_menu_list_link, TD.submenu_cell A   {
    color: ➚FFF;
}
 
TD.layout_content_submenu_column IMG.menu_bullet{
 display: none;
}
 
TD.cms_menu_section_blocks_title h2, 
 TD.cms_menu_section_blocks_title h2 a, 
 TD.cms_menu_tab_blocks_text h2 {
    margin:0;
    padding: 0px;
    font-size: 11px;
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    text-transform: uppercase;
    color: ➚42C4DD;
    font-weight: normal;
    white-space: nowrap;
}
 
TD.layout_content_submenu_column a.cms_menu_block_item {
    margin:0;
    padding: 0px;
    font-size:11px;
    color:➚FFF;
}
 
TR.layout_content_submenu_row TD.layout_content_submenu_column{
 background: transparent url(sub_menu_background.gifx) repeat-y 
 center top !important;
}
 
 
4.2 2. Super Menu Sections Example Code
 
This menu is essentially a simple float grid. The defaults 
 are written first. Then, below the "SUPER MENU VARIATIONS..." 
 comment, the defaults are overwritten by adding a containing 
 div with a unique class. In the code that renders the header 
 for the base system, the bottom menu resides in a table 
 cell with the class of "cms_header_bottom_menu" (note the 
 TD.cms_header_bottom_menu CSS selector).
 
/***************************************************************
****************************
   Section Blocks Menu (cms_menu_section_blocks UI Macro)
****************************************************************
***************************/
div.cms_menu_section_blocks {
    width: 260px;
    height: 260px;
    float: left;
    border-style: solid;
    margin: 0px 0px 12px 12px;
    border: 1px solid ➚e0e0e0;
    padding: 10px;
    background: url(blue/portal_horizontal_bkg.pngx) repeat-x 
 center bottom;
}
 
p.cms_menu_separator {
    border-top:1px dotted ➚ccc;
    margin-top: 6px;
    margin-bottom: 6px;
}
 
td.cms_menu_section_blocks_title h2, 
 td.cms_menu_section_blocks_title h2 a, 
 td.cms_menu_tab_blocks_text h2 {
    margin:0;
    padding: 0px;
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    font-size: larger;
    font-weight: normal;
    color:➚444;
}
 
a.cms_menu_block_item {
    margin:0;
    padding: 0px;
    color:➚999;
    font-size: inherit;
}
 
/***************************************************************
****************************
   SUPER MENU VARIATIONS FOR HORIZONTAL MENUS - Section Blocks 
 Menu (cms_menu_section_blocks UI Macro)
****************************************************************
***************************/
TD.cms_header_bottom_menu .cms_menu_super_menu_bar { /*style the 
 super menu drop down bar */
   z-index: 199;
   float: left;
   background: none;
   margin-left: 44px;
}
 
TD.cms_header_bottom_menu div.cms_menu_section_blocks {
    width: 200px;
    float: left;
    border: 0px;
    margin: 0px 0px 12px 0px;
    padding: 0px;
    background: none;
}
 
TD.cms_header_bottom_menu p.cms_menu_separator {
    border-top:0px dotted ➚ccc;
    margin-top: 0px;
    margin-bottom: 0px;
}
 
TD.cms_header_bottom_menu  .cms_menu_super_menu_bar_item { 
  /*style an item on the super menu drop down bar*/
   z-index: 200;
   float: left;
   padding-left: 12px;
   padding-right: 12px;
   padding-bottom: 8px;
   padding-top: 4px;
   cursor: pointer;
   cursor: hand;
   font-weight: bold;
   color: ➚000;
   border-left: 1px solid ➚FFF;
   border-top: 1px solid ➚FFF;
}
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TD.cms_header_bottom_menu 
  .cms_menu_super_menu_bar_item_selected {  /*style a selected 
 item on the super menu drop down bar*/
   z-index: 200;
   float: left;
   padding-left: 12px;
   padding-right: 12px;
   padding-bottom: 8px;
   padding-top: 4px;
   cursor: pointer;
   cursor: hand;
   background: ➚fff url(super_menu_bkg.gifx) no-repeat left top;
   font-weight: bold;
   border-right: 0px solid ➚CCC;
   border-bottom: 0px solid ➚CCC;
   border-left: 1px solid ➚DDD;
   border-top: 1px solid ➚EEE;
 
}
 
TD.cms_header_bottom_menu  .cms_menu_super_menu_content { /* 
 style super menu content block */
   position: absolute;
   z-index: 999;
   height:260px;
   display: none;
   padding: 18px;
   background: ➚dedfe0 url(super_menu_bkg.gifx) no-repeat left 
 top;
   border-right: 1px solid ➚CCC;
   border-bottom: 1px solid ➚CCC;
   border-left: 1px solid ➚DDD;
   box-shadow: 5px 5px 6px ➚666;
   -webkit-box-shadow: 5px 5px 6px ➚666;
   -moz-box-shadow: 5px 5px 6px ➚666;
   filter: 
 progid:DXImageTransform.Microsoft.dropShadow(color=➚666, 
 offX=5, offY=5, positive=true);
}
 
TABLE.super_menu_video_table {
    background: ➚787878 url("grey_background.pngx") repeat-y 
 scroll center top;
 width: 184px;
}

Example menu items and content links

The method for choosing a link target (current window, iFrame, or new window) and referencing 
the item linked (page, attachment, or URL) are similar. Review examples of how to link within 
these elements.
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• A content page reference helps you select the desired page. For example, the value home.do 
links to the site homepage.

• An attachment reference allows you to reference a single file attached to the menu item or 
section record. If there is more than one attachment, only the first attachment is referenced. 
The link is then generated automatically and displays a Browser File Save  prompt.

• The specified URL reference allows you to link to a full URL 
string in your instance or from another system. For example, 
com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=66c313e7c0a8016b008ebe1a8e3d97f5&sysparm_nameofstack=b654d15bef921000914304167b225638 
links to the Ask a Question  record producer. Use this reference to link to a page in an existing 
intranet system.

Menu items can be seen as featured links from each section. There are many choices in URL 
definitions and link options. Links within the ESS Portal open content pages within the site. In 
turn, each page has an iFrame or set of blocks that houses the corresponding data. This method 
is useful for rapid prototyping, but consider where to create dynamic detail pages and use the 
available linking options.

Menu item

Menu items are similar to content links except they are called by the list block, not as part of 
a navigation menu block. Menu items and content links function the same as far as how they 
are defined and the options available for linking to items. Content links are meant to be called 
through a list block that calls the Content Link [content_link] table. Content links do not have the 
Logged in  field or the Roles  option used to control the UI experience for various roles.

Content link
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Related topics

View links between system elements and URLs

View menu and list examples

Menu sections define groups of links and how the links behave.

Before you begin
Role required: content_admin or admin

About this task
For example, link behavior determines which page opens when the link is clicked and how it 
opens, such as in a new page or a new frame. Use the following procedure to view a sample 
menu section.

Procedure

1. Navigate to All  > Content Management  > Blocks  > Navigation Menus.

2. Click Portal - Block Menu.

3. In Menu Sections  related list, click Order Things.

4. Click the reference icon next to Detail Page  to open the page.

5. In Related Links, click Edit Page.
By default, the link goes to the Order Things page with the Portal - Order Splash Menu (Vertical 
Block Menu) in the page content area.

In most default CMS menus, the menu section has the menu title with secondary text, a 
separation line, and the links you define as menu items. Although the design is versatile and 
flows well between pages, there could be questions about linking and scalability to large 
catalogs. This practice may only be useful for a small catalog with limited items.

6. To view an example of dynamic content, follow these steps to look at the request catalog list/
grid view on the ESS Portal.

a. Add /ess/manage.do  to your instance URL.
For example, https://<instance name>.service-now.com/ess/manage.do.

b. In the Code Example Demos  section, click Request Catalog List / Grid View.

c. Browse the catalog items.

Configure dynamic blocks

Use dynamic blocks to use scripting or to pull information from the system. Dynamic blocks are 
where most of your content resides.

Before you begin
Role required: content_admin or admin

About this task
A good use of dynamic blocks is job postings. Store the postings in knowledge articles and 
display the postings with a dynamic block.

Several dynamic blocks are predefined, including the following items.
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• New Content: Each of the new content blocks allows for creating blocks while editing content 
pages.

• Clean Login: The default login page requesting user name and password, which includes a 
"Remember Me" check box. After the user logs in, this block triggers login rules.

• Login: An area that allows a logged out user to log in and a logged in user to log out. This block 
is especially useful on publicly available content pages.

• Search: The global text search field. Currently, global text search is the only form of search that 
can be included in a content page.

• Search Results: An area for displaying global text search results.

For information about Apache Jelly, see Jelly tags .

Note: 
Dynamic Content Blocks in Content Management System are not automatically escaped. 
These blocks must implement their own content escaping (e.g., to protect against potential 
Cross Site Scripting attacks). For more information, see Jelly escaping types .

Procedure

1. Navigate to All  > Content Management  > Dynamic.

2. Click New.

3. Complete the Dynamic Content form.

Dynamic Content form

Field Description

Name Type a unique name for the dynamic content block.

Category Select a category to provide organization for the dynamic block. The category 
also determines the detail page in which dynamic block links open.

Frame Select a border styling for the dynamic block. For more information, see Format 
a frame.

Active Select this check box to make the block available for use.

Conditional Enter any scripted conditions to be applied. If selected, adds a Condition  script 
field to the form.

Two phase Select this check box to allow two phase Extensions to Jelly syntax .

Dynamic 
content

Enter the XML script field that determines the behavior of the dynamic block.

Related topics

Content blocks

Configure a content block

View CMS block tags

Customize the list block

Format an image as a static HTML block

Catalog cart block

The catalog cart block is a dynamic block provided in the base system.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

671

https://www.servicenow.com/docs/access?context=r_JellyTags&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_JellyTags&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_JellyTags&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_JellyEscapingTypes&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_JellyEscapingTypes&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_JellyEscapingTypes&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ExtensionsToJellySyntax&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ExtensionsToJellySyntax&version=zurich&pubname=zurich-api-reference&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ExtensionsToJellySyntax&version=zurich&pubname=zurich-api-reference&ft:locale=en-US


This block provides the same cart that is available within the service catalog. If the site definition 
has the Use external cart  option selected, include this block in the site so users can interact with 
their catalog cart.

Catalog cart block is available when the glide.sc.use_cart_layouts  property is set to 
false.

Related topics

Content blocks

Configure a content block

Types of content blocks

Customize the list block

List blocks are content blocks that dynamically generate a list of links to records within the 
instance. When a user clicks a link in a list block, the associated information is displayed in a 
detail page determined by its content type.

Before you begin
Role required: content_admin or admin

About this task
Make the list using a simple query on any table or by scripting a more advanced query. Lists are 
powerful and flexible. Here are some places that allow you to have complete control over the list 
display.

List control

Option Description

Frames Frames provide a method to create decorative containers for content blocks and 
other elements within the site. When frames are used with the Type  field, the 
designer has complete control over list placement.

List Type The List Definitions module defines the type of lists available for content pages. On 
the List Block form, select a list definition in the Type  field.

List 
Filtering

Provides every field in the referenced table for more granular results.

Max 
Entries

Limits the results from a table to fit the design of the block.

Order 
and 
Order 
Direction

Allows sorting by any field in the referenced table, in either ascending or 
descending order.

You can also use list blocks to create a list of links to information outside your instance. Create 
the external links as records on the Content Link [content_link] table, and then follow the steps in 
this procedure.

Procedure

1. Navigate to All  > Content Management  > Lists.

2. Click New.

3. Complete form.
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List Block fields

Field Description

Name Enter a unique name for the list content block. It is used to identify the record 
in the instance and is not displayed on the content page. Use the Title  field for 
that purpose.

Category Select a category to provide organization for the list content block.

Type Select a list definition UI macro to format the list of links.

For more information, see Configure list definitions.

Frame Select a border style for the list block. For more information, see Create a frame 
UI macro.

Advanced Select this check box to enable generating a list from a script, rather than from a 
simple filtered query.

Query Filters the results using a condition builder.

Active Select this check box to make the block available for use.

Title Enter the name to display at the top of the list block when it appears in a 
content page.

Maximum 
entries

Set the maximum number of entries to display in this list block.

Table Select a table to query for the list items. The table determines which detail page 
displays when a user clicks a link in the list block. For more information, see 
Configure a content type

Note: 
The list shows only tables and database views that are in the same scope 
as the list block.

Conditional Select this check box to enable the use of scripted conditions. If selected, a 
Condition  script field appears. Other fields that appear include the Logged On 
and Omit if empty  check boxes.

4. Click Submit.

Configure list definitions

List definitions, similar to content management frames, are decorative containers that control the 
look and feel of lists.

Before you begin
Role required: content_admin or admin

About this task
Specifically, list definitions are UI macros that use Apache Jelly script to define how a list is 
rendered inside a list block. Site design often requires multiple list styles within the layout. Lists 
are often the primary form of navigation within a site, so it is important to have control over their 
formatting.

Configuring list definitions requires a knowledge of Apache Jelly.
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Procedure

1. Navigate to All  > Content Management  > Configuration  > List Definitions  > ..

2. Click New.

3. Complete the List Definition form.

Related topics

Content Management and the Apache Jelly engine

Configure a static HTML block

Use static blocks for text that does not change. For example, use a static block for a site footer 
with only the company or organization name. A static HTML block allows any HTML code to be 
run within a page.

Before you begin
Role required: content_admin or admin

About this task
Anyone who edits their own HTML, Jelly, or Javascript may find the HTML editor in the static 
block limited. The HTML editor can also add tags or formats that advanced coders find 
unnecessary. For more advanced options, use dynamic blocks.

Procedure

1. Navigate to All  > Content Management  > Blocks  > Static HTML.

2. Click New.

3. Complete the Static Content form.

Static content form

Field Input value

Name Type a unique name for the static HTML content block.

Category Select a category to provide organization for the static HTML block. The 
category also determines the detail page in which static HTML block links open. 
Detail pages often display information in different ways.

Frame Select a border styling for the static HTML block. For more information, see 
Format a frame.

Active Select this check box to make the block available for use.

Conditional Enter any scripted conditions to be applied. If selected, adds a Condition  script 
field and Logged on  check box to the form.

Static 
Content

Enter HTML code  that determines the behavior of the static HTML block.

4. Click Submit.

Related topics

Content blocks

Configure a content block

View CMS block tags
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Format an image as a static HTML block

An easy way to add an image to a CMS page is to use a static HTML block. After the block is 
created, you can reuse it throughout the site.

Before you begin
Role required: content_admin or admin

Procedure

1. Navigate to All  > Content Management  > Design  > Images.

2. Click New.

3. Select a Category  to help organize the images.

4. Type the file name of the image, including the extension (such as .png).

5. Upload the file by selecting Click to add  and browsing for the image.

6. Click OK.

7. Click Update.

8. Navigate to Content Management  > Blocks  > Static HTML  and click New.

9. Paste the following code into the HTML block, substituting the image name as uploaded in the 
previous step.
The "x" at the end of the filename is required for image caching.

<img src="<image_name>.gifx"/>

Now the image is a static HTML block and you can add it to any content page. Use standard 
HTML code to alter the image in the content block.

Related topics

Content blocks

Configure a content block

Configure a header block

Configure Flash movie blocks

Use a Flash movie block to embed any Flash movie (.swf file) as an attachment or by referencing 
a URL in a content page.

Before you begin
Role required: content_admin or admin

About this task
To add streaming video or Flash video (.flv), for example, to a knowledge article, see Embed 
videos in HTML fields  .

Procedure

1. Navigate to All  > Content Management  > Specialty Content  > Flash Movies.

2. Click New.

3. Complete the Flash Movie form.
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Flash Movie form

Field Input value

Name Type a unique name for the Flash movie block.

Source Specify where the Flash movie is found.

◦ Attachment: If this choice is selected, upload the Flash movie to this record.

◦ Link to External Object: If this choice is selected, a URL  field appears. Specify the 
Flash movie URL and ensure that the Flash movie is publicly accessible.

Height Enter the height of the Flash movie in pixels.

Width Enter the width of the Flash movie in pixels.

4. Click Submit.

Related topics

Add and manage attachments

Content blocks

Configure a content block

Configure content links

Use content links to create navigational links to information outside your instance. Content links 
are the predecessors to navigation menus.

Before you begin
Role required: content_admin or admin

About this task
After the content link is configured, it must be defined in a list block. List blocks use content links 
to reference information outside of your CMS.

Procedure

1. Navigate to All  > Content Management  > Specialty Content  > Content Links.

2. Click New.

3. On the form, fill in the fields.

Content Link form

Field Description

Name Type a unique name for the content link

Redirect to Select the location of the external link

Category Select a category to provide organization for 
the list content block.

URL Click the lock icon to open the edit field, then 
enter the site URL to open when the link is 
clicked. This field is available only if Redirect 
to  is set to The specified URL.

Open in Select the behavior of the clicked link.
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Field Description

Detail page Select the page where the link opens when 
it is clicked. This field is available only if 
Redirect to  is set to A content page.

iFrame Enter the name of the iFrame where the link 
opens when it is clicked. Make sure that 
there is an iFrame on the page where the link 
opens. This field is available only if Open In  is 
set to Named iFrame.

4. Click Submit.

5. From Content Management  > Blocks  > Lists, create a list block that references the content 
links by selecting Content Link  in the table field.

6. Create a query to determine which external links display on the page.
For example, the query Category is Search  displays any external links that have a 
category defined as Search.

7. Click Update.

Configure iFrames

An iFrame embeds a URL on a page within a frame. It can embed external pages or render 
ServiceNow  content.

Before you begin
Role required: content_admin or admin

About this task
Configure an iFrame with forms you create in the instance and link to the page in which the 
iFrame resides.

Note: 
Do not add any type of report, such as a calendar, to iFrames. For more information on 
adding a report directly onto a page without using iFrames, see Embedding reports in 
Jelly .

Note: 
To deliver ServiceNow  content from a web page, see Service Portal  instead.

Procedure

1. Navigate to All  > Content Management  > Specialty Content  > iFrames.

2. Click New.

3. Complete the iFrame form fields.

iFrame form fields

Field Input value

Name Type a unique name for the iFrame block.

Frame 
name

Type a name for the frame on the page.
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Field Input value

When you use iFrames to present ServiceNow  content such as forms or lists, the 
frame name must be gsft_main. This name allows links within the iFrame to open 
within the iFrame.

URL Enter the URL to display in the iFrame. If you use the iFrame to display ServiceNow 
content, start with the page name and do not include the base instance part of the 
URL. For example, to show the list of requested items, the URL is:

sc_req_item_list.do

Queries can be applied to the URL. For instance, to display a list of open requested 
items, the URL is:

sc_req_item_list.do?sysparm_query=active=true

For more information, see Navigate to a record or module using a URL.

Sizing Select an option for iFrame block size.

Note: 
The Expand to fit content  choice only works with ServiceNow  content. If Fixed 
Size  is selected, height and width fields are displayed for you to enter the size in 
pixels.

Note: 
Some browsers suppress iFrames because they use an X-Frame-Options header value 
of SAMEORIGIN. The X–Frame-Options header was introduced in Internet Explorer 8 
RC1, to help detect and prevent frame-based redressing. The SAMEORIGIN value causes 
the browser to render a blank page instead of the target page of the <frame> or <iframe> 
when the frame target is not on the same origin as the page itself. Support for this header 
has been implemented in Safari 4.0, Chrome 4.1.249.1042, and Firefox 3.6.9 and above.

Related topics

Content blocks

Configure a content block

Integrate Live Feed with CMS

You can provide access to Live Feed from pages built in the Content Management System (CMS). 
For example, allow an end user to access your company feed via the ESS portal.

Before you begin
Role required: content_admin or admin

About this task
The ESS Portal template includes the Portal - Live page  and Live Feed  dynamic block (requires 
the Live Feed plugin). To provide access to Live Feed from CMS pages, add the Live Feed 
dynamic block  to a CMS page or include the Portal - Live page  in a site.

Procedure

1. Navigate to All  > Content Management  > Specialty Content  > iFrames.

2. Click New.

3. Complete the iFrame block form with the following values.
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iFrame values

Field Input value

Name Type a unique name: Live Frame

Frame 
name

Type a frame name: live_frame

URL Enter https://instance name/live_feed.do?
sysparm_doctype=true . Replace instance name with your instance URL, for 
example, <myinstance>.service-now.com.

Sizing Select Fixed Size  and enter height and width pixel dimensions according to the page 
on which you plan to display the feed. For example, enter a width of 1024 and height 
of 768.

4. Click Submit.

5. Complete the steps in Add the block to a page.

Related topics

Content blocks

Configure a content block

iFrame methods

The following examples show how system records are pulled into an iFrame that is placed on a 
content page.

For system lists or forms, use the frame name gsft_main  so that links work properly.

• Order Hardware  is an example of linking to a catalog category.

◦ URL: com.glideapp.servicecatalog_category_view.do?
sysparm_parent=d258b953c611227a0146101fb1be7c31&sysparm_view=

◦ Frame name: gsft_main

• My Approvals List  is an example of linking to a list with a view filter and a JavaScript that 
reference the authenticated user.

◦ URL: sysapproval_approver_list.do?
sysparm_query=approver=javascript:getMyApprovals()&sysparm_view=ess

◦ Frame name: gsft_main

• Service Catalog Home Page (system)  references the system catalog page within the Service 
Catalog application. If you are satisfied with the way the catalog looks, this method is an easy 
way to bring the page into a CMS design.

◦ URL: catalog_home.do?sysparm_view=catalog_default

◦ Frame name: gsft_main

• Problem Management Overview  references a homepage. ../  makes the URL string relative 
to system homepages. Without it, the URL string resolves to the default CMS homepage 
reference in the site.

◦ URL: ../home.do?sysparm_view=problem_overview

◦ Frame name: gsft_main
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Configure a detailed content block

A detailed content block displays the content of an existing document, such as an incident, 
knowledge article, or service management request. The document type determines the page that 
a list of documents points to.

Before you begin
Role required: content_admin or admin

About this task
The block works with content types in the Default detail page  field. For more information, see 
Configure a content type.

If you plan to use a script to find a document, configure the form to add the Script  field if it is not 
displayed.

Procedure

1. Navigate to All  > Content Management  > Configuration  > Page Detail Settings.

2. Click New.

3. Complete the Detailed Content form.

Detailed Content form

Field Description

Name Type a unique name for the Detailed Content block.

Category Select a category to provide organization for the detailed content block. If 
the block Type  is Show the page's current document, the category displays 
content from any link of the same type.

Frame Select a border styling for the detailed content block. For more information, see 
Format a frame.

Model 
Document

Select the document to display by default.

Active Select this check box to make the block available for use.

Type Select the behavior for the block.

◦ Show a Specific Document: Displays the Model Document.

◦ Show the page's current document: Displays the currently selected 
document.

◦ Use a script to find a document: Uses the Script  field to select a particular 
document.

Conditional Select the check box and enter any scripted conditions to be applied. Selecting 
this check box adds a Condition  script field and Logged on  check box to the 
form.

Script Enter a script to find an appropriate document if the Type  is set to Use a 
script to find a document. Set the Return  to the GlideRecord of the desired 
document.

4. Click Submit.
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Related topics

Content blocks

Configure a content block

Content Management and the Apache Jelly engine

Apache Jelly is a Java-based and XML-based scripting and processing engine for turning XML 
into executable code.

The Apache Jelly engine closely resembles XML and should be comfortable for developers 
familiar with JavaScript, XML, XHTML, or HTML. In the ServiceNow  instance, the Apache Jelly 
engine renders items such as forms, lists, and UI Pages. Apache Jelly code renders well within a 
dynamic content block, but can have issues when used in static blocks. You can use Jelly tags, 
calls, and statements, but HTML acts just like XHTML.

<?xml version= "1.0" encoding= "utf-8" ?>
<j:jelly trim = "false" xmlns:j = "jelly:core" xmlns:g = "glide" 
 xmlns:j2 = "null" xmlns:g2 = "null" >
 
 <j:if test = "${current_page.getName()=='Solutions'}" >
 <h1 class = "page_name" > <b> <a href = 
 "solutions.do?" title = "${gs.getMessage('Solutions')}" 
 >${gs.getMessage('Solutions')}</a> </b> </h1>
 <p class = "page_description" >
       ${current_page.getDescription()}
 </p> <br />
 </j:if>
 <j:if test = "${current_page.getName()=='IT 3.0'}" >
    <h1 class = "page_name" > <b> <a href = 
 "solutions.do?" title = "${gs.getMessage('Solutions')}" 
 >${gs.getMessage('Solutions')}</a> </b> | 
 ${current_page.getName()}</h1>
    <p class = "page_description" >
       ${current_page.getDescription()}
  </p> <br />
  </j:if>
  </j:jelly>

Ensure that all tags are closed. If the tag is not a naturally closing tag, then place a forward slash 
before the end bracket. For example, a <BR />  or an <IMG src="cms.png" />.

If you are unfamiliar with Jelly scripting, review these topics:

• Jelly tags

• Extensions to Jelly syntax

• Jelly escaping types

Include the following tag with all Apache Jelly scripts.

<j:jelly trim= "false" xmlns:j= "jelly:core" xmlns:g= "glide" 
 xmlns:j2= "null" xmlns:g2= "null" >

The tag looks complex, but keep the following information in mind.
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• Apache Jelly script uses multiple namespaces.

• There are two types of prefixes in tags: j and g. The j prefix is used for tags that are natively part 
of Apache Jelly. The g prefix is used for tags that the ServiceNow  platform created and is using 
for platform purposes.

The j2 and g2 prefixes are just like j and g, except that they are processed in a second phase. The 
Apache Jelly script parser runs through each j and g tag respectively. For example:

<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="null" xmlns:g2="null">
 <j:set var="jvar_phase1" value="Hello" />
 <j2:set var="jvar_phase2" value="World" />
 ${jvar_phase1} $[jvar_phase2]
</j:jelly>

In phase 1, the parser runs through all the j and g tags. It then caches the result. Before it runs 
the second phase, it takes the j and g namespaces and moves the namespaces to the second 
phase. It looks something like the following code.

<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="jelly:core" xmlns:g2="glide">
 <j2:set var="jvar_phase2" value="World" />
 Hello $[jvar_phase2]
</j:jelly>

For subsequent calls of this script, only phase 2 is parsed.

Note: 
If you plan to use phase 2 Jelly tags (g2 and j2) on the Content Type [content_type] or 
Dynamic Content [content_block_programmatic] tables, select the Two phase  option on 
the content form.

Another example is to create a report of all open incidents assigned to each group. For this 
purpose, you could use a report and save time, but it is a good example for learning Jelly. Start 
with the Jelly tag:

<j:jelly trim= "false" xmlns:j= "jelly:core" xmlns:g= "glide" 
 xmlns:j2= "null" xmlns:g2= "null" >
</j:jelly>

First, you need a list of open incidents. Use a g2:evaluate  tag. The evaluate tag runs the 
script. Anything inside the tag is parsed like a business rule, so, for example, you can call global 
business rules, script includes, and gliderecord.

<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="null" xmlns:g2="null">
 <g:evaluate var="jvar_groups" object="true">
  var now_GR = new GlideRecord("sys_user_group");
  gr.orderBy('name');
  gr.query();
  gr;
 </g:evaluate>
</j:jelly>

This script is in phase 1 because frequent changes to incident assignment groups are not 
expected. Also notice the var  attribute on the evaluate tag. This attribute specifies what variable 
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is set from this block. At the end of the script, there is a gr  on a line by itself. That last line is what 
sets the variable.

You can omit the jvar_groups  variable, but then all the variables in the evaluate tag become 
Apache Jelly variables. The object=true  specifies that the variable is not a primitive data 
type. If object=true  is omitted, the script would break because jvar_groups  would only 
be able to hold items like integers and strings.

After the evaluate tag, loop through these groups and find the incidents for each one.

<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="null" xmlns:g2="null">
 <g:evaluate var="jvar_groups" object="true">
  var now_GR = new GlideRecord("sys_user_group");
  gr.orderBy('name');
  gr.query();
  gr;
 </g:evaluate>
 <table>
  <tr>
   <th>Name</th>
   <th>Incidents</th>
  </tr>
  <j:while test="${jvar_groups.next()}">
   <tr>
    <td>${HTML:jvar_groups.getValue('name')}</td>
    <td></td>
   </tr>
  </j:while>
 </table>
</j:jelly>

You can include normal XML in the Apache Jelly script at any time. Since there is no namespace, 
the Apache Jelly script does not try to parse the XML tags. Notice the j:while  loop. It is a 
normal while loop and can iterate through a GlideRecord object. Also notice that you output 
a value with ${HTML:jvar_groups.getValue('name')}. Here are the important 
elements:

• The outer brackets, ${}, specify the output of the variable and the phase in which the variable 
is output: ${}  means first phase, $[]  means second phase.

• HTML before the expression is for escaping the output. The expression 
jvar_groups.getValue('name')  is being escaped for HTML. For other types of 
escaping, there are JS (Javascript), NS (No Script), and some other options.

To select only one record and not iterate through many records, the code looks like the following 
example:

<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" 
 xmlns:j2="null" xmlns:g2="null">
 <g:evaluate var="jvar_groups" object="true">
  var now_GR = new GlideRecord("sys_user_group");
  gr.orderBy('name');
  gr.query();
  gr;
 </g:evaluate>
 <j:if test="${jvar_groups.next()}">
  We found ${HTML:jvar_groups.getValue('name')}
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 </j:if>
</j:jelly>

Content management and Jelly code examples

Code examples

Header Example Code

This dynamic content block needs to be active and have the "Two Phase" option 
clicked. The g:requires tag is including the UI script defined in the system whose 
name is "servicenow.website.globals". The file extension in the call is .jsdbx and is 
used only in the call to the UI script, not in the name of the script in the system. For 
JSDBX, the file being called is a JavaScript(.js) defined within the database (db) that 
needs to be cached (x).

<?xml version= "1.0" encoding= "utf-8" ?><j:jelly trim 
 = "false" xmlns:j = "jelly:core" xmlns:g = "glide" 
 xmlns:j2 = "null" xmlns:g2 = "null" >
 
    <g:requires name = 
 "servicenow.website.globals.jsdbx" />
 
</j:jelly>

Page Title and Description Example Code

This dynamic content block needs to be active. There are two actions within 
this code snippet. First is a forward-looking string container that allows 
site translation, the ${gs.getMessage('Your Text')} string call). The second 
action pulls in the page title and description, ${current_page.getName()} and 
${current_page.getDescription()}.

<?xml version= "1.0" encoding= "utf-8" ?><j:jelly trim 
 = "false" xmlns:j = "jelly:core" xmlns:g = "glide" 
 xmlns:j2 = "null" xmlns:g2 = "null" >
 
 <j:if test = "${current_page.getName()=='Solutions'}" 
 ><h1 class = "page_name" > <b> 
 <a href = "solutions.do?" title 
 = "${gs.getMessage('Solutions')}" 
 >${gs.getMessage('Solutions')}</a> </b> </h1><p class 
 = "page_description" >
       ${current_page.getDescription()}
  </p> <br /></j:if><j:if test = 
 "${current_page.getName()=='IT 3.0'}" ><h1 class 
 = "page_name" > <b> <a href = "solutions.do?" 
 title = "${gs.getMessage('Solutions')}" 
 >${gs.getMessage('Solutions')}</a> </b> | 
 ${current_page.getName()}</h1><p class = 
 "page_description" >
       ${current_page.getDescription()}
  </p> <br /></j:if></j:jelly>

List Block Pulling From Knowledge Articles Example Code

This code example contains one of the best tricks in the CMS. Using the type field 
with draws from a number of defined list definitions to make slight, or very dramatic 
changes, to list display. Because the UI is open to configuration and innovation, 
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this is a good opportunity to use design skills. Anyone who can use HTML and 
CSS knows that a basic list can be turned into a float grid or be made inline. The 
combinations are limited only by what the designer can dream up and code.

In the code example, there is a custom logo field (u_logo) added to the Knowledge 
form. The custom field displays customer logos, partner logos, and award images on 
the awards page. There are a number of different sections that use this list definition 
so efficient reuse is taking place.

• div class="cms_knowledge_list customer_success" - Begin by creating an outer 
container with a unique class name that can be used as a basis for CSS style 
selectors and rules. From the outer container, many of the child elements can be 
accessed for theming.

• <g:for_each_record file="${current}" max="${jvar_max_entries}"> - Loop for list 
creation that calls the selected table record and the entries set on the list form.

• <a href="knowledge.do?sysparm_document_key=kb_knowledge,
${current.sys_id}"><img src="${current.u_logo.getDisplayValue()}" 
alt="${current.text}" width="110px"/> - Defines linking to the article detail in the 
knowledge base. For further reference, look at content types within the site 
definition and you will see some similarities. The knowledge.do? portion of 
the URL points to the knowledge detail page which (as mentioned above) is 
mandatory if you plan to call the knowledge base in your CMS site. The rest of the 
URL represents the syntax for calling a knowledge article by its sys_id. Each and 
every item housed within the system has a unique sys_id.

• <ttt>${SP}-${SP}${current.author.first_name}${SP}${current.author.last_name}</
tt> - This example is commented out and not used, but it is still interesting in that 
it has a jelly call ${SP} and it pulls the knowledge article's author by first and last 
name.

<?xml version= "1.0" encoding= "utf-8" ?><j:jelly trim 
 = "false" xmlns:j = "jelly:core" xmlns:g = "glide" 
 xmlns:j2 = "null" xmlns:g2 = "null" >
 
<div class = "cms_knowledge_list customer_success" 
 ><g:for_each_record file = "${current}" max = 
 "${jvar_max_entries}" ><br /><table cellspacing 
 = "0" cellpadding = "0" border = "0" class 
 = "background_transparent" ><tr><td class 
 = "cms_knowledge_list_image" ><j:if test = 
 "${current.u_logo.getDisplayValue() != ''}" 
 ><div class = "knowledge_article_logo" ><a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${curr
ent.sys_id}" > <img src = 
 "${current.u_logo.getDisplayValue()}" alt = 
 "${current.text}" width = "110px" /> </a></div></j:if>
 
   </td><td width = "100%" ><a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${curr
ent.sys_id}" target = "_top" ><span 
 class = "cms_knowledge_list_link" 
 >${current.short_description}</span></a><p class = 
 "kb_description" >
     "${current.description}"
     <!--${SP}-${SP}<span 
 class="cms_knowledge_list_author">${current.author.fir
st_name}${SP}${current.author.last_name}</span>--></p
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></td></tr><tr><td width = "100%" colspan = "2" class = 
 "kb_learn_more" ><p class = "kb_learn_more" ><a href = 
 "knowledge.do?sysparm_document_key=kb_knowledge,${curr
ent.sys_id}" >Learn More</a></p></td></tr></table>
 
</g:for_each_record></div>
 
</j:jelly>

Related topics

Content Management and the Apache Jelly engine

Style in Content Management

Content pages can be styled with CSS, just like any HTML website.

Three elements control CSS styles:

• Style Sheets  are records containing CSS declarations.

• Themes  are groups of style sheets that can be invoked together.

• Frames  are UI macros that define the outer border of individual content blocks as they appear 
on a content page. Frames work by calling on particular definitions in the style sheets.

Related topics

Define a frame in a style sheet

Create a frame UI macro

Style sheets

Styles sheets are standard Cascading Style Sheets (CSS) that define the look and feel of all 
elements within the interface.

Cascading Style Sheets (CSS) can either be internal (stored in the database) or external (hosted 
on the server), based on organizational needs. To define an internal style sheet, use standard 
CSS in the style field. Using external CSS allows the Content Management System to use the 
same CSS as a corporate website or other online resource.

Use an external style sheet by defining a URL that points to the .cssx file. If you upload a .cssx file 
to the platform, you can reference the .cssx file using a URL.

Content pages do not reference style sheets directly. To invoke a style sheet, you assign the style 
sheet to a Theme using the related list on the Theme form.

Related topics

Customize a design theme

Design themes

Design themes are the convergence of structure and styling, making them a critical tool for 
creating a powerful user interface.

For a successful project, review the corporate style guide and communicate with the corporate 
website art team. If the organization has an art or design department that maintains branding, 
include them in this process.

A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a 
set of pages. In most environments, many pages share a few themes. Use multiple themes within 
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a site to create stylistic differentiators between site areas. You can also use a single theme to 
create one unified look and feel for the site.

Related topics

Define a frame in a style sheet

Create a frame UI macro

Customize a design theme

A theme is a collection of one or more style sheets (CSS files) that define a consistent look for a 
set of pages.

Before you begin
Role required: content_admin or admin

About this task
Themes can be invoked in any of the following ways.

• Directly by content pages.

• As the default theme of a content site.

• On the configuration page as a global default.

Procedure

1. Navigate to All  > Content Management  > Design  > Themes.

2. Click New.

3. Type a name for the theme and mark it as Active.

4. Right-click the form header and click Save
The Style Sheet  related list appears.

5. Use the Style Sheet  related list to add style sheets to the theme.

Doctypes

The view_content html page template on which all CMS is based defaults to doctype=html.

The code looks like the following HTML source code.

<!DOCTYPE HTML>

If your CMS site does not render properly, remove the doctype from the 
page by setting the following property: glide.html.doctype.pages  = 
chat_desktop,live_feed,live_feed_small,navigator,navpage11,image_browse

The following is the default for this property: glide.html.doctype.pages  = 
chat_desktop,live_feed,live_feed_small,navigator,navpage11,image_browse,view_content

Setting this doctype offers these benefits for building new sites:

• Incorporating common practice: Use a practice that is becoming widely adopted across the 
Internet and can prevent certain browsers from running in quirks mode.

• Cleaner CSS and markup: Write more standards-based CSS and markup to promote code 
sharing.

• A step towards browser compatibility: Find solutions that work across browsers and avoid 
browser-specific workarounds.
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Format a frame

Frames provide a way to manage decorative containers for content blocks and any other 
elements within the site. For example, one frame can be a container, made of div or span tags, 
that is styled with rounded corners.

Before you begin
Role required: content_admin or admin

About this task
Individual content blocks use a frame UI macro to define the frames. When viewing a content 
block form, the Frame  field offers a choice between the different frame UI macros. The frame 
UI macro does not, however, have the definition for the frame within its Jelly script. Instead, it 
references a particular frame as defined in a style sheet.

Configuring a new frame is a two-step process.

Procedure

1. Define the frame in a style sheet.

2. Create the frame UI macro to invoke the frame definition.

Define a frame in a style sheet

Add style definitions for any custom frame UI macro you create.

Before you begin
Role required: content_admin or admin

About this task
Each frame has its own class name.

Procedure

1. Navigate to All  > Content Management  > Design  > Style Sheets.

2. Select a style sheet to contain the frame definition.
Base system themes use a separate Frames  style sheet.

3. Add the following code, substituting the desired frame name and style:

div.FRAMENAME{border:STYLE;}

4. Click Update.

Create a frame UI macro

Copy an existing frame UI macro to display content in a custom frame.

Before you begin
Role required: content_admin or admin

About this task
Create a custom frame UI macro if you want to control the style of the frame with your own style 
sheet definitions.
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Procedure

1. Navigate to All  > Content Management  > Design  > Frames  and select one of the existing 
frame UI macros.

2. Change the name to match the FRAMENAME you used in the style sheet.

3. Right-click the header bar and select Insert and Stay.

4. Update the frame name in the XML field as shown:

<div class="FRAMENAME">

5. Click Submit.

What to do next

• In any content block form, select the UI macro.

• Define the frame in a style sheet.

Related topics

Content blocks

Content Management meta tags

Meta tags are special tags in web pages that contain information about the page but are not 
rendered with the page. You can define custom meta tags for content pages.

Meta tags are not noticeable to a page visitor unless the visitor looks at the page source code. 
Web search engines read meta tags as they "crawl" the web, identifying and organizing content. 
Modern website designers often use meta tags to embed "hints" to search engines about how to 
index or otherwise crawl the site.

Structurally, a meta tag consists of a tag and a name/content pair and looks similar to the 
following code.

<meta name="generator" content="MediaWiki 1.16wmf4" />

The Content Management System allows you to define both site level and page level tags.

Configure a page level meta tag

A page level tag is a meta tag defined on a specific page and included on only that page.

Before you begin
Role required: content_admin or admin

About this task
If an individual page has a specific tag with the same name as the site, the page tag takes 
precedence.

Procedure

1. Navigate to All  > Content Management  > Pages.

2. Open the page.

3. If not already included, add the Meta Tags  related list to the form.

4. In the Meta Tags  related list, click New.
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5. Type a Name  and Content  for the tag.

6. Click Submit.

Configure a site level meta tag

A site level tag is a meta tag is defined on a site and included on every page within that site.

Before you begin
Role required: content_admin or admin

About this task
If an individual page has a specific tag with the same name as the site tag, the page tag takes 
precedence.

Procedure

1. Navigate to All  > Content Management  > Sites.

2. Open the site.

3. If not already included, add the Meta Tags  related list to the form.

4. In the Meta Tags  related list, click New.

5. Enter a Name  and Content  for the tag.

6. Click Submit.

Configure DIV-based layouts

After you create your site, you can change the site layout with DIV tags.

Before you begin
Role required: content_admin or admin

About this task
Many web page layouts use tables for a consistent look and feel. Tables are effective for 
numbers and statistics, but can be limiting for designing other types of information. DIV tags are 
flexible block-element tags. To use DIV tags for layouts, give the tag an ID and assign attributes 
using CSS.

Changing to CSS and DIV tags help in the following ways:

• simplify code

• reduce the amount of code

• increase page load speed

• separate content from presentation

• help pages adapt to different device resolutions

• make pages easier for search engines to crawl

• make code more compliant with evolving web page design standards

A theme named Administration Theme - Charcoal  is included as an example of CSS-driven, 
DIV-based layouts. To view the Administration Theme - Charcoal  DIV-based layout, complete 
the following steps.
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Procedure

1. Navigate to All  > Content Management  > Design  > Layouts.

2. Click Admin 1 Column

3. Review the code.

Content meta tag hierarchy

Page and site level meta tags are included in a content meta tag hierarchy.

Site and page level tags

CMS supports page level and site level tags. The system behavior is to show the sum of all page 
level and site level tags. For example, if you have two tags on the site and one tag on the page, all 
with different names, you see three tags on the page. Two are from the site and one is from the 
page. If both the site and the page have a tag of the same name, only the page tag is used.

Note: 
The Content Management System does not support some commonly used meta tags. For 
example, you cannot use the X-UA-Compatible meta tag, which allows you to specify which 
version of Internet Explorer a site should be rendered in.

Example: all tags have unique names

 Site Level
Name         Content
breakfast    eggs
lunch        sandwich
 
Page Level
Name         Content
dinner       steak
 
Output
Name         Content
breakfast    eggs
lunch        sandwich
dinner       steak

Example: page level tag overrides site level tag

Site Level
Name         Content
breakfast    eggs
lunch        sandwich
 
Page Level
Name         Content
lunch        tacos <--- overrides site level
dinner       steak
 
Output
Name         Content
breakfast    eggs
lunch        tacos
dinner       steak
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Content Management integration points

Integration points use content blocks in CMS to link different applications together using static 
and dynamic methods.

By using integration points, users can connect to different systems from a single page. The 
power of the CMS is that it can display any data within the ServiceNow  platform. The ESS portal, 
for example, connects users to a service catalog, a knowledge base, and a help and incident 
reporting site. Each section contains a set of links to additional content. List blocks offer the 
easiest way to display data dynamically. Content types define how lists link to the detailed data 
they reference.

Generating lists from the ServiceNow  platform is straightforward, especially if you use filtering. 
When the CMS was first introduced, lists were the only method available to create navigational 
systems for sites. Content types define system record links using specific templates to define the 
list and the details.

• Summary template: defines the list

• Detail template: defines the detail as it is rendered in a page.

The templates work together to pass data attributes or Unique record identifier (sys_id)  (sysid) 
into a single detail page that manages the data. Any attribute variations use the URL sent to the 
page.

Understanding how content types work can mean the difference between a site with 20 pages 
versus a site with 200 pages. There is a time for both types of data calls. Depending on the task, 
there are appropriate times to use static content and times for dynamic methods.

View links between system elements and URLs

You can view the links between your system elements and their URLs to render more specific 
content within your site.

Before you begin
Role required: content_admin or admin

About this task
See the Navigate to a record or module using a URL  page for an overview of URL syntax in the 
ServiceNow  platform.

The Incidents list offers a quick example of viewing a form within its own tab. This viewing 
method illustrates how to append the URL string to render more specific content within your site.

Procedure

1. Navigate toIncident  > All.

2. Right-click in a blank area within the content frame and select Open Frame in New Window  or 
Open Frame in New Tab.
The URL returned looks similar to this example.

<instance_name>/incident_list.do?
sysparm_userpref_module=b55b4ab0c0a80009007a9c0f03fb4da9

The URL is comprised of the following elements.
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◦ incident_list.do?  is the call to the list with no parameters passed into it. Explore 
context menu options and list filtering variations to see how the URL string is appended with 
each action.

◦ incident_list.do?sysparm_query=&sysparm_view=ess  is an example of how 
the view is passed in the URL string.

◦ incident_list.do?sysparm_query=GROUPBYactive&sysparm_view=  is how 
the URL looks when the group by  option is chosen from the context menu.

◦ incident_list.do?sysparm_query=category%3Dsoftware  is the result of 
applying a category is software  filter to the list.

Explore all the options available within the right-click menu. Click through to the Incident form 
itself (incident.do) to see what the URL string does when parameters are passed into it.

Element link examples

View examples that show how to create a site pointing to various system data in several different 
data tables.

The following examples illustrate setting up access to the following system data.

• Knowledge: building a versatile front end for a knowledge base, from overview page to 
variations on the list definitions used in the site.

• Catalog: ideas for a business-to-consumer shopping experience that pulls various items and 
forms from your service catalog.

• Service Portfolio: using the business service portfolio to contain all defined services offered by 
your organization.

• Featured reports: methods for linking to the most important reports.

Example links to system data
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Page source view

Use the tools available in your browser to view the frame source page and understand what URL 
address bars pass between system frame sets.

The Firefox browser, for example, has the developer tools option. This option provides an easy 
way to view records that render within the main content frame (gsft_main) of the ServiceNow 
platform. Also, Firefox quickly builds menus and links to records within the system.

This Firefox functionality is useful when stepping through the menu items section.

Frame view

Static methods

Static methods in the CMS application were created for ease of use.

Form-based menu management and WYSYWIG code editing can be useful to both advanced 
and entry-level users. The technical ability of subject matter experts (SMEs) managing the 
language of your site can vary considerably. Letting SMEs write the content and having a 
technical resource manage the linking expedites menu and link creation within the system.
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Static and dynamic methods

Navigation Menu Links

Use base system templates to group similar links for placement on the page. 
Though the terminology is different (menu sections and menu items), this type of 
linking behaves the same way as content links. For more information on creating a 
navigation menu block, see Create a navigation menu block.

Static HTML Details

Content blocks that are useful for areas administered by developers unfamiliar with 
HTML or markup. Anyone familiar with markup can use dynamic blocks because 
they are extendable. For more information on static HTML, see Using Content 
Blocks.

Content Links

The predecessors to navigation menus from when the CMS was first introduced. 
Use content links to make navigational links by defining several content links 
under the same category. Then, call the links as a list referencing the Content Link 
[content_link] table.

iFrame Details

Used both dynamically and statically throughout the system. Using them is an easy 
way to bring any form or list into your CMS pages. For more information on iFrame 
methods, see Using Content Blocks.

Dynamic methods

While static methods are a powerful navigational tool, you have more control over data rendering 
using the dynamic methods.

Reference common code in the system to make long-term maintenance of the site easier. Coding 
skills are useful when implementing dynamic methods.
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Static and dynamic methods

Dynamic Blocks

These blocks are where the majority of your work resides. For more information, see 
Configure dynamic blocks.

Frames

Frames are meant to be decorative wrappers around any block in the system. They 
are mentioned with dynamic blocks because frames are essentially UI macros with 
the category of Frame. Frames apply the ${body}  variable to a block and define 
where the block is inserted when rendered on the page.

Lists

Lists generate links to records based on the filtering rules you define. Lists can 
be sorted for presentation by any field in the corresponding record. Lists help 
supplement navigation and pull data from outside the CMS. For more information, 
see Customize the list block.

Content Types

Content types provide site-specific control of how system data defined as templates 
is rendered. The rendering of lists is considered first (summary templates). The next 
consideration is the detail template, which allows control over the record rendering.

List Definitions

List definitions enable you to extend the summary template defaults defined on 
the site level. Used with frames, list definitions render the same data differently 
based on the placement on the page or site. For more information, see Configure list 
definitions.

Detailed Content

Detailed content in page detail settings) are blocks that display the content of 
an existing document as a block on a content page. For more information, see 
Configure a detailed content block.
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Example integration points

Each element on the page links to a specific URL point.

Integration points

Business Services  links to a content page (CMS page referenced: Business Service Portfolio, 
URL: (business_service_category.do) that pulls the system service catalog homepage 
into a frame within the content area. Each link within this section uses the browse by category 
page, where you pass in the name of the category to return results.

• Target page iFrame URL: catalog_home.do?
sysparm_nameofstack=aabdae07ef221000914304167b22567d&sysparm_view=business&sysparm_clear_stack=yes

• Target page frame name: gsft_main

◦ Desktop Computing  URL: category_browse.do?category=Desktop Computing

◦ Business Applications  URL: category_browse.do?category=Business 
Applications

◦ Communications Services  URL: category_browse.do?
category=Communications Services

◦ Infrastructure Services  URL: category_browse.do?category=Infrastructure 
Services

◦ Hosting Services  URL: category_browse.do?category=Hosting Services

Featured Services  links to a content page which pulls a small subset of services into an iFrame.

• iFrame URL: com.glideapp.servicecatalog_category_view.do?
sysparm_parent=d67c446ec0a80165000335aa37eafbc1&sysparm_view=

• Frame name: gsft_main

◦ Install Software  URL: catalog.do?
uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=10d69689c611227600ffeba41c664824

◦ Email Account  URL: catalog.do?
uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67a86b6c0a80165009386c752cd4a09

◦ Electronic Messaging  URL: catalog.do?
uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=533798810a0a0b2600f1a03593e19058
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◦ VPN RSA Token  URL:  catalog.do?
uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=d67b099ac0a80165019d0c276b772502

◦ Shared Storage (SAN)  URL: catalog.do?
uri=com.glideapp.servicecatalog_cat_item_view.do?
sysparm_id=cedd458a0a0a0b8300c3b1e32e7a3ac2

Reporting  links to a content page that pulls the reports page into an iFrame. All links within this 
menu leverage homepages in the system, which creates an issue with the home.do URL. Notice 
in the following links that ../ is used to create a relative URL outside of the CMS site home.do 
definition. Without this path, the site homepage would render within the iFrame.

• iFrame URL: report_home.do

• Frame name: gsft_main

◦ Cost Management Overview  URL: ../home.do?
sysparm_userpref_homepage=fa81ae91c0a805c64c0942ab2e4b852b

◦ Administration Overview  URL: ../home.do?
sysparm_userpref_homepage=8b7b11f6c611228901ff3fcfbdb3cc8f

◦ Portfolio Overview  URL: catalog_home.do?sysparm_view=business

◦ Service Availability  URL: ../home.do?
sysparm_userpref_homepage=8ee772000a0a0bad00c38eb7e68b93d0

◦ Service Level Agreements (SLA)  URL: ../home.do?
sysparm_userpref_homepage=757e86a30a0006d4010a6851639498d1

Content Management testing

Test your site to ensure that all pages display correctly, links go to the specified address, and 
images are not broken. It is important to test the site as you build it. Do not wait until just before 
launch to begin testing.

Also, test templates as you create them so any issues are resolved before creating other content 
based on the templates. Recruit as many people as possible to help you test.

Here are some general site testing guidelines:

• Test on the browsers and platforms your site visitors use

• Test on various monitors (for example, LCD and CRT)

• View pages using different screen resolutions

• View pages using different color settings

• Test all navigation and links

• Test items that can be downloaded (for example, PDF files)

• Test the search functionality

• Test site security

• If necessary, test for accessibility (for guidelines, see the W3C Website Accessibility 
Initiative )

Global search in Content Management

When you add global search to a CMS site, two different search result blocks can display, 
depending on the user role: global or no global.
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Roles are defined at System Properties  > Global Text Search.

• Search Results (Global): For users with permission to use the global search within the normal 
frame set. The normal frame set is defined as the default, non-CMS user interface with the set 
of frames.

• Search Results (No Global): For users without permission to use the global search. Searches 
only the knowledge base and the catalog.

The header search bar and the Search dynamic block in the base system both automatically 
handle the permissions and direct the user to the appropriate search results. In the base system, 
the search result blocks are deployed on the same Search Results content page.

In order for the global search to work properly, it is important to ensure that the DEFAULT directs 
users to a working content page. If not, the results from the global search link back to the frame 
set, not to pages within the CMS site.

Note: 
The global search is similar to the normal frame set user interface and ties to the same roles 
(Set global text search properties ).

Search Results (Global)

Before you use the Search Results (Global)  dynamic block, define Configure content types  to 
control the behavior a search result is clicked. If no content type is defined for a table, selecting 
a link on that table renders the results according to the DEFAULT  content type. It is good practice 
to point the DEFAULT  content type to a page with a normal "Current Document" detailed block. 
Set the content type detail (Detail Template  field) to have just an iFrame.

The Search Results (No Global)  dynamic block does not require any additional configuration.

CMS translation

You can translate CMS sites by activating internationalization plugins and manually translating 
custom interface strings.

Two tables support the translation of a CMS site into other languages.

• Translated Name / Field [sys_translated]: Stores strings that are shared or commonly used 
within a site. These include menu section names, menu item names, site breadcrumb names, 
link names, and footer menu links. Internationalization plugins typically provide translations for 
these strings. SeeSystem Localization .

• Translated Text [sys_translated_text]: Stores unique string translations which you create when 
you manually translate interface elements. See Export and edit translation records .

View a translated CMS site

Activate an internationalization plugin, which provides a quick way to see translated strings 
for CMS menus, breadcrumbs, and links. For a full translation, you must translate the instance 
manually.

Before you begin
Role required: content_admin or admin

About this task
This example explains how to view a translated site in Japanese.
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Procedure

1. Navigate to All  > System Definition  > Plugins.

2. In the Go to  filter, select Name, enter I18N, and then press the Enter key.

3. Activate both the I18N - Japanese Translations  and the I18N: Knowledge Management 
Internationalization Plugin v2  plugins.

4. Refresh the browser.

5. In the Language  picker in System Settings, select Japanese.

6. Browse the site to see the translated language strings.

7. Navigate to the ESS Portal at http://Instance Name.service-now.com/ess/.

8. Browse the site to see the translated language strings in the ESS Portal.

Related topics

Language internationalization support

Service Portal
Service Portal  allows you to build a mobile-friendly self-service portal experience for your 
employees or customers. Service Portal  is a ServiceNow AI Platform  feature that is active by 
default and interacts with parts of the platform so users can access platform features through 
portals.

https://player.vimeo.com/video/1088513009?
h=944a2d483d&badge=0&autopause=0&player_id=0&app_id=58479

Both beginner and expert developers and can configure portals using Service Portal. Less 
technical users can make basic configuration changes to the UI using Branding Editor and other 
components of Service Portal. More advanced users can edit and extend portals, pages, and 
widgets. Expert users can use the Widget Editor tool to write scripts to power a portal, and even 
create rich web applications on the ServiceNow AI Platform.

Get started

Explore

Learn about how 
administrators, developers, 
and end users use portals 
built with Service Portal.

Configure

Plan and configure 
your portal.

Develop widgets

Develop custom widgets 
using AngularJS, Bootstrap, 

and the ServiceNow API.
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Improve SEO

Make public portal 
pages more findable 

by improving how 
external search engines 
index and rank pages.

Analyze

Get insights to 
optimize your portal.

Reference

Get details about 
properties, SCSS 

variables, and more.

Troubleshoot and get help

• To learn more about what's new and what's changed in Zurich, see the Service Portal release 
notes .

• Ask or answer questions in the ServiceNow AI Platform  community forum

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Service Portal

Whether you're adapting a base system portal or developing a custom portal, learn more about 
the available features that help you provide a self-service portal that drives productivity and 
satisfaction for your employees or customers.

Benefits

Benefit Feature Role

Quickly create a self-service portal with an 
engaging, mobile-friendly user experience 
using an easy-to-use, modular UI.

• Service Portal 
Designer

• Branding and styles

• Widgets

Developer

Empower users with self-service, deflect 
issues, and drive user productivity and 
satisfaction by providing simple and 
immediate access to resources.

• Service catalogs

• Knowledge bases

• Agent Chat

Administrator

Connect users to what they’re looking for in a 
powerful, consumer-grade search experience.

AI Search Administrator

Improve how external search engines index 
and rank public portal pages to make them 
more findable.

Search engine 
optimization

Administrator
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Benefit Feature Role

Monitor metrics and interactions to 
understand a portal's user experience better 
and identify how to improve it.

User Experience 
Analytics

Administrator

Control who accesses your portal and what 
they can see.

Security Administrator

Understanding Service Portal

Service Portal  provides a modular user interface framework for quick and easy building of 
application portals and dashboards for the platform. It helps developers and non‑technical 
administrators create attractive and engaging user experiences that drive employee adoption of 
critical enterprise applications.

How to use Service Portal

Service Portal  is an application included in the platform UI, however it includes a visual layer for 
you to do most of your configuration. In the application navigator, navigate to Service Portal  > 
Service Portal Configuration  to view the configuration page.

The Service Portal  configuration page provides a unique, intuitive way of viewing all the pieces 
of your portal and how they interact with one another. The configuration page allows you to take 
advantage of a real-time preview, while configuring portal settings. Use each of the tiles on the 
configuration homepage to assemble the different components of your portal.

If you prefer the platform layout for configuring Service Portal, you still have the option of creating 
your portal components within the platform UI. The two options are not separate. Everything you 
create in the Service Portal  configuration page also appears in a table in the platform UI.

Who can use Service Portal

Several different kinds of users can configure a portal.

• Limited coding: Service Portal  was designed so that even users with limited coding ability or 
knowledge of the platform UI could set up a portal.

• ServiceNow  Experts: Users with an understanding of the ServiceNow  platform can create 
portals, set up URL redirects, and view all the components of the portal in a table. Most 
portal configuration takes place in the Service Portal  configuration page, but in specific 
circumstances, Service Portal  administrators may need to do additional configuration directly 
within the platform.

• Developers: Advanced customizations and new widget creation are tasks for a developer or 
someone who understands AngularJS and Twitter bootstrap.

In all cases, the user configuring a portal must have the admin  or sp_admin  role.

Basic concepts

You should have a basic understanding of all the following components that make up a portal:

• Themes: Themes define the look and feel of the whole portal, but can be overridden by other 
style configurations.

• Pages: Pages control where and how you store portal content. Pages do not have a defined 
relationship to portal records, they simply exist.
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• Widgets: Components in Service Portal  are called widgets. You can use HTML templates, CSS, 
client scripts, server scripts, and any JavaScript dependencies to define what a widget does. 
From an AngularJS standpoint, widgets are essentially a superset of an Angular directive.

• Most of the data in Service Portal is managed in different locations throughout the system.

For example, if you are building a knowledge portal, the data exists in Service Portal, but the 
knowledge articles are authored and managed in the Knowledge application. The same is 
true for any other type of content you plan to leverage. Take time to understand which tables 
contain and control the data you are working with in Service Portal.

Before you begin

Take the following into consideration before configuring Service Portal:

• Who are you building your site for and why?

• What information do you want to include in your site?

• What do you want the mobile experience to be for users?

• Which platform applications do you plan to use in your portal?

You can use parts of the platform, such as knowledge articles and catalog items, as the 
content for your portal.

For example, if you are building a knowledge portal, the content displays in Service Portal, 
but the knowledge articles are authored and managed in the Knowledge application. The 
same is true for any other type of content you plan to leverage. It is important to take time to 
understand the table structure of data to become acquainted with content.

• How customized is your service catalog? Catalog client scripts and UI policies only work in 
Service Portal  if they use the mobile GlideForm API , so you may need to make some changes.

Additional resources

Service Portal  is built using several well known technologies. Use the following websites as 
resources to help you understand and configure your portal:

• Twitter Bootstrap

• CSS 3 Flexbox

• AngularJS

Service Portal core concepts

Service Portal  contains two parts: a framework and a portal. The framework is composed of a set 
of APIs, Angular services, directives, and tools that help to build portals. The portal is a group of 
pages linked by page IDs.
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Service Portal  overview diagram

After you enter a URL, the framework uses the suffix and picks the appropriate portal to 
determine the theme and configurations. Then it loads the configured default portal homepage 
unless the URL has a specified ID.

Each widget added to a page becomes its own instance. A widget instance is basically the 
application of a widget in a page. Because widgets are reusable and can appear on different 
pages to do different things, the manifestation of a widget on a page is referred to as a Widget 
Instance. The page loads with content represented by widgets.

Widget instances get their logic from the base widget template, client scripts, server scripts, and 
depending on the widget, CSS.

Service Portal configuration page

Most Service Portal  configuration is accessible through the Service Portal  configuration page 
landing page.

In your instance, access the Service Portal  configuration page by navigating to Service Portal  > 
Service Portal configuration. The Service Portal configuration page opens in a new tab in your 
browser.
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Service Portal configuration page

You can also access the configuration page by appending your URL with sp_config. For example, 
https://<instance name>.service-now.com/sp_config.

Use each option on the Service Portal  config page to set up the different parts of your portal.

Page navigation in Service Portal  by URL

You can navigate to a portal or a page in Service Portal  using a URL.

Service Portal  URLs have the following structure:

https://<instance>/<portal suffix>/<guest 
 language>/<keywords>?id=<page id>&lang=<language>&<page 
 parameters>

Element Description

instance Unique, secure web address for each instance. The default format is 
https://<instance name>.service-now.com.

portal suffix Suffix established for the portal. For example, /sp.

guest language The language ID of the portal language. For example, es  for 
Spanish. The page returns in the language specified if the language 
is active and the user accessing the page is a guest user.

keywords
Human readable keywords that improve search engine optimization 
(SEO) and click-through rates for public pages. Human readable 
URLs also help users understand what to expect on a page 
for public and non-public pages. For example, https://
<instance>/kb/en/faq/what-is-a-cookie?
id=kb_article_view&sysparm_article=KB0000007.

For more information, see Add human readable keywords to page 
URLs.

id The ID of the page to navigate to within the portal frame. For 
example, ?id=index.

language The language ID of the portal language. For example, lang=es  for 
Spanish. The page returns in the language requested if the language 
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Element Description

is active and the user accessing the page is a guest user or an 
authenticated user without a language preference set.

page parameters
Additional parameters are required by some pages to load 
dynamic content by looking up a record (table, sys_id). Find the 
$sp.getParameter  calls in a widget server script to see the 
parameters that a widget uses. For more detail on this method, see 
GlideSPScriptable - Scoped .

If you don’t include these additional parameters when required, 
you might get a You are either not authorized or 
record is not valid  error message.

For example, the URL for a public knowledge base page in Spanish in Service 
Portal  could be https://<instance>/sp/es/faq/what-is-a-cookie?
id=kb_article&sys_id=KB0000007.

Note: 
If you use article versioning with the Knowledge Management  - Service Portal 
(com.snc.knowledge_serviceportal) plugin, you must add the article version number 
to the URL to open a knowledge article in the base system or knowledge portals. For 
example, instead of accessing an article using the URL https://<instance>/sp?
id=kb_article&sys_id=KB0000005, you must include the article version number: 
https://<instance>/sp?id=kb_article&sys_id=KB0000005%20V1.0. To 
learn more, see Article versioning .

Referencing a page ID

Widgets and widget instance options reference Service Portal  pages using the page ID. For 
example, a link to the sc_home page within a widget HTML template might appear as follows:

<div><a href="?id=sc_home">${Order something...}</a></div>

Content Management and Service Portal

Service Portal  is a compelling alternative to the Content Management System (CMS) with a 
refined user experience. It does not duplicate CMS or platform UI functionality. Users who have 
sophisticated experiences delivered through CMS may need to invest time into transitioning to 
Service Portal, especially if the CMS implementation includes complex and customized Service 
Catalog  forms.

Service Portal  compatibility with existing CMS sites

ServiceNow  continues to support CMS in current and upcoming releases. If you have existing 
CMS sites and activate Service Portal  on your instance, your CMS sites will continue to work, as 
CMS and Service Portal  are separate applications.

Differences between Service Portal  and CMS

Service Portal  is an alternative to CMS based on more modern technologies. Major differences 
include:

Underlying technology

CMS uses Jelly, which is not a widely used technology. Service Portal  instead uses 
AngularJS , server-side JavaScript, HTML, and CSS. Any scripts that use Jelly do 
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not work in Service Portal. Building widgets in Service Portal  requires knowledge of 
AngularJS.

Visual layer

CMS uses iFrames which can be difficult to work with, limited in terms of styling, 
and susceptible to upgrade issues. Alternatively, Service Portal  is a self-contained 
application that accesses data from other tables on the platform. This enables fine-
tuned control over style and responsive design.

Mobile first

Unlike CMS, Service Portal  is optimized for a mobile environment. For this reason, 
the following apply to the Service Portal  environment:

• Any scripts used in Service Portal  can only use APIs supported in a mobile 
environment. For example, some APIs used in your Service Catalog  client scripts 
may not be supported. For a list of supported APIs, see Service Portal and client 
scripts.

• Service Portal  forms support a maximum of two-columns. As a result, any highly 
customized Service Catalog  forms, such as catalog items and record producers 
that use containers and variable sets, must be simplified to work in a two-column 
layout.

If transitioning to Service Portal, review the following resource: Mobile client 
GlideForm (g form) scripting and migration .

To understand how core CMS components are configured in Service Portal, refer to the following 
table.

CMS and Service Portal components

CMS component Service Portal  equivalent

Content site Portal

Content page Page

Content types
Content types link a table to a content page.

In Service Portal, content types are no longer required. Record 
data is queried and displayed using base system widgets. You 
can add widgets to any number of Service Portal  pages.

Learn more: Using portal widgets.

Layout and dropzones
In Service Portal, pages are made up of containers, rows, and 
columns.

Learn more: Pages.

Content block
A content block is a reusable piece of content.

In Service Portal, content blocks are replaced by widgets.

Learn more: Using portal widgets.
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CMS and Service Portal components  (continued)

CMS component Service Portal  equivalent

Service Catalog Service Catalog  pages are rendered using the SC Catalog Item 
widget in Service Portal. For this reason, Service Catalog  forms 
such as catalog items and record producers are shared between 
your CMS implementation and Service Portal. If you have a highly 
customized Service Catalog, you may need to invest time in 
simplifying your Service Catalog  items and client scripts so that 
they render as expected in Service Portal.

Learn more: Service Catalog forms in Service Portal.

Theme Theme

CSS CSS

CMS and Service Catalog  customizations

Service Portal  comes with base system widgets to address common use cases and to display 
record data. Even though there is no direct migration path from CMS to Service Portal, there may 
be some items, such as catalog items or knowledge articles, that render as expected in Service 
Portal  without any effort.

However, because Service Portal  is supported in a mobile environment, you may need to modify 
any customized forms and scripts. This approach ensures that the items display well on a mobile 
device and present a better user experience. Before transitioning to Service Portal, you may 
need to:

• Refactor client scripts used in your CMS/Service Catalog  to use supported mobile APIs and 
global objects. For a list of supported APIs, see Service Portal and client scripts.

• Build widgets to replace UI Macros and other unsupported scripts. If using a UI Macro in a 
catalog item form and referencing values on the form, you can use the following workaround 
instead: Replace a Service Catalog form script with a widget.

• Simplify any complex forms used in your Service Catalog  to fit the Service Portal  two-column 
form layout.

• Consider which release supports the required functionality. You may want to upgrade your 
instance before transitioning to ensure that you have the required base system features.

CMS to Service Portal  transition

Your CMS may include complex forms and customizations that do not render as expected in 
Service Portal. Use this guide to understand how best to modify your CMS and Service Catalog 
implementation for Service Portal  adoption, and to understand how a conversion may affect your 
users.

If you are considering transitioning from CMS to Service Portal, make sure that you understand 
the impact of moving to a mobile environment. Review the Mobile client GlideForm (g form) 
scripting and migration .
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Note: 
For information about redirecting CMS users to Service Portal, see the How to automatically 
redirect users who navigate to any CMS pages to Service Portal [KB0722455]  article in the 
Now Support Knowledge Base.

Support level and transition actions

CMS 
component Service Portal  support Possible transition actions

Data 
lookups The client-side component of a data 

lookup is not supported in Service 
Portal. However, the data lookup is 
applied in the platform when a record is 
submitted or updated in Service Portal.

While data lookups are not applied 
in the Service Portal, the record 
updates as expected in the platform 
UI when submitted or updated in the 
Service Portal. If your CMS is used by 
requesters only, this limitation may not 
affect your implementation.

Content 
blocks Because Content blocks use Jelly, they 

are not supported in Service Portal

.

In the Service Portal, content blocks are 
replaced by widgets. Widgets are highly 
customizable components that can 
query record data, display and update 
records, and gather user input.

Base system widgets generally cover 
most use cases. Just as you add 
content blocks to a page in your CMS, 
you can add widgets to a page using 
the Service Portal  Designer.

UI Macros
Because UI Macros use Jelly, they are 
not supported in Service Portal.

• In Service Portal, you can use 
widgets instead of UI Macros. Base 
system widgets generally cover most 
use cases, but for custom solutions, 
you can develop new widgets using 
AngularJS.

• If your implementation includes UI 
Macros in Service Catalog  forms that 
reference other fields or variables in 
the form, you can embed the widget 
inside a Service Catalog  variable. 
Learn more: Replace a Service 
Catalog form script with a widget.

UI actions
All server-side UI actions are 
supported in Service Portal, although 
setRedirectURL()  operations are 
ignored because Service Portal  forms 
handle redirection in a different way 
than the platform.

• Refactor any UI actions to remove 
setRedirectURL()  operations.

• Check that UI actions are not marked 
as client.
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CMS 
component Service Portal  support Possible transition actions

The form widget ignores all UI actions 
marked as Client.

Catalog 
client 
scripts

Only UI Type options Mobile / Service 
Portal  and All  are supported. UI type 
Desktop  is not supported in Service 
Portal. For a list of supported APIs, see 
Service Portal and client scripts.

Note: 
Synchronous JavaScript calls 
are not supported in Service 
Portal  and must be replaced by 
asynchronous calls. For example, 
the getXMLWait()  method 
of the GlideAjax class is not 
supported in Service Portal. 
Instead, use one of the following 
supported asynchronous 
methods:

• getXML(Function 
callback)

• getXMLAnswer(Function 
callback)

For additional information on 
GlideAjax, refer to GlideAjax .

To understand the impact of updating 
your CMS to work in a mobile 
environment, review Mobile client 
GlideForm (g form) scripting and 
migration .

• Update your scripts to remove any 
unsupported client APIs.

• Check that the script UI Type is set to 
Mobile / Service Portal  or All.

UI policies
Scripted UI policies can only use APIs 
supported in Service Portal. For a list of 
supported APIs, see Service Portal and 
client scripts.

Update your scripts to remove any 
unsupported client APIs.

Service 
Catalog 
variables

Service Catalog  variables are 
supported in Service Portal  with the 
following exceptions:

• UI Macros and UI pages variable 
types are not supported.

• Validation Scripts for variables are 
not supported. Supported validation 
types include:

• If embedding a widget in a catalog 
item form, you can use the UI Macro 
variable type. Learn more: Replace 
a Service Catalog form script with a 
widget.

• If using variable with annotations, 
make sure to test your catalog items 
in Service Portal  to ensure that help 
text displays as expected.
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CMS 
component Service Portal  support Possible transition actions

◦ The Mandatory  field on the 
variable form.

◦ Read-only variables.

◦ All fields in the Availability  tab of 
the variable form.

• Default variable size is not supported.

• Expanding and collapsing help text is 
not supported. Rather, the Help text 
and Instructions  fields defined in the 
Annotations tab on the variable form 
are always expanded. The Help tag 
does not display.

• The List Collector variable displays as 
a choice list instead of a slushbucket 
in the Service Portal.

Order 
guides Order Guides in Service Portal  use the 

Order Guide widget.
Large order guides can cause 
performance issues in the Service 
Portal. If you have large order guides, 
you can:

• Break them into multiple order 
guides.

• Simplify variables used in the order 
guides.

• As a temporary solution, you can 
render the Service Catalog  item using 
an iFrame. See Service Catalog forms 
in Service Portal.

Record 
producers Record producers are used in Service 

Portal  with the following differences:

• The sort order for catalog items in 
record producers is not honored.

• Date values do not honor time zone 
when the record producer submits a 
record.

Make sure to test all record producers 
used in Service Portal  to make sure that 
they behave as expected.

Login 
scenarios 
and 
redirects

In CMS, you used the CMSEntryPage 
script include to define login scenarios. 
Instead, Service Portal  uses the 
SPEntryPage script include and related 
system properties to define login 
scenarios. Redirects are not supported 
in Service Portal.

In Service Portal, define login behavior 
by modifying the SPEntryPage script 
include and setting system properties.

For more information, see Single sign-
on, logins, and URL redirects.
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CMS 
component Service Portal  support Possible transition actions

Service 
Catalog 
forms

Service Catalog  forms such as catalog 
items and record producers are 
rendered within widgets in a two-
column layout. Complex forms may not 
display as expected.

• Only the top-level container settings 
are honored. If there are other 
containers within the top-level 
container, they are rendered as a 
single column. If there are container 
splits or nested containers within 
these additional containers, they are 
rendered as a single column. A top-
level container is not a child of any 
other container.

• There can be a maximum of two 
columns in Service Portal. If your 
implementation includes forms with 
more than two columns, the fields 
are reorganized into two-columns in 
Service Portal.

• Variable sets are treated as 
containers. All previously listed rules 
apply to variable sets as well as any 
containers within them.

• Default variable size is not supported 
in Service Portal.

• Simplify any complex forms in your 
Service Catalog.

• As a temporary solution, you can 
render the Service Catalog  item using 
an iFrame. See Service Catalog forms 
in Service Portal.

Shopping 
cart The Service Portal  includes a base 

system Shopping Cart widget.

Use the Shopping Cart widget.

Supported features in Service Portal

Service Portal  is an alternative presentation layer for the platform. As such, not all features of the 
platform are extended to Service Portal. Consider your full application and the abilities of Service 
Portal  before making considerable investments.

Not currently supported

Domain separation at Levels 1-3. However, Service Portal  does include support for domain 
separation at the Data only  level. For more information, see Application support for domain 
separation  and Domain separation and Service Portal.

No plans to support

• @ Mentions

• Click-through/pop-ups

• Embedded HTML outside of HTML fields
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• Embedded lists

• UI macros

• Formatters

• UI actions marked as Client

• Nested container Catalog variables

• Survey wizards

• OpenFrame

Service Catalog  forms in Service Portal

Service Catalog  forms are rendered within Service Portal  widgets in a two-column layout. 
Complex forms may not display as expected.

Recommendations when creating Service Catalog  forms

Use the following recommendations as a guide to building scalable forms that can be used in 
both applications:

• Keep forms simple. Because forms with multiple containers, variable sets, and client scripts do 
not always display as expected in Service Portal, keep forms short to eliminate conversion and 
debugging issues.

• Think in mobile. Any support for Catalog Client Scripts or Catalog UI Policies is the same 
as in mobile. Review the following resource: Mobile client GlideForm (g form) scripting and 
migration .

Form rendering in Service Portal

Containers and variable sets within Service Catalog  forms are translated into a two-column 
layout when implemented in Service Portal. Service Catalog  forms are rendered in Service Portal 
using the following rules:

• Only the top-level container settings are honored. If there are other containers within the top-
level container, they are rendered as a single column. If there are container splits or nested 
containers within these additional containers, they are rendered as a single column. A top-
level container is not a child of any other container.

• There can be a maximum of two columns in Service Portal. If your implementation includes 
forms with more than two columns, the fields are reorganized into two-columns in Service 
Portal.

• Variable sets are treated as containers. All previously listed rules apply to variable sets as well 
as any containers within them.

• Default variable size is not supported in Service Portal.

For other forms in the platform, the view determines how the form displays in Service Portal. For 
base system tables, the form opens in the Service Portal  using the Service Portal  Table form 
views.

Example layout conversions

The following examples demonstrate how Service Catalog  forms display in Service Portal.

Single-column form
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A Service Catalog  form with:

• Two containers.

• A single-column layout.

Service Catalog  form

In Service Portal, the single-column layout renders as expected.

Service Portal result
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Two-column layout with subcontainers

A Service Catalog  form with:

• A container with a two-column layout.

• A subcontainer with a single-column layout.

• A subcontainer with a two-column layout.

Service Catalog  form

In Service Portal, the two-column layout setting of the subcontainer is ignored. The 
subcontainer renders as a single column.

Service Portal result
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Two-column layout with variable sets and subcontainers

A Service Catalog  form with:

• Containers with single-column and two-column layouts.

• Variable sets with a two-column layout within containers.

Service Catalog  form

In Service Portal, the two-column layout settings of the variable sets are ignored 
when inside a container column.
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Service Portal result

Containers within variable sets

A Service Catalog  form with:

• Variable sets with single-column layouts.

• A container with a single-column layout with a container split within a single-
column variable set.

• A container with a two-column layout within a single-column variable set.
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Service Catalog  form

In Service Portal, the container split and two-column container settings are ignored 
when inside a single-column variable set.
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Service Portal result

Nested containers

A Service Catalog  form with:

• Containers that contain variable sets.

• Variable sets that contain nested containers.

Service Catalog  form

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

719



In Service Portal, nested container formatting is ignored and displays as a single-
column.

Service Portal result

Render a complex form in Service Portal  using an iFrame

Because complex forms do not display as expected in Service Portal, you can render catalog 
items, record producers, and order guides in Service Portal  using an iFrame. This workaround is 
a temporary solution to enable your Service Portal  to function as expected while you simplify any 
complex Service Catalog  forms.

When rendering items in an iFrame in Service Portal, the following limitations apply:

• On catalog items and record producers, the attachment icon is not visible. As a result, users 
cannot attach any files during the submission. As a workaround, you can add the attachment 
button to your form.

• Click-through for the hover-over icon is not available.

• Forms are not optimized for a mobile environment.

For more information, see the Service Catalog on Service Portal  post in the ServiceNow 
Community.

Note: 
Be sure to make changes in a test environment before updating your production instance.
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Service Portal and client scripts

You can use client scripts and catalog client scripts in the Service Portal  if the UI Type is set to 
Mobile / Service Portal  or All. Client scripts and catalog client scripts are used with the Form 
widget and SC Catalog Item widget, as opposed to a widget client controller.

Before flagging a script as Mobile/Service Portal  or All, make sure that you are only using 
the mobile APIs. Setting a client script to Mobile  does not ensure that it will work, it simply 
flags that the script should be attempted by the mobile app or the Service Portal. Many of your 
existing client scripts can be set to All  as long as the API calls are supported by the mobile client 
scripting environment.

The topics in this section require advanced coding knowledge and an understanding of Service 
Portal  APIs.

Checking desktop vs mobile runtime

You might want to mark a client script compatible with both desktop and mobile, but include 
behavior that depends on the runtime. You can use this script:

  if (window === null)
    // Write your mobile compatible code here
  else
    // Write your desktop compatible code here

Unsupported client scripting globals

The following globals and APIs are unavailable in client scripts and catalog client scripts used in 
the Service Portal:

• $

• $$

• $j

• angular

• control

• document

• jQuery

• window

Note: 
Widget client controllers are full Angular controllers and are not subject to the unsupported 
client script globals listed here. Use jQuery and Angular as needed.

Embedded widgets & g_form

When using the Service Catalog variable type Macro  and Macro with Label, you can pick a 
widget to embed in a catalog item form. Within the client controller for the embedded widget you 
can access the field object and catalog item g_form instance using:

• $scope.page.field

• $scope.page.g_form()
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Example: Client scripts used with Service Portal

The g_list  global helps you set the filter of a Glide list element or a list collector variable. Use 
this API in place of the g_filter API on desktop client scripts.

function onLoad() {
  var myListCollector = g_list.get("my_list_collector");
  myListCollector.reset();
 
 myListCollector.setQuery("active=true^category=8c7b22230b402200
b0b02c6317673a62");
  myListCollector.addItem('3a700d39af5f4fc0aab978df90f4c692', 
 'Power Supply');
  myListCollector.addItem('1cb93419a3a248318da8f814140b42f6', 
 'Backpack');
}

g_service_catalog  is only available in Service Portal  service catalog item scripts. Use this 
API to know if your catalog item script is run as part of an order guide or on its own.

function onLoad() {
  if (window) // if CMS, don't run this
   return;
 
   // g_service_catalog api for Service Portal and Mobile
   var isOrderGuide = g_service_catalog.isOrderGuide();
   g_form.setValue("is_order_guide", isOrderGuide ? "Yes!" : 
 "Nope :(");
}

Supported client script types and APIs

Some client scripts are not supported in Service Portal. Others must have a UI type set to All 
or Mobile / Service Portal. If using a client script in the Service Portal, only client-side APIs 
supported in a mobile environment can be used.

Client script support in Service Portal

Client 
script

Description

Catalog 
client 
scripts

Service Portal  requires that the UI Type  field be set to All  or Mobile / Service 
Portal. Client Scripts marked as Desktop  rely on legacy APIs that are not 
supported in Service Portal. Before flagging a script as Mobile / Service Portal or 
All, make sure you are only using supported client-side APIs.

Validation 
scripts Service Portal  requires that the UI Type  field be set to All  or Mobile / Service 

Portal. Client Scripts marked as Desktop  rely on legacy APIs that are not 
supported in Service Portal. Before flagging a script as Mobile / Service Portal or 
All, make sure you are only using supported client-side APIs.

Validate user input in a specific field type using a validation script. In new 
instances, Service Portal  includes XML, Script, Script (Plain), Email, and Version 
validation scripts by default. If upgrading from a previous release, the Mobile and 
Service Portal  version is not active by default. You must activate the Mobile and 
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Client 
script

Description

Service Portal  version of the validation script to validate user input in the Service 
Portal.  See Activate Service Portal validation scripts.

Note: 
To call a UI script within a Validation script, use the g_ui_scripts global object. 
For more information, see GlideUIScripts . Verify that the UI script has the 
Global  field set to false and UI Type  set to Mobile / Service Portal  or All.

UI scripts
Service Portal  requires that the UI Type  field be set to All  or Mobile / Service 
Portal. Client Scripts marked as Desktop  rely on legacy APIs that are not 
supported in Service Portal. Before flagging a script as Mobile / Service Portal or 
All, make sure you are only using supported client-side APIs.

UI Actions
All server-side UI actions are supported in Service Portal, although 
setRedirectURL() operations are ignored because Service Portal  forms handle 
redirection in a different way than the platform.

The form widget ignores any UI Actions marked as Client.

UI Policies Supported, although you should use only declarative UI Policies. Avoid scripting 
unless the outcome cannot be achieved through the condition builder.

UI Macros Not supported as UI macros use Jelly.

Formatters Not supported as formatters use Jelly.

Supported client-side APIs

Supported client scripting APIs for use in onLoad, onChange, and onSubmit client scripts.

For detailed class and method information, see the Client API reference .

Class Available methods

g_form

• addDecoration(fieldName, icon, title)

• addErrorMessage(message)

• addInfoMessage(message)

• addOption(fieldName, value, label, index)

• clearOptions(fieldName)

• getActionName()

• getBooleanValue(fieldName)

• getDecimalValue(fieldName)

• getEncodedRecord()

• getFieldNames()

• getIntValue(fieldName)

• getLabel(fieldName)

• getReference(fieldName, callback)
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Class Available methods

• getRelatedListNames()

• getSectionNames()

• getSysId()

• getTableName()

• getValue(fieldName)

• hasField(fieldName)

• hideAllFieldMsgs(type: "info | error")

• hideErrorBox(fieldName)

• hideFieldMsg(fieldName, clearAll)

• hideRelatedList(listTableName)

• hideRelatedLists()

• isMandatory(fieldName)

• isNewRecord()

• isReadOnly(fieldName)

• isVisible(fieldName)

• removeDecoration(fieldName, icon, title)

• removeOption(fieldName, value)

• save()

• serialize(onlyDirtyFields)

• setFieldPlaceholder(fieldName, placeholder)

• setLabel(fieldName, label)

• setMandatory(fieldName, isMandatory)

• setReadOnly(fieldName, isReadOnly)

• setSectionDisplay(sectionName, isVisible)

• setValue(fieldName, value, displayValue)

• setVisible(fieldName, isVisible)

• showErrorBox(fieldName, message, scrollForm)

• showFieldMsg(fieldName, message, type: "info | error", scrollForm)

• showRelatedList(relatedTableName)

• showRelatedLists()

• submit(submitActionName)

Note: 
Using the variables.var_name  notation with the g_form 
API is not supported in Service Portal. g_form as a global object 
cannot be used in a widget client controller or in a UI script.

g_list

• get(fieldName)

• addItem(value, displayValue)
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Class Available methods

• removeItem(value)

• reset()

• setQuery(queryString)

• setDefaultOperator(operator)

• getDefaultOperator()

g_service_catalog
isOrderGuide()

GlideAjax

• addParam (name, value)

• getParam (name)

• getXML(callback)

• getXMLAnswer(callback)

• getJSON(callback)

• setErrorCallback(errorCallback)

• getURL()

• getParams()

• execute()

• successCalback(data, status, xhr)

• errorCallback(xhr)

• setScope(scope)

Note: 

• Because the mobile platform does not allow synchronous 
GlideAjax calls, the getXMLWait() method in a GlideAjax call 
does not work in the Service Portal. Instead, use one of the 
asynchronous calls such as getXML(Function callback) or 
getXMLAnswer(Function callback).

• GlideAjax cannot be used in a widget client controller.

GlideRecord

• addQuery(encodedQuery)

• addQuery(fieldName, operator, value)

• getEncodedQuery()

• get(id)

• getTableName()

• hasNext()

• insert(callback)

• gotoTop()

• next()

• loadRow(rowObj)

• getValue(fieldName)
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Class Available methods

• setValue(fieldName, value)

• isDotWalkField(fieldName)

• addOrderBy(fieldName)

• setDisplayFields(fieldNames)

• query(callback)

• setRows(rowsArray)

• setTableName(tableName)

• setLimit(maxInt)

• getLimit()

i18NV3
getMessage(String messageKey, Function callback)

Antivirus Scanning  in Service Portal

View the health status of file attachments in Service Portal. Antivirus Scanning  scans files in 
the Attachments [sys_attachments] table by default. When viewed from a Service Portal  page, 
attachments may not be available for download depending on their health status.

Note: 
Antivirus Scanning  is a ServiceNow AI Platform  feature. For more information, see Antivirus 
Scanning .

Scanning scenarios

Review these scanning scenarios to understand how Antivirus Scanning  interacts with 
attachments in Service Portal.

Upload a file

1. A user uploads an infected file to a record in Service Portal.

2. The system scans the file, moves it to quarantine, and displays a message. The 
file is unavailable for download.
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If viewing the record in the Ticket Form page, the thumbnail does not display.

3. The system sends an email notification to the user and the antivirus administrator.

Download a file
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1. A user opens a record with an attachment in Service Portal.

2. The system scans the file and moves it to quarantine. The file is unavailable for 
download. If viewing the record in the Ticket Form page, the thumbnail does not 
display.

3. The system sends an email notification to the user and the antivirus administrator.

View a file

1. A user opens a record with an infected attachment.

2. The file is unavailable for download. If viewing the record in the Ticket Form page, 
the thumbnail does not display.

Configuring Service Portal

Plan and set up a self-service portal for your employees or customers.

Configuration overview

The following list is a high-level overview of the workflow to get started configuring a portal. 
However, there may be use cases where performing these steps in a different order is preferred.

1. Upgrade Service Portal

If you upgraded from a previous release, you might need to perform additional tasks to take 
advantage of new or updated functionality in Service Portal.

2. Create a new portal or update a base system portal

A portal is the engine that houses all the references to content for your site. The portal record 
defines the URL extension for a site, as well as things like the knowledge base, catalog, and 
homepage. You can also use the portal record to define the header menu and the portal 
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branding. You can create a new portal or update an existing base system portal to suit your 
needs.

3. Configure portal branding

With the Branding Editor, you can configure the styles and theme of your portal in a view with 
real-time updates. You can see how your portal appears to users with the click of a button. 
More advanced users still have the option of creating CSS style sheets for the portal theme. 
However, they won't take advantage of the real-time update that the Branding Editor provides. 
Changes made in the Branding Editor or to specific components of the portal (such as a 
widget or a page container) override any customizations made to the theme. If you need more 
customization than what the Branding Editor can provide, see Create a portal theme.

4. Create new pages or update base system pages  and configure widgets

Pages are the centerpiece of the end-user experience. Page definitions not only control the 
layout of the content, they craft the experience for the user. Pages also help define mobile 
responsiveness, which is a key component in the user experience. Use any existing base 
system pages as an example for your own creation or create new pages from scratch.

Widgets are what define the content of your pages. You can use the base system widgets 
provided with Service Portal  to get started configuring pages.

5. Configure search in a portal

Search data displays within a widget on the search page. To make data searchable from a 
portal, create a search source that fetches data from a single table within your instance, from 
multiple tables, or from an external site. Enable AI Search  to take advantage of intelligent query 
features and quickly find the answers they need.

6. Manage access to a portal

Manage who can access your portal by making pages public, configuring user logins and 
single sign-on, limiting page access by role, or enabling multi-factor authentication. You can 
also use advanced user criteria for access to pages, widgets, and more.

Example: Common portal configurations

Refer to this video for examples of common configurations for portals.  Learn about configuring 
redirection, landing page branding, and language selection in portals.

Upgrading Service Portal

After upgrading a ServiceNow  instance from a previous release, you might need to perform 
additional tasks to take advantage of new or updated functionality in Service Portal.

Refer to the topics in this section for information about changes to implement to use the latest 
functionality in Service Portal.

Activate the Knowledge Article View page on upgrade

If upgrading from a previous release, take advantage of the latest article view features by 
activating the Knowledge Article View  page route map. New capabilities include article 
versioning and using links and images in article feedback. This map is active by default in new 
instances and applies to all portals in the system.

Before you begin
Role required: admin
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About this task
The Knowledge Article View  page route map routes the kb_article  page to the kb_article_view 
page. By default, users with the public role cannot access the kb_article_view  page. However, 
your administrator can modify this behavior. For more information, see Enable external or public 
users to view knowledge articles from the Knowledge Management Service Portal .

After activating the Knowledge Article View  page route map, you can:

• Comment on a knowledge article

• Create an article version by importing a Word document

• Create a version of a knowledge article from a managed document

Procedure

1. Navigate to All  > Service Portal  > Page Route Maps.

2. Open the Knowledge Article View  record.

3. Select Active.

4. Click Update.

Result
Your end users view knowledge articles in the Service Portal  using the kb_article_view  page.

Activate Service Portal  validation scripts

Validate user input in a specific field type using a validation script. In new instances, Service 
Portal  includes XML, Script, Script (Plain), Email, and Version validation scripts by default. If 
upgrading from a previous release, the Mobile and Service Portal  version is not active by default. 
You must activate the Mobile and Service Portal  version of the validation script to validate user 
input in the Service Portal.

Before you begin
Role required: admin

About this task
Service Portal  requires that the UI Type  field be set to All  or Mobile / Service Portal. Client 
Scripts marked as Desktop  rely on legacy APIs that are not supported in Service Portal. Before 
flagging a script as Mobile / Service Portal or All, make sure you are only using supported client-
side APIs.  See Supported client script types and APIs.

Note: 
To change the UI Type from Mobile / Service Portal  to All, delete the Desktop version from 
your instance to avoid activating conflicting scripts. Before deleting the Desktop version, 
make a backup in case you need to revert any changes.

Procedure

1. Navigate to All  > System Definition  > Validation Scripts.

2. Open the Mobile / Service Portal  version of the validation script you would like to use in the 
Service Portal.

3. Click the Active  flag to activate the validation script.

4. Optional:  Set the UI Type to All  to use the validation script in desktop, mobile, and Service 
Portal  environments.
To avoid activating conflicting validation scripts, you must first delete the Desktop version of 
the script.
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a. Navigate to the desktop version of the validation script you would like to replace.
Desktop versions have the UI Type  field set to Desktop.

b. Open the record.

c. Right-click the header menu and select Export  > XML (This Record)  to create a backup of 
the record.

d. Once the export completes, click Delete  and confirm the selection.

e. Navigate back to the validation script set to Active  in earlier steps and change the UI Type  to 
All.

Result
User input into the designated field type in the Service Portal  and Mobile environments is 
validated for correct formatting. For example, if you activated the Email validation script for use 
in the Service Portal, invalid user input into an Email field generates an error and prevents the 
browser from submitting the form.

Note: 
On a desktop browser, the field is validated when you submit the record. On a mobile 
browser, the field is validated when you navigate away from the field.

Create a portal

Create a portal for users to browse company resources, discover articles, and get help.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Portals, then click New.

2. On the form, fill in the fields.

Property Description

Title Name to define your portal. In the browser header and for bookmarks, the title 
appears as <Page Title> - <Portal Title>.

URL suffix Value that appears appended to an instance URL when you access a 
portal. For example, if you use sp, the instance URL for that portal would be 
<instance name>.service-now.com/sp. Ensure that this value is 
unique and is not the same as any other portal.

Note: 
Avoid using reserved words in your URL to prevent errors when 
navigating to your portal page. Avoid words such as portal  and cms. 
Also avoid any JavaScript protected terms.

Homepage Page that users see first after they sign in.

KB home 
page

Custom home page that users see when they go to a knowledge base.
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Property Description

Login page Custom page to authenticate users.

Logo
Logo that appears in the page header. You can also configure the logo in the 
Branding Editor.

Icon Icon that appears in the address bar for your portal. Each portal that you 
create can have a different icon.

Default Portal to use as your main portal.

Application Application scope of the portal. This field is uneditable and Global  by default.

404 page Default page that your users see whenever a page cannot load 
properly. You can also define a default 404 page using the 
glide.service_portal.default_404_page  system property.

Catalog 
home page Custom page to represent the Service Catalog.

Catalog 
category 
home page

Page to display catalog categories in the portal.

Main menu Reference to the menu in the Instances with Menu [sp_instance_menu] table 
that appears in the header.

Theme
Refers to a theme in the Themes [sp_theme] table that defines the style and 
branding for the portal. The theme is the lowest level of style configuration. 
Any changes made in the Branding Editor  or to specific portal components 
(such as widget or container CSS) override those styles.

Inactive Turn off access to a portal that you no longer want users to visit and optionally 
redirect them to another portal. For more information, see Deactivate a portal.

Quick start 
config Schema that defines configuration items in the Branding Editor. In JSON 

format, you can define the fields and records used to generate your branding 
options.

[{
 "tagline": {
  "table" : "sp_instance",
  "sys_id" : "34fe3d96cb20020000f8d856634c9cf4",
  "field" : "title"
 },
 "hero_background": {
  "table" : "sp_container",
  "sys_id" : "be98a8d2cb20020000f8d856634c9c63",
  "field" : "background_image"
 }
}]

CSS 
variables

Portal-specific Sass variables. You can overwrite existing theme variables 
here.
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Property Description

Note: 
Use the CSS variables field to define CSS variables only. Use CSS 
Includes to define CSS rules. As of the Madrid release, Sass and LESS 
can be used within CSS Includes.

Hide portal 
name

Option to hide the portal name in the page title.

Support 
right-to-left 
languages

Option to mirror the direction of the portal when the session language is a 
right-to-left language, such as Hebrew. Selecting this option automatically 
generates the necessary CSS but you can also provide your own CSS for 
right-to-left languages that overrides the auto-generated CSS.

To provide your own CSS for right-to-left languages, see Create a portal 
theme. For more information about support for right-to-left languages, see 
Styling for right-to-left languages in portals.

Enable 
favorites

Option to enable the My favorites functionality in the portal.

◦ Displays the favorite icon ( ) for all catalog items and KB articles in the 
portal.

◦ Displays the My Favorites  menu item in the portal header. This menu item 
displays a list of all catalog items or KB articles that are bookmarked for 
quick reference.

Note: 

▪ Only searchable catalog items or KB articles that are selected as 
favorites are displayed in this list.

▪ This is applicable only for Service Portal. For other portals, you can 
clone the My Favorites  menu item.

You may need to configure the form to add this check box.

AI Search

Enable AIS
Option to enable AI Search  in your portal. For more information, see AI Search 
in Service Portal.

Search 
Application

Defines the search experience settings for your portal, such as the search 
engine, search results limit, and suggestions limit. For more information on 
defining a search application configuration, see Defining search application 
configurations .

Search 
Results 
Configuration

Defines how search results are displayed in the portal. For more information 
on defining a search results configuration, see Define a composite dataset .

3. Save the form.

4. In the Knowledge Bases related list, select Edit  and then select which knowledge bases 
appear for the knowledge base page.
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For example, if you select IT  and Instance Security Center, only the article categories defined 
for these knowledge bases appear in the KB categories widget.

5. In the Catalogs  related list, click Edit  to select one or more catalogs listed in the sc_catalog 
table to use in the portal.

Assign a homepage to a portal

Edit your portal record to specify any page as your homepage.

Before you begin
Role required: sp_admin or admin

About this task
When a portal is referenced by the URL suffix, it lands on a homepage. This homepage is often 
labeled index  in website language. The homepage is probably the most important page of your 
portal as it houses the major information and actions that your users see.

You can use any portal page as the portal homepage. Navigate to All  > Service Portal  > Pages  to 
see the Pages [sp_page] table. To view or create pages in the Service Portal Designer, see Create 
and edit a page using the Service Portal Designer.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select the portal.

3. In the Homepage  field, select the page you want for your portal homepage and select Update.

Assign a default error page

Create a default 404 error page for your portal using a system property.

You can assign an error page to a portal using the portal form. If you do not assign an error page 
using that form, the system uses the default 404 page containing the breakout game widget. 
Use the default 404 page property [glide.service_portal.default_404_page] to 
configure the default error page.

Create a page  before adding it as the default error page.

1. Navigate to Service Portal  > Properties.

2. In the Default 404 page for Service Portals, type the page ID found in the ID field of the page 
form.

Configure a portal header menu

Define the look and behavior of the portal header menu and assign menu items to appear in the 
header. The header menu is one of the primary navigation controls for Service Portal  users.

Before you begin
Role required: admin

About this task
Configuring a portal header with a menu involves several steps.

Procedure

1. Create a header and add it to a theme.
Until you add a theme with a header to a portal, the header menu does not display.
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2. Create a main menu with menu items and assign it to the portal.
The main menu record is where you assign which navigation options appear in the header. For 
example, you can add a menu item that links to another page within your portal, such as the 
service catalog.

Result
The main menu and header form a header menu when associated with a theme and a portal.

Add a header or footer to a portal

Use the theme to add a header or footer to your portal.

Before you begin
Role required: (admin or none)

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Portal Tables  > Themes  and then select the theme you want to add the header or footer 
to.

3. In the header or footer field, select the header or footer you want to use for your portal.
If you are just getting started, you can reuse the base system Stock Header or Sample Footer 
widgets.

4. Optional:  Select Fixed Header  or Fixed Footer  to lock the header or footer in one place so 
when users scroll up or down they remain in the same location on the page.

5. To configure the appearance of the header, in the Service Portal configuration page, open the 
Branding Editor.

6. Under the Theme Colors  tab, use the color selectors in the Navbar section to control the colors 
in the header.

Create a portal header menu

Create a menu with menu items to display in the header of a portal.

Before you begin
Role required: (admin or none)

Procedure

1. From the Service Portal configuration page (Service Portal  > Service Portal Configuration), 
navigate to Portal Tables  > Instance with Menu  and select New.

2. Complete the fields in the menu form.
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Menu fields

Field Description

Title Name of the header menu. You need to know this when you associate the 
menu with your portal.

Additional 
options, 
JSON format

Advanced configuration options. For example, use this field to enable the 
shopping cart in the header menu with the following code:

{
 "enable_cart": {
  "displayValue": "true",
  "value": true
 }
}

Application The record scope. The header menu record and the source table must have 
the same application scope.

Widget The widget that the header menu is based on. Select a menu-type widget 
from the list. For example, the header menu widget that is included as a base 
system widget.

3. Save the form, and then select Menu Items  from the related lists.

4. Select New  and complete the menu item form.

Menu item fields

Field Description

Label Name that appears for the item in the menu

Parent 
menu

This field should already contain the name of the menu you are adding items to. 
You can change the value as needed to other menus

Parent 
menu 
item

Use this field to nest menu items within other menu items

Order Value that determines where the item appears in the menu in relation to other 
menu items

Type The kind of page the item links to. Form fields vary depending on the option that 
you select from this list. Choose from:

◦ Page: Link to another page in the Service Portal.

◦ URL: Link to an external website. To have the URL open on a new browser tab or 
window, enter _blank  in the URL target  field.

◦ Service Catalog: Link to the Service Catalog.

◦ Catalog Category: Link to a specific catalog category within the Service Catalog.

◦ Catalog Item: Link to a specific catalog item.

◦ Knowledge Base: Link to the knowledge base that you previously configured as 
the portal's default knowledge base.

◦ KB Topic: Link to a KB topic page.

◦ KB Article: Link to a KB article by number.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

736



Field Description

◦ KB Category: Link to a specific KB category within the knowledge base.

◦ Filtered List: Set conditions to determine which page to link to.

◦ Scripted List: Enter a script to determine which page to link to.

Page Name of the portal page the item links to. This option is available if you select 
Page  as the menu item type.

Condition Determines what conditions are required for menu items to show in the header. 
For example, the condition gs.hasRole("sp_admin")  restricts access to 
menu items to users with the sp_admin role. Hide a menu item by setting this 
value to false. For more information on what conditions to use in the Condition 
field, see Create a UI Action  .

Glyph Icon that appears beside the menu item

5. Select Submit.

6. After you create a menu and menu items, add the menu to a portal.

a. Navigate to Service Portal  > Portals, then open the portal you want to add a menu to.

b. From the Main menu  field, select the reference lookup icon, then select the appropriate 
menu by name.

c. Select Save.

What to do next
Associate the menu you created with a portal, then create a header with a theme for your menu.

Enable a language selector in portal headers

Allow all users to select their language preferences by enabling the language selector in your 
portal header.

Before you begin
Active the languages your portal users need and configure a portal header menu. For more 
information, see Activate a language  and Configure a portal header menu.

Role required: admin

About this task
For all portals except the Knowledge (/kb), Customer Support (/csm), and Customer Service (/
csp) portals, the language selector is included but turned off by default. To display the language 
selector in the portal header for other portals, you must enable it according to this procedure.

In portal headers, the language selector displays the current language selection of the user and 
a menu of languages that the user can choose from. If region grouping is enabled, languages 
are displayed according to the configured region groups. For more information about grouping 
languages, see Create regions for language selection in portals .

Procedure

1. Navigate to All, and then enter sys_properties.list  in the navigation filter.

2. Open the glide.sp.portals.language_selector_enabled  property.

3. In the Value  field, enter the sys_ID of the portal to display the language selector widget.

4. Select Update.
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Result
The language selector displays in the header menu for both authenticated and unauthenticated 
users.

Configure a catalog in Service Portal

Associate a portal with multiple catalogs. By default, Service Portal is associated with Service 
Catalog.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Click the Service Portal  record.

3. To associate a portal with a catalog, perform the following steps.

a. In the Catalogs  related list, click Edit.

b. Select one or more catalogs to add to the portal.
The categories and catalog items associated with the selected catalogs are displayed in 
Service Portal.

Note: 

▪ If no catalogs are selected, all active catalogs accessible to the requester are 
available in Service Portal.

▪ Irrespective of the catalogs associated with the portal, items are searched for only 
in the catalogs configured in the search source in AI Search. For information on 
configuring AI-based catalog search experience, see Configure AI-based catalog 
search experience .

4. Optional:  To edit the label for a catalog, perform the following steps.

a. For the Main menu  field, click Open Record.

b. From the Menu Items  section, Click the Catalog  record.

c. In the Label  field, specify the label for the catalog.
The catalog label is displayed in the main menu of Service Portal.

5. Click Update.

Related topics

Service Catalog in Service Portal

Access Management Automation

Automate access management request fulfillment using the Service Catalog  or Service Portal. 
The catalog items and flows support requests in Okta, Microsoft Entra ID (formerly Microsoft 
Entra ID), and Microsoft Active Directory.
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Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store version history release notes .

Application version

Access Management Automation  v2.1.0 is the latest version.

Catalog Items and flows

The Access Management Automation  application provides catalog items and flows to automate 
tasks. When a catalog item is submitted, the related flow is triggered and the task is performed. 
Available catalog items include:

Service Catalog Item Description

Create Active Directory Group Creates a group in Microsoft 
Active Directory with the 
provided details.

Create Active Directory User Creates a user in Microsoft 
Active Directory.

Remove Active Directory User 
from Groups

Removes the specified 
user from the groups in the 
Microsoft Active Directory.

Enable Active Directory User Enables the specified user in 
the Microsoft Active Directory.

Disable Active Directory User Disables the specified user in 
the Microsoft Active Directory.

Add Active Directory User to 
Groups

Adds the specified user to 
groups in the Microsoft Active 
Directory.

Microsoft Active Directory

Unlock Active Directory User Unlocks the specified user in 
the Microsoft Active Directory.

Delete Microsoft Entra ID User Deletes the specified user 
from Microsoft Entra ID.

Add Microsoft Entra ID User to 
Groups

Adds the specified user to 
groups in the Microsoft Entra 
ID.

Create Microsoft Entra ID 
Security Group

Creates a security group in 
Microsoft Entra ID.

Remove Owner From 
Microsoft Entra ID Group

Removes an owner from the 
specified Microsoft Entra ID 
group.

Create Microsoft Entra ID 
O365 Group

Creates an Office 365 group in 
the Microsoft Entra ID.

Microsoft Entra ID (formerly 
Microsoft Entra ID)

Disable Microsoft Entra ID 
User

Disables the specified user in 
the Microsoft Entra ID.
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Service Catalog Item Description

Enable Microsoft Entra ID User Enables the specified user in 
the Microsoft Entra ID.

Remove Microsoft Entra ID 
User from Groups

Removes the specified user 
from groups in the Microsoft 
Entra ID.

Add Owner to Microsoft Entra 
ID Group

Adds an owner to the 
Microsoft Entra ID group.

Create Microsoft Entra ID User Creates a user in Microsoft 
Entra ID.

Reset Okta User Factors Resets factors of the specified 
Okta user.

Add Okta User to Okta Groups Adds the specified user to 
groups at Okta.

Unlock Okta User Unlocks the specified user at 
Okta.

Unsuspend Okta User Unsuspends the specified 
user at Okta.

Create Group at Okta Creates a group in Okta.

Create User at Okta Creates a user at Okta.

Suspend Okta User Cancels the specified user at 
Okta.

Remove Okta User from Okta 
Groups

Removes the specified user 
from groups in Okta.

Okta

Activate Okta User Activates the specified user at 
Okta.

Subflows

The Access Management Automation  application provides subflows to automate tasks. The 
available subflows include:

Subflow Description

Create Incident Creates an incident if automation fails.

Create Event Creates an event if automation fails.

Dynamic Flow Template Template to use the Create Event and Create 
Incident subflows.

Fetch Approvers and Assignee Retrieves the details of approvers, assignees, 
and assignment groups for the requested 
item, catalog task, and incident from the 
decision tables.
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Actions

The Access Management Automation  application provides actions to automate tasks. The 
available subflows include:

Action Description

Convert Mask to password2 Converts a mask field to a password2 field.

Convert String to Array.Strings Converts a string of comma-separated values 
to an array of strings.

Decision tables

The Access Management Automation  application uses decision tables to save the approver and 
assignee information. The decision tables include:

Decision table Description

Access Mgmt. Catalog Task Group Assignment 
Policy

Used to choose the groups to assign the 
fulfillment catalog task to, if the automation 
fails.

Access Mgmt. Catalog Task User Assignment 
Policy

Used to choose the users to assign the 
fulfillment catalog task to, if automation fails.

Access Mgmt. Failed Automation Flow Policy Used to choose the subflow that should 
execute if automation fails.

Access Mgmt. Incident Group Assignment 
Policy

If the subflow that executes when automation 
fails is Create Incident, this decision table 
is used to choose the groups to assign the 
incident to.

Access Mgmt. Incident User Assignment 
Policy

If the subflow that executes when automation 
fails is Create Incident, this decision table 
is used to choose the users to assign the 
incident to.

Access Mgmt. Requested Item Group 
Approval Policy

Used to choose the groups assigned as 
approver for the catalog requests.

Access Mgmt. Requested Item User Approval 
Policy

Used to choose the users assigned as 
approver for the catalog requests.

User roles

The Access Management Automation  application provides the 
sn_acc_mgmt_sc.access_mgmt_user role. Users with this role can view access management 
automation catalog items.

Note: 
User must have the sn_acc_mgmt_sc.access_mgmt_user, ITIL, and Catalog Admin roles to 
create and submit catalog items.

Set up Access Management Automation

Set up the Access Management Automation  application by configuring the Service Portal  page to 
use the default catalog items.
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Before you begin

• This application requires an Integration Hub or Automation Engine subscription. For more 
information, see Legal schedules - Integration Hub overview .

• Activate and configure one of the required spokes.

◦ Okta  spoke

◦ Microsoft Entra ID spoke (formerly Microsoft Entra ID  spoke)

◦ Microsoft Active Directory  spoke

Note: 
Configure only the required spokes. For example, if you want to manage access in Okta, 
configure the Okta  spoke.

• Activate the Access Management Automation  app

• Role required: admin

Procedure

1. Configure the decision tables to perform these tasks:

◦ Assign users, groups, or both to approve requested items.

◦ Assign users, groups, or both to take action on catalog tasks and incidents.

◦ Trigger subflow(s) if the automation fails.
The flows in this application use decision tables to enable admins to configure approvers, 
assignments, and subflow routing without modifying any of the flows in Workflow Studio. In 
each decision table by default, you can modify the decision record to select an option (group, 
user, or subflow) that applies to all catalog items in the application. If you want to have different 
assignments, approvers, or subflows per catalog item, you can add new decisions for each 
catalog item within the decision tables.

a. Navigate to System Definition  > Decision Tables.

b. Open the required Access Management Automation  decision table record.
These steps should be repeated for each decision table.

c. Click the Decisions  tab.

d. Click the decision record.
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e. Select the required group, user, or subflow in Answer, depending on what the decision table 
is used for.

Note: 
Configure these seven decision tables and assign Answer  as per your requirements.

▪ Access Mgmt. Catalog Task Group Assignment Policy

▪ Access Mgmt. Catalog Task User Assignment Policy

▪ Access Mgmt. Failed Automation Flow Policy

▪ Access Mgmt. Incident Group Assignment Policy

▪ Access Mgmt. Incident User Assignment Policy

▪ Access Mgmt. Requested Item Group Approval Policy

▪ Access Mgmt. Requested Item User Approval Policy

If select the Create Incident subflow in the Access Mgmt. Failed Automation Flow Policy 
decision table, you should configure the incident assignment decision tables. If you 
choose the Create Event subflow, ignore the incident assignment decision tables.

2. Configure the Service Portal  page.

Note: 
Ensure that you select Default [Global]  and Global  for current update set and 
application.

a. Navigate to Service Portal  > Portals.

b. Open the Service Portal  record.

c. Click the Catalogs  tab.

d. Click Edit.

e. Add Access Management  to the Service Portal  list.
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f. Click Save.

What to do next

• To view the catalog items, navigate to Service Catalog  > Catalog Definitions  > Maintain 
Catalogs  and click Access Management.

• To request a catalog item:

Note: 
User must have the sn_acc_mgmt_sc.access_mgmt_user, ITIL, and Catalog Admin roles 
to create and submit catalog items.

1. Navigate to the Service Portal.

2. Click the Catalog  tab.

3. Click Browse by Categories.
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4. Select Access Management.

5. Select the required service from the displayed categories.

6. Select the required action and submit the catalog item. When the request is approved, the 
associated flow is triggered and the required user can provide the approval. Activities are 
logged in the catalog item.

• If you are using the application to manage access in Okta, ensure that the user has the Okta 
admin role to retrieve data in the Okta groups module. Also, the user must have the Okta  admin 
role to submit request using the catalog item.

• For information about customizing the widget and macro, see the KB article, Access 
Management Automation - Widget & Macro Customisations .

Cloud Deployment Automation

Automates the deployment and provisioning of the AWS CloudFormation services using Service 
Catalog  or Service Portal.

Request apps on Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Spoke dependencies

You must activate and set up the AWS CloudFormation spoke  to use this application.

Catalog items and flows

The Cloud Deployment Automation  provides catalog items and flows to automate tasks. When 
a catalog item is submitted, the associated flow is triggered and the task is performed. To 
customize a flow, create a copy of it in a new application scope. Available catalog items and flows 
include:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

745

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0993763
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0993763
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0993763
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0993763
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://www.servicenow.com/docs/access?context=aws-cloudformation&version=zurich&pubname=zurich-integrate-applications&ft:locale=en-US
https://www.servicenow.com/docs/access?context=aws-cloudformation&version=zurich&pubname=zurich-integrate-applications&ft:locale=en-US
https://www.servicenow.com/docs/access?context=aws-cloudformation&version=zurich&pubname=zurich-integrate-applications&ft:locale=en-US


Catalog Item or Flow Description

Create Stack Creates a stack in AWS CloudFormation account.

Create and Execute Change 
Set

Creates and executes a change set in AWS CloudFormation 
account.

Create Stack Set Creates a stack set in AWS CloudFormation account.

Delete Stack Deletes a stack in AWS CloudFormation account.

Delete Stack Set Deletes a stack set in AWS CloudFormation account.

Update Stack Set Updates a stack set in AWS CloudFormation account.

Subflows

The Cloud Deployment Automation  provides subflows to demonstrate automating tasks. To 
customize a subflow, create a copy of it in a new application scope. Available subflows include:

Subflow Description

Create Event Creates an event if automation fails.

Create Incident Creates an incident if automation fails.

Dynamic Flow 
Template

Subflow template to create event and incident.

Fetch Approvers 
and Assignees

Retrieves details of approvers (groups and users), assignee, and 
assignment group for the requested item, catalog task, and incident from 
the decision tables.

Get Stack Set 
Operation Result 
Status Reason

Retrieves the AWS CloudFormation stack set operation result status 
reason.

Get Stack Set 
Operation Status

Retrieves the operation status of the AWS CloudFormation stack set.

Get Stack Status Retrieves the status of the AWS CloudFormation stack.

Actions

The Cloud Deployment Automation  provides an action, Change Array.Object Internal Names to 
change an array of objects to another array of objects based upon the key value pair.

Decision tables

The Cloud Deployment Automation  application uses decision tables to save the required 
information. The decision tables include:

Decision table Description

CDA Requested Item User 
Approval Policy

Policy used to assign a requested item to the relevant user for 
approval.

CDA Requested Item Group 
Approval Policy

Policy used to assign a requested item to the relevant group for 
approval.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

746



Decision table Description

CDA Incident User 
Assignment Policy

Policy used to assign an incident to the relevant user.

CDA Incident Group 
Assignment Policy

Policy used to assign an incident to the relevant group.

CDA Failed Automation Flow 
Policy

Policy used to choose between creating an incident or an event 
when an automation failure occurs.

CDA Catalog Task User 
Assignment Policy

Policy used to assign a catalog task to the relevant user.

CDA Catalog Task Group 
Assignment Policy

Policy used to assign a catalog task to the relevant group.

User roles

The Cloud Deployment Automation application provides the 
sn_cloud_dpmt_atmn.cloud_deployment_automation_user role. Users with this role can view 
cloud deployment automation catalog items.

Note: 
User must have the sn_cloud_dpmt_atmn.cloud_deployment_automation_user 
_mgmt_user, ITIL, and Catalog Admin roles to create and submit catalog items.

System properties

The Cloud Deployment Automation application provides system properties that you can 
configure as per your requirement.

System property Description

sn_cloud_dpmt_atmn.exclude_aws_regions List of additional regions that should be 
excluded from those mentioned in the 
CloudDeploymentAutomationUtils script 
include.

sn_cloud_dpmt_atmn.include_aws_regions List of additional regions that should 
be included to those mentioned in 
CloudDeploymentAutomationUtils script 
include.

sn_cloud_dpmt_atmn.flow_loop_limit Number of hours that flows should run in loop 
before they exit.

Navigate to System Properties  > All Properties  to configure the values of these properties.

Set up Cloud Deployment Automation

Set up the Cloud Deployment Automation  application by configuring the Service Portal  page to 
use the default catalog items.

Before you begin

• Request Integration Hub  subscription. For more information, see Legal schedules - 
IntegrationHub overview .

• Activate and configure the AWS CloudFormation spoke .
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• Activate the Cloud Deployment Automation  app

• Role required: admin

Procedure

1. Configure the decision tables to perform the required tasks.
The flows in this application use decision tables to enable admins to configure approvers, 
assignments, and subflow routing without modifying any of the flows in Workflow Studio. In 
each decision table by default, you can modify the decision record to select an option (group, 
user, or subflow) that applies to all catalog items in the application. If you want to have different 
assignments, approvers, or subflows per catalog item, you can add new decisions for each 
catalog item within the decision tables.

a. Navigate to System Definition  > Decision Tables.

b. Open the required Cloud Deployment Automation  decision table record.
These steps should be repeated for each decision table.

c. Click the Decisions  tab.

d. Click the decision record.

e. Select the required group, user, or subflow in Answer, depending on what the decision table 
is used for.
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Note: 
Configure these seven decision tables and assign Answer  as per your requirements.

▪ CDA Catalog Task Group Assignment Policy

▪ CDA Catalog Task User Assignment Policy

▪ CDA Failed Automation Flow Policy

▪ CDA Incident Group Assignment Policy

▪ CDA Incident User Assignment Policy

▪ CDA Requested Item Group Approval Policy

▪ CDA Requested Item User Approval Policy

2. Configure the Service Portal  page.

Note: 
Ensure that you select Default [Global]  and Global  for current update set and 
application.

a. Navigate to Service Portal  > Portals.

b. Open the Service Portal  record.

c. Click the Catalogs  tab.

d. Click Edit.

e. Add Cloud Deployment Automation  to the Service Portal  list.
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f. Click Save.

What to do next

• To view the catalog items, navigate to Service Catalog  > Catalog Definitions  > Maintain 
Catalogs  and click Cloud Deployment Automation.

• To request a catalog item:

Note: 
User must have the sn_acc_mgmt_sc.access_mgmt_user, ITIL, and Catalog Admin roles 
to create and submit catalog items.

1. Navigate to the Service Portal.

2. Click the Catalog  tab.

3. Click Browse by Categories.
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4. Select Cloud Deployment 

Automation.

5. Select the required action and submit the catalog item. When the request is approved, the 
associated flow is triggered and the required user can provide the approval. Activities are 
logged in the catalog item.

Associate a portal with a knowledge base

You can associate a portal with any knowledge base. Multiple knowledge bases can be 
associated with a portal.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. In the Knowledge Bases  related list, select Edit.
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Tip: 
If you don't see the Edit  option, confirm that you have the correct application scope 
selected in the application picker.

3. Select one or more knowledge bases to add to the portal.
The knowledge bases are displayed in Service Portal page listed in the KB Home page  for the 
portal. If no knowledge bases are selected, all knowledge bases are available in the portal.

4. Select Update.

Related topics

Configure the Knowledge Management Service Portal

Configure Agent Chat  in a portal

Your end users can initiate and maintain an Agent Chat  conversation in any portal page. Write a 
script to pass portal-specific data to Agent Chat. For example, pass the name of your knowledge 
base to a Virtual Agent  conversation.

Before you begin
Role required: admin

• Activate the Glide Virtual Agent  (com.glide.cs.chatbot) or the Agent Chat 
(com.glide.interaction.awa) plugin. You can activate the Glide Virtual Agent plugin only if you 
have a subscription.

Note: 
For information about using Now Assist  in Virtual Agent  in portals, see Configuring 
assistants overview .

Procedure

1. Navigate to All  > Service Portal  > Agent Chat.
The Service Portal Agent Chat Configurations [sp_agent_chat_config] table opens.

2. Select New.

3. Complete the form.

Field Description

Active Select to make the configuration active.

Name Enter a unique name for the configuration record.

Portals Select the portals in which you would like to use the specified chat 
configuration. If no portal is selected, the configuration applies to all 
portals in the system.

Application Read-only application scope for the record.

Public
Select to make Agent Chat  available to users before they log in.

Roles
Select the roles a user must have to use Agent Chat. If you don't select a 
role, Agent Chat  is available to all users regardless of their role.

Order Enter a number indicating the order that the configurations should 
run. Only one configuration applies per portal. If there are multiple 
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Field Description

configurations on a portal, the system runs the first configuration found 
from lowest to highest.

Server script
Write a script that passes page and widget data to an Agent Chat 
conversation when a user initiates the conversation. For example, 
pass a field to the chat conversation to enable Agent Chat  to access 
the value. Data passed in this script is available to every page in 
the portal associated with this record. This script has access to the 
GlideSPScriptable  API.

Note: 
The portal suffix, page ID, and language are automatically available 
to Agent Chat  and do not require a custom script. Sys ID and table 
are automatically available to Agent Chat  when they are present in 
the URL.

This example returns an object containing the list of catalogs associated 
with the portal to the current conversation.

(function ($sp) {
   return {
      catalogs: $sp.getValue(‘catalogs’)
   };
})($sp);

When Agent Chat  opens in an iframe  HTML element, the list of 
catalogs is included in the iframe  URL. Parameters from this field 
override any conflicting page data passed to Agent Chat.

4. Select Submit.

Result
Users can initiate and maintain an Agent Chat  conversation from any page in the selected portal.

Customize the Agent Chat  button

You can change the color and images that are used in the Agent Chat  button in your portal.

Before you begin
If you plan to replace one or both of the images that are used in the Agent Chat  button, upload 
the images to your instance. For more information on uploading an image, see Storing images in 
the database.

Role required: sp_admin or admin

About this task
You can configure the following elements of the Agent Chat  button:

• The image to indicate that the chat window is open

• The image to indicate that the chat window is closed

• The button background color

These elements are determined in the portal theme. To customize the Agent Chat  button, update 
the relevant SCSS variables in the portal theme record. For more information, see Set up your 
bot's branding .
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Note: 
If you change the web client Virtual Agent  button icon while the system property 
[sys_property] table value com.glide.cs.advanced-chat.popover  is set to true, 
set the web client Virtual Agent chat button to the same size as the original button icon, 
otherwise the icon is displayed oversize.

Procedure

1. Navigate to All  > Service Portal  > Themes.

2. Open a theme record.

3. In the CSS variables  field, add the following variables:

Variable Description

$sp-agent-chat-
btn-close

Image to indicate that the chat window is closed. Use an image URL 
that contains:

◦ Your instance address

◦ The name of the Image [db_image] record to reference
For example, to reference the tack-icon.png  image in the 
database, enter the following:

$sp-agent-chat-btn-close: 
 url("https://
<instance-name>.service-now.com/tack-icon.png
");

To use the default image, remove the variable.

$sp-agent-chat-
btn-open

Image to indicate that the chat window is open. Use an image URL 
that contains:

◦ Your instance address

◦ The name of the Image [db_image] record to reference
For example, to reference the book-icon.png  image in the 
database, enter the following:

$sp-agent-chat-btn-open: 
 url("https://
<instance-name>.service-now.com/book-icon.png
");

To use the default image, remove the variable.

$sp-agent-chat-
bg

Button background color. Use a Hex code to set the color. For 
example, to use red, enter the following:

$sp-agent-chat-bg: ➚ff0000;
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Variable Description

To use the default background color, remove the variable.

4. Click Update.

Migrate from the Virtual Agent  Service Portal  widget

If you are upgrading from a previous release, your portal implementation may include the 
Virtual Agent  Service Portal  widget. Migrate widget options to the Agent Chat  in Service Portal 
configuration and remove all instances of the widget to enable your users to initiate and maintain 
an Agent Chat  conversation in any portal page.

Before you begin
Role required: (admin or none)

Procedure

1. Record instance options and delete instances of the Virtual Agent  Service Portal  widget.

a. Locate each instance of the Virtual Agent  Service Portal  widget and open the instance 
options.

b. Record the values.

c. Delete the widget instance.

2. If your widget instance included a color instance option, add the color variable to the portal 
theme record.

a. Navigate to Service Portal  > Themes.

b. Open the theme record for the portal.

c. In the CSS variables  field, add the $sp-agent-chat-bg  variable and set the value to the 
desired color.

Example 

$sp-agent-chat-bg: ➚ff0000

3. If your widget instance options included URL parameters, add them to the Service Portal Agent 
Chat Configurations form Server script  field.

Note: 
The portal suffix, page ID, and language are automatically available to Agent Chat  and do 
not require a custom script. Sys ID and table are automatically available to Agent Chat 
when they are present in the URL.
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a. Navigate to the record in the Service Portal Agent Chat Configurations 
[sp_agent_chat_config] table for the desired portal.

b. In the Server script  field, write a custom script to pass the parameters to Agent Chat.

Example 

This example returns the value of the chat_queue field to the current conversation.

(function ($sp) {
 return {
  chat_queue: $sp.getValue('chat_queue')
 };
})($sp);

Result
Widget instances are removed from individual portal pages. Instead, the portal applies the 
Service Portal Agent Chat Configurations record to every portal page.

Pass page data to Agent Chat

Use the spContextManager  class in a widget client script to pass dynamic page data to 
Agent Chat. For example, pass the number of approvals in the Approvals widget to Agent Chat 
when a user initiates a conversation from the Service Portal  homepage.

Before you begin
Role required: admin
Examine the widget to understand how data is passed to the widget client script. To make data 
available to Agent Chat, you must pass it to the spContextManager  service. You can then 
access the data in a Virtual Agent  topic using the vaContext  object. For more information 
about using context variables in Virtual Agent  scripts, see Virtual Agent scripts .

Procedure

1. Open the widget in the widget editor.

2. Update the widget client script.

a. Inject the spContextManager  service into the widget client script function.

b. Pass variables to Agent Chat  using the spContextManager  API.

This example passes approval_count  to Agent Chat. When a user initiates a conversation 
from the Service Portal  homepage, the system appends &sysparm_approval_count=5 
to the Agent Chat  iframe  URL.

function ($scope, spContextManager) {
 
   spContextManager.addContext('agent-chat', {
      'approval_count': 5
   });
};

Keys passed to this API are unique per page. For example, if the 'agent-chat'  key is 
already initialized by another widget on the page through the addContext()  method, you 
must use the updateContextForKey()  method to update the key's data. . For more 
information about the spContextManager  class, see spContextManager .

3. Click Save.
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4. Use Service Portal  data in a Virtual Agent  topic.

a. Navigate to Virtual Agent  > Designer  and open the topic in which you would like to use 
Service Portal  data.

b. Click Edit Topic Flow.

c. Configure the topic as needed.
In a script field, use the vaContext  object to access the context variable passed from the 
Service Portal.

For more information about creating a Virtual Agent  topic, see Create a Virtual Agent topic .

Example 
For example, this script accesses the value of the approval_count  variable in the 
Approvals widget.

(function execute() {
    return "Your approval count is: " + 
 vaContext.approval_count;
})()

d. Save and publish the topic.

Result
Agent Chat  can access the variables when an end user initiates a conversation from the Service 
Portal  page.
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Remove Live Chat link from the header menu

If your portal includes a Live Chat link in the header menu, you can remove it by updating the 
widget's option schema.

Before you begin
Role required: admin

About this task
Adding the Chat Queue  field to a portal record adds the Live Chat link to the portal's header 
menu. If you integrate your portal with Agent Chat, the Live Chat link is no longer needed.

Procedure

1. In the Service Portal configuration page, navigate to Portal Tables  > Instance with Menu.

2. Open the record for your portal's header menu.
For example, open SP Header Menu  if using the base system portal.

3. In the Additional options, JSON format  field, add the following JSON key-value pair.
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“enable_live_chat”: {
    “displayValue”: “false”,
    “value”: false
}

The final JSON looks like this.

{
    “enable_cart”: {
        “displayValue”: “true”,
        “value”: true
    },
     “enable_wishlist”: {
       “displayValue”: “true”,
         “value”: true
     },
    “enable_live_chat”: {
      “displayValue”: “false”,
        “value”: false
    }
}

4. Click Update.

Result
When you navigate to the portal, Live Chat  does not appear in the header menu.

Defining portal styles

Pages are made up of containers, columns, rows, widgets, and widget instances. You can 
configure the CSS of each component, or use the CSS defined in theme and branding as global 
definitions for the portal. If you do not define CSS in theme or branding, Bootstrap defaults are 
used.

You can define CSS in your portal at multiple levels.

Bootstrap defaults

If no other CSS is defined, all elements use Bootstrap version 3.3.6 defaults. You 
can use Bootstrap CSS Helper Classes  with any Service Portal  field that accepts 
CSS as a value. To show or hide Service Portal  containers, use Bootstrap CSS 
Responsive Utilities Helper Classes such as visible-lg  or hidden-md.

Branding editor theme colors/Portal CSS

CSS defined in the Branding Editor Theme Colors tab. Changes made to the theme 
colors in the Branding Editor appear in the CSS variables field in the portal table 
[sp_portal]. Customizing the theme colors overwrites the Bootstrap defaults.
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Theme CSS

CSS defined in the CSS variables field in the Themes table [sp_theme]. Use the 
Theme CSS as much as possible to allow for more flexible evolution of your portal in 
the future.

Using a theme overwrites the Portal CSS/Branding Editor theme colors.

Page CSS

CSS defined in the Page Specific CSS field in the Pages table [sp_page].

Page-specific CSS overwrites the theme CSS.

CSS classes

You can define CSS classes elements on the page within each respective record.

Widget CSS

CSS defined in the CSS field in the Widgets table [sp_widget].

Widget CSS overwrites container, column, and row CSS.

Widget instance CSS

CSS defined in the CSS field in the Instance table [sp_instance].

Widget instance CSS overwrites all other CSS definitions.

Note: 
In some cases, default styles for accessibility might overwrite the CSS defined for a portal.
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Hierarchy of style application in the Service Portal

Configure portal branding

Use Branding Editor  to give your portal its own look and feel.

To access the Branding Editor, navigate to Service Portal  > Service Portal Configuration, then 
click Branding Editor.

Select the portal you want to customize the theme for from the portal list. Then use the options 
on the Quick Setup and Theme Colors tabs to customize your portal.

Branding Editor
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Quick Setup tab options

Field Description

Portal Title
The name of your portal. Changing the name of the portal in the Branding Editor 
also changes the title on the portal form field in the platform UI.

Logo The logo that appears in the header for your portal. This image is scaled to a 
maximum height of 46 px and a maximum width of 200 px.

Logo 
padding

Where you want the logo to sit in location to the edge of the header. This 
information is stored in the CSS variables section on the portal form.

Tag line & 
background Fields defined by the JSON schema in the Quick start config  field on the 

portal record in the platform UI. The sample Service Portal  adds Tag Line  and 
Background  to the Branding Editor  using the following schema:

[{
 "tagline": {
  "table" : "sp_instance",
  "sys_id" : "34fe3d96cb20020000f8d856634c9cf4",
  "field" : "title"
 },
 "hero_background": {
  "table" : "sp_container",
  "sys_id" : "be98a8d2cb20020000f8d856634c9c63",
  "field" : "background_image"
 }
}]

Tag line Introduce your users to a portal page with a tag line. This text is stored in an 
instance of the homepage search widget.

Tag line 
color

Select a color for the tag line.

Homepage 
background 
color

Add a color for your background. You can type in a color name, hex color, decimal 
(RGB), or select from the color palate.

Background 
image

Upload an image to appear in the background of your homepage. This image is 
stored in the container for the widget on your homepage.

For any colors on the theme tab, you can use the standard color name, hex code, decimal (RGB) 
code, or select the color from the color palate. All the color definitions are stored in the CSS 
variables field of the portal form. The theme preview updates in real time as you make changes.

Theme colors tab

Field Description

Navbar Use the fields in this section to customize the colors for the header menu.

Brand Use the fields in this section to customize the page colors. For example, the page 
background or the widget background.

Text Use the fields in this section to customize the color of the text on a page.
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Changes made to the theme colors in the Branding Editor  appear in the CSS variables field of the 
portal form in the platform UI.

Activate La Jolla theme branding

Activate the Service Portal La Jolla Brand to apply ServiceNow  branding, which includes WCAG-
AA compliance for contrast. This plugin is active by default on new instances, but admins must 
activate the plugin on instances upgraded from earlier versions.

Before you begin
Role required: admin

About this task
The Service Portal La Jolla Brand Update  activates these related plugins if they are not already 
active.

Plugins for Service Portal La Jolla Brand Update

Plugin Description

Service Portal La 
Jolla Brand

[com.glide.service-
portal.themes.la-
jolla]

This plugin updates your /sp and /sp_config portals with the ServiceNow 
La Jolla branding. If the portal record has not been modified, the logo, 
favicon, login page background image, hero banner, theme, and widget 
instance options are updated.

Note: 
If you have modified the /sp  or sp_config  portal pages before installing the plugin, you 
may not see all elements of the La Jolla branding. All branding images are located in the 
db_image  table for manual updates to your custom portals.

To purchase a subscription, contact your ServiceNow  account manager. After purchasing the 
subscription, activate the plugin within the production instance.

You can evaluate the feature on a sub-production instance without charge by requesting it from 
the HI Customer Service System.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .
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Related topics

List of plugins (Zurich)

Create a portal theme

If you need more customization than Branding Editor can provide, you can create your own 
custom theme.

Only users with an understanding of CSS should create custom themes.

1. Navigate to Service Portal  > Themes, then select New.

2. Complete the form fields and then from the form context menu, select Save.

Theme form fields

Field Description

Name Name of your theme. Use this name to associate the theme with your 
portal. This name is not visible to users, you should know it to apply 
the correct theme to a portal.

Turn off SCSS 
compilation

Turns off compiling SCSS and sends the plain CSS file directly to the 
client.

Application
The record scope. The header menu record and the source table 
must have the same application scope.

Header List of headers and footers from the sp_header_footer table that you 
can associate with a portal theme. Headers and footers are widgets 
and can be configured the same way.

Footer List of headers and footers from the sp_header_footer table that you 
can associate with a portal theme.

Fixed header Locks the header at the top of the page so that when a user scrolls 
the header remains on the screen.

Fixed footer Locks the footer at the bottom of the page so that when a user scrolls 
the footer remains on the screen.

CSS variables CSS custom properties that you can use to change the color and 
styles in a portal. For example, the stock theme uses some of the 
following variables:

$sp-logo-margin-x:   15px !default;
$sp-tagline-color:  $text-color !default;
$navbar-inverse-bg:  ➚3a3f51 !default;

Note: 
Use the CSS variables field to define CSS variables only. Use 
CSS Includes to define CSS rules. As of the Madrid release, 
Sass and LESS can be used within CSS Includes.

3. To add a style sheet to the theme, in the CSS Include  related list, select New.

4. Complete the style sheet form fields and select Submit.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

764

https://www.servicenow.com/docs/access?context=list-of-plugins&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=list-of-plugins&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=list-of-plugins&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=list-of-plugins&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=list-of-plugins&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Style sheet form fields

Field Description

Name Name of the CSS Include. Remember this name to associate the CSS 
Include with the theme.

Application The record scope. The header menu record and the source table 
must have the same application scope.

Source Select one of the following options:

◦ Style Sheet: Add an internal style sheet that has been uploaded to 
the CSS table [sp_css]. For example, ng-sortable.min.css. Internal 
style sheets use standard CSS in the CSS field.

◦ URL: Link to an external style sheet. Use external style sheets to 
use the same CSS as a corporate website or other online resource.

Style sheet An internal style sheet to associate with the theme.

CSS file URL A URL to an external style sheet to associate with the theme.

Lazy Load
(Optional) Option to load the CSS Include asynchronously to improve 
page load time. This option should be set to the same value for all 
CSS Includes of a theme. Enabling asynchronous loading for only 
some CSS Includes associated with a theme isn’t recommended.

Note: 
Enabling Lazy Load  isn’t recommended for portals with flashing 
of unstyled content.

The CSS Includes with Lazy Load  enabled are listed in the Lazy load 
CSS includes  related list in the theme record.

RTL CSS file URL
(Optional) A URL to an external style sheet for mirroring the direction 
of a portal when the session language is a right-to-left language, such 
as Hebrew.

For information about support for right-to-left languages, see Styling 
for right-to-left languages in portals.

5. To add a JavaScript include to the theme, in the JS Include  related list, select New.

6. Complete the JS Include form fields and select Submit.

JS Include form fields

Field Description

Display name Name of the JS Include. Remember this name to associate the JS 
Include with the theme.

Application The record scope. The header menu record and the source table 
must have the same application scope.

Source Select one of the following options:
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Field Description

◦ UI Script: Add an internal UI script that has been uploaded to 
the UI script table [sys_ui_script]. UI scripts allow you to create 
client-side JavaScript and reuse it in multiple locations. For more 
information on UI scripts, see UI scripts .

◦ URL: Link to an external JavaScript file. Use external URLs to 
use the same JavaScript as a corporate website or other online 
resource.

UI Script or JS file 
URL

Associate an internal UI script or JavaScript file URL, depending on 
which option you select in the Source field.

Updated Date and time that the JS Include was last updated

Package The Service Portal package that the JS include is associated with. For 
example, Service Portal Configuration Pages. This field is populated 
by default.

Enable text resize in your portal

Enable text resize to increase the size of your text up to 200% through your browser settings.

Before you begin

• If you upgraded to a Rome instance from a prior release, the property is created for you. The 
property default is set to False  for Service Portal  and Mobile Employee Service Portal (MESP). 
Follow the steps in this task to manually set the property to True.

• If you have a new portal or a zBoot instance, the property is set to True by default. There are no 
actions you need to take.

• If you haven't upgraded to a Rome instance, the property is created, but is set to False  by 
default.

Role required: admin

Procedure

1. Enter sys_properties.list  in the Filter navigator.

2. Select glide.service_portal.resize_text.{your 
portal_url_suffix}.enable_rem_conversion  from the list.
For example, 
glide.service_portal.resize_text.sp.enable_rem_conversion.

3. On the form, set the Value field to true.

4. Select Update.

Override the HTML base CSS font size in your portal

Set the HTML base CSS font size in your portal.

Before you begin
Role required: admin

Procedure

1. Enter sys_properties.list  in the Filter navigator.

2. Select glide.service_portal.resize_text.
{portal_url_suffix}.base_font.
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For example, glide.service_portal.resize_text.mesp.base_font.

3. On the form, set the Value field to the font size you want.

4. Select Update.

Note: 
If an issue arises with resize text for custom pages coming from styling from custom CSS 
includes, convert those CSS values from pixels to REMs.​

Styling for right-to-left languages in portals

Localizing a portal for right-to-left languages requires CSS that mirrors the direction of portal 
pages.

Service Portal  can generate the CSS required to mirror the user interface direction of the 
portal when the session language is a right-to-left language. The entire hierarchy of existing 
infrastructure for styling left-to-right languages—the theme, page, widget, and widget instance 
SCSS—is converted to CSS for right-to-left languages. All directional properties supported 
by RTLCSS  are converted. However, plain CSS files included in any of the theme or widget 
dependency records, internal CSS, and inline CSS aren’t automatically converted.

You can also provide your own CSS for right-to-left languages to override the automatically 
generated CSS if you use an external CSS library and you can control the conversion of CSS for 
right-to-left languages using a variety of methods.

Note: 
Base system portals besides Service Portal  (/sp) and custom portals might need additional 
CSS customization to mirror the direction of a portal for right-to-left languages completely.

To track how many users view a portal in a right-to-left language, see the PortalPageLoad event 
in User Experience Analytics  for Service Portal. For more information about available events, see 
Service Portal events.

Mirror the portal direction for right-to-left languages

Mirror the direction of a portal's user interface for right-to-left languages by enabling the 
necessary CSS.

Before you begin
Active a right-to-left language, such as Hebrew. For more information, see Activate a language .

Role required: sp_admin or admin

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select a portal.

3. Select the Support right-to-left languages  option.

4. Select Update.
CSS that mirrors the direction of a portal's user interface for right-to-left languages is 
generated.

5. Optional:  If you use an external CSS library for your portal theme, provide your own CSS that 
mirrors the direction of a portal's user interface to override the automatically generated CSS.

a. Navigate to All  > Service Portal  > Themes.

b. Select the theme for the portal.
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c. In the CSS Includes  related list, select the CSS Include that links to an external CSS library 
URL.
If you need to create a new CSS Include, see Create a portal theme.

d. In the RTL CSS file URL  field, enter the URL to an external style sheet for mirroring the 
direction of a portal for right-to-left languages.

e. Select Update.

Result
When the session language is a right-to-left language, the direction of the portal user interface is 
mirrored to display from right to left.

Trouble? 

If any content in your portal isn’t automatically mirrored for right-to-left languages, see CSS for 
right-to-left languages in portals  for information about how to resolve these issues.

CSS for right-to-left languages in portals

You can control the generation of CSS for right-to-left languages using a variety of methods.

Base system portals besides Service Portal  (/sp) and custom portals might need additional CSS 
customization to mirror the direction of a portal for right-to-left languages completely.

Custom widgets might need some manual conversion for right-to-left languages.

• For inline styles in a widget's HTML template, move these styles to the widget's CSS so they’ll 
be automatically converted.

• For internal styles in a widget's HTML template, you can use the [dir=”rtl”]  attribute 
selector or .rtl  class selector to provide CSS that is specific to right-to-left languages.

• To include CSS that is specific to right-to-left languages, you can call the isRTLEnabled() 
method in the GlideSPScriptable - Scoped  class in a widget’s server script or use the 
g_portal_isrtl  global flag in the widget’s client script.

Also, in the theme, page, widget, or widget instance CSS, you can add right-to-left directives to 
CSS properties only using a Sass interpolation string (➚{""}).

CSS directives for right-to-left languages

Right-to-left CSS directive Description

/*rtl:ignore*/ Ignores the property when converting portal 
CSS for right-to-left languages.

/*rtl:prepend:10px*/ Adds a value to the beginning of the property 
value for right-to-left languages. This example 
prepends 10px.

/*rtl:append:3rem*/ Adds a value to the end of the property value 
for right-to-left languages. This example 
appends 3rem.

/*rtl:replace:30px*/  or /
*rtl:30px*/

Replaces the property value with the specified 
value for right-to-left languages. This example 
replaces the property value with 30px.
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CSS directives for right-to-left languages  (continued)

Right-to-left CSS directive Description

/*rtl:insert:25px*/ Inserts the specified value in place of the 
directive for right-to-left languages. This 
example inserts 25px.

Example: Ignore the transform property in the converted right-to-left CSS

.fl {
transform: rotate(45deg) translateY(5px) ➚{"/*rtl:ignore*/"};
}

Creating portal pages

Use pages to organize content, ensure responsive mobile optimization, and design meaningful 
portal user experiences for your customers. A page houses containers and rows, which then 
contain widgets. By manipulating the layout of the page, and the widgets within it, you can 
construct your desired user experience.

• Pages are referenced using the page ID.

• Pages can be referenced in more than one portal.

• Use base system pages as templates.
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Page layout

Containers

Containers are markup artifacts that are put on a page to contain the layouts that house the 
widgets.

You can view containers and how they make up a page in the Service Portal Designer (Service 
Portal  > Service Portal Configuration  > Designer). Open a page in the Service Portal Designer, 
then click anything on the page. In the top left corner, breadcrumbs appear to show you which 
element on the page you have selected. Use the breadcrumbs to select a container, then click 

the edit icon ( ).
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Service Portal Designer breadcrumbs

You can also edit a container by navigating to the Page Editor and selecting the container node 
in the tree view. In this view, you can:

• Change the layout of widgets on a page.

• Determine the number of columns on a page.

• Determine whether to scale with changes to the browser window.

• Add a background color to a portion of a page.

• Add an background image to a portion of a page.

• View the current layout of the widgets within the page.

Create and edit a page using the Service Portal  Designer

Create or edit a page and use layouts to organize the columns that house the widgets.

Before you begin
Role required: sp_admin or admin

About this task
These steps are intended for users with little to no coding experience. The Service Portal 
Designer includes several layers of customization from simply adding widgets in a particular 
configuration on a page, to adding CSS classes.

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Designer.

3. Switch to the portal you want to design pages for by selecting the portal name in the header.

4. From the Service Portal  Designer, select a page to customize or select Add a new page.

5. Under Layouts, select Container  and drag it onto the page.

6. Drag one of the other layouts and drop it in the container.
This layout defines the structure of your page and the space available to drop widgets. The 
structure of the layout aligns with the Bootstrap grid template and always adds up to 12.

7. Use the filter to search for a widget, then drag the widget to the layout.
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Example 

Drag containers, layouts, then widgets onto a page

For widgets that do not contain any information by default, you must configure the options for 
their widget instances before they will appear on a portal page. For more information about 
configuring widget instance options, see Configure widget instances.

8. Optional:  Edit page properties.

a. Select Edit Page Properties.
The page record from the Pages table [sp_page] opens.

b. Edit the form.

Page fields

Field Description

Title Internal name of the page. Use the title to search for a page in the 
Service Portal Designer.

ID A unique ID for the page. The ID is what you use to assign a 
page to a portal. It also determines the URL for the page, for 
example https://instance name.service-now.com/
doc_portal/?id=doc_page, where doc_page is the page ID.

Application The application scope.

Public Enables the page to be accessed without the need for 
authentication. If Public  is selected, all users can view the page no 
matter the roles listed.

Draft Mark a page as draft to limit user ability to view the page while you’re 
still creating it. Only users with the admin role can view a page in 
draft, all other users see a 404 page.

Roles Limit user access to a page by role.
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Field Description

Short description Describes the portal page. This field isn’t public facing.

Page Specific CSS Unless a page has Page Specific CSS, the page inherits CSS from 
the Theme and Branding. If you need a page to look different, the 
Page Specific CSS overrides the inheritance from the Theme and 
Branding.

Dynamic page title
(Optional) Create variables to generate descriptive titles depending 
on the content loaded into a page.

For more information, see Add dynamic titles to a page.

Clone Page Enables you to make a copy of a page that can be modified. If you 
clone a base system page, a new widget instance is created for each 
widget on the page.

Use SEO script
(Optional) Option to enable a script include that adds SEO tags for 
canonical URLs and hreflang tags.

For more information, see Enable SEO for localized versions of a 
portal page.

SEO script
(Optional) Script include to apply to the page. By default, the system 
uses the SPSEOHeaderTags script include, which includes the 
default implementation for the canonical URL and hreflang tags for 
Service Portal Analytics  pages.

Human readable 
URL structure (Optional) Add human readable keywords to the page URL 

to improve search engine optimization (SEO) and click-
through rates for public pages. Human readable URLs 
also help users understand what to expect on a page for 
public and non-public pages. For example, https://
<instance>/kb/en/faq/what-is-a-cookie?
id=kb_article_view&sysparm_article=KB0000007.

For more information, see Add human readable keywords to page 
URLs.

9. Optional:  Edit container properties.

a. Select within the container you would like to edit, or select Container  in the breadcrumbs.

b. Select the edit icon [ ].
The container record from the Containers table [sp_container] opens.

c. Edit the form.

Container fields

Field Description

Name Internal name of the container.
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Field Description

Order The order in which the containers appear on a page. To set a 
container to appear above all other containers, give the container 
the lowest number in the Order  field.

Page The page that includes the container.

Screen reader title The title used by a screen reader.

Semantic tag The semantic HTML tag that includes the container. Options 
include:

▪ None: All content on the page between the header and footer is 
included in the <main>  tag.

▪ Main: The <main>  tag includes only the container and its 
contents. The <main>  tag is a semantic HTML element that 
contains the main content of the page. It should be applied to 
content that is unique to the page and should be configured for 
only one element on the page.

Note: 
The <main>  tag can be applied to a container, row, or 
column. For more information, see Configure the main tag 
on a page.

Application The application scope.

Width Width of the container. Options include:

▪ Fixed

▪ Fluid

Parent class Parent CSS class for the container.

CSS class The CSS classes for the container. Overwrites page-specific CSS.

Background color The background color of the container.

Background image Background image for the container.

Background style The display style of a background image. Options include:

▪ Default

▪ Cover

▪ Contain

▪ Repeating

Bootstrap alternative Selecting this field removes the standard Bootstrap grid classes 
and disables the Bootstrap grid system in the container. If 
selected, the following aren’t applied:

▪ The Width  field in the container record.

▪ Standard Bootstrap class in the row record within the container.

▪ The Size - xs, Size - sm, Size - md, and Size - lg  fields in column 
records within the container.
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Field Description

Only select this field if you plan to provide custom CSS classes 
and CSS for the container, row, and column records.

Move to header If selected, the container sticks to the header and doesn’t scroll. 
Use this option to create a subheader.

10. Optional:  To switch to a different page, select the Pages  tab in the left pane, then select the 
next page you want to configure.

11. Optional:  Use the Preview button in the header to view your page as you design it.
You can also use Preview  to view your page in mobile or tablet mode through the controls 
presented in the header.

Designer tablet view

Add a subheader to a page

Select a container record to serve as a page subheader. A subheader sticks to the page header 
and does not scroll.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Designer.

3. Select a page.

4. Switch to the portal you want to design pages for by selecting the portal name in the header.

5. Select the container that you would like to use as a subheader, or select the container using 
the breadcrumbs.
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6. Select the edit icon ( ).

7. Select Move to header.

Result
As a subheader, the container sticks to the header and does not scroll.

Include font icons on a page

Include font icons on a page so that all the widgets on the page have access to the font-icon set.

Before you begin
Role required: sp_admin or admin

Procedure

1. Navigate to All  > Service Portal  > Pages  and click the page you want to add font icons to.

2. Attach the font-icon file to the page record.

3. In the Page Specific CSS field for the page, add the CSS for the font-icon definition.
Use the sys_id of the attachment as the src  in the CSS. For example:

Example 

/* fallback */
@font-face {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: 400;
  src: url('/828b8ca8b7033010897725cbde11a9f7.iix') 
 format('woff2');
}
 
.material-icons {
  font-family: 'Material Icons';
  font-weight: normal;
  font-style: normal;
  font-size: 24px;  /* Preferred icon size */
  display: inline-block;
  line-height: 1;
  text-transform: none;
  letter-spacing: normal;
  word-wrap: normal;
  white-space: nowrap;
  direction: ltr;
 
  /* Support for all WebKit browsers. */
  -webkit-font-smoothing: antialiased;
  /* Support for Safari and Chrome. */
  text-rendering: optimizeLegibility;
 
  /* Support for Firefox. */
  -moz-osx-font-smoothing: grayscale;
 
  /* Support for IE. */
  font-feature-settings: 'liga';
}
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Result
You can select an icon from the icon set for any widget on this page. For example, in the HTML 
widget you can use the Source Code  option to use an icon. For example:

<p style="text-align: center;"><em class="material-
icons">flight_land</em></p>

Standard ticket page

Configure individual request types to display the request-specific information, while still having 
a consistent layout that is similar to other request types. This configuration verifies a consistent 
experience when viewing submitted requests.

For new instances, the standard ticket page is available by default. For upgraded instances, you 
must activate the Standard Ticket Route page route map. For information about activating this 
page route map, see Activate the page route map for the standard ticket page.

The information displayed in each section of a standard ticket page depends on the individual 
request type. If a configurable section has no specified values or if a user doesn’t have access to 
the information, it isn’t visible.

Standard ticket page for an incident

Header section

By default, this section displays the following information for a submitted request:

• Identification number

• Created and updated dates

• State. Instead of the State  field, you can also configure any other field that represents the state 
of the ticket.

Info section

If configured, this section displays the following regions for a submitted request:
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• Ticket description region with the short description, and optionally the description.

Note: 
You can map the Description  field to any other field on the record.

• Fields region where the associated fields are configured. A configured field isn’t visible when it 
has no value or when a user doesn’t have access to the field.

Note: 
A field of the workflow type isn’t supported for any table. Only for the Requested Item 
[sc_req_item] table, the workflow type field is supported, for example, the Stage  field. 
This field is displayed at the last irrespective of the field position in the configuration.

• Actions region

Tabs section

If configured, this section displays the following types of tabs for a submitted request:

• Activity

• Attachments

• Variable editor

• Variable summarizer

• Associated Requests. Displays all associated requests (visible in the My Requests  widget in 
Service Portal) for which the current ticket is the parent. It’s applicable in any of the following 
scenarios:

◦ If the current ticket is a universal request, then all requests associated (through the Parent 
field on the task table) with child tickets of the universal request are displayed.

◦ If the current ticket isn’t a universal request, then all requests associated (through the 
Parent  field on the task table) with the current ticket are displayed.

For information on defining filters for the My Requests widget, see Define filters for My 
Requests .

• Custom tab

By default, the Activity  and Attachments  tabs are available.

Configurations for a cross-scope application

For each request type of a cross-scope application, the following configurations are required:

• Restricted caller access privileges for the following standard ticket page widgets so that 
these widgets can access the application tables. For information about these privileges, see 
Application access settings .

◦ Widget: Standard Ticket Header

◦ Widget: Standard Ticket Attachments

◦ Widget: Standard Ticket Tab

• Restricted caller access privileges for the Description  field in the application. This field is 
displayed on the standard ticket page header.

• Page route map to route all the requests of that application to the standard ticket page
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Domain separation for a standard ticket page

Tab configurations aren’t domain-separated.

Ticket configurations are process domain-separated. For any request type record, when a 
user opens the standard ticket page, it checks for ticket configurations in the following order 
irrespective of the user's domain:

1. In the record’s domain

a. Ticket configurations for the record table

b. Ticket configurations for the parent table of the record table

2. In the record domain’s parent hierarchy

a. Ticket configurations for the record table

b. Ticket configurations for the parent table of the record table

Note: 
For a table, only one active configuration is enabled per domain.

Related topics

Standard ticket page for a requested item

Incident standard ticket page

Configure the standard ticket page

Configure the standard ticket page

Give Service Portal  users a consistent way to view their submitted requests. You can configure 
the standard ticket page for different request types.

Before you begin
Role required: admin or sp_admin

About this task
You can add a standard ticket configuration only for a task-extended table.

Widgets containing Date/Time  values display the date and time only in the Time Ago  (for 
example, 11 minutes ago) format, and user preferences for such widgets aren’t considered. For 
example, the Created date  and the Updated date  values are displayed in the Time Ago  format.

Procedure

1. Navigate to All  > Standard Ticket  > Standard Ticket Configuration.

2. Select New.

3. On the form, fill in the fields.

Ticket Configuration form

Field Description

Table Task-extended table for which you want to configure the standard ticket page.

Active Option to specify if the ticket configuration is active.

Application Application associated with the ticket configuration.
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Field Description

State field Any field of the task-extended table. By default, this field is mapped to the 
State  field of the task-extended table. You have to configure the form to add 
this field.

Note: 
You can’t add fields for any of the following information:

◦ Number

◦ Short description

◦ Created date

◦ Updated date

◦ Watch list

◦ Any user input such as comments and work notes

Info Region

Show 
'Description'

Scenario when the request description should be displayed. Possible options 
are:

◦ None

◦ Always

◦ When no variables

Note: 
When displayed, you can expand and collapse the description.

Description 
field A field that the sp_admin can select from the fields of the ticket record (for 

example, sc_req_item, incident), which is displayed as description on the 
Standard Ticket Page.

Advanced Option to specify that a widget should be displayed in the info region.

Info widget Widget that should be displayed in the info region. This field appears only 
when the Advanced  check box is selected.

Info widget 
parameters

Name value pair to specify the widget parameters. This field appears only 
when the Advanced  check box is selected.

Info fields Fields that should be displayed in the info region. This field disappears when 
you select the Advanced  check box.
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Field Description

Note: 

◦ You can’t add fields for any of the following information:

▪ Number

▪ Short description

▪ Created date

▪ Updated date

▪ Watch list

▪ State

▪ Any user input such as comments and work notes

◦ A field of the workflow type isn’t supported for any table. Only for 
the Requested Item [sc_req_item] table, the workflow type field is 
supported, for example, the Stage  field. This field is displayed at the 
last irrespective of the field position in the configuration.

Action Region

Action 
widget

Widget to specify the actions available in the Action region.

Note: 

If the field is configured, it takes precedence over the standard ticket 
actions.

Action 
widget 
parameters

Name value pair of action widget parameters.

Summarization

Summary 
fields

Standard ticket page fields that are included in the summary generated by Now 
Assist.

4. Select and hold (or right-click) the header menu and select Save.

5. After you make all the required changes, select Submit.

Related topics

Enable instance options for the Activity tab

Configure tabs for standard ticket page

Configure actions for standard ticket page

Now Assist in Standard Ticket Page

Enable instance options for the Activity tab

Format the work notes and add @mentions in the Activity tab on a standard ticket page.
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Before you begin
Role required: sp_admin or admin
You should add the Activity  tab in the standard ticket configuration of a request type. For 
information on configuring tabs, see Configure the standard ticket page.

Procedure

1. Navigate to the request in Service Portal.

2. Press Control and right-click anywhere in the Activity  tab.

3. Click Instance Options.

4. Configure settings for the Activity  tab.

Activity tab instance options

Instance option Description

Enable Rich Text Editor Option to enable formatting the work notes.

Note: 

For the Ticket Form for Case (csm_ticket) page, the Activity 
tab options must be configured from the Activity tab 
configuration record of the sn_customerservice_case page.

a. Navigate to All  > Standard Ticket Configuration.

b. Select the sn_customerservice_case  record.

c. In Tab Configurations, select the Activity  tab configuration 
record.

d. Edit the rich_text_editor  widget parameter field.

Enable @ Mentions 
(works only when Rich 
Text Editor is enabled)

Option to enable mentioning the relevant people in work notes.

Note: 
This option is applicable only when the Enable Rich Text 
Editor  instance option is selected.

5. Click Save.

Configure tabs for standard ticket page

You can configure the tabs for the standard ticket page.

Before you begin
Role required: admin and sp_admin

About this task

• By default, the Activity and Attachments type tab configurations are available for all standard 
configurations. Other default tab configurations may vary based on the task-extended table. 
For example, for the sc_req_item configuration, the Variable Editor (Read-Only) type is also 
available.

• You can’t duplicate any tab type other than Custom.
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• You can configure a maximum of six tabs.

• You can add either Variable Editor (Read-Only) or the Variable Summarizer tab type.

Procedure

1. Navigate to All  > Standard Ticket  > Standard Ticket Configuration.

2. On the Ticket Configuration form, select the Tab Configurations related list.

3. Select New.

4. On the form, fill in the fields.

Tab Configuration form

Field Description

Type Tab type based on which a widget is displayed. Possible options are:

◦ Activity

◦ Associated Requests

◦ Attachments

◦ Custom

◦ Variable Editor (Read-Only)

◦ Variable Summarizer

Tab name Name of the tab.

Application Application associated with the ticket configuration.

Order Order in which the tab should be displayed in the tabs section. The tab with 
the least order is the tab selected on the page load.

Advanced Option to enable adding a script for the tab visibility. By default, this check 
box is cleared.

Visible(Script) Script for the tab visibility.

◦ If the script returns true, the tab is visible on the standard ticket page.

◦ If the script returns false, the tab is not visible on the standard ticket page.

Note: 
This field appears only when the Advanced  check box is selected.

Visible Conditions for the tab visibility. This is not displayed if the Advanced  check 
box is selected.

Widget Widget that should be displayed in the tabs section. This field appears only 
when Custom  is selected from Type.

Widget 
parameters

Comma-separated list of tab widget parameters. This field appears only when 
Custom  is selected from Type.

5. On the Ticket Configuration form, select Update.
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Related topics

Configure the standard ticket page

Enable instance options for the Activity tab

Configure actions for standard ticket page

Configure actions for standard ticket page

You can configure specific actions to be directly available on the standard ticket page. 
Requesters are able to initiate these actions. Scriptable APIs can also trigger these actions.

Before you begin
Role required: admin and sp_admin

Procedure

1. Navigate to All  > Standard Ticket  > Standard Ticket Configuration.

2. On the Ticket Configuration form, select the Standard Ticket actions related list.

3. Select New.

4. On the form, fill in the fields.

Standard Ticket actions form

Field Description

Name Name the action you want to be on the page. For example, Resolve.

Application Application associated with the ticket configuration.

Short 
description

Describe the action in detail. For example, for the Resolve action, you can 
specify “Marks the incident as resolved.”

Ticket 
configuration

Reference to the standard ticket configuration record. For example, incident.

Active Select the check box if you want this action to be active.

Table Name of the associated table. For example, Incident [incident].

Order Order in which the action should be displayed in the actions section.

Advanced Option to enable adding a script for the action visibility. By default, this check 
box is cleared.

Applicability 
script Script for the action visibility.

◦ If the script returns true, the action is visible on the standard ticket page.

◦ If the script returns false, the action isn’t visible on the standard ticket page.

Note: 
This field appears only when the Advanced  check box is selected.

Action script Action script performs the specified action. For example, when the Resolve 
action is selected, actions script determines the next action.

Applicability 
condition

Conditions for the action visibility. This isn’t displayed if the Advanced  check 
box is selected.

User input Option to enable adding text input by users for the action. If you select this 
check box, and save the changes, you see a new Standard Ticket Action 
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Field Description

Inputs related list. You can create a new user input in this related list. For 
example, a user input where strings must be provided.

Note: 
Only string-type input is supported for standard ticket actions.

5. Select Update.

Related topics

Configure the standard ticket page

Enable instance options for the Activity tab

Configure tabs for standard ticket page

Activate the page route map for the standard ticket page

If you have upgraded your instance, redirect the ticket page to standard_ticket page in Service 
Portal and view requests on the standard ticket page.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Page Route Maps.

2. Select Standard Ticket Route.

3. Select the Active  check box.

4. Click Update.

Related topics

Define filters for My Requests

Redirect a reference to a page ID

Redirect all references from Service Portal  widgets to route to a new page with a single record to 
avoid manually replacing the hard-coded page ID in widgets.

Before you begin
Role required: sp_admin

About this task
Multiple widgets in Service Portal  can link to a single page using a hard-coded page ID. This 
process allows you to replace page references in widgets without locating and replacing all 
references to the page ID by cloning and updating each widget.

To redirect all references to a page, create a record in the Page Route Map [sp_page_route_map] 
table. This table enables you to redirect a reference to a page without cloning base system 
widgets.

Creating a record in the Page Route Map table only redirects references to a page. It doesn’t 
redirect navigation to a page ID within a URL.
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Note: 
You don't need to create a page route map to redirect users to a 404 page. To specify the 
404 page for your portal, update the 404 page  field in the Portal [sp_portal] record.

Procedure

1. Navigate to All  > Service Portal  > Page Route Maps.

2. Select New.

3. On the form, fill in the fields.

Field Description

Short Description Optional short description to describe the redirect.

Service Portal(s) Portals that apply the redirect. If you don't select a portal, the 
redirect applies to all portals in the instance.

Route from Original page you’re redirecting from.

Route to Page you’re redirecting to.

Active Whether the Page Route Map record is active. The redirect only 
applies when the record is active.

Roles Roles to which the page route map applies. Users that don't have 
any of the roles specified in this field aren't redirected to the new 
page. If no roles are specified, the page route map is applicable to 
all users.

Order Priority of the Page Route Map record. If more than one active 
record has the same value in the Route from  field, the record 
with the lowest order applies. The system evaluates records from 
lowest to highest. If multiple records have a matching order, the 
system honors the oldest record.

4. Select Update.

Result
All references to the page listed in the Route from  field redirect to the page in the Route to  field.

Attaching files to records from portal pages

Attachments can be added to records from portal pages by navigating the file system, pasting 
files from the clipboard, or dragging and dropping files.

By default, several base system widgets accept attachments from portal users using one or more 
of these methods. To modify how portal users can add attachments, you can clone and edit 
widgets to customize the file attachment experience as described in the following procedures.

To track how portal users attach files to records from pages in your portal, see the SP File Attach 
event in User Experience Analytics  for Service Portal. For more information about available 
events, see Service Portal events.

Add attachments by pasting or dropping files

Allow portal users to attach files by pasting or dropping files in the Add attachments dialog box.
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Before you begin
By default, the Form, Ticket Attachments, Ticket Conversations, and SC Catalog Item base 
system widgets support adding attachments by pasting or dropping files in the Add attachments 
dialog box rather than only by navigating the file system.

To configure this functionality for other widgets, you can clone or create a widget that supports 
adding attachments with the sp-attachment-button  directive. For more information about 
cloning widgets, see Clone a widget.

Note: 
Base system widgets are read-only so you can benefit from future updates. To make 
changes, you can clone base system widgets. However, cloned widgets are considered 
custom and don't benefit from future updates to the widgets they were cloned from.

Role required: sp_admin or admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Widget Editor.

3. In the Edit an existing widget menu, select the widget you cloned.

4. In the HTML Template  of the widget, locate the sp-attachment-button  element.

5. Configure attributes for the sp-attachment-button  element.

◦ modal: Enables copy-paste and drag-and-drop support when set it to true.

To turn off copy-paste and drag-and-drop support, set it to false.

◦ supported-extensions: Displays a list of supported file extensions for attachments at 
the bottom of the Add Attachments dialog box.

To list the supported file extensions specified by the glide.attachment.extensions 
system property, set it to {{::data.supportedAttachmentExtensions}}.

Example 

<sp-attachment-button modal="true" supported-extensions="{{::data.supportedAttachme
ntExtensions}}"></sp-attachment-button>

6. Select Save.

Result
On a page with the widget, you can paste or drop files over the Add attachment dialog box to 
attach them to the record, as shown in the following example.

Note: 
This functionality isn't supported for mobile experiences. Pasting attachments isn’t 
supported in Firefox.
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Add a drag-and-drop zone for attaching files

Allow portal users to drop attachments in a dedicated zone of a page to quickly attach files to a 
record.

Before you begin
To configure a drag-and-drop attachments zone on a page, you must clone or create a widget 
that supports adding attachments by calling attachmentHandler  set to an instance of 
nowAttachmentHandler  in its client script. For an example of a widget like this, see the Form 
widget. For more information about cloning widgets, see Clone a widget.

Note: 
Base system widgets are read-only so you can benefit from future updates. To make 
changes, you can clone base system widgets. However, cloned widgets are considered 
custom and don't benefit from future updates to the widgets they were cloned from.

Role required: sp_admin or admin

About this task
By default, portal users can add attachments on many base system pages by selecting the 

Add attachments icon ( ) to open the Add attachments dialog box. With a drag-and-drop 
attachments zone, portal users can add attachments with fewer clicks. For example, you could 
drop attachments over an area of a catalog request or a form.

In this example, the zone is an area over the body of a form widget. The zone is only visible when 
moving a file over it.
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Attachment zone over a widget

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Widget Editor.

3. In the Edit an existing widget menu, select the widget you cloned to add the attachment zone 
to.

4. In the HTML Template  of the widget, add the sp-attachment-picker attachment-
handler="attachmentHandler"  directive as an attribute of a <div>  or <section> 
element.
The zone can include the entire widget or only part of it.

Example 

<div sp-attachment-picker attachment-handler="attachmentHandler">

5. Optional:  Configure attributes for the sp-attachment-picker  directive.

◦ disable-picker-overlay="true": Turns off showing an overlay over the 
attachment zone when you drag a file over it. By default, the overlay is enabled.

◦ onFilePick: Implements custom logic by triggering an event when any file is picked. 
Set the value to a function that takes in the references of all the selected files as an array 
as the first parameter. For example, on-file-pick="attachFiles($files)". 
Examples of custom logic that could be implemented include previewing the files, custom 
validations, or custom upload logic. If this attribute is configured, the attachment-
handler="attachmentHandler"  attribute isn’t needed and can be removed.

6. Optional:  Hide the attachment zone on mobile devices.

a. Add the ng-if="isDesktopBrowser"  directive to the sp-attachment-picker 
directive.

Example 

<div sp-attachment-picker attachment-handler="attachmentHandler" ng-if="isDesktop
Browser">

b. In the Client Script  of the widget, add the following script.
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Example 

$scope.isNative = cabrillo.isNative();
$scope.isMobileBrowser = spUtil.isMobile() 
 && !$scope.isNative;
$scope.isDesktopBrowser = !$scope.isNative 
 && !$scope.isMobileBrowser;

7. Select Save.

Result
On a page with the widget, you can drag one or more selected files over the attachment zone 
and drop them to attach them to the record.

Add an attachments section to a widget

Allow portal users to paste, drop, or navigate to files in a section of a widget to quickly attach files 
to a record.

Before you begin
To configure an attachments section in a widget, you must clone or create a widget that 
supports adding attachments by calling attachmentHandler  set to an instance of 
nowAttachmentHandler  in its client script. For an example of a widget like this, see the Form 
widget. For more information about cloning widgets, see Clone a widget.

Note: 
Base system widgets are read-only so you can benefit from future updates. To make 
changes, you can clone base system widgets. However, cloned widgets are considered 
custom and don't benefit from future updates to the widgets they were cloned from.

Role required: sp_admin or admin

About this task
By default, portal users can add attachments on many base system pages by selecting the Add 

attachments icon ( ) to open the Add attachments dialog box. With an attachments section, 
portal users can add attachments with fewer clicks.

In this example, the attachments section is added to the bottom of a catalog item widget.
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Attachment section in a widget

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Widget Editor.

3. In the Edit an existing widget menu, select the widget you cloned to add the attachment 
section to.

4. In the HTML Template  of the widget, add the sp-attachment-picker  directive as an 
element where you want the attachments section to appear.

Example 

<sp-attachment-picker attachment-handler="attachmentHandler"></sp-attachment-pick
er>

5. Optional:  Configure attributes for the sp-attachment-picker  directive.

◦ disable-picker-overlay="true": Turns off showing an overlay over the 
attachment section when you drag a file over it. By default, the overlay is enabled.

◦ onFilePick: Implements custom logic by triggering an event when any file is picked. Set 
the value to a function that takes in the references of all the selected files as an array as the 
first parameter. For example, on-file-pick="attachFiles($files)". Examples of 
custom logic that could be implemented include previewing the files, custom validations, or 
custom upload logic.

6. Optional:  Hide the attachment section on mobile devices.

a. Add the ng-if="isDesktopBrowser"  directive to the sp-attachment-picker 
directive.

Example 

<sp-attachment-picker attachment-handler="attachmentHandler" ng-if="isDesktopBro
wser"></sp-attachment-picker>
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b. In the Client Script  of the widget, add the following script.

Example 

$scope.isNative = cabrillo.isNative();
$scope.isMobileBrowser = spUtil.isMobile() 
 && !$scope.isNative;
$scope.isDesktopBrowser = !$scope.isNative 
 && !$scope.isMobileBrowser;

7. Select Save.

Result
On a page with the widget, you can paste or drop one or more selected files over the attachment 
section to attach them to the record.

Note: 
Pasting attachments isn't supported on Firefox.

Configure Service Portal  Approval Configuration record

Configure the Service Portal  Approval Configuration record to make the Approval assistance AI 
agent and Approval Info Record widget work better for your specific use case.

Before you begin
Role required: admin or sp_admin

Note: 
Now Assist  support for portals includes all pages within the portal.

To define how a search query should be formed for checklist generation, configure the Service 
Portal  Approval Configuration for a table.

The sc_request and sc_req_item tables are provided by default in Approval Configuration. You 
can configure additional tables to go through the approval workflow.

You can select the display fields that you want the AI agent to display in the results, such as 
a short description, opened by, and requested for. The display field order also applies to the 
Approval Info Record widget. You can add, change, or remove display fields for both the Approval 
assistance AI agent and the Approval Info Record widget.

The checklist uses KB articles and policies to assist the Approval assistance AI agent in decision 
making. The checklist fetches information from knowledge base articles about specific requester 
approval tickets. All fields that are available from the approval configuration can be used by 
the Approval assistance AI agent. If you do not configure a table for the AI agent, the Approval 
assistance AI agent uses the default fields.

Approval Configuration

Configuration Type Description

*Name String The specific name of a table.

*Table Drop down list You can choose to configure 
additional tables to go through 
the approval workflow.
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Approval Configuration  (continued)

Configuration Type Description

Application Auto populated You can choose an 
application scope, such as 
Global or Now Assist Agent for 
Requester.

*Active Check box Active is selected by default. 
If you clear the Active check 
box, then the configuration for 
this table will be disabled.

Display Fields Configuration Tab Display fields represent the 
information that the Approval 
assistance AI agent and 
Approval Info Record widget 
presents to the requester.

Gen AI Checklist & KB Search Tab Defines the table for which 
the approval checklist is 
generated and configures the 
Knowledge Base search fields 
used to build search queries 
for relevant articles.

Conditionally Drop down list Set the conditions that the 
records must meet to generate 
the approval checklist. For 
example: Short description 
> starts with  > Tuition 
reimbursement.

Configuring the Approval Configuration record

To better control the table records that go through the approval workflow, configure the fields that 
you want to show in the Service Portal Approval Info Record widget and the Approval assistance 
AI agent.

Procedure

1. Navigate to All  > Service Portal  > Approval Configurations.

2. Modify an existing record, or click New.

3. Click the Display Fields Configuration  tab.

4. Click Display 

fields.
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5. Move the display fields from the Available  list to the Selected  list.

6. Use the arrows to change the order of the display fields.

Note: 
The order of the display fields are also reflected in the Approval Info Record widget.

7. Click the Gen AI Checklist & KB Search  tab.

8. In the Approval checklist list, select one of the following options.

9. Click KB search fields. 

10. Move KB search fields from the Available  list to the Selected 

list.

11. Click Update.

Using portal widgets

Widgets are what define the content of your portal pages. You can use the base system widgets 
provided with Service Portal, clone and modify widgets, or develop custom widgets to fit your 
own needs.

https://player.vimeo.com/video/1085023120?
h=bd4199fd16&badge=0&autopause=0&player_id=0&app_id=58479

When you create or update a page in the Service Portal  Designer, you easily add widgets by 
searching in the widget filter and dragging a widget onto the page. You can also access all widget 
records from the platform at All  > Service Portal  > Widgets.

Base system widgets

You can use the base system widgets included with Service Portal  to get started configuring 
portal pages. Base system widgets are read-only so you can benefit from future updates. 
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However, for each instance of a base system widget that you add to a page, you can configure 
the instance options available for that widget.

For a list of base system widgets and information about their instance options, see the Widget 
library.

Widget instances

When you add a widget to a page using the Service Portal Designer, it creates a widget instance. 
A widget instance is a reference to a widget that contains a location, properties, and CSS specific 
to that instance. Adding the same widget multiple times to the same page creates multiple 
instances.

All widget instances point to a widget. If you edit that widget, all of its widget instances receive 
that change as well. You can also make changes specific to a widget instance, and only that 
widget instance is affected.

For example, the following image includes four instances of the base system Icon Link widget 
with different configurations specific to each instance.

Icon link widgets

Note: 
For widgets that do not contain any information by default, you must configure the options 
for their widget instances before they will appear on a portal page.

Widget context menu

From any rendered Service Portal page, you can CTRL+right-click a widget to see more 
configuration options in a context menu.

For example, navigate to Service Portal  > Service Portal Home  to open a sample portal page. 
CTRL+right-click Knowledge Base on that page.
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Widget context menu

Note: 
You must have the admin or sp_admin role to see the widget context menu. When you 
impersonate a user without one of those roles, you can still see the menu. However, a 
regular user signed in without those roles can’t see the menu.

Widget context menu options

Option Description

Widget performance How long it takes for a widget to load

Instance options Specify an instance of a widget. Widgets instance options vary 
depending on the widget that you select. For example, the instance 
options for the cool clock widget include different time zones for 
each instance, so you can have the same clock four times on a 
page, but with all different time zones.

Instance in Page Editor Opens that instance of the widget in the Page Editor

Page Designer Opens the widget in the Service Portal Designer, which lets you 
add containers, columns, and widgets. You can add styling from the 
Service Portal Designer to the widget or to the page the widget lives 
on.

Show Widget 
Customizations

Shows customization levels of widgets on the page so that you 
can diagnose page issues. For more information, see Widget 
diagnostics.
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Widget context menu options  (continued)

Option Description

Edit Container 
Background

Edit the layout in which the widget is located.

Widget Options Schema Define the options that you can select for an instance of a widget. 
For more information on configuring your own instance options, see 
Widget option schema.

Widget in Form Modal Opens the widget form in a pop-up window so you can make quick 
changes to the widget.

Widget in Editor Opens the widget in the Widget Editor. You can use the Widget 
Editor to configure HTML templates, CSS, client scripts, service 
scripts, and demo data for the widget.

Log to console: 
$scope.data

The $scope.data object passes data from the server to the client-
side controller. Instead of adding console.log messages or alerts 
into the controller code, you can log the $scope.data object to the 
browser console and view the data there.

Log to console: $scope Similar to the $scope.data object, except it logs everything in 
$scope to the console.

Custom widgets

Base system widgets are read-only so you can benefit from future updates. To make changes, 
you can clone base system widgets. However, cloned widgets are considered custom and don't 
benefit from future updates to the widgets they were cloned from.  You can also create widgets 
from scratch. To learn more about cloning or creating widgets, see Developing custom widgets.

Configure widget instances

Create unique instances of widgets by configuring the options for each instance.

Before you begin
Create or edit a portal page and add widgets to it. You can also configure the existing widget 
instances on a base system page. For more information, see Create and edit a page using the 
Service Portal Designer.

Role required: sp_admin or admin

About this task
You can have several instances of the same widget on a page, and each instance of the widget 
you configure remains unique. For example, each instance of the Cool Clock widget  on a page 
could use a different time zone.

Each time you add a widget to a page it creates a record on the Widget Instances [sp_instance] 
table with the following information:

• A reference to the widget

• A reference to the column of the page where the widget is located

• The configuration for a widget in the form of pre-defined form fields and an Additional Options 
field in JSON format
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Note: 
For widgets that do not contain any information by default, you must configure the options 
for their widget instances before they will appear on a portal page.

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Designer.

3. Select the page with the widget instance(s) you want to configure.

4. In the Service Portal Designer, move to a widget instance and select the Edit icon ( ).

5. In the instance options window, fill in the fields to configure the widget instance.
Instance options vary depending on which widget you select.

6. Select Save.

Example: Configure widget instance options

What to do next
Advanced users can define what options are available for a widget. For more information, see 
Widget option schema.

Widget library

You can use base system widgets as-is in your Service Portal  or clone them to suit your own 
business needs.

Note: 
Base system widgets are read-only so you can benefit from future updates. To make 
changes, you can clone base system widgets. However, cloned widgets are considered 
custom and don't benefit from future updates to the widgets they were cloned from.  To learn 
more about cloning or creating widgets, see Developing custom widgets.

Due to the ever-changing number of widgets that exist at any given time in Service Portal, this 
widget library is not a definitive list. You can find more widget descriptions as they become 
available. To view and configure the instance options for a widget, see Configure widget 
instances.
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Example widgets

• Announcements widget

• Approvals widget

• Approval Info widget

• Approval Record widget

• Breadcrumbs widget

• Breakout Game widget

• Calculator widget

• Carousel widget

• Cool Clock widget

• Documents widget

• Header menu widget

• Hello World widgets

• HTML widget

• Icon Link widget

• Icon menu list widget

• Language Switch widget

• Link button widget

• Login widget

• My Requests widget

• Organization Chart widget

• Sample Footer widget

• Ticket Attachments widget

• Ticket Conversations widget

• Ticket Fields widget

• Ticket Location widget

• User Profile widget

Service Catalog  widgets

• Catalog Content widget

• Catalog Homepage Search widget

• Recent & Popular Items widget

• Request Fields widget

• Requested Items widget

• Requests and Approvals widget

• SC Catalog Item widget

• SC Categories widget

• SC Category Page widget
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• SC Order Guide widget

• SC Popular Items widget

• SC Save Bundles widget

• SC Saved Carts widget

• SC Scroll to top widget

• SC Shopping Cart widget

• SP Variable Editor widget

• SC Wish List Cart widget

Knowledge Management  widgets

• KB also in Category widget

• KB Article Comments widget

• KB Article Page widget

• KB Categories widget

• KB Category Page widget

• KB Knowledge Bases widget

• KB Most Viewed widget

• KB News widget

• KB Search widget

• KB Top Rated widget

• KB View widget

• KB View 2 widget

• Knowledge Breadcrumbs widget

Service Status widgets

• Business Service Status widget

• Current Status widget

• Planned Maintenance widget

• Service History widget

• Service Status widget

• Service Status Legend widget

• Service Status Subscription widget

Service Portal  configuration widgets

• Service Portal Config Overview widget

• Portal config widget

• SP Page Map widget

• SP Portal Map widget
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• Theme Preview widget

• Widget Edit Panel widget

List and form widgets

• Simple List widget

• Data table from instance definition widget

• Data Table from URL definition widget

• Form widget

Search widgets

• AI Search Assist widget

• Contextual Search widget

• Faceted Search widget

• Homepage Search widget

• Typeahead Search widget

• Legacy: Search Page widget

Example widgets

All widgets in Service Portal can be used as example code for how scripts are used in a widget. 
However, several base system widgets have been included expressly for this purpose.

Use the example widgets to see how to use HTML, CSS, or client and server scripts in Service 
Portal. You can also clone and extend each widget to suit your needs.

Announcements widget

Users can view all active announcements. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

This widget lists the active announcements for a portal from the Announcement [announcement] 
table. To see the list of active announcements, navigate to All  > Service Portal  > 
Announcements. For information about creating announcements, see Create an announcement.

Announcements widget
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Instance options

Field Description

Type Select the type of announcements to display. Announcement types can be 
selected in the announcement record. Choices include:

• Banner

• Widget

If a type is not defined, the widget instance displays all active 
announcements.

Title Widget header title.

Glyph Glyph displayed to the left of the title.

Use Display Style If selected, each announcement displays according to the style defined in 
the announcement record. Before selecting this option, consider how the 
widget will display if multiple announcements in the widget use different 
styles.

Paginate Paginates multiple announcements.

Max Records Number of announcements displayed per page.

View All Page Click target for View all  link. The View all  link only displays when:

• There are more announcements than can be displayed on a single page. 
The Max Records  field defines the number of records displayed per 
page.

• A view all page is defined.

Who Can View 
Instances | Who 
Cannot View 
Instances

Control who can and cannot view a widget instance with user criteria. Only 
visible if user criteria for the Service Portal  is activated.

Approvals widget

Users can approve or reject items directly within Service Portal. You can use this base system 
widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The Approvals widget displays data from the Approvals [sysapproval_approver] table. If the user 
has been assigned to approve a request, the approval record is displayed in the widget.
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You can enable e-signature for the approvals widget to require reauthentication for your users. 
For more information on enabling e-signature, see Enable e-signature for Service Portal.

Instance options

Use the instance options to change the appearance of the approvals widget.

Approvals widget instance options

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Glyph Add an icon to display beside the widget 
name.

Buttons stacked side by side If this check box is selected, the Approve and 
Reject buttons appear horizontally beside 
each other. If this check box is cleared, the 
Approve and Reject buttons appear stacked 
vertically.

Max number of elements shown in the list Limit the number of approvals users see on 
a page. The default number is 10. Only enter 
numbers greater than 0.

Who can view instances/who cannot view 
instances

Control who can or can’t view a widget 
instance with user criteria. User criteria must 
be enabled for this option to appear.

Comments mandatory for rejection Require approvers to provide comments 
when rejecting an approval. The comments 
are added to the Approval record. By default, 
providing comments is optional.

Approval Info Record widget

The Approval Info Record widget shows details about the approval request and a full record for 
an approval including the activity stream.
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Using the widget

Approval Info Record widget

Configure the field values and the order of the fields from Service Portal  Approval Configuration. 
For more information, see Configure Service Portal Approval Configuration record.

Instance options

Approval Info Record widget instance options

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Approval Info widget

The Approval Info widget works in tandem with the Approval widget to display details about the 
approval request. You can use this base system widget as-is in your portal or clone it to suit your 
own business needs.
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Approval Info widget

Instance options

Approval info widget instance options

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Approval Record widget

The Approval Record widget shows the full record for an approval including the activity stream. 
You can use this base system widget as-is in your portal or clone it to suit your own business 
needs.
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Approval Record widget

Instance options

The approval record widget does not include instance options.

Breadcrumbs widget

The breadcrumbs widget allows users to easily navigate around a portal. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The breadcrumbs widget displays information based on where a page is located in a portal. For 
example, if you navigate to the Knowledge Base from the home page, then the breadcrumb reads 
as Home  > Knowledge Base. Each subsequent page that you open expands the breadcrumb.

Click a page name on the breadcrumbs widget to navigate to that page. For example, to return to 
the home page, click Home.

You can customize this widget to change the breadcrumb path. For more information, see 
KB0719179 .

Instance options

The breadcrumbs widget does not have instance options.
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Breakout Game widget

Add a fun, interactive 404 page to pages that do not exist using the Breakout Game widget. You 
can use this base system widget as-is in your portal or clone it to suit your own business needs.

Breakout Game widget

Instance options

The Breakout Game does not have instance option. You can use it as an example of how to use 
the Link Function as part of an Angular Directive.

Calculator widget

The calculator widget does simple calculations. You can use this base system widget as-is in 
your portal or clone it to suit your own business needs.

Use the calculator widget as an example of how to pass data between the client and server.
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Calculator widget

Instance options

The calculator widget does not include instance options.

Carousel widget

Showcase specific items in your catalog using a scrolling list of images in the carousel widget. 
You can use this base system widget as-is in your portal or clone it to suit your own business 
needs.

Use the carousel widget to showcase items on your portal page. For example, display items 
available in a service catalog at the top of the service catalog page.
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Carousel widget

Note: 
For Employee Center Pro, use Content Experiences widget to showcase actionable 
communications content on your employee portal. .

Add slides to the carousel widget

Use the related lists for an instance of the carousel widget to add images for the carousel widget 
to scroll through.

Before you begin
Role required: Admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Widgets.

2. Open the Carousel  widget record.

3. From the carousel form, on the Instances  related list, under instances, open a carousel 
instance.

4. From the instance of carousel form, click New  on the Carousel Slides  related list.

5. Complete the form.

Field Description

Name Name of the carousel slide. Use the name 
to differentiate the slide from other slide 
records.
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Field Description

Order Where the slide appears in the list of slides

HREF/URL Link to the item in the slide. For example, for 
a slide with a catalog item, link to page for the 
catalog item using the HREF ?id=<page 
name>&sys_id=<sys_id for item>. 
For more information on linking to a page 
within a portal, see Page navigation in 
Service Portal by URL. You can also link to 
other sites using the URL.

Background Upload an image for the slides. Carousel 
images should be 1022x300 pixels.

Application Automatically populated with the name of the 
application the portal falls under.

Carousel Name of the instance of the carousel widget 
you are adding the slide to. This field is not 
automatically populated and you cannot 
select an instance of the carousel widget if it 
does not have a name.

Repeat this step for as many slides as you want to appear in the carousel widget.

Change Password widget

Users can change their passwords using the Change Password widget.

Change Password widget

Note: 
Updated credentials are stored in the User [sys_user] record in the local instance.
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Instance Options

The Change Password widget does not have instance options.

Cool Clock widget

Show different times around the world using the Cool Clock widget. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.

Cool clocks demonstrates how to use instance options in a widgets. The time zone is loaded 
using an instance option. If you do not select a time zone, the widget uses a default time zone.

Cool Clock widget

Instance options

Cool clock widget instance options

Field Description

Title Name of the clock, for example New York, NY. 
The name appears below the clock so it helps 
to use a name related to the time zone.

Timezone The location from which the time is displayed. 
Use the local full name, for example, America/
New York, instead of the abbreviated time 
zone. Using the full name allows time zones to 
stay consistent with daylight savings time. The 
default value is America/Los Angeles

Second hand color Color of the second hand using the hex code, 
RGB, or color name. The default value is red.

Data table from instance definition widget

Display a filtered list on your portal using the data table from instance definition widget. From 
the widget's context menu, portal users can export the filtered list. You can use this base system 
widget as-is in your portal or clone it to suit your own business needs.

After you add the data table from instance definition widget to a page, use the instance options 
to configure the appearance of the table.
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Data table from instance definition widget

Note: 
If you want this widget to be accessed by guest users, you must select the Public  option in 
the widget record for both this widget and the Data Table widget.

Instance options

Data table instance options

Field Description

Table The table that the widget displays records from.

Filter Text field from the condition builder that you can use to limit the items returned in 
the table. To create a filter, use the context menu to open the widget instance in the 
platform. Then use the condition builder to create a filter.

Fields Columns to display in the table.

Maximum 
entries

Limits the number of items displayed in the table. If there are more entries than 
allowed in the table, users can scroll to the next page.

Order by The table field used to order items.

Order 
direction

The direction to order items: ascending or descending.

Title The title of the widget. If you leave this field empty the name of the table displays as 
the widget name.

Bootstrap 
color

Color scheme for the widget. The default colors are defined by the portal theme, but 
if you want the instance to have a specific color, select the option from the list.

Glyph Icon that displays beside the widget title.

Bootstrap 
color

Color scheme for the widget. The default colors are defined by the portal theme, but 
if you want the instance to have a specific color, select the option from the list.
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Data table instance options  (continued)

Field Description

Link to 
this page

Direct users to a specific page when they click a record. By default, clicking an entry 
in the table opens that entry in a form.

Data Table from URL definition widget

The Data Table from URL definition widget displays the table you select from the list. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Data Table from URL definition widget

Note: 
If you want this widget to be accessed by guest users, you must select the Public  option in 
the widget record for both this widget and the Data Table widget.

Instance options

Complete the instance options to define the table.

Field Description

Title The title of the widget. Select the Use Instance Title  check box to use this title 
instead of the name of the table.

Glyph Icon that displays beside the widget title

Bootstrap 
color

Color scheme for the widget. The default colors are defined by the portal theme, but 
if you want the instance to have a specific color, select the option from the list.

Link to 
this page

Direct users to a specific page when the click a record. By default, clicking an entry 
in the table opens that entry in a form.

Fields Columns to display in the table. For example, short description or priority.

Use 
Instance 
Title

Select to use the title in the Title field instead of the table title

Enable 
Filter

Select this check box to allow users to create their own filter for the table

Note: 
Data Table from URL Definition widget instances do not support Maximum entries.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

813



If Enable filter  is enabled in the instance options, users can add custom conditions to filter the 
results.

Data Table URL with condition builder

For more information on using the condition builder, see Create a filter in List.

Note: 
The condition builder is only available in the desktop view.

Documents widget

You can add, edit, or delete documents associated with records based on user permissions 
through the Documents widget. You can use this widget in your portal or clone and customize it.

Note: 
The Documents widget is available with the Multi Provider Document Services Framework 
plugin (com.snc.multiprovider_documents). For more information, see Multi Provider 
Document Services Framework .

Add, edit, and delete documents related to a record with the Documents widget. You can drag 
and drop multiple files at a time, including editing and adding new versions. The default version 
shown is the latest version.

The maximum document size is 100 MB and concurrent uploads should be less than 10 MB.

Note: 
External users don’t have permission to share documents, review or approve documents, or 
access records in the platform.
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Related Documents widget

Configure the Related Documents widget

Configure the Related Documents widget for records.

Related Documents widget

Fields Description

Record ID Sys_id of the record for which the documents 
are listed.

Record table Table name of reference record.

Title Title of the related document widget. The 
default title is Documents.

Popup before upload Select this option to provide a dialog box to 
enter document details and description for a 
single file.

Note: 
This option doesn’t appear if multiple 
files are selected.

Metadata form view The configured form view to be opened when 
Edit Document  is selected or while uploading 
a single file. By default, the dw  form view is 
selected. This form contains only Name  and 
Description  fields.

Form widget

The form widget is a platform form within the Service Portal  UI with a few differences. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.
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Form widget

URL Parameters

The form widget accepts the following parameters within the URL. Add these parameters to the 
page URL to display a specified record with the form widget.

Form widget URL parameters

Parameter Description

sys_id  or 
sl_sys_id

Sys_id for the record to be displayed.

table, 
sl_table, 
or t

Table for the record to be displayed.

The form widget validates access to the table by checking for the 
necessary cross-scope privileges when fetching data from the 
table. To turn off validating cross-scope privileges, you can set the 
glide.service_portal.enforce_cross_scope_check_in_form 
system property to false. For more information, see Service Portal properties.

view  or v View used to display the record.

In the following example, the URL would display an incident with a sys_id of 
1c741bd70b2322007518478d83673af3 in the portal view:

https://example.service-now.com/sp?
id=form&table=incident&sys_id=1c741bd70b2322007518478d83673af3&view=portal

Note: 
Timer fields, such as Time Worked, don’t display correctly in Service Portal. For more 
information and a workaround, see the Timer fields do not display the correct data in 
Service Portal [KB0752404]  article in the Now Support Knowledge Base.
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Scripting

Not all client scripts are supported in the Service Portal. To understand how client scripts interact 
with forms in the Service Portal, see Service Portal and client scripts  and Supported client script 
types and APIs.

Header menu widget

The Header Menu widget controls which options appear in the page header. You can use this 
base system widget as-is in your portal.

Unlike other widgets in Service Portal, the header menu widget is not something you drag onto a 
page. Instead you configure the header menu by associating the header menu with a portal. For 
more information on configuring a header menu, see Configure a portal header menu.

Note: 
Cloning this widget is not supported. For more information, see the Header widget with 
sp_ng_template templates cannot be cloned easily [KB0697352]  article in the Now 
Support Knowledge Base

Instance options

The header menu widget does not include instance options.

Hello World widgets

The Hello World widgets are included with Service Portal  as examples of how to use and create 
widgets. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

All three Hello World widgets display the same way. The real difference between them is in their 
underlying code base. Each version of the widget uses a different method of using the server 
and client script.

To view the Hello World widgets, navigate to Service Portal  > Service Portal Configuration  then 
click Widget Editor. In the Widget Editor, click Check out the Hello World Example.

Hello World 1
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Hello world 1 displays how the HTML template and the client script communicate. For more 
information on using the client script in Service Portal, see Developing custom widgets.

Use the widget list to switch to Hello World 2 or 3.

Hello World 2

Hello World 2 includes an example of how the server script can be used as well.

Hello World 3

For more information on Service Portal  APIs, see the GlideSPSriptable API .

HTML widget

Use the HTML widget to directly inject HTML, text, lists, or content in general into a page. You can 
use this base system widget as-is in your portal or clone it to suit your own business needs.

Because the HTML widget can contain content of any kind, any example may just appear as 
regular text. For example, the HTML widget appears as a box of text on the 404 page.
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HTML widget

Instance options

HTML widget instance options

Field Description

Title Name for the HTML text. Users do not see this 
information.

HTML Text box for the HTML. Use the toolbar 
like most word processing tool bars. For 
more information on using the toolbar, see 
Formatting icons for the HTML field editors  .

Icon Link widget

Link to any other item. You can use this base system widget as-is in your portal or clone it to suit 
your own business needs.

Configure Icon Link widgets to link to a specific URL, page within the portal, or a specific category 
in the knowledge base or the service catalog.

Icon Link widget

Instance options

Instance options fields

Field Description

Title Name of the icon link. Choose something that 
defines what the widget is linking to.

Glyph Icon for the widget.
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Instance options fields  (continued)

Field Description

Bootstrap class name Use concurrently with page or theme level 
CSS.

Type Defines what the widget links to. The fields that 
appear on the form vary depending on which 
option you select. Choose from:

• Page: Another page in the Service Portal

• URL: Link to an external website.

• Catalog category: Link to a specific catalog 
category within the service catalog.

• Catalog item: Link to a specific catalog item.

• KB topic: Link to a KB topic page.

• KB article: Link to a KB article by number.

• KB category: Link to a specific KB category 
within the knowledge base.

Page Page within the portal that you want to link to. 
This field varies depending on the Type  you 
choose.

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Template The appearance of the link icon widget. 
Choose from:

• Top icon

• Circle icon

• Color box

Icon menu list widget

A simple list with a glyph icon next to each link. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

Configure the icon information using the Menu Items related list.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

820



Icon Menu list widget

1. From the instance options for the icon menu list widget, under Related Lists, click Menu Items.

2. Click New.

3. Use the fields on the New Menu Items form to configure the icons for the icon menu list widget.

Icon menu list widget instance options

Field Description

Label Name or description of the icon

Parent 
Menu

The name of the menu that the icon appears in. This automatically populates with 
the name of the icon menu list widget that you created but you have the option to 
switch it to another menu.

Order The order in which the icons appear in the icon menu list widget.

Parent 
menu 
Item

Nest menu items within a parent menu.

Page The page within Service Portal that the icon links to. Select Page  from the Type list to 
enable this option.

Type Select the type of link you want the icon to have. You can link to pages within 
Service Portal, external URLs, KB articles, Service Catalog, or lists. Different fields 
will appear on the form depending on the option you select from the list.

Condition Determines what conditions are required for menu items to show in the header. For 
more information on what conditions to use in the Condition  field, see Create a UI 
Action  Create a UI action .

Glyph Icon that you want to display in the icon menu list widget.

Language Switch widget

Add the Language Switch widget to a landing or homepage to allow your users to change the 
language of the page. You can use this base system widget as-is in your portal or clone it to suit 
your own business needs.
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Language Switch widget

Instance options

The Language Switch widget does not include any instance options.

Link button widget

The Link Button widget is a button you can nest in any other widget that links to another 
destination. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

Link Button widget

Instance options

Instance option fields

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Link for button Page that the button links to. Use ?
id=<page_name> to link to another page in the 
portal.

Contents of button The button text.

Login widget

The login widget controls user access to your site. You can use this base system widget as-is in 
your portal or clone it to suit your own business needs.

Using the widget

Users log in to a portal by entering their credentials in the login widget.
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The widget uses credentials from the User [sys_user] record. In the User name  field, the user 
enters the User ID  from their user record. In the Password  field, the user enters the password 
from their user record.

Login widget

The login widget by default includes a Forgot Password?  link that enables users to reset their 
password using the Password Reset  application. For more information about Password Reset 
configuration, see Password Reset .

Note: 
When the user selects Forgot Password?, the system redirects the user to the page value 
specified in the glide.security.password_reset.uri  system property.

If you don't want to include the Forgot Password?  link, set the 
glide.security.forgot_password.display.link  system property to false.

External user self-registration

External user self-registration enables a large group of users to register to a ServiceNow  app 
without the help of an administrator. Users register to the app via a link at the bottom of the login 
widget screen that says ""Don't have an account? Register".
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For more information on external user self-registration, see Enable external users to self-register 
to your ServiceNow  instance .

PIV/CAC authentication

With certificate-based authentication activated in your instance, users can register their Personal 
Identity Verification (PIV) or Common Access Card (CAC) card for Service Portal  login.

After self-registering their PIV/CAC card, a user can log in by inserting their card into a card 
reader and then selecting Login with PIV/CAC card  on the login widget.
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Before a user can register their PIV/CAC card, an administrator must activate certificate-based 
authentication and then set up PIV/CAC authentication. For more information on this setup 
process, see Personal Identity Verification (PIV) card or Common Access Card (CAC) based 
authentication .

For more information on how a user self-registers their PIV/CAC card, see Register your PIV/CAC 
card for Service Portal login.

Instance options

Use the instance options to configure the login widget for a portal page.

Field Description

Show panel Show or hide the panel that appears behind the login widget. The 
panel helps the widget stand out from the page background rather 
than blending in.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

825

https://www.servicenow.com/docs/access?context=certificate-based-authentication&version=zurich&pubname=zurich-platform-security&ft:locale=en-US
https://www.servicenow.com/docs/access?context=certificate-based-authentication&version=zurich&pubname=zurich-platform-security&ft:locale=en-US
https://www.servicenow.com/docs/access?context=certificate-based-authentication&version=zurich&pubname=zurich-platform-security&ft:locale=en-US
https://www.servicenow.com/docs/access?context=certificate-based-authentication&version=zurich&pubname=zurich-platform-security&ft:locale=en-US


Field Description

Use Advanced View Changes the widget layout. Adds the Forgot Password?  link to the 
left of the Login  button and adds field names for User name  and 
Password  instead of hint text.

My Requests widget

The My Requests widget stores all of your open requests in one place. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.

The list is updated in real time so you can see your requests getting processed. The widget pulls 
open request information from the sc_request table.

My Requests widget

Search requests by entering a complete word or record number in the search bar.

Instance options

Instance options fields

Field Description

Title Name of the widget. The name you enter here 
appears in the header for the widget.

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Maximum entires The maximum number of entries allowed to 
appear in the widget.

My Requests widget

Use the My Requests widget (my-requests-v2) to enable requesters to view open or closed 
requests in Service Portal.

Requests, incidents, and tasks are displayed in a single view that is based on the filter conditions 
and display settings in the My Request Filter module. For information about defining filters for 
this module, see Define filters for My Requests .
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My Requests widget

Search requests by entering a complete word or record number in the search bar.

Instance options

Use the widget instance options to customize the settings for the My Requests widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the My Requests widget

Field Description

Presentation

Title Title of the widget.

Behavior

Show 
View

If selected, displays the View  list. Using this list you can filter for closed or open 
requests. If deselected, only open requests are displayed.

Items 
per 
page

Number of records displayed per page.

Enable the My Requests menu for an upgrade scenario

Enable the My Requests menu that uses the My Requests (my-requests-v2) widget for an 
upgrade scenario.

Before you begin
Role required: admin

About this task
The My Requests menu that is based on the My Requests (my-requests-v2) widget is available 
by default for zBoot users. For more information about this widget, refer to My Requests widget.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select a portal.

3. Next to the Main menu  field, click Preview this record  and open the record.

4. In the Menu items related list, perform the following steps.

a. For the Requests  menu item of the Page  type, set Active  as true.

b. For the Requests  menu item of the Scripted List  type, set Active  as false.
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5. Navigate to Service Portal  > Page Route Maps.

6. For the My Request  page route map, set Active  as true.

7. Click Update.

Organization Chart widget

The Organization Chart widget shows employees in a tree structure relative to their manager. You 
can use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

In the text input field, enter or select a user to see their manager and subordinates. The widget 
uses information from the User [sys_user] record to display the organization hierarchy relative to 
the selected user.
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Click a card to open the profile page for that user. To reconfigure the card link, change the URL  or 
Page  in the widget instance options.

You can drag individual cards to rearrange the chart.

You can zoom in or out of the chart view by clicking the magnifying glass icons or by scrolling.

Instance options

Use the instance options to configure the Organization Chart widget for a portal page.
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Note: 
There are no valid values for several instance options. By default, you can set only the 
following instance options:

• User Background Color

• Node Background Color

• URL

• Page

Field Description

Data

Card Fields
Fields from the user record that appear on each card. By default, each 
card displays the name, title, department, email, phone, and location of 
each user.

There are no valid values that you can enter in this field.

Presentation

User Background 
Color Color of the user card. Use color names or Hex codes. For example, 

you can enter red  or ➚ff0000.

The user background color is lightblue  by default.

Node Background 
Color Color of cards that extend from the user card. Use color names or Hex 

codes. For example, you can enter yellow  or ➚ffff00.
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Field Description

The node background color is azure  by default.

Table Layout
Size and margin of the content in each card.

There are no valid values that you can enter in this field.

Row Layout
Alignment of the text in the card. The text is left-aligned by default.

There are no valid values that you can enter in this field.

Line
Color of the lines that connect cards. The lines are black by default.

There are no valid values that you can enter in this field.

Tree Layout
Size, spacing, and alignment of the chart.

There are no valid values that you can enter in this field.

Picture Layout
Size of image space in each card. By default, the image space is 55x65 
pixels. The user image is shrunk or stretched to fit the space.

There are no valid values that you can enter in this field.

Behavior

URL
Web address of the page that opens when you click a card. Use the 
part of the portal URL that references the page ID. For example, to 
navigate to the Service Catalog, enter ?id=sc_category.

If left blank, clicking the card opens the page that is specified in the 
Page  field. If the Page  field is also blank, clicking the card opens the 
user profile page by default.
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Field Description

Page
Portal page that opens when you click a card. Use the page ID.

If left blank, clicking the card opens the web address in the URL  field. 
If the URL  field is also blank, clicking the card opens the user profile 
page by default.

Note: 
The URL  field overwrites the Page  field. To specify a page rather 
than a URL, leave the URL  field blank.

Simple List widget

The Simple List widget can be used to display any list in the system within Service Portal. You can 
use this base system widget as-is in your portal or clone it to suit your own business needs.
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Simple List widget
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Instance options

Instance options fields

Field Description

Table The platform table that the simple list is 
formed from.

Filter Conditions that are applied to the list. To 
edit the filter, in the widget instance options 
context menu, select Open in platform. Use 
the Table & Filter tab to apply conditions to the 
simple list. For more information, see Create a 
filter in List.

Display field Main field that displays as the "title" of the list 
item.

Secondary fields Fields from the list item that display in addition 
to the main display field.

List page The page that opens when a user selects 
View all  in the widget footer. Select a page 
that correlates with the items that display in 
the list.

Enforce field-level Read ACLs on Filter query 
terms (may alter the query for unprivileged 
users)

Enforce read ACL rules for fields included in 
filter conditions applied to the list.

Note: 
When the 
glide.service_portal.enable_acls_for_encoded_query_in_list 
system property is set to true, read 
ACLs are enforced for Simple List filter 
conditions always.

Link to this page Portal page to link to from a list item.

Show even when empty Widgets are designed to hide on a page when 
no results meet the criteria. Select this option 
to make the simple list widget display on a 
page even when empty.

View The view option for when a list item links to a 
form. The Link to this page  field must be set to 
a form page for this option to work.

Disable record watcher Turn off automatically updating the list based 
on changes to the filtered records.

Glyph Icon that displays next to the widget name in 
the header

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Bootstrap size Size of the widget
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Instance options fields  (continued)

Field Description

Maximum entries Maximum allowed number of entries that 
appear in the list at one time.

List body height Actual length of the widget in pixels or EMs. 
A long list with a small body height includes a 
scroll bar option.

Image field Displays an image in the list. Select a field type 
that includes an image. For example, Photo.

Rounded images Makes any images selected in the Image field 
round in the list.

Hide footer Show or hide the widget footer

Sample Footer widget

The Sample Footer widget is an example of a footer you can use in your portal. You can use this 
base system widget as-is in your portal or clone it to suit your own business needs.

Unlike other widgets in Service Portal, you add a footer to your portal by configuring it in the 
Theme form. For more information on adding a footer to a portal, see Add a header or footer to a 
portal.

Instance options

The Sample footer widget does not include instance options.

Ticket Attachments widget

Use the attachment widget to attach items to tickets. You can use this base system widget as-is in 
your portal or clone it to suit your own business needs.

Attachments should be less than 24MB. You can drag files into the Attachments widget to add 
them to a record.

Ticket Attachments widget

Instance options

Ticket attachments widget instance options

Field Description

Record ID The ID number of the record for the 
attachment.

Record table Limit the records users can add an attachment 
to by adding a table to the attachment widget. 
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Ticket attachments widget instance options  (continued)

Field Description

Users can then only add attachments if they 
are in a record for that table.

Ticket Conversations widget

Record of ticket items. Users can use this widget to communicate back and forth with the fulfiller 
and the receiver. You can use this base system widget as-is in your portal or clone it to suit your 
own business needs.

The Ticket Conversations widget displays journal entries from the activity formatter of the target 
record. Journal entries are presented in chronological order, with the oldest entries appearing 
at the bottom of the widget. Entries made by the user that created the record appear on the right 
side of the center divider. Entries made by other users appear to the left.

The Ticket Conversations widget is intended only for tables that extend task.

Limit the number of journal entries that appears in the ticket conversation widget using the 
glide.service_portal.stream_entry_limit  system property. The default number is 
100 on a base instance or 500 if the property is not in the System Property [sys_properties] table. 
Change the number by navigating to Service Portal  > Properties, and enter the new number in 
the Maximum number of stream entries displayed in Service Portal  field.

Ticket Conversations widget

Instance options

Instance options fields

Field Description

Use dynamic placeholder Use a placeholder for journal fields. The 
default value is false.

No readable journal field message The message that displays when there are no 
readable journal fields. Forms that have added 
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Instance options fields  (continued)

Field Description

journal fields may not display in the Ticket 
Conversation widget.

Enter key behavior The action to perform when pressing 
the Enter key. The default is to submit 
the entry. The System Property 
option is based on the value of the 
glide.service_portal.comment.enter_adds_newline 
system property.

Ticket Fields widget

The Ticket Fields widget displays information about a request that a user has made. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

After a user submits a request, they can track their request on a ticket page in Service Portal. 
The user can consult the Ticket Fields widget to review the details of their request and check its 
resolution status.

Fields for the Ticket Fields widget are defined by the HTML template and the server.

If a user entered variables when submitting the request, they can view those variables in the 
Options section.
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Note: 
The values that appear in the Options section are not field values from the ticket. They are 
Service Catalog  variables that are associated with the ticket. For more information, see 
Service catalog variables .

Instance options

Use the instance options to configure the Ticket Fields widget for a portal page.

Field Description

Pickup message
Text to communicate the expected resolution time of the ticket. This 
text is displayed below the ticket fields.

The default is ${Tickets are picked up within <br/> 4 
hours (M-F 9-5)}. Ensure that any changes you make are within 
the curly braces.

Ticket Location widget

Share your location in a ticket. You can use this base system widget as-is in your portal or clone it 
to suit your own business needs.
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Ticket Location widget
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Instance options

The Ticket Location widget does not include any instance options.

User Profile widget

Display user profile information. You can use this base system widget as-is in your portal or clone 
it to suit your own business needs.

Users can use the User Preferences section to enable accessibility in a portal.

User Profile widget

Instance options

Instance options fields

Field Description

Show current user Displays the logged-in user within the team 
members list in this widget when viewing 
a team member's user profile. The team 
members list is based on the organization 
chart.

Search widgets

Several search widgets are provided with Service Portal.

You can configure search in Service Portal using any of the search widgets.

AI Search Assist widget

Improve incident deflection for Service Portal  users by displaying the most relevant search 
results within a record producer.
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Using the widget

The widget is included in the Create Incident  record producer form to display items based on 
keywords entered in the description. These items can be knowledge articles or Service Catalog 
items. These search results appear as the user types the information.

AI Search Assist widget

Instance options

The AI Search Assist widget doesn't include instance options.

Contextual Search widget

Contextual Search is an embedded widget that can be added to a record producer and used with 
the SC Catalog Item widget. You can use this base system widget as-is in your portal or clone it to 
suit your own business needs.

By default, the widget is included in the Create Incident  record producer form to display items 
based on keywords entered in the description. These items can be knowledge articles or Service 
Catalog  items. These search results appear as the user types the information.

To use this widget with other record producers, see Define contextual search for the record 
producer .
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Contextual Search widget

Related topics

Contextual search

Faceted Search widget

The Faceted Search widget displays search results and search facets defined for a search 
source. The Faceted Search widget enables end users to filter search results for a more 
meaningful result set.

Using the widget

You can use facet filters to refine your search in Service Portal. For example, you can view only 
knowledge article search results by selecting the Knowledge  source facet bucket. Or, to filter 
search results by certain knowledge categories, you can select one or more facets.
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Filter for Faceted Search widget

The available facets are dynamic, showing only field values that are included in your current 
search results. As you select facets, the search narrows and the number of available facets 
decreases. You can broaden your search by clearing an individual facet selection.

To see which facets you've selected, view the pills in the Filters panel. If you select a different 
source facet bucket, your other selected facets are carried over and applied to your modified 
search.

You can initiate a new search by entering a new search term in the typeahead search box. After 
you enter the new search term, the system clears your facet filter selections from the previous 
search. You can refine your new search by selecting new facet filters.

For more information on configuring the available facets, see Create a facet in an AI Search 
application configuration .

Instance options

Use the instance options to configure the Faceted Search widget for a portal page.

Field Description

Presentation

Facet List Title Display title for the facet component.

Typeahead Search - 
Title

Default text in the typeahead search component.

Typeahead Search - 
Color

Whether the glyph in the typeahead component is filled in.

Typeahead Search - 
Glyph

Icon that appears in the search field beside the widget. The search 
icon is the default. To use a different icon, type the name of the icon 
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Field Description

in the field, for example search-plus. For a list of icons to choose 
from, open the instance options for the Icon Link widget.

Typeahead Search - 
Size

Determines the font size and height of the widget. Choose from xs, sm, 
md, and lg.

Show Typeahead 
Search Box

Option to show or hide the search box on the portal page.

Behavior

Max results for All 
search

Maximum number of results that display for all search sources when 
viewed together.

Max results for single 
search source

Maximum number of results that display for a single search source.

Show Did You Mean Displays suggestions when a search produces no results.

Typeahead Search - 
Limit

Number of typeahead search results displayed. The default is 15.

AI Search

Placeholder
Text that appears in the search box before the user enters anything.  By 
default, the placeholder text is Search.

Note: 
This instance option applies only if AI Search  is enabled in your 
portal. For more information on enabling AI Search  for Service 
Portal, see Enable and configure AI Search in Service Portal.

Homepage Search widget

Add a search bar to your home page. You can use this base system widget as-is in your portal or 
clone it to suit your own business needs.

Homepage Search widget

Instance options

Use the instance options to configure the Homepage Search widget for a portal page.

Note: 
The AI Search  instance options apply only if AI Search  is enabled in your portal. For more 
information on enabling AI Search  for Service Portal, see Enable and configure AI Search in 
Service Portal.
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Field Description

Presentation

Title Name that appears above the search bar. For example "How can we 
help?"

Short description A subtitle that appears below the title.

Typeahead search Controls the appearance of the search bar. Use a comma separated list 
inside curly braces to add style details to the search bar, for example 
{title: 'Search', color: 'blue', size: 'lg'}. For more information on which 
style options you can add, see the instance options for the Typeahead 
Search widget.

AI Search

Search Application
Defines search experience settings for the widget, such as the search 
engine, search results limit, and suggestions limit. By default, the 
widget uses the same search application configuration as the portal, 
but you can override this configuration at the widget level.

For more information on defining a search application configuration, 
see Defining search application configurations .

Search Results 
Configuration Defines how search results are displayed after using the widget. By 

default, the widget uses the same search results configuration as the 
portal, but you can override this configuration at the widget level.

For more information on defining a search results configuration, see 
Define a composite dataset .

Disable All 
Suggestions Option to disable search suggestions.

Placeholder
Text that appears in the search box before the user enters anything.  By 
default, the placeholder text is How can we help?.

AI Search Source 
Filter

Content that portal users can search on, including tables in your 
instance or external data sources. For more information, see Defining 
search sources .

Legacy: Search Page widget

The Search Page widget displays search results. The Faceted Search widget replaces the Search 
Page widget. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.
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Search Page widget

Search Page instance options

Search page instance options

Field Description

Show score When selected, shows search results relative 
to ranking.

Max results for All search The maximum number of results that show for 
all search groups when viewed together.

Max results for single search group The maximum number of results that show 
for a single search group when you view that 
specific search group.
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Search page instance options  (continued)

Field Description

Show Did You Mean Displays suggestions when a search produces 
no results.

For more information on configuring search, see Configuring search in a portal.

Typeahead Search widget

Predictive search feature that shows words as users type. You can use this base system widget 
as-is in your portal or clone it to suit your own business needs.

Typeahead Search widget

Instance options

Use the instance options to configure the Typeahead Search widget for a portal page.

Note: 
The AI Search  instance options apply only if AI Search  is enabled in your portal. For more 
information on enabling AI Search  for Service Portal, see Enable and configure AI Search in 
Service Portal.

Field Description

Presentation

Title The name or words that appear in the search field before a user starts 
typing. For example, search  or what are you looking for

Color Whether the search button beside the search field is filled in or not

glyph The icon that appears in the search field beside the widget. The search 
icon is the default. To use a different icon, type the name of the icon 
in the field, for example search-plus. For a list of icons to choose 
from, open the instance options for the Icon Link widget.

Size Determines the font size and height of the widget. Choose from xs, sm, 
md, and lg.

Behavior

Limit If search suggestions is enabled, enter the number of suggestion 
entries you want to display. If search suggestions is disabled, enter the 
number of typeahead entries you want to display. The default is 15. See 
Enable and disable search suggestions .

Contextual Search 
Sources

Limit the results available in the typeahead search by only configuring 
specific search sources. For example, users searching in the Service 
Catalog only see results for the Service Catalog when that search 
sources is configure. For more information on contextual search, see 
Configure Search Sources available on a page

AI Search
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Field Description

Search Application
Defines search experience settings for the widget, such as the search 
engine, search results limit, and suggestions limit. By default, the 
widget uses the same search application configuration as the portal, 
but you can override this configuration at the widget level.

For more information on defining a search application configuration, 
see Defining search application configurations .

Search Results 
Configuration Defines how search results are displayed after using the widget. By 

default, the widget uses the same search results configuration as the 
portal, but you can override this configuration at the widget level.

For more information on defining a search results configuration, see 
Define a composite dataset .

Disable All 
Suggestions Option to disable search suggestions.

Placeholder
Text that appears in the search box before the user enters anything.

By default, the placeholder text is Search.

AI Search Source 
Filter

Content that portal users can search on, including tables in your 
instance or external data sources. For more information, see Defining 
search sources .

Knowledge Management widgets

Use Knowledge Management widgets to build a knowledge base for your portal.

Knowledge Management widgets are included as part of the Service Portal - knowledge base 
plugin [com.glide.service-portal.knowledge-base], which is activated automatically with the 
Service Portal for Enterprise Service Management [com.glide.service-portal.esm] plugin.

For more information on knowledge management, see Knowledge Management .

KB also in Category widget

List of articles also included within a particular category. You can use this base system widget as-
is in your portal or clone it to suit your own business needs.

The information that appears in the KB also in Category widget is determined by the knowledge 
article child categories. For more information, see Define a knowledge article category .
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KB also in Category widget

Instance options

KB also in Category instance options

Instance Options

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

KB Article Comments widget

Rating and comment option for knowledge base articles. You can use this base system widget 
as-is in your portal or clone it to suit your own business needs.
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Ratings on articles in the KB Article Comments widget determine the article popularity in the KB 
top rated widget.

KB Article Comments widget

Instance Options

KB comments widget instance options

Instance options fields

Field Description

Show star rating Select the option to show a star rating 
on the KB article comments widget. 
Selecting the Use system properties  option 
shows the star rating option based on the 
glide.knowman.show_star_rating 
system property.

Show user comments Select the option to show the comment 
box on the KB article comments widget. 
Selecting the Use system properties  option 
shows the comment box based on the 
glide.knowman.show_user_feedback 
system property.

KB Article Page widget

Use the Article page widget to view Knowledge Base articles within Service Portal. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Any specialized font or formatting added in the text field for the knowledge article within the 
platform, appears the same way in the portal.
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KB Article Page widget

Instance Options

KB article page widget instance options

Instance options

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.
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Instance options  (continued)

Field Description

Show star rating Displays the star rating on the article 
page widget. If you select Use 
system properties, the appearance 
of the star rating is defined by the 
glide.knowman.show_star_rating 
system property.

KB Categories widget

Lists the categories for your Knowledge Base. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

KB Categories widget

Categories are determined by the list of Knowledge Categories provided for the Knowledge 
Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge  > 
Administration  > Knowledge bases  then select the name of the knowledge base, for example IT. 
Categories for the knowledge base appear in the related lists. For more information on defining 
categories for a knowledge base, see Define a knowledge article category .

Note: 
If the Max article limit to allow category counts  field is set to 500 counts and the 
knowledge base contains more than 500 articles the KB categories widget displays all of 
the categories in the knowledge base.

The knowledge base that a portal uses is determined in the portal form. If your portal uses 
multiple knowledge bases, you can use the KB Knowledge Bases widget  to filter the content of 
the KB Categories widget.
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For more information on associating your portal with a knowledge base, see Associate a portal 
with a knowledge base.

Note: 
In the widget Instance Options, if the Max number of articles evaluated per category to 
determine visibility  value is set to 1 or higher the user must have access to at least one 
article in the category for the category to be displayed.

Instance options

The KB categories widget does not include instance options.

KB Category Page widget

Articles and article preview within a particular category. Categories are specified within the 
Knowledge Base module. You can use this base system widget as-is in your portal or clone it to 
suit your own business needs.

The KB Category Page widget works together with the KB Categories widget. When you select 
a category in the KB Categories widget, the KB Category page widget lists articles within that 
category.

To have the KB Categories and KB Category Page widgets work in tandem, add the two widgets 
to the same page.

If you add the KB Category Page widget to a page without adding the KB Categories widget, the 
KB Category Page widget displays an uncategorized list of all articles within the knowledge base.

Categories are determined by the list of Knowledge Categories provided for the Knowledge 
Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge  > 
Administration  > Knowledge bases, then select the name of the knowledge base, for example 
IT. Categories for the knowledge base appear in the related lists. If a category does not have any 
associated articles, it does not appear in the portal. For more information on defining categories 
for a knowledge base, see Define a knowledge article category .

The knowledge base that a portal uses is determined in the portal form. For more information on 
associating your portal with a knowledge base, see Associate a portal with a knowledge base.

Instance options

KB category widget instance options
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Instance options fields

Field Description

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Show star rating Displays the star rating on the category page. 
If you select Use system properties, the 
appearance of the star rating is defined by the 
glide.knowman.show_star_rating 
system property.

KB Knowledge Bases widget

Give users the option to select which knowledge base to browse on your portal. You can use this 
base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

If you associate your portal with multiple knowledge bases, the KB Knowledge Bases widget 
provides users with a menu to select a knowledge base. After a user selects a knowledge base, 
other KB widgets on the page filter their content accordingly.

For example, if a user selects to browse only the IT knowledge base, then the KB Categories 
widget  shows only the categories within the IT knowledge base.

If you associate your portal with only one knowledge base, then the KB Knowledge Bases widget 
remains hidden on the page.

For more information on associating your portal with knowledge bases, see Associate a portal 
with a knowledge base.

Instance options

The KB Knowledge Bases widget doesn't include instance options.
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KB Most Viewed widget

List of most viewed knowledge base articles. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

KB Most Viewed widget

Instance options

KB most viewed widget instance options

Instance options fields

Field Description

Title The name that appears in the widget header

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Max number The maximum number of most viewed articles 
listed

KB category KB category for the most viewed articles. The 
list is generated by the kb_category table.
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KB News widget

The KB News widget displays information from the Knowledge Base. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.

You can configure the KB News widget to display specific information by selecting a category 
from the KB category list.

Note: 
The KB News widget only displays the knowledge base articles a user has access to based 
on ACL rules.

KB News widget

Instance options

KB news widget instance options
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Instance option fields

Field Description

Title Name of the widget that appears in the widget 
header

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Max number The maximum number of news articles 
appearing in the widget. The default number is 
5.

Note: 
If a user does not have access to articles 
based on ACL rules, the widget can 
display fewer articles than the maximum 
number.

KB category The knowledge base category determined by 
the kb_category table. Only published articles 
display. For a news widget, select something 
like Announcements  to show upcoming 
events.

KB Search widget

The KB Search widget is a search widget that is specifically confined to the knowledge base. You 
can use this base system widget as-is in your portal or clone it to suit your own business needs.

The typeahead search widget  is embedded in the KB search widget.

KB Search widget
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Instance options

KB search widget instance options

Instance option fields

Field Description

Title Name of the widget. This field is non-public 
facing.

KB Top Rated widget

Lists Knowledge Base articles with the highest rating. Ratings are determined by user feedback. 
You can use this base system widget as-is in your portal or clone it to suit your own business 
needs.

KB Top Rated widget
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Instance options

KB top rated widget instance options

Instance options fields

Field Description

Title The name that appears in the widget header

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
you want the instance to have a specific color, 
select the option from the list.

Max number The maximum number of most viewed articles 
listed

KB category KB category for the top rated articles. The list is 
generated by the kb_category table.

KB View widget

The KB View widget is an example of how to structure a knowledge base page. You can use this 
base system widget as-is in your portal or clone it to suit your own business needs.

Use the search filter to find a specific topic or article.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

859



KB View widget

Instance options

The KB view widget does not have any included instance options.

KB View 2 widget

The KB View 2 provides an alternative structure to the KB View widget to show a different 
example of how to display knowledge articles. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

The KB View 2 widget displays each knowledge category as a card. Click a card to access the 
articles within that category.
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KB View 2

Categories are determined by the list of Knowledge Categories provided for the Knowledge 
Base. To view a list of categories for a knowledge base, in the platform navigate to Knowledge  > 
Administration  > Knowledge bases, then select the name of the knowledge base, for example 
IT. Categories for the knowledge base appear in the related lists. If a category does not have any 
associated articles, it does not appear in the portal. For more information on defining categories 
for a knowledge base, see Define a knowledge article category .

The knowledge base that a portal uses is determined in the portal form. For more information on 
associating your portal with a knowledge base, see Associate a portal with a knowledge base.

Instance options

The KB View 2 widget does not have any included instance options.

Knowledge Breadcrumbs widget

Help users navigate a knowledge base by adding the Knowledge Breadcrumbs widget. You can 
use this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The knowledge breadcrumbs widget displays information based on where an article is located 
in a knowledge base. For example, if you open an article on "How to Deal with Spam," the 
breadcrumbs show that the article is located in the Email category of the IT knowledge base.

You can broaden your search of the knowledge case by selecting the titles in the breadcrumbs. 
For example, to see all articles in the Email category, you would select Email. To see all articles in 
the knowledge base, you would select IT (Knowledge Base).

The widget also includes a search box so that you can search for an article by name.

Instance options

Use the instance options to configure the Knowledge Breadcrumbs widget for a portal page.

Note: 
The AI Search  instance options apply only if AI Search  is enabled in your portal. For more 
information on enabling AI Search  for Service Portal, see Enable and configure AI Search in 
Service Portal.
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Field Description

Behavior

Show Search Box Option to include a search box for users to search the knowledge 
base.

AI Search

Search Application
Defines search experience settings for the widget, such as the search 
engine, search results limit, and suggestions limit. By default, the 
widget uses the same search application configuration as the portal, 
but you can override this configuration at the widget level.

For more information on defining a search application configuration, 
see Defining search application configurations .

Search Results 
Configuration Defines how search results are displayed after using the widget. By 

default, the widget uses the same search results configuration as the 
portal, but you can override this configuration at the widget level.

For more information on defining a search results configuration, see 
Define a composite dataset .

Disable All 
Suggestions Option to disable search suggestions.

Placeholder
Text that appears in the search box before the user enters anything.

AI Search Source 
Filter

Content that portal users can search on, including tables in your 
instance or external data sources. For more information, see Defining 
search sources .

Service Catalog widgets

Use the Service Catalog widgets to build a catalog for your portal.

Most service catalog widgets are part of the Service Portal Service Catalog [com.glide.service-
portal.service-catalog] plugin that is activated automatically with the Service Portal for Enterprise 
Service Management (com.glide.service-portal.esm) plugin.

The Service Portal - Service Catalog v2 plugin (com.glideapp.servicecatalog.portal) provides an 
enhanced Service Catalog experience. This plugin is active by default and enables the following 
widgets:

• Catalog Homepage Search (ID: cat-homepage-search)

• SC Scroll to top (ID: sc-scroll-to-top)

• Requests and Approvals (ID: sc_request_and_approvals)

• Recent & Popular Items (ID: sc-recent-popular)

Most of the configuration for the Service Catalog widgets takes place in the Service Catalog 
application of the platform. For more information on Service Catalog, see Service Catalog .

Related topics

Service Catalog in Service Portal
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Catalog Content widget

The Catalog Content widget is part of the Service Catalog  and includes a tiled list of all the 
content items available in the catalog. You can use this base system widget as-is in your portal or 
clone it to suit your own business needs.

The items that appear on the page are grouped by category alphabetically. Catalog items and 
categories are defined in the Service Catalog application in the platform. For more information on 
creating catalog items to appear in the catalog, see Create a catalog item .

Catalog Content widget

Instance Options

The Catalog Content widget does not include instance options.

Catalog Homepage Search widget

Give your users the option to search the Service Catalog  as soon as they log in. You can use this 
base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

Add the Catalog Homepage Search widget on your Service Catalog  landing page. When users 
navigate to the Service Catalog, they can use the Catalog Homepage Search widget to find what 
they are looking for.
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Users can enter a keyword in the search bar. The Catalog Homepage Search widget uses a 
predictive search feature that shows words as users type.

Alternatively, to navigate to a list of Service Catalog  categories, users can select Browse by 
Categories.

Instance options

Use the instance options to configure the Catalog Homepage Search widget for a portal page.

Note: 
The AI Search  instance options apply only if AI Search  is enabled in your portal. For more 
information on enabling AI Search  for Service Portal, see Enable and configure AI Search in 
Service Portal.

Field Description

Presentation

Title Title to appear above the search bar.

Short description Text to appear under the title.

AI Search

Search Application
Defines search experience settings for the widget, such as the search 
engine, search results limit, and suggestions limit. By default, the 
widget uses the same search application configuration as the portal, 
but you can override this configuration at the widget level.

For more information on defining a search application configuration, 
see Defining search application configurations .

Search Results 
Configuration Defines how search results are displayed after using the widget. By 

default, the widget uses the same search results configuration as the 
portal, but you can override this configuration at the widget level.

For more information on defining a search results configuration, see 
Define a composite dataset .

Disable All 
Suggestions Option to disable search suggestions.
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Field Description

Placeholder
Text that appears in the search box before the user enters anything.  By 
default, the placeholder text is How can we help?

AI Search Source 
Filter

Content that portal users can search on, including tables in your 
instance or external data sources. For more information, see Defining 
search sources .

Other Options

Typeahead Search Configuration of the search bar. You configure the search bar by using 
the instance options for the Typeahead Search widget. Use the syntax 
{field1:'value1',field2:'value2'}. For example, to 
configure the title, color, and size of the search bar, enter the following: 
{title:'Search...',color:'default',size:'lg'}.

Recent & Popular Items widget

Allow a user to browse recent and popular catalog items. You can use this base system widget 
as-is in your portal or clone it to suit your own business needs.

Using the widget

The Recent & Popular Items widget includes two tabs: My Recent Items  and Popular Items.

A user opens the My Recent Items tab to see catalog items that they recently viewed or 
requested.

A user opens the Popular Items tab to see catalog items that have been widely requested by 
other users.
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Each item card displays basic information about the catalog item, such as the item name, image, 
and price.

To navigate to the item listing, the user selects View Details.

Instance options

Use the instance options to configure the Recent & Popular Items widget for a portal page.

Field Description

Data

Popular Items used in Time span over which users have requested the popular items. You 
select one of the following options:

• -- None --: Display popular catalog items with no time span specified. 
This is the default option.

• Last 3 Months: Display the most requested catalog items in the past 
three months.

• Last 6 Months: Display the most requested catalog items in the past 
six months.

• Last 12 Months: Display the most requested catalog items in the 
past year.

• Life time (Has performance implications): Display the most 
requested catalog items of all time. Selecting this option may 
decrease system performance.

Presentation

Number of Items Maximum number of catalog items to display in each tab. The value is 
8 by default.

Behavior

My Recent Items By Criteria to qualify which catalog items are displayed in the My Recent 
Items tab. You can select one of the following options:
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Field Description

• -- None --: Display recent items with no criteria specified. This is the 
default option.

• View: Display the catalog items that the user viewed most recently.

• Request: Display the catalog items that the user requested most 
recently.

Request Fields widget

The Request Fields widget displays information about any request a user has made. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Fields for the Request Fields widget are defined by the HTML template and the server.

Request Fields widget

Instance options

Request fields widget instance options

Field Description

Pickup message Information that appears at the bottom of the 
widget. Make sure any changes you make 
are within the curly braces. The default is 
${Requests are picked up within 
<br/> 4 hours (M-F 9-5)}

Requested Items widget

Describes at what stage of the order a requested item is. You can use this base system widget 
as-is in your portal or clone it to suit your own business needs.

You can define different workflows for items directly within the Service Catalog module. For more 
information on Service Catalog workflows, see Service Catalog request fulfillment .
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Requested Items widget

Instance options

Requested Items widget instance options

Requested Items instance options fields

Field Description

Title Name of the widget. The title appears in the 
header of the widget.

Bootstrap color Color scheme for the widget. The default 
colors are defined by the portal theme, but if 
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Requested Items instance options fields  (continued)

Field Description

you want the instance to have a specific color, 
select the option from the list.

Display field Determine what information displays as the 
title for each requested item. Short description 
is the default.

Filter Limit what appears in the list using a filter. You 
can add a filter by opening the Requested 
Items record in the platform (From the context 
menu, click Open in platform) and using the 
condition builder.

Table Table that displays the item when the user 
clicks an entry

Link to this page Page that opens when the user clicks an item

Maximum entries Max number of entries that appear in the list of 
requested items

Requests and Approvals widget

Allow a user to refer to their open requests and approvals in the Service Catalog. You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Using the widget

The Requests and Approvals widgets includes two tabs: My Requests  and My Approvals.

A user opens the My Requests tab to see data from the Task [task] table. If the user has opened 
any task record, such as an incident or a change request, the record is displayed in the widget.
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A user opens the My Approvals tab to see data from the Approvals [sysapproval_approver] 
table. If the user has been assigned to approve a request, the approval record is displayed in the 
widget.

If the user doesn't have any open requests or approvals, the widget remains hidden on the page.

Instance options

The Requests and Approvals widget doesn't include instance options.

SC Catalog Item widget

Use this widget (widget-sc-cat-item-v2) to view the information about a catalog item and order 
the item. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

Configure catalog items  using the Service Catalog in the platform UI by navigating to Service 
Catalog  > Catalog Definitions  > Maintain Items.

Catalog variables determine what information your users are allowed to select from, for example, 
color, size, or price. For more information on defining the variables for a catalog item, see Create 
a service catalog variable .

Instance options

Use the widget instance options to customize the settings for the SC Catalog Item widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the SC Catalog Item widget

Field Description

Presentation

Bootstrap color Color of the widget based on the selections made in the Branding 
Editor.
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Instance options for the SC Catalog Item widget  (continued)

Field Description

Other Options

Show Add Cart Button Displays the Add to Cart  button in the Order Item widget.

Show field validation 
messages

Displays the Required information  section with mandatory fields 
whose values are not specified.

Show Add/Update Wish 
List buttons

Displays the Add to Wish List  or the Update Wish List  buttons in 
the Order Item widget.

Order Item Section on 
Top

Displays the Order Item widget to the right of the catalog item form. 
Else, the Order Item widget is displayed below the catalog item 
form.

Enable Show More/Less 
for Item description on 
Mobile

Enables the Show more  or Show less  options for the catalog item 
description in the mobile view. By default, the Show more  option is 
available.

• Click Show more  to display the entire description.

• Click Show less  to display only 150 characters of the description.

Note: 
For a record producer, you can edit the label of the Submit  button by using the widget 
instance options.

For example, if you want to change the label to Request, press Ctrl+click on the catalog 
item widget, select Instance in Page Editor, and specify the following parameters in the 
Additional options, JSON format  field.

"record_producer_label":{
   "value" : "Request"
  }

Related topics

Request a catalog item from Service Portal

SC Categories widget

The SC Categories widget displays Service Catalog  categories. You can use this base system 
widget as-is in your portal or clone it to suit your own business needs.

The system renders the categories available in this widget from the Categories table in Service 
Catalog [sc_category].
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SC Categories widget

If you associate your portal with multiple catalogs, then the SC Categories widget also includes a 
menu to select which catalog to browse.
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For more information on associating your portal with catalogs, see Configure a catalog in Service 
Portal.

Instance options

Categories widget instance options fields

Field Description

Data

Page Defines what page opens when a user clicks a category. By default, 
this option redirects to the page for the selected category.

Number of categories 
to load

Specifies the number of categories displayed in the Categories 
pane. By default, ten categories are displayed. If there are additional 
categories, the Show All  option is available.

Presentation

Bootstrap color Color scheme for the widget. The default colors are defined by the 
portal theme, but if you want the instance to have a specific color, 
select the option from the list.

Category Layout Select a flat or nested layout. A flat layout shows all of the available 
categories. A nested layout shows only the parent categories. Use a 
nested layout if you have a large number of categories to prevent an 
unnecessarily long list. Click  that appears next to a category with 
nested topics to expand the sub-categories.

The widget only supports three levels of nesting. After level four, 
categories appear in the flat view.

Behavior

Hide at XS Hides the categories option on small screens, for example, on smart 
phones. The default is set to false.

Omit badges Show or hide the number of items included in each category.

Check canView per 
item

Verifies with each item that the user has the right roles to view the 
catalog item.

Note: 
If a category contains more than 200 items, update the following instance options on this 
widget for better performance:

• Category Layout: Flat

• Omit badges: True

• Check canView per item: False

Related topics

Access Service Catalog categories in Service Portal

SC Category Page widget

Lists the catalog items available within a certain category. Categories are determined within the 
Service Catalog  module. You can use this base system widget as-is in your portal or clone it to 
suit your own business needs.
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Note: 
Catalog items are sorted in ascending order by their Order  value. If catalog items have the 
same order, they are sorted by the Name  field.

SC Category Page widget

Instance options

Category page widget instance options fields

Field Description

Click event name The name of the event that is emitted when a 
user clicks a catalog item.

You can override the default behavior when 
clicking on a catalog item by providing a 
different event name. This would be in a 
situation where you embedded the category 
page in another widget.

The default value is 
$sp.cat_item_list.click.

Number of items to display per page Number of items to display in the category 
page.

Note: 
When defining the number of items to 
be displayed, consider the item data 
such as images and long descriptions. A 
large number may slow down the page 
performance.

Show items from Child Categories Displays items in the child categories along 
with those in the parent category.
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Category page widget instance options fields  (continued)

Field Description

Note: 
If the Category Layout  instance options 
is set to Flat  in the SC Categories 
widget, then set this instance option to 
False.

SC Order Guide widget

Use this widget (widget-sc-order-guide-v2) to request an order guide, that is, a single service 
catalog request for several catalog items with a specific purpose. You can use this base system 
widget as-is in your portal or clone it to suit your own business needs.

Configure order guides  using the Service Catalog in the platform UI by navigating to Service 
Catalog  > Catalog Definitions  > Order Guides.

The order guide form comprises the following sections:

Describe Needs

This section displays the following that are associated with the order guide:

• Image

• Description

• Variables

Choose Options

This section displays a list of catalog items included in the order guide based on the information 
provided in the Describe Needs  section and the rule base configured for the order guide. Each 
catalog item is displayed with its name and description on an accordion.

Each accordion displays:

• Options, if a catalog item has fields that need user inputs.

Note: 
If the fields are mandatory, a red asterisk is displayed beside Options.

• A toggle to include the catalog item in the order guide request. You can make it mandatory 
to include all items in the order guide request by not displaying the toggle. You can make it 
optional to include items in the order guide request by displaying the toggle. To display the 
toggle for each catalog item of the order guide, select the Show Include Toggle (Service 
Portal)  check box while configuring the order guide. For more information, see Create an order 
guide  .

Note: 
When an item is excluded from the order guide request, the item is not editable and the 
corresponding mandatory field restrictions are ignored.
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Summary

This section provides a summary of the order guide that you can review before requesting the 
order guide.

Instance options

Use the widget instance options to customize the settings for the SC Order Guide widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the SC Order Guide widget

Field Description

Presentation

Title Name of the order guide.

Bootstrap Color Color of the widget based on the selections made in the Branding Editor.

Enable Show 
More/Less for Item 
description on 
Mobile

Enables the Show more  or Show less  options for the description of 
the order guide or the associated catalog items in the mobile view. By 
default, the Show more  option is available.

• Click Show more  to display the entire description.

• Click Show less  to display only 150 characters of the description.

Note: 
This instance option is applicable for the description of the order 
guide in the Describe Needs  section, and the description of the 
associated catalog items in the Choose Options  section.

Compact Mode Displays the widget in the compact mode when configured for smaller 
real estates (less than 6*6).

Hide Delivery Time Hides the delivery time for each catalog item in the accordion. It is not 
applicable for the order guide summary page and the delivery time is 
never displayed on the summary page.

Behavior

Show Add to Cart Option to display the Add to Cart  button on the order guide summary 
page.

Related topics

Request an order guide from Service Portal

Configure order guide widgets

SC Popular Items widget

List of Service Catalog  items that users purchase often. You can use this base system widget as-
is in your portal or clone it to suit your own business needs.
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SC Popular Items widget

You can view order guides in the Service Catalog Popular Items widget as a standalone request 
instead of items ordered as part of the guide.

Instance Options

Popular Items widget instance options

Popular Item widget instance option fields

Field Description

Limit Maximum number of popular items shown. 
The default number is 9.

Include Record Producers Includes requests made through record 
producers .

SC Save Bundles widget

The Save Bundles widget allows you to save specific catalog items together for reuse. You can 
use this base system widget as-is in your portal or clone it to suit your own business needs.

The Save Bundles widget is embedded within the SC Shopping Cart widget.
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SC Save Bundles widget

Instance Options

The Save Bundles widget does not have any included instance options.

SC Saved Carts widget

The Saved Carts widget shows previously created and saved bundles from the Service Catalog. 
You can use this base system widget as-is in your portal or clone it to suit your own business 
needs.

SC Saved Cart widget

When you add an existing cart bundle to a shopping cart, you have two options. You can:

• Replace the items in the shopping cart with the items in the bundle.

• Add the bundle in addition to the rest of the items in the cart.
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Add bundle items to a cart

Instance Options

The Saved Carts widget does not have any included instance options.

SC Scroll to top widget

In the Service Portal  mobile view, the SC Scroll to top widget (sc_scroll_to_top) lets you scroll to 
the top of the screen after you scroll down. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

This widget is displayed when you start to scroll upwards after reaching a specific screen height.
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SC Scroll to top widget

Instance options

Use the widget instance options to customize the settings for the SC Scroll to top widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the SC Scroll to top widget

Height from top 
(px)

Screen height where the widget is displayed when you start to scroll 
upwards.

SC Shopping Cart widget

The SC Shopping Cart widget (sc-shopping-cart-v2), used with Service Catalog, stores all your 
orders at one place. You can use this base system widget as-is in your portal or clone it to suit 
your own business needs.
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Use the shopping cart widget to:

• Control the quantity of items in the cart.

• Add items to a cart. This information is stored in the sc_cart table.

• Define who the items are being requested for.

• Save specific items together as a bundle, which can be reloaded later. You can replace the cart 
items with the saved bundles, or add the bundles to the cart items.

• Remove all items from your cart.

SC Shopping Cart widget

Instance options

Use the widget instance options to customize the settings for the SC Shopping Cart widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the SC Shopping Cart widget

Field Description

Presentation

Bootstrap 
color

Color scheme for the widget. The default colors are defined by the portal theme, but 
if you want the instance to have a specific color, select the option from the list.

Behavior

Cart 
Template

Enter the name of a ng-template you want to use to provide 
a different template for the shopping cart. By default, two ng-
templates are provided: small_shopping_cart_v2.html  and 
large_shopping_cart_v2.html.

Auto 
update 
cart

Automatically updates the cart across all sessions.
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Related topics

Add a catalog item to the shopping cart

Enable the Shopping Cart widget

The shopping cart widget is enabled automatically for instances upgrading to Istanbul, however, 
there are several ways to manually enable or disable the widget.

To enable the shopping cart for a catalog item:

1. Navigate to a catalog item on the Service Catalog page in Service Portal.

2. CTRL+right-click a catalog item widget to open the widget instance options.

3. Select or clear the Show Add Cart Button  option to enable or disable the shopping cart for 
that particular catalog item.

Catalog item cart option

To enable the shopping cart in the portal header:

1. From the Service Portal configuration page, select the Portal editor.

2. Select the SP Header Menu in the portal hierarchy.

3. In the Additional options  section, make sure the enable cart value is set to true.

{
 "enable_cart": {
  "displayValue": "true",
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  "value": true
 }
}

Set the value to false  to hide the shopping cart.

Shopping cart in the header menu

Enable automatic updates to the shopping cart

Automatically update the shopping cart across all sessions when users make changes from 
multiple tabs and platforms.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. In the banner, click Cart.

3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.

4. Select the Auto update cart  check box and click Save.

5. Perform these steps only for upgrade customers.

a. Navigate to Service Portal  > Service Portal Configuration.

b. In the banner, click Portals.

c. In the list, ensure that Service Portal  is selected.
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d. In the portal hierarchy chart, select SP Header Menu.

e. In the Additional options, JSON format  field, set the auto_update_cart  value as true.

"auto_update_cart": {
        "displayValue": "true",
          "value": true}

Automatic updates to the shopping cart

SP Variable Editor widget

The Variable Editor widget allows you to change the specifications you chose for an item in the 
Service Catalog. You can use this base system widget as-is in your portal or clone it to suit your 
own business needs.

You can embed the variable editor widget in the shopping cart widget, to allow users to edit and 
make changes to their cart items. The options included in the widget are determined by the 
specific catalog item and the variables that have been configured for it.

For more information on the service catalog variables that are available in Service Portal, see 
service catalog variable types .
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Variable Editor widget

Instance Options

The Variable Editor widget is embedded as part of the shopping cart widget, therefore no 
instance options are included.

SC Wish List Cart widget

Use this widget to add catalog items or record producers to the wish list so that you can review 
them. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

If the wish list is enabled for Service Catalog, SC Wish List Cart widget (sc_wishlist_cart) is 
available in Service Portal. Once enabled, the following options are available:

• The Wish List  menu option on the main navigation bar.

• The Add to Wish List  button in the Ordering widget for catalog items and record producers.

• A wish list details page that displays all items in the Wish List.

From the wish list details page, you can view or delete catalog items, clear the wish list, or 
navigate to the Service Catalog landing page.
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SC Wish List Cart widget

Instance options

Use the widget instance options to customize the settings for the SC Wish List Cart widget. To 
customize the settings for this widget, press the Ctrl key, click on the widget, and select Instance 
Options.

Instance options for the SC Wish List Cart widget

Field Description

Auto update wish list Automatically updates the wish list across all sessions.

Related topics

Add an item to the wish list in Service Portal

Enable the SC Wish List Cart widget in Service Portal

Add catalog items or record producers to the wish list after you enable the wish list.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Catalog  > Maintain Catalogs.

2. From the Catalogs list, select Service Catalog.

3. On the catalog form, select the Enable Wish List  check box and click Update.
The Wish List  menu option is displayed in the Service Portal banner.

Note: 
The Use the sc_layout driven cart macros (default true) 
( glide.sc.use_cart_layouts) property must be set to true to enable the wish 
list.

4. To enable the Wish List  menu option in the Service Portal banner, perform these additional 
steps only for upgrade customers.

a. Navigate to Service Portal  > Service Portal Configuration.

b. In the banner, click Portals.

c. In the list, ensure that Service Portal  is selected.
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d. In the portal hierarchy chart, select SP Header Menu.

e. In the Additional options, JSON format  field, set the enable_wishlist  value as true.

"enable_wishlist": {
        "displayValue": "true",
          "value": true}

Enable the SC Wish List Cart widget

5. Enable the Add to Wish List icon ( ) in the Ordering widget of a catalog item or record 
producer:

a. Navigate to Service Portal  > Service Portal Home  > Order Something.
The Service Portal homepage is displayed.

b. Click one of the available catalog items.

c. Press and hold the Ctrl key, click a catalog item widget, and select Instance Options.

d. Select the Show Add/Update Wish List buttons  check box and click Save.

Enable automatic updates to the wish list

Update the wish list automatically with user-specific changes from multiple tabs and platforms.
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Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Home.
The Service Portal homepage is displayed.

2. Access the wish list.

3. Press and hold the Ctrl key, click the wish list widget, and select Instance Options.

4. Select the Auto update wish list  check box and click Save.

5. Perform these additional steps only for upgrade customers.

a. Navigate to Service Portal  > Service Portal Configuration.

b. In the banner, select Portals.

c. In the list, ensure that Service Portal  is selected.

d. In the portal hierarchy chart, select SP Header Menu.

e. In the Additional options, JSON format  field, set the auto_update_wishlist  value as 
true.
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"auto_update_wishlist": {
        "displayValue": "true",
          "value": true}

Automatic updates to the wish list

Service Portal configuration page widgets

Service Portal  uses widgets for configuration. When you configure a page or a widget for a portal 
in the Service Portal  Configuration page, you actually use Service Portal  widgets to do so.

Service Portal  configuration widgets are internal only and cannot be extended.

Configuration page widgets are included as part of the Service Portal  Configuration Pages plugin 
[com.glide.service-portal.config], which is activated automatically when you activate the Service 
Portal  for Enterprise Service Management plugin [com.glide.service-portal.esm].

Navigate to Service Portal  > Service Portal Configuration  to view these widgets in action.

Service Portal Config Overview widget

The Service Portal Config Overview widget is the widget that appears on the sp_config 
homepage. Use this widget to navigate Service Portal Configuration. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.
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Service Portal Config Overview widget

Portal config widget

The Portal Config widget is the left panel of the Branding Editor, which you use to configure 
themes for your portal. You can use this base system widget as-is in your portal or clone it to suit 
your own business needs.

SP Page Map widget

The Page Map widget works in the Page Editor to display any Service Portal page in a tree 
structure. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

SP Page Map widget

SP Portal Map widget

The Portal Map widget displays your portal in a tree structure.

SP Portal Map widget

Theme Preview widget

The Theme Preview widget appears in the Branding Editor and allows you to see any theme 
changes you make to your portal. You can use this base system widget as-is in your portal or 
clone it to suit your own business needs.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

890



Theme Preview widget

Widget Edit Panel widget

The Widget Edit Panel appears on the main page of the Widget Editor in Service Portal 
Configuration (All  > Service Portal  > Service Portal Configuration  > Widget Editor). You can use 
this base system widget as-is in your portal or clone it to suit your own business needs.

Use the Widget Edit Panel to view widgets that have recently been updated, create a widget, or 
view an existing widget.

Widget Edit panel
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Service Portal service status widgets

Use the service status widgets to display current, planned, and historical outages for business 
services to your end users.

The service catalog widgets are part of the Service Portal Service Status [com.glide.service-
portal.service-status] plugin, which is activated automatically with the Service Portal for 
Enterprise Service Management [com.glide.service-portal.esm] plugin.

Business Service Status widget

View how services are running on your system. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

The Business Service Status widget pulls information from the cmdb_ci_service table. You can 
change where the data comes from in a cloned version of the widget by adjusting the settings in 
the widget server script.

Business Service Status widget
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Instance options

Business Service Status widget instance options

Instance option fields

Field Description

Title Name of the widget. This only appears in the 
header for the widget instance options, it is 
not user-facing. To change the title for the list 
of services, clone and edit the widget HTML.

Glyph Icon for the widget. This is not user-facing.

Number of Services The number of services displayed in the 
widget. The default number is 250.

Current Status widget

The Current Status widget displays any issues reported in the system. You can use this base 
system widget as-is in your portal or clone it to suit your own business needs.

The Current Status widget checks the Outages [cmdb_ci_outage] table to see if the system is 
experiencing any outages.

Service owners and service desk managers report planned or unplanned outages by creating 
outage records. Each outage record includes Begin  and End  fields to indicate the duration of 
the outage. If the End  time is later or empty, then the outage is still ongoing. The Current Status 
widget displays all ongoing outages.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

893



Current Status widget

The Current Status displays outages only for services, which are tracked in the Services 
[cmdb_ci_service] table.

Instance options

Use the instance options to configure the Current Status widget for a portal page.

Field Description

Show outage details Option to display details from the Outage [cmdb_ci_outage] record.

Standalone Option to remove explanatory information. This option also adds a link 
to more information.

Planned Maintenance widget

Describes any planned system maintenance. You can use this base system widget as-is in your 
portal or clone it to suit your own business needs.

The widget gathers information from the cmdb_ci_outage table. Any planned maintenance within 
the following five days appears in the Planned Maintenance widget.

Planned Maintenance widget

Instance options

The Planned Maintenance widget does not have any included instance options.

Service History widget

Displays the history of specific service's status. For example, if the Bond Trading widget has 
a history of planned outages or degradations, the widget displays those with a varied color 
scheme to differentiate the outage type. You can use this base system widget as-is in your portal 
or clone it to suit your own business needs.
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Service History widget

Instance options

The Service History widget does not include any instance options.

Service Status widget

The Service Status widget provides a visual representation of service availability over the past 
three months. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

The Service Status widget displays the history of service availability for one service from the 
Services [cmdb_ci_service] table. The widget uses the page URL to determine which service to 
represent.

Service Status widget

Each pill represents one day. Each color correlates with a type of service availability. To include 
additional details when you hover over a pill, such as the task number or short description, you 
must clone the widget and edit the server script.

Color Service availability

Green No issues

Blue Planned maintenance

Yellow Service degradation

Red Outage
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Instance options

The Service Status widget does not have any included instance options.

Service Status Legend widget

Use concurrently with the Status History widget to show what the icons in the Status History 
widget mean. You can use this base system widget as-is in your portal or clone it to suit your own 
business needs.

Service Status Legend widget

Instance options

The Service Status Legend widget does not have any included instance options.

Service Status Subscription widget

Used in conjunction with the service status widget. Users subscribe to receive updates about 
the service status. You can use this base system widget as-is in your portal or clone it to suit your 
own business needs.

Service Status Subscription widget

Instance options

The Service Status Subscription widget does not have any included instance options.

Configure widget loading order in Service Portal

Configure service portal pages to defer load the widgets on a page. The delay in loading of non-
essential widgets helps to improve page loading speed and optimizes the use of resources.

Before you begin
Role required: sp_admin or admin
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Procedure

1. Navigate to All  > Service Portal  > Service Portal Designer  > Widgets.

2. Hover over the widget that you want to defer load.

3. Select the Form  icon  to open a new form.

4. Select the Select the check box to defer load this widget  check box.

5. Complete the fields in the form.

Form fields

Field Description

In which order do 
you want to load the 
widget?

Select Viewport  if you want the widget to load when it appears in the 
page view. Select Parallel  to have the widget load just soon after the 
page loads.

Device type Select the type of device (desktop, tablet, and mobile) on which you 
want to defer load widgets.

Advance dimensions 
configuration

Select the check box to define the height and width of the widget.

Placeholder 
dimensions

Specify the height and width of the widget in each of the selected 
device types with the following code:

 
{
  "mobile": {
  "height": "100%",
  "width": "100%"
  },
  "desktop": {
  "height": "100px",
  "width": "100%"
  },
  "tablet": {
  "height": "100%",
  "width": "100%"
  }
}
 

Limit widget size to 
placeholder

Select the check box to retain the original placeholder dimensions 
and avoid layout shifts.

Placeholder 
Template

Define the custom skeleton loader. A default code is already available 
and can be edited for customization.

6. Select Save.

Result
Deferred loading of the widget is enabled.
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Deferred loading of AI Search  assets in Service Portal

Deferred loading of AI Search  on the Service Portal  delays the loading of certain AI Search 
assets until the main page content is loaded. This delay helps the page to load faster, thus 
improving user experience in the portal. st.

A new system property, glide.service_portal.ais_defer_load_enable.list, 
has been added to control for which portals deferred loading is applied. This property accepts a 
comma-separated list of portal url_suffix values. By default, deferred loading is enabled for the 
Service Portal.

Note: 
If the web embeddable feature is enabled, loading of the AI Search  assets can’t be 
deferred. Instead, they load along with the other widgets on the portal page.

Configuring search in a portal

Service Portal  displays search results data within a widget on the search page. To make data 
searchable from Service Portal, you can fetch data from a single table within your ServiceNow 
instance, from multiple ServiceNow  tables, or from an external site.

Search engines

AI Search

AI Search  provides a modern consumer-grade search engine that is faster and 
more assistive than the legacy Zing search engine. Portal users can find answers 
more quickly and easily with features like auto-complete search queries, natural 
language support, and typo handling. AI Search is only supported in Service Portal, 
Employee Center (ESC), Consumer Service Portal, and Customer Service Portal. 
Custom portals must be built off a baseline of one of these portals to have the AI 
Search capability.

Zing

Zing is the legacy text indexing and search engine originally used by Service Portal. 
Some portals still use this search engine by default.

Search analytics and suggestions

Generate relevant search suggestions for your users and monitor search analytics to 
understand what your users are searching for and whether they're finding what they need. 
Search Suggestions is a ServiceNow AI Platform  feature. For more information, see Search 
Suggestions .

Generate suggestions from custom widgets

By default, the Search Events [sys_search_event] and Search Source Events 
[sys_search_source_event] tables collect search data from base system search 
widgets.  To generate search analytics from custom Service Portal  search 
widgets, use the GlideSPSearchAnalytics API. For more information, see 
GlideSPSearchAnalytics .

Performance recommendations

To avoid performance degradation and to ensure a fast search experience for end users, follow 
these recommendations.
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• Limit search sources when possible to perform only the necessary query. For example, if 
a search only needs to return active incidents, add a condition to the search source set to 
[Active]  [is]  [true]. A search that queries only active incidents is faster than a search that 
queries all records in the incident table.

• Create facet items and mapped queries with no more than 30 filter items. To verify, test each 
search source with a variety of keywords as a user with low permissions.

Note: 
Service Portal  search results display as text only. HTML tags, images, and formatting do not 
display in search results.

AI Search  in Service Portal

Configure the ServiceNow  AI Search  application for Service Portal  so that portal users can take 
advantage of intelligent query features and quickly find the answers they need.

AI Search  features

Powerful and flexible search

Unlike the legacy Zing search that was used in previous releases, AI Search  is faster 
and more assistive. Portal users can find answers more quickly and easily with 
features like auto-complete search queries, natural language support, and typo 
handling.

Search suggestions

Typo handling

Relevant and actionable search results

With AI Search  enabled in Service Portal, the portal search engine captures 
information about the user — such as their role, location, department, assets, and 
search history — and returns search results that are relevant and personalized.

AI Search  also includes genius results that enable users to take action directly from 
the search results list.
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Genius result

Intelligent search refinement

Portal users can refine their search results using dynamic and static filters. For 
example, if a user searches Mac, they can use facets to filter search results by 
hardware or user profiles.

Search facets

Tab filters

For more information on using facets and tabs, see Faceted Search widget.

For more information on AI Search  features, see Exploring AI Search .
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Activation information

AI Search  is a ServiceNow AI Platform  feature that is active by default.

AI Search  is enabled in Service Portal  for all new and zBoot customers by default.

If you are upgrading to Zurich  as an existing customer, AI Search  is disabled in Service Portal  by 
default. You can enable it by updating the portal record. For more information, see Enable and 
configure AI Search in Service Portal.

Note: 
Search widgets that you cloned or customized before a system upgrade may not be 
compatible with AI Search. You can resolve this issue by running a fix script that reclassifies 
search widget instances. For more information, see Reclassify cloned or customized search 
widgets.

Configuring AI Search  for Service Portal

Configure AI Search  in Service Portal  by defining the following:

Search application configuration

Defines search experience settings, such as the search engine, search results 
limit, and suggestions limit. For more information on defining a search application 
configuration, see Defining search application configurations .

Search results configuration

Defines how search results are displayed. For more information on defining a search 
results configuration, see Define a composite dataset .

You can change the search application configuration or search results configuration that your 
portal uses by updating the portal record. For more information, see Enable and configure AI 
Search in Service Portal.

To use a different search application or search results configuration for a specific search widget, 
update the widget instance options. AI Search  is used in the following widgets:

• Homepage Search widget

• Typeahead Search widget

• Faceted Search widget

• Catalog Homepage Search widget

• Knowledge Breadcrumbs widget

To configure the search results payload to navigate to and display the appropriate portal page for 
a selected data source, define an AI Search results action. For more information, see Define an AI 
Search Results Action.

You can configure the action buttons in genius results by defining an Entity View Action Mapping 
(EVAM) action. For more information, see Define an EVAM action .

You can customize the look and feel of the AI Search  experience in Service Portal  by updating 
the relevant CSS variables. For more information on these variables, see Theming for AI Search 
in Service Portal.

Browser support

With AI Search  enabled in Service Portal, users must log in with a modern browser such as 
Google Chrome, Mozilla Firefox, Microsoft Edge  (Chromium), or Apple Safari.
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Enable and configure AI Search  in Service Portal

Enable and define the AI Search  experience in your portal.

Before you begin
AI Search is only supported in Service Portal, Employee Center  (ESC), Consumer 
Service Portal, Business Portal and Customer Service Portal. Custom portals must 
be built off a baseline of one of these portals to have the AI Search capability. The 
glide.service_portal.enable_ais_portal.allow_list  property contains a list 
of supported baseline portals.

Role required: sp_admin or admin

About this task
AI Search  is enabled in Service Portal  for all new and zBoot customers by default.

If you are upgrading to Zurich  as an existing customer, AI Search  is disabled in Service Portal  by 
default. You can enable it by updating the portal record.

If you leave AI Search  disabled, the portal uses the legacy search experience.

Procedure

1. Navigate to Service Portal  > Portals  and open a portal record.

2. On the form, select Enable AI Search.

3. In the Search Application  field, select the search application configuration to use for the 
portal.

A search application configuration defines search experience settings, such as the search 
engine, search results limit, and suggestions limit. A search application configuration is 
selected by default, but you can select a different configuration if needed.

For more information on defining a search application configuration, see Defining search 
application configurations .

4. In the Search Results Configuration  field, select the search results configuration to enable for 
the portal.

A search results configuration defines how search results are displayed. A search results 
configuration is selected by default, but you can select a different configuration if needed.

For more information on defining a search results configuration, see Create an EVAM 
definition .

5. Select Update.

Result
AI Search  is enabled throughout the portal. Employees or customers can use AI Search  the next 
time they log in.

The Search Sources related list is hidden from the portal record. You now define search sources 
in the AI Search  application. For more information, see Defining search sources .

To use AI Search  for knowledge articles, you can keep the default Knowledge Bases  search 
source or select a custom one.
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Note: 
If you're experiencing issues using AI Search  for knowledge articles, check that the 
associated search profile is linked to a knowledge bases search source. For more 
information, see Link a search source to a search profile .

What to do next
Search widgets that you cloned or customized before a system upgrade may not be compatible 
with AI Search. You can resolve this issue by running a fix script that reclassifies search widget 
instances. For more information, see Reclassify cloned or customized search widgets.

Reclassify cloned or customized search widgets

Search widgets that you cloned or customized before a system upgrade may not be compatible 
with AI Search. You can resolve this issue by running a fix script that reclassifies search widget 
instances.

Before you begin

1. Enable and configure AI Search in Service Portal

2. Run the Portal Analyzer to identify all cloned or customized search widgets. For more 
information, see Get a list of widgets per page.

3. For each cloned or customized search widget, copy the sys_id value of each widget instance 
that is associated with the widget.

4. For each cloned or customized search widget, ensure that the widget and its corresponding 
widget instances have the latest AI Search  code from the base system search widget.

Warning: 
Run the fix script only after you've updated all cloned or customized search widgets. If 
you run the fix script without first updating the widget code, the widgets won't be able to 
uptake the AI Search  code later.

Role required: admin

About this task
If you're unable to use AI Search  in Service Portal, you may need to reclassify your cloned or 
customized search widgets. You can run the Reclassifying Search widgets  fix script, which 
reclassifies widget instances to the sp_instance_ais  class.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. On the list, find and open the record named Reclassifying Search widgets.

3. On the form, update the script to define which widget instances to reclassify.
Paste the sys_id value of each search widget instance in the array. For example, you would 
enter the sys_id values as follows:

var instances = ["sys_id_1", "sys_id_2"];

4. Save the form.

5. Select Run Fix Script.

Define an AI Search Results Action

Configure which portal page opens when a result is selected from the list of search results.
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Before you begin
Role required: sp_admin or admin

About this task
This configuration is required for UXF Client Action buttons in genius results or search results 
cards.

Note: 
If the action is being implemented as a server script, the script is executed by the search 
widget. Notification messages defined in the server script are displayed.

Procedure

1. Navigate to All  > Service Portal  > AI Search  > Search Results Action  and select New.

2. On the form, fill in the fields.

Field Description

Short description A unique description of the search results action.

Service Portal(s) Portals in which the search results action appears. If left blank, the 
search results action appears in all active portals.

AI Search Source Content that portal users can search on, including tables in your 
instance or external data sources. For more information, see Defining 
search sources .

Action name Name of the action assignment. Only navigation actions are 
supported for selecting a search result in portals.

Application Application scope of the search results action.

Active Option to activate the search results action.

Order
Priority that the search results action takes over other actions with 
the same configuration. To give higher priority to an action, enter a 
lower number.

If two actions have the same order, then the oldest action takes 
priority.

Portal page Page on that opens when a result from the search source is selected 
from the list of search results.

Payload query 
parameters Query parameters to apply to the URL.

◦ In the first drop-down, select the payload fields that correspond to 
the selected Action name.

Note: 
You can find the payload fields by opening the record 
referenced in the Action name  field. Then, in the Action 
Assignment record, open the record referenced in the 
Specify client action  field. The Payload  field in the Action 
Payload Definition record specifies the fields used.

◦ In the next field, enter the query parameter to use in the URL.
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Field Description

Additional query 
parameters

Custom query parameters to use in addition to the payload query 
parameters. For example, to add view=sp  as a query parameter, 
you would enter view  and sp  in the Name  and Value  fields, 
respectively.

3. Select Submit.

Create a CSS include to override theming for AI Search  in Service Portal

Override theming for AI Search  in Service Portal  to match your company branding.

Before you begin
Role required: sp_admin or admin

About this task
As an example of styling features of AI Search  in Service Portal, this procedure removes the 
borders around the search filters. You can style several other features using additional CSS 
variables. For more information about these variables, see Theming for AI Search in Service 
Portal.

Search filters: Remove the line borders around search filters.

Procedure

1. Create a style sheet record.

a. Enter sp_css.do  in the Filter navigator.

b. On the form, fill in the fields.
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Style Sheet form

Field Description

Name Unique name for your style sheet. For 
example, sp_ais.css.

CSS Field for your CSS code. Enter this code and 
then customize the variables.

To remove the border for the search filters 
panel, paste this code and customize as 
desired.

sn-search-facets {
 
 --
now-color--divider-tertiary: 
 0px !important;
}

Application Application this style sheet applies to. 
Global means the style sheet applies to all 
applications.

c. Select Submit.

2. Create a CSS include record.

a. Enter sp_css_include.do  in the filter navigator.

b. On the form, fill in the fields.

CSS Include form

Field Description

Name Unique name for your CSS include record.

Source Source for your CSS include. Select Style 
Sheet.

Style sheet The style sheet you want to incorporate with 
this CSS include form. Select the style sheet 
you created in step 1.

Application Application this CSS include record applies 
to. Global means the CSS include applies to 
all applications.

Lazy Load
Option to load the CSS Include 
asynchronously to improve page load time. 
This option should be set to the same value 
for all CSS Includes of a theme. Enabling 
asynchronous loading for only some CSS 
Includes associated with a theme isn’t 
recommended.
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Field Description

Note: 
Enabling Lazy Load  isn’t 
recommended for portals with flashing 
of unstyled content.

The CSS Includes with Lazy Load  enabled 
are listed in the Lazy load CSS includes 
related list in the theme record.

3. Input your CSS override into the style sheets form and override the theme that's applied to 
your UI.

a. Enter m2m_sp_theme_css_include  in the filter navigator.

b. On the form, fill in the fields.

Style Sheets form

Field Description

Order An integer that prioritizes the incorporation 
of this style sheet against other style sheets. 
The lower the number, the higher in the 
list. The typical practice is to make these 
numbers hundreds, for example, 100, 200, 
300, and 400, so you can put new icons 
between existing ones in the future.

CSS Include CSS include that includes the overrides you 
created in previous steps.

Application Application this style sheet applies to. 
Global means the style sheet applies to all 
applications.

Theme Theme that's applied to your UI that you 
want to override.

c. Select Submit.
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Result
The borders around the search filters are 

removed.

Theming for AI Search  in Service Portal

You can customize the look and feel of the AI Search  experience in Service Portal  by updating 
the relevant CSS variables.

The following CSS variables control the look and feel of the AI Search  features in Service Portal. 
For more information about AI Search  features, see Using AI Search .

You can edit these variables in the CSS variables  field of a Theme [sp_theme] record. You can 
also configure these variables with a CSS Include associated with a portal's theme. For more 
information, see the following topics:

• Create a portal theme

• Create a CSS include to override theming for AI Search in Service Portal

Variable Default value Description

$now-sp-font-family-
sans-serif

"SourceSansPro", 
Helvetica, Arial, 
sans-serif

Font family for all texts.

$now-sp-color--text-
primary

$gray-dark  Color of   unselected tabs, 
Genius result button text, hit 
text color, result icons, and 
 search bar drop down list 
item text and icon color.

$now-sp-text-link--
primary--color

$gray-dark The color of the title text in 
search results.

$now-sp-display-
type--tertiary--
color

$gray-dark The color of the text snippet in 
search results.
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Variable Default value Description

$now-sp-color--
neutral-12

$gray-dark  Expanded icon color 
(chevron) of the facets in 
mobile view.

$now-sp-global-
border-radius

4px  Rounded search results 
corners affecting the content 
pane and not search result 
cards. This variable also 
affects Genius results, buttons 
on Genius results, and search 
bar icon hover background 
highlights. This variable 
doesn't affect facets.

$now-sp-color--
focus-ring

$brand-primary Tabs focus color.

$now-sp-tabs--
selected--color

$brand-primary Text color of selected tab. 
Doesn't include on hover.

$now-sp-tabs--
color--hover

$brand-primary Text color of all tabs when 
hovered.

$now-sp-tabs--
border-color

$sp-b-border-color Tabs underline color.

$now-sp-tabs--
selected--
background-color

$brand-primary Selected tab underline color.

$now-sp-heading--
title-primary--color

$gray-dark Color Filters label.

$now-sp-checkbox-
label--color

$gray-dark Filter item (checkbox label) 
color.

$now-sp-button--
primary--bare--color

$link-color Clear All  and Clear  link color 
in facets filter.

$now-sp-button--
primary--bare--
color--active

$link-color Clear All  and Clear  link color 
in facets filter on click.

$now-sp-button--
primary--bare--
color--hover

$link-hover-color   Clear All  and Clear  link color 
in facets filter on hover.

$now-sp-pill--
selected--
background-color

$brand-primary Selected filter pill background.

$now-sp-pill--
selected--border-
color

$brand-primary  Selected filter pill border 
color.

$now-sp-button--
secondary--
background-color

$btn-default-bg Genius result button 
background.

$now-sp-button--
secondary--color

$btn-default-color  Genius result button text 
color.
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Variable Default value Description

$now-sp-button--
secondary--border-
color

$btn-default-border Genius result button border 
color.

$now-sp-button--
secondary--
background-color--
hover

darken($btn-default-
bg, 10%)

Genius result button 
background color on hover.

$now-sp-button--
secondary--color--
hover

$btn-default-color  Genius result button text 
color on hover.

$now-sp-button--
secondary--border-
color--hover

darken($btn-default-
border, 12%)

 Genius result button border 
on hover.

$now-sp-button--
secondary--
background-color--
active

darken($btn-default-
bg, 10%)

Genius result button 
background on click.

$now-sp-button--
secondary--color--
active

$btn-default-color Genius result button text color 
on click.

$now-sp-button--
secondary--border-
color--active

darken($btn-default-
border, 12%)

Genius result button border 
color on click.

$now-sp-highlighted-
value--tertiary--
color

$gray-dark Genius result Top Result tag 
text color.

$now-sp-button--
border-radius

$now-sp-global-
border-radius

Differentiates the radius 
for button and search bat 
buttons.

$now-sp-container--
border-radius

$now-sp-global-
border-radius

Border radius for search result 
cards, genius result cards, and 
the search results container. 
Doesn't affect the border 
between individual results.

$now-sp-button--
primary-negative--
background-color

$btn-primary-bg  Genius button background 
color in the EVAM action 
confirmation modal.

$now-sp-button--
primary-negative--
border-color

$btn-primary-border Genius button border color in 
the EVAM action confirmation 
modal.

$now-sp-button--
primary-negative--
background-color--
hover

darken($btn-primary-
bg, 10%)

Genius button background 
color on hover in the EVAM 
action confirmation modal.

$now-sp-button--
primary-negative--
border-color--hover

darken($btn-primary-
border, 12%)

Genius button border color on 
hover inside the confirmation.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

910



Variable Default value Description

$now-sp-button--
primary-negative--
background-color--
active

darken($btn-primary-
bg, 10%)

  Genius button background 
color on click inside the 
confirmation modal.

$now-sp-button--
primary-negative--
border-color--active

darken($btn-primary-
border, 12%)

Genius button border color on 
click inside the confirmation 
modal.

$now-sp-button--
primary--background-
color

$btn-primary-bg Selected filter (pill) 
background color.

$now-sp-button--
primary--border-
color

$btn-primary-border Selected filter (pill) border 
color

$now-sp-button--
primary--color

$btn-primary-color Selected filter (pill) color.

$now-sp-button--
primary--background-
color--hover

darken($btn-primary-
bg, 10%)

 Selected filter (pill) 
background color on hover.

$now-sp-button--
primary--border-
color--hover

darken($btn-primary-
border, 12%)

Selected filter (pill) border 
color on hover.

$now-sp-button--
primary--background-
color--active

darken($btn-primary-
bg, 10%)

Selected filter (pill) 
background color on click.

$now-sp-button--
primary--border-
color--active

darken($btn-primary-
border, 12%)

Selected filter (pill) border 
color on click.

$now-sp-rem-factor 5 The same variable as --
classicsponlydonotuse--
rem-multipy.

Note: 
It's not suggested to use 
this variable.

$sp-search-result-
title-highlight--
background-color

None Text background color for title 
highlights in search results.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

911



Variable Default value Description

Note: 
For this theme setting 
to take effect, you must 
add the static value 
removeHitHighlighting 
with value "false" 
for the sn-search-
result-evam-
card  component in 
the relevant EVAM  view 
template, as shown in 
this example:

{
  "component": "sn-
search-result-evam-ca
rd",
  "staticValues": {
  
  "removeHitHighlight
ing": {
    
  "translatable": 
 true,
    
  "key": "false"
    }
  },
}

To learn about 
configuring settings in 
EVAM  view templates, 
see Define an EVAM 
view template .

Zing search in Service Portal

Service Portal  search supports the ServiceNow  Zing text indexing and search engine. Zing allows 
you to index and search record data by table and is created entirely with ServiceNow  code and 
implemented within the relational model.

To make data searchable from Service Portal, you create search sources that fetch data from 
a single table within your ServiceNow  instance, from multiple ServiceNow  tables, or from an 
external site.

Search sources

A search source is a record that describes the behavior and source of searchable data. A search 
source defines:

• Where to retrieve search data from.

• Whether search suggestions can populate the search field based on user input.

• How a search entry displays in the search result page.
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Search sources have simple and advanced configurations.

Simple

Define a table within your ServiceNow  instance as a source of searchable data. To 
learn more, see Define a search source.

When you create a simple search source, Service Portal  uses the search engine 
settings configured on your instance. To learn more, see Zing text indexing and 
search engine .

Advanced

Define a data fetch script to return data. A data fetch script executes on the server 
and returns a result array to the search widget. This method is more complex, but 
offers complete power over how a search executes. You are not limited to querying 
single tables within ServiceNow  and can define a script that fetches data from 
multiple tables, or from anywhere on the web. To learn more, review the Tutorial: set 
up an external knowledge base search source.

Note: 
Search facets may not behave as expected if integrated into an advanced 
search source that queries data from a non- ServiceNow  site.

Text index groups

A text index group defines how users see search results. For example, combine search results 
from several sources, or set the weight of certain fields.  Text index groups are a ServiceNow AI 
Platform  feature. To learn more, see Configure multiple tables for indexing and searching .

Associate a portal with a text index group to create common search rules and to combine search 
results from all search sources in the group. If you have a custom search source or portal, 
consider whether you want to use the base system portal_index_group  text index group, or 
create your own text index group. The base system text index group includes the Catalog items 
and Knowledge tables. When a user searches for an item in Service Portal, they see combined 
results from these tables.  To add an index group to a portal, see Add a text index group to a 
portal.

Note: 
Text index groups do not support external search sources.

Search suggestions and typeahead search

Search suggestions replaces typeahead search in Service Portal. Update the 
glide.service_portal.search_as_you_type_behavior  system property to 
change this behavior.  For more information, see Enable and disable search suggestions . 
Service Portal  search widgets automatically use whichever feature you enable.

Search facets

Enable your end users to filter search results for a more meaningful result set.  Facets can return 
results based on:

• Fields in a table such as Active  or Author.

• Query conditions such as [Updated][After][Last week].
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Note: 
Only set search facets for indexed fields. Fields that are not indexed may take longer to 
return results and are not optimized for a fast search experience. Learn more: Configure a 
table for indexing and searching .

Search facets render in the Faceted Search widget on the sp_search page.  In new instances, 
search facets are enabled by default. If upgrading from a previous release, enable search facets 
by activating a record in the Page Route Maps [sp_page_route_map] table.  See Enable search 
facets.

Simple

Enable end users to refine search results for a simple search source. You can create 
facets for a table search source that return results based on field values or query 
conditions.  See Add facets to a simple search source.

Advanced

Define facets for advanced search sources using the Facet generation script  on the 
search source record. Use facet APIs to create facets and assign ServiceNow  facet 
items or mapped queries to the facet.

API Use

SPScriptedFacetService - 
Scoped

Creates a single or multi choice facet.

SPScriptedFacet - Scoped Defines facet items, filters, or mapped queries 
for the facet.

Define a search source

Configure a basic search source to query data from an instance table, or configure an advanced 
data fetch script to query data across multiple tables and data sources, or to pull data from 
anywhere on the web.

Before you begin
Role required: admin

Procedure

1. In the platform UI, navigate to Service Portal  > Portals  and select the portal you want to add 
search sources to.

2. From the Search Sources  related list, click New  to add a search source.

3. Define the fields on the Search Source  form.

Search Source form

Field Description

Name The display value for the search category.

ID The record ID. The value should be unique, and should not include 
any spaces or special characters.

Application The scope of the search source.

Roles If the Service Portal User Criteria Support plugin is not enabled, 
define user roles to access this search source.
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Field Description

Search page template
The HTML template that displays the search results. If defining 
a basic search source, you do not need to change the default 
template.

For an example of a modified template, see Tutorial: set up an 
external knowledge base search source.

4. Complete the fields on the Data Source  tab.

Field Description

Is scripted source Adds an advanced data fetch script. If configuring an instance table 
as the data source, do not check this option.

Data fetch script
Script defining the endpoint and API calls to fetch data. This field is 
only visible when Is scripted source  is selected.

For an example of a data fetch script, see Tutorial: set up an external 
knowledge base search source.

Note: 
If defining a facet generation script, inject the facets object into 
the data fetch script and update the script to generate data for 
each facet item. For an example, see the Knowledge Base and 
Service Catalog search sources.  Search facets may not behave 
as expected if integrated into an advanced search source that 
queries data from a non- ServiceNow  site.

Facet generation 
script Script defining search facets for a scripted search source. Enable 

your end users to filter search results for a more meaningful result set. 
This field is only visible when Is scripted source  is selected.

Note: 
If defining a facet generation script, inject the facets object into 
the data fetch script and update the script to generate data for 
each facet item. For an example, see the Knowledge Base and 
Service Catalog search sources.  Search facets may not behave 
as expected if integrated into an advanced search source that 
queries data from a non- ServiceNow  site.

Table Select a table from the list that you want to draw your results from. You 
can select any table in the platform. For example, User [sys_user] or 
Knowledge [kb_knowledge].

Note: 
Only indexed tables return search results. Learn more: 
Configure a table for indexing and searching .

Conditions Filters results based on defined conditions. For example, Active is 
True.

Primary display field Select which field you want to display on the search results page. For 
example, Name.
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Field Description

Display fields Select additional fields to display on the search results page. For 
example, User ID, Email, and City.

Paginate results
Paginates search results. True by default.

If Is scripted source  is selected, the value updates to false. To enable 
pagination for a scripted search source, see Paginate search source 
results.

Define the maximum number of results per query for the search 
source in the Search Page widget or Faceted Search widget instance 
options.

5. Configure Typeahead  settings to allow search results to populate the search field based on 
user input.

Field Description

Enable typeahead Allows typeahead functionality. If you do not want to integrate 
typeahead into your search source, clear the check box.

Advanced typeahead 
config

Optionally add an advanced typeahead script to configure the 
way search results display. For more information, see Create an 
advanced typeahead template.

Typeahead glyph Adds an icon beside each typeahead result.

Page Defines a service portal page to display the selected result. 
For example, if form  is configured, a selected typeahead result 
opens in a form.

6. Click Submit.

What to do next
To enable end users to refine search results, Add facets to a simple search source.

Paginate search source results

Limit the number of results that a search source displays at one time to improve performance. 
End users can load more results as needed.

Before you begin
Role required: admin or sp_admin

About this task
If adding pagination to a simple search source, set Paginate results  on the search source record 
to true. However, if adding pagination to an advanced search source, you must also modify the 
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data fetch script to handle multiple pages of results. When a user loads more search results, the 
search source re-executes the data fetch script.

Note: 
If paginating a search source with advanced facets, do not modify the facet generation 
script to load facets based on the results from each page. Facets should enable end users 
to filter results from an entire result set, rather than page-specific results.

Procedure

1. In the platform UI, navigate to Service Portal  > Search Sources.

2. Open a search source to add pagination to.

3. From the Data Source  tab, set Paginate results  to true.
Enabling this field adds a Load more results  button to the search results page. This flag 
automatically enables pagination for simple search sources.

4. Optional:  If the search source is advanced, modify the data fetch script to handle multiple 
search result pages.
Update the data fetch script using one of the following GlideRecord APIs, depending on the 
scope of the search source.

Scope Method

Global setLocation() in GlideRecord - Global

Scoped application chooseWindow() in GlideRecord - Scoped

The following is an example data fetch script for a global search source that queries the 
incident table and paginates results.

// queryLocation is a special value injected into the script,
// which holds the query_location property of the last item
// in the previously fetched result set
(function(query, queryLocation, count) {
 var results = [];
 var now_GR = new GlideRecord("incident");
 gr.addQuery("123TEXTQUERY321", query);
 gr.query();
 // Here, we are utilizing queryLocation to implement 
 pagination.
 // In practice, there are many other ways to use the
 // query_location value of the last item in the previous
 // result set to implement pagination. Your implementation
 // will vary by use case.
 gr.setLocation(queryLocation - 1);
 
 var resultCount = 0;
 while(gr.next() && resultCount < count + 1) {
  results.push({
   label: gr.getDisplayValue(),
   short_description: gr.getValue("short_description"),
   // Here, we are populating the query_location
   // property of each result item. This is how the
   // framework knows what value to pass into the
   // next fetched search result script execution
   query_location: gr.getLocation(),
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   primary: gr.getDisplayValue(),
   state: gr.getDisplayValue("state")
  });
  resultCount++;
 }
 
 if (results.length == 0)
  return results;
 
 if(results.length > count) {
  results.pop();
 } else {
  // In order to indicate that a result in the result
  // set is the final result (that there are
  // no more results to be fetched), add this property
  // to the final element in your result set.
  results[results.length - 1].isLastResult = true;
 }
 return results;
})(query, queryLocation, count, facets);

For an additional example, see the Knowledge Base search source.

5. Define the maximum number of results per query for the search source in the Search Page 
widget or Faceted Search widget instance options.

Result
The search page only returns the defined number of results at one time. When a user selects 
Load more results, the search source re-executes the query or data fetch script.

Create an advanced typeahead template

Configure the way typeahead results display with an advanced template.
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Before you begin
Note: 
Search suggestions replaces typeahead search in Service Portal. Update the 
glide.service_portal.search_as_you_type_behavior  system property to 
change this behavior.  For more information, see Enable and disable search suggestions . 
Service Portal  search widgets automatically use whichever feature you enable.

Role required: admin

Procedure

1. Complete the required fields in Define a search source.

2. In the Typeahead  tab of the Search Source  record, select the Advanced typeahead config 
check box.

3. In the Typeahead template  field, add an HTML template.

Example 

This example uses AngularJS bindings to display service catalog images in the typeahead 
results.

<i class="ta-img" ng-if="match.model.type=='sc'" 
 style="background-image:url('{{match.model.picture}}')"></i>
<i class="ta-img" ng-if="match.model.type=='sc_guide'" 
 style="background-image:url('{{match.model.picture}}')"></i>
<i class="ta-icon fa fa-file-text-o" 
 ng-if="match.model.type=='sc_content' && 
 match.model.content_type == 'kb'"></i>
<strong ng-if="match.model.type=='sc_content' && 
 match.model.content_type == 'external'">➚</strong>
<span ng-bind-html="match.label | 
 uibTypeaheadHighlight:query"></span>

4. Click Update.
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Typeahead results display beside the image defined in the service catalog record.

Tutorial: set up an external knowledge base search source

Define an advanced search source to return data from any source on the Internet. To understand 
the power of search sources, follow this tutorial to set up an external knowledge base search 
source.

Before you begin
Role required: none

To create an advanced search source, you need authenticated access to an external website via 
a REST API and basic knowledge of AngularJS .

About this task
In this integration, you will:

• Create a data fetch script that uses the ServiceNow  Table API  to query a knowledge base 
from another ServiceNow  instance.

• Decode the JSON response and define the fields that the search widget expects.

• Update the search sources HTML template to open the search result in the external site.

Procedure

1. In the platform UI, navigate to Service Portal  > Portals  and select the portal you want to add 
the search source to.

2. From the Search Sources  related list, click New.
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3. Create a name and ID for the search source.
The ID should be unique, and should not include any spaces or special characters.

4. On the Data Source  tab, select the Is scripted source  check box.

5. Add content to the data fetch script field.

a. Define the search function to be executed by the instance.

Example 

This example uses a Recordless RESTMessageV2 example , but you can modify this 
example to use a pre-configured Outbound REST web service  if needed, or create a more 
secure authentication profile.

(function(query) {
var results = [];
/* Calculate your results here. */
var url= 
 "https://myInstance.service-now.com/api/now/table/kb_knowled
ge?sysparm_query=GOTO123TEXTQUERY321%3D" + encodeURI(query) + 
 "&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccateg
ory%2Ctext";
    var ws = new sn_ws.RESTMessageV2();
        ws.setBasicAuth("search_user", "search");
        ws.setHttpMethod("get");
        ws.setEndpoint(url);
 
        var jsonOutput = ws.execute();
 
return results;
})(query);

Note: 
In the preceding example, ws.setBasicAuth  requires a username and password 
for the remote instance. For more detail, see RESTMessageV2 - Scoped, Global  .

b. Add an if statement to the data fetch script to decode the JSON object being returned, 
iterate over each result, and set expected fields.

Example 

The final data fetch script:

(function(query) {
var results = [];
/* Calculate your results here. */
var url= 
 "https://<my-instance>.service-now.com/api/now/table/kb_know
ledge?sysparm_query=GOTO123TEXTQUERY321%3D" +
encodeURI(query) + 
 "&sysparm_fields=sys_id%2Cnumber%2Cshort_description%2Ccateg
ory%2Ctext";
var ws = new sn_ws.RESTMessageV2();
    ws.setBasicAuth("search_user", "search");
    ws.setHttpMethod("get");
    ws.setEndpoint(url);
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    var jsonOutput = ws.execute();
    if (jsonOutput) {
        var response = new 
 JSON().decode(jsonOutput.getBody());
        results = response.result;
        results.forEach(function(result) {
            result.url = 
 "https://myInstance.service-now.com/kb_view.do?sysparm_artic
le=" + result.number;
            result.target = "_blank";
            result.primary = result.short_description;
        });
    }
 
    if (jsonOutput.haveError()){
        gs.addErrorMessage(jsonOutput.getErrorMessage());
    }
 
return results;
})(query); 

In this example, the following fields are set on the result object:

▪ url: If linking to an external site rather than opening the record in your ServiceNow 
instance, this defines where the link leads to.

▪ target: The target for the link. Set the target to _blank  to open results in a new tab, 
otherwise leave it blank.

▪ primary: The primary field displayed in the search results.

6. Update the search page template to open the search results in the external site.

Example 

<div>
 <a 
 href="https://
myInstance.service-now.com/kb_view.do?sysparm_article={{item.nu
mber}}" target="_blank" class="h4 text-primary m-b-sm block">
    <span ng-bind-html="highlight(item.primary, 
 data.q)"></span>
  </a>
  <span class="text-muted" ng-repeat="f in item.fields | 
 limitTo: 4">
    <span class="m-l-xs m-r-xs" ng-if="!$first"> &middot; 
 </span>
    {{f.label}}: <span ng-bind-html="highlight(f.display_value, 
 data.q)"></span>
  </span>
</div>

7. Click Update.

Result
Test the external search in your portal. Results display under the name field value defined in step 
three.
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Each search result opens in the external site defined in the search page template.

Example: set up a GitHub search source

Set up an advanced search source that queries data from an external website.

Before you begin
Role required: none

To create an advanced search source, you need authenticated access to an external website via 
a REST API and basic knowledge of AngularJS .
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Procedure

1. In the platform UI, navigate to Service Portal  > Portals  and select the portal you want to add 
search sources to.

2. From the Search Sources related list, click New.

3. Create a name and ID for the search source.
The ID should be unique, and should not include any spaces or special characters.

4. On the Data Source  tab, select the Is scripted source  check box.

5. Add content to the data fetch script field.

Example 

To set up a GitHub integration:

(function(query) {
    var results = [];
    /* Calculate your results here. */
    var url = "https://api.github.com/search/repositories?q=" + 
 encodeURI(query);
    var ws = new GlideHTTPRequest(url);
    ws.setBasicAuth("YOUR_USERNAME_HERE", 
 "YOUR_PASSWORD_HERE");
    var jsonOutput = ws.get();
    if (jsonOutput) {
        var response = new JSON().decode(jsonOutput.getBody());
        results = response.items;
        results.forEach(function(result) {
            result.url = result.svn_url;
            result.target = "_blank";
            result.primary = result.full_name;
        });
    }
 
    return results;
})(query);

Note: 
In the preceding example, ws.setBasicAuth  requires a username and password for 
the external resource. For more detail, see GlideHTTPRequest - Global .

6. Use the Search page template to customize the way the search results display.

Example 

<div>
  <div class="pull-right">
    <strong>{{item.language}}</strong>
    <a ng-href="{{item.svn_url}}/stargazers" 
 target="_blank" class="m-l-sm"><span class="fa fa-star 
 m-r-xs"></span>{{item.stargazers_count}}</a>
    <a ng-href="{{item.svn_url}}/network" target="_blank" 
 class="m-l-sm"><span class="fa fa-code-fork 
 m-r-xs"></span>{{item.forks}}</a>
  </div>
  <a ng-href="{{item.svn_url}}" target="_blank" class="h4 
 text-primary m-b-sm block">
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    <span ng-bind-html="highlight(item.full_name, 
 data.q)"></span>
  </a>
  <p>{{item.description}}</p>
  <p>Updated <sn-time-ago 
 timestamp="item.updated_at"></sn-time-ago> ago</p>
</div>

Enable search facets

In new instances, search facets are enabled by default. If upgrading from a previous release, 
enable search facets by activating a record in the Page Route Maps [sp_page_route_map] table.

Before you begin
Role required: admin or sp_admin

About this task
Search facets render in the Faceted Search widget on the sp_search page.  To enable search 
facets after upgrade, activate the page route map record to route your search results to render in 
the sp_search page.

Procedure

1. Navigate to All  > Service Portal  > Page Route Maps.

2. Locate the Search record in the list.
This record redirects users from the search page to the sp_search page when viewing search 
results in Service Portal. The sp_search page includes the Faceted Search widget, which 
supports search facets in both desktop and mobile environments.

3. Set the Active  field to true.

Result
When using search in Service Portal, results render in the sp_search page. Add facets to the 
search source to enable end users to filter search results. To learn more about facets, see Add 
facets to a simple search source.

Add facets to a simple search source

Enable end users to refine search results for a simple search source. You can create facets for a 
table search source that return results based on field values or query conditions.

Before you begin
Role required: admin or sp_admin

In new instances, search facets are enabled by default. If upgrading from a previous release, 
enable search facets by activating a record in the Page Route Maps [sp_page_route_map] 
table.  See Enable search facets. Create facet items and mapped queries with no more than 
30 filter items. To verify, test each search source with a variety of keywords as a user with low 
permissions.

Note: 
Only set search facets for indexed fields. Fields that are not indexed may take longer to 
return results and are not optimized for a fast search experience. Learn more: Configure a 
table for indexing and searching .
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Procedure

1. Navigate to All  > Service Portal  > Search Sources.

2. Open or create a simple search source.
Simple search sources do not use a data fetch script. Rather, they define a table as the source 
of searchable data. To learn more about search sources, see Configuring search in a portal.

3. Select the Facets  related list.

4. Click New.
The Facet form displays.

5. Complete the fields.

Field Description

Name Display name of the facet header.

Application Application scope of the search source. This value is read-only.

Selection type Type of user selection allowed:

◦ Single: Only one filter value can be selected at a time. For 
example, if a facet is created for the Assigned to  field, the 
end user can select Fred Luddy  or Beth Anglin, but not both 
at the same time. Before filtering for a new value, the user 
must first clear the current value.

◦ Multiple: Multiple filter values can be selected at the same 
time. For example, if a facet is created for the Assigned to 
field, the end user can select both Fred Luddy  and Beth 
Anglin. Because multi choice results in an OR query, records 
assigned to either Fred Luddy or Beth Anglin display.

Active Whether the filter option displays in search results.

Use mapped facet filters Maps a facet to a query condition, such as [Updated][After]
[Last week].

When selected, the Fields  and Sort  fields are removed from 
the form. After saving, define filters in the Facet Filters related 
list.

Order Defines the display order when multiple facets are defined.

If some facets do not have an order value defined, facets with 
an order defined display first. Facets without an order defined 
are displayed alphabetically.

Table Table that the query is created for. This value is read-only and 
defined by the table used in the search source.

Field
Field that end users can filter search results by. For example, if 
Active  is selected, the user can filter search results by true or 
false.

Only fields of the following types are supported: True/False, 
Choice, Decimal, Floating Point Number, Integer, IP Address, 
Long, Reference, String, String (Full UTF-8), and URL.

Sort Determines the order in which filter options display.
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Field Description

◦ Ascending: Sorts filter options from A to Z when 
alphabetical, and from lowest to highest when numerical. 
This is the default option.

◦ Descending: Sorts filter options from Z to A when 
alphabetical, and from highest to lowest when numerical.

6. Save the record.
If Use mapped facet filters  is selected, the Facet Filters  related list appears in the facet form.

7. Optional:  If Use mapped facet filters  is selected, define facet filters.
Map facet filters map a query condition to a facet label. When the end user selects the label 
from the facet list, the defined query executes.

a. In the Facet Filters  related list, click New.
The Mapped Facet Form appears.

b. Define the facet filter fields.

Field Description

Name Display name of the facet filter option.

Order Defines the display order when multiple facet filters are defined.

(Optional) If some facet filters do not have an order value defined, 
facets filters with an order defined display first. Facet filters without an 
order defined are displayed alphabetically.

Application The application scope of the search source. This value is read-only.

Facet The search facet that uses the mapped query. This value is read-only.

Table The table defined in the search facet. This value is read-only.

Mapped query A query condition that users can set to filter search results. For 
example, [Updated][On][Today].

c. Click Submit.
Users can filter search results based on the query defined.

Disable facets for a search source

Disable facets for one or more search sources by adding a system property. Once disabled, the 
search source does not display search facets in the Faceted Search widget on the sp_search 
page. You can disable facets for simple or advanced search sources.

Before you begin
Role required: admin or sp_admin

Procedure

1. Enter sys_properties.list  in the Application Navigator to navigate to the System 
Properties table.

2. Click New.
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3. In the Name  field, enter 
glide.service_portal.disable_facets_for_search_sources.

4. In the Value  field, enter a comma-separated list of search source Sys IDs to disable facets for.
Do not include spaces. For example, 
c6170ae86721220023c82e08f585efe6,c96eb1686721220023c82e08f585efff.

5. Click Submit.

Result
Facets do not display when the defined search source is selected in the sp_seach page.

Populate search suggestions in Service Portal

If you are upgrading from a previous release, run a script to populate search suggestions with 
data from a platform search table to provide search suggestions to your users.  Alternatively, you 
can wait until users search for keywords instead of running this script.

Before you begin
Role required: admin
In new instances, the search suggestions are enabled by default. In upgraded instances, you 
must enable the search suggestions. For more information, see Enable search suggestions .

About this task
The ServiceNow AI Platform  collects search data and analytics that generate search suggestions. 
If you are upgrading from a previous release, the search analytics do not contain any data yet. To 
immediately provide suggestions to your users, you can populate the search suggestions using 
data from either the Text Searches [text_search] table or the Service Portal Log Entries [sp_log] 
table. The Service Portal Log Entries table includes search data from Service Portal  only and may 
take less time to populate search suggestions. The Text Search table includes search data from 
the entire platform.

Search suggestions improve over time as more people use Service Portal. Search Suggestions is 
a ServiceNow AI Platform  feature. For more information, see Search Suggestions .

Warning: 
Populating search suggestions can be a resource-intensive task that may take a while to 
complete. Do not run this script during peak hours. Populating search suggestions is not 
supported on domain-separated instances.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Populate Suggestions to avoid Cold Start - Portals  scheduled job.

3. Modify the script for your search implementation.

a. Define which portals the suggestions apply to.
By default, the script populates suggestions in the base system service portal, but you can 
add as many as you want to the array.

var portals = ["Service Portal"];

b. Change where the data comes from
By default, the script imports data from the Text Searches [text_search] table, but you can 
change the source table to the Service Portal Log Entries [sp_log] table. The Service Portal 
Log Entries only saves records from the last 90 days.

var searchLogTable = "text_search";
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c. Push data to any custom search sources in your instance.

Suggestions are not enabled for external search sources. You must push data to both the 
search source name and the Sys ID.

For example, push text searches from the Incident table to your custom Incident search 
source. For more information about custom search sources, see Define a search source. 
By default, the system pushes text searches from the Catalog and Knowledge tables to the 
respective search sources.

Add the following code after line 11 in the script for each of your custom search sources.

searchSources.push("<search-source-table-name>");
searchSourceIds.push("<search-source-sys-id>");

If the search source table does not exist, the system does not push suggestions to that 
search source.

d. Save the record.
Make sure that the script includes the configuration you need. You can only run the script 
once.

4. Activate the record and select Execute Now.
Running this scheduled job populates the Search Events [sys_search_event], Search Source 
Events [sys_search_source_event], and Search Suggestions [sys_search_suggestion] tables.

Result
Users see suggestions when they start typing in a Service Portal  search widget.

Add a text index group to a portal

Define how users see search results. For example, combine search results from several sources, 
or set the weight of certain fields.

Before you begin
Role required: admin
If you have a custom search source or portal, consider whether you want to use the base system 
portal_index_group  text index group, or create your own text index group. The base system text 
index group includes the Catalog items and Knowledge tables. When a user searches for an item 
in Service Portal, they see combined results from these tables.

Note: 
Index tables before adding them to a text index group. To learn more about text indexing, 
see Configure a table for indexing and searching .

Text index groups are a ServiceNow AI Platform  feature. To learn more, see Configure multiple 
tables for indexing and searching .

About this task
Note: 
Text index groups do not support external search sources.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Open the portal that you would like to add a text index group to.
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3. Configure the form to add the Text Index Group  field.

4. Add the text index group you want to the Text Index Group  field.

Result
Search results display according to the text index group's rules.

Set the default portal search source

Use the glide.service_portal.default_search_sources  system property to 
define default search sources.

Before you begin
Role required: admin

About this task
If you don't define specific search sources for your portal, the system uses default search 
sources instead.

Default search source flow chart

Procedure

1. In the Navigation filter, enter sys_properties.list.
The entire list of properties in the System Properties [sys_properties] table appears.

2. On the list, find the system property 
glide.service_portal.default_search_sources, and then open the property 
record.

3. Copy the sys_ID of any search source you want to add into the Value  field of the system 
property using a comma-separated list.

To change the order in which the default search sources show in the Search List, change the 
order of the IDs in the property.

You can remove the default search source behavior by deleting the property value or deleting 
the property altogether.

4. Click Update.
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Configure Search Sources available on a page

Use contextual search to limit search results for an instance of the type-ahead search widget.

With contextual search enabled, users only see type-ahead results for specific search sources. 
For example, searching on the Service Catalog page only shows results from the Service Catalog 
search source when contextual search is enabled.

1. In the Service Portal Designer Service Portal  > Service Portal Configuration  > Service Portal 
Designer, find an instance of the type-ahead search widget.

2. Point to the widget and click the edit icon ( ).

Alternatively, in any preview page containing the type-ahead search widget, for example the 
Service Catalog homepage, control + right-click to open the widget context menu. Then click 
Instance Options.

3. In the Contextual Search Sources field, select search sources from the list.

Search sources listed for contextual search can be limited to just one, several, or all search 
sources.

Default search sources are defined in the 
glide.service_portal.default_search_sources  property, so even if you do not 
have search sources configured, type-ahead search widget still shows type-ahead suggestions. 
For more information on default search sources, see Set the default portal search source.

Managing portal access

Control user access to a portal.

Control who accesses your portal and what they can see in the following ways:

• Authentication: Configure login and single sign on for users

• Limit page access by role: Use roles to limit the users who can see a page.

• Public pages: Use the public  check box on a page record to make the page publicly accessible.

Note: 
A number of portal pages that are installed by default are marked public. Filter your list of 
Service Portal pages for Public [is] true  to identify these pages. Setting the Public  value to 
false  will prevent these pages from being publicly available.

• User criteria: For a more advanced way of limiting user access, create and apply user criteria to 
pages, widgets, widgets instances, and search sources.

• Multifactor authentication: If an instance is configured to require multifactor authentication, 
users are automatically directed to set up multifactor authentication upon initial login. For 
setup instructions, see Setup multi-factor authentication upon initial login . If multifactor 
authentication is optional, users can still enable or disable authentication from their user 
profile. For setup instructions, see Setup multi-factor authentication on your user profile .

Single sign-on, logins, and URL redirects

Service Portal  uses a combination of system properties and script includes to determine how the 
system handles URL redirects for users logging in to the portal.

Only users who understand SSO, URL redirects, and the ServiceNow  platform should make any 
changes.
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Single sign-on and Service Portal

To use single sign-on with Service Portal, you must enable the Integration - Multiple Provider 
Single Sign-On Installer plugin (com.snc.integration.sso.multi.installer).

If you are using the system property to automatically redirect to your primary IdP, then Service 
Portal  automatically redirects to that IdP. If you have multiple identity providers, Service 
Portal  shows a link on the login page to Use external login. For more information on SSO and 
authentication in the platform, see Multiple-Provider single sign-on (SSO) .

To redirect users to the SSO Identify Provider (IdP) login page without 
first redirecting them to the portal login page, you can configure the 
glide.service_portal.sso.early_redirect.portals  system property. For more 
information, see Service Portal properties. If your portal uses a customized version of the Login 
widget, you must update the sp_sso_early_redirection  UI macro as needed to redirect 
users to the SSO Identify Provider (IdP) login page without trying to load the portal page first.

Note: 
Service Portal  has a known issue related to using Multi-Provider SSO and Okta. For more 
information about this issue and a workaround, see the Service Portal: After enabling Multi 
SSO, end users are able to access navpage.do through OKTA if they are already logged in 
[KB0687717]  article in the Now Support  Knowledge Base.

Require authentication for a Service Portal  page

If you want to require authentication for a Service Portal  page, ensure that the Public  flag on the 
page record is not selected. For more information, see Create and edit a page using the Service 
Portal Designer. If a user navigates to a non-public page, they are redirected to the login page for 
the requested portal.

Because every page request is routed through the $sp  page, this page must be public. The 
following values in the Public Pages sys_public  table define the page as public:

• Page: $sp

• Active: true

Configure a portal as the instance login page

Direct all unauthenticated users to a portal login page to log in. The portal login page becomes 
the primary login page for your instance.

Before you begin
Role required: admin

Procedure

1. Add a system property  with the following settings:

◦ Name: glide.entry.page.script

◦ Type: string

◦ Value:

new SPEntryPage().getLoginURL()

2. Optional:  If you need to direct users to a portal other than the default portal, edit the portal 
specified in the SPEntryPage script include.
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(Optional) SPEntryPage uses the default portal on the instance as the portal path to redirect to. 
Employee Center  (esc) is the default portal by default.

Note: 
If you edit the script include, it won't be upgraded with future updates.

a. Navigate to All  > System Definition  > Script Includes.

b. From the Script Includes [sys_script_include] table, search for a script include named 
SPEntryPage.

c. In the Script  field, edit the script to change the assigned portal to the portal_suffix you want.

(Optional) For example, change this.portal = this.getDefaultPortal();  to 
this.portal = "/sp/";  to redirect to Service Portal.

SPEntryPage.prototype  = {
 
    initialize: function() {
        this.logVariables = false; // for debugging 
        this.portal = this.getDefaultPortal(); // The URL suffix for 
 default portal
    },

Note: 
The slash character (/) after /sp  may cause issues when configuring single sign-on. If 
you're experiencing issues, try removing the character from the script.

Redirect to Service Portal after login

Conditionally redirect users to a Service Portal  page after logging in.

Before you begin
Role required: admin

Procedure

1. Enter sys_properties.list  in the navigation filter.

2. In the System Properties [sys_properties] table, add the following properties and values.

Property Type Value Description

glide.entry.first.page.scriptstring new 
SPEntryPage().getFirstPageURL()

First page after 
authentication

glide.entry.page.script string Server script that 
redirects users to 
where to log in. For 
example:

new 
SPEntryPage().getLoginURL()

Contains the call 
to the server script 
include method that 
determines where to 
log in

getFirstPageURL primarily does the following:
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◦ Redirects to login_redirect.do  to break out of the frameset (if there is one).

◦ Redirects to the default portal if the user has no roles or to the full platform for users with 
roles who are not trying to go to a portal directly.

When the user has no roles, they are redirected to the portal equivalent of a page. For 
example,

https://<instance_name>.service-now.com/nav_to.do?
uri=change_request_list.do

sends users without roles to:

https://<instance_name>.service-now.com/sp/?
id=list&table=change_request.

Note: 
This change does not prevent users without roles from accessing the full platform. To 
prevent users without roles from accessing the platform and always redirect to a portal, 
set the value of the glide.entry.loggedin.page_ess  system property to the 
portal suffix, such as /sp.

3. Optional:  Customize the after-login behavior in the SPEntryPage  script include.

(Optional) For more information about modifying script includes, see Script includes .

For example, if you want users with certain roles to be redirected to Service Portal, you could 
modify user.hasRoles()  in the following code.

if (user.hasRoles() && !redirectURL && !isServicePortalURL)

Note: 

◦ If you edit the script include, it won't be upgraded with future updates.

◦ Users with the admin role always pass a user.hasRoles()  check.

◦ If you are using external authentication, ensure that your IdP supports the RelayState 
URL parameter. This parameter retains the originally requested URL while the user 
authenticates, and is necessary for redirection after login.

What to do next
To debug redirection, see Debug Service Portal URL redirects. For additional redirection 
troubleshooting information, see the Frequently Asked Questions on redirection with service 
portal [KB0747432]  article in the Now Support Knowledge Base.

Debug Service Portal URL redirects

Debug the URL redirects for logging in to Service Portal  and redirecting to the first page.

To view debug output from SPEntryPage and see the session variables it redirects based on:

1. Make sure the system property glide.entry.first.page.script has the value: new 
SPEntryPage().getFirstPageURL().

2. From the SPEntryPage script include, set this.logVariables = true.

3. In a separate browser, log in.

4. From the system navigator, view the log output by navigating to System Logs  > System Log  > 
All.
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Configure page security by role

Set up pages to be public or filter them by role.

Before you begin
Role required: admin or sp_admin

About this task
Public pages won't require a user login; anyone can access them. All other options require user 
authentication.

Procedure

1. In the Service Portal configuration page (Service Portal  > Service Portal Configuration), open 
the Page Editor.

2. In the Select Page list, search for the page to apply page security to.

3. Select the highest level node in the tree view.

4. Configure page security.

◦ To make a page public, select the Public  check box. All users can access pages marked as 
Public.

◦ To limit access to a certain role, add roles in a comma separated list. Users without the role 
listed can see links to the page if they appear in the portal. Trying to open the page results in 
a "page not found" error.

Note: 
If you select Public  and add a list of roles, the page is still accessible by any user.

◦ To create a draft page that only administrators can see while the page is still in development, 
select Draft. Users must have the admin role to see any pages in draft. Everyone else sees a 
"page not found" error.

5. Click Save.

Example:

Page with limited access by role

What to do next
Follow the steps in Configure widget security  to configure security for the widgets on your page.
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Configure widget security

Configure widget security to ensure that your widget is being accessed only by the intended 
audience.

Before you begin
Role required: admin or sp_admin

About this task
There are several ways to configure widget security:

• Restrict the widget to users with a login only (authenticated users)

• Restrict the widget to users with certain roles only

• Restrict which tables a public widget can access and return data from for guest 
(unauthenticated) users

When you configure widget security, configure the page security accordingly so that users can 
access the widget via the page on which it appears. For more information, see Configure page 
security by role.

Procedure

1. Navigate to All  > Service Portal  > Widgets.

2. Open the record of the widget to configure.

3. On the form, configure the widget security.

4. Select Update.

User criteria for Service Portal

User criteria enables you to allow access to users based on role, department, group, 
location, or company. Administrators can control access to pages, widgets, widget instances, 
announcements, and search sources in a portal by creating and applying user criteria.

User criteria records define conditions that are evaluated against user records. When user 
criteria is defined, portal records are only visible to users who pass the defined conditions.

User criteria is a platform feature used in Service Portal. Learn more about user criteria in the 
ServiceNow AI Platform:

• Service Catalog: Set security for items and categories .

• Knowledge Management: Control access at the knowledge base level through user criteria .

Important: 
After making user criteria additions or changes, you may need to log out and log back in to 
clear the prior configuration.

Converting role-based permissions to user criteria records

User criteria in Service Portal  replaces role-based permissions. After activating the user criteria 
for Service Portal  plugin, you must Set the user criteria for Service Portal system property  to 
true. When the system property is set to true, any existing roles defined for a page, widget, or 
search source are automatically converted into user criteria records. To disable user criteria and 
continue using role-based permissions, set the system property to false.
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User criteria checks

User criteria uses the following checks in Service Portal  to verify user access.

Page access user criteria

The following diagram shows how the system decides whether a user can access a page based 
on user criteria.

Widget access user criteria

The following diagram shows how the system determines whether a user has access to a 
particular widget or widget instance.
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Activate the user criteria for Service Portal plugin

You can activate the Service Portal  User Criteria Support plugin (com.glide.service-portal.user-
criteria) if you have the admin role.

Before you begin
Activating the plugin creates user criteria records for Service Portal  records already on the 
instance. The plugin does not create user criteria for any Service Portal  records added by plugins 
installed after this one. For those records, you must manually create or import the user criteria.

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Zurich)

Set the user criteria for Service Portal system property

After activating the Service Portal  User Criteria Support plugin, you must set the system property 
to true.
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Before you begin
Role required: admin

About this task
Setting the system property activates user criteria for Service Portal. When the system property 
is set to true, any existing roles defined for a page, widget, or search source are automatically 
converted into user criteria records. To disable user criteria and continue using role-based 
permissions, set the system property to false.

Procedure

1. Navigate to All  > Service Portal  > Properties.

2. Click the check box to set the following property to true.

3. Click Save.

Create a user criteria record for Service Portal

Create a user criteria record to apply to items in Service Portal  and control user access to pages, 
widgets, widget instances, and search sources.

Before you begin
Role required: admin

About this task
You can apply existing user criteria  to records in Service Portal  through Service Portal 
configuration (Service Portal  > Service Portal configuration). You can only create user criteria 
within the platform UI.

Procedure

1. In the navigation filter, type Service Portal.

2. Select a page, widget, or widget instance record.

3. In the related list at the bottom of the record, select the Can View  or Cannot View  tab, then 
click New.

If a user criteria record is already created, you can click Edit  to apply user criteria to the page, 
widget, or widget instance.

User criteria records are stored in the [user_criteria] table.

4. Complete the fields on the form, as appropriate.

Service Portal  User Criteria

Field Description

Name Name of the criteria record.

Users User records to match access criteria.

Groups Group records to match access criteria.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

939



Field Description

Roles Roles to match access criteria.

Advanced Displays or hides the Script  field.

Script Defines any additional criteria, and returns true or false. This field is available 
only if Advanced  is selected.

Note: 

◦ Because scripts are evaluated dynamically, including scripts in user 
criteria records can decrease performance.

◦ Do not use a function with its name as answer, that is, answer().

Application Application scope for the user criteria record.

Active Activate or deactivates this criteria record.

Companies Companies to match access criteria.

Locations Locations to match access criteria.

Departments Departments to match access criteria.

Match All Determines whether all elements from each populated criteria field must 
match. If selected, only users who match all criteria are given access. If 
cleared, the user must meet one or more of the set criteria to be given access.

By default, this check box is cleared so that any condition met provides a 
match.

For example, consider a user criteria record for the following:

◦ Locations A or B

◦ Company C or D

With Match All  selected, only users meeting all these conditions are matched. 
For example, a user with a location A and a company C.

With Match All  cleared, users meeting any of these conditions are matched. 
For example, a user with a location B.

Note: 
If you select Match All, ensure that you do not create contradictory 
conditions that can never be met. For example, if all users in location A 
work for company G, then the conditions in this example can never be 
met.

5. Click Submit.

Apply user criteria to a page, widget, or widget instance

Assign user criteria to pages, widgets, or widget instances to limit user access to content in a 
portal.

Before you begin
Activate the Service Portal User Criteria Support (com.glide.service-portal.user-criteria) plugin 
and set the glide.service_portal.user_criteria_enabled  system property to 
true.
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Role required: admin or sp_admin

About this task
You can apply several user criteria records to a single portal item.

Procedure

1. In the Service Portal Configuration page (Service Portal  > Service Portal Configuration), open 
the Page Editor.

2. Select a page from the list.

3. Select a page, widget, or widget instance node from the page tree.

4. Under related lists, click Who Can View  or Who Cannot View.

5. Click New.

6. Select a criteria from the Can View  or Cannot View  list.

Selecting criteria from the Can View  or Cannot View  list applies user criteria records created 
in Create a user criteria record for Service Portal  to the selected page, widget, or widget 
instance.

7. Click Save.

Apply user criteria to a search source

Assign user criteria to search sources to limit user access to content in a portal.

Before you begin
Role required: admin

About this task
You can add user criteria to custom or default Configuring search in a portal.

Procedure

1. In the Service Portal Configuration page (Service Portal  > Service Portal Configuration), 
navigate to Portal Tables  > Search Source  in the header menu.

2. Open the search source record that you would like to modify.

3. Under related lists, click Who Can View Search Sources  or Who Cannot View Search 
Sources.

4. Click New.

5. Select a criteria from the Can View  or Cannot View  list.

Selecting criteria from the Can View  or Cannot View  list applies user criteria records created 
in Create a user criteria record for Service Portal  to the selected search source.

6. Click Save.

Enable e-signature for Service Portal

You can configure e-signature in Service Portal  to require re-authentication from approving users.

Before you begin
The com.snc.integration.esig.window  system property is supported to enable SSO 
login in a new window.

Role required: admin
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Procedure

1. Activate the Approvals with e-Signature [com.glide.e_signature_approvals] plugin.

2. Navigate to System Definition  > e-Signature Registry.

3. Add any tables you want to require an e-signature for to the list.

Result
With e-signature enabled, approvers are required to provide a password to approve or reject any 
requests. Authentication with touch ID works in the mobile app. On the mobile web, approvers 
are still required to enter a password. For more information on configuring e-signature, see 
Approval with e-signature .

Enable SSO login in a new window

Open a new window for SSO authentication when using e-Signature for approvals.

Before you begin
Security Assertion Markup Language (SAML) login is only supported on the desktop Service 
Portal.

For additional information, see the e-signature SSO login KB article .

Role required: admin

Procedure

1. Enter the spEsignatureCustom script.

a. Enter sys_ui_script.list  in the Filter navigator.

b. Select New, and create a new UI script.

c. On the UI Script form, enter spEsignatureCustom  in the API Name field.

d. In the UI Type field, select Mobile/Service Portal.

e. Paste the spEsignatureCustom script  in the Script  field.

f. Select Submit.

2. Enter the spAuthCustom script.

a. In the same sys_ui_script.list  table, create another new UI script by selecting New.

b. On the UI Script form, enter spAuthCustom  in the API Name field.

c. In the UI Type field, select Mobile/Service Portal.

d. Paste the spAuthCustom script  in the Script  field.

e. Select Submit.

3. Associate the UI scripts to the JS Include record.

a. Navigate to Service Portal  > Portals.

b. Identify the Service Portal you want to apply the esignature support to and select the Theme.

c. In the related lists, select JS Includes.

d. Select New.

e. On the form, fill in the fields.
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JS Include form

Field Description

Display name Name for your JS Include. Enter 
spEsignatureCustom  and associate 
the record with the spEsignatureCustom 
UI script you created, or enter 
spAuthCustom  and associate the record 
with spAuthCustom you created.

Source Source for your JS Include record. Select UI 
Script.

UI script UI script source for your JS Include record. 
Select either spEsignatureCustom or 
spAuthCustom depending on the record 
you're creating.

Application Application for your JS Include record. The 
default application is Global.

Updated Field displaying when the record was last 
updated.

Package Field that establishes the JS Include 
package.

f. Select Submit.

Result
A new window opens when you use E-Signature for approvals.

spEsignatureCustom script

Paste the spEsignatureCustom script in the sys_ui_script.list script field.

angular.module('sn.$sp').provider('spEsignature', function() {
 'use strict';
 
 this.$get = function spEsignature($q, $http, $window, urlTools, 
 xmlUtil) {
  var w = window;
  var esignOW;
  var windowWidth;
  var windowHeight;
  var redirectURL;
 
  function isWindowChosen() {
   var postParams = {
    sysparm_scope: 'global',
    sysparm_processor: 'ESignatureAuthUtils',
    sysparm_name: 'isWindowChosen'
   };
   return $http({
    method: 'POST',
    url: '/xmlhttp.do',
    data: urlTools.encodeURIParameters(postParams),
    headers: {
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     'Content-Type': 'application/x-www-form-urlencoded'
    },
    transformResponse: function(response) {
     return xmlUtil.getDataFromXml(response);
    }
   }).then(
    function(response) {
     var data = response.data ? response.data[0] : {};
     return data.answer ===  'true'
    },
    function(response) {
     // Handling failure case.
     switch (response.status) {
      default:
      case 404:
       return false;
     }
    });
  }
 
  function initiateEsignature() {
   var postParams = {
    sysparm_scope: 'global',
    sysparm_processor: 'ESignatureAuthUtils',
    sysparm_name: 'fetchAuthDetails'
   }
   return $http({
    method: 'POST',
    url: '/xmlhttp.do',
    data: urlTools.encodeURIParameters(postParams),
    headers: {
     'Content-Type': 'application/x-www-form-urlencoded'
    },
    transformResponse: function(response) {
     return xmlUtil.getDataFromXml(response, 'result');
    }
   }).then(
    function(response) {
     var data = response.data ? response.data[0] : {};
     process(data);
    });
  }
 
  function process(data) {
   var shouldLogoutFirst = data.logoutFirst === 'true';
   w['windowHeight'] = data.popup_window_height;
   w['windowWidth'] = data.popup_window_width;
   w['redirectURL'] = data.loginURL;
   if (shouldLogoutFirst)
    openEsignatureWindow(data.logoutURL);
   else
    authenticate();
  }
 
  function openEsignatureWindow(url) {
   w['esignOW'] = window.open(url, 'esignatureAuthentication',
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 'height='+w['windowHeight']+',width='+w['windowWidth']+',top=10
0,left=100,toolbar=0,location=0,menubar=0');
  }
 
  w['authenticate'] = function(){
   if(w['redirectURL']){
    if(w['esignOW']) //when we signed out previously, a window 
 is already opened. reuse it.
     w['esignOW'].location.href = w['redirectURL'];
    else
     openEsignatureWindow(w['redirectURL']);
   }
  };
 
  w['evaluateRedirect'] = function(msg) {
   w['esignOW'].close();
   if (msg == "saml2 login complete") {
    $window.onReauthenticationComplete(msg);
   }
  };
 
  return {
   isWindowChosen: isWindowChosen,
   initiateEsignature: initiateEsignature
  };
 
 };
});

spAuthCustom script

Paste the spAuthCustom script in the sys_ui_script.list script field.

angular.module('sn.$sp').factory('spAuthModal', function($q, 
 spModal, i18n, $http, spAuthentication, glideUserSession, 
 cabrillo, $cookies, $window, spUtil, $uibModal, spEsignature) {
 "use strict";
 
 function _showAuthenticationModal(requestParams, username, 
 userSysId) {
  var currentUser;
  var deferred = $q.defer();
  glideUserSession.loadCurrentUser({reload: 
 true}).then(function(user) {
   if (!user) {
    deferred.reject({
     error: {
      status: 'ANONYMOUS',
      message: i18n.getMessage('Not logged in')
     }
    });
    return;
   }
   currentUser = user;
   var serializedUser = {
    sysId: currentUser.userID,
    userName: currentUser.userName,
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    firstName: currentUser.firstName,
    lastName: currentUser.lastName
   };
 
   // hand off to native clients
   if (cabrillo.isNative()) {
    cabrillo.auth.reauthenticate(currentUser).then(function() {
     deferred.resolve(serializedUser);
    }, function(error) {
     if (error && error.status) {
      deferred.reject({
       error: error
      });
     }
     //TODO: Handle rejection a little more gracefully
     deferred.reject();
    });
    return;
   }
 
   var loginMethod = currentUser.$private.loginMethod;
   if (!loginMethod) {
    // As we were unable to determine the login method via the 
 HTTP session, trying to get glide_sso_id cookie which is set in 
 case of multisso login
    var providerSysId = $cookies.get('glide_sso_id');
    loginMethod = providerSysId ? 'multisso' : 'db';
   }
 
   if (loginMethod === 'saml' || loginMethod === 'oidc' || 
 loginMethod === 'multisso') {
    spEsignature.isWindowChosen().then(function(result) {
     var modal;
     if (!spUtil.isMobile() && loginMethod !== 'oidc' && result 
 === true) {
      // If enabled, Opening a new window for desktop saml login
      spEsignature.initiateEsignature();
     } else {
     
 glideUserSession.getSsoReauthenticationUrl().then(function(url) 
 {
       requestParams.externalLoginURL = url;
       openExternalAuthModal(requestParams).then(function(m) {
        modal = m;
       });
      });
     }
     $window.onReauthenticationComplete = function(result) {
      deferred.resolve(serializedUser);
      if (modal)
       modal.close();
     };
    });
   } else {
    spModal.open({
     title:i18n.getMessage("Approver authentication"),
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     message:i18n.getMessage("Additional authentication is 
 required, enter your usename and password to continue."),
     footerStyle: {border: 'none', 'padding-top': 0},
     widget: 'simpleloginui',
     widgetInput: {},
     shared: requestParams,
     onSubmit: function() {
      return onLoginModalSubmit(requestParams, username);
     }
    }).then(function(confirm) {
     if (confirm.label == i18n.getMessage("OK")) {
      deferred.resolve(serializedUser);
     } else {
      deferred.reject();
     }
    });
   }
  });
 
  return deferred.promise;
 }
 
 function onLoginModalSubmit(requestParams, username) {
  //(1) call login service to verify auth
  //(2) verify same user
  return $q(function(resolve, reject) {
   var errorMessage = null;
 
   if(!requestParams.username || requestParams.username.trim() 
 === "" ||
     !requestParams.password || requestParams.password.trim() 
 === "") {
    errorMessage = i18n.getMessage("User name or password 
 invalid");
   } else if(requestParams.username !== username) {
    errorMessage = i18n.getMessage("Attempted to authenticate as 
 a different user");
   }
 
   if(!errorMessage || errorMessage === "") {
    spAuthentication.validateCreds(requestParams.username, 
 requestParams.password).then(function(res) {
     resolve({status: res.success, errorMessage: res.message});
    });
   } else {
    resolve({status: !errorMessage || errorMessage === "", 
 errorMessage: errorMessage});
   }
  });
 
 }
 
 function openExternalAuthModal(requestParams) {
  var deferred = $q.defer();
 
  var options = {
   title: i18n.getMessage("Approver authentication"),
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   message: '',
   messageOnly: false,
   errorMessage: '',
   input: false,
   label: '',
   size: 'lg',
   value: '',
   required: false,
   footerStyle: {border: 'none', 'padding-top': 0},
   values: false,
   onSubmit: null,
   widget: 'simpleloginui',
   widgetInput: {},
   shared: requestParams,
   buttons: [{label: i18n.getMessage('Cancel'), cancel:true}]
  };
 
  var widgetURL = spUtil.getWidgetURL(options.widget);
  $http.post(widgetURL, 
 options.widgetInput).success(function(response) {
   options.widget = response.result;
   options.widget.options.shared = options.shared;
   var modal = $uibModal.open({
    templateUrl:'sp-modal.html',
    controller: spModalCtrl,
    size: options.size,
    resolve: {
     options: function() {
      return options;
     }
    }
   });
 
   deferred.resolve(modal);
  });
 
  return deferred.promise;
 }
 
 function spModalCtrl($scope, options) {
  $scope.options = options;
  $scope.form = {};
 
  $scope.buttonClicked = function(button){
   if (button.cancel) {
    $scope.$dismiss();
    return;
   }
  }
 }
 
 return {
  prompt: _showAuthenticationModal
 }
}).decorator("spAuthModal", function($delegate) 
 { return( $delegate );});
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Enable external user self-registration for Service Portal

Enable external users to register to a ServiceNow  app through Service Portal.

Before you begin
Role required: admin

Complete the previous tasks:

1. Activate External User Registration

2. Configure the registration form for an external user configuration

Role required: admin

About this task
External user self-registration enables a large group of users to register to a ServiceNow  app 
without the help of an administrator. For more information, see Enable external users to self-
register to your ServiceNow instance .

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Open a portal record.

3. On the form, fill in the External user registration configuration  field.

Select a user registration configuration.

4. Click Update.

Result
The login widget includes a link to the registration form that you previously configured.

Register your PIV/CAC card for Service Portal  login

Register your Personal Identity Verification (PIV) or Common Access Card (CAC) card so that you 
can log in to your organization's portal without entering a password.

Before you begin
To register your PIV/CAC card, an administrator must activate certificate-based authentication 
and then set up PIV/CAC authentication. For more information on this setup process, see 
Personal Identity Verification (PIV) card or Common Access Card (CAC) based authentication .

The following task assumes that you have a card reader connected to your system.

Role required: none

Procedure

1. Log in to a portal using your user name and password.

2. In the portal, open your user profile.

3. Insert your PIV/CAC card into a card reader and then select Register your client certificate.
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4. In the dialog box that appears, review the PIV/CAC certificate and then select Register.

If the registration is successful, the system provides the following alert message: The PIV/
CAC certificate has been successfully registered and linked to 
the user account.

Close the dialog box to finish.
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Result
The next time you log in to your portal, you can log in using your PIV/CAC card. To log in, insert 
your PIV/CAC card into a card reader and then select Login with PIV/CAC card.

To log out of the portal, select your avatar and then select Logout. Then, close the browser 
window.

Related topics

Login widget

Deactivate a portal

Turn off access to a portal that you no longer want users to visit and optionally redirect them to 
another portal.

Before you begin
Role required: sp_admin or admin

About this task
After you deactivate a portal, users are either redirected to an alternate portal that you configure, 
or they receive a message that the portal is inactive.
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If an alternate portal is selected, pages are redirected by replacing the URL suffix of the inactive 
portal with the suffix of the alternate portal. To confirm that users are redirected to the correct 
page, complete the following steps:

• Verify that all necessary resources, such as knowledge base articles and catalog items, are 
available on the alternate portal.

• If different pages are used on each portal, set up page route maps to map pages from the 
inactive portal to the alternate portal. For more information, see Redirect a reference to a page 
ID.

• If customizations exist for page redirects using the SPEntryPage script include or other 
methods, test these customizations thoroughly to confirm that there are no conflicts or remove 
the customizations. For more information, see Single sign-on, logins, and URL redirects.

To support deactivating and reactivating public portals without search engines deindexing their 
pages, temporary HTTP 302 redirects are used for inactive portals.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select a portal.

Note: 
You can't deactivate the default portal on an instance or any portal configured as an 
alternate portal for an inactive portal. You can't deactivate or redirect to the Mobile 
Employee Service Portal (/mesp).

3. Select Inactive.

4. Optional:  In the Alternate portal  field, select an active portal to which to redirect users who 
attempt to access the inactive portal.
Multiple inactive portals can redirect to the same alternate portal.

5. Select Update.

Result
If you selected an alternate portal, users attempting to access the inactive portal are redirected 
to the alternate portal. They receive a message informing them that they've been redirected. For 
example:

If you don’t specify an alternate portal, users receive a message that the portal has been 
deactivated. You can customize these messages from the Message [sys_ui_message] table. For 
more information see, Message table .

To reactivate a portal, clear the Inactive  option.

Developing custom widgets

Develop custom widgets for portals using AngularJS, Bootstrap, and the ServiceNow  API.

Before you begin

To develop widgets, you need ServiceNow  API experience to:
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• Run record queries on the server.

• Create and update records.

You need AngularJS experience to:

• Bind variables to client controllers.

• Access server objects in a widget.

• Gather user input.

Optionally, you can build on the Bootstrap template by accessing Bootstrap components.

Parts of a widget

Like Angular directives, widgets execute a specified behavior within a Service Portal  page. A 
widget includes mandatory and optional scripting components.

HTML template

A mandatory widget component.

The HTML template requires knowledge of AngularJS to display and gather data. 
Use the HTML template to:

• Render the dynamic view that a user sees in the browser using information from 
the model and controller.

• Bind client script variables to your markup.

• Gather data from the end user.

Client script

A mandatory widget component.

A client script requires knowledge of both the ServiceNow  API and AngularJS to 
create a client controller. Use the client script to:

• Map server data from JavaScript and JSON objects to client objects.

• Process data before rendering it.

• Pass data to the HTML template.

• Pass user input and data back to the server for processing.

Server script

A mandatory widget component.

A server script requires knowledge of the ServiceNow  API to work with record data. 
Use the server script to:

• Set the initial state of the widget.

• Send record data to the widget client script using the data  variable.

• Run server-side queries.

Link function
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An optional widget component.

The link function requires knowledge of AngularJS. Use a link function to directly 
manipulate the DOM.

Option schema

An optional widget component.

Allows a Service Portal  admin to configure a widget. Use the option schema to:

• Specify the parameters for a widget.

• Allow admin users to define instance options for a widget instance.

• Develop flexible, reusable widgets.

Angular Providers

An optional widget component.

Angular Providers require knowledge of AngularJS. Use Angular Providers to:

• Keep widgets in sync when changing records or filters.

• Share context between widgets.

• Maintain and persist state.

• Create reusable behaviors and UI components and inject them into multiple 
widgets.

Dependencies

An optional widget component.

A widget dependency is an external resource used by your widget such as 
JavaScript or CSS files.

Global objects in widgets

When a widget begins to render for the first time on a page, the server script executes first and 
accesses three global objects: input, options, and data. Because the input  variable is a data 
object sent from the client script, this variable is undefined when first initialized.
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When a widget is first instantiated, the server script:

1. Initializes an empty data  object.

2. Initializes the input  object with any data sent from the client controller, or the options  object 
with any data used to initialize the widget.

3. Sends the data  object to the client controller as JSON.

The client script:

1. Accesses the server data  object using c.data.

Note: 
By default, widgets use the c  variable to represent the controller instance using 
controller as  syntax. You can change this variable when creating or cloning 
widgets.

2. Uses server.update()  to post changes to the data model. This method updates the 
server script using the input  object.

Note: 
After calling server.update(), the client script data  object is automatically 
overwritten by the server script data  object.

3. Uses c.options  to access the values used to invoke the widget on the server. This object is 
read-only.
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Using the Widget Editor

When you create a widget, a record is created in the sp_widget table. However, you can use the 
Widget Editor in Service Portal  Configuration as your scripting environment. The Widget Editor 
is a full page application similar to an IDE. You can show the parts of the widget you want to edit 
and hide the rest, while previewing your changes in real time.

Note: 
For server-side scripts, you can turn on using the ECMAScript 2021 (ES12) JavaScript mode 
if your application uses ES5 Standards mode or Compatibility mode. Scripts in applications 
with the JavaScript mode set to ECMAScript 2021 (ES12) use ECMAScript 2021 (ES12) by 
default. For more information, see Turn on ECMAScript 2021 (ES12) mode for a script .

General guidelines for developing widgets

When developing custom widgets, keep these general guidelines in mind for optimal 
performance, scalable development, and a good user experience.

Create a default state that provides an example to the end user

A widget does not have instance options defined when initially added to a page. 
A widget in this empty state can appear blank and cause confusion. In situations 
where a widget requires some initial configuration, ensure that your widget has a 
default state that communicates to the admin what configuration is necessary.

Widgets can also be created with demo data. Demo data can also be used to:

• Clearly demonstrate the widget functionality to the user.

• Provide data when previewing the widget in the widget editor. (Demo data is not 
visible in the designer).

Learn more: Tutorial: Build a custom widget.

Embed a widget rather than clone when possible

Embedding an existing widget into your custom widget takes advantage of pre-
existing functionality without cloning or duplicating code. You can still pass 
parameters into the embedded widget to control its behavior.

Learn more: Embed an existing widget

Avoid using large data sets to improve performance

Querying data, evaluating ACLs, running business rules, and data processing take 
time and can slow performance. Determine how much data portal users need and 
then apply the appropriate limits and filters to your scripts and queries. Isolate 
widgets that require significant data or processing to their own separate pages in 
the portal. Avoid implementing the following items that use large data sets:
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• Scripted menu items that load large amounts of data, which can cause every page 
in the portal to load slowly.

• Large files and attachments, such as high-definition media files or fonts from the 
Attachments [sys_attachment] table.

• Auto-refreshing widgets. Every time a widget's client controller calls 
server.update(), spUtil.update(), server.refresh(), or 
spUtil.refresh(), the application runs the widget's server script and sends 
a data object back to the client.

• Unfiltered record watchers. The recordWatch()  function watches for updates 
to a table or filter and returns the value from the callback function. Adding filters 
for specific fields to watch reduces the number of calls a widget makes to the 
server. Specifying when to refresh widgets in response to a record producer 
notifying the client that there is an update in the callback function can also 
improve performance.

• Server-side scripts with GlideRecord queries without the setLimit  function. 
Using the setLimit  function can restrict the number of records returned and 
improve response time on queries. For added flexibility, you can tie this limit 
to an instance option rather than assigning a hard-coded value (for example: 
gr.setLimit(options.limit || 100)).

Learn more:

• Six common performance pitfalls in Service Portal and how to avoid them 
[KB0634588]

• spUtil - recordWatch

• GlideRecord setLimit Function

Create a directive instead of embedding a complex widget

When an embedded widget is called from the server, all the scripts associated with 
that widget are returned. If you only need a subsection of a widget, embedding 
the entire widget creates unnecessary overhead. Instead, use directives to share 
lightweight code between widgets. Directives are useful, for example, when building 
UI components. Complex components with server-side and client-side functionality 
are best left as widgets. Use a directive instead of an embedded widget to:

• Share scope or custom scope behavior with multiple widgets.

• Share a reusable, lightweight subsection of a widget.

• Share a common UI feature, such as a list or an avatar.

• Augment widget behavior.

Learn more: Reuse components with Angular Providers.

Use a service or factory to share data and persist state

Data services and factories maintain and persist state in a widget without requiring 
multiple calls to the server, enabling you to:

• Keep widgets synchronized when changing records or filters.

• Share data between widgets.

• Develop more performant widgets.
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Learn more: Reuse components with Angular Providers.

Handle events with a publish/subscribe service

Avoid using $broadcast  in the DOM. $broadcast  dispatches the event name to 
all child scopes notifying registered listeners, which can be an expensive call that 
requires the use of the $rootScope  global object.

Instead, use a publish/subscribe service to handle events. When using a publish/
subscribe service, a clear relationship forms between your widgets through callback 
handlers. In this model, you can better control the state of your events.

Use REST calls or server.get  to fetch data from the server

When you call server.update(), the entire widget is returned from the server. 
If your widget includes divergent code paths, multiple calls to update the server can 
affect performance. As a rule, use your server script to set up the initial state of your 
widget. For subsequent updates, use scripted REST APIs that call script includes on 
your instance. This practice:

• Separates business logic from UI elements.

• Centralizes your code, allowing changes to be made in one place.

You can also use server.get  to pass information to the server. Use this function 
along with input.action  to execute specific parts of the server script.

Develop with localization, accessibility, and UI in mind

To create the best experience for your users, follow these guidelines:

• Consider the impact of your widget in a mobile environment. For example, avoid 
using mouse-over and other events that do not translate to a mobile device.

• Use SCSS variables to reuse items. See SCSS variables.

• Use variable names when using colors.

• Wrap strings for translation in localization APIs. See Internationalize a widget.

Remove unused Angular Providers from client script

For easier maintenance, remove any unused Angular Providers that were injected 
into the client script function statement.

Avoid using <script> tags in HTML templates

To lessen the likelihood of production issues in Service Portal, avoid using inline 
templates using <script> tags in a widget's HTML template. Instead, create a related 
Angular ng-template record for the widget.

Tutorial: Build a custom widget

Follow this tutorial to build a custom widget that displays Service Catalog  items. Use this tutorial 
as a model to help you understand the advanced scripting power of the Service Portal.

In this tutorial, you will create the Quick Order widget. This widget:

• Displays popular items to the user prior to any search.

• Queries the Service Catalog  and displays available options to the user.
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• Includes an embedded SC Catalog Item widget, allowing the user to view and order items 
within the Quick Order widget.

• Uses an Angular Provider to display a category icon beside each queried item.

Create a widget and set up a template

Create the Quick Order widget to query items in the Service Catalog.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  and click Widget Editor.

2. Click Create a new widget.

3. Define the following values.

◦ Widget Name: Quick Order

◦ Widget ID: quick_order

◦ Create a test page: Active

◦ Page ID: quick_order

Adding a widget to a test page creates a record in each of the following tables:

◦ sp_page

◦ sp_container

◦ sp_row

◦ sp_column

◦ sp_instance

◦ sp_widget

Note: 
You can use the Page Editor in Service Portal Configuration to view the hierarchy of 
elements on your test page.

4. Click Submit.

5. From the Widget Editor, open the Quick Order widget.

6. Add the following simple template to the HTML field.

<div class="panel panel-primary">
 <div class="panel-heading">Request an item from the 
 catalog</div>
 <div class="panel-body">
   My catalog results
 </div>
</div>

7. Click Save.

8. Preview your test page in a new tab using the following URL: <yourInstanceUrl>/sp?
id=quick_order.
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Your widget template displays on the test page.

Add a server script to query an instance table

After adding your widget and creating a basic template, you can define advanced client and 
server scripts that enable users to query data from an instance table. You can pass the data 
model between the client and server by querying data from the database, displaying it to the 
user, and sending any updates back to the server.

Before you begin
Role required: admin or sp_admin

Procedure

1. From the Widget Editor, open the Quick Order widget.

2. Select Server Script  to open the server script field.

3. Replace the default server script with the following custom script.

(function() {
 if  (input.keywords != null && input.keywords != '')
  data.items = getCatalogItems(input.keywords);
 
 function  getCatalogItems(keywords) {
  var  sc = new  GlideRecord('sc_cat_item');
  sc.addActiveQuery();
  sc.addQuery('123TEXTQUERY321', keywords);
  sc.addQuery('sys_class_name', 'NOT 
 IN', 'sc_cat_item_wizard,sc_cat_item_content');
  sc.addQuery('sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
  sc.setLimit(100);
  sc.orderByDesc("ir_query_score");
  sc.query();
  var  results = [];
  while  (sc.next()) {
   if  (!$sp.canReadRecord(sc))
    continue;
 
   var  item = {};
   $sp.getRecordDisplayValues(item, sc, 'name,price,sys_id');
   item.category = sc.getValue('category');
   results.push(item);
  }
  return  results;
 }
})();

This script performs a keyword search on the sc_cat_item table using the 123TEXTQUERY321 
query method.

4. Replace the HTML template with the following script:
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<div class="panel panel-primary">
 <div class="panel-heading">Request an item from the 
 catalog</div>
 <div class="panel-body">
   <input class="form-control" type="search" placeholder="Start 
 typing here to search the list of catalog items" 
 ng-model="c.data.keywords" ng-change="c.server.update()" 
 ng-model-options="{debounce: 250}" />
   <ul class="list-group result-container">
     <li class="list-group-item" ng-repeat="item in 
 c.data.items">
       <a href>{{item.name}}</a><span 
 class="pull-right">{{item.price}}</span>
     </li>
   </ul>
 </div>
</div>

This template adds a search field and displays the results of the query performed in the server 
script using the following Angular directives. To learn more about these directives, review the 
Angular API Reference .

Angular directives used in the template

Angular directive Description

ng-model Automatically reads and writes value changes to the model variable 
c.data.keywords.

ng-model-options Configures ng-model behavior. In this template, ng-model updates 
the model after a user has stopped typing for 250 milliseconds.

ng-change Executes c.server.update()  after the model value changes. 
This function posts the data object to the server script. After the 
script is executed, the data object is automatically updated with the 
new values from the server generated data object.

ng-repeat Creates a template from the parent element and child elements. 
For each item in c.data.items, an instance of the 
template is created and the expressions {{item.name}}  and 
{{item.price}}  are replaced with the values from each item.

5. Add the following script to the CSS - SCSS  field:

.result-container {
 margin-top: 10px;
}

6. Refresh your test page preview to view the changes.
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As you type in the search box, matching catalog items appear. Try searching for ipad.

Manage the empty state of a widget

Display a list of popular items to the user before any search terms are entered.

Before you begin
Role required: admin or sp_admin

About this task
Because no search has been executed when the widget initializes, the server input  variable is 
undefined. This empty state may cause confusion when a user first interacts with the widget. To 
solve this issue, give your widget something to display when the input  variable is empty. This 
initial data can guide your users when initially interacting with your widget.

Procedure

1. From the Widget Editor, open the Quick Order widget.

2. Replace the existing server script with the following script:

(function() {
    if  (input.keywords != null && input.keywords != '')
        data.items = getCatalogItems(input.keywords);
    else  data.items = getPopularItems();
 
    function  getCatalogItems(keywords) {
        var  sc = new  GlideRecord('sc_cat_item');
        sc.addActiveQuery();
        sc.addQuery('123TEXTQUERY321', keywords);
        sc.addQuery('sys_class_name', 'NOT 
 IN', 'sc_cat_item_wizard,sc_cat_item_content');
        sc.addQuery('sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4');
        sc.setLimit(100);
        sc.orderByDesc("ir_query_score");
        sc.query();
        var  results = [];
        while  (sc.next()) {
            if  (!$sp.canReadRecord(sc))
                continue;
 
            var  item = {};
            $sp.getRecordDisplayValues(item, 
 sc, 'name,price,sys_id');
            item.category = sc.getValue('category');
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            results.push(item);
        }
        return  results;
    }
 
    function  getPopularItems() {
        var  items = [];
        var  count = new  GlideAggregate('sc_req_item');
        count.addAggregate('COUNT', 'cat_item');
        count.groupBy('cat_item');
        count.addQuery('cat_item.sys_class_name', 'NOT 
 IN', 'sc_cat_item_guide,sc_cat_item_wizard,sc_cat_item_content');
       
 count.addQuery('cat_item.sc_catalogs', 'e0d08b13c3330100c8b837659bba8fb4
');
        count.orderByAggregate('COUNT', 'cat_item');
        count.query();
        while  (count.next() && items.length < 9) {
            if  (!$sp.canReadRecord("sc_cat_item", 
 count.cat_item.sys_id.getDisplayValue()))
                continue; // user does not have permission to see this item
 
            var  item = {};
            item.name = count.cat_item.name.getDisplayValue();
            item.category = count.cat_item.category.toString();
            item.price = 
 count.cat_item.price.getDisplayValue();
            item.sys_id = 
 count.cat_item.sys_id.getDisplayValue();
            items.push(item);
        }
        return  items;
    }
})();

This script introduces a new function getPopularItems()  to query the database and 
return popular items when the input  variable is empty.

3. Replace the HTML template with the following script:

<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the 
 catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" 
 placeholder="Start typing here to search the list 
 of catalog items" ng-model="c.data.keywords" 
 ng-change="c.server.update()" ng-model-options="{debounce: 
 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular 
 items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in 
 c.data.items">
        <a href>{{item.name}}</a><span 
 class="pull-right">{{item.price}}</span>
      </li>

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

963



    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    <ng-pluralize count="c.data.items.length"
                 when="{'0': 'No items found for ',
                     '1': 'One item matching ',
                     'other': 'Found {} items matching '}">
    </ng-pluralize>
    {{c.data.keywords}}
  </div>
</div>

This script provides a template to display the popular items returned from the server script.

4. Refresh your test page preview to view the changes.

The widget displays popular items to the user prior to any search input.

Embed an existing widget

Enable the user to view and purchase Service Catalog  items in the Quick Order widget by 
embedding the SC Catalog Item widget.

Before you begin
Role required: admin or sp_admin

About this task
Instead of duplicating code, you can embed widgets to leverage pre-existing functionality. The 
SC Catalog Item widget is a base system widget that enables the user to view and purchase 
Service Catalog  items.

Procedure

1. Inspect the SC Catalog Item widget.
Before embedding the SC Catalog Item widget, inspect the widget to understand what data 
it needs access to. You may need to update your Quick Order widget client or server script to 
make sure that the correct data is passed to the embedded widget.

a. Navigate to <yourInstanceURL>/sp_config?id=widget_editor.

b. Open the SC Catalog Item widget.
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c. Note that the widget ID is widget-sc-cat-item.
You will use this ID to embed the widget model in the client script.

d. Examine the server script.

Notice that the data  object includes a sys_id property populated by either the input  or 
options  objects. If neither input  nor options  include a sys_id, the $sp.getParameter()
method retrieves the sys_id from the request query string.

To populate the input  object, you can pass a catalog item sys_id from the Quick Order 
widget client script.

2. From the Widget Editor, open the Quick Order widget.

3. Replace the Quick Order widget client script with the following script.

function($location, spUtil) {
    var  c = this;
 
    c.select = function(item_id) {
        if  (c.openItem == item_id) {
            c.openItem = null;
            return;
        }
 
        renderCatalogItemWidget(item_id);
    }
 
    function  renderCatalogItemWidget(item_id) {
        c.catalogItemWidget = null;
        spUtil.get("widget-sc-cat-item", {
            sys_id: item_id
        }).then(function(response) {
            c.catalogItemWidget = response;
            c.openItem = item_id;
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        });
    }
}

This script uses spUtil.get()  to retrieve the widget model by ID (widget-sc-cat-
item) and define the {sys_id: item_id}  object. This object posts to the server script as 
input.

4. Replace the HTML template with the following script:

<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the 
 catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" 
 placeholder="Start typing here to search the list 
 of catalog items" ng-model="c.data.keywords" 
 ng-change="c.server.update()" ng-model-options="{debounce: 
 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular 
 items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in 
 c.data.items">
        <a href 
 ng-click="c.select(item.sys_id)">{{item.name}}</a><span 
 class="pull-right">{{item.price}}</span>
        <div class="catalog-item" ng-if="item.sys_id == 
 c.openItem">
            <sp-widget ng-if="c.catalogItemWidget" 
 widget="c.catalogItemWidget" />
        </div>
      </li>
    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    <ng-pluralize count="c.data.items.length"
                 when="{'0': 'No items found for ',
                     '1': 'One item matching ',
                     'other': 'Found {} items matching '}">
    </ng-pluralize>
    {{c.data.keywords}}
  </div>
</div>

This template:

◦ Adds on-click behavior using the ng-click directive.

◦ Displays the embedded SC Catalog Item widget using the sp-widget directive.

5. Replace the CSS with the following script:

.result-container {
  margin-top: 10px;
}
 
.catalog-item {
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  background-color: ➚f5f5f5;
  padding: 10px;
  @include border-top-radius($panel-border-radius);
  @include border-bottom-radius($panel-border-radius);
}

6. Refresh your test page preview to view the changes.

When you select a search result, the item opens in the embedded SC Catalog Item widget.

Create a reusable directive and add it to a widget

Angular Providers are reusable components that can be added to multiple widgets. Using the 
Widget Angular Providers table, create a directive that shows a category icon next to each result 
in the Quick Order widget.

Before you begin
Role required: admin or sp_admin

About this task
Angular Providers let you build angular directives and services that can be injected into your 
client script controller. The code in a Provider differs from a typical Angular directive or service 
because it must be anonymous, without being appended to a specific module.

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  > Portal Tables  > Widget 
Angular Provider.
The Widget Angular Providers table opens.

2. Select New  to create a new record.

3. Fill out the form.
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a. Add the type and name.

▪ Type: Directive

▪ Name: categoryIcon

b. Add the client script.

function() {
    return  {
        template: '<span class="fa fa-stack fa-lg"><i class="fa fa-circle 
 fa-stack-2x"></i><i class="fa fa-{{::icon}} fa-stack-1x fa-inverse"></i></span>',
        restrict: 'E',
        replace: true,
        scope: {
            category: '='
        },
        link: function(scope, element) {
 
            var  _iconMap = {
                "b06546f23731300054b6a3549dbe5dd8": "tablet",
                /* Tablets */
                "15706fc0a0a0aa7007fc21e1ab70c2f": "question",
                /* Can we help you? */
                "d68eb4d637b1300054b6a3549dbe5db2": "mobile-phone",
                /* Mobiles */
                "109cdff8c6112276003b17991a09ad65": "print",
                /* Office and Print */
                "5d643c6a3771300054b6a3549dbe5db0": "print",
                /* Printers */
                "2c0b59874f7b4200086eeed18110c71f": "plug",
                /* Peripherals */
                "2809952237b1300054b6a3549dbe5dd4": "desktop",
                /* Software */
            };
 
            scope.icon = _iconMap[scope.category] 
 || "shopping-cart";
        }
    }
}

This script associates the sys_id of the Category record with the Service Catalog  item. The 
icon that displays is the icon defined in the Category record in the Service Catalog.

c. Select Save.

4. Associate the new Angular directive with the Quick Order Widget.

a. Navigate to All  > Service Portal  > Widgets.

b. Open the Quick Order widget.

c. Under Related Lists, select Angular Providers.
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d. In the Angular Providers list, select Edit  and associate the categoryIcon Angular Provider 
with the Quick Order widget.

e. Select Save.

5. Add the categoryIcon directive to your Quick Order HTML template.

a. From the Widget Editor, open the Quick Order widget.

b. Replace the HTML template with the following script.

<div class="panel panel-primary">
  <div class="panel-heading">Request an item from the 
 catalog</div>
  <div class="panel-body">
    <input class="form-control" type="search" 
 placeholder="Start typing here to search the 
 list of catalog items" ng-model="c.data.keywords" 
 ng-change="c.server.update()" ng-model-options="{debounce: 
 250}" />
    <h5 ng-if="!c.data.keywords">Showing the most popular 
 items</h5>
    <ul class="list-group result-container">
      <li class="list-group-item" ng-repeat="item in 
 c.data.items">
        <a href 
 ng-click="c.select(item.sys_id)"><category-icon 
 category="item.category" style="margin-right: 
 10px"></category-icon>{{item.name}}</a><span 
 class="pull-right">{{item.price}}</span>
        <div class="catalog-item" ng-if="item.sys_id == 
 c.openItem">
            <sp-widget ng-if="c.catalogItemWidget" 
 widget="c.catalogItemWidget" />
          </div>
      </li>
    </ul>
  </div>
  <div class="panel-footer" ng-if="c.data.keywords">
    <ng-pluralize count="c.data.items.length"
                 when="{'0': 'No items found for ',
                     '1': 'One item matching ',
                     'other': 'Found {} items matching '}">
    </ng-pluralize>
    {{c.data.keywords}}
  </div>
</div>

6. Refresh your test page preview to view the changes.
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A category icon displays beside each result.

Clone a widget

Take advantage of existing code by cloning and editing an existing widget.

Before you begin
Role required: admin or sp_admin

About this task
Note: 
Base system widgets are read-only so you can benefit from future updates. To make 
changes, you can clone base system widgets. However, cloned widgets are considered 
custom and don't benefit from future updates to the widgets they were cloned from.

Procedure

1. Open the Widget Editor in the Service Portal Configuration page, then select an existing widget 
from the Select a widget  list.
For example, select Hello World 2.

2. From the list menu in the widget header, click Clone "Hello World 2".
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Clone a widget

3. Enter a name for the cloned widget.
The widget ID is created automatically based on the widget name.

4. Optional:  Select Create test page  to automatically create a page containing the widget.

5. Use the check boxes to show or hide the different components of the widget editor as needed.

Make changes to the HTML Template, CSS, client script, server script, or the link function.

Note: 
For server-side scripts, you can turn on using the ECMAScript 2021 (ES12) JavaScript 
mode if your application uses ES5 Standards mode or Compatibility mode. Scripts in 
applications with the JavaScript mode set to ECMAScript 2021 (ES12) use ECMAScript 
2021 (ES12) by default. For more information, see Turn on ECMAScript 2021 (ES12) mode 
for a script .

Hello World 2 clone

6. In order to enable a preview of your widget, use Enable Preview  from the menu.
Use the eye icon that appears to show or hide a preview of your widget.

What to do next
If you clone a widget that uses the Angular ng-template, you must manually clone the template 
and change the name of the template reference in the widget.
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For example, the header menu widget uses the Angular ng-template menuTemplate. If you 
clone the header menu widget, you must also clone the menuTemplate  and give the clone a 
unique name. When you open the clone of the header menu widget, you can see a reference to 
the menuTemplate in the HTML.

menuTemplate in header widget HTML

Create a new widget

Create a new widget to build a custom widget from scratch.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Widget Editor.

3. Click Create a new widget.

4. Enter a name for the new widget.
The widget ID is created automatically based on the widget name. You can then select Create 
test page  to automatically create a page containing the widget.

Note: 
After completing development of a widget with a test page, delete the test page. 
Maintaining test pages can create clutter when managing pages.

5. Click Submit.
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The widget HTML template, client script, and server script display in the widget editor. Basic 
script templates are included as a guide.

Note: 
For server-side scripts, you can turn on using the ECMAScript 2021 (ES12) JavaScript 
mode if your application uses ES5 Standards mode or Compatibility mode. Scripts in 
applications with the JavaScript mode set to ECMAScript 2021 (ES12) use ECMAScript 
2021 (ES12) by default. For more information, see Turn on ECMAScript 2021 (ES12) mode 
for a script .

Widget option schema

Widget instances allow users to uniquely configure each widget they add to a page. Use the 
option schema to define the parameters for your widget.

Storing instance options

When developing a widget, you can edit the option schema to create parameters for your widget, 
or you can create a table to store instance options. If you edit the existing option schema, any 
instance options defined are stored in JSON format in the Additional options, JSON format  field 
in the sp_instance table. The following field types are available:

• String

• Boolean

• Integer

• Reference

• Choice

• Field_list (depends on table)

• Field_name (depends on table)

• Glide_list

To use other field types not supported in the option schema, create an extension table to store 
your custom widget option schema. Using a table enables you to:

• Add any ServiceNow  field type, including fields with advanced customization, to the option 
schema.

• Define a complex option schema.

• Search and filter instance options.
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Note: 
While storing options in a table enables you to define more complex options, this method 
is more difficult to maintain than editing the option schema. To avoid creating unnecessary 
tables and adding additional server calls to your widget, edit the existing option schema 
when possible. Store options in a table only when complex or searchable options are 
required.

Using options in a widget

Access options in the widget from both the client script and the server script using the options 
global variable. You can access to any option value in your widget client script or server script 
using options.optionName.

Client script

function() {
  /* widget controller */
  var c = this;
    console.log(c.options.text_color) //Outputs the text_color 
 option for this instance
}

Server script

(function() {
     $sp.log(options.text_color) //Logs the value of the 
 text_color option to the browser console.
})();

Defining default options

Before an option value is set on an instance, it appears as an undefined value when you access 
that option variable. Use the widget server script to specify default values for your options.

(function() {
  options.text_color=options.text_color||"blue";
  options.maximum_entry_count=options.maximum_entry_count||5;
})

Edit the widget option schema

Widget instances allow users to uniquely configure each widget they add to a page. Edit the 
option schema to define basic parameters for your widget.

Before you begin
You must have cloned or created a new widget.

Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  > Widget Editor.

2. Select the widget you want to configure the option schema for.

3. Click the menu icon ( ) and select Edit option schema.
This option only appears for users that have the right to edit the widget.

4. Click +  to add a widget option.
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5. Define a label, name, type, hint and form section.

More fields appear depending on the type  you select.

Adding flexible widget options allows you to create more reusable widgets. You can add default 
values to help users understand each widget option. If you do not select a form section, the 
default is set to Other options.

6. Click Save.
The option schema you defined is stored in JSON format in the Option schema  field in 
the sp_widget table. Based on this option schema, each instance of the widget can use 
individually defined instance options.

7. Test the option schema by adding the widget to a page in the Service Portal  Designer.

a. Navigate to Service Portal  > Service Portal Configuration  > Service Portal Designer.

b. Add the widget to a page and click the edit icon on the widget instance to view the instance 
options.

c. Configure the widget instance options.

d. View the configuration by navigating to the instance record in the sp_instance table.
The instance options are stored in JSON format in the Additional options, JSON format 
field.

Store instance options in a table

Create a table to store widget instance options instead of editing the existing option schema. 
When using a table as your widget option schema, you can define custom fields using any 
ServiceNow  field type, add filters to fields, and search or query instance options.
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Before you begin
Role required: admin or sp_admin

About this task
To define a custom option schema, add fields to an sp_instance extension table, then set your 
widget to use the extension table as a data source. Using an extension table enables you to:

• Add any ServiceNow  field type, including fields with advanced customization, to the option 
schema.

• Define complex widget options.

• Search and filter instance options.

Note: 
While storing options in a table enables you to define more complex options, this method 
is more difficult to maintain than editing the option schema. To avoid creating unnecessary 
tables and adding additional server calls to your widget, edit the existing option schema 
when possible. Store options in a table only when complex or searchable options are 
required.

Procedure

1. Create a table that extends an sp_instance table to store your custom option schema.

a. Navigate to System Definition  > Tables.

b. Click New.

c. Define a label and name.

d. In the Extends table  field, select an sp_instance table that provides the necessary fields.

Instance table Description

Instance [sp_instance] Includes base instance fields.

Instance with Table [sp_instance_table] Includes sp_instance fields and fields to 
display table data such as Table and Filter.

e. Save the form.

2. Define custom fields in the extension table.
You can define any field type to use in your option schema by adding new columns in the 
Columns  list.

3. Update your widget to use the extension table as a data source.

a. Navigate to Service Portal  > Widgets.

b. Open the widget you would like to create custom options for.
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c. In the Data table  field, select your sp_instance extension table.

4. Configure the extension table form to display the desired fields.
Fields configured on the form are available as instance options.

a. Navigate to the extension table form: <yourInstance>/
<your_extenstion_table>.do.

b. Right-click the header menu and select Configure  > Form Layout.

c. Add the fields to the form.

d. Click Save.

5. Configure the widget to display the desired fields as instance options.

a. Navigate to Service Portal  > Widgets.

b. Open the widget that has the extension table set as the data source.

c. Use the Fields  slushbucket to select fields to display as instance options.

d. Save the form.

What to do next
Test the option schema by adding the widget to a page in the Service Portal  Designer. Click 
the edit icon on the widget instance to view the instance options. After configuring the widget 
instance options, view the configuration by navigating to the instance record in the sp_instance 
extension table.

Widget API reference

Service Portal  includes client and server side APIs to use in widget client and server scripts.

Service Portal  client-side APIs

These are Service Portal  APIs that you can use in a widget client controller.

See the API reference for detailed class and method information.
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Class Description

spAriaUtil
Shows messages on a screen reader.

spContextManager
Makes data from a Service Portal  widget available to other applications 
and services in a Service Portal  page. For example, pass widget data to 
Agent Chat  when it opens in a Service Portal  page.

spUtil
Utility methods to perform common functions in a Service Portal  widget 
client script.

spModal
Shows alerts, prompts, and confirmation dialogs in Service Portal 
widgets. The spModal  class is available in Service Portal  client 
scripts.

Note: 
g_form as a global object cannot be used in a widget client controller or in a UI script.

Service Portal  server-side APIs

These are Service Portal  APIs that you can use in a widget server script.

Class Description

GlideSPScriptable
The GlideSPScriptable  API provides methods to interact with 
data and perform record operations in Service Portal  widgets.

GlideSPSearchAnalytics
The GlideSPSearchAnalytics  API provides methods to 
generate search analytics from custom ServiceNow  search widgets.

SPScriptedFacet - 
Scoped Defines facet items, filters, or mapped queries for a facets object.

SPScriptedFacetService 
- Scoped Generates a multi-choice or single-choice facets object for an 

advanced search source.

SPSEOUtilsSNC - 
Global Return human-readable URLs for a specific page, or for the current 

page, based on the transaction request.

SPWidgetAccessControl 
- Global Check whether a provided table is granted access to a widget to 

ensure that a widget is securely accessed by an intended audience.

Widget properties

Global variable and functions available in widget client and server scripts.
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Server script global objects

Property Description

input An object containing client-side properties 
set under c.data. The value is 
undefined  until the client controller calls 
c.server.update().

data An object containing properties set during 
server-side execution.

options An object containing the schema option 
properties.

Client script global functions

Property Description

this.server.get([Object]) Calls the server and sends custom input. 
Returns Promise.

this.server.update() Calls the server and posts this.data  to the 
server script. Returns Promise.

this.server.refresh() Calls the server and automatically replaces 
the current options and data from the server 
response. Returns Promise.

A promise  represents the eventual result of an asynchronous operation. For more information 
on promises, see https://promisesaplus.com/  or AngularJS documentation .

Reuse components with Angular Providers

Angular Providers are reusable components that can be injected into multiple widgets. To 
ensure quick loading widgets and a high performing portal, create Angular Providers instead 
of overloading your client controllers with persistent data and additional logic. With Angular 
Providers, you can maintain data for the lifetime of your Service Portal  and reuse components 
and data objects across multiple widgets.

Before you begin
Role required: admin or sp_admin

About this task
By creating an Angular Provider, you can:

• Keep widgets in sync when changing records or filters.

• Share context between widgets.

• Maintain and persist state.

• Create behaviors and inject them into multiple widgets.

To learn more, visit Angular Providers .

Tip: 
For easier maintenance and troubleshooting, remove any unused providers from the 
Angular Providers related list in the Widget [sp_widget] table.
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Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  > Portal Tables  > Widget 
Angular Provider.
The Widget Angular Providers table opens.

2. Click New  to create a new record.

3. Select the type of Angular Provider.

◦ Directive

◦ Factory

◦ Service
To facilitate migration to ECMAScript 6 or later, consider using services over factories.

4. Define a name.
You will use the name to associate the Provider with your widget.

5. Add a script in the Client Script  field.

Example 

A basic factory that formats a number in US currency.

function formatterFactory(){
  var myVal = Number;
  return {
    format: function(myVal) {
      return '$' + myVal.toFixed(2);
    }
  }
}

6. Associate the Angular Provider with a widget.

a. Navigate to <yourInstanceURL>/sp_config?id=widget_edit.

b. Open the widget you would like to associate with the Angular Provider.

c. Under Related Lists, select Angular Providers.

d. In the Angular Providers  list, click New.

e. In the Angular Provider  field, select the appropriate Provider.

f. Check the Widget  field to ensure that you are associating the Angular Provider with the 
correct widget.

g. Click Save.

7. Update the appropriate scripts in your widget to inject the Angular Provider into the widget.

Example 

Inject the factory into your widget client script by passing the name of the factory as an 
argument in your client controller function. You can then access the object defined in the 
factory function in your widget client script.

function(formatterFactory) {
  /* widget controller */
  var c = this;
  console.log(formatterFactory.format(300));
}
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If defining a directive, use the directive in the widget HTML template.

8. To edit the Angular Provider after it is registered with your widget, open the Angular Provider 
client script in the widget editor.

a. Navigate to Service Portal Configuration  > Widget Editor.

b. Under Edit an existing widget, select the widget associated with your Angular Provider.

c. From the Show  menu, open the Dependencies  list and select the Angular Provider.

Note: 
Only Angular Providers associated with the widget are displayed in the Dependencies 
list. This list includes any external resources your widget depends on.

The Angular Provider client script displays in the widget editor. In the widget editor interface, 
you can edit and save your widget and Provider scripts at the same time.

What to do next
To use an Angular Provider with multiple widgets, register your Provider with each widget and 
update the appropriate scripts.

Embedded widgets

Embed a widget in the HTML template, server script, or client script.

Embed a widget in an HTML template

Use the <widget></widget>  element to embed a widget in an HTML template. Pass in the ID 
of the widget you are trying to embed as a parameter.

<div>
    <widget id="widget-cool-clock"></widget>
</div>

If a widget has an option schema, you can define instance options in JSON format.

<widget id="widget-cool-clock" options='{"zone": 
 "America/Los_Angeles","title": "San Diego, CA"}'></widget>

Alternatively, you can define options in the widget server script.

HTML template

<widget id="widget-cool-clock" 
 options='data.clockOptions'></widget>

Server script

(function() {
  data.clockOptions = {"zone": 
 "America/Los_Angeles","title": "San Diego, CA"};
})();

Embed a widget in a client script

Use spUtil.get()  to get a widget model in the client script.
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spUtil.get("widget-sc-cat-item", {sys_id: 
 "your_catalog_item_sys_id"}).then(function(response) {
    c.catalogItemWidget = response;
});

When using the spUtil  class in a widget client script, you must inject the class into the client 
script function. The following example embeds the Cool Clock widget:

Client script

function(spUtil) {
    var c = this;
   
 spUtil.get("widget-cool-clock").then(function(respon
se) {
            c.myClockWidget = response;
    });
}

HTML template

<sp-widget widget="c.myClockWidget"></sp-widget>

Embed a widget in a server script

Use $sp.getWidget()  to get a widget model in the server script.

data.catalogItemWidget = $sp.getWidget("widget-sc-cat-item");

The following example embeds the Cool Clock widget:

Server script

(function() {
    var coolClockOptions = {"zone": 
 "America/Los_Angeles","title": "San Diego, CA"}
    data.coolClockWidget = 
 $sp.getWidget('widget-cool-clock', coolClockOptions);
})();

HTML template

<sp-widget widget="data.coolClockWidget"></sp-widget>

Widget model properties

When a widget model is called from within another widget, the HTML template, client script, and 
link function are loaded just as they are in the sp_widget record. The data property is the result 
of the widget server script execution. Anything that you put on the data object on the server is 
available in the data object on the client.

Property name Type Description

client_script string Widget client script field.

css string Compiled CSS output from the SASS field for the widget.

data object Data object containing keys and values from the widget 
server script.
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Property name Type Description

dependencies array Any third-party libraries to load before the widget 
executes.

options object Options used to initialize the widget.

template string HTML template field for the widget.

Embed a widget multiple times with custom options

Embed the cool clock widget multiple times using custom options.

Before you begin
Role required: admin or sp_admin

About this task
Create a widget that embeds multiple instances of the cool clock widget, each with a different 
time zone and title. Open the cool clock widget in the Widget Editor to see widget options 
referenced in the HTML template and the Client Script.

Cool Clock widget with Options highlighted

Procedure

1. Clone the Cool Clock widget with the name Embedded clock.

2. Replace the code blocks with the following:

HTML Template

<div class="panel panel-default">
  <div class="panel-heading">Time across the US</div>
  <div class="panel-body">
    <div class="row">
      <div class="col-sm-3" ng-repeat="myClock in 
 c.data.clocks">
        <sp-widget widget="myClock"></sp-widget>
      </div>
    </div>
  </div>
</div>
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CSS

.panel {
    margin-top: 10px;
}

Client Script

function() {
    // nothing to do here...
}

Server Script

(function() {
    var options = [
        {zone: "America/Los_Angeles", title: "San Diego"},
        {zone: "America/Denver", title: "Denver"},
        {zone: "America/Chicago", title: "Chicago"},
        {zone: "America/New_York", title: "New York"}
    ];
 
    data.clocks = [];
    for (var i in options) {
        data.clocks.push($sp.getWidget("widget-cool-clock", 
 options[i]));
    }
})();

Result
Each instance of the clock in the embedded clock widget appears with a different time zone.

Sample clock options

Create a widget dependency

In Service Portal, you can link JavaScript and CSS files to widgets to create dependencies 
between widgets and third-party libraries, external style sheets, and angular modules.

Before you begin
Role required: sp_admin or admin

About this task
Dependencies are loaded asynchronously from the server when needed.
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Widgets can have as many or as few dependencies as needed. However, the more you add, the 
more content a widget must download to render on the page. Keep dependencies as small as 
possible for more efficient load times.

Procedure

1. Create a dependency package.

A dependency package is a collection of JavaScript and CSS files that can be connected to a 
widget.

a. Navigate to Service Portal  > Dependencies.

b. In the dependency record, define the following fields.

Field Description

Name The name of your dependency. (Useful for selecting a 
dependency from a dropdown list.)

Application Application scope for the dependency record.

Include on page load Select if you want your dependency to be loaded onto the 
page on the initial page load of Service Portal, or leave 
unchecked to load the dependency only when the linked 
widget is loaded onto a page.

Angular module name Optional. Define the value if the linked JavaScript is an 
Angular module. Provide the name of the Angular module 
being loaded, so that it can be injected into the Service 
Portal Angular application.

2. Add files to the dependency package.

After you save the information for your dependency package, use the related lists to add JS 
and CSS Include files. For each related list, include the following information:

Field Description

Display name Name of the script include.

Source Depending on whether you add a JS Include or a CSS 
Include, select one of these options from the list:

◦ URL

◦ UI script (for a JS Include) or Style Sheet (for a CSS 
Include)

For a JS Include, use the UI Script field to reference a UI 
Script found in System UI  > UI Scripts.

For the CSS Include, use the Style Sheet field to reference a 
record in the sp_css  table.

3. Add a dependency package to a widget.
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After you have created a dependency package and added files, create a relationship between 
the dependency and a widget.

a. Navigate to Service Portal  > Widgets  and find the widget record you want to add the 
dependency to.

b. From the Dependencies related list, click Edit.

c. In the slushbucket, find the dependency you created and double-click to add it to the 
selected items column on the right.

d. Save the page to return to the widget record.

Include a font icon in a single widget

If you only want one widget to have access to a font icon, include the font icon in a single widget.

Before you begin
Role required: admin or sp_admin

About this task
Adding an icon to a specific widget keeps the icon scoped and prevents it from interfering with 
other CSS on the page.

Procedure

1. In the platform UI, navigate to Service Portal  > Widgets, then click the widget you want to add 
an icon to.

2. Attach the individual icon file to the widget record.

3. In the HTML template, include something like the following:

<div>
<i class='font-family'>icon_name</i> you did it!
</div>

Make sure that the class is exactly the same as the font family called out in the CSS. For 
example, <i class='material-icons'>  should be the same as the .material-
icons  included in the CSS. The icon_name  should match the name of the file you attached.

4. In the CSS field for the widget, add the CSS for the font-icon definition.

Most font-icon sets include a CSS file similar to the material icons one used below. Use the 
sys_id of the attachment as the src  in the CSS. For example:

/* fallback */
@font-face {
  font-family: 'Material Icons';
  font-style: normal;
  font-weight: 400;
  src: url('/828b8ca8b7033010897725cbde11a9f7.iix') format('woff2');
}
 
.material-icons {
  font-family: 'Material Icons';
  font-weight: normal;
  font-style: normal;
  font-size: 24px;  /* Preferred icon size */
  display: inline-block;
  line-height: 1;
  text-transform: none;
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  letter-spacing: normal;
  word-wrap: normal;
  white-space: nowrap;
  direction: ltr;
 
  /* Support for all WebKit browsers. */
  -webkit-font-smoothing: antialiased;
  /* Support for Safari and Chrome. */
  text-rendering: optimizeLegibility;
 
  /* Support for Firefox. */
  -moz-osx-font-smoothing: grayscale;
 
  /* Support for IE. */
  font-feature-settings: 'liga';
}

Result
An icon that you can select in the widget or widget instance. For example:

What to do next
To use custom font-icons across widgets, add the icon to a page or make it a widget dependency.

Related topics

Include font icons on a page

Include font icons as a widget dependency

Include font icons as a widget dependency

You can include font icons wherever a widget is loaded by including them as a widget 
dependency.

Before you begin
Role required: admin or sp_admin

About this task
Note: 
CSS included as a widget dependency is not scoped and can disrupt other CSS on a page.

Procedure

1. In the platform UI, navigate to Service Portal  > CSS  and create a new style sheet.

2. Attach the font-icon set to the sp_css record you created, and use the sys_id of the attachment 
as the src  for the font icon.

Example 
For example:

@font-face {
  font-family: 'Material Icons';
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  font-style: normal;
  font-weight: 400;
  src: url('/828b8ca8b7033010897725cbde11a9f7.iix') format('woff2');
}
 
.material-icons {
  font-family: 'Material Icons';
  font-weight: normal;
  font-style: normal;
  font-size: 24px;  /* Preferred icon size */
  display: inline-block;
  line-height: 1;
  text-transform: none;
  letter-spacing: normal;
  word-wrap: normal;
  white-space: nowrap;
  direction: ltr;
 
  /* Support for all WebKit browsers. */
  -webkit-font-smoothing: antialiased;
  /* Support for Safari and Chrome. */
  text-rendering: optimizeLegibility;
 
  /* Support for Firefox. */
  -moz-osx-font-smoothing: grayscale;
 
  /* Support for IE. */
  font-feature-settings: 'liga';
}

3. Navigate to Service Portal  > Dependencies  and create a new dependency.

4. Attach the CSS record you created to the new dependency using the CSS Includes  related list.

Internationalize a widget

Use the ${}  or gs.getMessage()  syntax in the HTML Template, Client Script, or Server 
Script  fields of a widget to tag strings for translation so you can localize your Service Portal 
content.

The ${}  or gs.getMessage()  searches in the messages table [sys_ui_message] in the 
platform to see what the translation would be.

Use the HTML template to internationalize strings in a widget. Type the following in an HTML 
template.

<div>
  <p>${This message will be internationalized.}</p>
  <p>However, this will NOT be.</p>
</div>

Writing text as ${message}  is the equivalent of writing ${gs.getMessage("message")} 
in other parts of the system, but written as a more legible shorthand.
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Note: 
In some cases, the translation might have quotes or double quotes on it. That could lead to 
JavaScript errors if you are using the ${} syntax in the client script. The safest way to fetch 
a translated message is to do it in the server script. Then, assign the value to a client-side 
Angular binding.

Translating strings in the client script

function() {
  var c =this;
  c.message="${This message will be internationalized}";
}

HTML template:

<div>
  <!-- The output of this text will be internationalized. -->
  <p>{{c.message}}</p>
</div>

Translating strings in the server script

Use the server script to translate schema options and other values during server-side runtime.

Server script

function() {
  data.message=gs.getMessage("this message contains 'quotes'");
  //You can also translate schema options using the server 
 script
  //For example, data.message=gs.getMessage(options.title);
}

HTML template

<div>
  <p>{{c.data.message}}</p>
</div>

Replace a Service Catalog  form script with a widget

You can use widgets in Service Portal  to replace UI Macros. If your Service Catalog  form includes 
a UI Macro that references other fields or variables on the form, you can create a widget to hold 
reusable code and embed it within the Service Catalog  form. Use special syntax to access any 
variable fields on the form.

Before you begin
Role required: admin or sp_admin

Procedure

1. Create a widget that performs the action you would like to use in catalog item forms.
See step 7 for a simple example widget that accesses another variable on the form.

2. Open a catalog item that previously used a UI Macro or other reusable component not 
supported in Service Portal.

3. In related lists, add a new variable to the catalog item.

4. Configure the variable form to add the Widget  field.
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5. In the Type  field, select Macro.

6. In the Widget  field, select a widget that performs the desired action.

7. Optional:  Use the $scope.page.g_form()  or $scope.page.field  syntax in the 
embedded widget to access the catalog item values.

Example 
This example shows how to modify the value of a single-line text variable with the name color 
associated with the catalog item.

Widget HTML Template

<div>
  Data from catalog variable:
  <h1>{{ c.data.message }}</h1>
</div>

Widget client script

function($scope) {
     var c = this;
 
     //Watch for changes in the color variable
     $scope.$watch(function () {
          return $scope.page.g_form.getValue('color');
     }, function (value) {
     //Update local data object with data from 
 variable
     c.data.message = value ? 'Content of color 
 variable: ' + value : '';
});
}  

You can use the following to access variable or catalog item fields:

◦ $scope.page.g_form(): The g_form instance on the form. You can use all 
supported g_form methods described in Service Portal and client scripts. For example, 
g_form.setValue('variable_name', 'new value');.

◦ $scope.page.field(): The object that represents the variable.
When you open the catalog item in the Service Portal, the embedded widget accesses the 
variable fields associated with the catalog item.

Widget troubleshooting guide

Use the following tools to investigate and resolve unexpected behavior in your custom Service 
Portal  widgets.

Provides debugging tips for troubleshooting Service Portal configuration issues.
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Reduce complexity

Deactivate widgets unrelated to the widget you are troubleshooting to isolate parts 
of the page that may be causing errors or unexpected behavior. Set the active field 
to false on a widget record to hide the widget on the page, and prevent associated 
scripts from executing.

Use the browser developer console

All supported desktop browsers have built in developer tools. Access your browsers 
developer tools to view console messages and errors thrown by client-side 
JavaScript. Many of the logging tools detailed below output information to this 
console.

If you experience performance issues, check the JavaScript console to see if there 
are errors, a large number of HTTP requests, or HTTP requests that take a long time 
to resolve. You can use the console to identify any widgets that load slowly. For 
more information, see the How to identify a slow widget on a page [KB0744521]
article in the Now Support Knowledge Base.

Determine the cause of performance issues

The following tips can help determine the cause of performance issues in portals:

• Determine if the issue is related to the portal or platform-wide by comparing the 
functionality in both interfaces. For more information about platform performance 
issues, see Platform performance .

• Determine if the issue affects the entire portal or specific pages. If all pages in 
the portal are slow, check if scripted menu items in the header menu or themes 
with large font or image files could be the cause. If a specific page is slow, use the 
browser developer console to determine which widget could be the cause.

• Check the Log [syslog] table for warnings related to large JSON objects causing 
slowness. If these warnings are appear with the action that causes slowness, this 
indicates that a widget is using too much data.

For more information, see the Six common performance pitfalls in Service Portal 
and how to avoid them [KB0634588]  article in the Now Support Knowledge Base.

Use the widget context menu to access information and options

CTRL+right-click a widget to access configuration options for the widget. There are 
also options to output the scope and scope data object to the browser console. For 
more detail on this menu, see Using portal widgets.

Use script methods to capture debugging output

Several methods are available to output debugging information within your server 
and client-side code.

Scripted debugging methods

Method Availability Description

console.log() Server and 
client

Logs output to the browser developer 
console.

$sp.log() Server Logs output to the Service Portal Log 
Entries [sp_log] table, when the logged 
in user has the sp_admin  or admin 
role.
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Scripted debugging methods  (continued)

Method Availability Description

gs.log() Server Logs output to the Log [syslog] table.

Note: 
gs.log creates records on the 
syslog table. Excessive use can 
adversely affect performance.

gs.warn() Server Produces warning level output in the 
Log [syslog] table.

gs.error() Server Produces error level output in the Log 
[syslog] table.

gs.addInfoMessage() Server Displays a green information message 
at the top of the browser window.

gs.addErrorMessage() Server Displays a red error message at the top 
of the browser window.

spUtil.addErrorMessage() Client Displays an error message within the 
browser window.

spUtil.addInfoMessage() Client Displays an Info message within the 
browser window.

spUtil.addTrivialMessage() Client Displays a message which automatically 
disappears after a short time.

debugger Client Sets a break point in Chrome and 
Firefox browsers, allowing you to step 
through a script line by line in the 
browsers developer console.

{{data|json}} HTML This code can be added to the HTML 
code of a page to output the data object 
to the portal page in JSON format.

Check for security restrictions

Often, widget display issues are caused by access rules or user criteria rather than 
the widget script. Check the user criteria for records and verify that any records that 
are not accessible within a widget are accessible using the platform UI. Use the ACL 
debugger to ensure that your users have the expected access to records used by 
your widgets. For more detail on the debugger, see ACL debugging tools .

Service Catalog  items can also be restricted to not appear in Service Portal. If you 
get a You are either not authorized or record is not valid 
error message for a Service Catalog  widget, check that the item is not hidden from 
Service Portal.

Check the associated Angular Providers

Verify that the necessary Angular Providers are associated with widgets. 
Removing the default Angular Providers associated with a base system widget 
can cause unexpected behavior. For example, removing the scToggleData or 
scBindHtmlCompile Angular Providers from the SC Catalog Item widget.

Create a reference to the widgets scope in the console
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Use reference to a widget to manipulate scope data or manually run the widgets 
client and server scripts. Use the following steps to create the reference.

• 1. Right-click the widget and choose Inspect.

• 2. In dev tools Elements tab, click to highlight the element with attribute 
widget=widget. You can find it a few elements above the currently inspected 
element. This element points the $0 scripting tool at the widget.

• In the Javascript console, run the following code:

var scopeRef = angular.element($0).scope();

Use the reference to your widget to change data within the console. See the 
following example. Remember to run AngularJS $apply()  on the scope to 
apply changes to the page.

scopeRef.data.prop1 = "Pear";
scopeRef.$apply();

Run any function defined in the widgets client controller from your reference using 
the syntax below.

scopeRef.exampleFunction();

Use the refresh command to manually execute the widgets server script.

scopeRef.server.refresh();

Widget diagnostics

Resolve Service Portal  page issues by identifying widget customization levels and checking 
widget code directly from a portal page.

If a portal page isn't working as expected, it may be because of a bug in widget code. To 
diagnose the page, try diagnosing the widgets on the page.

Diagnosing widgets involves:

• Identifying widget customization levels

• Checking the code that is used in each widget

Identifying customization levels

Customization levels  describe how widgets have been modified or developed. Identifying 
the customization level of a widget can help you know which part of the widget code is most 
important to check. There are four levels of widget customization.

Customization level Description

Base Base widget installed on a base system or with other ServiceNow 
plugins. Base widgets have no modifications but can have widget 
instances for which you have set instance options.

Cloned Widget that you cloned from a base widget.

New Widget that you created.

Customized Base widget that you configured in any of the following ways:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

993



Customization level Description

• Modified the widget code directly

• Modified widget option schema

• Modified widget dependencies, ng-templates, or Angular Providers

To identify the customization levels of widgets on a portal page, open the Widget Context Menu 
and select Show Widget Customizations. Widgets are color-coded as follows:

• Green: base widget

• Yellow: cloned widget

• Blue: new widget

• Red: customized widget
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Widget customizations highlighted on a portal page

Checking the widget code

After you've identified the customization levels of widgets on a portal page, check the code in 
each widget.

To view the widget code from the portal page, click the information icon ( ) on a widget.
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From the widget diagnostics window, you can check the widget code in several ways:

• View a widget record from a portal page

View and identify potentially problematic code in the widget record without navigating away 
from the portal page.

• Identify customizations in widget related records

View and identify potentially problematic code in the widget dependencies, Angular Providers, 
and ng-templates that are being used by the widget.

• Compare versions of a widget related record

Compare an Angular Provider or ng-template against its previous version so that you check if 
your most recent code changes are causing issues on a portal page.

• Compare versions of a customized widget

Compare your most recent update of a customized widget against the previous version to 
check if your recent changes are causing issues on a portal page.

• Compare a cloned or customized widget against a base widget

Identify customizations to a widget so that you can revert your cloned or customized widgets 
and resolve issues on a portal page.
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Recommendations for diagnosing widgets

Of the four customization levels, the highest priority issue is customized widgets. These widgets 
aren't supported in system upgrades. If you're experiencing page issues during an upgrade, it 
may be because you have a customized widget on your portal page.

To resolve page issues that may be caused by customized widgets, identify which parts of the 
widget code have been customized. Then revert the code to the original configuration. For more 
information on identifying these code differences, see Compare a cloned or customized widget 
against a base widget.

Tip: 
Even if a customized widget is not causing page issues now, you may want to revert to the 
original widget to prevent issues during upgrades later.

If you're still experiencing page issues after reverting customized widgets, check your new and 
cloned widgets next.

With a new widget, it's likely that your most recent code changes are causing issues on your 
portal page. To identify your most recent changes so that you can debug your code, follow the 
steps in Compare versions of a widget related record.

If you cloned a widget prior to a system upgrade, it's likely that the cloned widget didn't receive 
the same updated code as the base widget. In this case, it's recommended that you clone the 
widget again and add your customizations to the clone.

A base widget is least likely to cause page issues. If you've already checked other widgets and 
are still experiencing page issues, remove base widgets from the page and add them again 
without any widget options set. You can also try adding base widgets to another page instead.

Limitations

There are several known limitations using widget diagnostics from a portal page:

• Although you can view and compare widget code, you can't fix or revert code directly. Navigate 
away from the portal to change the code.

• If you navigate to another portal page while using widget diagnostics, the system disables the 
tool.

• Because the tool uses color to categorize widgets, it may not be accessible for visually 
impaired users.

• The widget dependencies that are listed on the portal page reflect only the first-level 
dependencies. Any dependency that is nested deeper than the first level is not included. To 
further troubleshoot the widget, check the nested dependencies in the widget record.

• There is no way for the system to track a Widget Dependency after you've deleted it.

View a widget record from a portal page

View and identify potentially problematic code in the widget record without navigating away from 
the portal page.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.
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3. On the widget context menu, click Show Widget Customizations.

Widgets are color-coded as follows:

Color Customization level

Green Base system widget

Yellow Cloned widget

Blue New widget

Red Customized widget

4. On any widget, click the information icon ( ).

5. On the window, click Open widget in platform.

Note: 
The Open widget in platform  button doesn't appear for all customized widgets. 
The button appears for customized widgets only if you modified one or more widget 
dependencies, Angular Providers, or ng-templates.

Result
A new window opens with a read-only view of the widget record.

Compare versions of a customized widget

Compare your most recent update of a customized widget against the previous version to check 
if your recent changes are causing issues on a portal page.
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Before you begin
Role required: admin or sp_admin

About this task
The option to compare versions is available only for customized widgets that you modified 
directly. There's no option to compare versions of a customized widget for which you modified 
only the widget dependencies, Angular Providers, or ng-templates.

There's no option to compare versions for new, cloned, or base system widgets.

Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.

3. On the widget context menu, click Show Widget Customizations.
Customized widgets are outlined in red.

4. On a customized widget, click the information icon ( ).

5. On the window, click Compare with previous version.

The system displays the widget records of the current and previous widget versions side by 
side.
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Although both widget records are labeled Version, the left-side record represents the previous 
version and the right-side record represents the current version.

6. For each field in which it appears, click the window icon ( ) to open the code comparator.
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Your most recent changes to the widget code are highlighted in the code comparator.

Compare a cloned or customized widget against a base widget

Identify customizations to a widget so that you can revert your cloned or customized widgets and 
resolve issues on a portal page.

Before you begin
Role required: sp_admin or admin

About this task
If a widget is cloned from another cloned widget, both clones are compared against the base 
widget.

Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.

3. On the widget context menu, select Show Widget Customizations.
Customized widgets are outlined in red. Cloned widgets are outlined in yellow.

4. On any customized or cloned widget, select the information icon ( ).

5. From the Widget Diagnostics dialog box, select Compare with base widget.

The system displays the widget records of the base widget and cloned or customized widgets 
side by side.

Note: 
The left-side record represents the base widget and the right-side record represents the 
cloned or customized widget.
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6. For each field in which it appears, select the window icon ( ) to open the code comparator.

Differences between the code of the customized or cloned widget and base widget versions 
are highlighted.
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Note: 
The left-side record represents the base widget and the right-side record represents the 
cloned or customized widget.

Identify customizations in widget related records

View and identify potentially problematic code in the widget dependencies, Angular Providers, 
and ng-templates that are being used by the widget.

Before you begin
Role required: admin or sp_admin

About this task
Your widget may be using potentially problematic code from any of the following records:

• Widget Dependencies

• Angular Providers

• Angular ng-templates

You can view these related records directly from your portal page to check the code in each 
record.

Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.

3. On the widget context menu, click Show Widget Customizations.

Widgets are color-coded as follows:
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Color Customization level

Green Base system widget

Yellow Cloned widget

Blue New widget

Red Customized widget

4. On any widget, click the information icon ( ).

5. On the window, open links to the following related records:

Field Description

Dependencies JavaScript and CSS files that the widget uses from the Widget 
Dependencies [sp_dependency] table.

Note: 
The widget dependencies listed on this window only reflect 
the first-level dependencies. Any dependency that is 
nested deeper than the first level is not included. To further 
troubleshoot the widget, check the nested dependencies in the 
widget record.

Angular Providers Angular Providers that the widget uses from the Widget Angular 
Providers [sp_angular_provider] table.

Angular templates Angular ng-templates that the widget uses from the Angular ng-
templates [sp_ng_template] table.

Related records that you modified or developed are outlined in red.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1004



You can open each related record by clicking the record name.

What to do next
If you're still unable to diagnose the widget, consider checking nested dependencies or URL 
dependencies.

Compare versions of a widget related record

Compare an Angular Provider or ng-template against its previous version so that you check if 
your most recent code changes are causing issues on a portal page.

Before you begin
Role required: admin or sp_admin

About this task
Your widget may be using potentially problematic code from any of the following records:

• Widget Dependencies

• Angular Providers

• Angular ng-templates

You can compare versions for these related records directly from your portal page to check code 
changes for each related record.

Note: 
There's no option to compare versions for Widget Dependency records. Also, there's no 
option to compare versions for related records that you created. You can only compare 
versions of a base system record that you modified.
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Procedure

1. Navigate to a portal page.

2. On the page, open the widget context menu by CTRL+right-clicking any widget.

3. On the widget context menu, click Show Widget Customizations.

Widgets are color-coded as follows:

Color Customization level

Green Base system widget

Yellow Cloned widget

Blue New widget

Red Customized widget

4. On a widget, click the information icon ( ).

Related records that you modified or developed are outlined in red.

5. Next to a Angular Provider or ng-template record, click Compare.

The system displays the records of the current and previous versions side by side.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1006



Although both sides are labeled Version, the left-side record represents the previous version 
and the right-side record represents the current version.

6. For each field in which it appears, click the window icon ( ) to open the code comparator.

Your most recent changes to the widget code are highlighted in the code comparator.

Improving search engine optimization for portals

Search engine optimization (SEO) helps portal users find the information they need and be more 
engaged with your portal. Adding SEO information to your public portal pages improves how 
external search engines index and rank pages to make them more findable.

You can add the following types of information to Service Portal  pages to improve SEO:
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• Human readable keywords in URLs.

• Meta tags that include information about the page or portal in the <head>  section of a page.

• Dynamic page titles that are descriptive of the page contents.

• hreflang  tags that specify all the available languages of a page.

• Canonical URLs that specify which pages to index from sets of duplicate URLs.

To improve SEO for your portal further, you can also define and automatically generate XML 
sitemaps for search engines to index using the Sitemap Generator  application.

Some portal pages load data from a record that's specified by a parameter in the URL. For these 
pages, you can use dynamic page variables to add meta tags, page titles, and human readable 
URL keywords that vary depending on the record loaded in the page.

Using a Service Catalog  page as an example, the following URL includes a sys_id parameter in 
addition to the page ID. Different content loads on the page depending on the value of the sys_id 
parameter, which specifies a catalog item record.

https://<instance>/sp?
id=sc_cat_item&sys_id=c3b9cbf29716cd1021983d1e6253afad

In this example, the sys_id is for the iPad pro catalog item. The sc_cat_item page has been 
configured to generate a dynamic title and dynamic keywords in the URL based on the Name 
field of the catalog item record.

Add human readable keywords to page URLs

Add human readable keywords to the URLs of portal pages to improve search engine 
optimization (SEO) and click-through rates and help users understand what to expect on the 
page.

Before you begin
Role required: sp_admin or admin

About this task
Human readable keywords are added to URLs in the following format:
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https://<instance>/<portal suffix>/<guest language>/<keywords>?
id=<page id>&<page parameters>

Keywords can be populated using static content or dynamic page variables and can include a 
single slash (/). Dynamic page variables load keywords that are based on data in a record. The 
page parameters in the URL specify which record to use. In the following examples, the category 
and short description of a knowledge article and the category and name of a catalog item are 
added as keywords:

• https://<instance>/kb/en/faq/what-is-a-cookie?
id=kb_article_view&sysparm_article=KB0000007

• https://<instance>/sp/es/hardware/developer-laptop-mac?
id=sc_cat_item&sys_id=774906834fbb4200086eeed18110c737

Note: 
To turn off human readable URLs for an instance, add the 
glide.service_portal.enable_human_readable_urls  property to the 
System Properties [sys_properties] table and set the value to false.

Procedure

1. Navigate to All  > Service Portal  > Pages.

2. Select a page.

3. Optional:  Use keywords that are dynamic based on the page content by adding a dynamic 
page variable to the page.

a. Select the Dynamic page variables related list tab.

b. Select New.

c. On the form, fill in the fields.

Dynamic page variables form

Field Description

Name The variable that loads keywords in the page URL from record 
data. The variable name must begin with %  and can’t contain 
spaces. For example, %short_descr.

Order The priority order from lowest to highest for when multiple 
dynamic page variables with the same name have different URL 
query parameters.

Page The page that uses the dynamic page variable to include 
keywords in the URL.

URL query parameter The parameter in the page URL that determines which record 
displays.

Relevant table column The column in the specified table that includes the values of the 
URL query parameter. The default value is Sys ID.

Table The table that includes the records used to populate keywords 
in the URL and the column with the values of the URL query 
parameter.
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Field Description

Table field A field from records in the specified table that populates the 
keywords in the URL.

Query condition Conditions that filter the records in the table. A record must 
meet the query conditions for the variable to apply.

Example 

(Optional) This example shows the values for a variable that references the short description 
of a knowledge base article identified by its number for a published workflow.

Dynamic page variable

Field Value

Name %short_descr

Page kb_article_view

Order 100

URL query parameter sysparm_article

Relevant table column Number

Table Knowledge[kb_knowledge]

Table field Short description

Query condition [Workflow][is][Published]

4. Select Submit.

5. In the Human readable url structure  field of the page record, specify the keywords to populate 
in the page URL using static content, dynamic page variables, or a combination.

Keywords can include alphanumeric characters, hyphens (‐), one slash (/), and percent signs 
(%) for variables.

Example 

Human readable url structure Example value

Static content faq/what-is-a-cookie

Dynamic page variables %category/%short_descr

Static content and dynamic page 
variable

faq/%short_descr

Keywords are automatically formatted to use only lowercase letters, replace spaces with 
hyphens, and remove any disallowed special characters added by dynamic page variables. If 
the keywords in the URL exceed 75 characters, they’re truncated to be less than or equal to 75 
characters.

6. Select Update.
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Result
If users access the page using the URL without human readable keywords, the page URL is 
updated in one of the following ways:

• On the initial page load by a guest user, the page redirects to the human readable URL.

• On the initial page load by an authenticated user, the URL is updated to include the human 
readable keywords without redirection.

• On subsequent page loads for all users, the URL is updated to include the human readable 
keywords without redirection.

Example: Knowledge article page with human readable keywords in the URL

In this example, the kb_article_view page displays knowledge article KB0000007. The knowledge 
article record has the following fields and values:

• Category  is FAQ

• Short description  is What is a cookie?

The page has been configured to add keywords based on these field values to the URL using 
dynamic page variables such as %category/%short_descr. The question mark in the short 
description isn’t an allowed character in the URL keywords so it’s automatically removed from the 
URL. The question mark that is in the URL is the query parameter that's always included before 
the page ID.

The URL that is displayed in the browser appears as: http://<instance>.com/kb/en/
faq/what-is-a-cookie?id=kb_article_view&sysparm_article=KB0000007.

What to do next
For pages that have canonical URLs, you must include the human readable keywords in the 
canonical URL. In the SEO script include that returns canonical URLs for pages, use one of 
the getHumanReadableUrl  methods in the SPSEOUtilsSNC  class to return the human 
readable keywords in page URLs and include them in the canonical URLs.

For more information about including human readable keywords in canonical URLs, refer to the 
following resources:

• Configure custom SEO tags for canonical URLs and localized knowledge articles

• SPSEOUtilsSNC - Global

Add meta tags to a public page

Improve the searchability of Service Portal  pages by adding meta tags. You can add the meta 
name and description attributes to a page, define the robots attribute, or create dynamic meta 
tags for pages that load record data based on a URL parameter.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Pages.

2. Open a page.

3. Check that Public  is selected.
Pages that are not public are not indexed by external search engines.

4. Click the Meta tags  related list tab.
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5. Click New  to create a new meta tag.

6. Complete the form.

Field Description

Page Page to apply the meta tag to.

Application Application scope of the page. This value is read-only.

Name The HTML meta name attribute.

To define the meta robots attribute, add ROBOTS.

Content The HTML meta description attribute.

If ROBOTS  is defined in the Name  field, you can add one of the 
following content values:

◦ INDEX, FOLLOW: The search engine shows the page in search 
results and trusts any links in the page. This is the default value.

◦ NOINDEX, FOLLOW: The search engine does not show the page in 
search results, but trusts any links in the page.

◦ INDEX, NOFOLLOW: The search engine shows the page in the 
search results, but does not trust links in the page.

◦ NOINDEX, NOFOLLOW: The search engine does not show the page 
in search results and does not trust links in the page.

Alternatively, you can pass a variable into this field based on record 
data. For example, you can define a %description  variable in this 
field, and create a content variable to populate the content tag with 
record data.

Example 

7. Click Submit.
The meta information is added to the page header. For example:

<meta name="description" content="Order something from the 
 Service Catalog">

8. Optional:  Create a content variable to populate the content tag with record data.
If the page loads record data based on one or more URL parameters, you can add meta tags 
generated from the record data.
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a. Open a meta tag record and check that the Content  field contains a variable, or add a 
variable.
Depending on the available URL parameters and the meta tag you would like to define, you 
can add the following types of values:

Value types Description Example value

One URL parameter 
variable

Populates the content tag with the 
value defined in the associated content 
variables record.

%description

More than one URL 
parameter variable

Populates the content tag with the 
values defined in the associated content 
variables records.

%description 
%price

Static value and a URL 
parameter variable

Populates the content tag with a static 
value and the associated content 
variables record.

Catalog item: 
%description

Example 

(Optional)

b. In the Content variables  related list, click New.
The Content variables  related list is only available after saving the meta tag record.

c. Complete the form.
Associate a field with a URL query parameter. When the value of the query parameter is used 
to display content, a field from the same record is used to generate the content tag. You can 
define the field to generate the content tag through the Table field  field.

Field Description

Name The variable to store the value. Must begin with %  and cannot 
contain spaces. This value must match one of the variables 
defined in the Content  field in the Meta tag record.

Application Application scope of the page. This value is read-only.

Metatag The meta tag to apply the dynamic variable to.

URL query parameter URL parameter to indicate the record that is being displayed. 
You can enter any string.
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Field Description

Tip: 
To create a URL parameter that is meaningful and easily 
identifiable, use a field name from the record. For example, 
to refer to a knowledge article, you can enter number  to 
reference the article by its number.

Relevant table column Table field to match the URL query parameter. For example, if 
you entered number  to reference a knowledge article by its 
number, select Number. If left blank, the system uses the record 
sys_id.

Table The source table of the URL query parameter record.

Table field Select a field from the table defined in the Table  field. This field 
is used to generate the value of the content tag.

Important: 
To support SEO, ensure that the referenced table field is 
public. For more information on granting access to a table 
field, see Create an ACL rule .

If more than one content variables match a variable defined in the Content  field of the meta 
tag record, the record with the earliest Created date is used.

d. Click Submit.

The content tag loads record data. For example:

<meta name="description" content="Apple iPad 3">

Add dynamic titles to a page

Create variables to generate descriptive titles depending on the content loaded into a page.

Before you begin
Role required: admin

About this task
Note: 
The dynamic titles don’t apply to the knowledge article view page in the Knowledge 
Management Service Portal.

Procedure

1. Navigate to All  > Service Portal  > Pages.

2. Open a page.

3. Add one or more variables to the Dynamic page title  field.
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Depending on the available URL parameters and the dynamic title you would like to define, you 
can add the following types of values:

Value types Description Example value

One URL parameter 
variable

Generates a page title using the 
associated record of one URL parameter.

%first_name

More than one URL 
parameter variable

Generates a page title using the 
associated records of multiple URL 
parameters.

%first_name 
%last_name

Static value and a URL 
parameter variable

Generates a page title using a static 
value and the associated record of a URL 
parameter.

Employee: 
%first_name

Enter the variables in the intended syntax of the title. For example, to have an employee's 
name and title separated by a hyphen, you would enter %first_name - %title. In the 
page title, this syntax would render as something like "Beth - System Administrator".

4. Click the Dynamic page variables  related list tab.

5. Click New  to create a new variable.

6. On the form, fill in the fields.
Associate a field with a URL query parameter. When the value of the query parameter is used 
to display content, a field from the same record is used to generate the title. You can define the 
field to generate the title through the Table field  field.

Field Description

Name Variable to store the value. Must begin with %  and cannot contain 
spaces. This value must match one of the variables defined in the 
Dynamic page title  field.

Application Application scope of the page. This value is read-only.

Page Page to apply the dynamic variable to.

URL query parameter URL parameter to indicate the record that is being displayed. You 
can enter any string.

Tip: 
To create a URL parameter that is meaningful and easily 
identifiable, use a field name from the record. For example, 
to refer to a knowledge article, you can enter number  to 
reference the article by its number.

Relevant table column Table field to match the URL query parameter. For example, if you 
entered number  to reference a knowledge article by its number, 
select Number. If left blank, the system uses the record sys_id.

Table The source table of the URL query parameter record.

Table field Field from the table defined in the Table  field. This field is used to 
generate the dynamic page title.

If more than one dynamic page variables match a variable defined in the Dynamic page title 
field, the record with the latest Updated date is used.
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Variables with same name aren't supported and won't be created multiple times. Each variable 
should be unique.

In this example, the value of the Title field in the User [sys_user] table populates the page title. 
The %title  variable must also be defined in the Dynamic page title  field in the page record.

7. Click Submit.

Result
When the page loads, the record defined in the URL query parameter displays. The field defined 
in Table field  determines the title of the page.

Configure the main tag on a page

Specify the main content of a page to include in the <main>  tag to improve search engine 
optimization and accessibility.

Before you begin
Role required: sp_admin or admin

About this task
The <main>  tag is a semantic HTML element that contains the main content of the page. The 
<main>  tag should be applied to content that is unique to the page and should be configured 
for only one element on the page.

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration.

2. Select Designer.

3. Select a page.

4. Switch to the portal you want to design pages for by selecting the portal name in the header.

5. Select a container, row, or column on the page that contains the main content of the page.

See the breadcrumbs in the header to confirm you have the correct element selected. You 
can’t add the <main>  tag to a widget.

6. Select the edit icon [ ].

7. In the Semantic tag  field, select Main.

8. Select Save.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1016



Result
In the HTML of the page, the <main>  tag contains the container, row, or column. In Service 
Portal  Designer, a <main>  tag displays in the bottom-right corner of the element.

Enable SEO for localized versions of a portal page

Allow users to discover portal pages in their preferred language by adding hreflang  tags.

Before you begin
Role required: sp_admin or admin

Procedure

1. Navigate to All  > Service Portal  > Pages  and open a page record.
Ensure that Public  is selected for the page. Pages that are not public are not indexed by 
external search engines.

2. On the form, select the Use SEO script  check box.

Selecting this check box causes the SEO script  field to appear. By default, the system uses the 
SPSEOHeaderTags script include. You can use a different script include by updating this field.
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3. Click Update.

Result
The system adds default hreflang  tags for each active language in your instance.

What to do next
You can override the default hreflang  tags, add a canonical URL, or add custom header tags 
by updating the script include that is referenced in the SEO script  field. This needs to be set by 
the page or content author.

To specify a canonical URL for the page, update the generateCanonicalURL  function in the 
script include.

To specify custom header tags for the page, update the generateCustomTagsForSEO 
function in the script include.

For an example of inserting custom SEO tags into the knowledge article view page, see 
Configure custom SEO tags for canonical URLs and localized knowledge articles .

Sitemap Generator

Use the ServiceNow®  Sitemap Generator  application to define and automatically generate XML 
sitemaps to improve search engine optimization of public portal pages.

Activation information

You can activate the Sitemap Generator  application (sn_ux_seo_sitemap) from your instance. For 
more information, see Activate Sitemap Generator.
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You can also activate Sitemap Generator  from the ServiceNow Store. Visit the ServiceNow Store
website to view all the available apps and for information about submitting requests to the store. 
For cumulative release notes information for all released apps, see the ServiceNow Store  version 
history release notes .

Sitemap requirements

The sitemap is generated from a script or static XML. When creating a sitemap, you must 
ensure that its contents meet the following requirements because validating them isn’t handled 
automatically:

• Includes only pages with unauthenticated user access.

Sitemap Generator  automatically excludes portal URLs that aren’t publicly accessible 
from sitemaps. However, this doesn’t apply for URLs with custom domains instead of the 
ServiceNow  domain. URLs that are excluded from the sitemap are listed in the Application Log 
[syslog_app_scope] table.

• Excludes pages that respond with a 301 redirect.

• Excludes pages with the NOINDEX meta tag, such as retired or expired pages. If you use a 
script to create the sitemap, include logic similar to that of the SEO script include you used 
to add NOINDEX meta tags to pages to exclude those pages from the sitemap. For more 
information, see Configure custom SEO tags for canonical URLs and localized knowledge 
articles .

• For any pages with canonical URLs or hreflang  tags, the sitemap includes those canonical 
URLs or URLs with hreflang  tags returned by the SEO script include for that page. If you 
use a script to create the sitemap, include logic similar to that of the SEO script include you 
used to return canonical URLs or URLs with hreflang  tags. For more information, see SEO 
for canonical URLs and localized versions of knowledge articles .

• For any pages with human readable keywords in URLS, the sitemap includes those URLs 
with human readable keywords. If you use a script to create the sitemap, use one of the 
getHumanReadableUrl  methods in the SPSEOUtilsSNC  class to return the human 
readable keywords and include them in the sitemap URLs. For more information, see Add 
human readable keywords to page URLs.

Note: 
Guidance on how to meet these requirements is included in the code templates in the 
Script  and Static XML  fields where the sitemap contents are defined. For more information, 
see Generate XML sitemaps for SEO indexing.

For more information about sitemap requirements for SEO, refer to the following resources:

• Build and submit a sitemap  in the Google  documentation

• XML schema for the Sitemap protocol  on the sitemaps.org website

Activate Sitemap Generator

You can activate the Sitemap Generator  plugin (sn_ux_seo_sitemap) for Service Portal  if you 
have the admin role.

Before you begin
Role required: admin

About this task
Scheduled jobs and tables are installed with Sitemap Generator.
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For more information, see Components installed with Sitemap Generator.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Sitemap Generator  plugin (sn_ux_seo_sitemap) using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Components installed with Sitemap Generator

Several types of components are installed with activation of the Sitemap Generator  plugin, 
including tables and scheduled jobs.

Scheduled jobs installed

Scheduled job Description

Sitemap Scheduler Updates the sitemap contents daily at midnight.

SitemapPurgeScheduler Deletes the previous version of the sitemap.

Tables installed

Table Description

UX Sitemap Configuration

[sys_ux_seo_sitemap_config]

Sitemaps configured on the instance.

UX Sitemap Definition

[sys_ux_sitemap_definition]

Definitions that specify the content to include in a sitemap.

Generate XML sitemaps for SEO indexing

Create XML sitemaps for web crawlers to index your public portal pages and improve search 
engine optimization for your portals.
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Before you begin
Add SEO information to portal pages, such as meta tags that improve the searchability of Service 
Portal  pages. For more information, see Improving search engine optimization for portals.

Review the "Sitemap requirements" section of the Sitemap Generator  documentation topic to 
determine what content should be in the sitemap.

Role required: admin

Procedure

1. Navigate to All  > Sitemap Generator  > Sitemap Configuration.

2. In the UX Sitemap Configurations [sys_ux_seo_sitemap_config] table, select New.

3. On the form, fill in the fields.

UX Sitemap Configuration form

Field Description

Sitemap Name A unique name for the sitemap.

Description A description of the sitemap contents.

Active Option for whether the sitemap is automatically generated.

4. From the form context menu, select Save.

5. From the Sitemap Config Definition  tab, select New.

Important: 

◦ You must ensure that the contents of your sitemap meet the Sitemap requirements.

◦ You don’t need to add the header and footer of the sitemap XML. These are added 
automatically when the sitemap is generated.

6. In the Type  field of the UX Sitemap Definition form, select one of the following options to define 
the contents of the sitemap either with a script or by specifying static URL elements.

7. Select Active  and then select Submit.

8. Optional:  Repeat steps 5  through 7  to define additional content to include in the sitemap.
You can create multiple sitemap definitions with any combination of types that combine to 
create the sitemap. For example, you could include both static XML and dynamic content from 
a script or you could include content from multiple scripts.

9. Optional:  Configure the number of URL elements to include per sitemap page to control how 
many pages are in your sitemap.
By default, 750 URLs are included per sitemap page. For URLs with hreflang  tags, you 
should limit the number of URLs per page to the default value of 750 URLs.

a. Enter sys_properties.list  in the navigation filter.

b. Open the glide.sitemap.page.count  property and set the value to the number of 
URLs to include per page.
The maximum value is 5,000.

c. Select Update.
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10. From the UX Sitemap Configuration record, select Generate Sitemap.

If a sitemap includes more than the number of URL elements specified with the 
glide.sitemap.page.count  system property, a sitemap index file that specifies the 
URLs of the sitemap pages is generated. The sitemap index file naming structure is sitemap-
<sitemap-config-sysid>.xml  and the sitemap page naming structure is sitemap-
<page>-<sitemap-config-sysid>.xml.

11. Select Copy Sitemap URL  and add the sitemap URL in Google  Search Console or to your 
robots.txt  file with the Google  Custom Search integration.

Note: 
This URL accesses the latest sitemap or, if the sitemap is paginated, the latest sitemap 
index. It doesn’t execute scripts on the fly to regenerate the sitemap.

For information about using Google  Search Console, see Manage your sitemaps using the 
Sitemaps report  in the Google  documentation. For information about the Google  Custom 
Search integration, see ServiceNow provided integrations .

12. Optional:  Review any portals URLs that were excluded from the sitemap because they aren't 
publicly accessible.

a. Navigate to All  > System Logs  > System Log  > Application Logs.

b. In the condition builder, enter the filter [App Scope] [is] [Sitemap Generator] AND 
[Message] [starts with] [The given URL].
The Message  field includes the excluded URLs. For example, "The given URL https://
<instance>/kb?id=kb_article_view  is not public".

Result
All active sitemaps automatically regenerate once a day and include content from any of their 
active sitemap definitions. Previous versions of the sitemap are deleted. You can check the 
status of the daily job at All  > System Logs  > System Log  > Application Logs  using the filter [App 
Scope] [is] [Sitemap Generator].

Posting announcements to portal users

Announcements broadcast messages to Service Portal  users. They display in an announcement 
banner or an announcement widget instance.

Announcements are active on new instances. To activate announcements after upgrade, you can 
activate the Service Portal  Announcements plugin (com.glide.service-portal.announcements).

When creating announcements, you can define the way an announcement displays.

Sort order

Announcements are displayed depending on the order defined in:

• The glide.service_portal.announcement.default_sort_order 
system property. See Service Portal properties.

• The Display First  field in the announcement record.

If there is a tie between two records set to Display first, the sort order defined in the 
system property is honored.

Display location
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Announcements can display in the following locations:

• Announcement banner

• Announcements widget  instance

To define the announcement display location, define the announcement type in the 
announcement record.

Display Style

Using display styles, you can:

• Create a custom color scheme.

• Change the text alignment.

Announcements that appear in a banner use the display style defined in the 
Announcement record by default. To use the display style in an instance of the 
Announcements widget, you can select the Use Display Style  instance option.

User criteria

If user criteria is set up for the Service Portal, you can define who can and 
who cannot view an announcement. Through user criteria, you can create 
announcements only visible to specific users, groups, roles, organizations, and 
more.

Create an announcement

An announcement appears as a banner in Service Portal  or within the announcements widget.

Before you begin
Role required: announcement_admin, sp_admin, or admin

About this task
The title and summary of an announcement can be localized in the Translated Text 
[sys_translated_text] table. For more information, see Translating text fields .

Procedure

1. Navigate to All  > Service Portal  > Announcements.
The Announcements [announcement] table displays all announcements.

2. Click New.

3. On the form, fill in the fields.

Field Description

Name Internal title that doesn't display in the announcement.

Active Option to activate the announcement. To hide an announcement, clear 
the Active  check box.

Title Title to appear in the announcement.

From Date and time that the announcement begins to appear.

To Date and time that the announcement ends. If left empty, the 
announcement continues to appear until it's deactivated.

Summary Text to appear in the announcement.
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Field Description

Display style Defines the background color, text color, and text alignment of banner 
announcements. Base system styles include:

◦ Normal: Blue background and left-aligned, white text.

◦ Urgent: Red background and left-aligned, white text.

Announcements that appear in a banner use the display style defined 
in the Announcement record, by default. To use the display style in an 
instance of the Announcements widget, you can select the Use Display 
Style  instance option.

Type
Defines where an announcement displays. By default, announcements 
appear in the following locations:

◦ Banner: Announcement banner above the banner frame in the Service 
Portal.

◦ Widget: Instance of the announcements widget.

You can create an announcement type to define other widget instances 
to display an announcement.

Glyph Glyph to display to the left of the title in banner announcements.

Glyph alt text Alternative text for the glyph icon used with screen readers.

Public Option to display the announcement to users before and after they've 
logged in.

Display first If selected, the announcement displays before all other announcements.

If there is a tie between two records set to 
Display first, the sort order defined in the 
glide.service_portal.announcement.default_sort_order 
system property is honored. See Service Portal properties.

Roles If Public  is not selected, you can define the roles that the announcement 
is visible to. If left empty, the announcement is visible to all roles.

Note: 
Alternatively, you can define user criteria for the announcement 
instead. To do so, set up User criteria for Service Portal  and clear 
the Public  check box. Announcements display to only the users 
who pass the access criteria.

Unauthenticated 
only

Option to display the announcement only to users who haven't logged in.

This option appears only if Public  is selected.

Click target Creates a link below the announcement body that opens to a target page 
or URL.

◦ None: Announcement doesn't include a link.

◦ Page: Opens a Service Portal  page in the current browser tab.

◦ URL in current browser tab: Opens a URL in the current browser tab.

◦ URL in new browser tab: Opens a URL in a new browser tab.
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Field Description

Details page The page that opens in the current browser tab. Available if the Click 
target  is Page.

Details URL The URL that opens in the current or new browser tab. Available if the 
Click target  is URL in current browser tab  or URL in new browser tab.

Details link text Link text for the page or URL click target. If you leave this field empty and 
define a click target, the title of the announcement is "Learn More".

Dismiss options Determines whether the user can dismiss the announcement. Options 
include:

◦ User can dismiss - no redisplay

◦ User can dismiss for current session only

◦ User cannot dismiss

Portals Portals that display the announcement. If this field is empty, the 
announcement displays in all portals.

4. Save or submit the record.

What to do next
If the Type  is Banner, test your announcement by navigating to the portal defined in the Portals 
field. If the Type  is Widget  or a custom type, test your announcement by navigating to the page 
with the associated widget instance.

Create an announcement display style

Define the background color, foreground color, and text alignment of an announcement.

Before you begin
Role required: admin, sp_admin, or announcement_admin

Procedure

1. Navigate to All  > Service Portal  > Announcements.

2. Open an existing announcement or create a new announcement.

3. In the Display style  field, click the reference lookup icon to open the referenced table.
The Announcement Styles [announcement_style] list view opens.

4. Click New  to create a new display style.

5. Complete the form.

Field Description

Name Internal name of the display style.

Application The application scope of the announcement. This value is read-
only.

Background color Color name or HEX value in the format  000000 for the 
announcement background.

Foreground color Color name or HEX value in the format  000000 for the 
announcement text.
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Field Description

Alignment Text alignment. Options include:

◦ Left align

◦ Center align

6. Click Submit.

Result
By default, the announcement appears in both the portal banner and the Announcements 
widget, but only the banner uses your new display style. You can configure the widget to use the 
display style also. For more information, see the instance options in Announcements widget.

Create an announcement type

Announcement types determine where an announcement displays. Announcements include two 
base system types: banner and widget.

Before you begin
Role required: admin, sp_admin, or announcement_admin

About this task
Similar to creating a category tag, you can create alternative types to define custom locations. 
For example, to display an announcement only in a specific widget instance, you can create an 
announcement type for that widget instance. Any announcements tagged with that type will only 
display in the desired widget instance.

Procedure

1. Navigate to All  > System Definition  > Tables  > Announcement Consumer Type.
The Announcement Consumer Type table [announcement_consumer_type] opens.

2. In the Columns section of the form, Click New.

3. Define a Name.
The name is used to associate an announcement with a widget instance.

4. Click Save.

5. Add the custom type to an announcement.

a. Navigate to Service Portal  > Announcements.

b. Open an existing announcement or create a new announcement.

c. In the Type  field, select the custom type.

d. Click Save.

6. If using the type in a widget, define the type as a widget instance option.
The announcement banner only displays announcements tagged with the Banner  type.

a. Navigate to an instance of the Announcement widget.

b. Control + right-click the widget instance and select Instance Options.

c. In the Type  field, select the custom announcement type.

Result
The widget instance associated with the type displays any announcements tagged with the 
same type.
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Analyzing portal performance and usage

Analyze the user experience and performance of a portal. With these analytics and performance 
evaluation tools, you can gather insights to improve your portal's performance and usage.

Analytics and Reporting Solutions for Service Portal

Platform Analytics Solutions  contain prepackaged Performance Analytics  and Reporting  content 
for use with other ServiceNow AI Platform  products. This Platform Analytics Solution  provides 
metric visualizations to better understand the Service Portal user experience and identify how to 
improve it.

Required roles

The following roles and tasks are associated with this Solution:

• ServiceNow AI Platform  administrator (admin): Install and activate this Analytics and Reporting 
Solution and make any necessary changes to system properties.

• Performance Analytics  administrator (pa_admin): Review the indicators, breakdowns, widgets, 
and dashboards. Set up and start data collection. Share the dashboards with appropriate 
stakeholders.

For information about additional roles, see .

User Experience Analytics  for Service Portal

The User Experience Analytics  application provides views for monitoring usage analytics of your 
Service Portal  applications. Visualize metrics and interactions to better understand the Service 
Portal  user experience and identify how to improve it.

https://player.vimeo.com/video/1107546571?
h=347a86e18b&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

You can view user analytics tracking for the portal in the User Experience Analytics  application. 
For more information, see Overview of the User Experience Analytics application .

User Experience Analytics  for Service Portal  provides views for monitoring the key performance 
indicators (KPIs) of web applications built on Service Portal. You can use these insights to 
optimize your portal.
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For example, User Experience Analytics  tracks when a user orders a catalog item or views a 
knowledge article. You can use this data to infer which items or articles are the most popular 
among users. For more information on user-triggered events that are tracked automatically, see 
Service Portal events.

• Note: 
User Experience Analytics  tracking is enabled for all portals by default. You need to 
enable tracking for a portal only if you enabled tracking for some portals but not others in 
a previous version. For more information, see Track User Experience Analytics in Service 
Portal.

• Note: 
If you make certain key changes to portals, such as changing the sys_id, data is not 
carried over and you see a different dashboard.

Roles

The portal_analytics_admin and portal_analytics_viewer roles are installed with the Service 
Portal Analytics plugin (com.glide.service-portal.analytics). For information on other roles 
associated with User Experience Analytics, see Roles installed with User Experience Analytics .

User consent notices

User consent notices must conform to the ServiceNow  Data Processing Addendum. Review 
your ServiceNow  template user consent notices before they are presented to users. You can 
tailor the options for how these notices are presented to users, including the wording. For more 
information, see Define texts for Notice and Explicit Opt-in messages .

Related topics

User Experience Analytics

Track User Experience Analytics  in Service Portal

Track User Experience Analytics  for Service Portal  to monitor key performance indicators with the 
User Experience Analytics  application.

Before you begin
Role required: portal_analytics_admin

About this task
By default, tracking is not enabled for portals. You need to enable tracking for a specific portal 
only if you enabled tracking for some portals but not others in a previous version.

Portals that have been configured for tracking are listed in the User Experience Analytics  settings 
[sys_analytics_bucket] table. For information about managing existing analytics settings for a 
portal, see Configure User Experience Analytics Settings .

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. Select the portal title.

3. On the portal form, select Create Analytics Settings.
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Note: 
If a portal has already been configured for tracking, the button name will be View 
Analytics Settings.

4. On the User Experience Analytics Settings form, specify which users to track.

◦ To track analytics only for authenticated users, clear the Enable Unauthenticated User 
Tracking  check box.

◦ To track analytics for both unauthenticated and authenticated users, select the Enable 
Unauthenticated User Tracking  check box.

Note: 
If you enabled unauthenticated user tracking, you might be required by law to notify 
unauthenticated users that you are tracking their usage for analysis. To display a legal 
notice, activate the Privacy Notice announcement, which is inactive by default. For more 
information, see Activate the privacy notice for unauthenticated users.

5. Select Update.

Result
You can now view user analytics tracking for the selected portal by navigating to All  > Platform 
Analytics  > User Experience Analytics. For more information on using the User Experience 
Analytics  application, see Overview of the User Experience Analytics application .

Related topics

Enable User Experience Analytics

Activate the privacy notice for unauthenticated users

If you enabled unauthenticated user tracking in your portal, you may be required by law to notify 
unauthenticated users that you are tracking their usage for analysis. You can display a legal 
notice by activating the Privacy Notice announcement.

Before you begin
By default, unauthenticated user tracking is turned off for portals. To modify analytics settings for 
a portal, see Configure User Experience Analytics Settings .

Role required: sp_admin

Procedure

1. Navigate to All  > Service Portal  > Announcements  and open the inactive record named 
Privacy Notice.

2. Review the form.

You can modify the default text of the Summary  field or leave it as-is.
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Privacy Notice announcement form

By default, the Unauthenticated only  option is selected to display the announcement only to 
users who haven't logged in to the portal. The announcement disappears after the user logs in.

3. In the Portals section, select a portal in which to display the announcement.
If no portals are available, select Insert a new row  and specify a portal.

Portals section

Note: 
The Privacy Notice announcement appears only in portals for which have User 
Experience Analytics settings.

4. Activate the announcement by selecting the Active  option.

5. Select Update.

Result
The Privacy Notice announcement is displayed to unauthenticated portal users.

Privacy Notice example

Related topics

Create an announcement
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Service Portal  events

View Service Portal  events to get insight into how a portal is being used in your organization.

User Experience Analytics  automatically detects the gestures and actions of portal users. You 
can view each occurrence of these events in the User Experience Analytics  application.

Event Description

Submit Catalog 
Request Tracks when a user submits a request through the SC Catalog Item 

widget. You can view the request ID and the number of items in each 
request.

Use these analytics to optimize the Service Catalog.

Order Catalog Item
Tracks when a user orders a catalog item through the SC Catalog Item 
widget. You can view the name and ID of each ordered item. You can 
also view the associated request ID.

Use these analytics to optimize the Service Catalog.

Submit Record 
Producer Request Tracks when a user submits a request through any record producer.

Use these analytics to optimize the Service Catalog.

View Knowledge 
Article Tracks when a user views a knowledge article. You can view the name, 

ID, and language of each viewed article.

Use these analytics to optimize the knowledge base.

Initiate Search
Tracks when a user searches the portal using the Faceted Search and 
Typeahead Search widgets. You can view the search keywords that 
users enter. You can also compare usage of the two search widgets.

Use these analytics to improve search in Service Portal.

Search Result 
Selected Tracks when a user selects a search result when using the Faceted 

Search widget. You can view the click rank and sys_id of the selected 
search item.

Use these analytics to improve search in Service Portal.

Successful Login
Tracks when a user logs in to Service Portal.

Use these analytics to monitor login activity within a given time period.

PortalPageLoad
Tracks which pages users visit and in which languages.

Use these analytics to understand your user base and the pages they 
interact with.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1031



Event Description

SP File Attach
Tracks how users attach files to records from portal pages: by 
navigating the file system, pasting files from the clipboard, or dragging 
and dropping files.

Use these analytics to optimize how users can attach files to records 
from portal pages.

You can create custom events to be triggered. For more information, see SNAnalytics - Client

Related topics

SC Catalog Item widget

Faceted Search widget

Typeahead Search widget

User Experience Analytics  related properties for Service Portal

Use system properties to configure User Experience Analytics  for Service Portal.

glide.analytics.tracking.force_allowed.portals

Turns off the user consent pop-up for specified portals. You specify a portal by 
pasting its sys_id in the Value  field. To specify multiple portals, enter a comma-
separated list with no spaces.

• Type: string

• Default value: none

glide.analytics.tracking.restricted.portals

Turns off user analytics tracking for specified portals. You specify a portal by pasting 
its sys_id in the Value  field. To specify multiple portals, enter a comma-separated 
list with no spaces.

• Type: string

• Default value: none

Related topics

Add a system property

Unique record identifier (sys_id)

Evaluate the performance of a portal page

Evaluate how the widgets on a page perform against performance benchmarks that you specify.

Before you begin
Role required: sp_admin or admin

Procedure

1. Turn on the Performance Analyzer for the portals that you want to evaluate.
By default, the Performance Analyzer is enabled for the Service Portal (sp).
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a. In the navigation filter, enter sys_properties.list.

b. Filter the list by entering sp_allow_perf_debug_option_for_portals  for the 
Name field.

c. Select the sp_allow_perf_debug_option_for_portals  record.

d. In the Value field, enter the suffixes of the portals to analyze.

For users with the sp_admin or admin roles, the open Performance Analyzer icon ( ) appears 
on pages in the specified portals.

2. Navigate to the portal page that you want to analyze.

3. Select the open Performance Analyzer icon ( ).
The Performance Analyzer opens in another browser tab. The Portal Page URL field 
automatically populates with the URL of the page from which you open the Performance 
Analyzer.

4. From the Benchmarks details tab, enter the performance benchmarks to analyze the page 
against.

Benchmark Description

Widget Load Time 
(ms)

The time, in milliseconds (ms), that it takes for a widget to load on the 
page.

ACL Execution time 
(ms)

The time, in milliseconds (ms), that it takes for a widget to execute 
any applicable ACLs.

DB Call Execution 
Time (ms)

The time, in milliseconds (ms), that it takes for a widget to execute 
database queries.

Business Rule 
Execution Time (ms)

The time, in milliseconds (ms), that it takes for a widget to execute 
business rules.

Ajax Calls Time (ms) The time, in milliseconds (ms), that it takes for a widget to execute 
AJAX calls.

Ajax Waiting Time 
(sec)

The time, in seconds (s), to wait for AJAX calls after the page has 
finished loading.

5. Select Validate.

Note: 
During validation, refrain from interacting with other pages on the instance as doing so 
could impact the results of the page evaluation.

The Performance Analyzer returns the benchmark results, which include any widgets on the 
page that exceed the benchmarks and details about their performance.

6. Review the benchmark results.

7. Optional:  To evaluate the page against different benchmarks, select Start Over  and enter new 
benchmarks.

What to do next
Consider updating any widgets that don’t meet your performance benchmarks to improve the 
page performance. For example, if a widget's server script takes too long to load, evaluate if the 
script can be improved to load faster.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1033



Get a list of widgets per page

Get a summary of all widgets that appear on Service Portal  pages. Use this data to better 
understand widget customizations and page usage.

Before you begin
Role required: sp_admin or admin

About this task
The Portal Analyzer is a scheduled job that runs on-demand. After you select to run the Portal 
Analyzer job, the system produces a list of each widget and the page that it appears on.

The list also includes the following information:

• Level of customization of each widget

• Number of views on each page

• Number of user visits on each page

Use the exported list to consider which pages and widgets to focus on while redesigning your 
portal. For example, you might consider removing a page that has fewer user visits or replacing a 
customized widget with a cloned widget.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Portal Analyzer record.

3. On the form header, select Execute Now.
The system creates a list of all the widgets on each page in your instance.

4. In the navigation filter, enter sp_portal_analyzer.list.

5. Review the list and, if needed, export it as a CSV, Excel, XML, JSON, or PDF file to reference 
during a system upgrade.
For more information on exporting list data, see List export .

Related topics

Scheduled jobs

Service Portal  reference

Reference topics provide information about roles, configuration properties, SCSS variables, 
domain separation, and more.

Service Portal  roles

Service Portal  installs these roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Service Portal  administrator  [sp_admin]

Manages the configuration of portals created by Service Portal.

Contains Roles

List of roles contained within the role.
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• evam_admin

• taxonomy_admin

• search_application_admin

• announcement_admin

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Announcements administrator  [announcement_admin]

Manages posting announcements to portals.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.

Portal analytics administrator  [portal_analytics_admin]

Can create User Experience Analytics  settings for Service Portal.

Contains Roles

List of roles contained within the role: portal_analytics_viewer.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Note: 
Avoid granting an admin role when more specialized roles are available.
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Portal analytics viewer  [portal_analytics_viewer]

Users with this role can view the Analytics Dashboard  link and settings within in the application 
navigator, and have viewer role permissions for portal metrics in the Service Portal  > Analytics 
Dashboard.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations
Read-only access to analytics. Use the Portal analytics administrator [portal_analytics_admin] 
role to manage analytics.

Service Portal  properties

Service Portal  properties control aspects of the portal experience for admin and end users.

The most commonly used Service Portal properties are set on the Service Portal  properties 
page. Some less commonly used properties are available only from the System Properties 
[sys_properties] table.

You can access the properties listed in the following table by navigating to All  > Service Portal  > 
Properties.

Service Portal  page properties

Property Description

Default 404 page (page ID or sp_page sys_id) 
for Service Portal

glide.service_portal.default_404_page

Set the default page that your users see 
whenever a page can’t load properly.

• Type: string

• Default value: 404

• Learn more: Assign a default error page

The string must match the name of the page 
exactly.

Show a message to admin users in Service 
Portal  pages if a browser error is encountered

glide.sp.show_console_error

• Type: true | false

• Default value: true

Maximum number of stream entries displayed 
in Service Portal  (activity widget, conversation 
widget, and so on)

glide.service_portal.stream_entry_limit

Limit the number of entries users can see in 
the ticket conversation widget. Users only see 
the most recent entries and can’t go further 
back in the history than the maximum allowed 
amount.
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Service Portal  page properties  (continued)

Property Description

• Type: integer

• Default value: 100

Duration (in seconds) info and error messages 
persist in the Service Portal  before auto-
dismissal

glide.service-
portal.notification_timeout.seconds

Set the duration in seconds that non-critical 
notifications remain on the screen before they 
are auto-dismissed. If set to 0, messages do 
not auto-dismiss and require that a user close 
them.

• Type: integer

• Default value: 5

Critical notifications should be tagged with 
the sn-sticky-notification  HTML 
class attribute to prevent them from being 
automatically dismissed.

If the glide.ui.accessibility preference is 
enabled, messages don’t auto-dismiss, 
regardless of the system property value. To 
set this preference, see Enabling accessibility 
features.

Default sort order for announcements

glide.service_portal.announcement.default_sort_order

Define the sort order for banner 
announcements.

• Type: choice list

• Default value: Start Date Descending

Options include:

• Start Date Ascending: The oldest start date 
appears first.

• Start Date Descending: The most recent 
start date appears first.

• End Date Ascending: The oldest end date 
appears first.

• End Date Descending: The most recent end 
date appears first.

Enable debug runtime information

glide.sp.debug

Controls whether the Angular.js flag 
$compileProvider.debugInfoEnabled 
is set to true or false. This option allows debug 
runtime information in the compiler, such as 
adding binding information and a reference to 
the current scope on to DOM elements. This 
property is turned off by default to improve 
performance on the instance.
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Service Portal  page properties  (continued)

Property Description

• Type: true | false

• Default value: false

If user criteria  [com.glide.service-portal.user-criteria] is enabled, the following 
properties also appear in the Service Portal  properties page:

User criteria properties

Property Description

Enable use of User Criteria records instead of 
Roles fields for Service Portal  entitlements

glide.service_portal.user_criteria_enabled

Define permissions for Service Portal  widgets, 
widget instances, pages, and search sources.

• Type: true | false

• Default value: true

• More information: User criteria for Service 
Portal

List of roles (comma-separated) that bypass 
User Criteria validation in Service Portal

glide.sp.entitlement.override

Allow users with a specific role to see any 
page, widget, widget instance, or search 
source regardless of user criteria.

• Type: string

• Default value: admin

You can access the properties listed in the following table in the System Properties 
[sys_properties] table.

Service Portal  system properties

Property Description

glide.service_portal.enable_acls_for_encoded_query_in_list
Option to always enforce read ACLs for filter 
conditions specified in Simple List widget 
instances. If false, the Enforce field-level Read 
ACLs on Filter query terms  option in Simple 
List widget instances determines whether to 
enforce the ACLs.

• Type: true | false

• Default value: true

• For more information, see Simple List 
widget.
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Service Portal  system properties  (continued)

Property Description

glide.service_portal.enable_human_readable_urls
Option to allow configuring human readable 
keywords in portal page URLs for the instance.

• Type: true | false

• Default value: true

• For more information, see Add human 
readable keywords to page URLs.

glide.service_portal.enforce_cross_scope_check_in_formOption to enforce validating cross-scope 
privileges to a table when the form widget 
fetches data from a table.

• Type: true | false

• Default value: true

• For more information, see Form widget.

glide.service-
portal.notification.threshold Specify how many notifications should appear 

before users have the option to clear all 
notifications at once.

• Type: integer

• Default value: 5

glide.service_portal.sso.early_redirect.portalsRedirects users to the SSO Identify Provider 
(IdP) login page without first redirecting them 
to the portal login page. Provide a comma-
separated list of portal suffixes.

Note: 
If your portal uses a customized version 
of the Login widget, you must update the 
sp_sso_early_redirection  UI 
macro as needed to redirect users to the 
SSO Identify Provider (IdP) login page 
without trying to load the portal page first.

• Type: String

• Default value: None

• For more information, see Single sign-on, 
logins, and URL redirects.

glide.sp.portals.language_selector_enabledAllows any user to choose and view content in 
their preferred language.

This property contains a list of portal sys 
IDs separated by commas. By default, the 
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Service Portal  system properties  (continued)

Property Description

sys IDs for the Knowledge (/kb), Customer 
Support (/csm), and Customer Service (/csp) 
portals are included. For any portal specified, 
the language selector appears in the portal 
header if any languages are installed and 
active on the instance in addition to English.

• Type: string

• Default value: 
2086b814c3221200f3897bfaa2d3aea8,89275a53cb13020000f8d856634c9c51,45d6680fdb52220099f93691f0b8f5ad

• For more information, see Enable a 
language selector in portal headers.

glide.sp.starting.page.ignore.listIgnores intermediate pages used during 
SSO authentication in order for users to be 
directed to their starting page rather than 
an intermediate page. Provide a comma-
separated list of page IDs.

• Type: String

• Default value: login_with_sso,idp_disco

glide.sp.theme.parse_scss
Option to allow compiled SCSS files to be 
loaded as links to improve repeat page view 
performance. If set to false, SCSS files are 
included inline in the page HTML instead.

• Type: true | false

• Default value: true

sp_allow_perf_debug_option_for_portalsSpecify the portals to evaluate using the 
Performance Analyzer by providing a comma-
separated list of portal suffixes. For users with 
the sp_admin or admin roles, the Performance 

Analyzer icon ( ) appears on pages in the 
specified portals.

• Type: String

• Default value: sp

• For more information, see Evaluate the 
performance of a portal page.

Service Portal SCSS Primer

SCSS is a subset of the Syntactically Awesome StyleSheets (Sass) specification and is an 
extension of CSS. Every valid CSS style sheet is valid SCSS.
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SCSS variables

SCSS variables are a way to store information that you want to reuse throughout your style sheet. 
You can store things like colors, font stacks, or any CSS value you think you want to reuse. SCSS 
uses the $ symbol to make something a variable.

SCSS supports the follow data types:

• Numbers (including units)

• Strings (with quotes or without)

• Colors (name, or names)

• Booleans

Variables can also be arguments to or results from one of several available functions or mixins. 
During translation, the values of the variables are inserted into the output CSS document.

For example:

$font-stack:    Helvetica, sans-serif;
$primary-color: ➚333;
 
body {
  font: 100%$font-stack;
  color: $primary-color;
}

For more information on Sass, see the Sass/SCSS reference .

SCSS functions

List of functions for Service Portal SCSS compiler.

RGB functions

Function Description

rgb($red, $green, $blue) Creates a Color from red, green, and blue 
values.

rgba($red, $green, $blue, $alpha) Creates a Color from red, green, blue, and 
alpha values.

red($color) Gets the red component of a color.

green($color) Gets the green component of a color.

blue($color) Gets the blue component of a color.

mix($color1, $color2, [$weight]) Mixes two colors together.

HSL functions

Function Description Availability

hsl($hue, $saturation, 
$lightness)

Creates a Color from hue, 
saturation, and lightness 
values.

Yes
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Function Description Availability

hsla($hue, $saturation, 
$lightness, $alpha)

Creates a Color from hue, 
saturation, lightness, and 
alpha values.

Yes

hue($color) Gets the hue component of a 
color.

Yes

saturation($color) Gets the saturation 
component of a color.

Yes

lightness($color) Gets the lightness component 
of a color.

Yes

adjust-hue($color, $degrees) Changes the hue of a color. Yes

lighten($color, $amount) Makes a color lighter. Yes

darken($color, $amount) Makes a color darker. Yes

saturate($color, $amount) Makes a color more saturated. Yes

desaturate($color, $amount) Makes a color less saturated. Yes

grayscale($color) Converts a color to grayscale. Yes

complement($color) Returns the complement of a 
color.

No

invert($color) Returns the inverse of a color. No

Opacity functions

Function Description Availability

alpha($color) Gets the alpha component 
(opacity) of a color.

Yes

opacity($color) Gets the alpha component 
(opacity) of a color.

Yes

rgba($color, $alpha) Changes the alpha 
component for a color.

Yes

opacify($color, $amount) Makes a color more opaque. No

fade-in($color, $amount) Makes a color more opaque. No

transparentize($color, 
$amount)

Makes a color more 
transparent.

No

fade-out($color, $amount) Makes a color more 
transparent.

No

Other color functions

Function Description Availability

adjust-color() Increases or decreases one or 
more components of a color.

Yes
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Function Description Availability

scale-color() Fluidly scales one or more 
properties of a color.

Yes

change-color() Changes one or more 
properties of a color.

No

ie-hex-str() Converts a color into the 
format understood by IE filters.

No

String functions

Function Description Availability

unquote($string) Removes quotes from a string. Yes

quote($string) Adds quotes to a string. Yes

str-length($string) Returns the number of 
characters in a string.

No

str-insert($string, $insert, 
$index)

Inserts $insert into $string at 
$index.

No

str-index($string, $substring) Returns the index of the first 
occurrence of $substring in 
$string.

No

str-slice($string, $start-at, 
[$end-at])

Extracts a substring from 
$string.

No

to-upper-case($string) Converts a string to upper 
case.

No

to-lower-case($string) Converts a string to lower 
case.

No

Number functions

Function Description Availability

percentage($number) Converts a unitless number to 
a percentage.

Yes

round($number) Rounds a number to the 
nearest whole number.

Yes

ceil($number) Rounds a number up to the 
next whole number.

Yes

floor($number) Rounds a number down to the 
previous whole number.

Yes

abs($number) Returns the absolute value of 
a number.

Yes

min($numbers…) Finds the minimum of several 
numbers.

Yes
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Function Description Availability

max($numbers…) Finds the maximum of several 
numbers.

Yes

random([$limit]) Returns a random number. No

List functions

Lists in SCSS are immutable. All list functions return a new list rather than updating the existing 
list in-place.

All list functions work for maps as well, treating them as lists of pairs.

Function Description

length($list) Returns the length of a list.

nth($list, $n) Returns a specific item in a list.

set-nth($list, $n, $value) Replaces the nth item in a list.

join($list1, $list2) Joins two lists into one.

append($list1, $val) Appends a single value onto the end of a list.

zip($lists…) Combines several lists into a single 
multidimensional list.

index($list, $value) Returns the position of a value within a list.

list-separator($list) Returns the separator of a list.

Adding custom functions

Scss @function my-calculation-function($some-number, $another-number){ @return $some-
number + $another-number }

SCSS nesting

SCSS lets you nest your CSS selectors in a way that follows the same visual hierarchy of your 
HTML.

For example:

nav {
  ul {
    margin: 0;
    padding: 0;
    list-style: none;
  }
 
  li { display: inline-block; }
 
  a {
    display: block;
    padding: 6px 12px;
    text-decoration: none;
  }
}
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The ul, li, and a  selectors are nested inside the nav  selector, which is a great way to organize 
your CSS and make it more readable. When the widget is rendered, the generated CSS looks 
something like the following code block:

nav ul {
  margin: 0;
  padding: 0;
  list-style: none;
}
 
nav li {
  display: inline-block;
}
 
nav a {
  display: block;
  padding: 6px 12px;
  text-decoration: none;
}

For more information on Sass, see the Sass/SCSS reference .

SCSS operators

SCSS has a handful of standard math operators like +, -, *, /, and %.

Use simple math to calculate widths for an aside &  article. For example:

.container { width: 100%; }
 
article[role="main"] {
  float: left;
  width: 600px / 960px * 100%;
}
 
aside[role="complementary"] {
  float: right;
  width: 300px / 960px * 100%;
}

The generated CSS looks like:

.container {
  width: 100%;
}
 
article[role="main"] {
  float: left;
  width: 62.5%;
}
 
aside[role="complementary"] {
  float: right;
  width: 31.25%;
}

For more information on Sass, see the Sass/SCSS reference .
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SCSS mixins

A mixin lets you make groups of CSS declarations that you want to reuse throughout your site. 
You can pass in values to make your mixin more flexible.

The following code block is an example for border-radius.

@mixin border-radius($radius) {
  -webkit-border-radius: $radius;
     -moz-border-radius: $radius;
      -ms-border-radius: $radius;
          border-radius: $radius;
}
 
.box { @include border-radius(10px); }

The generated CSS looks like:

.box {
  -webkit-border-radius: 10px;
  -moz-border-radius: 10px;
  -ms-border-radius: 10px;
  border-radius: 10px;
}

For more information on Sass, see the Sass/SCSS reference .

Domain separation and Service Portal

Domain separation is unsupported in Service Portal. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Overview

Domain separation provides complete data isolation for domain-specific users.

How domain separation works in Service Portal

Elements of the Service Portal platform such as settings, portals, pages and widgets are 
not domain-separated. However, the data within widgets does display when based on the 
appropriate domain. To provide different experiences, admins should create separate service 
portals, each with unique URLs, that they can redirect users to.

Related topics

Domain separation for service providers

Plugins installed with Service Portal

The following plugins are installed with the Service Portal  for Enterprise Service Management 
[com.glide.service-portal.esm] plugin, which is a ServiceNow AI Platform  feature that is active by 
default.
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• Service Portal - Knowledge Base [com.glide.service-portal.knowledge-base]

• Service Portal - Service Catalog [com.glide.service-portal.service-catalog]

• Service Portal - Service Status [com.glide.service-portal.service-status]

• Service Portal Configuration Pages [com.glide.service-portal.config]

• Service Portal Designer [com.glide.service-portal.designer]

• Service Portal Surveys [com.glide.service-portal.survey]

If Service Portal  [com.glide.service-portal.esm] is not active on your instance, you can activate by 
following the Activate a plugin  instructions.

Adoption services
Adoption Services  is a suite of solutions, both products and features, that provide user support 
and critical information at the anticipated time of need. Such services include in-product help, 
modals, tours, and guides that teach users how to interact with the UI pages that they’re looking 
at in their instance.

Get started

Choose one of the tiles to get started.

Dynamic Guidance

Generates an engaging 
voice and text based, 
step by step, real-time 
guidance, dynamically, 

across platforms.

In-product help

Provide users with 
helpful, contextual 

information about what 
they can accomplish 
while they're using a 

configurable workspace 
or a specific UI page.

Onboarding modals

Create onboarding 
modals to introduce users 

to new experiences, 
products, and applications.

Guided setup Guided tours
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Use guided setup 
to go through the 

initial configuration 
of any product or 

application that provides 
a Guided Setup module.

Use guided tours to provide 
step-by-step walkthroughs 

of applications 
within your instance.

For additional getting started information, see the following Getting Started with Adoption 
Services  video.

Platform Academy Session: Getting Started with Adoption Services

Dynamic Guidance
Dynamic Guidance  is the proactive AI assistant invoked from Help Center  and Now Assist  panel 
that generates an engaging voice and text based, step by step, real-time guidance, dynamically, 
across platforms.

Dynamic Guidance  addresses the need for personalized contextual support by leveraging 
artificial intelligence to queries raised by you in natural language. Thus, it can respond 
conversationally, guiding you more effectively within the product experience. Dynamic Guidance 
uses Google  services to share real-time screen and get guidance.
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Note: 
The minimum version required is: Zurich  patch 8 and Australia  patch 2.

Why Dynamic Guidance

Dynamic Guidance  answers any ServiceNow®  related question using indexed content from the 
official ServiceNow®  product documentation and/or other configured sources. Common use 
cases include:

• Onboarding on a new module or feature for the first time

• Navigating unfamiliar workflows

• Learning configuration options and correct practices

• Getting step-by-step help mid-task without exiting the platform

• Accessibility-first guidance

• Fully voice-driven as no visual overlays are required

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1049



Admins can extend the documentation sources available to Dynamic Guidance  by configuring 
External Content Connectors (XCC) — enabling guidance from custom knowledge bases and 
internal runbooks in addition to standard ServiceNow®  product documentation.

Dynamic Guidance  transforms the in-product help experience by implementing an advanced, 
conversational help capable of delivering contextual support to users. This solution will surpass 
traditional, static, administrator-created content by utilising natural language, screen context 
awareness, and robust system integration.

Explore

Dynamic Guidance  provides an assistance that is fully embedded within the product, enabling 
users to access relevant information without navigating away from their Workflow.

Explore various features of Dynamic Guidance:

• Voice and screen share options

Note: 
User voice or screen share data is not stored. The transcript however, gets logged in the 
database.

• Responses are based on ServiceNow®  product documentation from the same family release 
as that of the instance you're on

• Front-end component to invoke Dynamic Guidance  and end a conversation

• Option for multiple users running this simultaneously

• Enabled to work across the ecosystem of ServiceNow

• Near real-time experience and minimized latency

• Browser support: In Firefox, while the entire screen or the app gets shared with screen share, 
you can choose to share only the desired tab in Google Chrome

Note: 
Screen share is not supported in Safari.

• 30 minutes of audio and screen share support

Note: 
You can cancel screen sharing anytime in the course of conversation.

• Pause and resume conversation at your pace

• Cross-tab control on pausing and ending the conversation although, the transcript can only be 
accessed from the launching tab of Dynamic Guidance

• The chat window has a floating feature which makes it visible on any other open instance 
across browser tabs. You can control the conversation from the other open instance via 
floating chat window.

How Dynamic Guidance  works

When you ask a question that requires documentation lookup:

1. User query: You ask a question via voice interface

2. Gemini decision: Gemini Live API determines if knowledge base search is needed

3. Tool call: Gemini invokes the knowledge base search tool with the query
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4. RAG API processing: RAG API Handler processes the query and searches XCC

5. XCC search: XCC searches the crawled ServiceNow Docs content

6. Results return: RAG API Handler formats and returns relevant documentation snippets

7. Response Generation: Gemini synthesizes the answer using the retrieved content

Configure

Configure Dynamic Guidance  to be available in the Help Center  and Now Assist  panel.

Before you begin
Role required: sn_dyn_guidance_admin and sn_nowassist_admin.nsa_admin

Note: 
By default, Dynamic Guidance  as a skill is active for applicable users but not accessible. 
The admin (with role sn_dyn_guidance_admin) must assign sn_dyn_guidance_user role to 
users who can access Dynamic Guidance.

Follow these steps to enable Dynamic Guidance  on Help Center  and Now Assist  panel:

Procedure

1. Log in to the relevant instance.

2. Navigate to Now Assist Admin.

3. Select Platform  > Knowledge  under Now Assist Skills.

4. Search for Dynamic guidance  and select Activate skills.

◦ Dynamic Guidance  gets enabled on Help Center.

◦ External Content Connectors(XCC) ServiceNow Docs plugin is automatically installed as a 
dependency. This ensures that the XCC infrastructure for documentation search is available.

What to do next

• Configure external content connectors to integrate with Dynamic Guidance. See External 
content connector in Dynamic Guidance.

• Link Dynamic Guidance  to additional documentation sources. See Adding custom sources.

External content connector in Dynamic Guidance

Dynamic Guidance  leverages XCC (External Content Connector) to provide intelligent, context-
aware assistance by accessing ServiceNow®  product documentation.

Dynamic Guidance  uses XCC specifically for to power its knowledge base search capabilities. 
This integration enables the system to search and retrieve relevant documentation to answer 
user queries effectively.

Architecture of XCC integration

The architecture consists of three main components working together:

• Dynamic Guidance- The user interacts with Dynamic Guidance  through a voice interface. 
When the Generative AI application  determines that it needs to search the knowledge base, it 
uses the search_knowledge_base tool.

• RAG API handler- This middleware component receives the search query from Gemini and 
processes it to retrieve relevant documentation from XCC.
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Note: 
XCC uses AI search which, is enabled by default on all customer instances. See AI 
Search .

• XCC Search (External Content Connectors ServiceNow®  Docs)- The XCC system searches the 
crawled ServiceNow®  documentation and returns relevant content to the RAG API handler, 
which then provides it to Gemini for generating accurate responses.

Adding custom sources

Extend Dynamic Guidance  knowledge base by linking your custom sources or adding additional 
sources beyond the default ServiceNow®  product documentation. This enables Dynamic 
Guidance  to provide answers based on your organization's specific documentation, knowledge 
articles, or other content repositories.

Before you begin
Role required: admin

Configure external content connectors for enabling desired custom sources. See https://
www.servicenow.com/docs/r/platform-administration/ai-search/configuring-ext-cont-
connectors.html .

Procedure

1. Navigate to All  > AI search  > Search experience  > Search profiles.

2. Follow standard search source configuration.

The process for adding sources to Dynamic Guidance  is the same as adding any search 
source to a search profile in ServiceNow®. Follow this link: https://www.servicenow.com/docs/
r/platform-administration/ai-search/link-search-source-profile-ais.html

3. Select Save  to activate.

4. Publish Dynamic Guidance  search profile record.

This capability of Dynamic Guidance  provides comprehensive assistance according to your 
organization's specific needs while maintaining the foundation of ServiceNow®  product 
documentation.

Using Dynamic Guidance

Learn how to invoke Dynamic Guidance  and use it effectively to enhance your experience.

Before you begin
Role required: sn_dyn_guidance_user

Google  must be turned on in AI control tower for Dynamic Guidance  to work.

How to use Dynamic Guidance

Procedure

1. Go to an instance you want help on.

2. Choose from Now Assist  panel or Help Center  as one of the options to launch Dynamic 
Guidance  from.

3. Follow these steps to invoke Dynamic Guidance  via Help Center:
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a. Launch Help Center  from the instance to find Dynamic Guidance  as your voice-enabled 
guide.

b. Select Start.

4. Follow these steps to invoke Dynamic Guidance  from Now Assist  panel:

a. Navigate to Now Assist  panel on your instance.

b. Select Dynamic Guidance.
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c. Invoke the help agent from Now Assist  panel via skill named 'Ask Dynamic Guidance for 
help'.

d. Select Open Dynamic Guidance.

5. Select Start  to enable.

6. Authorize the users' consent modal for screen sharing and microphone access.
This modal appears for first time users only.

7. Select Allow  to enable access to the browser tab.
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8. Allow and enable voice and screen sharing in browser tabs, when prompted.

9. Ask your question verbally to hear a conversational response real-time.

Note: 
The response will be relevant and according to the instance screen you use.

10. End the conversation when you need and provide a feedback as prompted.

11. Select Submit  to save your response.

Reference

Reference information for Dynamic Guidance

Use cases

Here are a few use cases for Dynamic Guidance.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1055



• Use case 1- "Where do I find my assigned incidents?"

Scenario: Support agents logs in and wants to quickly locate tickets they are responsible for.

Voice response: Responds with steps to navigate to "My Work" or "Assigned to me" list view in 
Agent Workspace. The assistant also offers to explain filters if needed (for example, "You can 
filter by priority or state here").

Value: Reduces time spent navigating menus and improves focus on active work.

• Use case 2- "How to give a user access to a module?"

Scenario: The admin needs to provide a user access to the Change Management  module.

Voice response: Explains the steps to assign roles to users (for example, "Navigate to User 
record > Roles tab > Add 'itil' role"). The assistant also confirms if the user would like to learn 
more about roles.

Value: Helps new or part-time admins complete access tasks confidently without searching 
docs.

In-product help
There are two kinds of in-product help to assist users understand the UI that they are using: 
Embedded Help  and Help Center.

In-product help overview

For both in-product help experiences, ServiceNow®  provides some help content out of box, and 
you can replace it or create your own custom help content based on the needs of your users.

Embedded Help  provides targeted help content to a user in a page in the classic  environment 
based on the user's role. For more information, see Embedded Help.

Embedded Help  for a Catalog task page
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The Help Center  is the next-generation Embedded Help  product for configurable workspace. 
The Help Center  provides targeted help content to users based on their role and specific to their 
location in a configurable workspace  or page built with the Next Experience UI Framework.

Help Center  will display Embedded Help  content, so you don't have to rewrite any content you 
previously created for Embedded Help. For more information, see Help Center.

Help Center  within the Service Operations Workspace

Get started

Embedded Help

Embedded Help provides 
targeted help content to a user 

in a UI page, based on their role.

Help Center

Help Center is the next-generation 
Embedded Help product for configurable 
workspaces and pages built on the Next 
Experience UI framework. Help Center 

provides targeted help content to users 
in a UI page, based on the user's role.

Workarounds

• Check out Getting Started with Help Center  on the ServiceNow Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Embedded Help

Embedded help provides targeted help content to a user in a UI page, based on their role. Some 
embedded help content comes with the base instance. Your organization can add or replace 
embedded help content.
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Embedded Help  overview

Note: 
Required: Embedded help is only available in Core UI. For configurable workspace, use 
Help Center.

The Embedded Help  plugin (com.glide.embedded_help) is active by default for all new and 
upgraded instances. Embedded help content appears in the right sidebar when the user clicks 
the help icon.  If embedded help exists for the current UI page, the help icon has an indicator 

( ).

Embedded help for the Catalog Task page

If there is no embedded help for a list or form, the sidebar displays links to the User Guide and 
the documentation site search. Select Search Documentation  to search for documentation 
about that feature.

Users with the embedded_help_admin or admin role can add help to the page. They can also 
edit custom content that appears for a page. The following image shows what the admin sees 
when there is no help article, and how to open an existing article. If you want to edit base system 
help content, follow the steps in Add custom Embedded Help from a copy.
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Embedded help administrator features in the help panel

Embedded help is displayed based on the user's role. If the content has no associated role, all 
users see it. If the role is different than admin, users with the specified role and above see the 
content. For example, content with the itil role appears for itil, itil_admin, and admin.

Get started

Explore

Learn about the 
features and benefits 

of Embedded Help

.

Configure

Configure the 
Embedded Help

content in your instance.

Reference

Review system 
properties and domain 
separation information.

Workarounds

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Embedded Help

Embedded help provides targeted help content to a user in a UI page, based on their role. Some 
embedded help content comes with the base instance. Your organization can add or replace 
embedded help content.

Embedded Help  overview

Embedded Help  enables you to provide the help that your users need, as well as benefit from 
help topics available in the base system. You can add new embedded help content or replace 
content. Replacing content involves deactivating the existing topic and adding a topic.
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Your organization may want to add or replace Embedded Help  content for some of the following 
reasons:

• To provide help for custom applications.

• To provide more specific instructions or embedded videos to describe your business process.

• To provide embedded help content where none exists for a page.

• To provide embedded help content in languages other than English (default).

• To provide different content for different roles.

The UI page name identifies embedded help content. To find the page name, 
look for the table name in the URL for that view. For example, the page name for 
the list view of Assessment Metric Types is asmt_metric_type_list and is found 
in this address: instancename.service-now.com/nav_to.do?uri=
%2Fasmt_metric_type_list.do%3Fsysparm_userpref_module%. The page name 
for the form view is asmt_metric_type.

You cannot edit the content in a base system  topic. In base system topics, the read-only 
ServiceNow Help  check box is selected.  If you edit the content and try to save changes, you see 
an error message. To change the information that appears in a base system  topic, make a copy 
of the topic, which clears the ServiceNow Help  check box. Modify the topic with your content 
and save it. Customized content takes precedent over ServiceNow help content and is displayed 
when a user opens help for that UI page.

Starting this release, Embedded Help  also supports non-English content import without 
overriding the last uploaded language content.

Embedded Help  workflow

The ServiceNow  datacenter contains the Content Delivery Network (CDN) where 
embedded help content is stored. Topics in the local (instance) Embedded Help  content 
[sys_embedded_help_content] table are populated from the CDN. Help content in the CDN is 
refreshed every 30 days.

When a user accesses a UI page, the embedded help process displays a custom topic if one 
exists for the user's role. If there is no custom topic, the following steps are performed.

1. Checks the browser cache first, and displays the content if found in the cache. It then checks 
the Embedded Help  content [sys_embedded_help_content] table for the corresponding 
embedded help topic with the role and qualifier, if applicable.

◦ If a topic is found, it checks the date in the Last sync  field. If the date is 15 or more days old, 
it places a request in the Embedded Help  Queue [sys_embedded_help_queue] table with 
the last sync date and the resource ID.

◦ If a topic is not found, it places a request in the Embedded Help  Queue 
[sys_embedded_help_queue] table with the current date and the resource ID.

2. Within a minute of the page being viewed, the system processes the request and checks the 
CDN. In the first case, it checks whether the topic was updated since the Last sync  date. In 
either case, after a minute, refresh the page to see the content.

◦ If the topic was updated, it pulls the updated topic into the table and updates the Last sync 
date.

◦ If the topic was not updated, it displays the local cached or database topic, and updates the 
Last sync  date.

3. If the topic was not in the local database, it pulls the topic into the table if it exists on the CDN. 
If it does not exist, there is no action.
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The administrator can modify the default 15-day synchronization duration in system properties.

Configure Embedded Help

Plan and configure the Embedded Help  topics that your organization's users would benefit from.

Configuration overview
You should begin your Embedded Help  configuration by planning, including identifying features, 
forms, and lists that your users could use additional guidance on. Then, begin to map and create 
or update the topics you will create.

Embedded Help  planning

Before writing custom embedded help, plan the content and note the information used in the 
Embedded Help  form. Careful planning ensures that the topic appears for the correct page and 
role.

Each UI page can display embedded help, specified in the Page  field as shown in the following 
example.

Embedded Help  topic for the Service Catalog  home page

In planning for embedded help topics, consider how the following fields are used and note the 
values that you need for your custom topics.

Page

Identify and note the UI page name which is found in the URL when the page 
is displayed as shown. If the page name begins with a dollar sign, such as 
$mid_server_user, include the dollar sign in the page name. Before you write an 
embedded help topic for the page, search for the page name to locate a file you can 
copy.

Modifier

• Normal  content appears for any user with the appropriate role who navigates to 
the page.

• Setup  content appears when the page is accessed from a link in Guided Setup.
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Many embedded help topics in the base system  are for Guided Setup. You can copy 
Setup  content and change the Modifier  to Normal  to quickly provide help for all 
users.

Qualifier

Identify pages you want custom help for that are used in many applications.  For 
example the home.do  page opens for every homepage module and for many 
dashboard modules. The embedded help administrator can use qualifiers to 
customize content for a common page in the instance.

Role

Specify the lowest level role to provide access to this embedded help topic. All roles 
that contain the role also see the content, unless another topic targeted to their role 
exists for the same page.

For example, if you add embedded help content for the itil role that describes your 
business process for entering incidents, the itil_admin role also sees the content. 
If you write a different topic with the itil_admin role, the itil_admin sees that content 
instead of the itil content.

Product

Write content only for the Enterprise  topic. You can copy an Express  topic and 
change this field to Enterprise  if appropriate.

Version

Base system content is typically specified to the current software version. If you are 
editing the content for a custom application or to provide information relevant to 
your organization business process, select All.

Domain

If your organization uses domain separation and customizes help content, specify 
the domain the content applies to.

ServiceNow  Help

If the check box is selected, this field indicates a base system  topic. You cannot edit 
a base system  topic, but you can create a copy to add custom content.

Content

You can use the formatting tools to format the content. The following list describes 
the limitations.

• You cannot include images in embedded help content.

• To embed video, you must code the video information in the source code <<>> 
view. Video content from YouTube and Vimeo are supported.

• To add a related information link, you must use a full URL, not a relative URL.

• Best practice is not to use the highlight text tool, as the color may make text 
unreadable depending on the theme the user has selected.

• Any changes you make to embedded help are not automatically deployed to 
another instance.

• Changes to the embedded help table are not captured in update sets, 
update_sync=false is set intentionally.

Use qualifiers in Embedded Help

The embedded help administrator can use qualifiers to customize content for a common page in 
the instance.
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Before you begin
Role required: embedded_help_admin

About this task
Imagine that your organization wants to provide specific instructions for the SLA homepage. You 
can write custom embedded help content and use a qualifier to accomplish that goal. Create the 
qualifier, and then associate it with custom embedded help content that you write.

Procedure

1. The home.do  page is opened for every Homepage module and for many Dashboard modules. 
The specified query parameters in the URL define which homepage to open.

2. To get the information for the qualifier, open the module in a new browser window and copy the 
query parameter.

Notice that the query parameter uses underscores between words instead of hyphens or 
dashes.

You can also select the query parameter from the Arguments  field on the module link type. To 
see the module link type, select the pencil icon beside the module in the application navigator, 
and then select the Link Type  tab.

3. Navigate to Embedded Help  > Help Qualifiers, and then select New.

4. Complete the form.

Embedded Help  qualifier form

Field Description

Path Enter the page to display the embedded help content. Do not include .do. For 
example, for the SLA homepage, enter home.

Query 
params Enter the query parameters or the link argument using the format 

id=query_parameters.

Warning: 
If the query parameter contains more than one word, use underscores 
between words instead of hyphens or dashes. If you use hyphens or 
dashes, the system uses only the first word in the parameter and ignores the 
rest.
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Field Description

Fragment Enter the ➚<string>  at the end of the URL.

This is rarely found in the URL of a page in the instance. If you want custom help 
for a page that ends with ➚<string>, place it into this field.

Note: 
The proven practice is to include at least a query parameter. If you do not, 
the custom help appears for every home.do  page. You can use either the 
query parameter, the fragment, or both.

Qualifier
Enter the qualifier to use, for example sla_homepage. Record the qualifier to 
use in the embedded help content record.

Warning: 
If the query parameter contains more than one word, use underscores 
between words instead of hyphens or dashes. If you use hyphens or 
dashes, the system uses only the first word in the parameter and ignores the 
rest.

5. Select Submit.

6. Follow the steps in Add custom Embedded Help content  to create the content, and include the 
following information.

◦ Name  and Page: The page you created the qualifier for, for example, home.

◦ Qualifier: The qualifier you entered, for example sla_homepage.

Note: 
You can also copy an existing Embedded Help  topic and enter the qualifier in the copied 
record.

7. Test the qualifier by opening the page you added the content for, and then opening the help 
panel.

Note: 
If you added a role to the Embedded Help  content, log in as a user with the role, or 
impersonate a user with that role.

Embedded Help  roles

Embedded help content can be targeted to users with a specified role who access the UI page. 
All roles that contain the role also see the content, unless another topic targeted to their role 
exists for the same page.

For example, if you add embedded help content for the itil role that describes your business 
process for entering incidents, the itil_admin role also sees the content. If you write a different 
topic with the itil_admin role, the itil_admin sees that content instead of the itil content.

Embedded Help  role priority

The embedded help role priority is stored in the Embedded Help Role Priority 
[sys_embedded_help_role] table. Each role is assigned a default priority order number based on 
the role name in the Roles [sys_user_role] table.
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Default embedded help priority order numbers

Order 
number

Role name

10 admin

Examples: admin, chat_admin, pa_admin, survey_admin

Exception: itil_admin

100 manager or itil_admin

Examples: itil_admin, catalog_manager, content_manager, sla_manager

300 itil (only)

1000 All other roles or no role (ESS user)

Examples: approver_user, financial_management_user, personalize_form, 
template_editor

The priority executes from the lowest number to the highest, meaning that embedded help 
content with no role displays only if no other content is available for the UI page and the 
user's role. All base-system  content is targeted to a role unless the content is intended for all 
users, including ESS users. When you add a role, such as a role for a custom application, it is 
automatically added to the Embedded Help Role Priority [sys_embedded_help_role] table with 
the appropriate default order.  You can modify the order of priority as needed.

If a page requires different help content for different roles, separate topics must be added. For 
example, users with any role can access the incident.do  page, and it opens with a view 
appropriate for their role.

The following list describes how content for different roles can be targeted for the incident form.

Admin

Provides information and links to help with configuring the incident form.

itil_admin

Describes how to monitor the progress of the incident.

itil

Describes how to work on an incident.

No role

Explains what the user can review and modify in the Self-Service view of the 
incident form.

Modify embedded help role priority

You can modify the default order of priority that is assigned to a role in the Embedded Help  role 
priority [sys_embedded_help_role] table. The priority order determines what Embedded Help 
content a user accesses on a UI page, based on roles assigned to the user.

Before you begin
Role required: embedded_help_admin or admin

About this task
When you add a role, such as a role for a custom application, it is automatically added to the 
Embedded Help Role Priority [sys_embedded_help_role] table with the appropriate default order. 
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You can modify the role priority, including adding priority numbers between the default priority 
numbers, if appropriate.

Procedure

1. Navigate to All  > Embedded Help  > Role Priority  and locate the role to modify the priority.

2. Select the value in the Order  column to open the list editor.

3. Enter the new priority order number and select the green check mark to save it.

Embedded Help  internationalization

Embedded Help  internationalization provides the ability for you to localize your embedded help 
content to a variety of languages to meet global user needs. You can write your embedded help 
content in a language of your choice and decide what languages to display.

Existing embedded help content records are written in English by default. You can translate the 
English embedded help content provided with the base system  into other languages to meet 
your needs. You can also create custom embedded help content in the language of your choice.

Localized Embedded Help  content

To translate English Embedded Help  content into another language or to create embedded 
help content in a language other than English, your working session must be configured to the 
language in which you want to write. For example, you must be working in a French session if 
you want to write embedded help content in French. Refer to Localization settings  for more 
information.

Configure embedded help content to display in the language of your choice by accessing the 
Language  field on the Embedded Help  Queue [sys_embedded_help_queue] table. Depending 
on the foreign language translations activated on your instance, you can choose which language 
to display your embedded help content.

If embedded help content is available in a particular language and users are working in an 
instance with that language, they will see available embedded help in the desired language.

Working with localized embedded help content

When a user requests an embedded help content record, the associated embedded help queue 
record populates accordingly and the language specified in the embedded help queue record is 
set to the current session language.

When embedded help content is available in a user's session language, content will be shown 
in that same language. If embedded help content is not available in the user's session language, 
than English content is shown. However, if you do not want to see English content in a non-
English session, you can configure the sys_property to False (default is True).

Embedded Help  content prioritization

Displaying Embedded Help  content in the user's session language takes priority over all other 
mechanisms, such as role, whether content is user-created, and the latest content version.

When a user is in a non-English working session, the priority for embedded help content display 
is as follows:
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1. Working-session language (other than English) content displays, if available.

2. User-created content displays when working-session language content is not available.

3. Version-related content displays when working-session language and user-created content are 
not available.

For example, if an admin user is in a French working session and requests embedded help 
content, but French content is not available for the admin role, the same-language content for a 
lower role is displayed if available.

If there is no embedded help content for the French admin role, but there is content for the 
French itil role and English admin role, the French itil role takes priority over the English admin 
role. The French-language content will display at the itil-role level.

Create internationalized embedded help

Translate provided English Embedded Help  content into other languages or create custom 
Embedded Help  content in the language of your choice.

Before you begin
Role required: embedded_help_admin or admin

About this task
All embedded help content records are in English by default. To create a non-English Embedded 
Help  content record, there must first be an English content record in the Embedded Help 
[sys_embedded_help_content] table. The English Embedded Help  content record is parent to 
all other language Embedded Help  content records. Once you create a non-English Embedded 
Help  content record, it resides in the Translated Texts [sys_translated_text] table.

To translate provided English content into another language, create a copy of the English content 
record and save the edited, non-English, copy record. The new record is saved to the Translated 
Texts [sys_translated_text] table. Refer to Add custom embedded help from a copy  to translate 
available embedded help content.

To create a non-English custom embedded help content record, your working instance must 
be configured to the same language you intend to write in. You create custom non-English 
Embedded Help  content when English embedded help content is not available to copy.

After creating a non-English Embedded Help  content record, you must create the same content 
record in English and store it in the Embedded Help  [sys_embedded_help_content] table. The 
English Embedded Help  content record is parent to all other languages.

Procedure

1. Navigate to All  > Embedded Help  > Help Content.

2. Open the Embedded Help  topic to copy.
You can also open an Embedded Help  topic by selecting Edit Help Article  from the menu in 
the Embedded Help  pane.

3. Update the fields as appropriate.

Field Description

Name The Embedded Help  topic name.

Page The UI page this topic corresponds to. Typically, you do not change the page name.
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Field Description

Modifier ◦ Normal  content appears for any user with the appropriate role who navigates to 
the page.

◦ Setup  content appears when the page is accessed from a link in Guided Setup.

Role The role that the topic is written to assist. Users assigned to the role see the 
content when they navigate to the associated UI page.

All roles that contain the role also see the content, unless another topic targeted to 
their role exists for the same page.  For more information, see Embedded Help roles

Active Specifies whether this content displays for the UI page. Clear the check box to hide 
the content from being available.

Product Enterprise  is the default, and should not be changed.

Qualifier The qualifier that provides custom Embedded Help  for a common UI page.

For example, the home.do  page is opened for every Homepage module and 
for many Dashboard modules. Create the qualifier before you enter it into this 
Embedded Help  record.

Version The version this topic is appropriate for. If you are editing the content for a custom 
application or to provide information relevant to your organization business 
process, select All.

Last 
sync

The last date and time that the CDN was checked for updated content. When a 
user accesses this UI page, the platform determines whether the last sync date 
and time are more than 15 days ago. If it is, the CDN is checked for updated content 
and the date is refreshed.

Note: 
The administrator can change the last sync duration in system properties.

Order The order defaults based on the role, and determines what content to display 
when the user has an assigned role. For more information, see Embedded Help 
roles.

Domain Specify the domain this content is used for, if applicable.

This field appears in the form if the administrator configured the form to display it.

4. In the Content  field, update the text using the HTML formatting tools as needed.
If you add a link, enter the full URL to the web page. A good practice is to select New window 
(_blank)  as the Target.

Note: 
Do not add images in an embedded help topic. Images are removed from the content 
section when the record is saved.

To add an embedded video, see Embed video content in help topics.

5. Optional:  To add another line below tables, videos, or related links, click the newline icon (⏎).

6. Select Copy  in the form header.
The edited topic is saved and the list displays again. The ServiceNow Help  check box is 
cleared in the saved topic.
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Add custom Embedded Help  from a copy

To customize embedded help for your organization, you can edit a topic in the base system and 
save it as a copy.

Before you begin
Role required: embedded_help_admin or admin

About this task
In base system topics, the read-only ServiceNow Help  check box is selected.  When you create a 
copy, the ServiceNow Help  check box is cleared, allowing you to modify the content.

When a user navigates to a UI page for which custom content exists, the custom content displays 
instead of the base system  content.

Note: 
Embedded Help  records are also used to create content for the Help Center  within 
a configurable workspace. For more information, see Create Help Center content for 
configurable workspace.

Procedure

1. Navigate to All  > Embedded Help  > Help Content.

2. Open the Embedded Help  topic to copy.
You can also open an Embedded Help  topic by selecting Edit Help Article  from the menu in 
the Embedded Help  pane.

3. Update the fields as appropriate.

Field Description

Name The Embedded Help  topic name.

Page The UI page this topic corresponds to. Typically, you do not change the page name.

Note: 
If you are using the Embedded Help  record to display in the Help Center, 
as described in Create Help Center content for configurable workspace, 
enter the same value in the Name  and Page  fields, replacing spaces with 
underscores in the page field.

Mode ◦ Normal  content appears for any user with the appropriate role who navigates to 
the page.

◦ Setup  content appears when the page is accessed from a link in Guided Setup.

Role The role that the topic is written to assist. Users assigned to the role see the 
content when they navigate to the associated UI page.

All roles that contain the role also see the content, unless another topic targeted to 
their role exists for the same page.  For more information, see Embedded Help roles

Active Specifies whether this content displays for the UI page. Clear the check box to hide 
the content from being available.

Product Enterprise  is the default, and should not be changed.

Qualifier The qualifier that provides custom embedded help for a common UI page.
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Field Description

For example, the home.do  page is opened for every Homepage module and 
for many Dashboard modules. Create the qualifier before you enter it into this 
embedded help record.

Version The version this topic is appropriate for. If you are editing the content for a custom 
application or to provide information relevant to your organization business 
process, select All.

Last 
sync

The last date and time that the CDN was checked for updated content. When a 
user accesses this UI page, the platform determines whether the last sync date 
and time are more than 15 days ago. If it is, the CDN is checked for updated content 
and the date is refreshed.

Note: 
The administrator can change the last sync duration in system properties.

Order The order defaults based on the role, and determines what content to display 
when the user has an assigned role. For more information, see Embedded Help 
roles.

Domain Specify the domain this content is used for, if applicable.

This field appears in the form if the administrator configured the form to display it.

4. In the Content  field, update the text using the HTML formatting tools as needed.
If you add a link, enter the full URL to the web page. A good practice is to select New window 
(_blank)  as the Target.

Note: 
Do not add images in an embedded help topic. Images are removed from the content 
section when the record is saved.

To add an embedded video, see Embed video content in help topics.

5. Optional:  To add another line below tables, videos, or related links, click the newline icon (⏎).

6. Select Copy  in the form header.
The edited topic is saved and the list displays again. The ServiceNow Help  check box is 
cleared in the saved topic.

Add custom Embedded Help  content

You can add a custom Embedded Help  topic, for example, if you have a custom application and 
you want to provide help to users.

Before you begin
Role required: embedded_help_admin or admin

About this task
When you write content for your users, keep the following limitations in mind.

• You cannot include images in embedded help content.

• To embed video, you must code the video information in the source code <<>> view. Video 
content from YouTube and Vimeo are supported.

• To add a related information link, you must use a full URL, not a relative URL.
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• Best practice is not to use the highlight text tool, as the color may make text unreadable 
depending on the theme the user has selected.

• Any changes you make to embedded help are not automatically deployed to another instance.

• Changes to the embedded help table are not captured in update sets, update_sync=false is 
set intentionally.

Note: 
Embedded help records are also used to create content for the Help Center  within a 
configurable workspace. For more information, see Create Help Center content for 
configurable workspace.

Procedure

1. Navigate to All  > Embedded Help  > Help Content.

2. Select New.

3. Complete the form.

Field Description

Name Enter the Embedded Help  topic name. A typical name is the title of the page to 
which it applies.

Page Enter the UI page this content provides help for, without the .do file extension.

Note: 
If you're using the embedded help record to display in the Help Center, 
as described in Create Help Center content for configurable workspace, 
enter the same value in the Name  and Page  fields, replacing spaces with 
underscores in the Page  field.

Modifier Select the modifier, typically Normal.

◦ Normal  content appears for any user with the appropriate role who navigates to 
the page.

◦ Setup  content appears when the page is accessed from a link in Guided Setup.

Role Select the role that the topic is written for.

All roles that contain the role also see the content, unless another topic targeted to 
their role exists for the same page.  For more information, see Embedded Help roles

Active Select the check box to make this content appear. Clear the check box to hide the 
content from being available, for example, to have someone review it before it is 
accessed on the UI page.

Product Enterprise  is the default, and should not be changed.

Qualifier The qualifier that provides custom embedded help for a common UI page.

For example, the home.do  page is opened for every Homepage module and 
for many Dashboard modules. Create the qualifier before you enter it into this 
embedded help record.
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Field Description

Note: 
Dynamic IDs are supported in Embedded Help  Qualifier route parameters. 
For example, adding $dynamic_value$  in the fragment field makes your 
content available for the same URL, even when the value changes. This can 
happen when selecting different languages for the same page.

Version Select a version, if different from the current version of your instance. To provide 
content for a custom application or information relevant to your organization 
business process, select All.

Order Change the default role, if needed. The order defaults based on the selected role. 
For more information about default order priority numbers, see Embedded Help 
roles.

Domain Specify the domain this content is used for, if applicable.

This field appears in the form if the administrator configured the form to display it.

4. In the Content  field, enter the text using the HTML formatting tools as needed.
If you add a link, enter the full URL to the web page. A good practice is to select New window 
(_blank)  as the Target.

Note: 
Do not add images in an embedded help topic. Images are removed from the content 
section when the record is saved.

To add an embedded video, see Embed video content in help topics.

5. Optional:  To add another line below tables, videos, or related links, select the newline icon 
(⏎).

6. Select Submit.

Embed video content in help topics

You can embed a link to video content in a custom Embedded Help  topic. YouTube and Vimeo 
video content is supported.

Before you begin
Role required: embedded_help_admin or admin

About this task
You cannot use the insert/edit video icon in the HTML editor to embed the video. You must enter 
the source code.

HTML editor icons

The administrator can disable the ability for users to see embedded video in the Embedded Help 
system properties.
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Procedure

1. Complete the following steps to obtain the embed code for the video.

a. Navigate to the location of the video on YouTube or Vimeo.

b. Open the Share  option for the video.
In YouTube, the text appears below the video. In Vimeo, select the share icon beside the 
video.

c. Under Embed, select the code and paste it into a text editor.

d. Modify the code to enclose it in a <div> and remove elements that do not get rendered in the 
embedded help content page.

Example 
For example, here is the embed code for a YouTube video. The modified code also contains a 
title for the embedded video enclosed in a <p> tag.

<iframe width="560" height="315" 
 src="https://www.youtube.com/embed/bqh-5yew2yQ"
frameborder="0" allowfullscreen></iframe>

After modification, the code looks like this.

<div class="video"><iframe 
 src="https://www.youtube.com/embed/bqh-5yew2yQ"
allowfullscreen=""></iframe>
<p class="p">Video: Work at Now</p>
</div>

Vimeo embed code has more attributes. Strip them out so it looks like the following example. 
Notice the difference between YouTube and Vimeo for the allowfullscreeen  attribute.

<div class="video"><iframe 
 src="https://player.vimeo.com/video/67392563" 
 frameborder="0"
allowfullscreen></iframe>
<p class="p">Video: Work at Now</p>
</div>

Note: 
As shown in the examples, enclose the <iframe>  and the <p>  tags within a <div 
class="video">  tag. If the administrator disables the property to display video 
content, all content within the <div class="video">  tag are hidden.

2. Navigate to Embedded Help  > Help Content, and then open the custom help topic to embed a 
video.

3. Select the source code icon (<>).

4. Position your cursor at the end of the line above the location of the video.

5. Press the Enter key to move to a blank line enter the embed code you modified.
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6. Select OK, and then select Update.

7. To test that the video appears, open the page that displays the content you just updated, and 
then open the help panel.

Embedded Help  reference

Reference topics provide information about system properties, configure, and basic information 
about domain separation.

Embedded Help  system properties

Embedded help is active by default on your instance. The administrator can change system 
properties to modify how the instance interacts with embedded help.

The administrator navigates to Embedded Help  > Properties  to change these properties.

Embedded help system properties

Name Description

com.glide.embedded_help.auto_close Auto-closes the help pane when the user clicks 
Start a Tour  or Back To Guided Setup.

• Type: true | false

• Default value: true

com.glide.embedded_help.cdn_timeout Duration in milliseconds at which a content pull 
from the Content Delivery Network (CDN) is 
timed out.

• Type: integer

• Default value: 2000

com.glide.embedded_help.enabled Enables the embedded help plugin for 
activation.

• Type: true | false

• Default value: true

com.glide.embedded_help.enable_video Enables users to see embedded videos in help 
content. The administrator can embed video 
and a description, but if this property is false, 
the video and description are hidden in the help 
pane.

• Type: true | false

• Default value: true
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Embedded help system properties  (continued)

Name Description

Note: 
When you embed video content, enclose 
the video embed code and description 
inside a <div class="video">  tag. 
If you disable the property, the content 
inside the <div class="video">  tag 
is hidden when the content is displayed.

com.glide.embedded_help.sync Enables the instance to look in the CDN for 
updated content when a user accesses a UI 
page. The instance checks the Last sync  date 
in the topic against the specified frequency 
to determine whether to look in the CDN for 
updated content.

• Type: true | false

• Default value: true

If the property is disabled (false), the embedded 
help content is never synced with CDN topic 
updates.

com.glide.embedded_help.sync_frequency Specifies how many days must pass from the 
Last sync  date in the topic for the embedded 
help process to look for updated content in the 
CDN.

• Type: integer

• Default value: 15

com.glide.embedded_help.sync_self_hosted Specifies whether a self-hosted instance syncs 
content with the CDN.

• Type: true | false

• Default value: false

com.glide.embedded_help.url Lists the location from where embedded help is 
dynamically retrieved.

• Type: string

• Default value: varies

com.glide.embedded_help.version Specifies the instance version for which help is 
displayed.

• Type: string

• Default value: Jakarta

If blank, displays the help for the version the 
instance is currently running.
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The following system property is available by navigating to the [sys_properties] table.

Name Description

com.glide.embedded_help.guided_setup.persist_actions Enables Guided Setup actions in 
the embedded help panel that are 
based on states to display on all 
pages. An example is the Mark 
as Complete  action. The default 
behavior (false) is to only show 
actions on the initial Guided Setup 
page.

• Type: true | false

• Default value: false

Domain separation and Embedded Help

Domain separation is supported for Embedded Help. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Domain separation overview

The goal of Embedded Help  is to enable your users to benefit from base system  help topics, as 
well as to create your own custom help topics. If your organization uses domain separation, you 
can create custom embedded help for each domain.

How domain separation works in Embedded Help

If your organization uses domain separation, you can create custom embedded help for each 
domain. To associate help content with a domain, the administrator configures the help content 
form to include the Domain  field. When custom content is created, the author selects the domain 
to which the content applies.
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Note: 

• Content with no specified domain is in the global domain.

• If domain-specific content does not exist for a user in a domain, the user sees the global 
help content.

• Users in the global domain only see global help content. An administrator who wants to 
test domain-specific help must impersonate a user in that domain.

Related topics

Domain separation for service providers

Help Center

Help Center  is the next-generation Embedded Help  product for configurable workspace. Help 
Center  provides targeted help content to users in a UI page, based on the user's role.

Note: 
Help Center  is a ServiceNow AI Platform  feature that is active by default.

Get started

Exploring Help Center
Using Help Center

Workarounds

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Help Center

Help Center  provides users with the information they need, and tells users what they can 
accomplish while they're using a configurable workspace. Help Center  content appears in the 
right sidebar when the user selects the help icon.

Help Center  overview

Help Center  provides users with the information they need, and tells users what they can 
accomplish while they're using a configurable workspace. Help Center  content appears on 
sidebar when the user selects the help icon. If Help Center  content exists for the current UI page, 
then the help icon has an indicator. Multiple help topics for the same page are available in Help 
Center.

Starting this release, Help Center  panel has additional adoption features:
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• Attachable and detachable from the help header

• Draggable and resizeable when detached from the help header

• Draggable and resizeable using keyboard to support accessibility

Help Center  Icon View

If there is no help content available for the current page, then the help icon will not display the 
indicator. If the user selects the help icon, the Help Center  displays a message that there is no 
help content and provides a link to browse product documentation instead.

You can add new content to the Help Center  with the add new content link, described in Create 
Help Center content for configurable workspace.
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No Help content available view

AI Search  within App Engine  Help Panel

AI Search  extends support to search within Help Panel for knowledge articles and embedded 
help documents. Only relevant content to the user will be displayed based on their role.

Note: 
This feature is dependent on the AI Search  Plugin. AI Search  is a ServiceNow AI Platform 
feature that is active by default.

App Engine Studio Help Panel AI Search

Note: 
The search results will be from knowledge tables and embedded help tables. Results are 
based on context that are relevant to the users.

For more information about AI Search  see AI Search .
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Using Help Center

Use Help Center  to create help content to provide users with helpful information about the page 
they are working on within a workspace. Help Center  content appears on the sidebar when the 
user selects the help icon

Create Help Centercontent

To create Help Center  content, you will create or modify two record types: guidance records and 
embedded help records. The guidance record enables your content, which is in an embedded 
help record, to display in the Help Center. This procedure explains how to enable displaying 
existing embedded help content in the Help Center. For more information see Create Help 
Center content for configurable workspace.

Provide feedback to ServiceNow®

The Help Center  menu includes an option you can use to provide your feedback to ServiceNow® 

about your experience with the current product. All feedback is reviewed and may be used to 
improve the product. For more information see Provide feedback to ServiceNow.

Create Help Center  content for configurable workspace

Create Help Center  content to provide your users with helpful information about the page that 
they are working on within a configurable workspace.

Before you begin
Create or edit an embedded help record before creating a guidance record by following the 
steps in Add custom Embedded Help content  to create content or Add custom Embedded Help 
from a copy  to modify existing content.

Role required: admin

About this task
To create Help Center  content, you will create or modify two record types: guidance records and 
embedded help records. The guidance record enables your content, which is in an Embedded 
Help  record, to display in the Help Center. This procedure explains how to enable displaying 
existing embedded help content in the Help Center.

Procedure

1. Navigate to the configurable workspace  page for which you are creating Help Center  guidance.

2. Copy or otherwise take note of the page URL, such as <instance name>.service-
now.com/now/sow/home.

3. Select the Show help  icon ( ) in the Unified Navigation  menu to expand the Help Center.

4. Scroll to the bottom of the Help Center  and select Add New Content.
A new tab with the Guidance form displays.

5. Fill in the fields on the Guidance form.

Guidance form

Field Description

Name The title of your guidance, which displays in 
the Help Center.

Type Select Embedded Help.

Roles The user roles required to see your guidance.
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Field Description

Note: 
Help content that is only relevant to your 
chosen role is supported. For example, 
users with the ITIL role will only see help 
created for the ITIL role, previously all 
help was displayed for all roles.

Application route
Part of the URL for the workspace page 
that you're targeting, in the format now/
<yourpagename>.

Refer to the URL you noted earlier and enter 
this portion of the URL, for example now/
sow.

See the examples  following these steps 
for more information on identifying the 
application route from the URL.

To target all workspace pages use 
sn_allfor the application route and context 
fields.

Embedded help content The content of your guidance, which is 
displayed to users in the Help Center. Select 
an existing embedded help record, or create 
an embedded help record as described in 
Add custom Embedded Help content.

Context
A value found in the URL of the workspace 
page you're targeting that immediately 
follows the Application Route. For example, in 
now/sow/home, the context is home.

Refer to the URL you noted earlier and 
provide only the word immediately following 
the value entered in the Application Route 
field. Values depend on the workspace and 
may also include list  and record.

See the examples  following these steps for 
more information on identifying the context 
from the URL.

To target help content on all pages in a 
particular workspace use the appropriate 
workspace application route, and enter 
sn_all  for the context field.

Description The description of your guidance, which 
displays in the Help Center  as a short 
description under the title provided in the 
Name field.
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Field Description

Route parameters
An advanced configuration to display 
guidance only when users view specific lists 
or record types within your workspace.

To provide guidance when a user 
is viewing a specific list, review the 
URL you noted earlier and look for 
the list id number, such as list-
id/d03d64feebd1301080de83402a5228f1. 
Then, enter route parameters in the 
following format: {"params":
{"listId":"d03d64feebd1301080de83402a5228f1"}}.

To provide guidance when a user is viewing 
a specific record type, review the URL you 
noted earlier and look for the record name, 
such as record/problem. Then, enter 
route parameters in the following format: 
{"params":{"table":"problem"}}.

To provide guidance when a user is viewing a 
related record (a record accessed from within 
another record), look for the second record 
name in the URL, such as sub/record/
incident. Then, enter route parameters 
in the following format: {"params":
{"table":"incident"}}.

See the examples  following these steps 
for more information on identifying route 
parameters from the URL.

Application The scope of your application.

Status The status of your guidance. Select 
Published  when the guidance is ready to 
display in the Help Center.

Active Indicates that the guidance is active. Keep 
this option checked when the guidance is 
published.

ServiceNow®  created Indicates that the guidance was created by 
ServiceNow®. Reserved for ServiceNow®  use 
only.

Version The current family release version for your 
guidance.

6. Select Submit.

Example: Creating guidance for a list in a configurable workspace

To provide guidance when a user is viewing a specific list, review the URL and look for 
the list id number, such as list-id/7ae4da1ec3013010965e070e9140dd66. 
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Then, enter route parameters in the following format: {"params":
{"listId":"7ae4da1ec3013010965e070e9140dd66"}}.

Route parameters for list

Example: Creating guidance for a record in a configurable workspace

To provide guidance when a user is viewing a specific record type, review the URL and look for 
the record name, such as record/problem. Then, enter route parameters in the following 
format: {"params":{"table":"problem"}}.

Route parameters record type

Example: Creating guidance for a related record in a configurable workspace

To provide guidance when a user is viewing a related record (a record accessed from 
within another record), look for the second record name in the URL, such as sub/
record/incident. Then, enter route parameters in the following format: {"params":
{"table":"incident"}}.
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Route parameters related record

Help Center  content thumbs up and down feedback

Help Center  content includes a thumb up or thumbs down feedback option for each Help center 
article in your instance.

Help Center  content feedback

When viewing Help Center  content, after an article is selected, a thumb up or thumbs down 
feedback option is included for each Help center article in your instance. A feedback helps to 
notify whether the article is helpful or if improvements can be made.
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Feedback analytics

To view the feedback analytics, navigate to All  > User Experience Analytics  > Dashboard.

In the example provided, Service Operations Workspace is selected, and in the left-hand 
navigation Analytics  > Events  are selected. The events page displays a list of events within the 
workspace, and the number of occurrences for each event.

In this example, after selecting the Thumbs up  event, the thumbs up dashboard displays to 
show.

• Occurrences

• Page name

• Page Id

• Pathname

• Sys_Id

• Topic Id

• Version
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Provide feedback to ServiceNow®

The Help Center  menu includes an option you can use to provide your feedback to ServiceNow 
about your experience with the current product. All feedback is reviewed and may be used to 
improve the product.

Before you begin
Role required: none

Procedure

1. Open the Help Center  by selecting the Help Center  icon .

2. Scroll to the bottom of the Help Center  menu and select Provide feedback.

3. Rate your experience and provide as much or as little detail in the entry boxes as you want.
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Your feedback is important to us and we appreciate all comments, both positive and negative.

4. When you have completed your feedback, select Submit.

Note: 
If you do not want the Provide Feedback  button to appear in the Help Center, you can 
disable it.

Disable feedback

You can disable the feedback providing mechanism by creating a system property and disabling 
it.

Before you begin
Role required: admin

Procedure

1. In the unified navigation, type sys_properties.list and press Enter.

2. Select New.

3. In the Name  field, type glide.ui.product_feedback_enabled.

4. In the Type  field, select .
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5. In the Value  field, select false.

6. Save the system property.

What's New

The What's New  tab in the Help Center  displays information about the new and important 
features for applications in your instance, including features from the latest ServiceNow® 

release(s).

The What's New  tab is a great way to learn about features, which are existing features and of 
what will be available to you on version upgrade (if not on the latest versions), without having to 
rely on the documentation site. The content in the What's New  tab is relevant to each application 
the tab is accessed from and the role of the user accessing the content.
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Note: 
Starting with this release, you can navigate to What's New  in Help Center  across all 
experiences. Configuration support for this new feature is available in classic  and custom 
pages. This feature is however, not supported for non-Polaris users.

If there is new content available for you, the Help Center  button is indicated. The blue indicator 
next to a feature notifies that the feature content is new and unread for the application and the 
user on your instance.

You can select a feature from the tab to access the feature page for more information including 
video demos and graphics if available. A view all features option is included at the bottom.

The feature page displays information on all new features for the application. Features are 
tagged to notify you of their availability state. In this example, configure the Catalog Builder 
experience for catalog item editors, is a feature that is not available. This could be either due 
to an upgrade requirement, or due to the required plugins for the feature not being installed on 
the instance. For most features, links are provided to expand information or to navigate to the 
documentation site.

Guided Setup
Guided Setup  is the product support that organizes configuration activities into categories. Use 
Guided Setup  to step through the initial configuration of any product or application that provides 
a Guided Setup  module.

Guided Setup  organizes configuration activities into categories. Each category provides 
information, such as planning guidance, pre-setup steps, and links to useful help content. 
Categories also provide a set of links to the pages in your instance where you perform the 
configuration.

Guided Setup  home page

The Guided Setup  homepage contains an overview of configuration types for your Guided Setup. 
You can select the Guided Setup  type and Continue  to launch the Guided Setup  steps and 
begin configuration.

Features supported in Guided Setup  are:
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• Categories page

• Task page

• Other features

Multiple-run support in Guided Setup

It's important to note that the Guided Setup  builder and player support multiple run or execution 
of tasks. You can switch between the two execution types, single and multiple. You can skip 
the execution creation page and load your default configuration with each run when you select 
multiple run on the configuration page.

Create a Guided Setup

Create a Guided Setup  to assist users with planning the roll-out of a product and performing the 
basic configurations to go live.

Before you begin
Role required: sn_help_setup_admin or sn_help_setup_player

The Guided Setup  builder is supported by the Process Automation Designer.

Procedure

1. Navigate to All  > Adoption Services  > Guided Setup.

2. Select the Build your guided setups  tab.

3. Select Create new.

4. Select Get started.

5. Fill in the form.

Introduce the Guided Setup  form

Field Definition

Name The name of your guided setup.

Description Describe the purpose of this guided setup.

User roles Roles required to access the guided setup.

6. Select Continue.

7. To add a stage to your Guided Setup, select Board view  do the following:

a. Select Add stage.

b. Fill in the form.

▪ Label

▪ Description

▪ Start rule

▪ When the process starts

▪ After specific stages
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c. Select Save and close.

d. After creating your stages, select Add activity.

e. Select Guided Setup  and one of the following activities:

▪ External links - Shows a list of external links such as docs and videos in the playbook UI.

▪ Iframe - Embed any page inside an iframe using a page url.

▪ Plugin Install - Installs a list of plugins from the provided plugin query.

f. Fill in the form.

g. In the Details tab, fill in

▪ Label

▪ Description

▪ Start Rule

▪ Select Show additional options

▪ Playbook display order

▪ Start with delay

▪ Run condition

▪ Restart rules

h. In the Automation tab, fill in

▪ For Iframe activity: Add URL

▪ For External Links activity: Add External links

▪ For Plugin Install activity: Add Plugin query

▪ select Show additional options

▪ Assigned to

▪ Assignment group

▪ Wait for user input

i. Optional:  In the UI Layout tab, fill in
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▪ Select Show additional options

▪ associated_table

▪ associated_record

▪ experience_status_table

▪ experience_status_record

▪ title

▪ description

▪ icon

▪ footer

▪ tagline

j. Select Save and close.

k. Select Activate  and then Finalize  when you're complete with configuring your stages.

l. Select the check box and Continue.

m. Create an optional pre-setup checklist and select Finalize.
For example:

▪ Image for header

▪ Content for company description

▪ Company logo

8. To delete a stage or activity, do the following:

a. To delete a stage, select the more actions menu  on your stage.

▪ Configure stage

▪ Add stage before

▪ Add stage after

▪ Delete stage

b. To delete an activity, select the more actions menu  on an activity.

▪ Configure activity

▪ Configure subflow in Flow Designer

▪ Move activity

▪ Delete activity

Domain separation and  Guided Setup

Domain separation is supported for Guided Setup. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.
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Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Key points

There are some key points to note with domain separation support.

• Guided Setup  player can view new guided setup execution for every domain.

• Creation and updation of Guided Setup  is allowed in global domain scope only. This requires 
builder roles.

Migration of existing setups is initiated only in global scope.

Status of setups in progress is shown as applicable to the domain scopes.

Related topics

Domain separation for service providers

Guided Tours
ServiceNow®Guided Tours  are interactive, step-by-step walkthroughs designed to help users 
navigate the platform's features and processes. They are useful for onboarding new users, 
training on new features, and providing assistance with specific tasks.

A sample guided tour and instructions on creating a guided tour. 

Watch this five-minute video to learn about creating Guided Tours  that help users learn how to 
perform tasks in ServiceNow.

Get started

Explore

Learn about the key 
features and benefits 

of Guided Tours.

Configure

Enable, create, modify, and 
customize Guided Tours.
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Using

Use Guided Tours to 
train and onboard users.

Reference

Get more information 
about Guided Tours.

Workarounds

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Guided Tours

Discover the components of Guided Tours  and learn how to create and utilize guided tours to 
familiarize new users with the features and processes of the ServiceNow AI Platform®.

Get to know Guided Tours

ServiceNow®  Guided Tours  are interactive guides designed to help users explore the 
features and processes of the ServiceNow AI Platform®. Two main personas are involved: the 
Administrator (or designer) and the User (or player). Administrators create the guided tours, 
which Users then utilize to understand the platform's capabilities and processes.

The tours are designed to operate within the ServiceNow®  user interface, which includes the 
Standard UI, Workspace, Service Portal, and Custom UI.

Each tour may consist of steps where users can either read information or engage in interactive 
experiences. For instance, the "Explore Service Portal Home Page"  tour highlights the features of 
the Service Portal, while the "Create an Incident in Workspaces" tour guides users through the 
process of creating an incident, resulting in a new record being added to the Incidents list.

Role-based Guided Tours  experience

Administrators (or designers) create engaging guided tours that empower users (or players) to 
explore the features and processes of the ServiceNow AI Platform®. Choose your navigation 
based on your role for the best experience.

Role-based navigation

Administrator User

Guided Tour Designer

Plan Guided Tours

Enable Guided Tours

Create Guided Tours

Edit Guided Tours

Test Guided Tours

Start a guided tour
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Role-based navigation  (continued)

Administrator User

(Optional) Configure auto-launch for Guided 
Tours

(Optional) Domain separation and Guided 
Tours

(Optional) Assign a view to Guided Tours

(Optional) Guided Tour Designer use case

Guided Tours dashboard

Guided Tour Designer

The Guided Tour Designer  is a tool for creating interactive, step-by-step walkthroughs that guide 
users through the ServiceNow AI Platform®.

Guided Tour Designer  (GTD) is a standard feature provided by default, with Guided Tours  for any 
business unit.

Administrators assigned to the guided tour admin role (guided_tour_admin) use the GTD to 
design guided tours. These integrated instructions and visual prompts offer users clear guidance 
for effectively navigating forms, applications, and online portals.

Key feature of GTD

No-code, drag-and-drop interface

GTD simplifies tour creation with an intuitive interface that makes it accessible to 
users without coding skills.

Role-based tours

Admins can create tours that are tailored to specific user roles, ensuring that users 
only see information relevant to them.

On-demand and auto-launch tours

Administers can configure the tour to auto-launch and users can access tours 
whenever they need them.

Tour insights

Analytics on tour usage enables administrators to track effectiveness and make 
necessary improvements.

Benefits of GTD

Faster onboarding

Guided Tours  assist new users in quickly learning how to navigate and use the 
ServiceNow AI Platform®.

Reduced support cases

Clear instructions and guidance lower the likelihood of users needing help with 
basic tasks.

Improved productivity

Users can easily locate what they need and complete tasks efficiently.
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GTD components

Learn about the Guided Tours  components.

Guided Tours  are composed of the following components that function as building blocks for the 
tours that you create.

Guided Tours  components

Component Description

Introduction
The introduction outlines the steps in the guided tour and describes the 
milestone you achieve when all actions are completed.

Step
A discrete component of a guided tour that indicates a sequence.

A step can provide a definition, an instruction, or both.

Callout

The callout provides the definition and instructions for the current tour step, 
including guidance to move to the next step. It highlights the relevant element 
and provides step-by-step instructions for navigating the ServiceNow®  user 
interface.

You can position callouts anywhere in your user interface to provide additional 
context or task-related instructions. There are several display options for the 
callouts, including:

• Above

• Below

• To the left

• To the right

You can customize the Service Portal  guided tour callout colors. For more 
information, see Guided Tour callout color.

Element
The specific components that the tour refers to, such as database records or 
page components.

Elements require formatting so that the tour can link to them.

Trigger

Triggers are actions that you take to advance the tour to the next step. Triggers 
include pressing the Enter key, selecting or right-clicking a UI element, or 
selecting a Next  button in the callout.

For more information, see GTD triggers.

Conclusion
A conclusion indicating that the tour is complete. It is a great opportunity to 
encourage users to explore other tours or provide follow-up information on what 
to do next.
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GTD triggers

Triggers are actions that you take to move the tour to the next step. Each callout in a guided tour 
step has a specific trigger that activates the subsequent step. You define the trigger for each 
callout, and only relevant triggers appear based on the UI element referenced by the callout.

Guided tour triggers

Action Description

Next 
Button The callout includes a Next  button that the user can select to move on to the next 

step. This feature is useful in the following situations:

• When the callout describes the element it’s pointing to, enabling the user to 
progress without needing to select any UI elements.

• When entering information into a reference or date picker field. Users can use the 
lookup function, manually enter data, or select it from a list. They can proceed 
once they’ve completed the necessary entry for the step.

Click 
the 
Element

The tour advances to the next step when the targeted element is selected.

For more information on how to display a step on a different page after users click 
a link, see How to show a step on a different page after the user clicked on a link 
(KB0725875) .

Mouse 
over the 
Element

The tour advances to the next step when the user hovers the mouse device over the 
element.

Right-
click the 
Element

The tour moves to the next step when the element indicated by the callout is right-
clicked.

Press 
Enter 
key

When the user presses the Enter key, the tour proceeds to the next step. This action 
acknowledges that the user has submitted input, such as in a text box.

Change 
Element 
Value

The tour advances to the next step when the user enters or selects a value in a field 
and then clicks outside of it.

Press 
any key

The tour advances to the next step when the user presses any key.

Select The tour proceeds to the next step when the user selects an option from the drop-
down menu.

Double 
click The tour moves to the next step when the user double-clicks an element.

GTD interface

The Guided Tour Designer  (GTD) provides an easy way to create guided tours. You can easily 
drag a callout to the element you want to highlight and enter instructions for each step, along 
with the corresponding trigger. As you add steps, you have the option to test and modify them as 
needed.

The GTD has the following features:
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GTD interface

(A) Guided tour actions

Share your draft or published tour with your internal colleagues for review by 

selecting the copy URL icon  and copying the link.

(B) Callouts

Create guided tour steps by dragging and dropping the callouts to the desired 
position on the page element.

Make sure that the callout's pointer touches the element you intend to assign it to.

Note: 
Guided tour callouts don't function on user interface elements created 
with Seismic technology. Additionally, the AI Search feature uses Seismic 
technology.

(C) Steps

View a step in the current view by hovering it.

If the step is from a previous page, a message appears saying Not found in current 
view. In this example, the first step isn’t visible in the current view. Access this step 
by selecting the back arrow in the upper left corner to open the list view, where the 
step is located.

Note: 
Each step should focus on only one interaction with a field or object. Avoid 
including multiple interactions in a single step.

(D) Step interaction
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When you hover over a step, the corresponding number on the page becomes 
large.

Edit the text of a specific step by choosing that step and selecting the edit icon . 
Then, in the Content HTML formatter, make your changes and select Save.

Remove a step by selecting it from the list and then selecting the delete icon (-).

Rearrange the steps by dragging and dropping them in appropriate positions.

If you accidentally link a step to the wrong element, delete it. Then create a new step 
with the correct details and reposition it appropriately.

Edit a trigger by selecting the step, choosing an option from the Choose action list, 
and then selecting Save.

(E) Tour action buttons

Select Preview  at any time to test and review your steps.

Select Publish  to make your guided tour visible to users.

Select Exit  to close the GTD. The browser tab or window closes and changes you 
made are automatically saved.

Select Play  to open the instance and designated UI page in a new browser tab or 
window and proceed through the steps. When you finish, close the tab or window to 
return to the GTD.

Related topics

GTD triggers

Create Guided Tours

Guided Tour Designer use case

GTD workflow

Learn about the primary steps to create a guided tour.

With the Guided Tour Designer, you can effortlessly create guided tours. The primary steps are 
as follows:

Define scope

Begin by accessing the Guided Tour Designer. Specify the tour's name, type (for 
example, Workspace, Service Portal), starting page, and the relevant user roles.

Add steps

Use the drag-and-drop interface to incorporate callouts, instructions, and triggers 
for specific page elements.

Test and refine

Test the tour during development to identify and implement necessary changes for 
an effective user experience.

Publish the tour

After the tour is finalized, publish it.

Limitations of GTD

Learn about the limitation of the Guided Tour Designer.
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The GTD does not currently support the following areas.

Standard Forms and Lists UI

• Flow Designer

• Agent Workspace

• Pop-up windows

• Connect Chat and Embedded Help on the GTD sliding panel

• Select2 elements

• SVG elements

• Custom Tags

• Standard UI pages that have custom UI elements, such as Contextual search.

Service Portal

• Service Portal  pages that contain IFRAMES

• The Service Portal Branding Editor, which also contains IFRAMES

• Select2 elements

• SVG elements

• Custom Tags

• Seismic components (shadow dom).

For example: sn-search-combobox - AI search box, sn-search-results-container - 
AI search results, ci-chat-components.

• Tours when loaded in the Next Experience UI.

Workspace

• Only the following app shell experiences are supported:

◦ Breadcrumb App shell

◦ ACE Unified Nav App shell

◦ Workspace App shell

◦ Custom App shell

• Experiences with an empty app shell are not supported.

• Tours that start in a custom app shell and go to the Polaris app shell are not 
supported.

• Not recommended to create tours on Workspaces in UI16

• Variants

• Callouts inside iframes in a workspace

• Guided Tours  that start in a standard UI or workspace and go to a service portal

• Guided Tours  are only supported within a page, if a link opens in a new tab the 
tour does not continue

Note: 
Admins must add the right action for the callout on elements that can open 
in a new tab.
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• Guided Tours  are not supported in mobile view

• Callouts on elements inside visualisation components or par widgets

Technical limitations

• Call out targeting generally works as expected, but may occasionally fail for some 
pages. When adding a step in Guided Tours, for example, the algorithm that 
identifies unique element selectors relies on the page's DOM structure. If multiple 
selectors match the same element, the algorithm picks the first match, which may 
not always be the correct one. In such cases, it is recommended to manually edit 
the selectors to ensure the intended element is uniquely identified.

• Elements that are loaded in DOM by scrolling the page effect Guided Tours. The 
admin must inform the user to scroll further when the form is present.

• If there is no click action on the elements that are selectable while creating the 
tour, place the callout on the parent element.

Configuring Guided Tours

Guided tour configurations allow you to enable, create, modify, and customize tours, as well as 
configure them to launch automatically and customize the tour experience.

Plan Guided Tours

Planning is essential before entering a guided tour into the system. Create an outline and include 
any assumptions to assist you during the tour creation.

Planning a guided tour

Before outlining a guided tour, consider these factors:

Purpose of the tour

Decide whether to create a tour that describes a user interface or one that helps 
users complete a task. Conduct research and break down the main goal into clear, 
manageable steps.

Accessibility of the tour

Enable the tour on your production system to help users perform routine tasks like 
ordering from the Service Catalog or creating incidents. If your aim is to train users 
to explore these tasks without creating real records, provide the tour on your non-
production system.

Name of the tour

Choose a unique, intuitive tour name that clearly indicates its purpose, like “Create 
a New Incident” or “Review the Incident List”.

Customize the instructions so that each user creates a unique record. For instance, 
if the tour instructs users on how to create a group called "Facilities," you can avoid 
duplicate name errors for subsequent users by prompting them in a callout to 
assign a unique value to the group name field.

User's knowledge about the task

Not all users who take the tour have the same knowledge level. Evaluate the 
information needed to make sure that participants comprehend the content from 
the start.

When planning your tour, consider addressing the following additional questions:
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• What page should the tour start on?

• What steps are important to accomplish the objective?

• How should a user navigate from one step to the next?

Selecting triggers

Triggers are actions that you take to move the tour to the next step. Each callout in a guided tour 
step has a specific trigger that activates the subsequent step. You define the trigger for each 
callout, and only relevant triggers appear based on the UI element referenced by the callout.

For more information, see GTD triggers.

Using callouts

You must place a callout on top of an element to interact with it. The element is highlighted in 
blue when it’s selected as the target.

In the following example, it looks like the callout is pointing to the context menu icon, but notice 
that the header bar is highlighted blue.

Incorrect callout placement for the context menu

This example depicts the correct placement of the callout for the context menu. Notice that the 
context menu icon is highlighted blue.

Correct callout placement for the context menu

The following tips may also be helpful:

• When you place a callout on a form that contains tabs, consider that a user may not have the 
tab open for viewing. Create a new callout that instructs the user to first open the tab before 
proceeding with the rest of the tour.

• When adding callouts to fields with dynamic content, keep them minimal. If users can’t locate 
the associated tour element due to a delayed page refresh, the tour may end unexpectedly.

• When you guide a user through pop-up windows, add your callout to the originating page on 
or near the pop-up icon. Within the callout instructions, guide your user through the steps 
intended for the pop-up window, because callouts can’t be added to the pop-up window.

• While the color of a callout is static in the Standard platform UI, you can customize callouts 
on Service Portal. Consider using this capability to make sure that a consistent look-and-feel 
between your callouts and your Service Portal  pages.
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Auto-launching your tour

Automatically start a tour if you want users to take the tour on their first visit to the page.

You can choose to launch multiple tours automatically from a single starting page. You can set 
the auto-launch order so that users start the second tour on their second page visit, the third tour 
on their third page visit, and so on. Use this option if you want to begin with an introductory tour 
and then add more complex or focused follow-up tours.

Enable Guided Tours

Enable guided tours for Standard platform UI, Workspace, Service Portal  pages, and Custom UI.

Before you begin
Role required: admin

Procedure

1. In the application navigator, enter sys_properties.list  and press the Enter key.

2. From the System Properties list, find the following properties and make sure that their values 
are set to True.

Property Description

com.snc.guided_tours.standard_ui.enable Enables guided tours across your instance 
to run on the Standard platform UI and 
Workspace.

com.snc.guided_tours.sp.enable Enables guided tours across your instance to 
run on Service Portal  pages.

com.snc.guided_tours.custom_ui.enable Enables guided tours across your instance to 
run on the Custom UI pages.

3. If the values of the system properties aren’t set to true, change them to True.

Result
You can create, update, and play guided tours within the ServiceNow®  user interface.
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Note: 

• The Guided Tour Designer  is only available in Core UI. The designer isn’t compatible with 
UI15. For information about how to activate the Core UI  plugin, see Activate Core UI.

• Guided Tours  are supported in Next Experience  pages, such as Workspace  or pages 
configured in UI Builder using the Next Experience  UI Framework.

Set the value of the system property 
com.snc.guided_tours.standard_ui.enable  to True  to enable Guided Tours 
under Next Experience. The following scenarios are still supported with Next Experience 
enabled:

◦ Creating and running new or existing Guided Tours  in the Classic Environment 
(including lists and forms).

◦ Creating and running new or existing Guided Tours  for a Service Portal.

◦ Creating new Guided Tours  for Unified Navigation menus (such as the All  or Favorites 
menus).

For more information, see Next Experience

Create Guided Tours

After you outline the guided tour, use the Guided Tour Designer  (GTD) to enter the steps using 
callouts and triggers.

Before you begin
Role required: guided_tour_admin or admin

About this task
This task illustrates how to create a guided tour.

Procedure

1. Navigate to All  > Guided Tour Designer  > Create Tour.

2. Enter the following information in the form:

Field Description

Name Enter a name for the tour that describes what the user accomplishes by completing 
the tour.

Tour 
Type

Select:

◦ Standard UI  for tours that start from system platform content, such as a list or a 
form.

◦ Service Portal  for tours that start from a Service Portal page.

Note: 
When you select Service Portal, a Portal  option appears, where you choose 
a record from the Service Portals table.

◦ Custom UI  for tours that start from Custom UI page.

◦ Workspaces  for tours that start from a Workspace page.

Starting 
Page

Select the page that the tour starts on:
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Field Description

◦ If your tour type is Standard UI, your choices include pages that show lists and 
forms.

◦ If your tour type is Service Portal, your choices include Service Portal  pages.

Note: 
In the base system, you can only launch tours from pages that use the 
SP Header Menu. Manually launched tours do not display on pages with 
custom header menus.

◦ If your tour type is Custom UI, your choices include pages that show Custom UI 
pages.

◦ If your tour type is Workspace, your choices include pages that show Workspaces 
pages. You can select the page in two ways:

▪ Paste URL: You can copy the URL of the workspace page and paste it. If the URL 
isn’t a valid experience, the Create Tour  button isn’t enabled.

Important: 
The maximum length for URLs is 2,500 characters. If a URL exceeds this 
limit, it is automatically truncated to the first 2,500 characters.

▪ Manual Selection: You can select the page from the drop-down menu by 
entering the name of the page.

Note: 
If the selected page contains parameters, you must mention the values 
of the parameters. If you want the tour to apply to the same page without 
exact parameters, configure the page parameters as dynamic.

You can begin entering the UI page name to show a list of matching pages, and 
then select it from the list.

Note: 
In some cases, navigating to standard forms and lists while creating custom 
tours might not work as expected. You can choose the following workaround to 
create the custom UI tour in such cases:

a. Create standard UI type tour on any page, ideally home page.

b. Go to system property - com.snc.guided_tours.homepages  and 
add the name of the custom page in the Value  field of this page. You can 
enter multiple values separated by commas.

c. Update the context of the tour from form view to your custom page.

Roles ◦ If the tour can be accessed by all the roles, then select All.

◦ If the tour can be accessed by specific roles, then select Specific.

Select the roles that can access the guided tour and move them from the 
Available Roles list to the Roles that can view the tour list.
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Field Description

Note: 
When you add at least one role to a tour, it limits the audience to only those 
users who have that role.

3. Select Create.
The Guided Tour Designer  opens in draft status in a new tab or window.

4. Select Create Introduction.

a. Enter an introductory title for your guided tour.

b. Write a message to your end users explaining the purpose of the tour.

c. Select Save.

5. Follow these steps to add a tour step with a callout and trigger:

a. Drag a callout from the upper right corner of the screen and drop it on top of the UI element.
The element is highlighted when the callout is positioned correctly. When you release the 
callout, it locks into the position.

b. Enter the instructions in the Text  box.
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You can change the direction of the callout by selecting the correct option under Placement. 
Only the placement options applicable to the selected element are enabled.

c. Select the trigger  from the Choose action  list. Only triggers applicable to the selected 
element appears in the list.

d. Optional:  To format text, such as bold or italic, add HTML tags around the text.
For example, enter Click <b>New</b> to set up a delegate. You can add 
other HTML tags, including tags for images.

e. Optional:  Select the Skippable  check box if a user can skip the step and proceed to the 
next if an element or field is unavailable at runtime.

f. Select Save.
The first Step label appears.
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When your end users select the label, they see your first step instructions rendered as a 
message.

6. Continue adding steps until you have completed the tour.
The tour is saved as you save each step.

7. Select Create Conclusion.

a. Enter a closing message for the demo that summarizes the users' achievements.

b. Select Save.

Note: 
You can edit and delete introductions, conclusions, and callouts at any time while 
your tour is in draft status. You can also insert HTML markup into your conclusions, 
introductions, and callouts.

All standard HTML tags compatible with your browser are supported.

8. Select Preview  at any time to test your steps and make any final revisions to the tour.
Note the steps that aren’t working properly or that need correction. Edit the tour or the steps as 
described in Edit Guided Tours.

9. To share your draft or published tour with your internal colleagues for review, do the following:

a. Select the copy URL icon  to copy the tour URL.

b. Send the URL to reviewers.

10. Select Publish  to make your guided tour visible to users.

Result
The guided tour is created and listed in the Help Center. Each guided tour is allotted with a 
unique tour ID. If you set property (com.snc.guided_tours.sort)  to true, the tours 
appear in alphabetical order.

Related topics

Exploring Guided Tours

Edit Guided Tours

You can modify the settings of a guided tour by using the Guided Tour Designer  (GTD).

Before you begin
Role required: guided_tour_admin or admin
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About this task
To edit a guided tour, you can use either GTD or the Guided Tours  form. The GTD enables you to 
add, delete, and reorganize guided tour steps. The Guided Tours  form is recommended for tasks 
that are difficult to accomplish using the GTD. You can start by editing the elements shown on the 
form when you open a guided tour record. Then, proceed to the GTD for further edits.

The base system offers several guided tours for specific applications, such as Performance 
Analytics. As an administrator, you can modify existing tours and assign one or more roles to 
them to manage access.

Procedure

1. Navigate to All  > Guided Tour Designer  > Guided Tours.

2. Open the guided tour that you want to edit.

3. In the Guided Tours  form, you can edit the following elements:

◦ In Workspace:

▪ Name: Update the name to make it unique and intuitive.

▪ Status: Change the to either draft or published.

▪ Context: Update the URL for the tours. For example, /now/sow/home, /now/sow/
record, or /now/sow/list.

▪ Description: Update the description to help users understand the purpose of the tour.

▪ Roles: Add or remove roles.

▪ Route Parameters: Update route parameters to collect metadata about the specific URL 
where you want to play the tour.

▪ Active  check box: Clear the Active  check box, to turn off the guided tour. The tour 
becomes read only, meaning it can’t be edited and is hidden from end users. 
If you want to keep the tour for future use but don’t want end users to see it, change its 
status back to draft for further editing. Select the Active  check box, to turn the tour back 
on.

◦ In Service Portal:

▪ Name: Update the name to make it unique and intuitive.

▪ Status: Change the to either draft or published.

▪ SP Portal: Specify where the tour should be created, such as in the Employee Center or 
the Knowledge Portal.

▪ SP Page: Specify which page in the SP Portal the tour should be created on, such as the 
index page or the home page.

▪ Additional URL Parameters:

You can initiate a Service Portal  tour from a specific widget, record, or view within a page 
rather than from the entire page. To initiate a tour, include the URL parameters that directly 
reference the specific item in the Additional URL Parameters  field.

For example, you can specify the part of the URL that contains the sys_id 
of a widget, or include parameters for a particular record or view, such as 
sys_id=abc123&view=myView.

▪ Description: Update the description to help users understand the purpose of the tour.
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▪ Roles: Add or remove roles.

▪ Active  check box: Clear the Active  check box, to turn off the guided tour. The tour 
becomes read only, meaning it can’t be edited and is hidden from end users. 
If you want to keep the tour for future use but don’t want end users to see it, change its 
status back to draft for further editing. Select the Active  check box, to turn the tour back 
on.

You can’t change the Tour Type, regardless of the user interface type.

4. To test and refine the steps, select Edit with Designer  in the form header.
The starting page opens in the GTD in a new tab or window.

5. You can perform any of the following tasks in the GTD.

Test Guided Tours

Test your guided tour to verify it achieves your intended goal.

Impersonate User

Impersonate a role to see the tour from the user's perspective. By participating in the tour 
as a representative user, you are able to observe and understand the experience from their 
perspective.

Guided Tour feedback

Send the tour URL to your colleagues for review and feedback. If the feedback is useful, update 
your tour as needed.

Guided Tour review

After the tour is published, review any failures caused by errors on the Guided Tours Overview 
page. Examine these failures to gain insights into which users encountered issues, at which step 
the tour failed, and what the error message was. Use this information to troubleshoot and fix the 
problems.

Configure auto-launch for Guided Tours

Configure one or more tours to launch automatically when a user lands on a page.

Before you begin
Role required: guided_tour_admin and embedded_help_admin, or admin

Note: 
Guided tours are only available for logged-in users.

About this task
You can set auto-launch for any guided tour starting page. Select this option if you want users to 
take the tour on their first visit.

Procedure

1. Navigate to All  > Guided Tour Designer  > Configure Auto Launch.
The Configure Auto Launch page shows tiles for each page that has one or more configured 
tours. You can filter the tiles by part of or the entire page name, and sort them by name or by 
the most recently edited tours.

2. Select a tile that represents the page where you want the tour to launch automatically.
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A list of tours available for the page is shown on the Configure Auto Launch screen.

You can enable or disable auto-launch on the tour whether it is in draft or published status. 
When you enable auto-launch:

◦ Tours in published status launch automatically when users access the starting page 
associated with the tour.

◦ Tours in draft status don’t launch automatically. When a tour in draft state is configured for 
auto-launch and is published later on, it starts to launch automatically.

3. Select the Auto Launch  toggle.

The toggle color changes to green, indicating auto-launch is enabled on the tour.

4. Configure auto-launch for more than one tour on a page.
If you have more than one tour enabled on a page, they appear as additional rows.

a. Repeat steps 2–3 for additional tours that you want to enable for auto-launch.
The tours move to the top of the list in the order that you enable them.
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b. Drag rows to reorder the tours so they appear in the order you want users to see when they 
visit the page successive times.
For example, the first tour may provide an overview of a page while the second tour guides 
the user through a specific task.

When users access a page that has a guided tour enabled for auto-launch, the tour begins 
immediately. If they stop the tour by selecting the X  icon on a tour step, a message appears 
that provides them with the option to stop both the current tour and other tours from auto-
launching the next time they access the page.

5. Reset an auto-launch tour for the page.
After you’ve gone through a tour on a page, the tour doesn't get triggered automatically if you 
revisit the same page. Reset an auto-launch tour for the page by performing the following 
steps:

a. Navigate to All  > Guided Tours.

b. Open the tour that you want to reset.

c. Under Related Links, select Override tour Auto Launch Preferences.
A list of records shows each user who has used the tour already.
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d. Deselect the Disable Autolaunch  check box to reset the tour.

e. Select Submit.

Domain separation and Guided Tours

You can assign a domain to a guided tour during its creation or edit the domain of the tour at any 
time.

Before you begin
Role required: guided_tour_admin or admin.
To use domain separation in Guided Tours, you must request domain separation .

Note: 
The Guided Tour Designer  requires Core UI. For more information, see Activate Core UI.

About this task
With the ServiceNow AI Platform®, service providers (SPs) can provide their customers with 
faster onboarding, meet compliance, and protect their data using domain separation. You can 
separate client data, processes, and reports into logical groupings called domains. SPs control 
who sees and accesses what content. You can create and modify guided tours that apply to 
specific domains in your instance as well as tours that are available to users globally. You can 
also copy the tour so that you can modify it for a specific domain.

Procedure
Add the Domain  column to the list:

1. Navigate to All  > Guided Tour Designer  > Guided Tours.

2. Select the gear icon  and add the Domain  columns.
The Domain  column indicates the domain to which a tour belongs.

Set a Domain  for the guided tour:

3. Select the globe icon and then select Domain scope.

Domain picker

4. From the Domain scope list, select a domain.

5. Create a guided tour.
For more information, see Create Guided Tours.

Change the Domain  of a guided tour:
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6. Navigate to All  > Guided Tour Designer  > Guide Tours.

7. Select the tour for which you want to change the domain.

8. Select the Form context menu ( )  > Configure  > Form Design.

9. On the Form Design  page, drag the Domain  element and drop it at an appropriate spot on the 
form.

10. Select Save.

11. Return to the Form view and confirm that the Domain  field has been included in the form.

12. Select any domain that you prefer and save the record.

Result
Within the specified domain, the saved version of the tour replaces the original for users in that 
domain.

Assign a view to Guided Tours

You can assign a list or form view to a step in a guided tour.

Before you begin
Role required: guided_tour_admin or admin

About this task
To assign a view to a tour step, you must know the view name. The name you see in the context 
menu View  option is the title of the view. Look up the view name before you assign it to a tour 
step.
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Context menu view options

Note: 
You can add a view to only one step in a guided tour, and this is only possible if the step 
begins in the default view. When the tour is played and that step is executed, the user 
interface refreshes to display the new view.

Procedure

1. Complete the following steps to find the view name:

a. Navigate to All  > System UI  > Views.

The first two columns are Name  and Title.

b. Locate the view by its Title, and note the value in the Name  column.

2. Navigate to All  > Guided Tours Designer  > Guided Tours.

3. Open the tour to be modified.

4. Under Related Links, from the Guided Tour Steps, select the step you want to add a view.

Guided Tour Steps related list
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5. In the Tour Step tab, enter the view name in the View  field.

Tour Step form

6. Select Update.

7. Complete the following steps to test the tour with the view:

a. In the Guided Tours  form, select Edit with Designer.

b. In the Guided Tour Designer  tab or window, select Play.

c. Verify that the step you modified displays the correct view.

Create Guided Tours with accessibility enabled

The Guided Tour Designer  has accessibility features so that users can design tours using screen 
readers and keyboard navigation.

Before you begin
Role required: guided_tour_admin or admin

About this task
Overall, the accessibility features of the Guided Tour Designer  align with those of the ServiceNow 
AI Platform®. See the Accessibility features  section for more information.

Procedure

1. If accessibility features aren’t enabled, navigate to User Administration  > User Preferences 
and enable the preference glide.ui.accessibility.

2. Navigate to Application  > Module.

3. Navigate to All  > Guided Tour Designer  > Create Tour.

4. Press tab to the Tour Name  field and enter a unique name for the guided tour.

5. Press tab to the Application Page Name  field.

6. Enter part of the name to open a list of pages to scroll through and choose from.

7. Tab to the Roles this tour is for  slushbucket and use skip links to select roles.
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8. Select Create.
The selected application page opens in the Guided Tour Designer.

9. Press tab to the field you want to add a step to.

10. Press tab again and then press Enter to open the Editing  window for the Guided tour step.
The editing window has the following features:

◦ An icon for placing the callout. Press Enter to open a list to choose the callout's placement. 
Only viable callout locations are enabled.

◦ The number of the guided tour step and how many steps have been created. When you 
create your first step this is step 1/1.

◦ A text box to instruct the user what to do at this step.

◦ A choice list to select the trigger. from the Choose action  list. Only triggers applicable to the 
selected element appears in the list.

◦ Cancel  and Save  buttons.

11. Continue adding steps until you have completed the tour.
The tour is saved as you save each step.

What to do next
Tab to the panel on the right side to edit the name of the tour, copy the tour's URL, and rearrange 
the tour's steps.

Using Guided Tours

Use Guided Tours  for onboarding new users, training on new features, and providing in-
application assistance.

Guided Tour Designer use case

Guided Tour Designer  is an interactive guide that assist administrators in creating and editing 
guided tours for ServiceNow®  applications, service portals, and custom applications.

Create a guided tour to illustrate vacation delegation

Use Guided Tour Designer  to create a guided tour for assigning a vacation delegate.

Before you begin
Role required: guided_tour_admin or admin

About this task
Here’s an example of using Guided Tour Designer  to create a tour that explains to users how to 
assign a vacation delegate. This example demonstrates the use of introduction, callouts, callout 
steps, and the conclusion in a tour.

Procedure

1. Navigate to All  > Guided Tour Designer  > Create Tour.

2. Enter a name in the Name  field.

3. From the Tour Type list, select Standard UI.

4. From the Starting Page list, search for sys_user_delegate_list.do  and select it.
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5. Select a role and then select Create Tour.
A guided tour is created.

6. In the Guided Tours  form view, to open the Guided Tour Designer  select Edit with Designer.

7. Add the following steps to the guided tour:

Step Callout Trigger

Add an 
introduction.

a. Select Create Introduction.

b. Enter a title; for example, Assign vacation delegation.

c. Enter the following message in the Text  field: This tour 
will walk you through the necessary 
steps to effectively assign someone to 
manage your responsibilities while you 
are away on vacation.

No trigger is 
required.

Select Save  to 
save the step.

Open the 
Delegate 
form and 
enter a new 
record.

a. Drag a callout and position it to point at the New  button in 
the Delegates list view.

b. Enter the following message in the Text  field: Click New 
to set up a delegate who will receive 

a. From the 
Choose 
action list, 
select Trigger 
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Step Callout Trigger

your notifications while you are on 
vacation.

next step on 
click.

b. Select Save 
to save the 
step.

Describe 
the User 
field.

a. Drag a callout and position it to point at the User  field.

b. Enter the following message in the Text  field: Your 
name defaults as the user who wants to 
delegate to another user. If you are 
setting up a delegate for someone else, 
you can select a different user.

a. From the 
Choose 
action list, 
select Trigger 
next step on 
next button 
click.

b. Select Save 
to save the 
step.

Select the 
delegate

a. Drag a callout and position it to point at the Delegate  field.

b. Enter the following message in the Text  field: Specify 
the person you want to delegate to by 
typing their name and selecting it when 
it appears.

a. From the 
Choose 
action list, 
select Trigger 
next step on 
next button 
click.

b. Select Save 
to save the 
step.

Set the start 
date

a. Drag a callout and position it to point at the Starts  field.

b. Enter the following message in the Text  field: Enter 
the date and time to start forwarding 
notifications.

a. From the 
Choose 
action list, 
select Trigger 
next step on 
click.

b. Select Save 
to save the 
step.

Set the end 
date

a. Drag a callout and position it to point at the Ends  field.

b. Enter the following message in the Text  field:Select 
the date and time to stop forwarding 
notifications.

a. From the 
Choose 
action list, 
select Trigger 
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Step Callout Trigger

next step on 
click.

b. Select Save 
to save the 
step.

Describe 
the delegate 
options

a. Drag a callout and position it to point at the check boxes 
from the Approvals  check box to the Meeting invitations 
check box.

b. Enter the following message in the Text  field: If you do 
not want these notifications forwarded 
to your delegate, you can clear any of 
these fields.

a. From the 
Choose 
action list, 
select Trigger 
next step on 
next button 
click.

b. Select Save 
to save the 
step.

Submit the 
delegate 
record

a. Drag a callout and position it to point at the Submit  button.

b. Enter the following message in the Text  field:  Click 
Submit to add the delegate.

a. From the 
Choose 
action list, 
select Trigger 
next step on 
click.

b. Select Save 
to save the 
step.

Add a 
conclusion

a. Select Create Conclusion.

b. Enter the following message in the Text  field: Hurrah! 
Your vacation delegation has been 
successfully completed!

No trigger is 
required.

Select Save  to 
save the step.

Result
The guided tour is created and listed in the Help Center.

Users can access a guided tour by navigating to a page that has one. For more information, see 
Start a guided tour.

Related topics

Create Guided Tours

Edit Guided Tours

Create guided tour to explore Service Portal  home page

Use Guided Tour Designer  to create a guided tour to explore the Service Portal  home page.

Before you begin
Role required: guided_tour_admin or admin

About this task
Here’s an example of using Guided Tour Designer  to create a tour that helps users to explore the 
Service Portal  home page.
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This example demonstrates the use of introduction, callouts, callout steps, and the conclusion in 
a tour.

Procedure

1. Navigate to All  > Guided Tour Designer  > Create Tour.

2. Enter a name in the Name  field; for example, Service Portal  overview.

3. From the Tour Type list, select Service Portal.

4. From the Portal list, select Service Portal.

5. From the Starting Page list, select ID Index.

6. From the Roles list, select All  and then select Create Tour.
A guided tour is created.

7. In the Guided Tours  form view, select Edit with Designer  to open the Guided Tour Designer.

8. Add the following steps to the guided tour:

Step Callout Trigger

Introduction a. Select Create Introduction.

b. Enter a title; for example, Service Portal  Overview.

c. Enter the following message in the Text  field: Welcome to 
the guided tour of your new Service Portal 
home page.

No 
trigger is 
required.

Select 
Save  to 
save the 
step.

1 a. Drag a callout and position it to point at the element How can we 
help?.

b. Enter the following message in the Text  field: Welcome to 
this guided tour of your new Service Portal 
home page. We start with the How can we 
help? search bar. If you can't find what 
you're looking for, enter it here, click 
the Search icon, or press Enter on your 
keyboard. For now, we will look at some 
other areas first.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

2 a. Drag a callout and position it to point at the element Request 
Something.

b. Enter the following message in the Text  field: If you would 
like to order something, such as a new 
phone, select Request Something.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
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Step Callout Trigger

step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

3 a. Drag a callout and position it to point at the element Knowledge 
Base.

b. Enter the following message in the Text  field: If you would 
like to search the knowledge base, select 
Knowledge Base.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

4 a. Drag a callout and position it to point at the element Get Help.

b. Enter the following message in the Text  field: If you would 
like to get help for an issue, select Get 
Help.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

5 a. Drag a callout and position it to point at the title bar.

b. Enter the following message in the Text  field: You can also 
check the knowledge base, order something, 
look at requests you have logged, and check 
other options up here in the title bar.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
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Step Callout Trigger

step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

6 a. Drag a callout and position it to point at your name in the top-right 
corner.

b. Enter the following message in the Text  field: View your 
profile or log out by clicking your name.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

7 a. Drag a callout and position it to point at the company logo in the 
top-left corner.

b. Enter the following message in the Text  field: Navigate back 
to your Service Portal home page by clicking 
your company logo.

a. From 
the 
Choose 
action 
list, 
select 
Trigger 
next 
step on 
Next 
button 
click.

b. Select 
Save 
to save 
the 
step.

Conclusion a. Select Create Conclusion.

b. Enter the following message in the Text  field: 
Congratulations! Now you have a general 
understanding of the Service Portal home 
page.

No 
trigger is 
required.

Select 
Save  to 
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Step Callout Trigger

save the 
step.

9. After you have created your tour, preview it to confirm that it displays correctly and guides the 
user effectively before submitting it.

Result
The guided tour is created and listed in the Tours  menu.

Users can access a guided tour by navigating to a page that has one. For more information, see 
Start a guided tour.

Related topics

Create Guided Tours

Edit Guided Tours

Create a guided tour to show incident generation in Workspace

Use the Guided Tour Designer  to create a tour that explains how to generate an incident in 
Workspace.

Before you begin
Role required: guided_tour_admin or admin

About this task
Guided Tours  are available in Workspace  to help users understand the features of the 
Workspace.

Here’s an example of using tours to guide users through the steps of creating an incident in 
Workspace.

Procedure

1. Navigate to All  > Guided Tours Designer  > Create Tour.

2. Enter the following details:

Guide tour form

Field Description

Name Enter the name of your tour; for example, 
Create New Incident Tour on Workspace.

Tour Type a. Specify the type of page for which the 
tour is created. In this example, it’s 
Workspaces.

b. Select Manual Selection.

Starting Page Specify the page for which the tour is created. 
In this example, it's Service Operations 
Workspace: Record.

Table Specify the type of record that requires 
guidance. In this example, it's incident.
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Field Description

Note: 

Make sure the term 'incident' is always 
written in lowercase letters only.

Sys_id
Specify the sys_id for the page that needs 
guidance. In this example, -1.

Note: 

To set up your tour, avoid using URLs 
with specific IDs like -1_uid_1 or -1_uid_3, 
as they’ll only work for incidents with 
the same ID. Instead, use this option: 
{"url":"/now/sow/record/incident/-1"}.

Start with this setup, and if you have 
steps with IDs, change them to: {"url":"/
now/sow/record/incident/-1"} for correct 
functionality.

3. Select the Create Tour  button.
A guided tour is created.

Update the Route Parameters

To enable your newly created guided tour to work on any sys_id, you must manually update the 
route parameters. This is also essential for enabling the Take a Tour  option in the Help Center.

Perform the following steps:

1. In the Guided Tour Designer  list view, choose the tour you want to update.

2. In the editable form, change the Route Parameters  and set the value of the parameter 
isDynamic  to 

True.

This update enables your guided tour across different sys-ids and activates the Take a Tour 
option in Help Center.
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Add steps to the guided tour

Use the Guided Tour Designer  to add an introductions, steps, and conclusion to your tour.

In the Guided Tour Designer, add the following steps to the tour:

Introduction

Add an introduction that outlines the steps in the guided tour and describes the 
milestone you achieve when all actions are completed.

Callouts

Add callouts to guide users with step-by-step instructions to navigate and operate 
within the workspace. You can position callouts anywhere in your workspace to 
provide additional context or task-related instructions. There are several display 
options for the callouts, including:

• Above

• Below

• To the left

• To the right

While creating your list of tour steps, you can also drag the steps to reorder them as 
needed.

Triggers

You can create steps across various pages in your workspace and set up triggers to 
lead users to the next step. As users progress through the tour, the next callout will 
appear after completing the trigger.

For example, the trigger can be configured to advance after the user selects the 
Next  button.

Conclusion
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At the end of the tour, add a conclusion indicating that the tour is complete. This is 
a great opportunity to encourage users to explore other tours or provide follow-up 
information on what to do next.

After you have created your tour, preview it to confirm that it displays correctly and guides the 
user effectively before submitting it.

The guided tour is created and listed in the Help Center.

Users can access a guided tour by navigating to a page that has one. For more information, see 
Start a guided tour.

Related topics

Create Guided Tours

Edit Guided Tours

Start a guided tour

Guided Tours  are available across four user interface types: Standard, Service Portal, Workspace, 
and Custom UI.

The way-guided tours start varies depending on the specific interface type (tour type).

Start guided tour from Help Center

If you have the appropriate roles, you can access a guided tour from Standard Forms and Lists 
UI, Workspace, and Custom UI.

Before you begin
Role required: user

Procedure

1. Select the  icon to open the Help Center.

The Help Center  lists a maximum of four tours.

2. To view more tours, select Show more.

3. Select a tour from the list.

After you begin a tour, you can see its progress in the Help Center.
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You can select End Tour  to end the tour.

Note: 
This process applies to custom UI pages or applications accessed through the navigator. 
Tours aren't visible if a custom page is opened directly without using the navigator.

Start a guided tour from Service Portal

If you have the appropriate roles, you can access a guided tour from Service Portal.

Before you begin
Role required: user

Procedure

1. Go to the Service Portal  page that has a guided tour.

The  menu appears on the banner with a color indicator to the right of the menu.

2. Select the Tours  menu.
All available tours for the page appear.

3. Select a tour.

Note: 

If a page doesn’t have a Service Portal  Header Menu, you can’t access the Tours  menu. 
In this case, the guided tour is only available to you through auto-launch. See Configure 
auto-launch for Guided Tours.

If a tour is assigned at least one role, the audience is limited to users with that role.

Guided Tours dashboard

The Guided Tours Overview dashboard provides statistics related to guided tour usage.

To access the Guided Tours  dashboard, navigate to Guided Tour Designer  > Guided Tours 
Overview. The dashboard features two tabs:

• User Engagement: This tab shows the number of users actively engaging with the Guided 
Tours  and highlights trends over time.

• Tour Statistics: This tab shows trends and patterns in user engagement. It enables you to 
analyze tour completions and failures, helping you create more successful tours.

You can view reports by selecting options in the interactive filter based on the guided tour type 
and the guided tours present in the instance. The statistics provided in the User Engagement 
and Tour Statistics tabs change based on the options selected in the interactive filter.

User Engagement
The User Engagement tab displays the following widgets.

Widgets in the User Engagement tab

Widget Description

Tour Views Number of user views of guided tours per day.

Tours Completed Number of tours completed by users per day.
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Widgets in the User Engagement tab  (continued)

Widget Description

Unique Users Views Number of individual users viewing guided 
tours per day.

Unique User Completion Number of individual users who have 
completed guided tours per day.

Weekly Engagement Trends and patterns of user engagement with 
guided tours per day over a period. You can 
save this graph in PNG or JPEG format by 
hovering over the graph and choosing the 
relevant format from the context menu.

Disengaged Users Number of users who turned off the auto-
launch feature for the guided tour. You can 
save this graph in PNG or JPEG format by 
hovering over the graph and choosing the 
relevant format from the context menu.

Sample User Engagement tab

Tour Statistics
The Tour Statistics tab displays a list of tours sorted by context. The tab has the following 
widgets.

Widgets in Tour Statistics tab

Column Description

Tour Views
Shows the number of tours abandoned, 
completed, dismissed, and failed tours. Select 
a bar in the bar graph to see more details.

Tour Completions
Shows the number of tours completed in 
Guided Tour Types and Guided Tours.
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Widgets in Tour Statistics tab  (continued)

Column Description

Select a bar in the bar graph to see more 
details.

Tour Failures
Shows the number of tours that failed in 
Guided Tour Types and Guided Tours.

. Select a bar in the bar graph to see more 
details.

Top 10 Tour Completions
Shows the names of the 10 most frequently 
completed tours.

Top 10 Tour Failures
Shows the 10 tours that failed most frequently.

Top 10 Tour Dismissals
Shows the 10 tours that are dismissed most 
frequently.

Sample Tour Statistics tab

Guided Tour Reference

Reference topics provide additional information about configuration properties, roles, and more.

Guided Tour callout color

Customize Guided Tours  callout colors in Service Portal.

Service Portal guided tour callout colors

Parameter Default Service Portal properties Custom CSS variables

Callout background color Panel background color $gtd-callout-background

Callout text color Text color $gtd-callout-content-color
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Service Portal guided tour callout colors  (continued)

Parameter Default Service Portal properties Custom CSS variables

Callout number color 
(Example: 2/5)

Text muted $gtd-callout-number-color

Callout close button (X) color Text muted $gtd-callout-close-color

Callout primary button color Primary button background 
color

$gtd-callout-active-color

Related topics

Create a portal theme

Onboarding modals
Onboarding modals  provide a wizard-like experience to introduce users to new experiences and 
applications in their ServiceNow®  Next Experience  instance.

Some onboarding modals are included by default in your instance, such as the onboarding 
modal displayed the first time you log in to an instance with Next Experience  enabled. You can 
also create your own custom onboarding modals to introduce new experiences and applications 
to users.

When you switch between dark, light or coral user interface themes, the images in Onboarding 
modals  match the theme of the instance you choose. This provides a visually cohesive 
experience.

Onboarding modals  slide example

Exploring new experiences

Onboarding modals  introduce you to new ServiceNow®  experiences through wizard-like 
interfaces in Next Experience. Learn about capabilities, benefits, and implementation 
approaches for effective user onboarding.
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Overview to Onboarding modals

Onboarding modals  are part of ServiceNow®  Adoption Services  suite, designed to introduce 
users to new experiences and applications through interactive, guided workflows. These modals 
appear as overlay windows that walk users through features, providing contextual help at critical 
moments.

Onboarding modals  support multiple content types including text descriptions, images, video 
links (YouTube and Vimeo), and interactive questions. The modal interface adapts to your 
instance's theme (dark, light, or coral), ensuring visual consistency across the user experience.

Modals can be triggered automatically on first login, when accessing specific applications, or 
programmatically through custom business logic, giving you complete control over when and 
how users receive guidance.

Benefits

Onboarding modals  provide benefits across different user populations:

Benefit Feature Users

Reduce onboarding time Step-by-step guided modals All users

Consistent user experience Theme-aware interfaces All users

Flexible deployment Programmatic triggers Administrators

Customizable content Multiple content types Administrators

Get Started

Begin using onboarding modals by following this implementation sequence:

1. Review default modals:  Navigate to All  > Adoption Services  > All Guidance  to examine the 
pre-configured onboarding modal included with Next Experience. Test the user experience to 
understand baseline functionality.

2. Plan your content:  Map out the user journey for your application or feature. Identify key 
concepts users need to learn, optimal sequence for information delivery, and decision points 
requiring user input.

3. Create guidance structure:  Navigate to All  > Adoption Services  > Create Guidance. Configure 
the guidance form with appropriate name, type (Modal), roles, and application scope.

4. Build guidance steps:  Add individual steps using the Help Guidance Steps related list. 
Choose layouts (Text, Video, Image and Text, Image and Question, or Question) and define the 
presentation order.

5. Configure launch mechanism:  Implement the programmatic trigger using UIB client scripts 
and event dispatching, or leverage automatic triggers based on application access patterns.

User Journey

The typical user journey with onboarding modals follows this pattern:

Initial trigger:  User logs in for the first time, accesses a new application, or triggers a custom 
business rule. The system evaluates whether to display an onboarding modal based on user 
profile, role assignments, and previous interaction history.
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Modal presentation:  The onboarding modal appears as an overlay, presenting the first guidance 
step. Users see the title, content (text, image, or video), and navigation controls (Next, Previous, 
or custom action buttons).

Progressive disclosure:  Users navigate through subsequent steps at their own pace.

Interactive elements:  Question-based steps collect user input through radio buttons (single 
answer) or checkboxes (multiple answers). Responses can inform subsequent content or be 
recorded for analytics purposes.

Completion:  Upon reaching the final step, users receive a completion confirmation and return 
to the application. The system records the interaction, preventing duplicate displays unless the 
modal is explicitly reset.

Configure

Plan and configure the Onboarding modals  to experience new applications.

Begin your Onboarding modals  configuration by planning, including identifying features, forms, 
and lists that your users could use additional guidance on.

Create Onboarding modals

Create your own Onboarding modals  to introduce your users to a new experience or application 
in your ServiceNow instance.

Before you begin
Role required: admin

Ensure you have:

• Planned your onboarding content, including the key concepts to cover and the optimal 
sequence for presenting information

• Identified target user roles who should see the Onboarding modals

• Prepared any images, videos, or custom HTML content to include in the modal

• Determined the application or workspace where the modal will appear

Procedure

1. Navigate to All  > Adoption Services  > Create Guidance.

2. To create your Onboarding modals, do the following:

a. On the guidance form, fill in the fields.

Guidance form

Field Description

Order Order that the guidance displays. The 
lowest number displays first and the next 
chronological number follows.

Name Name of the onboarding experience.

Type Type of guidance that appears in the UI. 
Select Modal.

Roles Roles for this guidance.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1133



Field Description

Application Application for the guidance.

Status Status of the guidance.

Active Select to enable or disable the guidance.

b. Select Submit.

3. To create embedded help guidance steps, do the following:

a. Select your guidance from the Guidances list.

b. On the Help Guidance Steps related list, select New.

c. On the form, fill in the fields.

Help Guidance Step form

Field Description

Name Name of your guidance.

Layout Selected layout of the guidance.

▪ Video

▪ Image

▪ Text

▪ Question

▪ Image and Text

▪ Image and Question

Order Order that the guidance displays. The 
lowest number displays first and the next 
chronological number follows.

Action Label Button labels that enable the user to 
navigate the guidance modal.

Application Application scope for the guidance. This 
guidance applies to the Global scope.

Guidance The guidance that this Help Guidance Step 
applies to.

d. Select Submit.

4. To create help contents for your help guidance steps, do the following:

a. Select your help guidance step in the related list.

b. On the Help Contents related list, select New.
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c. Note: 
Form fields are different for each type of guidance. Refer to the correct form for your 
guidance.

On the text form, fill in the fields.

Help Content text form

Field Description

Title Title of the help content.

Subtitle Subtitle that's displayed in the modal of the 
help content in the UI.

Type Type of guidance that's selected.

Application Application scope for the guidance.

Guidance Step Help Guidance Step that this Help Content 
is associated with. For example, Intro/
welcome, All menu, and History.

Default Help content that is the default for the 
guidance step.

Footer Footer that's displayed in the modal of the 
help content in the UI.

Provide Custom HTML Custom HTML for your help content.

Text Text that displays in the modal of the help 
content in the UI.

d. Click Submit.

e. On the video form, fill in the fields.

Help Content video form

Field Description

Title Title of the help content.

Subtitle Subtitle that's displayed in the modal of the 
help content in the UI.

Type Type of guidance that's selected.

Video Link The link for your video to display.

Note: 
Only YouTube and Vimeo are 
supported.

Application Application scope for the guidance.
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Field Description

Guidance Step Help Guidance Step that this Help Content 
is associated with. For example, Intro/
welcome, All menu, and History.

Default Help content that is the default for the 
guidance step.

Footer Footer that's displayed in the modal of the 
help content in the UI.

Provide Custom HTML Custom HTML for your help content.

Alternate Text Alternate text that displays in the modal of 
the help content in the UI.

f. Click Submit.

g. On the image form, fill in the fields.

Help Content image form

Field Description

Title Title of the help content.

Subtitle Subtitle that's displayed in the modal of the 
help content in the UI.

Type Type of guidance that's selected.

Image The image selected to display in your 
guidance.

Application Application scope for the guidance.

Guidance Step Help Guidance Step that this Help Content 
is associated with. For example, Intro/
welcome, All menu, and History.

Default Help content that is the default for the 
guidance step.

Footer Footer that's displayed in the modal of the 
help content in the UI.

Provide Custom HTML Custom HTML for your help content.

Provide Image Link The image link is displayed in the guidance.

Alternate Text Alternate text that displays in the modal of 
the help content in the UI.

h. Click Submit.

i. On the question form, fill in the fields.
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Help Content question form

Field Description

Title Title of the help content.

Subtitle Subtitle that's displayed in the modal of the 
help content in the UI.

Type Type of guidance that's selected.

Application Application scope for the guidance.

Guidance Step Help Guidance Step that this Help Content 
is associated with. For example, Intro/
welcome, All menu, and History.

Default Help content that is the default for the 
guidance step.

Footer Footer that's displayed in the modal of the 
help content in the UI.

Provide Custom HTML Custom HTML for your help content.

j. Select Submit.

k. Select New  in the Help Question related field.

Help question form

Field Description

Question The content of the question to add in the 
guidance.

Order The order of the question in the guidance.

Variant The variant of the question.

▪ Radio is selected for questions with only 
one answer.

▪ Checkbox is selected for questions with 
multiple answers.

Application Application scope for the guidance.

Help Content The Help Content that the question is 
created for.

Mandatory The question is Mandatory when selected.

l. Select New  in the Help Answers related field to create answers.

Help answer form

Field Description

Label The label for the answer.

Value The value for the answer.
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Field Description

Order The order of the answer.

Application Application scope for the guidance.

Question The question the answer is created for.

m. Select Submit.

5. Create any additional guidance that you want to build your onboarding experience.

6. When you're done building your onboarding guidance, confirm that the status of your guidance 
is set to Published  on the Guidance form.

7. On the Guidance form, select Update.

Result
Your onboarding modal is created and published. The modal contains all configured guidance 
steps with their associated help content. Users with the specified roles can now see the modal 
when it is triggered.

What to do next
Configure a launch trigger for your modal. See Launch an onboarding modal.

Launch Onboarding modals

Configure programmatic triggers to launch Onboarding modals  when to access specific pages or 
perform certain actions on their instance.

Before you begin
Role required: admin

Ensure you have:

• Created and published an Onboarding modals  with at least one guidance step

• Noted the sys_id of your guidance record (found in the URL when viewing the record)

• Identified the UI Builder  page where the modal should launch

• Access to UI Builder  and the ability to create client scripts

Procedure

1. Launch UI Builder  and navigate to the page where you want the modal to appear.

2. In the left panel, select Scripts  tab and create a new client script.

3. In the script editor, enter the following code, replacing 'YOUR_GUIDANCE_SYS_ID' with the 
actual sys_id of your guidance record:

api.emit('SN_HELP➚GUIDANCE_START_REQUESTED', 
 {guidanceId:'YOUR_GUIDANCE_SYS_ID'});

4. Save the client script.

5. In the left panel of UI Builder, select Body.

6. In the right panel, select Events  tab.

7. Under Dispatched Events, select Add.

8. In the Event name  field, enter: SN_HELP➚GUIDANCE_START_REQUESTED
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9. In the Label  field, enter a descriptive name (e.g., 'Onboarding Modal Launch').

10. Select Save.

11. Save and publish your UI Builder  page.

Result
The onboarding modal is configured to launch when users access the specified page. The modal 
will display the first guidance step and allow users to navigate through subsequent steps.

What to do next
Test the modal launch by accessing the page as a user with the appropriate role assignment. 
Verify that all guidance steps display correctly and navigation options function as expected.

Edit default Onboarding modals

Customize and edit default templates to optimize the onboarding experience and personalize 
content for your users.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Adoption Services  > All Guidance.

2. On the Guidance list, select Onboarding.

3. On the Guidance related list, select the guidance list entry that corresponds to the onboarding 
slide that you want to edit.
The list entries include Intro/welcome, Pinning, All menu, Favorites menu, History, and 
Application Pill.

4. On the form, edit the fields.

Help Guidance Step

Field Description

Name Name of the guidance.

Layout Selected layout of the guidance.

Order Order that the guidance displays. The 
lowest number displays first and the next 
chronological number follows.

Action Label Button labels that enable the user to navigate 
the guidance modal.

Application Application for the guidance.

Guidance The guidance that this Help Guidance Step 
applies to.

5. On the Help Contents related list, select the list entry associated with the guidance.
For example, Jump between things with ease  for the History guidance and Everything you 
need is right here  for the All menu guidance.

6. On the form, edit the fields.
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Help Content form

Field Description

Title Title of the help content.

Subtitle Subtitle that's displayed in the modal of the 
help content in the UI.

Type Type of guidance that's selected.

Application Application for the guidance.

Guidance Step Help Guidance Step that this Help Content is 
associated with. For example, Intro/welcome, 
All menu, and History.

Default Help content is selected as default.

Footer Footer that's displayed in the modal of the 
help content in the UI.

Provide Custom HTML Select to input custom HTML into the help 
content.

Text Text that displays in the modal of the help 
content in the UI.

7. Select Update.

Reference

Reference information for user roles and best practices when implementing onboarding modals.

User Roles

Onboarding modals require specific role assignments for configuration and usage:

Role Capabilities

admin Full access to create, edit, and delete guidance records, 
guidance steps, and help content. Can configure client scripts 
and launch mechanisms. Access to all Adoption Services 
modules.

help_content_admin Edit existing guidance content without full administrative 
privileges. Useful for content management teams maintaining 
onboarding materials.

User (any role) View and interact with onboarding modals assigned to their 
role. Navigate through steps, answer questions, and dismiss or 
complete modals.

Best Practices

Follow these guidelines to create effective onboarding experiences:

Content Design
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• Keep steps focused:  Each step should cover one concept. Limit modals to 5-7 steps maximum 
to avoid overwhelming users.

• Use clear language:  Avoid jargon and technical terms without explanation. Write for your least 
experienced user persona.

• Provide visual context:  Include screenshots or annotated images showing exactly where to 
find features. Users learn better with visual references.

• Make exit clear:  Always provide a Later  or Skip  option. Never trap users in mandatory 
onboarding that blocks critical work.

Technical Implementation

• Test across themes:  Verify modal appearance in dark, light, and coral themes. Images and text 
should remain readable in all contexts.

• Validate sys_id references:  When using programmatic triggers, ensure guidance sys_id is 
correct. Invalid references fail silently without user-facing errors.

• Set appropriate roles:  Match modal role requirements to actual user populations. Over-
restrictive roles mean users never see guidance; over-permissive roles show irrelevant 
content.

• Use descriptive names:  Name guidance records and steps clearly for maintainability. Future 
administrators should understand purpose without reading all content.

Maintenance and Updates

• Review quarterly:  Product updates and UI changes can make onboarding content outdated. 
Schedule regular reviews to maintain accuracy.

• Gather user feedback:  Add feedback mechanisms or monitor help desk tickets mentioning 
onboarding. Users will tell you what's confusing.

• Version content:  Use the Order  field and Status  field to manage content versions. Keep draft 
versions for testing before publishing changes.

• Document customizations:  Maintain external documentation of custom client scripts and 
launch mechanisms. Update sets may not capture all dependencies.

Personalize your experience
Work with various visual options for task tracking, project timelines, and homepage 
customizations.

Visual Task Boards

Navigate through forms and lists 
with this graphic interactive UI.

Timeline Visualization

Monitor projects and interact with time-
based or task-based views of operations.

Visual Task Boards

Streamline your management of lists, forms, and other task records. Visual Task Boards  presents 
an intuitive graphic interface with freeform or data-driven boards. Display records in quick-
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reference card formats, and lanes categorizing status or progress. Delegate specific team 
members to view and alter records, with access control rules for card visibility and task board 
management.

Timeline Visualization

Track activities in your organization over time using Timeline Visualization. Interactive month-
based two-dimensional (2D) and task-card-based three-dimensional (3D) views provide 
comprehensive assessment of operations and strategies in your business. Personalize visual 
records, manage project portfolios, and evaluate present and future projects.

Visual Task Boards
Visual Task Boards (VTB) transform the navigation of lists and forms into an interactive graphical 
experience.

Visual Task Boards  Overview
https://player.vimeo.com/video/1171947527?
h=9f62b408f3&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Note: 
Core UI  or Next Experience  is required to use Visual Task Boards.

Get started

Explore

Learn about Visual Task 
Boards concepts and features.

Activate

Activate Visual Task Boards.

Use

Create, modify, delete, view, share, 
and customize Virtual Task Boards.

Reference

See details about domain separation, 
supported browsers, and components 

that are installed with Virtual Task Boards.
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Troubleshoot and get help

• Ask or answer questions in the Visual Task Boards community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Visual Task Boards

Visual Task Boards  provide a visual representation of the work that needs to be done, allowing 
team members to easily collaborate, track and prioritize tasks. You can use Visual Task Boards 
in a variety of contexts, including project management, personal or team task management, and 
employee onboarding.

Visual Task Boards  overview

Teams can easily manage their workloads by assigning and reassigning tasks, updating task 
status, and setting priorities. This helps to improve productivity and reduce the time it takes to 
complete tasks. Any user can use task boards, regardless of role, though access control rules 
(ACLs) may limit which cards each user can see.

The Visual Task Board interface provides a graphic-rich environment suited for managing and 
collaborating on records. For example, a support manager might create a board for a team to 
track their assigned incidents by state in real time.

You can customize Visual Task Boards  to fit the unique needs of a team or organization. Teams 
can create their own workflows, labels, and columns to represent their specific process, making 
it easier to manage tasks and achieve their goals. Access Visual Task Boards  from any device, 
including smartphones and tablets. This allows team members to stay connected and up to date 
with their tasks.

Visual Task Boards  benefits

Anyone on the team can be given access to a Visual Task Board.

Benefit Feature

Teams can easily manage their workloads by assigning and 
reassigning tasks, updating task status, and setting priorities. 
This helps to improve productivity and reduce the time it takes 
to complete tasks.

Create a visual data driven board for team collaboration. You 
can add your individual tasks and add tasks from a form or a 
list too, modify lanes, add or remove members.

Creating Visual Task Boards

View and share board details or in a list. Add as favourite, 
share or create a connect conversation.

Viewing and sharing Visual 
Task Boards

Customize and configure Visual Task Boards. Customizing and configuring 
Visual Task Boards

You can edit card details, add attachments, configure card 
view and card limit, label, assign, archive and move cards.

Working with Visual Task 
Board cards

Create checklist and checklist template. Configure task types 
that can be created.

Visual Task Board checklists
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Types of Visual Task Boards

You can create guided Visual Task Boards, which are driven by data in your ServiceNow® 

instance. You can also create freeform boards that display a variety of information, or flexible 
boards, which combine both types.

There are three types of Visual Task Boards.

Board 
type

Description

Freeform 
boards

Display all types of task records, including personal tasks. Members of freeform 
boards can add and remove task cards and lanes.

Freeform boards are indicated with the Freeform board icon .

Flexible 
boards

Display tasks that match a filter against a particular table. Members of flexible boards 
can add task cards. Cards are removed automatically when the tasks no longer 
match the filter conditions. Members can define custom lanes, similar to a freeform 
board.

Flexible boards are indicated with the Flexible board icon .

Guided 
boards

Similar to flexible boards except that guided board lanes correspond to field values 
and cannot be edited in most cases.

Guided boards are indicated with the Guided board icon .

Sample Visual Task Board dashboard

All boards have the displayed elements. The color of a card represents the color you choose in 
the color palette for that board.

Elements of Visual Task Boards

Visual Task Boards  contain cards that represent a task. These cards are arranged in lanes based 
on the criteria you choose to sort them.

Visual Task Boards  contain the elements shown in the image below. Each element is described 
in the following table.
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Sample Visual Task Board elements

Task board elements

Element Description

Board header Displays the board name in the title bar. You 
can rename the board by double-clicking on 
the board name.

Filter the tasks in the board by:

• Entering the title or number of the task card

• Selecting an option in the Due By  list

Lanes
Organize cards on a board into vertical groups. 
These groups often represent the status of the 
task, such as To Do, Doing, and Done.

When using a guided board, each lane 
represents a possible field value. For example, 
a board on the Incident table can display one 
lane for each State  value such as New, Active, 
or Resolved.

Users can move cards from one lane 
to another to update the task that card 
represents.

Cards
Represent individual tasks that you can assign 
to users. You can add comments, attachments, 
and labels to cards. Each card is tied to a task 
record; updating one immediately updates 
the other. For freeform boards, each card 
represents a personal task.
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Task board elements  (continued)

Element Description

For flexible and guided boards, each card 
represents a record from the list that board 
was created from. For more information, see 
Create Flexible and Guided boards.

Quick panel Displays labels and users associated with 
the board. Board members can use the 
quick panel to quickly label or assign tasks. 
Members can also configure  what appears in 
the quick panel.

Visual Task Board tools Displays board information, board members, 
the board activity stream, and board labels.

Swimlanes Organize cards on a board into horizontal 
lanes. These lanes often represent the user 
assigned to a task. You can add any number of 
swimlanes to the board, and move cards from 
one user to another easily.

Visual Task Board tools

The task board tools area in a Visual Task Board contains several tabs, each represented by an 
icon.

Click an icon to open the tab. Click the same icon again to hide the tab. The tabs you see for 
each conversation depend on the conversation type and other conditions.

Conversation tool tabs

Tab 
icon

Tab name Description

Info Contains the following information about the task board:

• Board Name

• Board type

• Board Owner

• Number of members

• Number of assignees

• Number of lanes

• Number of tasks

• Table name

• Edit Filter (visible on data driven boards only)

• Lane field (visible to the board owner, on data driven boards only)

• Swimlane field - To change Swimlane field for the board

• Due Date field - To change the Due Date field for the board.

• URL
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Conversation tool tabs  (continued)

Tab 
icon

Tab name Description

Members Lists all members and assignees of the board. You can add or remove 
board members, promote assignees to be members, and filter the board 
by member or assignee.

Labels Use labels to visually distinguish tasks on the task board. Filter board 
contents by toggling the label. You need to enable labels  before being 
able to use this tab.

Activity Displays all of the activity for cards on the board.

Configuration Configure the settings for the task board. This setting is only available for 
the board owner. For more information, see Customize the look and feel of 
a task board.

Visual Task Board SLA indicators

SLA (service-level agreement) indicators alert board members if any cards on the board have 
breached SLAs.

Board members can enable SLA indicators from the board configuration menu. The setting 
applies to the current user only.

Enable SLA

When SLA indicators are enabled, a status bar appears on each card that has an associated 
SLA. If any cards have breached SLAs, an alert appears at the top of the board and a filter option 
appears in the quick panel. The indicator displays the elapsed percentage of the SLA. If there are 
multiple SLAs associated with a task card, the indicator displays the status of the SLA with the 
greatest elapsed percentage. For more information on SLA see .
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Visual Task Board with SLA indicators enabled

Related topics

Service Level Management concepts

Visual Task Board accessibility

Accessibility improvements in Visual Task Boards  include skip links and the ability to view card 
details.

Skip links

Skip links allow you to tab directly to the main content on a page. When accessibility mode is 
enabled, task boards include a skip link to view tasks as a list. The View tasks as a list  skip link 
switches all the task cards to the table view. For more information on viewing task boards in a list 
view, see View a Visual Task Board in a list.

View card details

With accessibility mode enabled, visual indicators appear on task cards that users can tab to in 
order to open card details. For more information, see View card details in a Visual Task Board.

View card details in a Visual Task Board

With accessibility mode enabled, tab through cards in a task board. Use the card details button 
to view task card details.

Before you begin
Enable accessibility from the General tab of the system settings menu.
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open an existing task board.

3. Press the Tab key to navigate through the board to get to a task card.
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4. Press the Tab key to navigate through the card until the Open Card Details button appears.

Card details

5. Press Enter  to open the card.

6. To exit the card, press Escape.

Activate Visual Task Boards

Visual Task Boards are active by default on new instances. For upgraded instances, you can 
activate the Visual Task Boards plugin [com.glide.ui.vtb] if you have the admin role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Visual Task Boards plugin (com.glide.ui.vtb) using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Using Visual Task Boards

Create, view, and edit freeform, flexible, and guided Visual Task Boards, and add users to these 
boards as members.

As a member of a Visual Task Board, you can view and share the board, customize card views, 
assign and move cards, and create checklists.

Getting started with Visual Task Boards

To find Visual Task Boards, navigate to Self-Service  > Visual Task Boards. If the application does 
not display after a general search, contact your admin.

https://player.vimeo.com/video/952369652?
h=e5240fa717&badge=0&autopause=0&player_id=0&app_id=58479

Creating Visual Task Boards

You can create, view, and edit freeform, flexible, and guided Visual Task Boards, and add users to 
these boards as members.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1149

https://www.servicenow.com/docs/bundle/zurich-platform-administration/page/administer/plugins/task/find-components.html
https://www.servicenow.com/docs/bundle/zurich-platform-administration/page/administer/plugins/task/find-components.html
https://www.servicenow.com/docs/bundle/zurich-platform-administration/page/administer/plugins/task/find-components.html
https://player.vimeo.com/video/952369652?h=e5240fa717&badge=0&autopause=0&player_id=0&app_id=58479
https://player.vimeo.com/video/952369652?h=e5240fa717&badge=0&autopause=0&player_id=0&app_id=58479


To find Visual Task Boards, navigate to Self-Service  > Visual Task Boards. If the application does 
not display after a general search, contact your admin.

Freeform Visual Task Boards

You can add personal task cards directly to lanes on a freeform board. You can also add other 
kinds of task cards to a freeform board from a list or form.

Create a freeform Visual Task Board

You can create freeform Visual Task Boards  (VTBs) for tracking any kind of task or project.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Next to My Task Boards, click New, or if you have never created a task board before, click 
Create New Visual Task Board.

3. From the Create New Board window, click Freeform.
A new task board opens with the default freeform lanes, To Do, Doing, and Done.

4. Click the board name and enter a new name.

What to do next

• Add a personal task to a freeform Visual Task Board

• Add a task to a freeform Visual Task Board from a form

• Add a task to a freeform Visual Task Board from a list

Add a personal task to a freeform Visual Task Board

You can add cards directly to a freeform board lane. These cards are called personal tasks and 
represent records on the Private Task [vtb_task] table.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Select a freeform board to add a personal task.

3. Select Add Card  at the bottom of a lane.
A new task card appears in the lane.

4. Enter a short description for the new task card.

5. To save the card, select another area of the board or press Enter.

Add a task to a freeform Visual Task Board from a form

You can add a task card to a freeform board from any table that extends Task. These cards 
represent records on whichever table you add them from.

Before you begin
Role required: none
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About this task
You can add cards from multiple task tables, such as Incident or Problem, to the same freeform 
board.

Procedure

1. Open a task record, such as an incident.

2. Click the menu icon ( ) or right-click the form header to show the form context menu.

3. Select Add to Visual Task Board.

4. Click the name of the board you want to add the card to.

5. To view the board, click the board name in the confirmation message.
The task appears in the first lane by default.

Add a task to a freeform Visual Task Board from a list

You can add a task card to a freeform board from any table that extends Task. These cards 
represent records on whichever table you add them from.

Before you begin
Role required: none

About this task
You can add cards from multiple task tables, such as Incident or Problem, to the same freeform 
board.

Procedure

1. Navigate to a list of task records, such as All  > Incident  > Open.

2. Perform either of the following actions.

Option Description

Add one task
Right-click a record and select Add to Visual 
Task Board.

Add multiple tasks

a. Select the check boxes beside the records 
you want to add.

b. In the column context menu, select Add to 
Visual Task Board.

3. Click the name of the board you want to add the card to.
A confirmation message appears.

4. To view the board, click the board name in the confirmation message.
The task appears in the first lane by default.

Data driven Visual Task Boards

You can add a task to a flexible or guided task board.

Create a data driven Visual Task Board

You can create a flexible or guided data-driven Visual Task Board (VTB) for any table that extends 
Task, such as Incident or Change.
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Before you begin
Role required: none

About this task

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Next to My Task Boards, click New, or if you have never created a task board before click 
Create New Visual Task Board.

3. From the Create New Board window, click Data Driven Board.

4. From the Task Table list, select a base table of tasks on which to base your board, for example, 
an incident table.

5. Optional:  From the Lane Field list, select the field you want to use for the lane headers.

(Optional) To create a flexible board with editable lane headers, select None.

The type of board that is created and the lanes that appear on the board depend on which 
type of column you select. If you select a reference or choice column, the board is a guided 
board. Each lane in a guided board represents one possible value for that column and the 
cards appear in the appropriate lane. For example, if you create a guided task board for 
incidents using the State  column, the board shows one lane for each incident state, such as 
New  or Closed. If you select a column that is not a reference or choice, the board is a flexible 
board  and the board shows the default lanes, To Do, Doing, and Done, with all cards in the To 
Do  lane.

6. Optional:  Create a filter  to show only the records you want to work with.
For example, you might filter out incidents that are not assigned to you.

(Optional) Any card that no longer fits the parameters of the filter is automatically removed 
from the task board.
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7. Optional:  Click the board name and enter a new name.

Note: 

◦ For guided boards created from choice fields, such as State, the system creates a lane 
for each possible choice value. For guided boards created from reference fields, the 
system creates a lane only for each value in use by a task card. Lanes are added as 
needed if the reference field values change.

◦ Be sure to enable Card View for more options. Clear the option Show Compact Cards  > 
Show Card Info.

What to do next
Add a task to a flexible or guided Visual Task Board

Add a task to a flexible or guided Visual Task Board

Cards in a flexible or guided board represent records on whichever table the board is associated 
with.

Before you begin
Role required: none

Procedure

1. In a lane header, click the lane menu ( ) and select Add Card.
Alternatively, click Add Card  at the bottom of a lane.

Fields are populated based on any filter conditions for the board and, for guided boards, the 
lane you add the card to.

Consider the example of a guided board that shows incidents with the Software  category, 
with a lane for each assignee. If you add a card to the ITIL User  lane, the new incident record 
Category  and Assigned to  fields are automatically set to Software  and ITIL User.
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2. Complete the form and click Submit.
A new task card appears in the lane.

Add or modify Visual Task Board lanes

Any board member can change the names and add new lanes to accommodate the task 
workflow you want to track. When you create a freeform or flexible task board, it includes the 
default lanes To Do, Doing, and Done.

Before you begin
Role required: none

About this task
Unlike guided boards, the lanes on a freeform or flexible task board do not match possible field 
values.

Note: 
You cannot remove lanes from guided boards.

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open a task board.

3. Perform any of the following actions.

Option Description

Create a new lane

a. Scroll past the last lane and click Add Lane.

b. Enter a title for the lane, then press the En­
ter key.

The Add Lane  option is always available for 
freeform and flexible boards. It is available for 
guided boards only if the lanes are based on 
a reference field, such as Assigned to.

Edit a lane name
a. Select the lane name in the lane header.

b. Enter a title for the lane, then press the En­
ter key.

Rearrange lanes

Select a lane header and drag the lane to the 
desired drop zone. To cancel the move, press 
the Escape key while you drag the lane.

You can also change the lane order from the 
board configuration menu.

Hide a lane a. Select the lane menu ( ) in a lane header.

b. Select Hide Lane.
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Option Description

Unhide a lane

a. Select the configuration menu ( ).

b. Select Advanced Settings.

c. Select the hidden lane in the Lane Configu­
ration  section.

Delete a lane

a. Select the lane menu in a lane header.

b. Select Delete Lane.

c. In the confirmation dialog box, click Delete. 
When you delete a lane on a freeform or 
flexible board, all the cards in the deleted 
lane are archived.

The Delete Lane  option is always available for 
freeform and flexible boards. It is available for 
guided boards only if the lanes are based on 
a reference field, and only for lanes that con­
tain no cards.

Exclude Child Table Records

a. Select Info  icon (

b. Under Structure  menu, select Exclude 
Child Table Records

The Child table lanes and records are ex­
cluded.

Note: 
Exclude Child Table Records  check 
box is only visible for choice type field.

Note: 
When moving the card from lane to another, if you get an error message while having 
write access to the record then create a system property glide.vtb.enable_list_edit_acl 
and set it to false.

Add or remove a Visual Task Board member

You can add and remove task board members using the members tab of the activity stream. You 
can also promote assignees to board members.
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Before you begin
Role required: none

About this task
Only members of a task board can access the board. Any board member can add or remove 
other members.

Procedure

1. On a Visual Task Board, open the task board tools.

2. Click the members tab.

3. Perform one of the following actions.

Option Description

Add a member
a. In the Users  section, click Add Members.

b. Enter a user's name or select a user from 
the drop-down menu.

Remove a member
a. In the Members  section, point to a user.

b. Click the remove icon ( ).

Promote an assignee to a member
a. In the Assignees  section, point to a user.

b. Click the upward arrow icon.

Promote all assignees to members In the Assignees  section, click Promote All.

Delete a Visual Task Board

You can delete any task board that you own.

Before you begin
Role required: none

About this task
Deleting a board does not impact the underlying task records. However, you cannot recover a 
board after you delete it.

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Under Boards you own, hover over the board and click the delete icon (X).

3. In the confirmation dialog, click Delete.

Viewing and sharing Visual Task Boards

View details about Visual Task Boards, view them as a list, and share them with others.

View Visual Task Boards  details

You can display the key information about any Visual Task Board.
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Before you begin
Role required: none

Procedure

1. Navigate toAll  > Self-Service  > Visual Task Boards.

2. Select a task board.

3. Click the board information icon ( ).

Result
The board information displays.

View a Visual Task Board in a list

You can view a Visual Task Board in the list view using the board information option.

Before you begin
Role required: none
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Procedure

1. Open a task board.

2. From the task board tools, click the board information icon ( ).

3. Click View List  at the bottom of the information panel.
The cards from the board open in the list view.

Note: 
The freeform board list view only shows cards made by the board and no other tasks that 
might be added manually.

Add a Visual Task Board as a favorite

Add Visual Task Boards  you access frequently to the application navigator using the favorite 
option.

Before you begin
Role required: none

About this task
Adding a board as a favorite is only available in Core UI.

Procedure

1. Navigate to All  > Self Service  > Visual Task Boards.

2. From the board that you want to favorite, select the information icon from the board tools.

3. Select the star icon.

Share a Visual Task Board in a Connect conversation

You can share a Visual Task Board in a Connect Chat  or Connect Support conversation.

Before you begin
Role required: none
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Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Drag a task board to a Connect mini window.
A link to the task board appears in the conversation. The task board is also listed in the 
conversation tools, which are visible in the Connect workspace. Only conversation members 
who are members of the board can access it. If you share a task board in a Follow a record in 
Connect , it appears as a URL in the record activity stream.

Related topics

Connect

Visual Task Boards

Create a Connect conversation from a Visual Task Board

Create a Connect Chat conversation from a Visual Task Board to collaborate with board members 
and keep track of activity as it happens.

Before you begin
Role required: none

About this task
When you create a conversation from a task board, all the board members become members of 
the conversation. The members are synchronized between the task board and the conversation. 
For example, if you remove a user from the conversation, the system automatically removes the 
user from the board as well.

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open a task board.

3. In the board header, click the connect with board members icon ( ).
The system automatically opens a record conversation for the board. Each board member 
becomes a member of the conversation.

Related topics

Connect Chat

Visual Task Boards

Customizing and configuring Visual Task Boards

You can customize the information in a Visual Task Board, as well as the way this information is 
displayed.

You can customize individual Visual Task Boards  to display your tasks in whatever way works 
best for you. You can change the look and feel of the board, add labels and swimlanes, set lane 
limits, or modify the query.

Customize the look and feel of a task board

By default, the visual task board inherits the look-and-feel from the user's Theme preference. You 
can, however, configure several options in the Visual Task Boards  to customize the look-and-feel 
of the board.

Before you begin
Role required: none
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Procedure

1. From the task board tools, click the menu icon ( ).

2. Click Advanced Settings.

3. In the Theme  section, select a color from the palette.
The selected theme is applied to the background of the board, lane header, add card button, 
quick filter, tab header, quick panel, and board header. It also appears as the color for the 
board on the My Task Boards page. This setting applies only to the boards of the user.

Visual Task Board color palette

4. In the Quick Panel section, toggle the options to customize the quick panel.

Note: 
Unless otherwise noted, these settings apply to the current user only.

Quick panel options

Option Description

Show Panel Option for making visible on the board.

User Names User names that appear next to user avatars in the quick panel.

Show 
Labels Labels that appear on cards and in the quick panel.
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Option Description

Note: 
The setting applies to all users.

Label 
Names

Label name that appears beside the colored icon for that label in the quick 
panel.

Note: 
This setting is available only when you enable Show Labels.

When all these options are enabled, a quick panel resembles the following illustration.

5. In the Card Configuration section, toggle the options to customize the appearance and 
information of cards.

Changes to the cards apply to the current user only.

View options

Option Description

Show 
Compact 
Cards

Decreases the lane width and card information. Thumbnail images do not 
appear on the card.

Show Card 
Info

Displays card information on each card. Card information typically includes 
details like the task state, date opened, and last user to update it.

This setting is available only when Compact Cards  is disabled.

Show Card 
Attachment

Cards display the first image attached to that card as a thumbnail.

This setting is available only when Compact Cards  is disabled.

Show SLAs SLA status indicators appear on cards and alerts appear when one or more 
card has a breached SLA. SLA status indicators are hidden when Compact 
Cards  is enabled.

This setting is available only when SLAs are associated with the tasks on the 
board.

6. Under Advanced Settings, in the Lane Configuration section, show or hide lanes by selecting 
or clearing the check box for each lane.
This setting is a user preference.

Related topics

Visual Task Board tools

Add or remove a Visual Task Board member

Sort Visual Task Boards

You can sort Visual Task Boards  using criteria that you create with a Sort-Filter option, grouping 
items by properties to help organize your cards.
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Before you begin
Role required: admin

About this task
Only the owner of the board can create the sorting criteria, and add, edit, or delete the criteria. 
The criteria appear as "read-only" for other users.

Note: 
The procedure is slightly different for Data Driven and Freeform boards. The instructions 
below contain both options.

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. On the My Task Boards page, select New.

3. For a Data Driven  board, follow these steps.

a. From the Create New Board window, select Data Driven Board.

b. Fill out the fields with your choices and then select Next.

c. Select Add sort, choose the conditions you want from the fields and then select Create.

d. In the Add Sort window, choose your sorting order and then select Save.
Your criteria displays. You can edit your sort order here, or add new criteria. You can also edit 
your choices in the navigation pane on the right.

4. For a Freeform Board, follow these steps.

a. From the Create New Board window select Freeform Board.

b. Create task cards for the board.

c. Select the info icon ( ).
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The sorting criteria and filtering appear in the Info navigation pane. 

You can edit your sorting criteria for both Freeform and Data Driven boards by selecting the 
Edit Filter and Sort  button.

Configure Visual Task Boards  labels

Labels help categorize tasks and visually distinguish them on the task board. You can disable or 
rename labels using the labels tab of the activity stream.

Before you begin
Role required: tags_admin and global_tags_creator

About this task
Every board has seven labels by default.
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Board members can edit the labels on a board. All the labels are visible on the Quick Panel 
under Labels

Procedure

1. From the task board tools, click the Labels  tab.

2. Turn on the Show Labels  button if it is turned off.
You can see seven default labels.

◦ Users with global_tags_creator role can add labels to the board and rename the label.

◦ To add labels, click Add Labels  . Newly added label remains in off state by default. You 
can assign any color or no color to the label. To rename the label, click the label text and 
enter new value.
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◦ To rename labels, click on the label and change the name of the 

label.

◦ To change the color of the label, click the Select color icon  beside the label. Select the 
color of your choice from the color picker, and then click Save.

.

◦ To disable or enable a specific label, toggle the button next to the label. To turn on or turn 
off a specific label, toggle the button next to the label. Only turned on labels show up in the 
quick filter and can be applied to a card
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◦ The board owner can delete the label by clicking Delete Label  icon.  next to the label.

◦ To filter the cards by labels, type the Label name in the Search bar 

or click Add to Filter  icon against the label. Once 
you filter by the label, you can only see cards with that label.

Labels on Card Details Page

When user clicks the card, the card opens with the details of the card. It contains all the 
applied labels under Details  tab.

Under the Labels  tab, the toggle button for applied labels is On and Off for the labels that are 

not applied.

Note: 
The table  label can also be used for Tags.

Configure a Visual Task Board with swimlanes

Swimlanes enable you to create an environment with horizontal lanes in addition to vertical 
lanes. Swimlanes use only compact cards in Visual Task Board.
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Before you begin
Role required: none

About this task
You can add swimlanes in all types of Visual Task Boards. For more information see Add or 
modify Visual Task Board lanes.

When you select swimlanes in Visual Task Boards, you can do the following:

• Name and rename the swimlanes.

• Move the tasks horizontally and vertically from one user to another.

• Drag the cards across swimlanes.

• Reorder swimlanes by dragging them or from Lane 

Configuration.

• Collapse and expand swimlanes.

Procedure

1. Navigate to All  > System Definition  > Self-service  > Visual Task Boards.

2. Click New  and select the board type.

◦ Freeform Board

◦ Data Driven Board

3. Configure swimlanes in the boards.

◦ In a freeform board, activate the swimlanes by sliding the Swimlanes  toggle switch in the 
Info  tab.

The following figure shows a sample freeform board created with swimlanes.
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◦ In a data driven flexible board, do the following:

a. Select None  in Vertical Lane Field  from the drop-down.

b. Click Next  and slide the toggle under the Info  tab to the right.

The following figure shows a data driven guided board created with swimlanes.
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◦ In a data driven guided board, select Vertical Lane Field  and Swimlane Field  while creating 
the board. You must have created a freeform board in order to create a guided board.

You can also add swimlanes to the existing guided board by selecting Swimlane Field  under 
Info  tab in the board.

Modify the query or lane field for an existing Visual Task Board

For flexible and guided Visual Task Boards, you can edit the board query or lane field. This ability 
enables you to change the board contents while preserving the member list, board configuration 
settings, and, if applicable, Connect Chat conversation history.
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Before you begin
Inform the board members that you plan to change the board query or lane field. If you or any 
members have manually sorted cards within a lane, the order may be reset.
Role required: none, but you must be the board owner

About this task
The board query consists of filter conditions that determine which tasks the board tracks. For 
example, you might edit the query so the board shows only active incidents, rather than all 
incidents.
The lane field is the field on the underlying table that defines the lanes. For example, you might 
change the lane field so the lanes represent incident states, rather than assignees. This change 
is called a lane field pivot. Lane field pivots also make it possible to convert a flexible board to a 
guided board or vice versa.

Procedure

1. Open a Visual Task Board.

2. Select the information icon ( ) by the board name.

3. Perform one of the following actions.

Option Description

Edit the board query

a. Under Board Filter, selectEdit Filter  to 
open the condition builder.

b. Add and remove conditions as needed to 
edit the query.

c. Select Save.

Change the lane field

a. Select the Vertical Lane Field  picker and 
select a field or the None  option.

Guided boards have the Vertical Lane 
Field  set to a field, such as State. Flexi­
ble boards have the Vertical Lane Field 
set to None. You can change the Vertical 
Lane Field  value accordingly to change the 
board type.

b. In the confirmation dialog, select OK.

The board reloads to reflect the changes.

Set lane limits on a Visual Task Board

You can set a limit to the number of cards added to a lane on a Visual Task Board. If the limit is 
not set, any number of cards can be added to a lane by default.

Before you begin
Role required: admin

Procedure

1. Open a Visual Task Board.

2. Click the More icon ( ) on the lane header.
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3. Select Set Lane Limit. Set Lane Limit for <name of the lane>  window appears.

4. Enter the number you want to set for the specific lane.
Leave blank, if you want set no limit to the lane.

5. Click Save.

Result

The number appears on the lane header. If the 
number of cards exceeds the set limit, the Red symbol appears on the lane header for all the 
board members.

If a card is moved to a lane with exceeded WIP lane limit, an error message appears at the top 
of the page. The member who moves a card to the lane with exceeded limit can view the error 
message.

Working with Visual Task Board cards

Visual Task Board task cards can represent a personal task or a record on a table. You can add 
task cards, edit task card details, add labels to cards, and access the underlying task record the 
card represents, depending on the board type.

Task cards are used to do the following:

• Represent tasks in a single view

• Update and make changes to tasks

• Drag and drop cards

• Customize labels

Note: 
Each board can display up to 1,000 cards by default. When the number of tasks exceeds 
the maximum, a warning appears and the system determines which cards to show by most 
recent update time. Administrators can configure a different maximum card limit. For details, 
see Configure the card limit for Visual Task boards.

Edit Visual Task Board card details

Edit the details of the card if you need to assign tasks, add comments, change the due date, or 
change other features of the card.

Before you begin
Role required: none

About this task
You can edit various card details. Updating these values also updates the underlying task record.
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Sample Visual Task Board card

Procedure

1. Open the task board from the My Task Boards  dashboard.

2. Click a card on the board.
The details for the card appear in a pop-up window.

3. Modify the card details.
Possible modification actions include:

◦ Rename the card by clicking the card title and providing the new name.

◦ Modify the short description.

◦ Add comments or work notes in the activity stream.

◦ Edit the users assigned to tasks.

◦ Add a label to the card by selecting one or more of the available labels.

◦ Add or edit the Due Date.If the completion of a task exceeds the due date, the date appears 
in red.

Due date in future Due date has passed

◦ View attachment by disabling Show Compact Cards  from Configuration.

◦ Add or remove file attachments.
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◦ Archive the card (freeform boards only). Once archived, the card is not visible in active 
items.

◦ Move the card to a different board (freeform boards only).

Add an attachment to a Visual Task Board card

You can add an attachment to a record within a Visual Task Board.

Before you begin
Role required: none

About this task
Adding an attachment to a task card also adds the attachment to the underlying task record.

Add attachment

Procedure

1. Click a card.

2. Click the attachment tab ( ).

3. Click Add Attachment  and select a file to add as an attachment.

Configure the card view on a Visual Task Board

Configure the fields that appear on a card in a task board.

Before you begin
Role required: admin
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Procedure

1. Navigate to the form you want to configure fields for.

2. Select the Additional actions icon from the header( ), and then select Configure  > Form 
Layout.

3. Under the Form view and section, select the VTB view.
You may need to create a VTB view for the form. For more information, see Create and delete 
views.

4. Select the fields to appear on the card by adding or removing the fields from the Selected 
column.

5. Select Save.

Configure the card limit for Visual Task boards

Freeform and data driven boards can display up to 1,000 cards by default. You can change the 
default card limit by adding a system property.

Before you begin
Role required: admin

About this task
You can set card limit for both Freeform board and Flexible and Guided board in Data Driven 
board.

Procedure

1. Add a new system property  with the following field values:

Field Value

Name glide.vtb.board_max

Type integer

2. Set the Value  to the maximum number of cards allowed for each board.

Note: 
Performance degradation may occur if you set the Value  to a number greater than 1,000, 
especially on tablet devices.

Label a Visual Task Board card

Labels help categorize tasks and visually distinguish them on the task board.

Before you begin
Role required: none

Enable  labels for the board.

About this task
You can filter the visible tasks to show only those with certain labels. Labels appear on cards as 
colored dots.
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Task card labels

You can add one or more labels to a task card.

Procedure

Do one of the following actions.

Option Description

Add a label to a card from the quick panel

a. Drag a label from the quick panel directly to 
a task card.

b. Drop the label in the drop zone.

Add a label to a card from the card details

a. Open the card details for a task.

b. Click the details tab ( ).

c. Under Labels, select one or more labels. 
Point to a label to display its name.

d. Close the card detail pop-up window.

What to do next
You can use configuration options to rename or disable  labels or to hide  labels altogether.

Assign a Visual Task Board card to a user

Assignees represent ownership of task cards and the associated records. Each task card can 
have one primary assignee and multiple additional assignees.

Before you begin
Role required: admin

About this task
You can filter the visible tasks on a board to show only tasks assigned to a certain user. 
Assignees appear on cards as avatars.
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Task card assignees

When a card changes lanes, all the assignees receive an email notification.

For flexible and guided boards, the primary assignee corresponds to the underlying task's 
Assigned to  field. For example, on a board created from the Incident table, if you add Joe 
Employee as the primary assignee for a card, the associated incident is assigned to Joe. Note 
that assignment rules on the associated table may restrict who you can make the primary 
assignee of a card. If you attempt to assign a task card to a user in a way that violates an 
assignment rule, a notification appears and the assignment does not take place.

Note: 
Assignees are not automatically granted access to the board. Only members can access 
the board.

Procedure

Do one of the following actions.

Option Description

Add an assignee from the quick panel

a. Drag a user's avatar from the quick panel di­
rectly to the task card.

b. Drop the avatar in the Primary  or Additional 
drop zone.

Add an assignee from the card details

a. Open the card details for a task.

b. Click the assignees tab ( ).

c. Click Add Primary Assignee  or Add Addi­
tional Assignee. The Add Primary Assignee 
option is not available if there is already a pri­
mary assignee.
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Option Description

d. Select a user.

e. Close the card detail pop-up window.

The system sends an email notification to inform the new assignee of the change.

Archive a Visual Task Board card

Archiving a card is a non-destructive way to remove a card from a freeform Visual Task Board. 
You can archive cards you are no longer working on to reduce visual clutter.

Before you begin
Role required: none

About this task

Note: 
You can only archive cards on a freeform board.

Procedure

Perform one of the following actions.

Option Description

Archive one card from the lane view

1. Point to a card and click the X  icon that ap­
pears in the corner.

2. In the confirmation dialog, click Archive.

Archive one card from the card details

1. Click a card and view the Details  tab.

2. Under Tools, click Archive.

3. In the confirmation dialog, click Confirm.

Archive all the cards in a lane

1. In the lane header, click the more options 

icon ( ).

2. Select Archive All Tasks.

3. In the confirmation dialog, click Archive.

What to do next

• To see all archived cards for the current board, from the board navigation panel, open the 

board information menu ( ) and click View Archived Tasks.

• To restore an archived card, point to it and click Restore.

Access a task record from a Visual Task Board card

You can open the form view of any task card. Viewing a task record on a form allows you to see all 
fields for that record, including fields that are not visible in the card details.
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Before you begin
Role required: none

About this task
Access a task record using one of the following options.

Procedure

• Access the record from the task card by clicking the record number on the task card.

• Access the record from the card details by doing the following:

1. Open the card details for a task.

2. Click the record number in the header.

Move a Visual Task Board card to a different lane

You can move a card from one lane to another on a Visual Task Board.

Before you begin
Role required: none

About this task
When you move a card to a different lane on a guided board, the field on which the lanes are 
based is updated to reflect the new lane value.

Procedure

1. Open a Visual Task Board.

2. Select a card and drag it to a different lane.
To cancel the move, press the Escape key while you drag the card.

Note: 

All mandatory fields on a record must be filled in to move the associated card to a new 
lane. For example, assume you have a guided board based on the Incident [incident] 
table, with a lane for each State. The Close code  and Close notes  fields become 
mandatory when the State  changes to Closed. If you attempt to move an incident card 
from the New  lane to the Closed  lane, a pop-up view of the form appears and prompts 
you to fill in the mandatory fields.

If you get an error message saying You do not have the permission to modify this record, 
create system property glide.vtb.enable_list_edit_acl  and setting it to 
false.

Move a freeform Visual Task Board card to a different board

You can move a card from one freeform board to another.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Self-Service  > Visual Task Boards.

2. Open a task board.

3. Open the card details.

4. In the details tab ( ), select Move.
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5. In the pop-up window that appears, select the board and lane to move the card to.
The board selection list displays freeform boards only.

Visual Task Board checklists

Checklists help you track the progress of tasks on your Visual Task Board.

Checklists are available as a tab in the card details.

Sample checklist

You can add, remove, or rearrange checklist items. You can also save a checklist as a template 
for future use on other cards. Any user can create or edit a checklist. When the compact card 
view is disabled, the task card displays a progress bar to show how many items are complete.

You can also use checklists with task records in the standard interface. For more information, see 
Checklists.

Create a checklist for a Visual Task Board card

You can create a unique checklist for each Visual Task Board card or create a task from a 
checklist item.

Before you begin
Role required: none

Procedure

1. Open the card details for a task.

2. Click the checklist tab ( ).

3. Click Add Item.

4. Enter text for the checklist item.
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5. Press the Enter key to add the checklist item.

6. Create as many additional checklist items as desired.

7. To delete a checklist item, click the minus (-) icon.

8. To reorder checklist items, click the drag icon ( ) and drag a checklist item to a different 
position in the list.

9. To create a task from a checklist item:

a. Point to a checklist item and click the create task icon ( ).

b. Select the type of task you want to create.
An administrator can configure which task types are available.
The new task record appears in a pop-up window. The short description is automatically 
populated with the checklist item text.

c. Fill in the form with additional detail as necessary.

d. Click Update.

Create a checklist template for Visual Task Board tasks

A template saves time by creating checklist items automatically. You can add, edit, or remove 
checklist items without impacting the template.

Before you begin
Activate Visual Task Boards.

Role required: none

About this task
There are two ways that you can create a checklist template:

• In the Visual Task Board interface,

• or in the ServiceNow AI Platform.

Procedure
Adding a checklist template in Visual Task Board

1. In Visual Task Board, open the card details for a task.

Note: 
You cannot give a checklist template a name when you create a checklist template in the 
Visual Task Board interface. To give a checklist a name, you must configure the checklist 
template in the ServiceNow AI Platform.

2. Click the checklist tab ( ).

3. Add items to the checklist that you want to save as part of the template.

4. Click the more icon ( ).
The more icon does not display unless you have added an item to the checklist, or if you have 
a pre-existing checklist template.

5. Select Save as Template.

6. In the dialog box, enter a descriptive template name to identify the checklist.
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When a user creates a checklist from a template, all templates are listed in alphabetical order 
and there is no way to filter which templates appear. To provide a better user experience, 
consider implementing a naming system for checklist templates. For example, include the 
name of the table or another identifier to clarify how the checklist should be used.

7. Click Save.

Adding a checklist in the ServiceNow AI Platform

8. Navigate to All, and search for checklist_template.list.

9. Select New  to create a new checklist template.

10. Configure the fields for your new checklist template.

Option Description

Group
You can use this field to limit the group of 
users that are allowed to use this checklist 
template.

Template

Your template in JSON. Example:

{"owner":"2816f79cc0a8916401c5a33be04be443","name":"Checklist 
of items","items":
[{"name":"Call the 
vendor","order":0},
{"name":"Follow up email 
to customer","order":1},
{"name":"Slack the 
supervisor","order":2}]}

The attributes of a checklist template are:

Owner

The sys_ID of the user who owns 
or creates the checklist tem­
plate.

Name

The name of the checklist tem­
plate.

Items

The checklist items.

Name

The name of a checklist item.

Order

The order in which a checklist 
item appears in the checklist.

Name The name of the checklist template.

User
The role required to use the checklist tem­
plate.

11. Select Submit.
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Result
Your checklist template is created.

What to do next
Create a checklist from a checklist template by selecting the template from the more icon.

Delete a checklist from a Visual Task Board card

You can remove a checklist from a Visual Task Board card.

Before you begin
Role required: none

Procedure

1. Open a task card that contains a checklist.

2. Click the checklist tab ( ).

3. Click the more icon ( ).

4. Select Remove Checklist.
A confirmation dialog box appears.

5. Click Delete.

Configure which types of tasks can be created from Visual Task Board checklist items

A system property controls which types of tasks you can create from a Visual Task Board 
checklist item.

Before you begin
Role required: admin

About this task
You might want to add custom tables or remove tables you do not use.

Procedure

1. Navigate to sys_properties.list.

2. Locate the glide.ui.create_task_type_option_list  property.

3. Edit the Value  to add or remove tables.
You can add any table that extends Task [task]. Use the table name, not the label. For example, 
you would enter change_request, not Change Request. Ensure the tables listed are 
separated by commas, with no spaces.
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The property value populates the task type selection list users choose from when they create 
a task from a checklist item. Note that users can only see task types for which they have the 
appropriate access roles.

Visual Task Boards  reference

The following sections describe the installed components and properties for Visual Task Boards, 
along with domain separation and supported browser information.

Domain separation and Visual Task Boards

Domain separation is supported in the Visual Task Boards  application. Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

How domain separation works in Visual Task Boards

Visual Task Boards that are "data-driven" show the data from tables that are like Task tables. The 
data that is domain separated is also supported.

Condition-based criteria is used to filter that data. Free-form VTBs' use Private Tasks (vtb_task), 
which supports domain separation as an extension of Task and inherits domain separation logic 
as a result.

Related topics

Domain separation for service providers
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Supported browsers for Visual Task Boards

The system supports Visual Task Boards  on most modern browsers.

Supported browsers

• The latest public release of Firefox or Firefox ESR

• The latest public release of Chrome

• Safari version 12

• Access Visual Task Boards on your mobile device using either a browser or the native mobile 
app. For more information, see Tested devices and supported versions for ServiceNow mobile 
apps .

For more information, see Browser support.

Scripting support

Visual task boards do not interact with client scripts. Use a UI policy or a data policy instead.

Installed with Visual Task Boards

Several types of components are installed with Visual Task Boards.

Tables installed with Visual Task Boards

Tables are added to your instance when you activate Visual Task Boards.

Table Description

Board Member

[vtb_board_member]

Stores a record for each member of each task board.

Private Task

[vtb_task]

Stores a record for each personal task on each freeform board.

Visual Task Board

[vtb_board]

Stores a record for each task board.

Visual Task Board 
Card

[vtb_card]

Stores a record for each task card on each task board.

Visual Task Board 
Card History

[vtb_card_history]

Stores records for certain task card changes, such as lane or assignee 
changes. Each record indicates the previous value and the new value.

Visual Task Board 
Lane

[vtb_lane]

Stores a record for each lane on each task board.
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Properties installed with Visual Task Boards

Properties are added to your instance when you activate Visual Task Boards.

Note: 
To open the System Property [sys_properties] table, navigate to All, and 
then enter sys_properties.list  in the navigation filter.

Property Description

vtb.board.upload_limit Sets the maximum file size in megabytes allowed for each task card 
attachment.

• Type: integer

• Default value: 10

• Location: System Property [sys_properties] table

Script includes installed with Visual Task Boards

Script includes are added to your instance when you activate Visual Task Boards.

Script include Description

VisualTaskBoards Provides general utilities for Visual Task Boards.

VTBBoardSecurity Provides security utilities to control board access.

VTBGetBoardsByUser Provides a method that retrieves all the boards a specified user owns or 
is a member of.

VTBTaskSecurity Provides security utilities to control task access.

Client scripts installed with Visual Task Boards

Client scripts are added to your instance when you activate Visual Task Boards.

Client script Table Description

Add 
Kanban 
Choice

Visual Task 
Board

[vtb_board]

Adds the -- Kanban Board --  option to the Lane field  field. This 
option indicates that the task board is a flexible board.

Business rules installed with Visual Task Boards

Business rules are added to your instance when you activate Visual Task Boards.

Business 
rule

Table Description

Add 
members 
to live 
group

Board Member

[vtb_board_member]

If a Connect Chat conversation is created for a task 
board, this business rule adds the board members as 
conversation members.
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Business 
rule

Table Description

Remove 
member 
from live 
group

Board Member

[vtb_board_member]

If a Connect Chat conversation exists for a task board and 
a user is removed from the board members, this business 
rule removes the user from the conversation members.

Remove 
member 
from VTB

Live Group Member

[live_group_member]

If a Connect Chat conversation exists for a task board 
and a user is removed from the conversation members, 
this business rule removes the user from the task board 
members.

Sync 
board 
name to 
Connect

Visual Task Board

[vtb_board]

If a Connect Chat conversation exists for a task board 
and someone updates the board name, this business rule 
updates the conversation name.

Sync chat 
name to 
VTB board

Live Group Profile

[live_group_profile]

If a Connect Chat conversation exists for a task board and 
someone updates the conversation name, this business 
rule updates the board name.

Sync 
Members 
With VTB

Live Group Member

[live_group_member]

If a Connect Chat conversation exists for a task board and a 
user is added to the conversation members, this business 
rule adds the user as a board member.

Update 
Board 
on Card 
Change

Visual Task Board 
Card

[vtb_card]

Triggers the system to update the task board when changes 
occur to the cards.

Update 
Board 
on Lane 
Change

Visual Task Board 
Lane

[vtb_lane]

Triggers the system to update the task board when changes 
occur to the lanes.

update 
board 
on lane 
change

Board Member

[vtb_board_member]

Triggers the system to update the task board when changes 
occur to the board members.

VTB 
Previous 
Additional 
Assignees

Private Task

[vtb_task]

Triggers the system to send an email notification to users 
when they are designated as additional assignees for 
cards.

Related topics

Connect Chat

Notifications installed with Visual Task Boards

Notifications are added to your instance when you activate Visual Task Boards.

Notification Description

VTB member addition 
notification

Sends an email notification to the member about their addition 
to the board.
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Notification Description

VTB member deletion 
notification

Sends an email notification to the member about their removal 
from the board.

VTB additional assignee 
notification

Sends an email notification to users when they are designated 
as additional assignees for tasks.

VTB assignee notification Sends an email notification to users when they are designated 
as the primary assignees for personal tasks.

VTB lane change notification Sends an email notification to a task's assignees when the task 
changes lanes.

VTB lane limit reached Sends an email notification to the board member that the 
number of tasks in the lane has reached the set lane limit.

VTB lane limit exceeded Sends an email notification to the board member that the 
number of tasks in the lane has exceeded the set lane limit.

VTB card movement across 
vertical lanes and swimlanes

Sends an email notification to the board member with the 
details of the card moved and the member who moved the card.

Timeline Visualizations
A timeline visualization is a representation of an organization's activities over time.

Note: 

Starting with the Zurich  release, timeline visualization is no longer deployed, enhanced, 
or supported. For details, see the Deprecation Process [KB0867184]  article in the Now 
Support  Knowledge Base.

Install the Portfolio Planning  (standard customers) or Strategic Planning  (Pro customers) 
application from the ServiceNow®  Store. Review the Planning roadmaps in Portfolio 
Planning  or Roadmaps in Strategic Planning  documentation for guidance on the 
roadmap functionality available within these workspaces. Migrate to the Portfolio 
Planning Workspace  (SPM  Standard) application that provides latest experience for this 
functionality.

Typically, timeline visualizations are useful for quickly assessing the impact of future strategic 
and operational activities such as change requests and projects. Timeline visualizations come in 
two varieties: a two-dimensional (2D) view where activities are grouped by month, and a three-
dimensional (3D) view where activities are grouped in lanes. Both views are interactive, and the 
2D view can be printed.

Timeline administrators, users with the timeline_admin role, can set up visualizations to 
represent ITSM-related activities, such as incidents, problems, changes, and projects. Timeline 
administrators or users with the timeline_user role can personalize their timeline visualizations 
from the Settings pane in the visualization.

The CIO Roadmap timeline visualization shows your organization's projects grouped by 
portfolios. Organizational leaders can use the CIO Roadmap to monitor and evaluate the status 
of current and upcoming projects.

Note: 
Activating timeline visualizations does not activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.
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Key terms for timeline visualizations

Lane

A logical grouping of items on the 3D timeline visualization. For example, one lane 
might show pending projects while another lane shows open projects.

Panel

A block that represents an item record in a 2D timeline visualization, or a block that 
represents one or more item records in a 3D timeline visualization.

Summary view

A pop-up window that appears when a user clicks a panel in either the 2D or 3D 
timeline visualization. The summary view contains additional information about 
the record. Timeline administrators configure the information that appears in the 
summary view.

Marker

A bar indicating the start of a month in a 3D timeline visualization.

Slider

A tool used to control the time period seen in a 3D visualization.

Slider track

An alternative view of the panels displayed in both the 2D and 3D timeline 
visualization.
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Activate Timeline Visualization

An administrator can activate the Timeline Visualization plugin (com.snc.timeline_visualization) to 
access the functionality.

Before you begin
Role required: admin

About this task
To use the CIO roadmap with timeline visualization, you must activate Project Portfolio 
Management (com.snc.financial_planning_pmo) plugin.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Installed with Timeline Visualizations

Several components are installed with timeline visualizations.

Tables

Timeline visualization adds the following table.

Table Description

Timeline Visualization [roadmap_page]
Stores all available timeline visualizations.

Personalize Timeline [roadmap_user_page]
Stores timeline personalization settings for all 
timeline visualizations.

UI Policies

Timeline visualization adds the following UI policy.

Name Table Description

Control Timeline Visualization 
configuration Page to enable/
disable certain fields

Timeline Visualization 
[roadmap_page] Script that hides fields in the 

Timeline Visualization form 
when the form loads.

Script Includes

Timeline visualization adds the following script includes.

Name Description

Roadmap2DUtil
Timeline Visualization - 2D API to generate 
data for lanes and panels.

RoadmapCommonUtil
Timeline visualization common utility to handle 
generic functions.
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(continued)

Name Description

RoadmapConfig
Timeline visualization utility allowing 
configuration through the Timeline 
Visualization [roadmap_page] table.

RoadmapItems
Timeline visualization utility to get lane items.

RoadmapUtil
API to generate data for lanes and panels.

Client Scripts

Timeline visualization adds the following client scripts.

Name Table Description

Roadmap Color Choice Timeline Visualization 
[roadmap_page] Sets color values for the color 

choice fields in the timeline 
visualization configuration 
page.

Roadmap Item Table Timeline Visualization 
[roadmap_page] Allows changing the color 

fields for the item_color_key 
whenever there is a change to 
the panel table.

Roadmap On Load Timeline Visualization 
[roadmap_page] Loads the personalized 

version of the roadmap/
visualization.

Roadmap Panel Table Change Timeline Visualization 
[roadmap_page] Allows changing the field 

name for item_color_key 
whenever there is a change to 
the panel/visualization table.

Business Rules

Timeline visualization adds the following business rule.

Name Table Description

Check only one default Timeline Visualization 
[roadmap_page] Checks if another visualization 

is already set as default when 
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(continued)

Name Table Description

user sets a new visualization 
as the default.

Timeline visualizations roles

Timeline visualizations provides two roles.

To learn more about managing subscriptions, see Managing per-user subscriptions in 
Subscription Management  and contact your account representative.

Timeline administrator [timeline_admin]

Create and edit timeline visualization pages and view timeline visualizations.

Contains Roles

Timeline administrator contains the Timeline User [timeline_user] role.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

Important: 
Avoid granting an admin role when more specialized roles are available.

Timeline user [timeline_user]

View timeline visualizations. Timeline user access is also granted to users with the 
project_manager  and project_user  roles.

Contains Roles

List of roles contained within the role.

None.

Groups

List of groups this role is assigned to by default.

None.

Special considerations

None.

Create a Timeline Visualization

Set up timeline visualizations for the organization's leaders by creating a timeline that provides 
visual representations of the organization's operational and strategic activities.
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Before you begin
Role required: timeline_admin

About this task
Additionally, create timeline visualization views to define what data appears in the summary 
window when a user clicks a panel on the timeline.

Note: 
Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Procedure

Navigate to Timeline Visualization  > Create New  and create a new record.

Example 

Timeline visualization configuration form

Timeline visualization configuration form field descriptions

Field Description

Name Unique name for the visualization.

Panel table
Table that provides the records displayed as lanes and panels in the timeline.

Note: 
The list shows only tables and database views that are in the same scope 
as the visualization.

Relationship 
field Field on the table that contains values displayed as lane titles. Typically this field 

is a reference field or a field that contains a limited range of values.

Note: 
The CIO Roadmap timeline visualization is a ServiceNow customized 
visualization for the Project application that does not use the Relationship 
field.

Show slider Check box that enables (selected) or disables (cleared) displaying the timeline 
slider that users move to change the dates shown.
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Field Description

Panel name Field from the Panel table that contains the values displayed in the panel body.

Panel date Field from the Panel table that contains the date values displayed in the panel 
head in 3D view and in the panel body in 2D view. These dates also determine 
placement of panels on a lane. Only date and date-time fields are available on 
the choice list.

Default Check box that sets (selected) or removes (cleared) the default status of 
a visualization when you have more than one defined for a specific table. 
Applications that include a visualization use the default visualization.

Max items 
per lane

Maximum number of items that are displayed in a lane in 3D view. The default 
value is 500.

Note: 
The field is not visible on the form by default. Configure the form to add this 
field.

Max items 
per lane 2d

Maximum number of items that are displayed in a lane in 2D view. The default 
value is 99.

Note: 
The field is not visible on the form by default. Configure the form to add this 
field.

Timeline visualization configuration filtering and sorting form field descriptions

Field Description

Lane 
condition Condition builder used to create filters and apply sorting to values that are used as 

lanes in 3D view visualizations. For example, if you set [Name] [is not] [IT]  as a lane 
condition for the CIO Roadmap, then IT no longer appears as a lane in the roadmap, 
nor does it appear as a lane option in the Settings pane. Removing the filter restores 
the IT lane to the visualization and to lane options in the Settings pane.

To order the results, specify sorting based on relevant field names. For example, to 
order the portfolio names so that they appear in reverse alphabetical order on the 
CIO Roadmap, set the sort fields to [Name] [z to a].

Panel 
condition

Condition builder used to create filters and apply sorting to values that are used as 
panels in 2D and 3D view visualizations. For example, if you set [State] [is one of] 
[Pending, Open, Work in Progress]  as the panel condition for the CIO Roadmap, 
only projects that are in one of those states appear on the roadmap.

Timeline visualization configuration color options form field descriptions

Field Description

Panel 
color 
key

Field from the Panel table that contains values used for color coding the information 
displayed. The field selected here determines the values that are available in the 
Label  fields on the form.
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Field Description

The CIO Roadmap uses State, which is a field in the Project table. Panels on the CIO 
Roadmap are color coded according to the project state, which can be Pending, Open, 
Work in Progress, Closed Complete, Closed Incomplete, and Skipped.

Note: 
You require PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Examples of other fields that are suitable for this selection include Priority, Risk, and 
Approval.

Label 1

Label 
2

Label 
3

Label 
4

Values to be color coded. The values available are determined by the Panel color key 
field. For example, the CIO Roadmap is based on the Project table and has the Panel 
color key  set to the State  field, which contains the values Pending, Open, Work in 
Progress, Closed Complete, Closed Incomplete, and Closed Skipped.

You can set set specific colors for up to four values from the selected field. Other 
values are shown in the Default color.

Default 
color

Color applied to values that are not selected for labels. For example, the CIO Roadmap 
color codes and creates labels for the values Pending, Open, Work in Progress, and 
Closed Complete. The additional values, Closed Incomplete  and Closed Skipped, use 
the default color.

Color 1

Color 
2

Color 
3

Color 
4

Colors that correspond to each of the Label  field values. For example, if Label 1  is the 
Pending  state, and Color 1  is red, then panels for projects in the pending state are red.

Create a Timeline Visualization view

The timeline visualization view determines which record details appear in the pop-up summary 
window when a user clicks a panel.

Before you begin
Role required: admin

About this task
You can create one timeline visualization view per table. For example, if your view shows incident 
records, you can create a view on the Incident table to show only certain information, such as the 
incident number, priority, and short description.

If no Timeline Visualization view exists, all panels use the default view that shows all the fields 
that currently appear on the default view of the form for that table. After you create a Timeline 
Visualization view for a table, all panels then use that view.

For example, to create a Timeline Visualization view using the Incident form:
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Procedure

1. Navigate to Incident  > All.

2. Open an incident.

3. Right-click the form header and select Configure  > Form Layout.

4. Under Form view and section, go to the View name  field and select New.

5. Enter timeline visualization  in the View  name field.

6. Click Ok  to create the timeline visualization view.

7. Add fields to or remove items from the timeline visualization view using the Available  and 
Selected  columns.

8. Click Save.

Planning Your Timeline Visualization

Before creating a timeline visualization, you should have a clear idea of the information that you 
want to display.

This planning process helps you identify the required table and fields, and determine filtering 
and sorting requirements. Since users can personalize the visualization, avoid setting restrictive 
filters that may prevent users from finding categories that they are accustomed to seeing. You 
can use the CIO Roadmap as a starting point for creating your own timeline visualizations.

Note: 
Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Use Timeline Visualization

Timeline Visualization provides a high-level view of an organization's strategic and operational 
activities over time.

Organizational decision makers can use the information in visualizations for activities such 
as planning future projects and estimating resource requirements. Users can personalize  the 
information displayed with the visualization Settings pane.

Activating the Timeline Visualization application does not install the CIO Roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap. CIO Roadmap is a timeline 
visualization that displays an organization's IT projects and portfolios. This following sections use 
the CIO Roadmap to demonstrate features of timeline visualizations.

Lanes, markers, and panels

Lanes, markers, and panels are the fundamental elements of a timeline visualization. appear in 
the 3D view only.

Note: 
Lanes and markers are available in the 3D view only. A panel in the 2D view always 
represents a single record, while panels in 3D view may represent one or more records.

Lanes

A lane is a channel in which activities are grouped. A visualization can display up to eight lanes 
at a time. While viewing a visualization, you can use the Settings pane to show or hide individual 
lanes.
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Note: 
The number of items displayed in a lane depends on the Max items per lane  and Max 
items per lane 2d  settings on Timeline Visualization form.

Markers

Markers are horizontal lines that cross all lanes and identify a transition to the next month.

Panels

In 2D view, panels are grouped by month and stacked in chronological order, from the earliest 
date to the latest date. By default, the 2D view opens with the current month displayed on the left 
side of the visualization. You can print visualizations from the 2D view using the browser's print 
option. In 3D view, panels are grouped in lanes and ordered by date, from earliest to latest. The 
date that appears on the panel determines its placement in 2D and 3D view. The date displayed 
is based on a value the timeline administrator selects during initial setup.

Panels appear in the CIO Roadmap according to the planned completion date for the project. 
In 3D view, projects with the same planned date of completion are consolidated into a single 
panel. In 2D view, projects with the same planned date of completion are displayed as individual 
panels.

Panel headers in the CIO Roadmap are color coded based on project state. However, in 3D view, 
if a panel represents more than one project, the panel header is colored black. The Settings 
pane contains a key showing each available project state and the corresponding color.

Note: 
Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

To view additional information about a panel:

• Click a panel for a single record while in 2D or 3D view to open a summary window that 
contains additional information. Click the heading in the summary window to open the full 
record.

• Press the Shift key and then click a panel to open the full record.

• Click a panel that represents multiple records to open a list of those records. Click a record 
number to open the full record.

The timeline administrator can configure the information that appears in summary windows.

Personalize Timeline Visualizations

You can configure settings for timeline visualizations like lane and panel conditions, colors, and 
labels.

Personalization

Open the Settings pane and click Configure. Complete the form as appropriate (see table).
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Visualization personalization

Timeline visualization personalization form

Field Description

Lane 
conditions Condition builder used to create filters and apply sorting to values that are used 

as lanes in 3D view visualizations. For example, if you set [Name] [is not] [IT] as a 
lane condition for the CIO Roadmap, then IT no longer appears as a lane in the 
roadmap, nor does it appear as a lane option in the Settings pane. Removing the 
filter restores the IT lane to the visualization and to lane options in the Settings 
pane.

To order the results, specify sorting based on relevant field names. For example, to 
order the portfolio names so that they appear in reverse alphabetical order on the 
CIO Roadmap, set the sort fields to [Name] [z to a].

Panel 
conditions

Condition builder used to create filters and apply sorting to values that are used 
as panels in the visualization. For example, if you set [State] [is one of] [Pending, 
Open, Work in Progress] as the panel condition for the CIO Roadmap, only projects 
that are in one of those states appear on the roadmap.

Panel 
color key Field from the Panel table that contains values used for color coding the 

information displayed. The field selected here determines the values that are 
available in the Label fields on the form.

The CIO Roadmap uses State, which is a field in the Project table. Panels on 
the CIO Roadmap are color coded according to the project state, which can be 
Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and 
Skipped.

Examples of other fields that are suitable for this selection include Priority, Risk, 
and Approval.

Label 1

Label 2

Label 3

Label 4

Values to be color coded. The values available are determined by the Panel color 
key field. For example, the CIO Roadmap is based on the Project table and has the 
Panel color key' set to the State field, which contains the values Pending, Open, 
Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped.

You can set specific colors for up to four values from the selected field. Other 
values are shown in the Default color.
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Timeline visualization personalization form  (continued)

Field Description

Default 
color

Color applied to values that are not selected for labels. For example, the CIO 
Roadmap color codes and creates labels for the values Pending, Open, Work in 
Progress, and Closed Complete. The additional values, Closed Incomplete and 
Closed Skipped, use the default color.

Color 1

Color 2

Color 3

Color 4

Colors that correspond to each of the Label field values. For example, if Label 1 is 
the Pending state, and Color 1 is red, then panels for projects in the pending state 
are red.

Note: 

• Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

• If the Max items per lane  field is set to more than 1000, you may observe a delay when 
displaying the timeline data using Internet Explorer (IE) as the browser.

The Settings pane

Element names in the Settings pane vary based on the table and fields used to create the 
visualization.
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The Settings pane contains the following elements:

Settings pane elements

Element Description

Key Identifies the type of information that is color coded on the timeline, such as state 
or priority. It also lists the color assigned to each possible value, such as pending 
state and open state.

Configure Allows you to personalize a visualization by creating filters on lane information and 
panel information, specifying sort order for results, and reassigning panel colors. 
These changes affect your view of the visualization only.

View Allows you to switch between 2D and 3D view.

View 
<table> 
List

Opens a separate browser tab showing the complete record list for the associated 
table.

Portfolio Allows you to click lane names to add or remove them from the visualization. While 
the visualization is in 2D view, the Settings pane displays a Show all <records> 
button that allows you to override lane filters applied to the initial setup.

Use the slider and slider track

The slider and slider track are useful for quickly navigating to any point in time on a visualization.
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Note: 
Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

For the CIO Roadmap, the slider track allows you to quickly view the distribution of projects 
over time and determine project states. While in 3D view, click and drag the slider to move the 
timeline forward or backward. In 2D view, click and drag the slider track right or left to move the 
timeline forward or backward.

The slider track provides an alternative view of panels on a visualization. For the CIO Roadmap, 
a colored dot in the slider track indicates the presence of one or more projects for a given day. 
The different dot colors correspond to different project states. This allows you to scan the slider 
track to identify projects of interest by their color, and then use the slider or slider track to quickly 
navigate to those projects. For example, if you are interested in projects that are in a pending 
state, you can use the slider to navigate to the colored dots that represent that state.

Note: 
Dots in the slider track do not correspond one-to-one with panels in a visualization. A dot 
represents the presence of one or more projects on a given date. In 3D view, if there is more 
than one project for a given day, all of the projects for that day are combined into a single 
panel on the roadmap. When the slider track is populated, projects in a multi project panel 
are analyzed for project state and then represented as appropriately colored dots in the 
slider track.

Similarly, you can use the slider or slider track in conjunction with the calendar to quickly 
navigate to any point in time. For example, if you are concerned about resource issues in April 
2014 because you see a large cluster of dots during that time, dragging the slider or slider track 
to those dots brings those projects into view. Click the individual panels to view additional 
information.

View timeline visualization

You can view timeline visualizations from a project.

Before you begin
Role required: none

Procedure

1. Navigate to Project  > Projects  > All.

2. Scroll to the bottom of the list and click the Timeline Visualization  related link.

By default, the CIO Roadmap opens in three-dimensional (3D) view with the current date at the 
forefront of the timeline. You can use the Settings pane to change between two-dimensional 
(2D) and 3D view. As soon as you view a timeline visualization, it is considered personalized. 
After that, you see your personalized view even if the timeline administrator makes changes to 
the default visualization.

Note: 
Activating timeline visualizations doesn't activate predefined CIO roadmap. You require 
PPM (com.snc.financial_planning_pmo) plugin to use CIO roadmap.

Timeline administrators can create timeline visualizations on other tables. If you are not sure 
whether a timeline visualization exists for a certain application, use the application navigator 
to open the application of your choice, and click All. If a timeline visualization exists for the 
application's table, a Timeline Visualization related link appears.
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Work with timeline visualizations

There are various tools that allow you to move visualizations backward and forward in time 
depending on whether you are in 2D or 3D view.

The following options are available for navigating between months.

2D views

Option Description

Dragging Hold down the left mouse button and drag the slider track  right or left to 
view other months.

Left and right arrow 
keys

Press the left or right arrow keys on the keyboard to move the timeline 
forward or backward.

Mouse wheel button Scroll the wheel to move the timeline forward or backward.

Right and left 
navigation arrows

Click the arrows to move from month to month. Arrows do not appear if 
there are no additional months to view.

The following options are available for navigating stacked panels.

Navigating stacked panels

Option Description

Dragging Hold down the left mouse button and drag the stack up or down to view 
other panels.

Up and down 
navigation 
arrows

Click the arrows in a stack to view additional panels for the same month. 
Arrows do not appear if there are no additional panels to view.

The following options are available for navigating in 3D view.

3D view

Option Description

Dragging Hold down the left mouse button and drag the slider along the slider track  to 
move the timeline forward or backward.

Mouse wheel 
button

Scroll the wheel to move the timeline forward or backward.

Up and down 
arrow keys

Press the arrow keys to move the timeline forward or backward.

Shift key Press the shift key and click the panel for a single record to open the complete 
record that contains additional information.
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